The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.

Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data. Users should verify for themselves that the data is accurate and suitable for their project work.

**Limitation of Damages**

IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL, SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION’S LIABILITY EXCEED THE AMOUNT THAT INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2) YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW.

**Export Controls**

Intergraph Corporation’s software products and any third-party Software Products obtained from Intergraph Corporation, its subsidiaries, or distributors (including any Documentation, Other Documentation or technical data related to these products) are subject to the export control laws and regulations of the United States. Diversion contrary to U.S. law is prohibited. These Software Products, and the direct product thereof, must not be exported or re-exported, directly or indirectly (including via remote access) under the following circumstances:

a. To Cuba, Iran, North Korea, Sudan, or Syria, or any national of these countries.


c. To any entity when Licensee knows, or has reason to know, the end use of the Software Product is related to the design, development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive nuclear uses.

d. To any entity when Licensee knows, or has reason to know, that an illegal reshipment will take place.

Any questions regarding export or re-export of these Software Products should be addressed to Intergraph Corporation’s Export Compliance Department, Huntsville, Alabama 35894, USA.

**Trademarks**

Intergraph, the Intergraph logo, PDS, SmartPlant, FrameWorks, I-Sketch, SmartMarine, Intelliship, ISOGEN, SmartSketch, SPOOLGEN, SupportManager, SupportModeler, Sapphire, and Intergraph Smart are trademarks or registered trademarks of Intergraph Corporation or its subsidiaries in the United States and other countries. Hexagon and the Hexagon logo are registered trademarks of Hexagon AB or its subsidiaries. Microsoft and Windows are registered trademarks of Microsoft Corporation. ACIS is a registered trademark of SPATIAL TECHNOLOGY, INC. Infragistics, Presentation Layer Framework, ActiveTreeView Ctrl, ProtoViewCtrl, ActiveThreeD Ctrl, ActiveListBar Ctrl, ActiveSplitter, ActiveToolbars Ctrl, ActiveToolbars Plus Ctrl, and ProtoView are trademarks of Infragistics, Inc. Incorporates portions of 2D DCM, 3D DCM, and HLM by Siemens Product Lifecycle Management Software III (GB) Ltd. All rights reserved. Gigasoft is a registered trademark, and ProEssentials a trademark of Gigasoft, Inc. VideoSoft and VXFlexGrid are either registered trademarks or trademarks of ComponentOne LLC 1991-2013. All rights reserved. Oracle, JD Edwards, PeopleSoft, and Retek are registered trademarks of Oracle Corporation and/or its affiliates. Tribon is a trademark of AVEVA Group plc. Alma and act/cut are trademarks of the Alma company. Other brands and product names are trademarks of their respective owners.
# Contents

**Preface** ........................................................................................................................................................ 12  
- Documentation Set ................................................................................................................................. 13  
- Documentation Comments ....................................................................................................................... 17  

**What’s New in Drawings and Reports** ..................................................................................................... 18  

**Drawings and Reports** ............................................................................................................................ 21  

**Delivered Drawing Types** ....................................................................................................................... 23  

**Interface Overview** ..................................................................................................................................... 25  
- Menus and Toolbars ............................................................................................................................... 26  
- Icons for Components and Drawings ...................................................................................................... 26  
- Permissions Overview ............................................................................................................................. 28  

**View Menu** .................................................................................................................................................. 29  
- Management Console (View Menu) ......................................................................................................... 29  
- Detail View (View Menu) ......................................................................................................................... 30  
  - Specify columns in the detail view ..................................................................................................... 30  
    - Column Settings Dialog Box ........................................................................................................... 32  
  - Refresh (View Menu) ............................................................................................................................ 33  

**Shortcut Menus** ......................................................................................................................................... 34  
- Copy Command ....................................................................................................................................... 35  
  - Copy an item .................................................................................................................................. 35  
- Create Drawing(s) Command ................................................................................................................... 36  
- Delete Command .................................................................................................................................... 36  
  - Delete an item ................................................................................................................................ 37  
- Edit Command ......................................................................................................................................... 37  
- New Command ....................................................................................................................................... 37  
  - Add a folder .................................................................................................................................... 38  
  - Add a package of components .......................................................................................................... 38  
  - Add a component .............................................................................................................................. 39  
  - Add Component Dialog Box ............................................................................................................ 39  
- Open Command ....................................................................................................................................... 39  
  - Open a document ............................................................................................................................. 40  
- Paste Command ....................................................................................................................................... 40  
  - Paste an item .................................................................................................................................. 41  
  - Paste Special Dialog Box ............................................................................................................... 41  
- Print Command ....................................................................................................................................... 42  
  - Print a document ............................................................................................................................. 42  
  - Print a document as a PDF file ......................................................................................................... 42  
  - Select Printer (File Menu) ............................................................................................................... 43
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isometric Style Common Tasks</td>
<td>114</td>
</tr>
<tr>
<td>Edit Options (Piping Isometric Drawing Component Shortcut Menu)</td>
<td>115</td>
</tr>
<tr>
<td>Customize isometric style options</td>
<td>117</td>
</tr>
<tr>
<td>Assign labels</td>
<td>117</td>
</tr>
<tr>
<td>Populate the title block</td>
<td>118</td>
</tr>
<tr>
<td>Import data from the style XML file</td>
<td>120</td>
</tr>
<tr>
<td>Set drawing frame options</td>
<td>120</td>
</tr>
<tr>
<td>Edit the North arrow on isometric drawings</td>
<td>121</td>
</tr>
<tr>
<td>Set drawing dimension options</td>
<td>122</td>
</tr>
<tr>
<td>Control drawing content</td>
<td>122</td>
</tr>
<tr>
<td>Set drawing control options</td>
<td>124</td>
</tr>
<tr>
<td>Specify drawing format</td>
<td>124</td>
</tr>
<tr>
<td>Create a key point note</td>
<td>124</td>
</tr>
<tr>
<td>Enable revision clouds</td>
<td>126</td>
</tr>
<tr>
<td>Assign unique part numbers</td>
<td>127</td>
</tr>
<tr>
<td>Isometric Style Options Browser</td>
<td>130</td>
</tr>
<tr>
<td>Fonts in Isometric Drawings</td>
<td>162</td>
</tr>
<tr>
<td>Select a font for isometric drawing output</td>
<td>162</td>
</tr>
<tr>
<td>Define a dynamic font for isometric drawing extraction</td>
<td>163</td>
</tr>
<tr>
<td>Place barcode data on the isometric drawing</td>
<td>164</td>
</tr>
<tr>
<td>Flow Arrows</td>
<td>165</td>
</tr>
<tr>
<td>Set flow arrow options</td>
<td>166</td>
</tr>
<tr>
<td>Bending Files</td>
<td>167</td>
</tr>
<tr>
<td>Material Lists and Material List Files</td>
<td>167</td>
</tr>
<tr>
<td>Set up a material list</td>
<td>169</td>
</tr>
<tr>
<td>Set up a cut list</td>
<td>170</td>
</tr>
<tr>
<td>Specify a label for the material list</td>
<td>170</td>
</tr>
<tr>
<td>Set styles for the MTO neutral file</td>
<td>171</td>
</tr>
<tr>
<td>Pipeline Lists</td>
<td>171</td>
</tr>
<tr>
<td>Display a pipeline list</td>
<td>172</td>
</tr>
<tr>
<td>Weld Lists and Weld Files</td>
<td>172</td>
</tr>
<tr>
<td>Print welds</td>
<td>173</td>
</tr>
<tr>
<td>Specify a label for the weld list</td>
<td>173</td>
</tr>
<tr>
<td>Change Management in Piping Isometric Drawings</td>
<td>173</td>
</tr>
<tr>
<td>Use piping isometric change management</td>
<td>175</td>
</tr>
<tr>
<td>Option Override (Piping Isometric Drawing Shortcut Menu)</td>
<td>177</td>
</tr>
<tr>
<td>Override isometric drawing style options</td>
<td>178</td>
</tr>
<tr>
<td>Option Override Dialog Box</td>
<td>179</td>
</tr>
<tr>
<td>Select Options Dialog Box</td>
<td>179</td>
</tr>
<tr>
<td>Detail Sketches in Drawings</td>
<td>180</td>
</tr>
<tr>
<td>Add a detail sketch</td>
<td>181</td>
</tr>
<tr>
<td>Layers</td>
<td>182</td>
</tr>
<tr>
<td>Map isometric data to drawing layers</td>
<td>183</td>
</tr>
<tr>
<td>Custom Symbols for Isometric Drawings</td>
<td>184</td>
</tr>
<tr>
<td>Configure the software to use an ASCII symbol file</td>
<td>184</td>
</tr>
<tr>
<td>Create a custom symbol for isometric drawings</td>
<td>185</td>
</tr>
</tbody>
</table>
## Contents

### Search Folders

- Create a search folder ................................................................. 188
- Setup (Search Folder) ........................................................................... 189
- Setup Dialog Box (Search Folder) .................................................... 189
- Search Folder Filters ................................................................................ 189

### Imported Folders ........................................................................... 192

- Create an imported folder .............................................................. 193
- Setup (Imported Folder) ........................................................................ 193
- Setup Dialog Box (Imported Folder) ................................................. 194
- Browse for Folder Dialog Box ............................................................ 194

### Tools Menu .................................................................................. 195

- Batch Processing - Intergraph Smart Batch Services .......................... 195
  - Update Action ................................................................................. 197
  - Refresh Action .............................................................................. 197
  - Print Action .................................................................................. 198
  - Set Print Options .......................................................................... 198
  - Create a Template ......................................................................... 199
  - Schedule [Task] Dialog Box ............................................................ 199
- Batch Processing ............................................................................... 200
  - Batch Management ........................................................................ 202
  - Batch Print ..................................................................................... 208
  - Batch Update ................................................................................. 208
  - Batch Local Update ....................................................................... 209
  - Batch Update Document(s) ............................................................ 209
  - Batch Refresh ............................................................................... 210
  - Schedule Wizard ............................................................................ 211
- Custom Commands ........................................................................... 223
  - Create custom commands ............................................................. 226
  - Add custom commands ................................................................... 227
  - Run a custom command ............................................................... 227
  - Edit a custom command ............................................................... 227
  - Delete a custom command ............................................................ 227
  - Custom Commands Dialog Box ....................................................... 228
  - Add Custom Command Dialog Box ............................................... 228
  - Edit Custom Command Dialog Box ............................................... 229
  - Delivered Custom Commands ....................................................... 229

### Working with Drawings and Reports and SmartSketch Drawing Editor ................................................................ 230

- Drawings View Explorer .................................................................... 233
- Move Sheet(s) .................................................................................. 235
- Dimensions ..................................................................................... 236
  - Automatic Dimensioning .............................................................. 236
  - Manual Dimensioning ................................................................. 244
  - Dimensioning in 3D Drawings ....................................................... 245
- Save As MicroStation or AutoCAD Format ......................................... 249
- Edit Sheet Properties Command ....................................................... 251
Contents

Change the Border Template for an Existing Sheet ............................................................... 252
Sheet Properties Dialog Box ......................................................................................... 252
Drawings Compose Toolbar ......................................................................................... 254
Place View Command ................................................................................................. 254
Place Region Command .............................................................................................. 272
Place Snapshot View Command .................................................................................. 275
Associate Objects to View Command ............................................................................. 276
Remove Associated Inputs Command ............................................................................ 290
Place Report View Command ....................................................................................... 290
Place a Label Command .............................................................................................. 293
Group Selected Labels .................................................................................................. 300
Place Detail Envelope Command .................................................................................. 304
Place Cutting Plane/Section View Command ............................................................... 308
Place Detail View Command ........................................................................................ 319
2D/3D Selection Command .......................................................................................... 322
Using Scaled Sketching ................................................................................................. 324
Retain Edits made inside a Drawing View ................................................................. 334
Hide/Show Object Command ...................................................................................... 335
Copy and Paste View Command ................................................................................... 337
Move View Command ................................................................................................... 337
Highlight Annotations Command .................................................................................. 339
Clear Manual Edits Command ........................................................................................ 341
Associate Graphics to Graphic View Command .......................................................... 341
Template Toolbar .......................................................................................................... 343
Place Drawing View Command (Template Toolbar) ....................................................... 344
Place Report Command (Template Toolbar) ............................................................... 348
Place Key Plan Command (Template Toolbar) ............................................................. 350
Edit Border Template Toolbar ................................................................................... 353
Place Drawing Property Label Command (Drawing Labels Toolbar) ....................... 353
Place Drawing Area Command ................................................................................... 366
Change the Border for an Individual Drawings by Rule Sheet ................................... 367
Edit Layout Template .................................................................................................... 368
Edit Border Family Command ...................................................................................... 368
Preview Layout Command ............................................................................................ 370
Shortcut Menus .............................................................................................................. 370
Update View Command ................................................................................................. 370
Switch Border ................................................................................................................ 371
Add a Sheet to Drawing ................................................................................................. 373
Layers (SmartSketch Drawing Editor Tools Menu) ....................................................... 373
Modify an Existing Border File ..................................................................................... 374
Custom Commands ...................................................................................................... 374
Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command .... 375
Edit a Composed Drawing ............................................................................................ 375
Edit the Drawing Template .......................................................................................... 377
Modify View Ribbon ..................................................................................................... 377
Crop a Drawings by Rule 2D Drawing View and the 3D Model Volume .................... 378
Remove Cropping on a Drawings by Rule View ......................................................... 379
Place an Unassigned View .......................................................................................... 379
Section View Orientation Rules in Drawings by Rule ................................................ 380
Update and Full Update Commands ............................................................................ 385
## Contents

**Revising** .......................................................................................................................... 388

- Revise ................................................................................................................................. 388
- Revise a document ............................................................................................................. 389
- Revise Dialog Box ............................................................................................................. 390

**Publishing Documents** .................................................................................................. 391

- Publishing Title Blocks .................................................................................................... 393
- Publish Common Tasks ..................................................................................................... 394
- Publish .............................................................................................................................. 395
  - Set properties for publishing documents ........................................................................ 396
  - Support for Handling Large Publishes .......................................................................... 396
  - Publish documents ......................................................................................................... 399
  - Publish Workflows ......................................................................................................... 400
  - Publish a large 3D model to SmartPlant Foundation ...................................................... 402
  - Issue request documents ............................................................................................... 403
  - Publish Dialog Box ......................................................................................................... 404
  - Document Properties Dialog Box .................................................................................. 407
- Find Documents to Publish ............................................................................................. 408
  - Find documents to publish ............................................................................................. 409
  - Find Documents to Publish Dialog Box ......................................................................... 409
- Manage Projects ................................................................................................................. 410
  - Select Active Project Dialog Box .................................................................................. 410

**Appendix: Troubleshooting Drawings and Reports** ....................................................... 411

- Troubleshooting Linked Servers ...................................................................................... 414

**Appendix: Isometric Drawing Options** .......................................................................... 415

- Alias Documentation .......................................................................................................... 416
- Alternative Text Options .................................................................................................... 416
- Drawing General Options .................................................................................................. 417
  - Content (Drawing) ........................................................................................................... 418
  - Controls (Drawing) ......................................................................................................... 428
  - Definitions (Drawing) ...................................................................................................... 439
  - Dimensions (Drawing) ..................................................................................................... 442
  - Format (Drawing) ............................................................................................................ 479
  - Layers (Drawing) ............................................................................................................. 515
  - Dynamic Fonts (Drawing) ............................................................................................. 516
  - End Connections (Drawing) .......................................................................................... 517
  - Revisions (Drawing) ....................................................................................................... 522
  - Welds (Drawing) .............................................................................................................. 524
- Drawing Frame Options ..................................................................................................... 543
  - Attributes (Drawing Frame) ......................................................................................... 545
  - Table Attributes (Drawing Frame) ............................................................................... 546
  - Symbol Table (Drawing Frame) ..................................................................................... 548
- Material List Options .......................................................................................................... 550
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Layout (Material List)</td>
<td>561</td>
</tr>
<tr>
<td>Variable Layout (Material List)</td>
<td>564</td>
</tr>
<tr>
<td>User Defined (Material List)</td>
<td>568</td>
</tr>
<tr>
<td>Summary File (Material List)</td>
<td>582</td>
</tr>
<tr>
<td>Transfers (Material List)</td>
<td>586</td>
</tr>
<tr>
<td>Weld List Options</td>
<td>589</td>
</tr>
<tr>
<td>Fixed Layout (Weld List)</td>
<td>590</td>
</tr>
<tr>
<td>Variable Layout (Weld List)</td>
<td>590</td>
</tr>
<tr>
<td>User Defined (Weld List)</td>
<td>592</td>
</tr>
<tr>
<td>Summary File (Weld List)</td>
<td>595</td>
</tr>
<tr>
<td>Cut List Options</td>
<td>598</td>
</tr>
<tr>
<td>Fixed Layout (Cut List)</td>
<td>601</td>
</tr>
<tr>
<td>User Defined (Cut List)</td>
<td>602</td>
</tr>
<tr>
<td>Summary File (Cut List)</td>
<td>606</td>
</tr>
<tr>
<td>Supplementary Options</td>
<td>609</td>
</tr>
<tr>
<td>Additional Data (Supplementary)</td>
<td>610</td>
</tr>
<tr>
<td>Auxiliary Programs (Supplementary)</td>
<td>611</td>
</tr>
<tr>
<td>Bending Report (Supplementary)</td>
<td>612</td>
</tr>
<tr>
<td>Centre of Gravity (Supplementary)</td>
<td>613</td>
</tr>
<tr>
<td>Data Files (Supplementary)</td>
<td>615</td>
</tr>
<tr>
<td>Detail Sketches (Supplementary)</td>
<td>615</td>
</tr>
<tr>
<td>Drawing Information File (Supplementary)</td>
<td>622</td>
</tr>
<tr>
<td>Fonts (Supplementary)</td>
<td>623</td>
</tr>
<tr>
<td>Heat Treatment (Supplementary)</td>
<td>623</td>
</tr>
<tr>
<td>Instrument SKEYs (Supplementary)</td>
<td>624</td>
</tr>
<tr>
<td>Neutral File (Supplementary)</td>
<td>624</td>
</tr>
<tr>
<td>Pipeline Attributes (Supplementary)</td>
<td>629</td>
</tr>
<tr>
<td>Reference Planes (Supplementary)</td>
<td>629</td>
</tr>
<tr>
<td>Report Files (Supplementary)</td>
<td>634</td>
</tr>
<tr>
<td>Site Weld File (Supplementary)</td>
<td>635</td>
</tr>
<tr>
<td>Spool Attributes (Supplementary)</td>
<td>637</td>
</tr>
<tr>
<td>Spool Information (Supplementary)</td>
<td>638</td>
</tr>
<tr>
<td>Table Attributes (Supplementary)</td>
<td>640</td>
</tr>
<tr>
<td>Title Texts (Supplementary)</td>
<td>642</td>
</tr>
<tr>
<td>Traceability (Supplementary)</td>
<td>643</td>
</tr>
<tr>
<td>Printed Material List (Supplementary)</td>
<td>645</td>
</tr>
<tr>
<td>S3D Options</td>
<td>646</td>
</tr>
<tr>
<td>Drawing Options (S3D)</td>
<td>647</td>
</tr>
<tr>
<td>Drawing Frame Options (S3D)</td>
<td>662</td>
</tr>
<tr>
<td>Material List Options (S3D)</td>
<td>666</td>
</tr>
<tr>
<td>Supplementary Options (S3D)</td>
<td>666</td>
</tr>
<tr>
<td>Neutral File Options (S3D)</td>
<td>674</td>
</tr>
<tr>
<td>Labels Options (S3D)</td>
<td>678</td>
</tr>
<tr>
<td>Symbol Mapping Options (S3D)</td>
<td>684</td>
</tr>
<tr>
<td>Intergraph Alternative Text Options (S3D)</td>
<td>686</td>
</tr>
<tr>
<td>Attribute Mapping Options (S3D)</td>
<td>687</td>
</tr>
<tr>
<td>Comments Options (S3D)</td>
<td>688</td>
</tr>
</tbody>
</table>
This document is a user's guide for the Smart 3D Drawings and Reports task and provides command reference information and procedural instructions.

The Drawings and Reports user documentation is delivered in three separate documents:

- Orthographic Drawings User’s Guide
- Piping Isometric Drawings User’s Guide
- Reports User’s Guide

Documentation Comments

For the latest support information for this product, comments or suggestions about this documentation, and documentation updates for supported software versions, please visit Intergraph Smart Support (https://smartsupport.intergraph.com).
Documentation Set

Intergraph Smart™ 3D Documentation is available as Adobe PDF files. The content is the same as the online Help. To access these PDF documents, click Help > Printable Guides in the software.

The documentation set is divided into four categories:

- Administrative guides contain information about installing, configuring, customizing, and troubleshooting.
- User's guides provide command reference and how-to information for working in each task.
- Reference data guides define the reference data workbooks. Not all tasks have reference data.
- ISOGEN guides.

Administrative Guides

*Intergraph Smart™ 3D Installation Guide* - Provides instructions on installing and configuring the software.

*Project Management User's Guide* - Provides instructions for setting up the databases, creating permission groups, backing up and restoring project data, assigning access permissions to the model, defining and managing locations for Global Workshare, and version upgrade.

*Global Workshare Guide* - Provides instructions for setting up the software and the databases to work in a workshare environment.

*Interference Checking Guide* - Provides information on installing, configuring, and using the interference detection service.

*Integration Reference Guide* - Provides information about installing, configuring, and using Smart 3D in an integrated environment.

*Interpreting Human Piping Specifications* - Provides information about how to interpret human piping specifications so that you can create the corresponding piping specification in the software.

*Design and Data Exchange with PDMS* - Provides information about how to export model data from Smart 3D to PDMS and from PDMS to Smart 3D. Specific guidelines relating to best practices and known limitations of the export functionality are also included.

*Export to Plant Design System (PDS) User's Guide* - Provides information about how to export model data from Smart 3D to PDS. Specific guidelines relating to best practices and known limitations of the export functionality are also included.

*Point Cloud Reference* - Provides information for referencing point cloud files provided by point cloud vendors in Smart 3D.

*Troubleshooting Reference Guide* - Provides information on how to resolve errors that you might encounter in the software by documenting troubleshooting tips, error messages, and To Do List messages.

*Plant Design System (PDS) Guide* - Provides all information needed to use PDS with Smart 3D. Topics include referencing active PDS projects in Smart 3D, exporting PDS data and importing that data into Smart 3D, and converting PDS reference data to Smart 3D reference data.
Intergraph Smart™ 3D Programmer’s Guide - Provides information about custom commands, naming rules, and symbol programming. If you install the Programming Resources, this document is delivered to the [Product Folder]/Programming/Help folder.

User's Guides

Catalog User's Guide - Provides information about viewing, editing, and creating reference data and select lists (codelists).

Civil User's Guide - Provides information about routing trench runs in the model.

Common User's Guide - Provides information about defining workspaces, manipulating views, and running reports.

Compartmentation User's Guide - Provides instruction for placing volume objects such as compartments and zones in the model.

Electrical User's Guide - Provides information about routing electrical cable, cableway, cable tray, and conduit.

Equipment and Furnishings User's Guide - Provides information about placing equipment.

Geometry Analysis and Repair User's Guide - Provides instructions for importing and exporting model data, checking the data against a defined set of requirements, and repairing the data.

Grids User's Guide - Provides instructions for creating coordinate systems, elevation grid planes, vertical grid planes, radial cylinders, radial planes, grid arcs, and grid lines.

Hangers and Supports User's Guide - Provides instructions on placing piping, duct, and cableway supports in the model.

Hole Management User's Guide - Provides instructions for placing, reviewing, and approving holes in a structure.


Molded Forms User's Guide - Provides instructions for placing hull, bulkheads, major openings, stiffeners, and other major structural components in the model.

Orthographic Drawings User's Guide - Provides information about creating and managing orthographic drawings.

Piping Isometric Drawings User's Guide - Provides information about creating and managing piping isometric drawings.

Piping User's Guide - Provides instructions for routing pipe and placing valves, taps, and pipe joints.

Planning User's Guide - Provides instructions about defining the assembly hierarchy (production bill of material) by creating blocks and assemblies and by specifying the assembly sequence.

Reports User's Guide - Provides information about creating and managing spreadsheet reports.

Space Management User's Guide - Provides instructions for placing space objects such as areas, zones, interference volumes, and drawing volumes in the model.

Structural Analysis User's Guide - Provides instructions for defining loads, load cases, load combinations, and the importing and exporting of analytical data.

Structural Detailing User's Guide - Provides instructions for creating, detailing, and maintaining the structural members of a model.
Preface

Structural Manufacturing User's Guide - Provides instructions for creating and maintaining manufacturing objects such as templates, jigs, and margins.

Structure User's Guide - Provides instructions for placing structural members, such as beams, columns, slabs, openings, stairs, ladders, equipment foundations, and handrails.

Systems and Specifications User's Guide - Provides instructions for creating systems and selecting the available specifications for each system type.

Reference Data Guides

2D Symbols User's Guide - Provides command reference information and procedural instructions for creating 2D symbols used to represent collars, clips, profiles, brackets, and other items.

2D Symbols Reference Data Guide - Provides information about the two-dimensional symbols used in all tasks.

Civil Reference Data Guide - Provides information about trench straight features, turn features, reference data.

Compartmentation Reference Data Guide - Provides information about compartmentation reference data.

Drawings and Reports Reference Data Guide - Provides information about reports reference data.

Electrical Reference Data Guide - Provides information about electrical cable, cableway, cable tray, and conduit reference data.

Electrical 3D Symbols Reference - Provides information about the cable tray and conduit 3D symbols that are available.

Equipment and Furnishings Reference Data Guide - Provides information about equipment reference data.

Equipment 3D Symbols Reference - Provides information about the equipment, equipment component, design shapes, and design aides 3D symbols that are available.

Hangers and Supports Reference Data Guide - Provides information about hangers and supports reference data.

Hangers and Supports 3D Symbols Reference - Provides information about the hanger and support 3D symbols that are available.

Hangers and Supports SmartPart Symbols Reference - Provides information about the hanger and support SmartPart symbols that are available.

Hole Management Reference Data Guide - Provides information about hole reference data.

HVAC Reference Data Guide - Provides information about HVAC reference data.

HVAC 3D Symbols Reference - Provides information about the HVAC 3D symbols that are available.

Reference Data Guide - Provides instructions about the Bulkload utility, codelists, and the reference data common to several disciplines.

Piping Reference Data Guide - Provides information about piping reference data including piping specifications, piping specification rules, piping parts, and piping symbols.

Piping 3D Symbols Reference - Provides information about the piping 3D symbols that are available.
Space Management Reference Data Guide - Provides information about space management reference data.

Structure Reference Data Guide - Provides information about structural reference data.

Structure 3D Symbols Reference - Provides information about the stair, ladder, footings, and equipment foundation 3D symbols that are available.

Structural Reference Data Overview - Provides an overview of the marine mode structural reference data library.

**ISOGEN Guides**

Symbol Keys Reference Guide - Provides information about the symbol keys for isometric drawings. This guide is from Alias, the makers of ISOGEN.
Documentation Comments

For the latest support information for this product, comments or suggestions about this documentation, and documentation updates for supported software versions, please visit Intergraph Smart Support (https://smartsupport.intergraph.com).
What's New in Drawings and Reports

The following changes have been made to the Drawing and Reports task.

Hot Fix and Service Pack Updates

Drawings (General)

- You can now transfer the ownership of drawings between permission groups. For more information, see Configuration Tab (Properties Dialog Box) (on page 63). (P2 CP:196182)
- You can copy a drawing view only by using the Copy and Paste View command. For more information, see Copy and Paste View Command (on page 337). (P2 CP:226825)
- You can now either delete a manual view placed by rule, or move the view to the UnAssigned Folder. For more information, see Delete Views (on page 387). (P2 CP:256645)
- In drawings by rule, view annotations, such as the ruler and view name, are automatically adjusted in relation to the View Offset value. For more information, see View Tab (Drawing View Properties Dialog Box - Drawings View Explorer) (on page 262). (P2 CP:274144)
- You must perform a bulkload before you can define View Offset. For more information, see View Tab (Drawing View Properties Dialog Box - Drawings View Explorer) (on page 262). (P2 CP:274144)
- You can perform Update Selected on both full and cropped views. For more information, see Drawings View Explorer (on page 233). (P2 CP:275860)
- The SmartPlant Foundation (*.xml) target file type allows you to save drawing data and metadata to generate .xml files in either integrated and non-integrated environments that can be easily updated. This option is available for Isometric Drawings, Composed Drawings, and Volume Drawings component types. For more information, see Save as SmartPlant Foundation (*.xml) (on page 69). (P2 CP:250767)
- You can now group labels so that their leaders stack and overlap. For more information, see Group Selected Labels (on page 300). (P2 CP:265171)
- To edit the volume of a drawing, the values for Volume growth into drawing and Volume growth out of drawing can be positive or negative. For more information, see Associate Objects to View Command (on page 276). (P2 CP:277031)
- You can now customize the shortcut menu on a folder in the Management Console. For more information, see New Command (on page 37). (P2 CP:278905)
- You can now update all drawings by rule documents with the Full Update action in Intergraph Smart Batch Services. For more information, see Full Update Action. (P1 CP:160700) (P3 CP:199390)
- Drawing by Rule view properties only display marine mode rule set styles. For more information, see View Tab (Drawing View Properties Dialog Box - Drawings View Explorer) (on page 262). (P2 CP:215229)
- Removed the Workspace Explorer from the View menu. For more information, see View Menu (on page 29). (P3 CP:278904)
- In ruleset views, if you change the view style before editing View Offset for the first time, View Offset displays the offset value as defined in the .xml template of the view style. For more
What's New in Drawings and Reports

- **Orthographic Drawings**
  - You can now associate manually placed objects to graphic views. For more information, see Associate Graphics to Graphic View Command (on page 341). (P2 CP:247816)

- **Piping Isometric Drawings**
  - You can now associate manually placed objects to graphic views. For more information, see Associate Graphics to Graphic View Command (on page 341). (P2 CP:247816)

**Version 2014 R1 (10.1)**

**Drawings (General)**

- Manual edits to the .xml files are no longer required when editing label rules. Instead, the new Label Rule Manager functionality allows you to modify label rules and the properties of label templates. For more information, see Label Rule Manager. (P2 CP:207541)

- You can now save all the sheets of a document as individual files at the same time. For more information, see Save As Command (on page 65). (P2 CP:232309)

- The Imported Folder command imports external files into the model. For more information, see Imported Folders (on page 192). (P3 CP:51619)

- The Fix Sector Size of Documents custom command adjusts drawing sector size from small to large. For more information, see Custom Commands (on page 223). (P4 CP:227654)

**Orthographic Drawings**

- Added information for using the Cut command, which moves a drawing, a component, or a folder from one location and paste it at another location. For more information, see Cut Command. (P1 CP 55697)

- The behavior of the Copy and Paste commands have changed. For more information, see Copy Command (on page 35), Paste Command (on page 40), and Paste Special Dialog Box (on page 41). (P1 CP:55697)

- The Angle for Target Evaluation property defines the allowable angle from the view plane for a target plate. For more information, see View Tab (Drawing View Properties Dialog Box) (on page 256) (P2 CP:239203)

- Highlight Annotations and Clear Manual Edits commands are available on the Drawings Compose toolbar. For more information, see Highlight Annotations Command (on page 339) and Clear Manual Edits Command (on page 341). (P2 CP:255949)

**Piping Isometric Drawings**

- Two new isometric options, ExcludeNuts and ExcludeWashers, specify if nuts and washers display in the Material List. For more information, see Material List Options (S3D) (on page 666). (P3 CP:232872)
A note to clarify the way in which ISOGEN distinguishes between fixed length pipe and variable pipe has been added. For more information, see FixedPipeAccumulation in Material List Options (on page 550). (P3 CP:240683)

The TreatTapsOnPipeAsTeeStubs option controls how the software manages taps on pipe during isometric drawing generation or the creation of a piping component file (PCF). For more information, see Content (S3D Drawing) (on page 655). (P2 CP:249162)

Reports

- Added the trench run report. For more information, see Trench Run Report (Civil). (P2 CP:259491)
S E C T I O N  1

Drawings and Reports

The Intergraph Smart™ 3D Drawings and Reports task creates orthographic drawings (by a variety of methods), isometric drawings, and reports from the model. When the 3D model changes, you can update your drawings and reports.

The Drawings and Reports task is also responsible for publishing your drawings and reports. When your model is registered using the SmartPlant Registration Wizard, you can publish volume and composed drawings, orthographic drawings, isometric drawings, and reports. You can also publish 3D model data using the 3D Model Data component.

The Management Console organizes the different document types into a customizable hierarchy. Using the component functionality of the console, you can create, edit, update, print, save, and publish the deliverables. This hierarchy of components and documents is also available in many of the 3D tasks, such as Common, by using the Tools > Drawing Console command. You can perform nearly all of your document operations using this command. For more information, see the Common User’s Guide.

Before you can create components for drawings and reports, your administrator must organize the Management Console hierarchy with folders for each component type. Then, the administrator must complete several setup steps, including setting up drawing and report templates, creating view styles, creating appropriate filters, and specifying isometric drawing options. Default templates and view styles are delivered with the software, and you can customize them to suit your needs.

It is possible to customize templates and view styles before any objects exist in the model. However, to create drawings and reports, objects must exist in your model. For example, if you want to generate isometric drawings, you must have piping in your model.

Composed Drawings

Composed drawings are orthographic drawings created in a 3D task such as Common. The composed drawing component, available in the Drawing and Reports task Management Console, manages the composed drawings you create. Composed drawings are flexible, allowing you to have views that are managed by a drawing region and associate the views to volumes and other views.

Volume Drawings

Volume drawings are useful for creating general arrangement or construction drawings of areas within the model. In the Volume Drawing workflows, you or your administrator must create or edit border templates. You can place drawing property labels in the title block of the template to fit your company or project. You also must configure the view styles, which are sets of rules that determine how the graphics in the three-dimensional model are represented on the drawings. View styles use filters. You can create a folder of drawing filters, with new, existing, and future filters for each discipline. You place drawing volumes in the Space Management task. You can publish Volume drawings when they are up-to-date.
Orthographic Drawings by Query

The Orthographic Drawing by Query component, in conjunction with the Drawings by Query Manager component, creates drawings in mass by specifying a filter-based query to collect objects for drawings. This drawing type is appropriate for creating detail drawings of particular objects within the model. They are especially useful when creating drawings that use the same style or format for large numbers of similar objects, such as hangers or supports.

Just like composed and volume drawings, you can print, update, save into MicroStation J (V7) or AutoCAD formats, or publish Orthographic Drawings by Query. When you publish Orthographic Drawings, a viewable graphic file is created; no physical data is published.

Piping Isometric Drawings by Query

Like Orthographic Drawings by Query, you create Piping Isometric Drawings by Query by specifying a filter-based query to collect the objects. The workflow requires that you create or edit border templates to fit your company or project. You or your administrator also must set the isometric options for each of the isometric styles that you need in your project.

When you publish Piping Isometric Drawings by Query, they are published as viewable graphics; no physical data is published.

Reports

In the Spreadsheet Reports workflow, you create report templates, which control the content and format of reports. The default file format of reports in the software is Microsoft Excel® format. The Report Template Editor provides the ability to configure your reports to use queries and special formatting.

You can publish Spreadsheet Reports just like drawings. However, the Spreadsheet Reports are published as Excel spreadsheets; no physical data is published.

NOTES

- Microsoft Excel 2003 is the minimum supported version for the Drawings and Reports task.
- Microsoft Excel 2007 has a file format and extension of .xlsx. However, the delivered report templates still use the old .xls extension. If you create a report template with the .xlsx extension, only machines with Excel 2007 will be able to handle (edit, update, or open) the report. If you attempt to open an .xlsx file with an older version of Excel, an error message appears stating that the file is not compatible with the version of Excel.
- If you use Office 2003, in Microsoft Excel under Tools > Macro > Security > Trusted Publishers tab, check the Trust Access to Visual Basic Project option.
- If you use Office 2007 and Office 2010, click the Microsoft Office button to open Excel Option. Go to the Trust Center category and select the Trust Center Settings button. Select the Macro Settings category and check Trust access to the VBA project object model.
- For more information about Microsoft Office and service packs, refer to the Microsoft web site (http://www.microsoft.com/).
Delivered Drawing Types

The delivered drawing types are drawing templates that include drawing borders, documentation annotation, note areas, and selection and resymbolization criteria.

Several drawing types are delivered and fully designed to meet particular drawing requirements. You can use the delivered types to create new drawing types and to modify the view styles or border templates as needed. You can copy a template from an existing drawing or you can copy volumes only, allowing you to create multiple drawings with the same border graphics. To copy a drawing type component, select the item on the Management Console hierarchy, and then select Copy. To paste the item, right-click a location in the hierarchy or in the Detail View and select Paste.

All of the delivered drawing types provide customizable templates and view styles. The delivered Equipment Plan drawing type is provided as an example below:

- The Equipment Plan is a single view drawing plan. It includes the location of equipment, structural columns, building walls, equipment steel, vessel and mechanical steel, and roads.
- The Equipment Plan includes general information for coordinate systems, sheet scales, and modifications. The drawing border provides the border graphics, title block graphics, and the title block labels.

The document annotation includes the following:

- **North Arrow** - Indicates the orientation of the model. The large symbol is used, which is typical for single view drawings. The north arrow is placed on each drawing view. Click and drag the symbol to position it within the Note Area if required.
- **Key Plan** - Shows the geographic position of the single grid relative to the rest of the grids of the same type in the single block.
- **Drawing Notes** - Shows the collection of notes, which consists of general notes applicable to all drawings, notes applicable to a discipline, notes applicable to a category of drawings, and notes specific to a single drawing (such as an element or a border report).

**Note Area**

The Note Area is used to display drawing notes and key plans. The note area on the Equipment Plan is five inches on the right-hand side of the drawing border. This area extends from the top of the border down to the top of the title area border. The Note Area is optional, and is not a required element in the template.

**View Regions**

The View Region defines the drawing view arrangements. The Equipment Plan defaults to a single view with a five-inch Note Area and one-inch margins around the drawing view.

**Drawing View**

The Equipment Plan is a single view plan. The following specifications are set:

- **Direction** - Set to Plan view (Looking Plan).
Delivered Drawing Types

- **Rotation** - Depends on the volume type and the Coordinate System defined, based on the grid section's X and Y size. For example, a volume placed by four points in the Space Management task will rotate the view.

- **Scale** - Set to 1/4" = 1' or 1 = 50.

- **North Arrow** - One symbol included per drawing view. Click and drag the symbol to the Note Area.

- **Annotation** - The plan uses *matchline labels* to indicate the appropriate coordinate of that segment of the grid boundary along with continuations. The *matchlines* are lines that outline the boundaries of a grid by following the exterior boundaries of the collection of sectioning elements defining the grid represented in the view.

- **Drawing Volumes** - The drawing volume is the queried 3D volume in the model.

**View Styles**

The view style specifies the object filters included in the drawing if present in the queried 3D volume. It specifies how objects are displayed, including graphical representation, labeling, and dimensioning. In the **Equipment Plan**, the volume and composed drawing view style definitions are the same.

**Title Blocks**

The title block generally displays at the bottom of a drawing template. It can include signatures, revision and issue information, and other properties associated with the drawing.

You can add drawing properties to the title block using the **Place Drawing Property Label** command when editing a template.

**See Also**

*Isometric Drawing Styles* (on page 107)

*Place a Drawing Property Label on a Template* (on page 355)
SECTION 3

Interface Overview

This task includes different windows or views within its interface. You can toggle the display of these windows using commands on the View menu. For more information, see View Menu (on page 29).

The Management Console contains a hierarchy of folders and components that you create. If you right-click an item in the Management Console, the available menu commands vary, depending on the item and your permissions. For more information on managing folders and components in the Management Console, see Shortcut Menus (on page 34).

The Detail View shows the children of the selected item in the Management Console. You can select multiple components or documents by pressing Ctrl or Shift while selecting. To specify the columns in the Detail View, right-click a column heading and click More. The Detail View is overlaid by other windows depending on the current operation. For example, when reviewing drawings using the Open command, a 2D viewer appears. When you edit report templates, a tabular editor appears. For more information on setting the appearance of the Detail View, see Detail View (View Menu) (on page 30).

The Workspace Explorer is the tabbed view of systems, assemblies, spaces, and Work Breakdown Structure (WBS) items in the software. For more information about the Workspace Explorer, see the Common User's Guide available from the Help > Printable Guides command in the software.

NOTE Another window you use while working in this task is the SmartSketch Drawing Editor window, which appears as a separate application window. It allows you to edit border templates, drawing templates, and backing sheets for all types of drawings.

See Also
Menus and Toolbars (on page 26)
Icons for Components and Drawings (on page 26)
Permissions Overview (on page 28)
Menus and Toolbars

In this task, the commands available change according to the active window, selected Management Console or Detail View item, and the specific workflow.

For example, when you edit a drawing template or open a drawing, you control the template with SmartSketch Drawing Editor. You use SmartSketch Drawing Editor menus and toolbars to edit the open drawing template. When you edit report templates, the report menus and commands are available.

In addition, the shortcut menu that displays when you right-click an item in the Management Console or in the Detail View differs according to the type of item. For example, some of the commands on the shortcut menu for a piping isometric drawing are different from the commands on the shortcut menu for a composed drawing component.

For the root node of the Management Console hierarchy and Folder items that have no child items beneath them, the shortcut menu includes Batch..., Copy, Paste, Delete, Rename, New..., Save Package..., and Properties. If there are any child items beneath the root node or beneath the selected folder, the following commands are added: Create Drawing(s), Refresh, Run Query, Update Now, Print, and Save As. If you are registered with SmartPlant Foundation, the Publish and Revise commands are added as well.

Also, keep in mind that the main menu bar available in the application varies by task. Some commands available in other tasks may not be available in this one.

See Also
Interface Overview (on page 25)
Detail View (View Menu) (on page 30)

Icons for Components and Drawings

The Management Console and Detail View display different icons to show the type and status of packages, components, and documents.

Drawing Type Icons

- Root of the model hierarchy
- Folder
- Search folder
- Imported folder
- Query manager
Interface Overview

- Generic module folder
- Volume Drawing component
- Composed Drawing component
- Orthographic Drawing component
- Piping Isometric Drawing component
- Spreadsheet Report component
- 3D Model Data component
- MicroStation 3D DGN drawing component
- Package of drawing components (in the Add Component dialog box)
- Drawing document. A status icon is always superimposed over this icon.

Document Status Icons

These icons appear superimposed on the document icon and indicate document status.

- Submitted or scheduled for batch processing. These documents are either submitted or scheduled for batch processing.
- Updating or publishing. A document also displays this icon if an error occurred and forced the machine to end the update process before it completed. Right-click the drawing document, and select View Log for more information, or update the document again.
- Out-of-date. This document has been altered in SmartSketch Drawing Editor or the drawing properties have been changed. A document is not marked out-of-date if the 3D model has been changed. For example, changing the view style of a drawing view causes the document to be out-of-date, while moving a pump in the 3D model does not affect the drawing status (unless a Refresh is performed). A change must be made to the drawing properties or inside the drawing in order for it to be marked out-of-date without a Refresh.
- Up-to-date. This document is an accurate representation of the 3D model based on the last update performed. If an object in the 3D model that is included in the drawing view has been moved inside the 3D environment, the document is still up-to-date unless Refresh is performed.
- Error status. An error has occurred during the update process. Right-click the drawing, and select View Log for more information.
- No graphic objects in the model associated with this drawing document. For example, the drawing is a Piping Isometric Drawing document created from a Pipeline System that has no piping parts associated with it.
- The drawing document is a version 6.1 legacy Snapshot drawing. You should use the Tools > Convert Legacy Snapshots command to convert this document to a Composed Drawing for use in the current version of the software. If you do not convert the legacy snapshot drawing, you cannot perform edit operations on the drawing, including update, revise, and publish.
Permissions Overview

Your site administrator sets permissions and creates permission groups in the Project Management task. These permissions are used in the different tasks in the software to control user access.

You can see your current permission group in the dropdown box in the upper left-hand corner of the window when in the Drawings and Reports task.

The permission group to which an item belongs can affect the actions allowed against that item. For example, the propagation of properties down the hierarchy, from parent to child, is interrupted when a node or document in a read-only permission group is encountered.

The following list shows the actions relating to drawings and reports that are affected by permission groups:

- Accessing shortcut menu commands in the Management Console and Detail View
- Creating items, such as drawings, drawing views, and drawing volumes
- Propagating properties down through the hierarchy
- Deleting items
- Updating items, such as re-extracting drawings

In addition, access to the SharedContent share on the server computer affects actions such as creating and editing view styles and graphic rules.

See Also

- Interface Overview (on page 25)
- Menus and Toolbars (on page 26)
SECTION 4

View Menu

Management Console (View Menu)

Toggles the display of the Management Console. By default, the Management Console is visible when you enter this task.

The Management Console contains a hierarchy of folders and components that you create. If you right-click an item in the Management Console, the available menu commands vary, depending on the item and your permissions. For more information on managing folders and components in the Management Console, see Shortcut Menus (on page 34).

**NOTE** When you switch to a different task and then return to the Drawings and Reports task, the Management Console remembers the node you last selected on the console hierarchy.

See Also

Interface Overview (on page 25)
Detail View (View Menu) (on page 30)
Refresh (View Menu) (on page 33)
Detail View (View Menu)

Turns the display of the Detail View on and off. This command is located on the View menu. When checked, the Detail View is visible in the application window. When you right-click folders or documents in the Detail View, shortcut menus display. The items on the shortcut menu vary depending on the selected item. For more information on the commands, see Shortcut Menus (on page 34).

To modify the headings in the Detail View, right-click the column-heading area. Select More on the shortcut menu to display the Column Settings dialog box.

See Also
Specify columns in the detail view (on page 30)
Column Settings Dialog Box (on page 32)

Specify columns in the detail view

1. Right-click a column heading in the Detail View. The shortcut menu shows the currently displayed columns with a checkmark ✔.

2. Add and remove columns automatically by checking and unchecking them on the shortcut menu.
3. To modify the appearance and order of the columns, click **More** on the shortcut menu.

![Column Settings dialog box]

Select the columns you want to see in the Detail View. Use the Move Up and Move Down Buttons to reorder the columns.

4. On the **Column Settings** dialog box, select the columns you want to include in the **Detail View**. Clear, or uncheck, the ones you do not want to include. You can also use the **Show** and **Hide** buttons to add and remove columns.

5. To change the order of the columns, click **Move Up** and **Move Down** on the **Column Settings** dialog box.

6. Specify the width of a column by selecting it and typing an integer in the **Width of selected column** box. You can also resize columns by dragging the edge of the column in the **Detail View**.

**See Also**

* Interface Overview (on page 25)*  
* Management Console (View Menu) (on page 29)*  
* Refresh (View Menu) (on page 33)*  
* Menus and Toolbars (on page 26)*  
* Column Settings Dialog Box (on page 32)*
Column Settings Dialog Box

Specifies the columns you want to see in the Detail View. You also can specify the order and width of the columns. You access this dialog box when you right-click in the column heading area of the Detail View and select More on the shortcut menu.

Move Up
Moves the selected column up one position. The column displays one position to the left in the Detail View.

Move Down
Moves the selected column down one position. The column displays one position to the right in the Detail View.

Show
Displays the column in the Detail View.

Hide
Hides the column in the Detail View.

In addition to the Show and Hide commands, you can use the checkboxes beside the column names to add and remove them from the Detail View. Checked indicates that the column displays in the Detail View.

Width of selected column
Specifies the width of the column in pixels. You can specify a different column width for each column.

See Also
Interface Overview (on page 25)
Detail View (View Menu) (on page 30)
Management Console (View Menu) (on page 29)
Refresh (View Menu)

Updates the loaded (expanded) content of the Console hierarchy, when others are concurrently adding folder, components, or drawings to the hierarchy. The entire hierarchy does not refresh unless you have all the nodes completely expanded. You can also press F5 to update the content.

See Also
Shortcut Menus (on page 34)
Interface Overview (on page 25)
Detail View (View Menu) (on page 30)
Management Console (View Menu) (on page 29)
SECTION 5

Shortcut Menus

When you right-click nodes in the Management Console and nodes or documents in the Detail View, shortcut menus display. The items on the shortcut menu vary depending on the selected item.

Root Shortcut Menu
Folder Shortcut Menu
Component Shortcut Menu
Drawing Document Shortcut Menu

NOTES

- By default, the Management Console and Detail View display when you enter the task. You can turn the views on or off on the View menu.
- When you switch to a different task and then return to the Drawings and Reports task, the Management Console remembers the node you last selected on the console hierarchy.
- If you are registered with SmartPlant Foundation, the Publish and Revise commands are added as well. You can also set up batch printing and updating for documents using the Batch commands available on the shortcut menus.

See Also
Components Overview (on page 84)
Copy Command

Copies a drawing, component, or folder. After you copy an item, you can paste it at another location in the hierarchy.

The software enforces the following rules regarding pasting:

- If you copy a drawing, select a component to use the Paste command. You cannot paste a drawing to a folder or under the drawing book.

  **NOTE** You can copy only the composed drawings and Drawing by Rule drawings.

- If you copy a composed drawing and paste it on a Composed Drawing component, the Paste Special dialog box is displayed. This dialog box gives you the option to paste the drawing with or without the volume associated with the view. For more information, see Paste Special Dialog Box (on page 41).

  **NOTE** The Paste Special dialog box is displayed for a composed drawing only if it is copied for drawings containing views with associated volumes.

- If you copy an application component, select a folder to use the Paste command. You cannot paste an application component under the drawing book.

- If you copy a folder, select a folder or a drawing book to use the Paste command.

- If you copy a volume or a MicroStation 3D DGN drawings component with a template or a drawing volume associated with it, the Paste Special dialog box is displayed if you paste the component in another volume or a MicroStation 3D DGN drawings component. This dialog box gives you the following options to paste: 1) only the template, (2) only the volume, or (3) both the template and the volume. The volume associated with the current volume drawings component being pasted, is copied and associated with the new volume drawings component. For more information, see Paste Special Dialog Box (on page 41).

  **NOTE** A component cannot be pasted under another component.

Copy an item

1. Select an item in the Management Console hierarchy or Detail View.
2. Right-click the item, and then select Copy on the shortcut menu.

  **NOTE** You can paste the copied item at another location in the Management Console hierarchy. For more information, see Paste an item (on page 41).

**See Also**

Shortcut Menus (on page 34)
Components Overview (on page 84)
Create Drawing(s) Command

Generates the drawings that have not previously been created. This command is available on the right-click menu for various items in the Management Console hierarchy.

If you select the top-level of the hierarchy, this command generates all drawings not already created for all components in the hierarchy. For example, if you have Volume Component drawings that have not been created and Isometric drawings that have not been created, both are created if you right-click the top-level hierarchy and select Create Drawing(s).

You can also right-click individual components or folders for which drawings are not yet created and select Create Drawing(s) on the shortcut menu to generate the drawings.

After you create drawing documents, you update them to include model object content. You can then open or edit them as needed.

See Also
Updating Documents (on page 75)
Shortcut Menus (on page 34)
Run Query (Shortcut Menu) (on page 97)

Delete Command

Removes an item and its sub-items from the hierarchy and the database. You access this command on the right-click menu for any node or document in the hierarchy. Undo is not available for this action. Upon deletion, a confirmation message displays.

When you delete a drawing, its associated template and its component remain unchanged. Any associated physical volumes are deleted.

You can delete many items that are directly or indirectly related to this task:

- Components in the Management Console hierarchy
- Documents
- Drawing volumes
- Drawing views

In some cases, deleting an item causes other items to be deleted. For example, when you delete a drawing volume, associated views are deleted. When you delete a drawing view in a generated drawing, associated volumes and documents are deleted.

In addition, the item status and your permissions can affect whether or not you can delete the item. A drawing set to Approved cannot be deleted. However, you may be able to delete a drawing set to Working.

NOTE You can select multiple components or documents in the Detail View and use the Delete command from the right-click menu to remove those items.
Delete an item

1. Right-click a folder component, document, drawing volume, or drawing view.
2. On the shortcut menu, click **Delete**.

**WARNING** You cannot undo a delete operation.

**NOTE** The **Delete** command propagates down the hierarchy. For example, if you delete a volume component, its child components (if any) and all the drawings contained in the components are deleted as well. However, when you delete a single volume drawing, the associated template, volume, and component remain unchanged. You can update the drawing component to re-create the drawing.

**See Also**
*Shortcut Menus* (on page 34)
*Components Overview* (on page 84)

**Edit Command**

Activates the selected drawing for editing. This command is available on the right-click menu for a drawing in the **Detail View**. The drawing opens in **SmartSketch Drawing Editor** with additional commands or toolbars available for editing the drawing.

Objects like drawing views, key plan views, report views, and drawing property labels are placed on the **DwgTemplate** layer when you save the drawing document. You should not place manual markups on the **DwgTemplate** layer. If you use native **SmartSketch Drawing Editor** commands (such as **Place Line** or **Place Dimension**) to add manual markups to the template, put them on the **Default** layer or on a layer that you define (for example, a layer named **AnnotationLayer**). This preserves the changes when you update drawings. For more information on layers, see **Layers (SmartSketch Drawing Editor Tools Menu)** (on page 373).

Your access permissions, defined in the Project Management task, affect whether or not you can edit documents.

**New Command**

Adds a new folder, a search folder, an imported folder, or a component to the **Management Console** hierarchy. Select the model root or a folder and right-click to select **New**. If you select the model root, **New** creates a folder, a search folder, or a folder containing a set of drawing components. If you select a folder, **New** creates a folder, a search folder, an imported folder, or a drawing component.

**Search Folders** (on page 187)
**Imported Folders** (on page 192)
**Components Overview** (on page 84)
Shortcut Menus

If you have previously created a package, the package is available in the Add Component dialog box to add a component to the hierarchy. For more information, see Save Package Command (on page 73).

You can configure the shortcut menu for a folder to display more New options. For more information, see Configure New Command on a Folder in the Smart 3D Drawings and Reports Reference Data Guide.

Add Component Dialog Box (on page 39)

What do you want to do?

- Add a folder (on page 38)
- Add a package of components (on page 38)
- Add a component (on page 39)

Add a folder

1. Right-click the root model in the Management Console hierarchy, and select New > Folder. The folder is added to the hierarchy.
2. To rename the folder, right-click the folder, and select Rename, or select the folder, and press F2 on the keyboard. Type a new name.

   NOTES

   - You can place another folder under a folder in the hierarchy.
   - You can place a folder, application component, or a package under a folder in the hierarchy. For example, you can add a Piping Isometric Drawings by Query component to a folder.
   - You cannot add folders or other components to a search folder component. For more information, see Search Folders (on page 187).

Add a package of components

1. Right-click the root model in the Management Console hierarchy, and select New.
2. On the shortcut menu, click More to open the Add Component dialog box, and select a package " for a set of related components. For more information, see Add Component Dialog Box (on page 39). A folder and components are added to the hierarchy.
3. To rename the folder or a component, right-click and select Rename on the shortcut menu, or press F2 on the keyboard.

   NOTE Right-click a component to access the available commands for that component.
Add a component

1. In the **Management Console**, create a folder or select an existing folder.
2. Right-click the folder, then select **New**.
3. On the shortcut menu, select a component such as **Composed Drawings** or **Orthographic Drawings by Query**, or click More to open the **Add Component** dialog box and select a component. For more information, see **Add Component Dialog Box** (on page 39).
   
   *The component is added to the folder.*
4. To rename the component, right-click the component, and select **Rename**, or select the component, and press F2 on the keyboard. Type a new name.

   **NOTES**
   - Right-click a component to access the available commands for that component.
   - You cannot add folders or other components to a search folder component. For more information, see **Search Folders** (on page 187).

Add Component Dialog Box

Lists the available packages and folder types you can use to create folders and drawing components at the selected level in the **Management Console** hierarchy. You access this dialog box when you right-click a folder or the model root, and select **New > More**.

Packages are organized in tabs by drawing type. Select a tab, and then select a package to view its description.

**NOTE** Many packages are delivered with the software. Your catalog administrator can add new tabs and packages to the dialog box using the **Save Package Command**. For more information, see **Save Package Command** (on page 73).

**See Also**
- **Components Overview** (on page 84)
- **Delivered Drawing Types** (on page 23)
- **Icons for Components and Drawings** (on page 26)

Open Command

Opens the selected document for viewing within this task. This command is available on the shortcut menu for all document types except 3D Model Data. You also can open the document by double-clicking it.

**NOTE** Opening a MicroStation 3D DGN document requires that the MicroStation J (V7) application be loaded on the workstation.
Open a document

1. In the Detail View, double-click a document. You can also right-click the document, then select Open.

2. Close a document by clicking File > Exit.

**NOTE** To edit the document, right-click the document, then select Edit. If the document is a drawing, you can annotate it.

**See Also**
- Open Command (on page 39)
- Shortcut Menus (on page 34)
- Components Overview (on page 84)

Paste Command

Inserts the contents that you last copied or cut into the hierarchy or, creates a copy of a drawing volume, depending on the component that you have selected. You must copy or cut an item using the Copy or Cut command before you can paste it.

The software enforces the following rules regarding pasting:

- If you copy or cut a drawing, select a component to use the Paste command.

**NOTES**
- You can copy only the Composed or the Drawing by Rule drawings.
- You can cut only the composed drawings.

- If you paste a composed drawing on a Composed Drawings component, the software displays the Paste Special dialog box. This dialog box gives you the option to paste the drawing with or without the volume associated with the view. For more information, see Paste Special Dialog Box (on page 41).

**NOTE** The Paste Special dialog is displayed only for the composed drawings if it is copied for the drawings containing views with associated volumes.

- If you copy a folder, select a folder or a drawing book to use the Paste command. You cannot paste a folder to an application component. Application components cannot have a folder below them in the hierarchy.

- If you copy an application component and the Paste command is selected on a folder, the copied application component is pasted under the folder.

- If the application component you copy is a volume drawing or a MicroStation 3D DGN component, and if the component has a template or a drawing volume associated with it, the Paste Special dialog box is displayed. The dialog box gives the option to paste the component with or without the template or the volume of that component.

- If you copy a volume drawings component with a template or a drawing volume associated with it and paste it in another volume drawings component, the software displays the Paste Special dialog box. This dialog box gives you the following options to paste: (1) only the template, (2) only the volume, or (3) both the template and the volume. For more information, see Paste Special Dialog Box (on page 41).
If you copy a MicroStation 3D DGN component with a drawing volume associated with it, the software displays the **Paste Special** dialog box if you paste onto another MicroStation 3D DGN component.

**Paste Special Dialog Box (on page 41)**

**Paste an item**

Before pasting an item, you must copy or cut the item using the **Copy** or the **Cut** command. For more information, see *Copy an item* (on page 35) and *Cut an item*.

1. Select a location in the **Management Console** hierarchy or **Detail View**.
2. Right-click the location, and click **Paste**.

   *The software pastes the item under the selected location.*

**See Also**

*Shortcut Menus (on page 34)*

*Components Overview (on page 84)*

**Paste Special Dialog Box**

Specifies the items to paste if you copied a volume drawing or MicroStation 3D DGN component that has a template or drawing volume defined. The options provided to you depend on the component selected.

If you are pasting a hierarchy containing one or more volume drawings or MicroStation 3D DGN components into a folder, you can select one of the following options:

- **Copy Nodes(s), Template(s), and Volume(s)** - Inserts the new components, including their respective template and drawing volumes, under the selected folder.
- **Copy Node(s) and Template(s)** - Inserts the new components, including their respective templates, under the selected folder.
- **Copy Node(s) Only** - Inserts the new components under the selected folder.

If you are pasting a volume drawings component onto another volume drawings component, or a MicroStation 3D DGN component onto another MicroStation 3D DGN component, you can select one of the following options:

- **Copy Template(s), and Volume(s)** - Copies the template settings and drawing volumes to the selected component.
- **Copy Template(s) only** - Copies only the template settings to the selected component.
- **Copy Volumes(s) only** - Copies only the drawing volumes to the selected component.

If you are pasting a composed drawing on a Composed Drawing snap-in, the following options are available:

- **Drawing(s) only** - Copies only the drawing and its views
- **Drawing(s) and Associated Volume(s)** - Copies the volume associated with the view along with the drawing.

**See Also**

*Paste Command (on page 40)*
**Print Command**

Sends a print request for the selected documents to the default printer. This command is not available until you have created and updated documents.

**What do you want to do?**
- Print a document (on page 42)
- Print a document as a PDF file (on page 42)

---

### Print a document

1. To specify a printer, select **File > Select Printer**. For more information on selecting a printer, see **Select Printer (File Menu)** (on page 43).
2. Select a folder, application component, or the root node in the **Management Console** to print all of the drawing and report documents beneath the selected level. You can also select a single document or multi-select documents in the **Detail View**. You can select multiple documents to print by pressing **Ctrl** or **Shift** and then clicking each document in the **Detail View**.
3. Right-click and select **Print** on the shortcut menu.

You can also use the **Batch > Print** command on the item’s shortcut menu to print the item using a scheduled batch job. For more information, see **Batch Print** (on page 208).

### Print a document as a PDF file

1. To specify a printer, select **File > Select Printer**. For more information on selecting a printer, see **Select Printer (File Menu)** (on page 43).
2. Select **SmartPlant PDF Converter 4xx** as the printer.
3. Select a folder, application component, or the root node in the **Management Console** to print all of the drawing and report documents beneath the selected level. You can also select a single document or multi-select documents in the **Detail View**. You can select multiple documents to print by pressing **Ctrl** or **Shift** and then clicking each document in the **Detail View**.
4. Right-click and select **Print** on the shortcut menu.

You can also use the **Batch > Print** command on the item’s shortcut menu to print the item using a scheduled batch job. For more information, see **Batch Print** (on page 208).
Select Printer (File Menu)

Specifies a printer for documents. The command lists all printers available to your computer.

**NOTES**
- To print a drawing as a PDF, select *SmartPlant PDF Converter 4xx* as the printer.
- *SmartPlant PDF Converter 4xx* requires special settings for 64-bit versions of Windows. For more information, see *Configure SmartPlant PDF Converter for Windows* (on page 43).

*Select Printer Dialog Box* (on page 43)

Configure SmartPlant PDF Converter for Windows

Smart 3D installs *SmartPlant PDF Converter 4xx*, a printer driver used to convert drawings and reports to PDF files. Special settings are needed for this driver.

**Windows 7**

1. Open *Start > Control Panel*
   
   *The Control Panel* displays.

2. In the *Hardware and Sound* section, click *View devices and Printers*.

3. Right-click *SmartPlant PDF Converter 4xx* and select *Printer properties*.
   
   *The SmartPlant PDF Converter 4xx Properties dialog box* displays.

4. On the *Advanced* tab:
   - Select *Spool print documents so program finishes printing faster*.
   - Select *Start printing immediately*.
   - Clear *Enable advanced printing features*.

5. Click *OK*.

Select Printer Dialog Box

Specifies a printer for documents.

**Name** - Specifies a printer name.

**Status** - Displays the current status of the specified printer.

**Type** - Displays the type of printer.

**Where** - Displays the port or location the printer uses.

**See Also**

*Components Overview* (on page 84)

*Print a Document* (on page 42)
Setting Properties

The software updates properties from parent nodes to child nodes and drawings in the Management Console hierarchy.

For example, you can display the Properties dialog box for a folder named Isometric Drawings. If you set the Division Location property to Huntsville, Alabama, the software pushes this value to the items contained within the Isometric Drawings folder.

You can specify inheritance for each item on its Properties dialog box. If you set the override flag for a property, the property is not inherited from the parent. You can provide a new, overriding value for the property. This new value then propagates to other items deeper in the hierarchy.

Properties and Publishing

Several document properties impact publishing the document. Before you can publish documents in the software, you must configure your computer. The configuration includes installing the SmartPlant Client and SmartPlant Schema Component and registering through the SmartPlant Registration Wizard. For more information about the SmartPlant Registration Wizard, see the Intergraph Smart™ 3D Installation Guide, available from Help > Printable Guides.

Even if you have registered your model using the SmartPlant Registration Wizard, you must set certain properties to enable the publishing capability. Properties that control publishing are found on the WBS Tab. For more information, see Set properties for publishing documents (on page 396).

NOTES

- The software considers blanks or cleared values as override flags.
- If the drawing document you are looking at in the Detail View has a yellow icon (for example: ![Icon](image)), the drawing document is a version 6.1 legacy Snapshot drawing. You should use the Tools > Convert Legacy Snapshots command to convert this document to a Composed Drawing for use in the current version of the software. If you do not convert the legacy snapshot drawing, you cannot perform edit operations on the drawing, including update, revise, and publish.

See Also

Edit document properties (on page 45)
Properties Command (on page 45)
Properties Command

Views and edits properties for the selected document. The properties of child items are inherited from the parent item unless you set the Override column for the properties.

Properties Dialog Box (on page 46)

What do you want to do?

- Edit document properties (on page 45)
- Set surface styles and aspects for 3D model data documents (on page 45)
- Set properties for publishing documents (on page 396)

Edit document properties

1. In the Management Console or Detail view, right-click an item in the hierarchy, and select Properties on the shortcut menu.

   The Properties dialog box displays.

2. Change the properties as needed. For example, you can set the coordinate system for the drawing on the Style tab or view the current approval information on the Signature tab.

   NOTES

   - If you do not want an item to acquire a property from its parent, select the Override column on the Properties dialog box and type a new value. This value propagates to other items deeper in the hierarchy.
   - The software treats blank or cleared property values as overrides.

Set surface styles and aspects for 3D model data documents

Surface Style Rules and Aspects must be set on each 3D Model Data document before updating it using the Update Now or Batch > Update command.

1. Select one or more 3D Model Data documents.

2. Right-click the selected documents, and select Properties on the shortcut menu.

   The Properties dialog box displays.

3. Go to the Surface Styles and Aspects tab to add surface style rules to the selected rules list. You can also import the surface styles used in the session file. For more information, see Surface Styles and Aspects Tab (Properties Dialog Box) (on page 53).

4. Click Select Aspects to specify the aspects used within the 3D Model Data documents. If you select no aspects for your documents, the Simple Physical aspect is automatically applied by default. For more information, see Select Aspects Dialog Box (on page 54).

5. Click OK on the Properties dialog box to save the changes to the document(s).
Now you can update the drawing documents using the Update Now or Batch > Update command to incorporate the surface styles and aspects with the 3D Model Data.

Use a Search Folder to Collect 3D Model Data Documents for Property Update

You can create a Search Folder that filters for the 3D Model Data documents so you can edit their surface style rule and aspect settings collectively. When you setup the Search Folder, use a filter that looks for the SmartPlant Review Output objects. You could additionally specify properties on the output objects to further narrow the search criteria, such as Data Created, Date Last Modified, or Signature. For more information, see Search Folder Filters (on page 189).

Properties Dialog Box

Sets options for items in the Management Console hierarchy. All items in the Management Console have a Properties command on their right-click shortcut menus. Using the Properties dialog box, you can control how you want properties to propagate through the hierarchy.

You can specify labels for some of the properties on the tabs. Click the browse button at the right of the table cell to display the Choose Label dialog box.

- General Tab (Properties Dialog Box) (on page 47)
- Title Area Tab (Properties Dialog Box) (on page 47)
- Signature Area Tab (Properties Dialog Box) (on page 50)
- Style Tab (Properties Dialog Box) (on page 51)
- Surface Styles and Aspects Tab (Properties Dialog Box) (on page 53)
- Custom Tab (Properties Dialog Box) (on page 58)
- Notes Tab (Properties Dialog Box) (on page 59)
- Issue Tab (Properties Dialog Box) (on page 60)
- Revision Tab (Properties Dialog Box) (on page 61)
- WBS Tab (Properties Dialog Box) (on page 62)
- Configuration Tab (Properties Dialog Box) (on page 63)

NOTES:

- The WBS tab is available only if you have registered your model using the SmartPlant Registration Wizard.
If your model has not been registered using the SmartPlant Registration Wizard, the Issue tab is always available. If your model has been registered, the Issue tab is available only if you have issued documents to a contract and the information is read-only. For more information, see Issue request documents (on page 403).

See Also
Setting Properties (on page 44)

General Tab (Properties Dialog Box)
Shows general properties for a drawing item.

Name
Displays the name of the property.

Value
Sets the current value of the property.

Behavior
Specifies whether to inherit or override a property in the hierarchy of items in the Console. If the property is Inherited, the setting comes from items higher in the hierarchy. If the property is not read-only, you can provide a new, overriding value for the property by changing the behavior setting to Override. This new value then propagates to other items deeper in the hierarchy. If you set the behavior to Force Override, the property setting is forced to items deeper in the hierarchy, even if they are set to Inherit.

Properties
Published - Indicates whether the drawing has been published.

Size - Displays the size of the file in KB (kilobytes).

See Also
Properties Dialog Box (on page 46)

Title Area Tab (Properties Dialog Box)
Sets options for the title area of drawings.

If you access this tab after selecting multiple drawings, these fields will appear empty, regardless of what information was defined for any of the drawings individually. Any information you add to this tab will overwrite the previously defined information in corresponding rows in the selected drawings.

Name
Displays the name of the property.

Value
Sets the current value of the property.

Behavior
Specifies whether to inherit or override a property in the hierarchy of items in the Console. If the property is Inherited, the setting comes from items higher in the hierarchy. If the property
is not read-only, you can provide a new, overriding value for the property by changing the behavior setting to **Override**. This new value then propagates to other items deeper in the hierarchy. If you set the behavior to **Force Override**, the property setting is forced to items deeper in the hierarchy, even if they are set to **Inherit**.

**Properties**

**Border**

Specifies the border attribute that stores the name of border for the title block. This attribute also stores the dimensions of the border.

**Charge Number**

Defines the charge number for the drawing.

**Charge Title**

Describes the **Charge Number** box. The charge title text is placed to the left of the charge number.

**Company Name**

Specifies the name of the company for which the project is designed.

**Desc1**

Describes the drawing. This description is the first of four lines of text used to describe the drawing.

**Desc2**

Describes the drawing. This description is the second of four lines of text used to describe the drawing.

**Desc3**

Describes the drawing. This description is the third of four lines of text used to describe the drawing.

**Desc4**

Describes the drawing. This description is the fourth of four lines of text used to describe the drawing.

**Division Location**

Specifies the location of the division for which the project is designed.

**Division Name**

Specifies the name of the division for which this project is designed.

**Drawing Naming Rule**

Specifies a default or custom naming rule to the drawing. The default name rules provided include:

**Default Drawing Name Rule** - This is the default rule for composed drawing types. Creates a name based on the parent component name, Global Workshare location ID, and an index number. The naming rule inserts a “-” between each name. If there are no parent objects, then only the child object name is used. For example, the first drawing created under the ComposedDrawings001 component at workshare site 1 is called ComposedDrawings001-1-0001.
**Default By Query Name Rule** - This is the default rule for all Drawings by Query drawing types. Creates a name based on the parent object name (each system and sub-system above the child object will be included in the name) and child object name. The naming rule inserts a "-" between each name. If there are no parent objects, then only the child object name is used. For example, the first composed drawing created at workshare site 1 under the ComposedDrawings001 component would be named *ComposedDrawings001-0001*.

**Default Report Name Rule** - This is the default rule for all Spreadsheet Reports. Creates a name based on the object name, Global Workshare location ID, and an index number. For example, the first drawing created at workshare site 1 is called *ComposedDrawings001-1-0001*.

**Volume Name Rule** - This is the default rule for volume drawing types. Creates a name based on the volume name, Global Workshare location ID, and an index number. For example, the first drawing created using the volume Volume001 in workshare site 1 is called *Volume001-1-0001*. If a volume is not specified, the drawing name will be named *Unspecified*.

**NOTE** Customized naming rules appear in the list if you bulkload against the CDrawingSheet class, which is the class for the drawing object. The rules are defined on the NamingRules sheet in the GenericNamingRules.xls workbook. For more information, see the Reference Data Guide.

**Drawing Number**
Displays the unique identifier for the drawing.

**Drawing Size**
Defines a standard note value for the border size.

**Drawing Type**
Defines the three-letter code to identify the type of drawing. For example, the type can be DGN.

**Job Number**
Defines the unique identifier assigned to a capital project or job.

**Note Line**
Specifies text for a miscellaneous note line.

**Plant Name**
Specifies the name of the plant or project for which the drawing is designed.

**Project Version**
Defines the number and letter sequence that identifies a particular generation of a document that was created since the last approved revision.

**Revision Numbers**
Defines the number of the current revision for this drawing.

**Sheet**
Defines the number of the page and the total number of pages that are associated with this one. For example, the value might be *3 of 5*.

**Site Location**
Specifies the site location for which the drawing is designed.
Shortcut Menus

Site Name
- Specifies the name of the site where the plant is being constructed.

Title1
- Specifies text for the first miscellaneous title. This title is usually a description of the area shown on the drawing.

Title2
- Specifies text for the second miscellaneous title. This title is usually a description of the type of drawing.

Title3
- Specifies text for the third miscellaneous title.

See Also
Properties Dialog Box (on page 46)

Signature Area Tab (Properties Dialog Box)
Sets options for the signature area of drawings.

If you access this tab after selecting multiple drawings, these fields will appear empty, regardless of the information defined for any of the drawings individually. Any information you add to this tab overrides the previously defined information in corresponding rows in the selected drawings.

Name
- Displays the name of the property.

Value
- Sets the current value of the property.

Behavior
- Specifies whether to inherit or override a property in the hierarchy of items in the Console. If the property is Inherited, the setting comes from items higher in the hierarchy. If the property is not read-only, you can provide a new, overriding value for the property by changing the behavior setting to Override. This new value then propagates to other items deeper in the hierarchy. If you set the behavior to Force Override, the property setting is forced to items deeper in the hierarchy, even if they are set to Inherit.

Properties

Approval Date - Specifies the date the drawing was approved.

Approved By - Specifies the name of the person responsible for approving the drawing.

Checked By - Specifies the name of the person responsible for checking the drawing.

Checked Date - Specifies the date the drawing was checked.

Designed By - Specifies the name of the person who specified or designed the information on the drawing.

Designed Date - Specifies the date the drawing was designed.
Shortcut Menus

**Drawing Status** - Defines the status code for the drawing.

**Drawn By** - Specifies the name of the person who drew the drawing, or created it.

**Drawn Date** - Specifies the date the drawing was drawn or created.

**Extra Sign By1** - Specifies the name of an extra person who is signing the drawing.

**Extra Sign By2** - Specifies the name of an extra person who is signing the drawing.

**Extra Sign Date1** - Specifies the date the drawing was signed by the person whose name displays in this box.

**Extra Sign Date2** - Specifies the date the drawing was signed by the person whose name displays in this box.

**Extra Sign Title1** - Defines the title of the person whose name displays in this box.

**Extra Sign Title2** - Defines the title of the person whose name displays in this box.

**Mfg Rep Date** - Specifies the date that the manufacturing representative initials the drawing.

**Mfg Rep Name** - Specifies the name of the manufacturing representative who signed the drawing.

**Plant Number** - Defines the plant number.

**Proj Engineer Date** - Specifies the date the project engineer initials the drawing.

**Proj Engineer Name** - Specifies the name of the person who is the project engineer for the project using the drawing.

**Spec By** - Specifies the name of the person who specified or designed the information on this drawing.

**Spec Date** - Specifies the date this drawing was specified or designed.

**See Also**

*Properties Dialog Box* (on page 46)

**Style Tab (Properties Dialog Box)**

Sets options for the style of drawings and reports.

If you access this tab after selecting multiple drawings, these fields will appear empty, regardless of the information defined for any of the drawings individually. Any information you add to this tab overrides the previously defined information in corresponding rows in the selected drawings.

**Name**

Displays the name of the property.

**Value**

Sets the current value of the property.

**Behavior**

Specifies whether to inherit or override a property in the hierarchy of items in the **Console**. If the property is **Inherited**, the setting comes from items higher in the hierarchy. If the property is not read-only, you can provide a new, overriding value for the property by changing the behavior setting to **Override**. This new value then propagates to other items deeper in the hierarchy. If you set the behavior to **Force Override**, the property setting is forced to items deeper in the hierarchy, even if they are set to **Inherit**.
Properties

Coordinate System

Specifies the global or an active coordinate system. Choose a coordinate system from the list, or click More... to choose another coordinate system with the Select System dialog box.

If you want to output large coordinates on your drawings, define a coordinate system using large negative coordinates. For example, if you want coordinates of 400,000 ft output on drawings, define a coordinate system origin of -400,000 ft and place your model elements close to global 0. Select the new coordinate system in the Coordinate System field on the Style tab. For more information on defining coordinate systems, see the Grids User's Guide available from Help > Printable Guides.

NOTES

- The Coordinate System property is not used by Composed Drawings. The coordinate system settings are driven by the properties for the drawing views in a composed drawing. For more information on the coordinate system properties for a drawing view, see Drawing View Properties Dialog Box (Place View Command) in the SmartSketch Drawing Editor Help.

- If you are accessing the Properties Style tab for a 3D Model Data component or document with the intention of saving it as a SmartPlant Review file, make sure this property is set appropriately so that the Plant Monument Coordinate Offset is passed correctly to SPR when creating the VUE file. This is because SPR shows the objects from the VUE file using global coordinates. The offset value allows you to see the original coordinates relative to the new SPR coordinate system. For more information on 3D Model Data components, see 3D Model Data. For information on saving to SPR, see Save as SmartPlant Review File.

Volume Naming Rule

Specifies the naming rule applied to the content of the drawing.

Change Management

Enables and disables Change Management for piping isometric drawings. You can override the Drawing.Content.ChangeManagementEnabled option in the Isometric style with this property. You can set the property to Enabled, Disabled, or set it to Undefined. This property is only available when you are viewing properties for a piping isometric drawing. For more information on Change Management, see Change Management in Piping Isometric Drawings (on page 173).

Baseline Date

Identifies a date in time when a snapshot of the drawing document was taken. It is a way of identifying when objects have changed.

WBS Project

Specifies the Work Breakdown Structure (WBS) project style to be used with the drawing. This property serves as the answer to an asking filter when specified in a View Style. For more information, see Create a Drawing Using WBS Objects.

See Also
Properties Dialog Box (on page 46)
Surface Styles and Aspects Tab (Properties Dialog Box)

Sets options for the surface styles and aspects used in 3D Model Data. This tab is only available when you are looking at the properties for a 3D Model Data document.

You can perform the following operations on this tab:

- Select an existing surface style rule from the library and add it to the workspace.
- Modify an existing surface style rule in the library and add it to the workspace.
- Create a new surface style rule and add it to the library and the workspace.
- Delete a surface style rule from the library or the workspace.
- Rearrange the style rules in the workspace box of the Surface Style Rules dialog box by using the Move Up and Move Down commands.
- Import surface styles from the session file.
- Set the aspects for the 3D Model Data.

Surface style rules

Style rule library - Lists all the current surface style rules in the Site database.
Selected rules - Lists all the names for the surface style rules currently assigned to the workspace.
Add - Adds the selected surface style rule to the workspace.
Remove - Removes a selected surface style rule from the workspace. To remove a surface style from the workspace, select the style in the Workspace list and click Remove.
Move Up - Moves the selected style rule up one step in the Workspace list.
Move Down - Moves the selected style rule down one step in the Workspace list.
New - Activates the Surface Style Rule Properties dialog box on which you can create a new surface style rule and add it to the database. This button is available only if you have write permission to the surface style rules.
Modify - Activates the Surface Style Rule Properties dialog box to modify an existing surface style rule and add it to the database.
NOTE: For more information on creating new or modifying existing surface style rules, see Surface Style Rule Properties Dialog Box (on page 56).
Copy - Creates a copy of the selected rule on the Clipboard. You use Copy to create a copy of a surface style rule in the Model database so you can modify the rule rather than create a new one.
NOTE: If you try to copy a style rule associated with a deleted filter, the style cannot be copied. A message box displays.
Paste - Pastes the copied rule from the Clipboard so it can be modified.
Delete - Removes the selected Surface Style Rule from the database.
Apply - Applies changes in surface style rules to the workspace.
NOTE: Double-clicking a surface style rule also activates the Surface Style Rule Properties dialog box on which you can create or modify a surface style rule if you have permission.
Shortcut Menus

Import from Session - Imports session surface style rules for the selected 3D Model Data component.

Aspects

Select Aspects - Opens the Select Aspects dialog box so you can specify the aspects to use for the 3D Model Data component. For more information, see Select Aspects Dialog Box (on page 54).

**NOTE** When publishing 3D Model Data documents, the Simple Physical aspect is used by default if no other aspects are specified.

See Also
Properties Dialog Box (on page 46)
Set surface styles and aspects for 3D model data documents (on page 45)

Select Aspects Dialog Box

Specifies the aspect associated with the 3D Model Data document(s). An aspect is a geometric area or space related to an object. The aspect represents information about the object, such as its physical shape or the space required around the object. Aspects are associated parameters for an object, representing additional information needed for placement. Aspects can represent clearances for safety or maintenance, additional space required during operation, or simple and detailed representations of the object. You define aspects when you model a part class for the reference data.

This dialog box displays when you click the Select Aspects button on the Surface Styles and Aspects tab of the Properties dialog for a 3D Model Data document(s).

Selected aspects - Shows a checkbox list of all aspects defined by the model reference data. You can check multiple aspects. By default, the Simple Physical aspect is selected.

- **Simple physical** - Includes primitive shapes. This aspect creates a less cluttered view of the object, showing only the body of equipment or a simplified cross-section for structure, as shown below.

![Simple Physical Aspect](image)

- **Detailed physical** - Provides a more detailed view of an object. This aspect shows all the graphical details associated with the equipment or structure. For example, certain types of equipment may include legs and lugs. For marine structure, this aspect uses all geometry in the cross-section, as shown below.

![Detailed Physical Aspect](image)

- **Insulation** - Shows an area around a piece of equipment indicating the presence of insulation. This aspect is also used to display structural fireproofing insulation. For
example, a 4-inch pipe with insulation might look like an 8-inch pipe when this aspect is used.

- **Operation** - Includes the area or space around the object required for operation of the object. This space shows in the model but not in drawings. For example, this aspect leaves enough space around a motor for a person to operate the motor or the overhead space needed for someone to walk up a stairway.

- **Maintenance** - Includes the area or space around the object required to perform maintenance on the object. This space may appear in the model but not in drawings. For example, this aspect leaves enough space around a motor to perform maintenance on a motor, including space to remove the motor.

- **Reference Geometry** - Allows you to construct or add graphical objects that do not participate in interference checking. For example, a reference geometry object could be a spherical control or the obstruction volume for a door. For marine structure, this aspect allows you to control the display of landing curves for design seams, profile systems, reference curves, and knuckle curves.
• **Centerline** - Displays objects as a single line representation. For example, this aspect is useful for when you want to display handrails or structural members as a single-line on drawings. For structure, the centerline is determined from the cardinal point used to place the member. That cardinal point is not always the center of the object.

![Diagram of Centerline](image)

• **Molded Forms** - Displays plate, profile, and beam systems for marine structure.

• **Equipment Hole** - Displays holes for marine structure created in the Hole Management task.

• ***** - Matches all cross-sections.

For more information on defining aspects for your model reference data, see the *Common User’s Guide*.

**See Also**

*Surface Styles and Aspects Tab (Properties Dialog Box)* (on page 53)

Set surface styles and aspects for 3D model data documents (on page 45)

**Surface Style Rule Properties Dialog Box**

Selects a filter and a surface style to be used for the objects identified by the filter. This dialog box displays when you click New or Modify or double-click a surface style rule on the Surface Style Rules dialog box. You can also use this dialog box to rename a rule after you use the Copy and Paste commands on the Surface Style Rules dialog box. Paste creates a rule named *Copy of original surface style rule name*.

*Surface Style Rule Properties Tab (Surface Style Rule Properties Dialog Box)* (on page 56)

*Configuration Tab (Surface Style Rule Properties Dialog Box)* (on page 58)

**Surface Style Rule Properties Tab (Surface Style Rule Properties Dialog Box)**

Creates or modifies a surface style rule. Surface style rules are based on filters. When you create new rules or modify rules, you specify a filter on which to base the rule. For more information on filters, see the *Common User’s Guide*.

**Rule name** - Specifies the name of the surface style rule.

**Filter** - Identifies the filter used within the style rule. The filters available are the ones defined for the current database. The list in the dropdown includes the last ten filters selected. Selecting Create New Filter in the dropdown list displays the New Filter Properties dialog box, which allows you to define a new filter for the style rule. Selecting More in the list displays the Select Filter dialog box. The Properties button for this field displays the Property dialog box for the
selected filter. For more information on defining a new filter or reviewing properties, see the Common User's Guide.

**TIP.** We recommend that you use simple, asking, and compound filters with style rules. Using SQL filters can result in significant performance degradation and should be avoided whenever possible. Unlike the other types of filters, the SQL server is performed directly on the database. For each object passed to the SQL filter, the software checks to see if any of the objects were returned by the query. However, modification of the object may change whether or not the object passes the SQL filter. For example, a pipeline might pass the SQL filter before it is assigned to a different system. After the system assignment changes, a different style rule is applied. Therefore, some SQL filters may result in decreased efficiency in assessing the project data model.

**Style applied** - Specifies the surface style to be used for the objects identified by the selected filter. The list in the dropdown includes all surface styles available for the current database. The **Properties** button displays the **Surface Style Rule Properties** dialog box so you can edit the style as needed.

**Select all aspects to which the style will be applied** - Shows a checkbox list of all aspects defined by the model reference data. You can check multiple aspects. By default, all aspects are selected.

**NOTES**

- An aspect is a geometric area or space related to an object. The aspect represents information about the object, such as its physical shape or the space required around the object. Aspects are associated parameters for an object, representing additional information needed for placement. Aspects can represent clearances for safety or maintenance, additional space required during operation, or simple and detailed representations of the object. You define aspects when you model a part class for the reference data.

- The **Simple Physical** aspect includes primitive shapes. The space can be a field junction box displayed in both the model and in drawings. When you publish 3D Model Data documents, this is the default aspect used if no other aspects are selected for the document properties.

- The **Detailed Physical** aspect provides a more detailed view of equipment in the model. For example, certain types of equipment may include legs and lugs. As opposed to the **Simple Physical** aspect, which only shows the body of the equipment, the **Detailed Physical** aspect shows all the graphical details associated with the equipment.

- The **Insulation** aspect shows an area around a piece of equipment indicating insulation is present. For example, a 4-inch pipe with insulation might look like an 8-inch pipe when the **Insulation** aspect is selected.

- The **Operation** aspect includes the area or space around the object required for operation of the object. This space shows in the model but not in drawings. The **Operation** aspect leaves enough space around a motor for a person to operate the motor.

- The **Maintenance** aspect includes the area or space around the object required to perform maintenance on the object. This space may appear in the model but not in drawings. The **Maintenance** aspect leaves enough space around a motor to perform maintenance on the motor, including space to remove the motor, if necessary.

- The **Reference Geometry** aspect allows you to construct or add graphical objects that do not participate in interference checking. For example, a reference geometry object could be the obstruction volume for a door on a field junction box. Another example is a spherical control point.
Configuration Tab (Surface Style Rule Properties Dialog Box)

Displays the creation, modification, and status information of an object.

**Model** - Displays the name of the model. You cannot change this value.

**Permission Group** - Specifies the permission group to which the object belongs. You can select another permission group, if needed. Permission groups are created in the Project Management task.

**Transfer** - Re-assigns ownership of the selected model objects from their current permission group to another satellite or host permission group. This button is only available if the active model/project is replicated in a workshare configuration. The button is not available if all of the objects in the select set already belong to another location and are non-transferable. For more information, see Transfer Ownership Dialog Box in the Structural Detailing User's Guide.

An important note: The Transfer option does not apply to the Surface Style Rules.

**Status** - Specifies the current status of the selected object or filter. Depending on your access level, you may not be able to change the status of the object.

**Created** - Displays the date and time that the object was created.

**Created by** - Displays the name of the person who created the object.

**Modified** - Displays the date and time when the object was modified.

**Modified by** - Displays the name of the person who modified the object.

Custom Tab (Properties Dialog Box)

Sets options for drawing properties.

If you access this tab after selecting multiple drawings, these fields appear empty, regardless of the information defined for any of the drawings individually. Any information you add to this tab overrides the previously defined information in corresponding rows in all selected drawings.

**Name**

Displays the name of the property.

**Value**

Sets the current value of the property.

**Behavior**

Specifies whether to inherit or override a property in the hierarchy of items in the Console. If the property is **Inherited**, the setting comes from items higher in the hierarchy. If the property is not read-only, you can provide a new, overriding value for the property by changing the behavior setting to **Override**. This new value then propagates to other items deeper in the hierarchy. If you set the behavior to **Force Override**, the property setting is forced to items deeper in the hierarchy, even if they are set to **Inherit**.

See Also

- Properties Dialog Box (on page 46)
**Notes Tab (Properties Dialog Box)**

Sets notes for the item.

If you access this tab after selecting multiple drawings, these fields appear empty, regardless of the information defined for any of the drawings individually. Any information you add to this tab overrides the previously defined information in corresponding rows in the selected drawings.

**Parent Notes**

Concatenates the notes from any parents of the currently selected item and displays the notes. This box is read-only.

**Notes**

Specifies notes for the currently selected item.

The following graphics demonstrate how parent notes and notes work. The first graphic shows how notes can be added at different levels of the hierarchy. The Notes tab shows Parent Notes from a higher-level folder or component. The Notes section shows additional information for a particular drawing document.

When the document is updated and displayed, the Note Region of the template contains the specified information.

**See Also**

*Properties Dialog Box* (on page 46)


**Issue Tab (Properties Dialog Box)**

Sets options for internal issues.

**Issue Number**

Shows the drawing issue number. Type the required issue number for the drawing. When you have selected multiple drawings or a node in the Management Console, this field is not available to edit, as an issue number is created for each individual drawing, depending on its current revision history.

**Description**

Describes briefly the scope of the issue.

**Issue Date**

Shows the date issued.

**Issue Reason**

Shows the reason the document was issued. Select a value from Bid, Fabrication, Construction, Reference, and your customized values, if any are defined.

**NOTE** The values for Issue Reason can be customized by editing and bulkloading the DrawingIssueReason_Codelist.xls workbook delivered in the [Product Folder]CatalogData\Bulkload\AdditionalDataFiles folder. For more information, see Bulkload Files in the Drawings and Reports Reference Data Guide.

**Job Spec**

Identifies the job specification for the issued document.

**Revision Number**

Defines the revision number for this issue of the drawing.

**Unregistered**

If you access Properties on a single document when your model has not been registered using the SmartPlant Registration Wizard, the Issue tab displays previous entries. A new row is available to make a new entry. You can edit each field using alphanumeric and special characters. You cannot delete a row after it has been added.

If you access Properties on a folder when your model has not been registered using the SmartPlant Registration Wizard, the Issue tab has a single blank row for a new entry. With the exception of the Issue Number field, you can edit all the fields. Their values are propagated to the documents within the folder.

**Registered**

If your model is registered using the SmartPlant Registration Wizard and you have issued requests for the document, the Issue tab is read-only. The Issue information is retrieved for informational purposes only.

**NOTES**

- You can create only one issue per instance of the Properties dialog box. To create another issue, close the dialog box and open it again.
For information on issuing requests for contracts when working in an integrated environment, see *Issue request documents* (on page 403).

**See Also**

*Properties Dialog Box* (on page 46)

### Revision Tab *(Properties Dialog Box)*

Displays and sets properties for revisions. The **Revision** tab is always read-write (subject to user permissions).

- **Action** - Lists the available actions when accessing Properties on a single component, multiple components, or multiple documents.
- **Append Record** - Creates a new revision record for each document under the selected components or in the document set. You can type a value for the next revision mark or let the software automatically increment it for you.
- **Edit Last Record** - Edits the last revision for each document under the selected components or in the document set. Only the edited revision fields overwrite the corresponding fields on the last revision record. To clear a populated revision field, type a single space character, and no other characters, in the edited field.

**NOTE** The **Append Record** and **Edit Last Record** options are not available for a model registered with SmartPlant Foundation or when revising a single document.

- **Revision Mark** - Specifies the current revision. For single documents, double-click the **New Record** cell to automatically increment to the next revision mark number. To manually type a value for the next revision mark, click the **New Record** cell and type the value. This only applies when the model has not been registered with SmartPlant Foundation. If this cell is not edited, then the revision mark number automatically increments to the next available number in each writeable document associated to the selected set.
- **Revision Minor Number** - Specifies the minor revision number for the revision.
- **Description** - Describes the scope of the revision.
- **Revised By** - Identifies the person who made the revision.
- **Revision Date** - Specifies the date of the revision.
- **Check** - Identifies the person who checked the revision.
- **Check Date** - Specifies the date the revision was checked.
- **Approved By** - Identifies the person who approved the revision.
- **Approval Date** - Specifies the date the revision was approved.

The appearance and behavior of the contents of this tab differ depending on whether properties are accessed on a single document or accessed on a single component, multiple components, or multiple documents. The contents of this tab also depend on whether the model is registered to SmartPlant Foundation.

**Unregistered**

If you access **Properties** on a single document and your model has not been registered to SmartPlant Foundation, the **Revision** tab displays previous entries made. A new row is available to make a new entry. You can edit each field using alphanumeric and special characters.
If you access **Properties** on a single component, multiple components, or multiple documents and your model has not been registered to SmartPlant Foundation, the **Revision** tab has a single blank row for a new or edited entry. All fields are editable. Their values are propagated to the writeable documents that are associated with the selected set.

**Registered**

If your model has been registered to SmartPlant Foundation, use the **Revise** command to create revision numbers. This command reserves a revision number by adding it to the document Revision properties. The revision number is added in the form of a blank row on the **Revision** tab of the **Properties** dialog box.

After reserving the revision number, right-click the document and select **Properties**. Go to the **Revision** tab and edit the **Revision** fields. All fields except for **Revision Mark** and **Revision Minor Number** are editable. For more information, see **Revising** (on page 388).

**NOTES**

- You can create more than one revision per instance of the **Properties** dialog box by selecting **Apply** after adding a record.
- You can delete one or more revision records by highlighting the revision rows and pressing **Delete**. You must select **OK** or **Apply** to make the deletion permanent. The rows selected for deletion must be adjacent and must include the last revision record.

**See Also**

*Properties Dialog Box* (on page 46)

**WBS Tab (Properties Dialog Box)**

Sets options for the Work Breakdown Structure (WBS) of drawings and reports. This tab is available only when your model has been registered using the SmartPlant Registration Wizard.

If you access this tab after selecting multiple drawings, these fields appear empty, regardless of the information defined for any of the drawings individually. Any information you add to this tab overrides the previously defined information in corresponding rows in the selected drawings.

**Name**

Displays the name of the property.

**Value**

Sets the current value of the property.

**Behavior**

Specifies whether to inherit or override a property in the hierarchy of items in the **Console**. If the property is **Inherited**, the setting comes from items higher in the hierarchy. If the property is not read-only, you can provide a new, overriding value for the property by changing the behavior setting to **Override**. This new value then propagates to other items deeper in the hierarchy. If you set the behavior to **Force Override**, the property setting is forced to items deeper in the hierarchy, even if they are set to **Inherit**.
Properties

**Project Name** - Displays the project to which the item belongs. In SmartPlant Foundation, a project is the scope of work approved for capital expenditure (that is, a job).

**Document Type** - Specifies the type of document, such as Civil Plan.

**Document Style** - Specifies the style of document, such as Ortho for orthographic drawing.

**Discipline** - Specifies the discipline for the document. If this is a 3D Model Data document, set the property to **SmartPlant Review Document**. If it is a drawing or report document, set the discipline to match the type of document.

**Allow Publish** - Sets the document as a publishable document.

Working with the Integrated Environment

You can only publish documents after the appropriate properties are set on the WBS tab. The WBS tab is not available if your login is not authenticated as valid for SmartPlant Foundation. The properties that must be defined for publishing are: **Document Type**, **Document Style**, **Discipline**, and **Allow Publish**. For more information, see *Set properties for publishing documents* (on page 396).

See Also
*Properties Dialog Box* (on page 46)

**Configuration Tab (Properties Dialog Box)**

Displays the creation, modification, and status information for an item.

**Model**

Displays the name of the Model. This value is read-only.

**Permission group**

Specifies the permission group to which the item belongs. You can select another permission group if needed.

If you access this tab after selecting multiple drawings, this field will be empty, regardless of what information was defined for any of the drawings individually. Any selection you in this field will overwrite the previously defined information in the selected drawings.

**Transfer**

Reassigns ownership of the selected model objects from their current permission group to another satellite or host permission group. This option is only available if the active model or project is replicated in a workshare configuration. The option is not available if all of the objects in the select set already belong to another location and are non-transferable. For more information, see *Transfer Ownership Dialog Box* in the Common User's Guide.

**NOTE** The **Transfer** option does not apply to the Filters and Surface Style Rules.

**Approval State**

Shows the approval state of the selected item. This value is read-only.

**Status**

Specifies the current status of the selected **Console** hierarchy item or items or selected documents in the **Detail View**. Depending on your access level, you may not be able to
change the status of the selected items.

**Date Created**
Displays the date and time the item was created.

**Created by**
Displays the name of the person who created the item.

**Date Last Modified**
Displays the date and time the item was modified last.

**Last Modified by**
Displays the name of the person who modified the item last.

**See Also**
*Properties Dialog Box* (on page 46)

**Transfer Ownership Dialog Box**
Allows you to specify a new location and permission group for the selected model objects.

**Current location**
Displays the name of the location that the current permission group is associated with. All of the objects in the select set must belong to the same location.

**Current permission group**
Displays the name of the permission group that the selected objects are currently associated with. If all of the objects in the select set do belong to the same permission group, this box appears blank.

**New location**
Specifies the name of the location to which you want to assign the objects. In a global workshare configuration, this box lists all the locations in which you have write access to one or more permission groups. The selection in this box filters the entries in the **New permission group** box.

**New permission group**
Specifies the new permission group to which to assign the selected objects. If you specify a value in the **New location** box, this list displays all permission groups that you have write access to in the selected location. If you do not specify a value in the **New location** box, this list includes all permission groups that you have write access to in all locations except the current location. This box is blank if you do not have write access to any permission groups at any locations other than the current one.

**NOTE** We strongly recommend that administrators follow naming convention rules that include the location as a prefix in the permission group name.
Choose Label Dialog Box

Specifies a label for a document property. This dialog box displays the labels available on the application server in the [Reference Data Folder]\SharedContent\Labels\Base Templates folders.

See Also
Setting Properties (on page 44)

Rename Command

Allows you to type a new name for a selected item in the hierarchy. The shortcut key for this command is F2.

NOTE You cannot have duplicate names at the same level in the tree, but the names are case-sensitive. For example, you can have two items be named 'ItemName' and 'itemname' at the same level in the tree.

Rename an item

1. Right-click an item in the Management Console hierarchy or Detail View, and select Rename on the shortcut menu. Alternatively, press F2 on the keyboard.

2. Type a new name for the item.

See Also
Rename Command (on page 65)
Shortcut Menus (on page 34)
Components Overview (on page 84)

Save As Command

Saves drawings and reports as specified file types to an external location, such as a share on another server. This command is not available until you generate drawings for at least one of the structures in the hierarchy. This command saves only the structures that contain drawings or reports. You can save multiple file types based on the types of documents available. You can specify the target file type for each drawing type you want to save.

To save the hierarchy as a package, right-click the folder and select Save Package on the right-click menu. For more information, see Save Package Command (on page 73).

Save As Dialog Box (on page 71)

What do you want to do?

- Save to a file (on page 66)
- Create a piping component file (PCF) (on page 67)
- Save as SmartPlant Foundation (*.xml) (on page 69)
Save to a file

Prior to following this procedure, you must have generated drawings already for at least one of the items in the Console hierarchy. The Save As command is not available if drawings have not been generated.

1. Select a folder, component, or document. You can select multiple documents by holding Ctrl or Shift and clicking each item.

2. Right-click your selection, then select Save As on the shortcut menu. The Save As dialog box displays.

3. Specify the Output Folder Rule to be used. You can save the item as it displays in the hierarchy, with its parent folder appended or with the entire model hierarchy appended.

4. Specify the File Already Exists Action to be used. This determines how you save the file if it has the same name of an existing file. Select Overwrite to replace the existing file, or select Save As filename (n) to save the file separately.

5. Specify the Output Folder location. Click Browse to display a dialog box to locate the appropriate folder location.

6. Check the boxes for the Component Types you want to save. You can select multiple component types. For more information, see Save As Dialog Box (on page 71).
7. In the **Target File Type** lists, specify the file types you want to save. You can specify a file type for each component type selected. For example, you could use the Iso_Stress style to create a Piping Component File (PCF) file, then when you perform a **Save As** on the document, check the **Isometric Drawings** component type and specify the **Target File Type** as PCF File.

![Shortcut Menus](image)

**NOTES:**

- For Piping Isometric Drawings, the name of the drawing document becomes the prefix for all of the files. For example, if the drawing document name is *My_Pipeline*, the saved file names become: *My_Pipeline.sha*, *My_Pipeline.pcf*, and so on.

- For Piping Isometric Drawings, a file is created for each sheet in the drawing with *[drawing name]*_[sheet name]* as the filename. For example, if the drawing *My_Pipeline* contains Sheet1 and Sheet2, two files will be saved with the names *My_Pipeline_Sheet1* and *My_Pipeline_Sheet2*.

- The **SmartPlant Foundation (*.xml)** target file type allows you to save drawing data and metadata to generate .xml files in either integrated and non-integrated environments that can be easily updated. For integration, you can use SmartPlant Interop Publisher to translate the generated .xml data file to a Smart Drawing available in SmartPlant Foundation. This option is available for **Isometric**, **Composed**, and **Volume Drawings**. For more information, see **Save as SmartPlant Foundation (*.xml)** (on page 69).

8. Click **OK** to save the files as specified. The saved drawings retain the same names they had in this task.

**Create a piping component file (PCF)**

When you create a Piping Isometric document that uses the Iso_Stress style, the software does not create drawings. Instead it creates the data necessary for a Piping Component File (PCF). You can then output the Piping Component File (PCF) to the CAESAR II pipe stress analysis software.

**NOTE:** You can also view the PCF data with the **View Extraction Data** command. For more information, see **View piping isometric extraction data** (on page 99).
1. Right-click the Piping Isometric document that uses the Iso_ Stress style and select **Save As**. The **Save As** dialog box displays.

![Save As Dialog Box](image)

2. Specify the **Output Folder Rule** to be used. You can save the item as it displays in the **Console**, with its parent folder appended or with the entire model hierarchy appended.

3. Specify the **File Already Exists Action** to be used. This determines how you save the file if it has the same name of an existing file. Select **Overwrite** to replace the existing file, or select **Save As filename (n)** to save the file separately.

4. Specify the **Output Folder** location. Click **Browse** to display a dialog box to locate the appropriate folder location.

5. Check the **Isometric Drawings** component type. You can select multiple component types. For more information, see **Save As Dialog Box** (on page 71).

6. In the **Target File Type** dropdown for the Isometric Drawing component type, select **PCF File** (.pcf).

7. Click **OK** to save the files as specified.

The PCF file is saved to the location you specified, ready for use in stress analysis.

**Note**
The saved drawings retain the same names they had in this task.

**See Also**
- **Save As Command** (on page 65)
- **Piping Isometric Drawings by Query** (on page 87)
- **Isometric Drawing Styles** (on page 107)
Save as SmartPlant Foundation (*.xml)

Use the **SmartPlant Foundation (*.xml)** target file type to save drawing data and metadata and generate .xml files in either integrated or non-integrated environments. This save option is available for **Isometric Drawings**, **Composed Drawings**, and **Volume Drawings** component types.

1. Before you use the **Save As** command, you must define the **Discipline** property for your documents:
   a. In the **Console**, right-click an item in the hierarchy, then select **Properties** on the shortcut menu.
   b. Go to the **WBS Tab**.
   c. Set the **Discipline** property. If your model has been registered using the SmartPlant Registration Wizard, this also adds the **Publish** command to the right-click menu for the selected document or documents. For a 3D Model Data document, the property is set to **SmartPlant Review Document**.

2. Right-click the Isometric, Volume, or Composed document, and select **Save As**.

   **The Save As dialog box displays.**

   ![Save As Dialog Box]

3. Specify the **Output Folder Rule** to use. You can save the item as it displays in the **Console**, with its parent folder appended or with the entire model hierarchy appended.

4. Specify the **File Already Exists Action** to be used. This determines how you save the file if it has the same name of an existing file. Select **Overwrite** to replace the existing file, or select **Save As filename (n)** to save the file separately.
5. Specify the **Output Folder** location. Click **Browse** to display a dialog box to locate the appropriate folder location.

6. Check the **Isometric Drawings, Composed Drawings, or Volume Drawings** component type. You can select multiple component types.

7. In the **Target File Type** menu list for the component type, select **SmartPlant Foundation (*.xml)**.

8. Click **OK** to save the files as specified.

   The software generates an .sha file and two XML files in the specified location; an .xml data file and an .xml metadata file. The data .xml file is named ToolData_<Drawing Name>. The metadata file is named MetaData_<Drawing Name>.

   You can now add the generated .sha in SmartPlant Interop Publisher to translate it to a Smart Drawing and publish the drawing to SmartPlant Foundation. SmartPlant Interop Publisher requires all generated files (.sha and .xml) to be located in the same folder location for translation and publishing. For more information about Smart Drawings and the translation and publish capabilities, refer to the SmartPlant Interop Publisher User's Guide.
Save As Dialog Box

Sets options for exporting drawings. You can open this dialog box by right-clicking a folder, component, or drawing and then selecting \textit{Save As} on the right-click menu.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{save_as_dialog_box}
\caption{Save As Dialog Box}
\end{figure}

Output Folder Rules

Specifies how you want to save the hierarchy. The following options are provided:

- \textbf{As displayed} - Specifies the selection is saved as displayed.
- \textbf{Append Parent Folder} - Specifies the selected item is appended to the parent folder.
- \textbf{Append Model Hierarchy} - Specifies the selected item is appended to the hierarchy starting from the root and including the selected item.

File Already Exists Action

Specifies how you want to save the hierarchy if a file with the same name already exists.

- \textbf{Overwrite} - Overwrites the existing file.
- \textbf{Save As filename (n)} - Saves the file separately, and appends a number \textit{n} after the file name. For example, if the existing file name is \texttt{FileName}, the new file name is \texttt{FileName (1)}.

Output Folder

Specifies the location to which to save the package.

Browse

Indicates a folder in which to save the drawings. You can select a local folder or a folder on another computer on the network.
File Type

Specifies the file formats to save for each drawing type. Check the box next to each drawing type you want to save. Use the **Target File Type** menu to specify the file type to which the drawing type is saved. The file types available for each drawing type are described in the following table.

<table>
<thead>
<tr>
<th>Drawing Type</th>
<th>Target File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroStation</td>
<td>MicroStation J (V7) (*.dgn) 32MB limit</td>
</tr>
<tr>
<td>Piping Isometric Drawings</td>
<td>Shape2DServer (*.sha)</td>
</tr>
<tr>
<td></td>
<td>PCF file (*.pcf)</td>
</tr>
<tr>
<td></td>
<td>Both (*.sha &amp; *.pcf)</td>
</tr>
<tr>
<td></td>
<td>All Files (<em>.</em>) - Includes all .sha and .pcf files, as well as all enabled supplementary files.</td>
</tr>
<tr>
<td></td>
<td>MicroStation J (V7) (*.dgn)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD (*.dxf)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD (*.dwg)</td>
</tr>
<tr>
<td></td>
<td>SmartPlant Foundation (*.xml)</td>
</tr>
<tr>
<td>Spreadsheet Reports</td>
<td>Worksheets (*.xls)</td>
</tr>
<tr>
<td>Composed Drawings, Volume Drawings, and Orthographic Drawings by Query</td>
<td>Shape2DServer (*.sha)</td>
</tr>
<tr>
<td></td>
<td>MicroStation J (V7) (*.dgn)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD (*.dxf)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD (*.dwg)</td>
</tr>
<tr>
<td>Composed by Drawings and Volume Drawings</td>
<td>SmartPlant Foundation (*.xml)</td>
</tr>
</tbody>
</table>

**NOTES:**
- For Piping Isometric Drawings, the name of the drawing document becomes the prefix for all of the files. For example, if the drawing document name is `My_Pipeline`, the saved file names become: `My_Pipeline.sha`, `My_Pipeline.pcf`, and so on.
- For Piping Isometric Drawings, a file is created for each sheet in the drawing with `[drawing name]_[sheet name]` as the filename. For example, if the drawing `My_Pipeline` contains Sheet1 and Sheet2, two files will be saved with the names `My_Pipeline_Sheet1` and `My_Pipeline_Sheet2`.

**See Also**

*Save As Command* (on page 65)
Save Package Command

Saves the Management Console hierarchy from the selected component down. The package saves the setup information and any template definitions that exist on nodes within the selected hierarchy. You can access this command by right-clicking a folder or application component in the Management Console. You must have at least write permissions on the component to access the Save Package command.

**IMPORTANT** This command is not used in the normal workflow of creating drawings and reports. An administrator with write permissions to the SharedContent folders saves packages.

When a package is added back into the Management Console, it recreates the hierarchy that was saved with the package.

Packages are also used in the setup of a Drawings by Query Manager component for the creation of orthographic and piping isometric drawings.

**Save Package Dialog Box (on page 74)**

**NOTES**

- Output documents are not saved in a package.
- If the topmost component saved in the package is a folder, then the package can be placed under the model root or a folder. If the topmost component saved in the package is an application component, then the package can only be placed under a folder.
- When you place a package, the software adds all the components to the active permission group.
- To save drawings or reports externally, see Save As Command (on page 65).

**Save a package**

1. Right-click a component in the Management Console hierarchy, and select Save Package. The Save Package dialog box displays.
2. Specify a package name, package description, and tab name. For example, you can save a Piping Isometric Drawing Package to a new tab called Iso.
3. Click OK to save the package.
The package is added to the **Add Component** dialog box on the specified tab. If a new tab name was specified, a new tab is added to the dialog box.

**NOTE** You can add the new package to the hierarchy by using the **New** command. Select the package on the **Add Component** dialog box. When you add a package, the software adds all the components to the active permission group.

**See Also**
- *Save Package Command* (on page 73)
- *Shortcut Menus* (on page 34)
- *Components Overview* (on page 84)
- *Piping Isometric Drawings by Query Common Tasks* (on page 89)

### Save Package Dialog Box

**Package Name**

Specifies a name for the package.

**Package Description**

Describes the package.

**Tab Name**
Specifies the tab of the Add Component dialog box on which the package displays. You can pick an existing name or type a new tab name in this field. The next time you access the Add Component dialog box from an existing folder, the software adds the new tab and lists the new package on the tab. For more information, see Add Component Dialog Box (on page 39).
For example, if you saved a package called Piping Isometric Drawing Package and added it to a new tab called Isos, an Isos tab is added to the Add Component dialog box:

See Also
Shortcut Menus (on page 34)
Save a package (on page 73)

Updating Documents

Updating documents increases productivity because you can easily keep deliverables current. It is important to understand the different update capabilities.

NOTES

- You must install the SmartPlant Schema Component to update documents.
- If the drawing document you are looking at in the Detail View has a yellow icon (for example: 🟢), the drawing document is a version 6.1 legacy Snapshot drawing. You should use the Tools > Convert Legacy Snapshots command to convert this document to a Composed Drawing for use in the current version of the software. If you do not convert the legacy snapshot drawing, you cannot update, revise, or publish the drawing.

Refreshing Document Contents

The Refresh command on the shortcut menu for a Console hierarchy item allows you to see which documents are out-of-date. For more information, see Refresh (Shortcut Menu) (on page 76).

Updating Documents Using Batch Processing

The Batch command queries the model to regenerate a single document or multiple documents. For volume and composed drawings, if you have edited the previous copy of the drawing (for example, by moving a label), the software remembers those changes and re-creates them. If batch processing is configured for the selected drawings, the update is performed on the Batch Server.
For more information, see Batch Processing - Intergraph Smart Batch Services (on page 195).

See Also
Refresh document status (on page 77)
Print Command (on page 42)

Refresh (Shortcut Menu)

Compares the date of the last update of the document with the modification date in the model for any object that has a positive (can be seen) resymbolization in the drawing.

This command is not available until you generate documents. You can access this command by right-clicking an item in the Management Console hierarchy or in the Detail View and selecting Refresh on the shortcut menu. The software updates the status for all the expanded items within the parent node.

NOTE The Refresh command is not available for Spreadsheet Report documents. A Spreadsheet Report document is regenerated each time you update or print the report document. You can refresh the contents of a folder that contains reports.

For out-of-date documents X, the command behavior implies the following:

- If the object is hidden entirely and is inside the drawing volume, but the style does not resymbolize the hidden lines, the object does not participate in the "out-of-date" definition.
- The modification date used for the object in the model can be for any property even if this property has no impact on the graphic. This means that a drawing could be considered out-of-date even though the graphic is up-to-date. For example, the approval status does not affect graphics. However, the view style you are using for your drawing can use a filter that sets approved objects to a specific color. A drawing document displays with an out-of-date definition because of a change to the approval status.
- Objects participating indirectly in the graphic as labels do not participate in the out-of-date definition. This means that, in rare cases, a label may be out-of-date on a drawing that is shown as up-to-date.

NOTES

- To refresh the Management Console to reflect changes made to loaded (expanded) tree view items, use the View > Refresh command.
- You can also use the Batch > Refresh command on the shortcut menu to perform your refreshes on the batch server. Batch > Refresh is not available for Spreadsheet Report documents.
Refresh document status

1. Right-click any item in the Management Console or in the Detail View.
2. On the shortcut menu, click Refresh. The software checks the model for any differences. The drawing icons change to reflect the status of the documents compared to the model.

**NOTE** After refreshing a folder or component, you can synchronize it with the model by right-clicking the item and then selecting Update Now on the shortcut menu.

**See Also**

- Refresh (Shortcut Menu) (on page 76)
- Icons for Components and Drawings (on page 26)
- Updating Documents (on page 75)

Update Now

Updates a single document or multiple drawing documents whether or not they are out-of-date. This command is available when you right-click on:

- A folder or component in the Management Console. All drawings in all components within the folder are updated.
- A component in the Management Console. All drawings in the component are updated.
- One or more documents in the Detail View. The selected drawings are updated.

This command works on your local computer regardless of the batch configuration.

For volume drawings, the Update Now command is not available until you place drawing volumes for a volume component in the Space Management task. For composed drawings, this command is not available until you create the drawings in a 3D task through Tools > Drawing Console. For reports, this command is not available until you create the report by choosing a report template.

**NOTES**

- If the software encounters a problem before or during the drawing update, it stops updating, displays either an error status or error message, and saves the errors to the log file. For more information, see Conditional Drawing Update (on page 81).
- The software preserves many of the modifications you make between regenerations of volume drawings. For example, if you annotate a volume drawing and then regenerate it, your annotations still display on the updated drawing.
- Documents created automatically in a Drawings by Rule component are automatically deleted by updating the component if the document no longer contains views.
- If the software cannot make a SmartPlant Foundation server connection when updating 3D Model Data documents, you are prompted to provide a valid login and password.
- If you place drawing property labels on a template, generate a drawing, move the labels on the drawing, and then update the drawing, the software remembers the new position of the labels on the drawing.

What do you want to do?

- Update all drawings in a folder or a component (on page 78)
- Update a report (on page 78)
Shortcut Menus

- Update a single drawing (on page 79)
- Insert a note at a precise place on an isometric drawing (on page 79)

Update all drawings in a folder or a component

**NOTE** Before you update a folder or a component, you can refresh its documents to determine which documents are out-of-date. For more information, see *Refresh document status* (on page 77). You do not have to refresh before updating, but it can be helpful to determine which documents are out-of-date.

1. Right-click a folder or a component in the hierarchy. If you select a component, it must contain existing drawings or reports. If you select a folder, it must contain a component with existing drawings or reports.
2. On the shortcut menu, click **Update Now**.
   
   *The icons for the out-of-date documents change to show they are updated. If the Batch Server is configured, the command displays the **Drawing Batch** dialog box.*

   For more information, see *Batch Processing - Intergraph Smart Batch Services* (on page 195).

**NOTE** You can update an individual document by right-clicking the document and selecting **Update Now** on the shortcut menu.

Update a report

1. Right-click a report document.
2. On the shortcut menu, select **Batch > Update** to update the document on the batch server now or create a schedule to run the batch job. Alternatively, select **Update Now** to update locally.

   *The icon for the out-of-date document changes to show it is updated ✓.*
3. If the batch server is configured, the **Drawings Batch** dialog box displays.

   *Batch Processing - Intergraph Smart Batch Services* (on page 195)

**NOTE** When using the **Batch > Update** command and batch processing is configured for the selected document, the update is performed on the Batch Server. If batch processing is not configured, the command behaves the same as the **Update Now** command, performing a complete regeneration of the entire drawing on the local machine.
**Update a single drawing**

1. Right-click a document.

2. On the shortcut menu, select **Batch > Update** to update the document on the batch server now or create a schedule to run the batch job. Alternatively, select **Update Now** to update locally.

   *The icon for the out-of-date document changes to show it is updated.*

3. If the batch server is configured, the **Drawings Batch** dialog box displays.

**NOTE** When using the **Batch > Update** command and batch processing is configured for the selected document, the update is performed on the Batch Server. If batch processing is not configured, the command behaves the same as the **Update Now** command, performing a complete regeneration of the entire drawing on the local machine.

**Insert a note at a precise place on an isometric drawing**

1. Select **Insert > Control Point**.

2. Select the pipe part in the model that needs a note.

   **TIP** Use the quick pick tool to make the correct selection.

3. Position the control point on the centerline of the pipe part. For precision placement, use commands like **Measure**, **PinPoint**, or **Point Along**.

4. In the **Type** box, verify that **Control Point** is selected.

5. Confirm or change the option in the **Subtype** box on the ribbon.

6. In the **Name** box, define a name for the control point.

7. Click **Properties**.

8. Under the **Notes** tab, click **New Note**.

9. In the **Key point** box, select the control point to which to attach the note.

10. In the **Notes at this location, listed by name** box, type or select a name.

11. In the **Purpose of note** box, select **Fabrication** so that the note is picked up for inclusion in the drawing.

12. In the **Note text** box, type descriptive text for the note.
13. Check the **Show dimension** box if you want a dimension to appear on the drawing.

14. Click **OK**.

15. In the Drawings and Reports task, use the **Update Now** or **Batch > Update** commands to update the drawing that includes the pipe part with the associated control point.

   *The note appears where it was placed in the model.*
Conditional Drawing Update

Before updating a drawing, Smart 3D ensures necessary information is present before changing the existing drawing document. If any of the following conditions are true before the update process begins, the software displays an error message that lists the missing items, and makes no changes to the drawing. If any of the following conditions are true after the update process begins, the drawing update process stops, changes to an error status (⚠️), and Smart 3D preserves the previous state of the drawing document to avoid any data loss.

Reference Data Conditions
- View style cannot be found.
  - Graphic preparation rule cannot be found.
  - Graphic rule cannot be found.
  - Label rule cannot be found.
  - Dimension rule cannot be found.
  - North arrow rule cannot be found.
  - Matchline rule cannot be found.
  - View rule cannot be found.
- View style filter cannot be found.
- Emptyvw.sha file cannot be found.
- Styles.sha file cannot be found.

Model Data Conditions
- Associated volume cannot be found.
- Associated coordinate system cannot be found.

Memory Conditions
- Not enough available memory to begin the update process.
- Not enough available memory to complete the update process after it has started.

**NOTES**
- Failure conditions found before the update process can be viewed in the Drawings.log.
- Failure conditions found during the update process can be viewed when you right-click a drawing and select View Log.
- Failure conditions are not logged when the Update command is used on a drawing view. You must use the Update Now command in either the Drawing Console or Drawings and Reports task to save the error(s) to the log.
- If an orphan view (a view that exists in the model database without a corresponding view) exists, it is removed from the database and a description of the error is logged in the Drawings log file in <Temp Folder>\Logs.
Restore

Restores a drawing document from a model restored from a backup. This command is available when you right-click on a document in the Drawing Console or the Drawings and Reports task.

**NOTES**

- When a document is restored, all document properties are overwritten.
- You cannot restore a document if the document is created in your current model after the backup is created. If you select a group of documents to restore, new documents in the group are not restored. All other documents are restored from the backup model.
- Views that are created in your current drawing after the backup is created are lost when you select Restore.

**What do you want to do?**

- Create a backup to use for restoration (on page 82)
- Restore a document from a backup model (on page 82)

---

**Create a backup to use for restoration**

1. In the Project Management environment, create a backup file of your current model using Tools > Backup. For more information, see Backup in the Project Management User's Guide.

2. Create a new model in the site by restoring the backup file using Tools > Restore. For more information, see Restore and Restore Wizard in the Project Management User's Guide.

**TIP.** Give the new model a name that makes it easy to identify as the backup of your current model.

**Restore a document from a backup model**

1. In the Drawing Console or the Drawings and Reports task, right-click on a drawing document in your current model, and select Restore.

   *The Restore Document dialog box displays.*

2. Select the backup model from the Model box, and then click OK.

   *The document in your current model is replaced with the document from the backup model.*
View Log Command

Displays the log information for the selected drawing. To access this command:

- Right-click a drawing document at any time, and select View Log on the shortcut menu.
Several specialized components allow you to access commands for configuring templates and generating drawings and reports. The various types of components can be divided into two groups: application components and folder components. Many of the application components correspond to specific types of drawings, such as volume drawings and composed drawings. The Spreadsheet Reports component provides access to report-related commands. You organize drawings and reports in folders. You can add folders to the root and to other folders. Each component has a different icon and right-click menu.

You can copy and paste components with some restrictions. For example, application components cannot contain folders or other application components. If you copy a folder, you can paste it under a folder but not under another component type. If you copy a Volume Drawing component, you can paste it under a folder. If you copy other types of components, you can paste them under folders but not under other types of components.

Your administrator can assign permissions to the different components using commands in the Project Management task. For example, the administrator can set permissions so that only the piping designers have write privileges on Piping Isometric Drawings. For more information, see the Project Management User's Guide.

There are several types of delivered components. Their names reflect the type of drawing or report they create. When you right-click the root or a folder and select New, the Add Component dialog box appears. The dialog box includes a General Tab for general types of drawings or reports and additional task-specific tabs with delivered folders and packages. For more information, see Add Component Dialog Box (on page 39).

*NOTE* You can also create and manage components from the 3D modeling tasks by using the Tools > Drawing Console command. For more information, see the Common User's Guide.

The following components are shown on the General tab of the Add Component dialog box. Other components are shown on other tabs.

### Delivered Component

<table>
<thead>
<tr>
<th>Delivered Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="3D Model By Query" /></td>
<td>Creates a 3D Model By Query component in the Console. You can use the 3D Model By Query component to export 3D model data in bulk as CAD (SAT) files. The software uses a filter-based query to collect the objects and document them automatically. More information is available in the Orthographic Drawings User's Guide.</td>
</tr>
<tr>
<td><img src="image" alt="3D Model Data" /></td>
<td>Creates a 3D Model Data component in the Console. Right-click the component and select Setup on the shortcut menu to specify a filter that identifies the objects you want collected by the 3D Model Data component. You can use the 3D Model Data component to output SmartPlant Review files or CAD (SAT) files. More information is available in</td>
</tr>
</tbody>
</table>
MicroStation 3D DGN
Creates a MicroStation 3D DGN component in the Console. Right-click the component and select Setup from the shortcut menu to define the MicroStation seed file and style to use in generating the component documents. More information is available in the Orthographic Drawings User's Guide.

Folder
Creates an empty folder in the Console.

Drawings By Query Manager
Creates a Drawings by Query Manager in the Console. The Drawings by Query Manager is used in conjunction with other components, such as the Orthographic Drawing by Query and Piping Isometric Drawing by Query components, to complete the query for objects in the model. The Drawings by Query Manager provides the filter that specifies the "where" side of the query. It tells the query "where" to look for the objects specified by the component "what" filter. More information is available in the Orthographic Drawings Users Guide and the Piping Isometric Drawings User's Guide.

Generic Module Folder
Creates a Generic Module Folder in the Console. The Generic Module Folder component provides a way for you to run your custom VB modules to create custom drawings. You set up the Generic Module Folder component to use your custom VB module. More information is available in the Orthographic Drawings User's Guide.

Composed Drawing
Creates a Composed Drawing component in the Console. Composed drawings are orthographic drawings created in a 3D task such as Common. The composed drawing component manages the composed drawings you create. More information is available in the Orthographic Drawings User's Guide.

Orthographic Drawing by Query
Creates an Orthographic Drawings by Query component in the Console. The Orthographic Drawing by Query component allows you to create drawings for many objects in the model all in the same manner. This component does not require physical volumes in the model. The software uses a filter-based query to collect the objects and document them automatically. More information is available in the Orthographic Drawings User's Guide.
Piping Isometric Drawing by Query

Create a Piping Isometric Drawings by Query component in the Console. You create isometric drawing by associating a Piping Isometric Drawing by Query component to a Query Manager. The Piping Isometric Drawing by Query component specifies the "what" portion of the query, while the Query Manager specifies the "where." More information is available in the *Piping Isometric Drawings User's Guide*.

Spreadsheet Reports

Creates a Spreadsheet Report component in the Console. More information is available in the *Reports User's Guide*.

Search Folder

Creates a Search Folder in the Console. Search Folders allow you to search for documents based on common properties such as out-of-date status, approval, or documents that have been published to a certain contract in integrated environment. More information is available in the *Orthographic Drawings User's Guide*.

Volume Drawings

Creates a Volume Drawings component in the Console. The Volume Drawing component uses a template to create drawings. You can place a view on the template and associate the view with a view style to control the output. To define the contents of the view, you create a drawing volume in the model. More information is available in the *Orthographic Drawings User's Guide*.

See Also

*Shortcut Menus* (on page 34)
*Icons for Components and Drawings* (on page 26)
*New Command* (on page 37)
*Delivered Drawing Types* (on page 23)
SECTION 7

Piping Isometric Drawings by Query

Isometric drawings communicate several important types of information to a pipe fabrication workshop. This information includes pipe cut lengths, bend angles, and welds. You create isometric drawing by associating a Piping Isometric Drawing by Query component to a Query Manager. The Piping Isometric Drawing by Query component specifies the "what" portion of the query, while the Query Manager specifies the "where."

The basic workflow for creating Piping Isometric Drawings by Query is as follows:

- Create a **Piping Isometric Drawing by Query** component that specifies what you want to document.
- Create a **Drawings by Query Manager** that specifies where to look for the data.
- Run the filter-based query.
- Create the drawings.
- Update the drawings, if necessary.
- Publish the drawings to a viewable graphic file; no physical data is published.

Each Piping Isometric Drawing by Query component has an associated isometric style. The delivered styles are **Iso_Pipeline**, **Iso_Piperun**, **Iso_PenSpool**, **Iso_Spool**, **Iso_WBS**, and **Iso_Stress**. You can open the Isometric Style Options Browser from any of the isometric drawing styles by right-clicking the drawing style in the Management Console or Drawing Console and selecting **Edit Options** on the shortcut menu. The browser allows you to set options for isometric drawing format and content.

After creating the Piping Isometric Drawings, you can open them for viewing, editing, printing, and publishing (if your model has been registered using the SmartPlant Registration Wizard). To troubleshoot the drawings, you can use the **View Data** command to access part and reports information and log files.
The software uses ISOGEN, a third-party engine made by Alias, to generate isometric drawings from the three-dimensional model. The following illustration shows the process of creating the drawings.

The application creates a piping component file (PCF), which is used along with the isometric style information to create an intermediate data file (IDF). The ISOGEN engine then reads the IDF and creates the isometric drawings.

**Administrator Setup**

Your administrator should set up appropriate isometric styles to use with the Piping Isometric Drawings by Query component. The administrator is also responsible for creating filters that define what to look for and filters that specify where in the model to look for the objects. The template and the "what" filter information within the component are saved as a package.

**Drawings by Query Manager**

The Drawings by Query Manager uses the filter to specify where to look for the objects included in the drawing.

For more information on the filters necessary for setting up a Drawings by Query component, see *Drawings by Query Filters* (on page 90).
Piping Isometric Drawings by Query Common Tasks

The following tasks are used when you create Piping Isometric Drawings by Query.

For information on filters required for creating Piping Isometric Drawings by Query, see Drawings by Query Filters (on page 90).

Setup a Piping Isometric Drawing by Query Component

Create and perform set up for a Piping Isometric Drawing by Query component. For more information, see Set up a Piping Isometric Drawing by Query component (on page 92). When you select a filter in Setup, you are specifying the "what" portion of the query. In other words, you are specifying the objects to be included in the drawing.

Save the Piping Isometric Drawings by Query Component as a Package

Save the Piping Isometric Drawing by Query component as a package so you can join it with a Query Manager to generate the query drawings. For more information, see Save a package (on page 73).

Add a Drawings by Query Manager

Create a Drawings by Query Manager, then set it up to specify the "where" portion of the query for the Piping Isometric Drawing by Query component. For more information, see Set up a Drawings by Query Manager component (on page 96).

Run the Query

You use the Run Query command to execute the query specified by the Piping Isometric Drawing by Query component and the Drawings by Query Manager. For more information, see Run Query (Shortcut Menu) (on page 97).

Create or Update the Drawings

To create or update the drawings, right-click the component and select the appropriate command. For more information, see Updating Documents (on page 75).

View the Drawing Log

You can view the drawing log to see any messages associated with the drawing. For more information, see View Log Command (on page 83).

Set Drawing Properties

You can specify the properties for the drawing component or drawing documents by right-clicking and selecting Properties. For more information, see Edit document properties (on page 45).

View Piping Data

You can view the piping extraction data by right-clicking a piping isometric drawing and selecting View Extraction Data on the shortcut menu. For more information, see View piping isometric extraction data (on page 99).
Compare 2D Drawing Objects to 3D Model Objects

You can open a Piping Isometric Drawing in a 3D task and compare the 2D drawing objects in the drawing document to 3D model objects. For more information, see *Compare 2D Drawing Object to 3D Model Object* (on page 323).

Publish the Piping Isometric Documents

Publish the Piping Isometric Drawing by Query documents. You can publish only if your model has been registered using the SmartPlant Registration Wizard. For more information, see *Publishing Documents* (on page 391).

*NOTE* The viewable files created when you publish drawings and reports provide relationship links to the 3D Model Data. You must also publish the 3D Model Data to provide the navigation between the viewable files and the 3D Model Data. For more information, see the *Orthographic Drawings User's Guide* available from Help > Printable Guides.

See Also
*Isometric Drawing Styles* (on page 107)

Drawings by Query Filters

Filters determine the contents of the documents produced by Drawings by Query components (3D Model By Query, Orthographic, Piping Isometric, and Drawings by Query Manager). For Orthographic and Piping Isometric Drawings by Query components, the Setup command specifies a what filter that access the model database and determines which objects are included in the drawings, as well as which hierarchy is traversed to create a tree in the Management Console. Setup then defines a Drawings by Query Manager component to specify a where filter that determines the position in the hierarchy and, therefore, the location of the objects included in the drawing.

For example, if you are creating Orthographic drawings that include pipe supports, you create a new Orthographic Drawings by Query component, and run Setup on the component to select a normal filter that returns only pipe support objects. For example, you might choose the Pipe Supports filter as shown below:

![Select Filter](image)
After saving your Orthographic Drawings by Query component setup as a package, you define a Drawings by Query Manager component to determine where in the model to collect the objects you specified in the what filter. When you run Setup on the Drawings by Query Manager component, you select a normal filter.

When you run the query, the software compounds the where filter with the what filter to return the needed objects. Each object is documented in a drawing using the template and rules you setup for the package. The following graphic shows an example drawing using the Pipe Supports filter:

For more information on defining filters, see the Common User's Guide available from Help > Printable Guides.
A what filter can specify non-graphical objects, such as various system nodes in the System tab, folders in the Space tab, WBS projects and items in the WBS tab, and Reference 3D Model nodes in the Reference 3D tab of the Workspace Explorer. When you specify non-graphical objects in the what filter, you must also specify a Navigator Rule in the Drawing View Properties dialog box.

The SystemRangeNavigator.dll Navigator Rule can be used to include all graphical objects under a non-graphical object. For more information on navigation rules, see the Navigator Rules section in Orthographic Drawings by Query.

See Also
Piping Isometric Drawings by Query Common Tasks (on page 89)

Setup (Piping Isometric Drawing by Query Component Shortcut Menu)

Sets component options for creating Piping Isometric Drawings by Query. This command is available on the shortcut menu for the Piping Isometric Drawing by Query component.

Setup Dialog Box (Piping Isometric Drawing by Query Component) (on page 93)

What do you want to do?

- Set up a Piping Isometric Drawing by Query component (on page 92)
- Create an isometric drawing (on page 98)

Set up a Piping Isometric Drawing by Query component

1. Right-click the folder where you want to store the new Piping Isometric Drawing by Query component, then select New.
   The Add Component dialog box displays.
2. Select the Piping Isometric Drawings by Query component, and then click OK.
   The Piping Isometric Drawing by Query component is created in the folder.
3. Right-click the Piping Isometric Drawing by Query component, and select Setup on the shortcut menu.
4. On the Setup dialog box, specify a filter in the Filter field. The dropdown shows the most recently selected filters. Click More to display the Select Filter dialog box and specify a filter. The filter you select is the "what" portion of the query; for example, Pipe Runs. Click Properties to display the current filter properties. For more information on filters for Drawings by Query, see Drawings by Query Filters (on page 90).
   (NOTE: Select a filter that is appropriate for the isometric styles you want to use for this Piping Isometric Drawing by Query component. For example, for the Iso_Pipeline style, the filter must contain piping and pipeline systems. For the Iso_Spool and Iso_PenSpool styles, the filter must contain spool assemblies.)
5. Specify a Style to use for the piping isometric drawings. The delivered styles include Iso_Pipeline, Iso_Piperun, Iso_Spool, Iso_PenSpool, Iso_WBS, and Iso_Stress. Your administrator may provide more isometric styles. Click More in the dropdown to display a list of all available styles. For more information, see Select Drawing Style Dialog Box (on page 94).

6. Click Properties to display the Isometric Style Options Browser. Modify options for the isometric styles you added as needed. For more information, see Customize isometric style options (on page 117).

7. Click OK to create the Piping Isometric Drawing component as specified.

To use the component to generate piping isometric drawings you need to save it as a package and associate it to a Drawings by Query Manager component. For more information, see Set up a Drawings by Query Manager component (on page 96).

**NOTES**
- To delete a component, right-click it and select Delete.
- To rename a component, right-click it and select Rename.

**Setup Dialog Box (Piping Isometric Drawing by Query Component)**

Sets options on Piping Isometric Drawing components.

**Filter** - Identifies the filter to use to define the "what" portion of the query. The software uses the filter to determine the objects included in the drawings when they are generated. Select More in the Filter dropdown list to display the Select Filter dialog box. Click to display the Filter Properties dialog box in order to edit the filter as needed. For more information on filters for Piping Isometric Drawings by Query, see Drawings by Query Filters (on page 90).

**Style** - Specifies the isometric style to use when generating the output for the piping isometric drawing. The delivered styles include Iso_Pipeline, Iso_Piperun, Iso_Spool, Iso_PenSpool, Iso_WBS, and Iso_Stress. Your administrator may provide more isometric styles. Click More in the dropdown to display the Select Drawing Style dialog. For more information, see Select Drawing Style Dialog Box (on page 94).

You can click the Properties to access the Isometric Style Options Browser and edit the isometric style as needed. For more information, see Isometric Style Options Browser (on page 130).

**See Also**
- Setup (Piping Isometric Drawing by Query Component Shortcut Menu) (on page 92)
Select Drawing Style Dialog Box

Displays a list of all available Isometric Styles. This dialog displays when you select More in the Style dropdown on the Setup dialog box for a Piping Isometric Drawing component or package.

See Also
Setup (Piping Isometric Drawing by Query Component Shortcut Menu) (on page 92)
Setup Dialog Box (Piping Isometric Drawing by Query Component) (on page 93)

Select Filter

Specifies a filter for orthographic or piping isometric drawings. The filter narrows the objects returned for the drawings.

For more information on setting up filters for Drawings by Query components, see Drawings by Query Filters (on page 90).

Select Filter Dialog Box (on page 94)

Select Filter Dialog Box

Creates, edits, deletes, and selects filters for use with the Define Workspace, Surface Style Rules, and other Select by Filter commands, including Project Management's Model Data Reuse (MDR), Drawings View Styles, and Reports commands that require runtime filter selection. You can access this dialog box in several ways as listed.

- Select File > Define Workspace, and select the More option in the Filter box.
- Select Format > Surface Style Rules, click New or Modify, and then select the More option in the Filter box.
- Select Tools > Select by Filter.

The tree view displays the following types of filters:

- **Catalog Filters** - These filters are used similarly to reference data in the Catalog. For example, a catalog filter could apply to company-wide operations. Your administrator can define Company_Filter_1, Company_Filter_2, and so forth.

- **Plant Filters** (for plant mode) or **Ship Filters** (for marine mode) - These filters are available to everyone assigned to a specific model database. There are delivered catalog filters to query on the different types of plant mode or marine mode objects. You must have the appropriate privileges to create, edit, or delete these filters.
- **My Filters** - These are personal filters that you create and place in the **My Filters** folder. They are visible only to you, the owner. You cannot see the personal filters of others, and they cannot see your personal filters. Select a filter from one of the listed filters, or create a new filter to meet your specific requirements.

  - **New Folder**
    - Creates a new folder.

  - **New Filter (Simple or Asking)**
    - Displays the **New Filter Properties** dialog box so you can create a new filter. Asking filters allow you to specify the parameters of the search. An asking filter has built-in functionality to ask for values (with boxes that you are required to record). The values apply to properties that you have already designated you will supply when the filter runs. Asking filters are portable between models.
    - **NOTE**: Model Data Reuse (MDR) does not support asking filters. The only valid filter types for an MDR transaction are System, Permission Group, Object Type, Volume and Properties. You can define the filter on any one of these tabs or in a combination using multiple tabs.

  - **New Compound Filter**
    - Displays the **New Compound Filter Properties** dialog box, which you use to create a new compound filter containing the Or, And, or Not operators. Compound filters are not supported for MDR.

  - **New SQL Filter**
    - Displays the **New SQL Filter Properties** dialog box, in which you can type the text of an SQL query. SQL filters are not supported for MDR.

  - **Delete**
    - Removes a filter or folder from the **Select Filter** list. If you delete a folder, the software also deletes its contents.

  - **Rename**
    - Changes the name of an existing filter or folder from the **Select Filter** list.

  - **Properties**
    - Displays the **Filter Properties** dialog box so you can select the properties that determine your filter search criteria.

**NOTES**

- If this dialog box is activated from the **Select by Filter** command, you can select multiple filters on this dialog box. Hold CTRL or SHIFT, and click each filter. When you click **OK**, all objects that fit the selected filters are selected.

- If this dialog box is activated from the **Select by Filter** command, it clears the select set before adding objects to the select set.
Setup (Drawings by Query Manager Component Shortcut Menu)

Sets options for creating a Drawings by Query Manager component. This command is available on the right-click shortcut menu for Drawings by Query Manager components.

The Drawings by Query Manager component is used in conjunction with other components, such as the Orthographic and Piping Isometric Drawing by Query components, to complete the query for objects in the model. The Drawings by Query Manager provides the filter that specifies the where side of the query. It tells the query where to look for the objects specified by the component what filter.

Setup Dialog Box (Drawings by Query Manager Component) (on page 97)

Set up a Drawings by Query Manager component

The Drawings by Query Manager component works in conjunction with the Orthographic Drawing by Query and Piping Isometric Drawing by Query components. Before using this command, you must create packages for your Orthographic Drawing by Query and Piping Isometric Drawing by Query components. For more information, see Save Package Command (on page 73).

1. Right-click the folder where you want to create your Drawings by Query Manager. The Add Component dialog box displays.
   
   **TIP** You can store the Drawings by Query Manager anywhere in the Console, but it is best to store it in the same location as the components with which it works.

2. Select the Drawings by Query Manager component, and then click OK. The Drawings by Query Manager component is created in the folder.

3. Right-click the Drawings by Query Manager component and select Setup to specify the properties for the component. The Setup dialog box displays.

4. Specify a filter in the Filter field. The dropdown shows the most recently selected filters. Select More in the dropdown list to display the Select Filter dialog box and specify a filter. Click Properties to display the current filter properties.
   
   The filter you select is the "where" portion of the query, as opposed to the "what" portion specified when you setup the Orthographic Drawing by Query or Piping Isometric Drawing by Query component. The filter you specify here tells where in the model you want to look for the objects.

   For more information on filters for Drawings by Query, see Drawings by Query Filters (on page 90).

5. In the Package field, specify the Orthographic Drawing by Query or Piping Isometric Drawing by Query package you created. The dropdown contains the most recently selected packages. Select More to display the Select Package dialog box. For example, if you are defining a Drawings by Query Manager for an Orthographic Drawing by Query, select an Orthographic Drawing by Query package.

6. Click OK to save the settings.
To create the drawings, you need to run the query. For more information, see Run Query (Shortcut Menu) (on page 97).

**NOTES**
- To delete a component, right-click it and select **Delete**.
- To rename a component, right-click it and select **Rename**.

**Setup Dialog Box (Drawings by Query Manager Component)**

Sets options for creating Drawings by Query Manager components.

- **Filter** - Identifies the filter to use to define the "where" portion of the query. The software uses the filter to determine where to look for the objects requested in Orthographic Drawing by Query and Piping Isometric Drawing by Query components when they are generated. Select **More** in the dropdown list to display the Select Filter dialog box. Click **Properties** to display the current filter properties. For more information on filters for the Drawings by Query Manager, see Drawings by Query Filters (on page 90).

- **Package** - Specifies the package to use in completing the query.

**NOTE** You must create an Orthographic Drawing by Query, Piping Isometric Drawing by Query, or 3D Model by Query package before setting up the Drawings by Query Manager component. For more information, see Save Package Command (on page 73).

**See Also**
Setup (Drawings by Query Manager Component Shortcut Menu) (on page 96)

**Run Query (Shortcut Menu)**

Runs the query associated with the selected Drawings by Query Manager component. For example, if you execute Run Query on a Piping Isometric Drawing by Query package associated with a Drawings by Query Manager, the software looks for piping in the model. The query results display beneath the style in the Management Console. You can create isometric drawings from the query results by right-clicking on the component and selecting Create Drawing(s).

If you have an Orthographic Drawing by Query package associated to a Drawings by Query Manager, the Run Query command runs the query associate with the components, collects the objects from the database, and builds the information that will be included in the drawing. You can then create orthographic drawings from the query results by running the Create Drawing(s) command on the Orthographic Drawing component.

The Run Query command uses the filters specified when you performed Setup components.

**NOTES**
- When working in a Global Workshare Configuration with users logging into both Host and Satellite systems for more than one site, you can encounter problems with the filters defined for a Drawing by Query package. For example, if you create a Filter Root Folder for a particular site, and then you try to run queries for drawings associated to this filter from another site, the Run Query command is unable to update the drawings due to a lack of permission against the Filter Root Folder. You have to move or transfer the Filter Root Folder to the appropriate site where the Run Query command is executed.
If the selected package was created and added manually, the folder name for the package must match the value for pkgid in the XML file. Edit the name of the folder to match the pkgid value.

See Also
Create Drawing(s) Command (on page 36)

Create an isometric drawing

1. Verify that at least one isometric piping drawing exists in the Console hierarchy. If none exists, add a Drawings by Query Manager component for isometric drawings.
2. Right-click the Drawings by Query Manager component, and then select Setup on the shortcut menu.
3. On the Setup dialog box, specify a filter in the Filter field. The list displays the most recently selected filters. Click More to display the Select Filter dialog box, and then specify a filter.
4. Specify a Package to use for the isometric drawings, and then click OK.
5. Right-click the isometric drawing style, and then select Run Query.

The hierarchy updates with the available items for that style.

TIP To display available items for all isometric styles in a component, right-click the component in the Console, and then select Run Query.
6. Right-click a folder, component, pipeline, or spool, and then select Update Document(s) to create isometric drawings.

TIP You can extract multiple objects (for example, pipelines) if you hold Ctrl or Shift while you select the objects in the Console or Detail View.

NOTE You can remove items from an isometric piping drawing component by modifying the filter and running the query again.

See Also
Piping Isometric Drawings by Query (on page 87)

View Extraction Data

This command helps you troubleshoot extraction errors by displaying part and report information for a line that has been processed. You can view the log file and Piping Component File (PCF) data for the extraction. If you have customized the style to produce report files such as the neutral file and cut pipe list, you can view those files directly in the Extraction Data dialog box. If you have overridden any style settings for a piping isometric drawing, you can view the style fragment data in the Extraction Data dialog box as well. For more information about overriding style options, see Option Override (Piping Isometric Drawing Shortcut Menu) (on page 177).

This command is available on the shortcut menu by right-clicking a line or isometric drawing in the tree view or list view.

Saving Extraction Data to File

If you need to review the data in more detail or the extraction data files are too large to view in the Extraction Data dialog box, you can right-click the isometric drawing document and select Save As to save the extraction information to a file. On the Save As dialog box, check the Isometric Drawings component type, then in the Target File Type dropdown, specify All Files to save all of
the extraction data files. You can also specify individual files; for example specify the **Target File Type** as **PCF File** to only save the PCF file information. For more information, see **Save As Command** (on page 65).

You can also save the original extracted PCF that is generated from Smart 3D in addition to the final PCF. Configure a ISOGEN preprocessor using **Supplementary.AuxiliaryPrograms.StartProgram** option, and then update the drawing. After updating the drawing, when you use **Save As** with the **All Files** option selected, the original extracted PCF file from Smart 3D is saved as `<filename>-extracted-pcf` in addition to the final PCF supplied to ISOGEN. For example, if the final PCF file name is `My_Pipeline`, then the extracted PCF is saved as `My_Pipeline-extracted-pcf`.

**IMPORTANT** You must configure a ISOGEN preprocessor StartProgram to store the extracted PCF. Otherwise, the software considers the final PCF as the extracted PCF.

*Extraction Data Dialog Box* (on page 101)

### What do you want to do?

- **View piping isometric extraction data** (on page 99)
- **View style fragment data** (on page 100)

### View piping isometric extraction data

1. In the **Console** hierarchy, right-click a piping isometric drawing.
2. Select **View Extraction Data** on the shortcut menu. The dialog box displays the part information and report information for the line, including the log file and Piping Component File (PCF) data.
3. To view the extracted parts information, select and expand the **Parts** node on the left side of the dialog box.
4. To view the report information, select and expand the **Reports** node on the left side of the dialog box.

![Extraction Data Dialog Box](image)

5. Type a query into the **Search** field at the top of the dialog box and press **Enter** or click 🔍 to locate the parts in the extraction data. For more information, see *Extraction Data Dialog Box* (on page 101).

**NOTES**

- If you have customized the style to produce report files, such as the neutral file and cut pipe list, you can also view those files directly in the dialog box.
- If you need to review the data in more detail or the extraction data files are too large to view in the **Extraction Data** dialog box, you can right-click the isometric drawing document and select **Save As** to save the extraction information to a file.

**View style fragment data**

1. Right-click a piping isometric drawing, and select **View Extraction Data**. The **Extraction Data** dialog box (on page 101) displays.
2. Expand the **Reports** and **StyleFragment** nodes, and select **Override**.
The contents of the style fragment, which includes the override setting, display in the view area on the right. An example is shown below.

![Extraction Data Dialog Box](image)

**NOTE** For more information about overriding style options, see Option Override (Piping Isometric Drawing Shortcut Menu) (on page 177).

**Extraction Data Dialog Box**

Provides troubleshooting information for the isometric drawing extraction process by displaying parts and reports. You can access this dialog box by right-clicking a piping isometric drawing and selecting View Extraction Data on the shortcut menu.

**NOTE** If you need to review the data in more detail or the extraction data files are too large to view in the Extraction Data dialog box, you can right-click the isometric drawing document and select Save As to save the extraction information to a file. For more information, see Save to a file (on page 66).

**Search Box**

The Search box at the top of this dialog box allows you to find parts that meet the search criteria. You must type the search text as ?<command>:<value>. The table below lists the allowable commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Value</th>
<th>Action</th>
</tr>
</thead>
</table>
| COORD   | Type a space separated coordinate value | Displays a list of parts at the specified coordinate.  
- Clicking the component selects the corresponding node in the Parts tree.  
- Double-clicking on the component replaces the list with its details. |
Piping Isometric Drawings by Query

<table>
<thead>
<tr>
<th>END</th>
<th>No value</th>
<th>Displays a list of pipeline end parts.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• Clicking the component selects the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>corresponding node in the Parts tree.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Double-clicking on the component replaces the list with its details.</td>
</tr>
</tbody>
</table>

| OID    | Type the OID value, including the curly-brackets ({{OID value}}) | Selects the node for the component in the Parts tree. |

For example, if you type ?COORD:29260.800 3962.400 5486.400 6 in the search box, the software displays the component with the corresponding COORD value in the tree, if one exists. When you click the listed component, the corresponding node in the Parts tree is selected. Double-click the listed component to display all of the component details.

**Parts**

You can view the extracted parts by expanding the **Parts** node on the left side of the dialog box.

The **Reports** node includes:

**Log File**
Piping Component File (PCF)

Extracted Piping Component File (PCF)

**NOTE** The extracted PCF is stored only if a StartProgram is configured. For more information on how to store original extracted PCF, see View Extraction Data (on page 98).
IsoSheet
Other Report Files
Examples include Supplement file, Neutral file, and Style Fragment file.
Piping Isometric Drawings by Query
SECTION 8  
Isometric Drawing Styles

Isometric drawing styles control several aspects of the isometric drawing output, including the output location and the type of object used for drawing creation. Each drawing style is also associated with a set of options and a backing sheet.

To customize the isometric drawing styles for your company, you can copy and then modify the delivered isometric drawing styles.

Delivered Isometric Drawing Styles

The delivered isometric drawing styles are Iso_Pipeline, Iso_Piperun, Iso_Spool, Iso_PenSpool, Iso_WBS, Iso_Stress, and Iso_System. Marine mode also delivers the Iso_Assembly drawing style. Each delivered style has an associated XML file and IGR file. The XML file contains the isometric options, and the IGR file is the backing sheet for the isometric drawing.

- **Iso_Pipeline** - Creates a final isometric drawing used to construct the plant. This style creates one drawing per pipeline system. This drawing style is an example of a potential configuration for a fabrication isometric. It includes a material list.
- **Iso_Spool** - Creates an isometric drawing used in the fabrication shop to manufacture the pipe. This style uses piping spools. You can create spools using the Generate Spools command in the Piping task. Like the final isometric style, it includes a material list.
- **Iso_WBS** - Creates an isometric drawing that documents a collection of parts that are assigned to one Work Breakdown Structure (WBS) item of the type Group Iso Drawing. This style creates one drawing per WBS item.
- **Iso_Stress** - Creates a Piping Component File (PCF) that can be output to the CAESAR II pipe stress analysis software. No drawing is created. To save the PCF file, use the Save As command. For more information, see Create a piping component file (PCF) (on page 67).
- **Iso_PenSpool** - Creates an isometric drawing that documents penetration spools that consist of a penetration plate and several piping spools. This style creates one drawing per penetration spools. You can create penetration spools using the Create Penetration Spools command in the Piping task.
- **Iso_Piperun** - Creates a draft of an isometric drawing for checking against project guidelines. This style creates one drawing per pipe run. This drawing style is an example of a drawing configuration used for checking pipeline designs prior to extracting the fabrication isometric.
- **Iso_System** - Creates an isometric drawing that documents a system, typically a piping system of connected pipelines. This drawing style creates one drawing for each system. Each pipeline change is called out on the drawing.
- **Iso_Assembly** (Marine mode only) - Creates an isometric drawing that documents piping block assemblies. This drawing style creates one drawing for each block. Assembly blocks split the pipelines into pipe parts (similar to spools). For more information, see Create Isometric Drawings by Query using Block Assemblies.

You can create other isometric drawing styles, such as a Bid style for construction contractors to bid on a project.
Migration of Isometric Drawing Styles

Migration of isometric drawing styles occurs automatically when you do one of the following two things:

- In migrated catalogs, the software only migrates the isometric drawing styles that already exist in the catalog (the XML style files that already exist in the catalog database as objects). For more information, contact Intergraph Support Services. You can find support information on our web site [http://support.intergraph.com](http://support.intergraph.com/).

- Automatically migrate your existing or modified isometric styles by opening them in the Isometric Style Options Browser and saving them to the catalog. For more information, see Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115).

Isometric Options

The isometric options define the isometric drawing output, which includes symbols, dimensions, layers, drawing frame attributes, material lists, weld lists, detail sketches, and many other settings. The options are stored in XML file in the [Reference Data Product Folder]\SharedContent\PmfgIsoStyleData folder on the server.

You should modify the option control data using the Edit Options command. The command displays the Isometric Style Options Browser, which is the tool used to control centrally all the options related to the appearance and information content of the various styles of isometric drawings. If you directly manipulate the XML file, your changes may not take effect in the software.

You can also use the Edit Options command to import, export, and save symbol maps.

The Option Override command provides the flexibility of modifying option control data on a per drawing basis. This feature allows you to override style settings for a single piping isometric drawing without having to define a new drawing style.

The isometric option control data is integrated within the catalog reference data. You must have access rights to the catalog reference data to edit and save the option control data.

Backing Sheets

The backing sheet allows you to customize the drawing style with your company's logo, watermark, and drawing borders. The delivered backing sheets are stored as IGR files in the [Reference Data Product Folder]\SharedContent\PmfgIsoStyleData folder on the server.

A document can include two different types of sheets: working sheets and background sheets. Working sheets contain design data, and background sheets contain title block graphics, borders, company logo, and watermarks. Each working sheet can contain a reference to a background sheet. If this reference is set, the size of the background sheet determines the size of the working sheet. Also, graphics on the background sheet become visible in the working sheet.

**NOTE** Graphic objects used in the background sheets must be embedded, not linked, using the Insert > Object command in SmartSketch Drawing Editor when editing the drawing or the drawing template.

When you create a backing sheet for isometric drawings, the backing sheet must have the following characteristics:

- It must contain a single, empty working sheet.
- It must contain a single background sheet containing the required graphics. The background sheet should be set to the appropriate size and scale.
The working sheet must contain a reference to the background sheet.

The working sheet must be active when you save the template.

The working sheet should have layers set up with the required colors, unless the color is specified explicitly in the isometric options. If the working sheet does not have the required layers, the ISOGEN software creates the layers automatically and assigns them to the colors specified in the options.

**Embedded Labels in Isometric Drawing Styles**

To enable recursive expansion of embedded labels used in isometric drawings styles, the report RFM file must set the **ToParse** flag to **Yes**, as in the following example:

```xml
<Data
    Column="ShortMaterialDescription"
    ToParse="yes"
    Visible="yes"/>
```

**See Also**

*Customize isometric style options* (on page 117)

*Override isometric drawing style options* (on page 178)

**Isometric Drawing Types**

An isometric drawing normally consists of a number of parts that are physically connected so that they form a network such as a pipe run, pipeline or spool. By using the **S3D.Drawing.DrawingClass** and **S3D.Drawing.SortInputParts** style settings, it is possible to create several other types of drawings.

**Disconnected Section Drawings**

If the parts that make up a drawing consist of several networks of connected parts, you can set **S3D.Drawing.SortInputParts** to **Connected Sets** in the isometric style to enable support for multiple connected networks in the same drawing. Each network produces output as though it was in its own drawing but the output is collected into the same drawing file.
The example below shows a single pipeline that consists of two networks.
The resulting drawing looks like this:

By default, each section is given a pipeline reference as normal. If any duplicates are created, then a number is appended to make the references unique.
Multi-Pipeline Drawings

If the parts that make up a drawing consist of more than one pipeline, you can set `S3D.Drawing.SortInputParts` to `Pipeline` in the isometric style to enable support for a multi-pipeline drawing. Each pipeline outputs in a single drawing file as a disconnected section with its own pipeline reference. This is useful for groups of related pipelines that are not connected, such as the equipment trim.

System Drawings

If the parts that generate the drawing consist of more than one pipeline and they are connected as a single network, you can set `S3D.Drawing.DrawingClass` to `System` in the isometric style to create an ISOGEN system drawing. Any boundaries between the pipelines in the system are indicated on the drawing.

**NOTE** If `S3D.Drawing.DrawingClass` is set to `System` the value of `S3D.Drawing.SortInputParts` will be ignored.

The example below shows a drawing of the following pipelines `SimpleSystem – Pipeline 1` and `SimpleSystem – Pipeline 2` using a WBS Item called `VerySimpleSystem`. 
The resulting drawing looks like this:

**Jacketed Pipeline Drawings**

If the parts of a drawing consist of jacketed pipelines, the jacket pipe is drawn as a hollow pipe to indicate the presence of the core pipe, and each connection between the jacket and core pipes are indicated with continuation references. The core pipes display continuation references for jacket pipes whereas jacket pipes display continuation references for core pipes.

To generate jacketed pipeline diagrams, make sure that the jacket and core pipe association has been established. For more information, see *Placing the Jacket Pipe and Components in Piping User's Guide*.

**NOTE** You must use the JFWN (weld neck jacket flange) and JFSO (slip on jacket flange) three-port flanges SKEYs for jacket flanges. For more information, see *Flanges (SKEYs)* (on page 793).

The example below shows a core pipeline drawing with a continuation reference for the jacket pipe.
Isometric Drawing Styles

The example below shows a jacket pipeline drawing with a continuation reference for the core pipe.

![Jacket Pipeline Drawing](image)

Isometric Style Common Tasks

The following tasks are used when you create new piping isometric styles.

**Modify Drawing Border Files**

You can create or modify border files two ways. You can modify existing delivered border files. For more information, see *Modify an Existing Border File* (on page 374).

If you have existing MicroStation J (V7) DGN files you want to use as a drawing border, you can import them. For more information, see "Import an Existing MicroStation DGN Border" in the *Drawings and Reports Reference Data Guide*.

**Create New Isometric Styles**

You can add new isometric styles to the delivered *BulkLoadIsoKeys.xls* file and bulkload the changes into the model data. For more information, see "Create a New Isometric Style" in the *Drawings and Reports Reference Data Guide*.

**Use the Isometric Style Options Browser**

You can modify, save, and import style options through the Isometric Style Options Browser. For more information, see *Customize isometric style options* (on page 117).

**Importing Data from the Style XML File**

You can import style data from the style XML file directly through the Isometric Style Options Browser. When you import styles, they are shown immediately within the Browser. For more information, see *Import data from the style XML file* (on page 120).

**Develop the Look and Feel of Drawings**

You can change the look and feel of an isometric drawing by changing options within the Isometric Style Options Browser. Options can specify everything from drawing content to the system controls for output definition. You can also use the Drawing Setup Tool to customize the content and format of the isometric drawing for a specific drawing style. You can customize the drawing frame and specify which reports are plotted on the isometric drawing when it is generated. You can also define the layout and appearance of the plotted report data. For more information, see *Drawing Setup Tool* (on page 131).
Override Drawing Style Options

You can override isometric drawing style options on a per drawing basis. For more information, see Option Override (Piping Isometric Drawing Shortcut Menu) (on page 177).

Use Alternative Text

AText is an abbreviation for alternative text, an ISOGEN feature that allows you to change or remove any text on the isometric drawing. You can substitute your own text in the place of standard ISOGEN words. For more information, see Alternative Text Options (on page 416).

Map Isometric Data to Drawing Layers

You can map layers within a previously created drawing border file to isometric data. The options used to define the mapping are found in the Isometric Style Options Browser in the Drawing.Layers and Drawing.Definitions options. For more information, see Map Isometric Data to Drawing Layers (on page 183).

Configure the Material List

You can specify three different styles for material lists on isometric drawings. You use the Isometric Style Options Browser to set the options for the MTO Neutral File.

Assign Labels

You assign labels to attributes within a drawing through the Isometric Style Options Browser. For more information, see Assign labels (on page 117).

Populate the Title Block

You can use labels to customize the title block of a drawing. Labels are often used for single pieces of data, such as the approval date or your company name. You can use the Isometric Style Options Browser to specify options for the appearance and content of the title block. For more information, see Populate the title block (on page 118).

Setting the Symbol Mapping

You can set symbol mapping in the Isometric Style Options Browser. For more information, see Symbol Mapping Options (S3D) (on page 684).

Edit Options (Piping Isometric Drawing Component Shortcut Menu)

Sets options for isometric drawing output, such as dimension styles, layers, drawing frame text, material lists, and weld lists.

You can also use the Edit Options command to import, export, and save symbol maps. You can import isometric styles from a previously created and saved XML file containing isometric keys.

You can access this command by right-clicking a Piping Isometric Drawings component or package in the Console. You must have access rights to the catalog reference data to save isometric options to the Catalog database.
The **Edit Options** command and the **Isometric Style Options Browser** set many isometric drawing style options:

- *Fonts in Isometric Drawings* (on page 162)
- *Flow Arrows* (on page 165)
- *Bending Files* (on page 167)
- *Material Lists and Material List Files* (on page 167)
- *Pipeline Lists* (on page 171)
- *Weld Lists and Weld Files* (on page 172)

**NOTE** For more information on isometric style options, see *Appendix: Isometric Drawing Options* (on page 415).

**Isometric Style Options Browser** (on page 130)

**Drawing Setup Tool** (on page 131)

---

**What do you want to do?**

- Customize isometric style options (on page 117)
- Assign labels (on page 117)
- Populate the title block (on page 118)
- Import data from the style XML file (on page 120)
- Set drawing frame options (on page 120)
- Edit the North arrow on isometric drawings (on page 121)
- Set drawing dimension options (on page 122)
- Control drawing content (on page 122)
- Set drawing control options (on page 124)
- Specify drawing format (on page 124)
- Create a key point note (on page 124)
- Enable revision clouds (on page 126)
- Assign unique part numbers (on page 127)
Customize isometric style options

Isometric drawing styles control several aspects of the isometric drawing output, including the output location and the type of object used for drawing creation. Each drawing style is also associated with a set of options.

1. Right-click a piping isometric component or package in the Management Console, then click Edit Options to display the Isometric Style Options Browser.
2. Select a style option category in the hierarchy. Expand a branch on the tree to see the options.
3. Edit the options as necessary in the data grid on the right-hand side of the dialog box.

   **TIPS**
   - To find an option, type text in the Search box to locate the option in the hierarchy.
   - You can find the option and switch number for the currently selected item displayed at the lower right of the dialog box.
   - For the collection-based option categories (such as Drawing.Layers.Layers), you can insert or delete rows in the grid by pressing the Insert or Delete keys or by clicking Insert Row ✔ or Delete Row ✗.

4. Click Save To Catalog ️ to save the changes to the Catalog database. You must have write permission to reference data to save changes to isometric styles in the catalog.
5. Save the option style data by selecting the root node, then clicking Save Style XML File ️. To import style data, click Import Data From File ️.
6. You can view the catalog style rule properties by clicking Catalog Style Rule Properties ️.

Assign labels

You assign labels to attributes within a drawing through the Isometric Style Options Browser. There are different types of labels that can be applied. The Component Note, the Continuation Note, and the Nozzle Note are used as examples below.

**Isometric Component Note**

1. Right-click a Piping Isometric Drawing component or package in the Management Console or Drawing Console, and then click Edit Options to display the Isometric Style Options Browser.
2. Expand S3D.Labels.ComponentNote. The right side of the dialog box shows the options specified as Component Notes within the current style.
3. To create a new Component Note, click Insert Row ✔. Set the attributes for the new Component Note as needed. For example, select PipeSupport from the dropdown list in the LabelAttribute2 field.
4. In the LabelName field, click the ellipsis button to open the Catalog Labels dialog box. Select a label to use for the Component Note.
5. If you want the Component Note to be enclosed by a border or bubble, specify it in the MessageEnclosure field.
6. Click **Save to Catalog** to save the changes to the Catalog database. You must have write permission to reference data to save changes to isometric styles.

7. Update your document to see the new applied style.

**Continuation and Nozzle Note**

1. Right-click an isometric style in the **Console**, and then click **Edit Options** to display the **Isometric Style Options Browser**.

2. Expand **S3D.Labels.EndConnection**. The **END-CONNECTION-EQUIPMENT** and **END-CONNECTION-PIPELINE** entries are the labels that give you the nozzle notes and continuation notes.

3. Make changes as necessary.

4. Save to the catalog as shown in the previous example.

5. Update the document to see the new applied style.

**NOTE** To enable recursive expansion of embedded labels, the report RFM file must set the **ToParse** flag to **Yes**, as in the following example:

```xml
<Data
  Column="ShortMaterialDescription"
  ToParse="yes"
  Visible="yes"/>
```

**Populate the title block**

You can use labels to customize the title block of a drawing. Labels are often used for single pieces of data, such as the approval date or your company name. You can use the **Isometric Style Options Browser** to specify options for the appearance and content of the title block.

The workflow for setting up attributes to populate the title block involves several steps. They are broken down as follows:

- Mapping host attributes to ISOGEN attributes using the **S3D.AttributeMAP** options within the **Isometric Style Options Browser**.
- Assigning labels as needed using **S3D.Labels.DrawingFrame** options.
- Positioning text on the border with the **DrawingFrame.Attributes** options.

**Mapping Attributes**

1. Right-click a Piping Isometric Drawing component or package in the **Management Console** or **Drawing Console**, and then click **Edit Options** to display the **Isometric Style Options Browser**.
2. Expand the **S3D.AttributeMAP** node and select **AttributeMAP**. Notice the mapping of **ExternalName** (host attribute) to **Name** (ISOGEN attribute). For example, the following graphic shows **Piping Specification** is mapped to **PIPING-SPEC**.

3. Expand **S3D.Labels.DrawingFrame**.

4. Notice the mapping of **IsogenAttributes** to labels. For example, **ISOGEN Attribute PIPELINE-REFERENCE** is mapped to the delivered catalog label **Piping Isometrics Pipe Line Reference**.

Some of the ISOGENAttributes are hard-coded. For example, **PIPING-SPEC** always returns the specification of the pipeline. It does not need or accept a label.

### Assigning Labels within the Title Block

1. Expand **S3D.Labels.DrawingFrame**.

2. Specify the mapping of **LabelAttributes** to **LabelNames**. In the **LabelName** column, click the ellipsis button to display the **Catalog Label** dialog box.

3. Expand branches of the catalog label hierarchy and select the label you want to assign to the **Label Attribute**.

### Positioning Labels on the Drawing Border

1. Expand **DrawingFrame.Attributes**.

2. Notice the mapping of **AttributeName** to a location on the drawing sheet. The following graphic shows a sample mapping.
NOTE When editing the **Drawing Frame.Attributes**, do not remove the **Pipeline Reference** from the **AttributeName** list.

3. All values are listed in **mm**, measured from the origin of the sheet. For example, **Pipeline Reference** is shown in **3.2 mm** font size at **X=164mm**.

4. Change values as needed to position labels on the drawing border.

**Import data from the style XML file**

You can import style data from the style XML file directly through the **Isometric Style Options Browser**. When you import styles, they are shown immediately within the Browser. The level of the hierarchy selected when you invoke **Import** and all levels below it are replaced with the new values from the imported file. The following procedure uses the **S3D.Labels.DrawingFrame** level as an example.

1. Right-click a Piping Isometric Drawing component or package in the **Management Console** or **Drawing Console**, and then click **Edit Options** to display the **Isometric Style Options Browser**.

2. Expand **S3D.Labels.DrawingFrame** and select **DrawingFrame**.

3. Click **Import Data From File** and browse to the folder where the style XML file is located. For example, you may have edited the style content of the **Iso_Pipeline.xml** file located in "\Program Files\SmartPlant\3D\Drawings\Templates\Styles".

4. Select the file and click **OK** to retrieve the style information. A dialog box displays to confirm the file you selected. Click **Yes** to continue. The style option information is updated in the browser. Bulkloading is not necessary.

5. Click **Save to catalog** to save the changes to the Catalog database. You must have write permission to reference data to save changes to isometric styles.

6. Update your document to see the new applied style.

**Set drawing frame options**

Using the **DrawingFrame** and **S3D.AttributeMAP** options, you can specify the content and placement of drawing frame attributes on isometric drawings. Drawing frame text can include revision control information, process conditions, and miscellaneous design or specification notes, placed in the isometric drawing border or title block area. For more information on drawing frame options, see **Drawing Frame Options** (on page 543).

To specify this text, you first map ISOGEN attributes with user-defined text strings. You will use the text strings during the remainder of the attribute definition process. Then, you specify the size and position of the attribute text in the **DrawingFrame.Attributes** category.
For example, you can map the ISOGEN attributes DRG and DESCRIPTION with the strings Drawing Number and Description, respectively. When ISOGEN processes the Piping Component File (PCF) content given below, the values "CW-PipeRun1" and "Chillwater Drawing" are inserted into the title block accordingly.

```
DRG CW-PipeRun1
DESCRIPTION Chillwater Drawing
```

You can also use labels to specify drawing frame text. In the S3D.Labels.Drawing Frame category, you map ISOGEN attributes to label definitions in the catalog.

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options. The Isometric Style Options Browser displays.

2. Open the S3D.AttributeMAP category, and add rows or modify the rows in the grid.

   **TIPS**
   - Type a meaningful text string in the ExternalName column. You will use this text string in the Drawing Frame category.
   - Select corresponding strings in the Name column.

3. Go to DrawingFrame.Attributes.

4. List all the attributes along with their corresponding locations and text sizes. Use the ExternalName strings you typed in the S3D.AttributeMAP category.

5. To use a label for drawing frame text, add an ISOGEN attribute to the S3D.Labels.Drawing Frame category, and map it to a label name and message enclosure.

**NOTES**
- When editing DrawingFrame.Attributes, do not remove the Pipeline Reference from the ExternalName list.
- Sample labels for drawing frame text on isometric drawings include a pipeline reference label and current date label. The templates for these labels are located in the [Product Folder]\CatalogData\Symbols\Labels\Base Templates folder.
- Another example of drawing frame customization is removing the north arrow. For more information, see Edit the North arrow on isometric drawings (on page 121).
- You can customize the mapping of ISOGEN Attributes ATTRIBUTE11 through ATTRIBUTE199. ATTRIBUTE1 through ATTRIBUTE10 are reserved by Intergraph. We recommend that you start adding your own attributes from ATTRIBUTE21.

### Edit the North arrow on isometric drawings

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options.

2. Open the DrawingFrame.Attributes category.

3. Click in the grid, and then press Insert to add a new row, or use the Insert Row command on the toolbar.

4. In the AttributeName column, select NORTH-ARROW-POSITION.

5. In the XPos and YPos boxes, specify the X- and Y-coordinates of the north arrow.

   **TIP** To turn the north arrow off, type 0 in the XPos and YPos boxes.
6. In the CharHeight and CharWidth boxes, specify the height and width.
7. Save the options, and extract some drawings to test.

**NOTE** It is not necessary to map the North Arrow Symbol attribute in the S3D.AttributeMAP category.

### Set drawing dimension options

Using the Drawing.Dimensions options in the Isometric Style Options Browser, you can specify how dimensions are used and displayed within the drawing. The options include such things as how dimensions are rounded, limits at which to suppress dimension display, and how coordinates are displayed. For example, to turn on the dimensioning for tapped branches on piping, you would do the following:

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options. The Isometric Style Options Browser displays.
2. Expand Drawing.Dimensions.
3. Change the TapOnPipe option as needed. You have three setting from which to select: None, Full, or Pipe Only.
4. Click Save To Catalog to save the changes to the Catalog database. You must have write permission to reference data to save changes to the isometric style.
5. Update the document to see the changes made to the drawing dimensions.

**NOTE** For more information on drawing dimension options, see Dimensions (Drawing) (on page 442).

### Control drawing content

Using the S3D.Drawing.Content options, you can specify the content of the isometric drawing. The options allow you to set such things as turning on and off specific coordinates or excluding certain items from the drawing. For descriptions of these options, see Content (S3D Drawing) (on page 655).

For example, if you want to exclude continuation parts from the drawing, you would set the following:

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options. The Isometric Style Options Browser displays.
2. Expand S3D.Drawing.Content.
3. Change the ExcludeContinuationParts option to True.
4. Click Save To Catalog to save the changes to the Catalog database. You must have write permission to reference data to save changes to the isometric style.

When you update your drawing document, the software excludes the continuation parts from the drawing content.
Using the HonorSpoolAtBranch Option

Another way you can control the content of your isometric drawings is to create your drawings on pipelines that maintain spool integrity at branches. The `S3D.Drawing.Content.HonorSpoolAtBranch` option gives you this control.

You should generate the spools with the **Include Stub-Ins with Header Spool** property set to **True** when using the **HonorSpoolAtBranch** option. For more information, see the *Piping User's Guide*, available from **Help > Printable Guides**.
For example, in the following graphic, even though the software extracts Pipeline_001 and the stub-in and flange do not belong to the pipeline, they must be manufactured together because they are part of the same spool. Setting the **HonorSpoolAtBranch** option to **True** means that all of Spool 1 is included in the isometric drawing for Pipeline_001 and is not included in the isometric drawing for Pipeline_002 (provided the **Include Stub-Ins with Header Spool** was set to **True** when you generated the spools for both pipelines).

For more information on this option, see *Content (S3D Drawing)* (on page 655).

**Set drawing control options**

You use the **Drawing.Controls** options to set system controls for the isometric drawings. For more information on drawing control options, see *Controls (Drawing)* (on page 428).

**Specify drawing format**

The **Drawing Area** style category in *Isogen Configuration* contains options for defining drawing isometric drawing objects, such as components, enclosures, and details sketches. For example, you can do the following:

- Specify the style of the enclosure box for flange rotation angles as having round ends with the **Drawing Area > Piping Components > Flanges > Enclosure Style** option.
- Set **Drawing Area > Content > North Arrow > Show Enclosure** to **True** to display the north arrow inside its own box.

For more information on drawing format options, see *Drawing Area.Drawing Area* in the *Isometric Drawing Options Reference Guide* available with the **Help > Printable Guides** command in the software.

**Create a key point note**

1. Right-click a Piping Isometric Drawing component or package in the **Management Console** or **Drawing Console**, and then click **Edit Options**.
   
   The **Isometric Style Options Browser** displays.

2. Expand **S3D.Drawing.KeypointNotes**.
The right side of the browser shows the options defined for key point notes within the current style. For more information, see Key Point Notes (S3D Drawing) (on page 660). An example is shown below.

3. To create a new key point note, click **Insert Row**. Set the attributes for the note as needed.

4. Specify a purpose for the note in the **Purpose** list.

5. In the **Keypoint** list, select the required key point. If a specific key point is not needed, select **Any**.

6. If you want the note to be enclosed by a border, select the required type in the **MessageEnclosure** list.

7. Click **Save to Catalog**.

   The software saves the changes to the Catalog database.

**IMPORTANT** You must have write permission to reference data to save changes to isometric styles.

**NOTE** For information about assigning a key point note to a drawing component, see "Insert a Note" in the **Common User’s Guide**, which is available using the **Help > Printable Guides** command in the software.
Enable revision clouds

Revision clouds are an ISOGEN customization feature that allows components within the isometric graphics to be "clouded". Revision clouds are typically used to indicate a section of the pipeline that has been revised. An example of a revision cloud as it displays on the isometric drawing is shown below.

The traditional representation of revision clouds on the isometric drawing can be modified to output a polygon enclosure, which can optionally be filled with a color.

![Revision Cloud Example](image)

**NOTE** There are two revision attributes. The first is the pipeline revision attribute, which defines the current revision of the whole pipeline. This attribute is commonly incremented whenever a new revision is issued. The second is a component revision attribute. This attribute is available for all components in the pipeline and defines the revision that the component was introduced in the pipeline. For revision clouds to be activated on specific components, the pipeline revision and the component revision must be equal.

1. Right-click a Piping Isometric Drawing component or package in the **Console**, and then select **Edit Options**.
The Isometric Style Options Browser displays.

2. Go to Drawing.Revisions.

The right side of the browser shows the options that you can define to control the output of revision changes on the isometric drawing for the current style. For more information, see Revisions (Drawing) (on page 522). An example is shown below.

3. Set Enabled to True.

4. Specify the distance from the component centerline to the revision box.

5. Define the required values for Colour and Layer. The numbers you specify depend on the drawing system being used, such as AutoCAD or MicroStation.

6. In the EnclosureType list, specify whether the revision box enclosure is a cloud or a polygon.

   **NOTES**
   - If you select Cloud, you must also define MinCloudArc and MaxCloudArc.
   - If you select Polygon, you can optionally define a fill color for the enclosure.

7. Click Save to Catalog.

   The software saves the changes to the Catalog database.

   **IMPORTANT** You must have write permission to reference data to save changes to isometric styles.

### Assign unique part numbers

Unique part numbers are used to apply a unique number for each material on the isometric drawing. This is typically used for traceability and to assign heat numbers.

The part numbers are unique per pipeline and are in the format of 1.x, where x is a number or an alpha character. The examples below show the two format options (highlighted in yellow).
A table of unique part numbers can also be plotted on the isometric drawing. This table is usually used to map the manually-input heat numbers against. An example is shown below.

1. Right-click a Piping Isometric Drawing component or package in the Console, and then select Edit Options.
The Isometric Style Options Browser displays.

2. Go to Supplementary.Traceability.

The right side of the browser shows the options that you can define for the properties associated with unique part numbers. For more information about these properties, see Traceability (Supplementary) (on page 643).

3. Set UniquePartNumber to Alpha or Numeric, depending on the required suffix.

4. Use UniqueNosBolts and UniqueNosGaskets to control whether bolts and gaskets are assigned unique numbers.

5. Set the remaining properties as needed.

6. Click Save to Catalog.

The software saves the changes to the Catalog database.

IMPORTANT You must have write permission to reference data to save changes to isometric styles.

To output a traceability file and then define its contents, open Supplementary.Traceability and specify the options listed below.

1. Set Enabled to True to create a traceability file.

2. In the Path box, specify the location for the traceability file. Type the full path location and file name.

3. Expand the Traceability node, and select the Traceability collection.

4. Define the attributes as needed. For more information, see Traceability Collection (Supplementary Traceability) (on page 645).

5. Click Save to Catalog.

The software saves the changes to the Catalog database.

NOTE To output the unique part numbers in the material control file, open MaterialList.SummaryFile and set IndividualEntries to True. The resulting output is similar to the example below.
Isometric Style Options Browser

Sets options for an isometric drawing style. You access this dialog box by right-clicking a Piping Isometric component or package and selecting **Edit Options** on the shortcut menu. The **Isometric Style Options Browser** controls all the options related to the appearance and information content of the various styles of isometric drawings. You can save changes permanently to the Catalog database.

The left pane of the browser window groups the options for a style. Click a node to view its corresponding table. For descriptions of the options, see *Appendix: Isometric Drawing Options* (on page 415). The **S3D.SymbolMAP** node shows the current symbol mapping options available. For more information on symbols and symbol keys, see *Appendix: Symbols and Symbol Keys* (on page 696).

The right pane of the browser window shows the values set for the options. The grid presents two overall types of options. One type lists the options in two columns: **Property** and **Value**. An example is the **Drawing Frame** options. The other type lists the options in a multi-column format, where each row is part of an associated collection of options. An example is **CutList.SummaryFile.SummaryFile**.

**NOTE** In the **Dimensions** option, setting **Drawing.Dimensions.Format** to **Composite** and **Drawing.Dimensions.Overall** to **Across Branches** results in both the pen plate and the overall dimensions being shown on the drawing. Both options must be used together to get the overall dimension call outs on the drawing.

You can sort the columns by clicking the column headings. For the collection-based option categories, you can insert or delete rows by pressing the **Insert** or **Delete** keys on the keyboard or by using the **Insert Row** and **Delete Row** buttons on the toolbar.
Save to Catalog - Stores the isometric style options in the reference data. You must have write permission to the reference data for the software to store your changes in the Catalog database.

Import Data From File - Imports either a bulkload spreadsheet containing the isometric keys or a previously saved XML file containing the isometric keys. For more information, see Import Data from the Style XML File (on page 120).

Save Style XML File - Saves the current style option data to an XML file. You can later import it. This button is enabled when you select the root node in the Options Browser.

Catalog Style Rule Properties - Displays information about the current style, such as name, type, description, and path to the isometric drawings. This information is stored in the Catalog database. This button is enabled when you select the root node in the Options Browser.

Drawing Setup Tool - Opens the Drawing Setup Tool, which you can use to customize the content and format of the isometric drawing for the selected isometric drawing style

Insert Row - Moves the cursor to the next empty row. There is always a blank row at the bottom of the table available for editing.

Delete Row - Deletes the selected row from the table displayed in the Table section of the dialog box.

Search - Finds an option based on text that you type. This command searches in the Property column. The software returns the results in the table portion of the browser. To find an option, type text in the Search box in the upper right of the Isometric Style Options Browser and press Enter. You can also type specific option numbers in the Search box. For example, you can type ?OPT:79 to find option 79.

See Also
Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115)
Isometric Drawing Styles (on page 107)

Drawing Setup Tool

Customizes the content and format of the isometric drawing for the active isometric drawing style.

NOTE You can access the Drawing Setup Tool only from within the Isometric Style Options Browser. For more information, see Open the Drawing Setup Tool (on page 134).

Many of the settings that you can configure using Edit Options relate to the positioning of elements on the drawing. Editing these directly in the Isometric Style Options Browser can be time-consuming. The Drawing Setup Tool enables you to edit drawing style properties in a graphic view, which can often be much easier. You can graphically define the position of the drawing area on the backing sheet and specify which user-defined reports, if any, are output on the drawing. You can also use the tool to define the attributes that display on the drawing frame. The options that you define in the tool can then be saved to the current isometric drawing style so that they are applied to the generated drawings.

The Drawing Setup Tool consists of a series of tabbed pages, each of which contains a set of options and properties that are specific to a particular aspect of the drawing setup, and a horizontal and vertical toolbar. The pages listed below appear by default for each isometric drawing style:

- Basic Setup
Isometric Drawing Styles

- Drawing Areas
- Attributes

If a user-defined Material List, Weld List, or Cut List report is currently associated with the selected isometric drawing style, or if you choose to add one of those reports during the Drawing Setup Tool process, a tabbed page specific to that report type is automatically displayed so that you can configure those settings as well. The example below shows the complete set of tabbed pages that can display in the tool:

![Drawing Setup Tool](image)

**Basic Setup Page** (on page 145)

**Drawing Areas Page** (on page 146)

**Material List Page** (on page 149)

**Weld List Page** (on page 154)

**Cut List Page** (on page 157)

**Attributes Page** (on page 160)

**Add/Remove Attributes Dialog Box** (on page 161)

The commands on the vertical and horizontal toolbars provide options for navigating through the tool and for manipulating the graphical view. For example, you can adjust the view to display the entire backing sheet, or you can focus on a specific area, such as the drawing frame. You can also increase and decrease the viewing area. Decreasing causes everything within the window to appear larger, while increasing causes everything within the window to appear smaller. Toolbar commands are also available that allow you to control the content of the user-specified reports and the attributes that are plotted in the title block.

**Drawing Setup Tool Toolbar**

**Vertical Toolbar:**

- Zoom In/Out - Increases or decreases the display size of the drawing template. You can zoom in to get a closer view of an area or zoom out to view more of the drawing template at a reduced size. Click the left mouse button and drag the pointer upward in the window to increase the view of an object as though you were moving closer to it. Drag the pointer downward in the window to reduce the view as though you are moving further away from the object.
Isometric Drawing Styles

**Zoom Window** - Increases the view magnification of an area in the drawing template that you define by creating a fence.

**Zoom to Fit** - Displays the entire contents of the drawing template in the window.

**Pan** - Repositions the drawing template in the display window so that you can view another section of the template without changing the view magnification.

**Add / Remove Attributes** - Opens the Add/Remove Attributes dialog box. This dialog box allows you to specify the attributes that are available in the Attribute list in the Attributes Grid window. The command is available only when the Attributes page is active.

**Add Column** - Inserts a column to the selected report so that an additional attribute can be plotted in the report. This command is available only when the Material List, Weld List, or Cut List page is active.

**Delete Column** - Removes the selected column of component attribute data from the plotted report. This command is available only when you select a Column category label on the Material List, Weld List, or Cut List page.

**Zoom to List Attributes** - Zooms in on the selected attribute. Each time you click Zoom to List Attributes, the view zooms to the selected attribute in the title block of the drawing frame or on the reports.

**Horizontal Toolbar:**

**Previous Page** - Returns to the previous page of the tool.

**Next Page** - Proceeds to the next page of the tool.

**Help** - Opens the on-line documentation delivered with the software and displays information about the tool.

**OK** - Saves the options and parameters that you have defined.

**Cancel** - Undoes the options and parameters that you have defined.

**Exit** - Closes the tool. If you have not saved your changes, the software prompts you to do so.

**NOTES**
The four graphic control commands on the vertical toolbar (Zoom In/Out, Zoom Window, Zoom to Fit, and Pan) can be used any time while running the tool. The availability of the remaining vertical toolbar commands is determined by the active page.

You can navigate back and forth sequentially through the pages using Previous Page and Next Page on the horizontal toolbar. Alternatively, click the tab to go directly to a specific page.

What do you want to do?

- Open the Drawing Setup Tool (on page 134)
- Specify the backing sheet (on page 134)
- Define drawing margins and report layout (on page 136)
- Customize report settings (on page 138)
- Define drawing frame attributes (on page 143)
- Update the style (on page 144)

Open the Drawing Setup Tool

1. Right-click an Isogen Isometric Drawing component or package in the Management Console or Drawing Console, and then select Edit Options.
   The software opens the Isometric Style Options Browser.
2. Click Drawing Setup Tool on the horizontal toolbar.
   The software opens the Drawing Setup Tool.
3. Use the options on the tabbed pages to customize the isometric drawing output as needed.
4. When finished, click Save to accept your changes.

Specify the backing sheet

1. Open the Drawing Setup Tool (on page 134).
2. On the Basic Setup page, click Browse, and navigate to the backing sheet template file that you want to use.
   The delivered backing sheets are stored as IGR files in the [Reference Data Product Folder]\SharedContent\PmfgIsoStyleData folder on the server.
3. Set the required drawing size. If you select Custom, you must specify values for Width and Height.
4. Under Reports, specify the reports that you want Isogen to plot on the isometric drawing. If a user-defined material list is to be plotted, you must specify the required number of sections. By default, two sections are output on the material list.
5. Click Save on the horizontal toolbar.
If you change the backing sheet template file, the software copies the referenced file to the catalog database and accesses the file from the database rather than from the folder location specified in the Template box. As such, when the Drawing Setup Tool is reopened after the template file has been changed, the Template box displays a path to the Temp folder.
Define drawing margins and report layout

You can customize the left, right, top, and bottom margins of the drawing area, either interactively with the mouse or by typing new values in the **Drawing Areas** window. Likewise, you can use either method to set the start positions of where Isogen plots the material, weld, and cut lists on the isometric drawing.

**Set Drawing Margins Graphically**

1. *Open the Drawing Setup Tool* (on page 134).

2. On the **Drawing Areas** page, place the cursor on the grab handle for the margin you want to change.
   
   The cursor updates from a pointer to a two-headed arrow cross, indicating the direction in which you can drag the boundary.

3. Drag the boundary to the new position, and then release the mouse.
   
   As you drag the boundary, the corresponding margin value in the **Drawing Areas** window dynamically updates.

   **TIP** Alternatively, place the cursor on one of the boundaries. The cursor updates from a pointer to a cross-hair, indicating that the margin is ready to be resized.

4. Drag the boundary to the new position, and then release the mouse.
   
   **TIP** To accurately fit the drawing area, zoom in to each corner of the area being defined.

   **NOTE** Using the corner grab handles, you can move two margins simultaneously while the other two margins remain unchanged.

   - **Grab handle 1**: Resizes the left and top margins.
   - **Grab handle 2**: Resizes the right and top margins.
   - **Grab handle 3**: Resizes the left and bottom margins
   - **Grab handle 4**: Resizes the right and bottom margins.
**Set Drawing Margins Using the Grid**

1. Expand **Drawing Area Margins** in the **Drawing Areas** window, and click the margin you want to resize.

2. Type the new value. 

   *The drawing boundary box in the View window updates accordingly.*

**Set Report Start Position Graphically**

1. On the **Drawing Areas** page, place the cursor on the appropriate report anchor.
The cursor updates from a pointer to a cross-hair, indicating that the anchor is ready to be moved.

<table>
<thead>
<tr>
<th>WELD NO.</th>
<th>SIZE</th>
<th>TYPE</th>
<th>LOCATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** In the above example, the numbers underneath the cross-hairs indicate the X and Y coordinate values.

2. Move the anchor to the required location, and then release the mouse.

   As you drag the anchor, the corresponding X and Y values that display with the anchor and in the **Drawing Areas** window dynamically update.

**Set Report Data Start Position Using the Grid**

1. Expand the appropriate list category in the **Drawing Areas** window, click **X**, and type the new value.

2. Click **Y**, and type the new value.

   The drawing boundary box in the **View** window updates accordingly.

**Customize report settings**

You can use the grid to define formatting properties such as text font, height, and the direction in which the report data is plotted. Additionally, some of the properties that control the layout of the report data can be customized graphically using the mouse.

**Set Up the Report Using the Grid**

1. **Open the Drawing Setup Tool** (on page 134), and select the tab that corresponds to the report you want to customize.

   **NOTE** Use the **Reports** section on the **Basic Setup** page to add and remove the reports to be plotted on the isometric drawing.

2. If needed, click **Zoom to List Attributes** on the vertical toolbar to zoom in on the report section of the backing frame.
3. Expand the report category node to expose those properties. In the example below, the **Weld List** category node is expanded.

4. Use **List Down** to specify the direction in which Isogen is to plot the report data.

5. Click **Maximum Entries**, and set the maximum number of entries allowed in the report before an overflow sheet is generated.

6. Type the appropriate **X** and **Y** values to set the horizontal and vertical start positions of the first line of the report.

   **NOTE** Alternatively, you can define these X and Y settings graphically. For more information, see *Define X, Y, and Offset Settings Graphically* below.

7. Select the font to be used to display the report data in the **Text Font** list.

8. If needed, modify the values for **Text Height** and **Vertical Spacing**.
9. Expand the column nodes to display those properties. In the example below, the **Column 3** node has been expanded.

10. Modify the component attribute settings as needed.
   - Use the **Name** list to specify which component attribute is to be plotted.
   - Use the **Offset** and **X** boxes to set the plot start position for the component attribute data. These settings can also be defined graphically. For more information, see *Define X, Y, and Offset Settings Graphically* below.

**Define X, Y, and Offset Settings Graphically**

Modifying the report layout graphically involves using the mouse to position report data. Using the mouse, you can define the horizontal and vertical position of the first line of data that is plotted on the report. You can also define an offset from the start position that the other columns of data use.

**Define the report origin graphically**

1. Place the mouse on the red rectangle in the first column of the report block.
2. When the mouse changes to a cross-hairs, as shown in the example below, drag the box in the appropriate left, right, up, or down direction.

The $X$ and $Y$ values dynamically update as you drag the rectangle.

3. Release the mouse when the rectangle has been re-positioned as needed.

Define an offset from the report origin graphically

1. Place the mouse on the green rectangle in the column of data that you want to reposition.
2. When the mouse changes to a two-side arrow, as shown in the example below, drag the box in the appropriate left or right direction.

The Offset and X values dynamically update as you drag the rectangle.

3. Release the mouse when the rectangle has been re-positioned as needed.

Add and Remove Report Columns

1. Click Add Column on the vertical toolbar.

The software adds a node to the tree view, and adds a column of empty rectangles to the appropriate report location in the View window.
Each empty rectangle represents an attribute value. To view the empty rectangles, set Maximum Entries and Vertical Spacing to a value greater than zero (0).

2. Define settings for Name, Offset, Maximum Characters, and X as needed.

3. To remove a column from the report, select the column in the tree view, and then click Delete Column on the vertical toolbar.

   The software removes the column heading from the tree view and the column of rectangles from the report location.

**Define drawing frame attributes**

**Add or Remove a Drawing Frame Attribute**

1. **Open the Drawing Setup Tool (on page 134), and select the Attributes tab.**

   The Attributes page displays.

2. Click Add/Remove Attributes on the vertical toolbar.

   The software opens the Add/Remove Attributes dialog box.

3. In the Available list, select the attribute to add.

   **TIP** Hold down the CTRL key to select multiple attributes.

4. Click Add to add the attribute In Use list.

5. Click OK to close the dialog box.

   The software inserts the attribute at the bottom of the Attributes Grid window, and places an empty rectangle on the drawing frame in the vicinity of the last attribute placed on the grid.

6. Position the rectangle as required, by graphically selecting and moving it, and then adjust its position by editing it in the Attributes Grid window.

**Remove a Drawing Frame Attribute**

1. Select the Attributes tab in the Drawing Setup Tool.

   The Attributes page displays.
2. Click **Add/Remove Attributes** on the vertical toolbar.
   
   *The software opens the Add/Remove Attributes dialog box.*

3. In the **In Use** list, select the attribute to remove.

4. Click **Remove Attribute** to remove the attribute from **In Use** list.

5. Click **OK** to close the dialog box.

6. The software removes the row containing the attribute data from the Attributes Grid window, removes the corresponding rectangle from the drawing frame.

### Graphically Move a Drawing Frame Attribute

1. Click once on the attribute to move.
   
   *The software highlights the attribute in red on the drawing frame, and the pointer changes to a cross.*

2. Drag the attribute to its new position, and release the mouse.

3. **NOTE** As you drag the attribute, the corresponding X and Y settings in the Attributes Grid window dynamically update.

### Modify a Drawing Frame Attribute

1. Click an attribute rectangle in the drawing frame.
   
   *The software highlights the attribute in the Attributes Grid window.*

2. Modify the attribute values as needed in the Attributes Grid window.

### Update the style

In order for the changes that you make in the Drawing Setup Tool to be effective, you must click **Save** on the horizontal toolbar to save the changes to the active isometric drawing style file.

### View the results

When you have completed using the Drawing Setup Tool, it is recommended that you review how your changes affect the isometric drawing output. In that way, if anything appears incorrect, you can re-open the tool and correct the problems.

1. Right-click a document.

2. On the shortcut menu, select **Update Now** to update the drawing.
   
   *The icon for the out-of-date document changes to show that it is updated.*

**NOTE** If the software encounters a problem before or during the drawing update, it stops updating, displays either an error status or error message, and saves the errors to the log file. For more information, see *Conditional Drawing Update* (on page 81)
**Basic Setup Page**

Controls the drawing format, size, and the template file used as the backing sheet. You can also specify which user-defined reports are to be plotted on the isometric drawing when it is generated.

**Template** - Displays the file to be used for the drawing backing sheet. Click Browse, and navigate to the required template file.

**Drawing Output Format** - This option is not available in Smart 3D. The only supported output file format is Shape2d (SHA).

**Allow ISOGEN to generate standard drawing frame** - This option is not available in the current version of the software.

**Drawing Size** - Displays the standard paper size for the isometric drawing. Select A0, A1, A2, A3, A4, ANSI "A", ANSI "B", ANSI "C", ANSI "D", ANSI "E", or Custom. The drawing size that you select is shown superimposed in green on the backing sheet, as shown in the example below.

**Width** - Sets the width of the drawing. This option is available only if you set Drawing Size to Custom.

**Height** - Sets the height of the drawing area. This option is available only if you set Drawing Size to Custom.

**Backing Sheet Units** - This option is not available in the current version of the software.

**User Defined Material List** - Indicates whether a Material List report is output on the isometric drawing. To include this report on the isometric drawing, select its check box. If you select this option, you must also specify the **Number of sections**. Clear the check box to suppress the report output.

**User Defined Weld List** - Indicates whether a Weld List report is output on the isometric drawing. To include this report on the isometric drawing, select its check box. Clear the check box to suppress the report output.
**User Defined Cut List** - Indicates whether a Cut List report is output on the isometric drawing. To include this report on the isometric drawing, select its check box. Clear the check box to suppress the report output.

**Number of sections** - Specifies the number of sections included for the user-defined Material List report that is output on the isometric drawing. Select **One**, **Two**, or **Three**. This option is available only if User Defined Material List is selected.

### Drawing Areas Page

Defines the drawing area, which includes the drawing sheet and the areas of the drawing frame where Isogen plots the user-defined reports. The **Drawing Areas** page of the tool is divided into two sections.

- **Drawing Areas** window - Displays a grid view of drawing and report layout properties. In the **View** window, a green box with grab handles identifies the drawing boundary. In the report area, a colored anchor indicates the start position of the report data.

- **View** window - Displays the selected style's default backing sheet with the drawing area superimposed upon it.

In the **View** window, you can graphically customize the left, right, top, and bottom margins of the drawing and define the layout and appearance of the report data that is plotted on the isometric drawing. You can also type new values in the **Drawing Areas** window. For more information, see *Define drawing margins and report layout* (on page 136).

### Drawing Areas Window

Any of the categories and related properties listed below can appear on the **Drawing Areas** window, depending on the settings that have been defined on the **Basic Setup** page.
**NOTE** The **Drawing Areas** window can be displayed, hidden, docked, maximized, tabbed, or made to float. For more information, see *Moving and Resizing Windows* in *Drawing Setup Tool* (on page 131).

- **Categorized** - Groups drawing properties in the **Drawing Areas** window by category. At a minimum, the panel displays the **Drawing Area Margins** category, which contains margin settings for the drawing area. Additional categories, such as **Material List**, **Cut List**, and **Weld List**, display only if the corresponding report option is selected on the **Basic Setup** page. These categories contain format and layout properties specific to the data that is plotted on a report. Another set of categories can also display on the window: **Section One**, **Section Two**, and **Section Three**. These categories, which contain properties that are specific to the different sections of the material list, are controlled by the **Number of sections** setting on the **Basic Setup** page. The example below illustrates the relationship between the reports options selected on the **Basic Setup** page (1) and the categories that appear on the **Drawing Areas** window (2).

![Diagram](image)

- **Alphabetical** - Groups drawing properties in the **Drawing Areas** window as a flat, alphabetical list.

- **Drawing Area Margins** - Groups the properties that define the drawing margins. Margins are measured relative to the drawing sheet. For more information, see *Define drawing margins and report layout* (on page 136).

  - **Bottom** - Sets the distance between the outer edge of the drawing sheet and the outer line of the drawing frame at the bottom of the drawing. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.
  
  - **Left** - Sets the distance between the outer edge of the drawing sheet and the outer line of the drawing frame on the left side of the drawing. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.
  
  - **Right** - Sets the distance between the outer edge of the drawing sheet and the outer line of the drawing frame on the right side of the drawing. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.
• **Top** - Sets the distance between the outer edge of the drawing sheet and the outer line of the drawing frame at the top of the drawing. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

**Material List** - Groups layout and format properties for material list report data on the isometric drawing. This collection of properties appears only if **User Defined Material List** is selected on the **Basic Setup** page.

• **Text Font** - Specifies the font used to display material list report data. Select the required font in the **Text Font** list.

• **Text Height** - Specifies the height of the text that appears in the material list report. This setting applies to all sections of the material list. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

• **X** - Sets the bottom left X, or horizontal, position of the first line of the material list plotted on the isometric drawing. Type a value (integer).

• **Y** - Sets the bottom left Y, or vertical, position of the first line of the material list plotted on the isometric drawing. Type a value (integer).

**Weld List** - Groups layout and format properties for weld list report data on the isometric drawing. This collection of properties is shown only if **User Defined Weld List** is selected on the **Basic Setup** page.

• **Text Font** - Specifies the font used to display weld list report data. Select the required font in the **Text Font** list.

• **Text Height** - Specifies the height of the text that appears in the weld list report. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

• **X** - Sets the bottom left X, or horizontal, position of the first line of the weld list plotted on the isometric drawing. Type a value (integer).

• **Y** - Sets the bottom left Y, or vertical, position of the first line of the weld list plotted on the isometric drawing. Type a value (integer).

**Cut List** - Groups layout and format properties for cut list report data on the isometric drawing. This collection of properties appears only if **User Defined Cut List** is selected on the **Basic Setup** page.

• **Text Font** - Specifies the font used to display cut list report data. Select the required font in the list.

• **Text Height** - Specifies the height of the text that appears in the cut list report. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

• **X** - Sets the bottom left X, or horizontal, position of the first line of the cut list plotted on the isometric drawing. Type a value (integer).

• **Y** - Sets the bottom left Y, or vertical, position of the first line of the weld list plotted on the isometric drawing. Type a value (integer).

**Section One** - Groups layout and format properties for the report data contained in Section 1 of the material list. This category appears only if **User Defined Material List** is selected on the **Basic Setup** page.

• **Content** - Indicates the category of data plotted in Section 1 of the material list. Select **Fabrication**, **Erection**, **Offshore**, or **Erection/Offshore**. The default setting is **Fabrication**.
Section Two - Groups layout and format properties for the report data contained in Section 2 of the material list. This category appears only if Number of sections on the Basic Setup page is set to Two or Three.

- **Content** - Indicates the category of data plotted in Section 1 of the material list. Select Fabrication, Erection, Offshore, or Erection/Offshore. The category that you select must not be the same as the Content setting for Section 1. The default setting is Erection.

- **Y** - Sets the Y, or vertical, offset for Section 2 of the material list with reference to the X and Y positions of the material list. Type a value (integer) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

- **X** - Specifies the X (or horizontal) offset for Section 2 of the material list with reference to the report origin defined by the X and Y settings under the Material List category. Type a value (integer) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

Section Three - Groups layout and format properties for the report data contained in Section 3 of the material list. This category appears only if Number of sections on the Basic Setup page is set to Three.

- **Content** - Indicates the category of data plotted in Section 3 of the material list. Select Fabrication, Erection, Offshore, or Erection/Offshore. The category that you select must not be the same as the Content setting for Section 1 or Section 2. The default setting is Offshore.

- **Y** - Sets the Y, or vertical, offset for Section 3 of the material list with reference to the X and Y positions of the material list. Type a value (integer) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

- **X** - Specifies the X (or horizontal) offset for Section 3 of the material list with reference to the report origin defined by the X and Y settings under the Material List category. Type a value (integer) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

Material List Page

Defines the layout and appearance of the report data in the material list that is plotted on the isometric drawing. When Isogen processes the style to generate an isometric drawing, the material list is automatically populated to report the materials in the pipeline (or spool). The Drawing Setup Tool displays this page only when User Defined Material List is selected on the Basic Setup page. The Material List page is divided into two sections.

- **Material List** window - Displays properties that control the materials report set up, contents, and location (also shown graphically). These properties can be customized to meet your specific isometric drawing requirements. For more information, see Customize report settings (on page 138).

- **View** window - Displays a copy of the selected style's default backing sheet with the location of the materials report data superimposed upon it.

Material List Window

The categories and related properties listed below can appear on the Material List window, depending on the reports options that are selected on the Basic Setup page. The data in the example below defines a two section material list. The first section (Section 1), starting at 380mm x 396mm, contains a list of up to 25 Fabrication materials plotted downwards (Down). The second
A section (Section Two) contains a similar number of Erection materials also plotted downwards. It is plotted 182 mm below the first section.

<table>
<thead>
<tr>
<th>Material List</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
</tr>
<tr>
<td>Y</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section One</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
</tr>
<tr>
<td>List Down</td>
</tr>
<tr>
<td>Maximum Entries</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section Two</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
</tr>
<tr>
<td>List Down</td>
</tr>
<tr>
<td>Maximum Entries</td>
</tr>
<tr>
<td>X Offset</td>
</tr>
<tr>
<td>Y Offset</td>
</tr>
</tbody>
</table>

| Section Three |

### NOTES

- Many of the properties listed below can also be defined or modified on the Basic Setup page of the tool.
- The Material List window can be displayed, hidden, docked, maximized, tabbed, or made to float. For more information, see Moving and Resizing Windows in Drawing Setup Tool (on page 131).

**Categorized** - Groups material list properties in the Material List window by category. The Number of sections setting, which is defined on the Basic Setup page, determines whether the categories Section Two or Section Three are displayed. The Section categories contain properties that are specific to a particular section of the material list.

**Alphabetical** - Groups material list properties in the Material List window as a flat, alphabetical list.

**Material List** - Groups layout and format properties for material list report data, including the report origin and the text size and font

- **X** - Sets the bottom left X, or horizontal, position of the first line of the material list that is plotted on the isometric drawing. Type a value (integer).
- **Y** - Sets the bottom left Y, or vertical, position of the first line of the material list that is plotted on the isometric drawing. Type a value (integer).
- **Text Font** - Specifies the font used to display material list report data. Select the required font in the Text Font list.
- **Text Height** - Specifies the height of the text that appears in the material list report. This setting applies to all sections of the material list. Type a value (real number) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.
Isometric Drawing Styles

- **Vertical Spacing** - Specifies the vertical spacing between the lines of data. The vertical spacing applies to all sections in the material list. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

**Section One** - Groups layout and format properties for the report data contained in Section 1 of the material list.

- **Content** - Displays the category of data plotted in Section 1 of the material list. Select **Fabrication**, **Erection**, **Offshore**, or **Erection/Offshore**. The default setting is **Fabrication**.
- **List Down** - Controls the direction in which the material list is printed with reference to the X and Y settings under the **Material List** category. If you select **Down**, Isogen plots the material list from top to bottom. If you select **Up**, the material list is plotted from bottom going up.
- **Maximum Entries** - Sets the maximum number of entries in the material list before an overflow sheet is generated. Type the required value (positive integer).

**Section Two** - Groups layout and format properties for the report data contained in Section 2 of the material list. This category appears on the panel only if **Number of sections** on the **Basic Setup** page is set to **Two** or **Three**.

- **Content** - Displays the category of data plotted in Section 1 of the material list. Select **Fabrication**, **Erection**, **Offshore**, or **Erection/Offshore**. The category that you select must not be the same as the category defined for Section 1. The default setting is **Erection**.
- **List Down** - Controls the direction in which the material list is printed with reference to the X and Y settings under the **Material List** category. If you select **Down**, Isogen plots the material list from top to bottom. If you select **Up**, the material list is plotted from bottom going up.
- **Maximum Entries** - Sets the maximum number of entries in the material list before an overflow sheet is generated. Type the required value (positive integer).
- **X Offset** - Specifies the X (or horizontal) offset for Section 2 of the material list with reference to the report origin defined by the X and Y settings under the **Material List** category. Adding a Section 2 X offset results in a horizontal double banking of the BOM. Type a value (integer) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.
- **Y Offset** - Specifies the Y (or vertical) offset for Section 2 of the material list with reference to the report origin defined by the X and Y settings under the **Material List** category. Type a value (integer) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

**Section Three** - Groups layout and format properties for the report data contained in Section 3 of the material list. This category appears on the panel only if **Number of sections** on the **Basic Setup** page is set to **Three**.

- **Content** - Displays the category of data plotted in Section 1 of the material list. Select **Fabrication**, **Erection**, **Offshore**, or **Erection/Offshore**. The category that you select must not be the same as the categories defined for Section 1 and Section 2. The default setting is **Offshore**.
- **List Down** - Controls the direction in which the material list is printed with reference to the X and Y settings under the **Material List** category. If you select **Down**, Isogen plots the material list from top to bottom. If you select **Up**, the material list is plotted from bottom going up. **IMPORTANT** For a three section material list, all sections must be plotted in the same direction.
- **Maximum Entries** - Sets the maximum number of entries in the material list before an overflow sheet is generated. Type the required value (positive integer).
- **X Offset** - Specifies the X (or horizontal) offset for Section 3 of the material list with reference to the report origin defined by the X and Y settings under the Material List category. Type a value (integer) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

- **Y Offset** - Specifies the Y (or vertical) offset for Section 3 of the material list with reference to the report origin defined by the X and Y settings under the Material List category. Type a value (integer) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

**Column Settings** - Controls what component attributes are to be plotted in the report, along with basic layout properties. In the example below, the material list is set up to plot five columns of attribute data. The first component attribute (PT-NO) is to be plotted with a zero (0) offset from the origin (X).

- **Name** - Specifies the name of the component attribute being defined in the report. Select the required attribute in the list.
- **Offset** - Specifies the offset from the X setting (or report origin) defined under the **Material List** category. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page. The value that you enter has a direct impact on the column X setting. For example, if the horizontal position of the origin for the first line of report data is set to 250, and you set a 150mm offset from that origin under **Column 6**, the horizontal start position (or X setting) for that component attribute data is 400.

- **Maximum Characters** - Sets the width of the column. The value that you enter must be zero or greater.

- **X** - Specifies the horizontal start position for the column data with reference to the X setting of the material list origin. The value that you enter causes the **Offset** setting to update automatically. Type a value (integer) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

**NOTES**

- You can also define **Offset** and **X, Y** settings graphically using the mouse. For more information, see **Define X, Y, and Offset Settings Graphically in Customize report settings** (on page 138).

- Use **Add Column** and **Delete Column** to control which component attributes are plotted in the material list report. For more information, see **Add and Remove Report Columns in Customize report settings** (on page 138).
Weld List Page

Defines the layout and appearance of the report data in the weld list that Isogen plots on the isometric drawing. The Drawing Setup Tool displays this page only when User Defined Weld List is selected on the Basic Setup page. The Weld List page is divided into two sections.

- **Weld List window** - Displays properties that control the report set up and report contents in a tree view format. These properties can be customized to meet your specific isometric drawing requirements. For more information, see Customize report settings (on page 138).

- **View window** - Displays a copy of the selected style’s default backing sheet with the location of the report data superimposed upon it.

Weld List Window

- **Categorized** - Groups weld list properties in the Weld List window by category.

- **Alphabetical** - Groups weld list properties in the Weld List window as a flat, alphabetical list.

- **Weld List** - Groups layout and format properties for weld list report data, including the report origin and the text size and font

- **List Down** - Controls the direction in which the weld list is printed with reference to the X and Y settings under the Weld List category. If you select Down, Isogen plots the weld list from top to bottom. If you select Up, the weld list is plotted from bottom going up.

- **Maximum Entries** - Sets the maximum number of entries in the weld list before an overflow sheet is generated. Type the required value (positive integer).

- **X** - Sets the bottom left X, or horizontal, position of the first line of the weld list that is plotted on the isometric drawing. Type a value (integer).

- **Y** - Sets the bottom left Y, or vertical, position of the first line of the weld list that is plotted on the isometric drawing. Type a value (integer).

- **Text Font** - Specifies the font used to display weld list report data. Select the required font in the Text Font list.

- **Text Height** - Specifies the height of the text that appears in the weld list report. This setting applies to all sections of the weld list. Type a value (real number) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

- **Vertical Spacing** - Specifies the vertical spacing between the lines of data. The vertical spacing applies to all sections in the weld list. Type a value (real number) in mm or
**Column Settings** - Controls which component attributes are plotted in the weld list report, along with basic layout properties. In the example below, the plotted weld list is set up to contain four columns of attribute data. The fourth component attribute (**WELD-LOCATION**) is to be plotted with a 43mm offset from the origin (X).

- **Name** - Specifies the name of the component attribute being defined in the report. Select the required attribute in the list.
- **Offset** - Specifies the offset from the X setting (or report origin) defined under the **Weld List** category. Type a value (real number) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page. The value that you enter has a direct impact on the column X setting. For example, if the horizontal position of the origin for the first line of report data is set to **245**, and you set a **15mm** offset from that origin under **Column 2**, the horizontal start position (or X setting) for that component attribute data is **265**.

- **Maximum Characters** - Sets the number of entries that the column can accommodate. The value that you enter must be zero or greater.

- **X** - Specifies the horizontal start position for the column data with reference to the X setting of the weld list origin. The value that you enter causes the Offset setting to update automatically. Type a value (integer) in mm or inches, depending on the **Backing Sheet Units** setting on the **Basic Setup** page.

**NOTES**

- You can also define Offset and X, Y settings graphically using the mouse. For more information, see Define X, Y, and Offset Settings Graphically in Customize report settings (on page 138).

- Use Add Column and Delete Column to control which component attributes are plotted on the weld list report. For more information, see Add and Remove Report Columns in Customize report settings (on page 138).
**Cut List Page**

Defines the layout and appearance of the report data in the cut list that is plotted on the isometric drawing. The Drawing Setup Tool displays this page only when User Defined Cut List is selected on the Basic Setup page. The Cut List page is divided into two sections.

- **Cut List** window - Displays properties that control the report set up, report contents, and report location (shown graphically). These properties can be customized to meet your specific isometric drawing requirements. For more information, see Customize report settings (on page 138).
- View window - Displays a copy of the selected style's default backing sheet with the location of the report data superimposed upon it.

**Cut List Window**

- Many of the properties listed below can also be defined or modified on the Basic Setup page of the tool.
- The Cut List window can be displayed, hidden, docked, maximized, tabbed, or made to float. For more information, see Moving and Resizing Windows in Drawing Setup Tool (on page 131).

 Bronze - Groups cut list properties in the Cut List window by category.

 Alphabetical - Groups cut list properties in the Cut List window as a flat, alphabetical list.

 Cut List - Groups layout and format properties for the cut list report data, including the report origin and the text size and font.

- **Allow Overflow** - Controls whether the cut list causes an overflow drawing.
- **List Down** - Controls the direction in which the cut list is printed with reference to the X and Y settings under the Cut List category. If you select Down, Isogen plots the cut list from top to bottom. If you select Up, the cut list is plotted from bottom going up.
- **Maximum Entries** - Sets the maximum number of entries in the cut list before an overflow sheet is generated. Type the required value (positive integer).
- **X** - Sets the bottom left X, or horizontal, position of the first line of the cut list that is plotted on the isometric drawing. Type a value (integer).
- **Y** - Sets the bottom left Y, or vertical, position of the first line of the cut list that is plotted on the isometric drawing. Type a value (integer).
- **Text Font** - Specifies the font used to display cut list report data. Select the required font in the Text Font list.
- **Text Height** - Specifies the height of the text that appears in the cut list report. This setting applies to all sections of the cut list. Type a value (real number) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.
- **Vertical Spacing** - Specifies the vertical spacing between the lines of data. The vertical spacing applies to all sections in the cut list. Type a value (real number) in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.
Column Settings - Controls which component attributes are plotted in the cut list report, along with basic layout properties. In the example below, the plotted cut list is set up to display five columns of attribute data. The first component attribute (CUT-PIECE-NO) is to be plotted with a zero offset from the origin (X).

- **Name** - Specifies the name of the component attribute being defined in the report. Select the required attribute in the list.
- **Offset** - Specifies the offset from the X and Y settings defined under the *Cut List* category. Type a value (real number) in mm or inches, depending on the *Backing Sheet Units* setting on the *Basic Setup* page. The value that you enter has a direct impact on the column X setting. For example, if the horizontal position of the origin for the first line of report data is set to 315.3, and you set an 18mm offset from that origin under *Column 2*, the horizontal start position (or X setting) for that component attribute data is 333.3.

- **Maximum Characters** - Sets the number of entries that the column can accommodate. The value that you enter must be zero or greater.

- **X** - Specifies the horizontal start position for the column data with reference to the X setting of the cut list origin. The value that you enter causes the Offset setting to update automatically. Type a value (integer) in mm or inches, depending on the *Backing Sheet Units* setting on the *Basic Setup* page.

**NOTES**

- You can also define Offset and X, Y settings graphically using the mouse. For more information, see *Define X,Y, and Offset Settings Graphically* in *Customize report settings* (on page 138).

- Use Add Column and Delete Column to control which component attributes are plotted on the cut list report. For more information, see *Add and Remove Report Columns* in *Customize report settings* (on page 138).
Attributes Page

Defines the pipeline attributes that are plotted on the drawing frame. The Attributes page is divided into two sections.

- View window - Displays a copy of the selected style's default backing sheet.
- Attributes window - Displays the component attributes. Each attribute has a position, and you can define its text size, font, and layer independently. These properties can be customized to meet your specific isometric drawing requirements. For more information, see Define drawing frame attributes (on page 143).

Attributes Window

NOTE The Attributes window can be displayed, hidden, docked, maximized, tabbed, or made to float. For more information, see Moving and Resizing Windows in Drawing Setup Tool (on page 131).

Attribute - Specifies the name of the attribute being defined.

X - Defines the X, or horizontal, position for the text. Type a value in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

Y - Defines the Y, or vertical, position for the text. Type a value in mm or inches, depending on the Backing Sheet Units setting on the Basic Setup page.

Text Height - Sets the character height for the text. Type the required size in mm or Inches (as a real number), depending on the Backing Sheet Units setting on the Basic Setup page.

Font - Specifies the font used when plotting the attribute in the drawing frame. Select the required font in the list.

Barcode - Sets the barcode standard used by Isogen. The value you enter creates the start and finish characters for the barcode reader. Type the number that corresponds to the required standard: 1 (Barcode 30), 2 (Barcode 25), 3 (Barcode 25 Interleave), or 4 (Barcode 128). Although several barcode standards exist worldwide to suit different industries, Isogen has only standardized on four.

Justification - Sets the justification for the text. Select Left, Right, or Centre.

Layer - Specifies a number that corresponds to the layer. This number is an integer that identifies the required layer, or level, to which the component type is to be assigned. Select the required value in the list.

Colour - Specify the index number that represents a specific color as defined in the output drawing software. This option is required only for MicroStation or AutoCAD output. AutoCAD uses a fixed 256 color pallet starting at 1 (red) to 256. In MicroStation, in addition to a default color pallet, each design file can have a unique custom color table. For example, color index number 3 may be red in one design file, but it may be green in another. The table below shows a color comparison between a sampling of AutoCAD and MicroStation color index numbers.

<table>
<thead>
<tr>
<th>AutoCAD Color Index Number</th>
<th>MicroStation Color Index Number</th>
<th>Color Output on Isometric Drawing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>
For specific information about AutoCAD, MicroStation, and other 3rd party drawing software color tables, refer to the product documentation delivered with your software.

Char Width - Sets the character width for the text. Type the required size in mm.

Weight - Controls the character thickness. Type a value between 1 and 9. This option is only used for MicroStation.

Rotation - Defines the angle of rotation in clockwise degrees.

Truncation Length - Defines the number of output characters.

**NOTE** Use Add / Remove Attributes on the vertical toolbar to control which drawing frame attributes are plotted on the isometric drawing. For more information, see Define drawing frame attributes (on page 143).

**Add/Remove Attributes Dialog Box**

Lists the attributes that are plotted in the drawing frame, as well as the attributes that are available to be plotted. The software opens this dialog box when you click Add / Remove Attributes on the Drawing Setup Tool vertical toolbar.

Available - Lists the attributes that you can select to plot on the isometric drawing.

In Use - Lists the attributes that are currently selected for plotting on the isometric drawing.

- **Add** - Moves the selected attribute to the In Use list.

- **Remove** - Removes the selected attribute from the In Use list.

OK - Closes the dialog box, and returns you to the Attributes page. The attributes that you selected are displayed in the Attributes window grid area.

Cancel - Closes the dialog box without making any changes to the grid in the Attributes window.

**NOTE** The Available and In Use lists are standard multi-select lists, allowing you to select one or more attributes. To select consecutive attributes, select the first attribute, press and hold down the
SHIFT key, and then select the last attribute. To select nonconsecutive attributes, press and hold down the CTRL key, and then select each attribute.

Fonts in Isometric Drawings

You can change the font that displays on the isometric drawing. A font information file (*.fif), which contains a default collection of fonts, is delivered in the workstation setup in the [Product Folder]\Drawings\Isometric\Alias\Core Components folder. You specify this file in the isometric options, and then you can select fonts for the material list and the drawing.

If there is a requirement to use a font that is not available in the standard font information file delivered in the workstation setup, the software supports user-specified dynamic fonts. Isogen recognizes the font definition automatically during isometric drawing generation.

What do you want to do?

- Select a font for isometric drawing output (on page 162)
- Define a dynamic font for isometric drawing extraction (on page 163)
- Place barcode data on the isometric drawing (on page 164)

Select a font for isometric drawing output

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options.
2. Type **font** in the search window of the browser and execute the search.

![Image of Isometric Style Options Browser]

3. Next to **Drawing.Format.TextFont**, select a font from the **Value** drop down list.

Define a dynamic font for isometric drawing extraction

1. Right-click a Piping Isometric Drawing component or package, and click **Edit Options**.

   *The Isometric Style Options Browser* opens.

2. Under **Drawing.DynamicFonts**, select the **DynamicFonts** collection.

3. Define the necessary options. In the following example, the font Calibri is being defined as a dynamic font.

<table>
<thead>
<tr>
<th>FontNumber</th>
<th>FontName</th>
<th>FontCorrectionFactor</th>
<th>FontStyleName</th>
<th>FontMicrostationNumber</th>
<th>FontMultibyteWidth</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>CALIBRI</td>
<td>1</td>
<td>CALIBRI</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**NOTE**: You must define **FontNumber** and **FontName** properties. For more information about these properties, see *Dynamic Fonts Collection (Drawing Dynamic Fonts)* (on page 516).

4. Click **Save to Catalog** to save the changes to the Catalog database. You must have write permission to the Catalog database to save changes to isometric styles.
NOTE  After the font is saved to the database, it displays under the Drawing.Format.TextFont and MaterialList.TextFont properties in the Isometric Style Options Browser, similar to the example below:

<table>
<thead>
<tr>
<th>TextFont</th>
<th>CALIBRI (True Type) - Dynamic</th>
</tr>
</thead>
<tbody>
<tr>
<td>TextSize</td>
<td></td>
</tr>
<tr>
<td>UserTextSize</td>
<td></td>
</tr>
<tr>
<td>TextWeight</td>
<td></td>
</tr>
</tbody>
</table>

Place barcode data on the isometric drawing

The following steps show you how to define a barcode font and then how to configure the isometric drawing frame so that a specific pipeline attribute is output as a barcode.

NOTE  If the barcode font you want to use is already defined as a dynamic font, skip steps 2-4.

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options. The Isometric Style Options Browser opens.

2. Expand Drawing.DynamicFonts, and select the DynamicFonts collection.

3. Click Insert Row, and define the required properties for the barcode font. In the example below, a barcode font called Sample Code 128AB a is defined.

<table>
<thead>
<tr>
<th>FontNumber</th>
<th>FontName</th>
<th>FontCorrelationFactor</th>
<th>FontStyleName</th>
<th>FontMicrocanonicalNumber</th>
<th>FontMultiByteWidth</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>Sample Code 128AB a</td>
<td>1</td>
<td>Sample Code 128AB a</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

   NOTE  You must define FontNumber and FontName properties. For more information about these properties, see Dynamic Fonts Collection (Drawing Dynamic Fonts) (on page 516).

4. Click Save to Catalog to save the changes to the Catalog database.

   IMPORTANT  You must have write permission to the Catalog database to save changes to isometric styles.

5. Expand DrawingFrame.Attributes, and select the Attributes collection.

6. Locate the drawing frame attribute to output as a barcode, and then use the Font list to select the barcode font. In the example below, the pipeline reference attribute is being configured to output using the Sample Code 128AB a font that you defined previously.
Flow Arrows

Isometric drawings commonly have annotations to denote the direction of fluid flow through pipe as well as through pipe components. To specify flow direction in the model, switch to the Piping task. Select a pipe run and change the flow direction by clicking the circular icons on the run. Then, use Isogen Configuration to define when and where flow arrows are placed on isometric drawings.

Two overall types of flow arrows exist: segment and component. Segment flow arrows display on pipe runs, while component flow arrows display beside components such as valves.

The options for flow arrow placement are located in Drawing Area > Content > Flow Arrows. The Show on Pipe property toggles all flow arrows on and off. If Show Flow Arrows is set to True, you can also specify component and segment flow arrow placement. You can set Show on Components so that component flow arrows appear beside components such as valves. Also, you can set Model Extraction > Drawing > Content > Segment Flow Arrow Placement to None, Pipe run, Branch, or Pipe Feature to denote how arrows are placed on the pipe. The Pipe run selection means a flow arrow is placed on each pipe run. The Branch selection means a flow arrow is placed on the first leg of each branch, including the header. If the pipeline does not have a branch, then no additional (there should always be at least one) flow arrow is placed even if one pipe run ends and another begins. The Feature selection means a flow arrow is placed on each and every feature of a pipe run.

When you configure your isometric styles, you can set Show on Components and Segment Flow Arrow Placement to match your company specifications. Thereafter, you can control all flow arrows on the isometric drawing by toggling Show on Pipe on or off.
The following diagram shows the relationships among the flow arrow options.

Set flow arrow options

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options.

2. Under Drawing.Content, set the ShowCptFlowArrows option.
   
   **TIP** Set the option to True if you want component flow arrows to display for this style. Set the option to False if you do not want component flow arrows to display for this style.

   
   **TIP** Select Pipe Run if you want a flow arrow placed on each pipe run. Select Branch if you want a flow arrow placed on the first leg of each branch, including the header. If the pipeline does not have a branch, then no additional (there should always be at least one) flow arrow is placed even if one pipe run ends and another begins. Select Pipe Feature if you want a flow arrow placed on each pipe feature in a pipe run. Select None if you do not want any segment flow arrows on the drawing.

4. Under Drawing.Content, set the ShowFlowArrows option to either True or False. This option is a master switch that toggles all flow arrows on or off.

**NOTES**

- When you configure an isometric style, set the ShowCptFlowArrows and SegmentFlowArrowPlacement options to match your company specifications. Thereafter, you can toggle all flow arrows on or off with the ShowFlowArrows option.
- When you set the Drawing.Content.ShowFlowArrows option to True, you also must set the Drawing > Format > SegmentFlowArrowPlacement option to a value other than None.

See Also

*Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115)*
Bending Files

The main purpose of the bending file is to provide an input to a bending machine, which bends the pipe.

Here is an example of a bent pipe and its corresponding bending file information. The pipe configuration is a 2 ft pipe/5 deg bend/2 ft pipe.

<table>
<thead>
<tr>
<th></th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Radius</th>
<th>Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>START</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>BEND1</td>
<td>-607.3</td>
<td>0.0</td>
<td>53.1</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>FINISH</td>
<td>-1216.9</td>
<td>0.0</td>
<td>53.1</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

The START row indicates the start point at 0, 0, 0. The BEND1 row indicates the relative coordinates of the bend location from the start point in millimeters. The distance of 607.3 mm is almost 2 ft (23.909 in). For the FINISH point, the distance of 1216.9 mm is almost 4 ft (47.909 in). The 53.1 mm distance is the absolute elevation between the start and finish points.

You can specify that a bending file is created by selecting Bending File in Drawing Manager > Reports > Report Types for an isometric style. The keyword BENDING_FILE_APPEND places the bending file information for each extraction consecutively in one file, and the keyword BENDING_FILE_OVERWRITE erases the file and writes to it with each extraction.

Material Lists and Material List Files

The software contains three different styles for MaterialLists on isometric drawings. FixedLayout is the default material list for which customization is limited. VariableLayout allows you to specify the attributes in the columns of the material list. UserDefined is the most customizable, allowing full control of the attributes in the columns, the number of sections in the material list, and remarks.

A material list can contain cut list information. The cut list includes the pieces of cut pipe and their required lengths. You can specify summary files for the material list and cut list.

You can also specify labels that correspond to items in the material list.

The software also allows you to specify several different types of material files for isometric drawings. In addition, you can include cut list information.
**Printed Material List**

The printed material list is a text file that contains the same information as the material list on the face of the drawing. The information is continuously appended to the file. You can specify that a printed material list file is created by using the `Supplementary.ReportFiles` category.

**MTO Neutral File**

The MTO neutral file is in a plain text format. The purpose of this file is to provide the extracted information to a material control system. You can control the objects included in the neutral file as well as the columns of information. This file is also called the Intergraph MTO neutral file.

Optionally, weld and bolt data can appear in the MTO neutral file. The data from these components can appear in columns already existing in the MTO neutral file, or you can specify new columns.

The MTO neutral file is set with the `S3D.NeutralFile` options. For more information, see *Set Styles for the MTO Neutral File* (on page 171).

**Material Control File**

The purpose of this file is the same as the MTO neutral file: to provide information to a material control system. This material control file is an Alias file. You can specify this file by using the `MaterialList.SummaryFile` options.

**Cut Pipe Report**

The cut pipe report provides a list of the pieces of cut pipe and their required lengths. To specify options for a cut list, you use the `CutList` options.

---

**What do you want to do?**

- [ ] *Set up a material list* (on page 169)
- [ ] *Set up a cut list* (on page 170)
- [ ] *Specify a label for the material list* (on page 170)
- [ ] *Set styles for the MTO neutral file* (on page 171)
### Set up a material list

1. Right-click a Piping Isometric Drawing component or package in the **Console**, and click **Edit Options**.
2. Open the **MaterialList** category.
3. Select a style: **FixedLayout**, **VariableLayout**, or **UserDefined**.
   
   **TIPS**
   
   - **Fixed Layout** is the default material list and is not customizable.
   - **Variable Layout** is a customizable version of the Fixed Layout style and allows you to specify the attributes in the columns of the material list.
   - **User Defined** is the most customizable of the three styles, allowing full control of the attributes in the columns, the number of sections in the material list, and remarks.
   - If the **Visible** option under **DrawingFrame.SymbolTable** is **False**, you must use the Fixed Layout material list style, because only a Fixed Layout material list can be used with an ISOGEN drawing frame.
4. Specify the options for the selected style.

   For a summary file of the material list, open the **Material List.SummaryFile** category and specify the options. The following steps show an example of how to specify the material list summary file:
   
   1. Set **MaterialList.SummaryFile.Enabled** to **True**.
   2. Set **MaterialList.SummaryFile.UserDefined** to **True**.
   4. Open the **MaterialList.SummaryFile.SummaryFile** category, and define values such as the name of the attribute, a width, and the justification. To insert a new row, click in the grid and press **Insert** on the keyboard.

   **NOTES**
   
   - The amount of area on the drawing that is reserved for the material list must be set properly, or overlap can occur between the piping symbology and the text of the material list. You can set the reserved area for the material list by setting the **DrawingFrame.ReservedAreaMatList** option.
   - By default, bolts and gaskets are accumulated automatically in the material list by diameter. You can deactivate this feature by setting **MaterialList.BoltAccumulation** or **MaterialList.GasketAccumulation** to **Suppress**.
   - To display a cut list with the material list on the drawing, open the **CutList** category, and specify the necessary options.
   - You can specify several different files with material list information, such as the MTO neutral file.
   - You can move components from one sort group to another in the materials list by using the **MaterialList.Transfers** category.
   - You can also specify labels that correspond to items in the material list using the **S3D.Labels.MaterialList** category.
Set up a cut list

1. Right-click a Piping Isometric Drawing component or package in the **Console** and click **Edit Options**.
2. Open the **CutList** category.
3. Select a style: **FixedLayout** or **UserDefined**.

**TIPS**

- **FixedLayout** is the default cut list and is not customizable.
- **UserDefined** is a customizable version of the cut list.

4. Specify the options for the selected style.

For a summary file of the cut list, open the **Cut List.Summary File** category and specify the options. The following procedure is an example of how to specify the cut list summary file.

1. Set **CutList.SummaryFile.Enabled** to **True**.
2. Set **CutList.Summary File.UserDefined** to **True**.
4. Open the **CutList.SummaryFile.SummaryFile** category, and define values such as length, size, and cut piece number. To insert a new row, click in the grid and press **Insert** on the keyboard or use the **Insert Row** command on the toolbar.

Specify a label for the material list

1. Right-click a Piping Isometric Drawing component or package in the **Console** and click **Edit Options**.
2. Open the **S3D.Labels.ComponentAtts** category.
3. Select a **Type** and **CompAttribute**, then click the browse button under **LabelName** to select an isometric label from the catalog.
4. Open the **MaterialList** category.
5. Set the **ActiveList** option to **UserDefined**.
7. In the blank row, define the location for the attribute using the **offset** and **MaxChars** columns.
Set styles for the MTO neutral file

The following procedure shows how to set styles for an MTO Neutral File using the Isometric Style Options Browser.

1. Right-click a Piping Isometric Drawing component or package in the Console, then click Edit Options to display the Isometric Style Options Browser.
2. Expand S3D.NeutralFile and change option settings as necessary.
   **NOTE** When S3D.NeutralFile.GroupBPIP is set to False, the object passed into the label is a pipe straight feature. Any custom labels designed to output data must be aware of this. For more information, see Neutral File Options (S3D) (on page 674).
3. Click Save to Catalog to save the changes to the Catalog database. You must have write permission to catalog to save changes to isometric styles.
4. Update your document to see the new applied label style.

Neutral File Example

1. For the S3D.NeutralFile.Enabled option, select True to turn the Neutral File display on.
2. For the S3D.NeutralFile.WeldData.Enabled option, select True to display weld data. You can also display BoltData and GasketData.
3. To add columns for weld data, expand to S3D.NeutralFile.WeldData.Column and add column data as needed for your neutral file contents.
4. Add columns for bolts and gaskets if needed.
5. Save the changes to the catalog and update your document to see the new Neutral File data.

**See Also**

*Edit Options (Piping Isometric Drawing Component Shortcut Menu)* (on page 115)

Pipeline Lists

You can specify an option to display process or design information from each pipe run on the isometric drawing. This pipeline list is an embedded Excel workbook.

**NOTE** When defining embedded report layout (sizing of columns and rows), consider the report usage first. Because of a Microsoft limitation concerning the size of Windows metafile objects within other applications, the data displayed may be incomplete. Therefore, no column should be out of screen when using 100 percent zoom for the report. Otherwise some columns are ignored when the report is embedded within the drawing. The same limitation exists for rows. To preserve the maximum number of rows displayed, the total header row(s) height should be a minimum of the overall report. Using Microsoft Excel default settings, the maximum number of columns is approximately 20 and the maximum number of rows is approximately 75 (including header rows). For more information on setting the defaults in Microsoft Excel, see your Microsoft Excel documentation.
Display a pipeline list

1. Right-click a Piping Isometric Drawing component or package in the Console, and click Edit Options.
3. Set ShowPipeLineListBox to True.

See Also
Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115)

Weld Lists and Weld Files

To enable weld list output on an isometric drawing, you must configure a few items in the software.

First, you must map each type of weld to a symbol key (SKEY). You can complete this mapping by opening Isogen Configuration for an isometric style and using the Model Extraction > General > Symbol Map group of options.

Second, you must set options to show the weld symbols as well as the weld numbers on the isometric drawing. The Welds and Joints > Generation and Display > Controls > Show Welds option indicates whether the weld symbol displays on the drawing, and the Show Weld Numbers option indicates if the weld number displays.

You can also specify that a weld list display on the drawing. The columns shown in the weld list can be customized. The weld list does not display if the option setting to display weld numbers is not also enabled. If needed, you can specify that the weld list information is also saved in a summary file.

The weld file contains the same information as the weld list on the isometric drawing. You can specify a weld file using Welds and Joints > Reports > Report Types to enable and define the Weld summary report.

What do you want to do?

- Print welds (on page 173)
- Specify a label for the weld list (on page 173)
Print welds

1. Right-click a Piping Isometric Drawing component or package in the Console, and select Edit Options.
2. Open the Drawing.Welds category.
3. Set the ShowWelds option to True.
4. Set the ShowWeldNumbers option to True.
5. To display a weld list on the drawing, set the WeldList.Visible option to True.

**NOTE** You can save the weld list information to a file by specifying the WeldList.SummaryFile options.

Specify a label for the weld list

1. Right-click a Piping Isometric Drawing component or package in the Console, and select Edit Options.
2. Open the S3D.Labels.WeldList category.
3. Under LabelAttribute, select an attribute. You can insert a row by clicking in the grid and pressing Insert on your keyboard or by using Insert Row on the toolbar.
4. Under LabelName, click the browse button, and select an isometric label from the catalog.
5. Open the WeldList category.
6. Set the ActiveList option to UserDefined.
8. Insert a row for the attribute you added.
9. Define the location for the attribute using the offset and MaxChars columns.

**See Also**

*Edit Options (Piping Isometric Drawing Component Shortcut Menu)* (on page 115)

Change Management in Piping Isometric Drawings

*Change Management* on a piping isometric drawing refers to the fact that the same information needs to display on the same sheet of an isometric drawing each time you extract the drawing. Change Management allows you to keep the overall drawing consistent in two ways:

- It maintains the same information per drawing sheet whenever possible.
- It prevents impact to other drawing sheets.

For example, a valve should not move from Sheet 1 to Sheet 2 in a piping isometric drawing simply because you added an olet to a pipe output to that same sheet. If the valve originally displayed on Sheet 1, it should always display on Sheet 1. However, if you add a gate valve and the MTO on Sheet 1 is full, the software adds a new sheet called Sheet 1A. This way the gate valve is still on Sheet 1, but the MTO is not overcrowded.

Also, when Change Management is enabled, you should not modify the part numbers on the isometric drawing between updates. For example, assume that you placed a gate valve and
updated the isometric drawing with Change Management enabled. The part number in the MTO might be 3 for the gate valve. Now, if you insert another gate valve on the pipeline and update the isometric drawing again, the old gate valve still has a part number of 3 and the new inserted gate valve has a part number of 4. This also applies to label callouts on the isometric drawing itself.

The Change Management functionality is enabled when you set the **S3D.Drawing.Content.ChangeManagementEnabled** option to **True**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChangeManagementEnabled</td>
<td>True</td>
</tr>
</tbody>
</table>

**NOTE**: You can override the **S3D.Drawing.Content.ChangeManagementEnabled** option in the Isometric style by changing the drawing document **Change Management** property setting. For more information, see **Style Tab (Properties Dialog Box)** (on page 51).

**Spool Number Consistency**

Spool data is generated in the Piping task and stored in the model database. Therefore, spool numbers remain constant even if you re-extract a drawing.

**NOTE**: If the **In Situ** spooling is active, the spool numbers could change depending on the types of changes that occurred in the model and/or settings in the spooling rules.

**Weld Number Consistency**

Weld number data is generated in the Piping task and stored in the model database. Therefore, weld numbers should not change even if you re-extract the drawing.

**Material Part Number Consistency**

Material part numbers in an MTO are driven by a label that, by default, looks for the **SequenceID** property of the part. One of the main purposes of Change Management is to have consistent part numbers on the MTO. This also applies to label call-outs for the Part number. However, Change Management does not affect your ability to apply another label, for example, to a gate valve.

**Component Data Continuity**

Any piping parts, components, instruments, or engineered items displaying on a given sheet do not change. If you re-extract the drawing, the components remain on the same drawing sheet. The same is true for the parts inclusion in a material list.
Weld Data Continuity
Welds display on a specific sheet on a piping isometric drawing. If you re-extract the drawing, the
welds do not change sheets. The same is true for the weld list.

Spool Representation Continuity
Spools displaying on a given drawing sheet do not change when you re-extract the drawing unless
a new spool is added or an existing spool is deleted. The software handles additions and deletions
implicitly by the material (parts and components) managed on the drawing; however, the software
also maintains spool integrity. For example, if one part is moved to another drawing sheet and the
spool displayed is active, the entire spool moves with the part.

Material List Continuity
Each drawing sheet has its own material list. The items on the list correspond to those shown in
the drawing. When you re-extract a drawing, the material list for any given component remains
constant. For example, the schematic drawing on which a given commodity displays and the
material list that includes that commodity always display on the same drawing sheet.

User-Defined Isometric Break Points
If the S3D.Drawing.Content.ChangeManagementEnabled option is set to True, the software
ignores all user-defined isometric break points. Only the sheet breaks from a previous extraction
of the drawing is used for change management. If isometric break points are added or deleted
from the model after change management is enabled, there is no impact on revised isometric
drawings.

If change management is turned off (the option is set to False), the software honors the isometric
break points.

Use piping isometric change management
The following procedures show how you must set your isometric style options in order to use
change management for piping isometric drawings. Right-click a Piping Isometric component or
package, then select Edit Options to display the Isometric Style Options Browser.
Set the ChangeManagementEnabled Option

To turn change management on for piping isometric drawings, set
S3D.Drawing.Content.ChangeManagementEnabled to True. For more information, see
Content (S3D Drawing) (on page 655).

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChangeManagementEnabled</td>
<td>True</td>
</tr>
<tr>
<td>PipeItemCode</td>
<td>True</td>
</tr>
<tr>
<td>ShowExpTags</td>
<td>True</td>
</tr>
<tr>
<td>InstrumentTagLineLimit</td>
<td>10</td>
</tr>
<tr>
<td>NozzleTagLabel</td>
<td>True</td>
</tr>
<tr>
<td>RowOutputUnit</td>
<td>False</td>
</tr>
<tr>
<td>SupportFilter</td>
<td></td>
</tr>
<tr>
<td>ExcludeContinuationParts</td>
<td>False</td>
</tr>
<tr>
<td>ExcludeDisconnectedTap</td>
<td>False</td>
</tr>
<tr>
<td>PreserveUserAnnotation</td>
<td>False</td>
</tr>
<tr>
<td>HideSpaceBranch</td>
<td>False</td>
</tr>
</tbody>
</table>

Set the PipeLineSplitting Option

When using change management for piping isometric drawings, set the
Drawing.Controls.PipeLineSplitting option to at least 90 (the default). For more information on
this option, see Controls (Drawing) (on page 428).

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoDrawingSplit</td>
<td>True</td>
</tr>
<tr>
<td>DiagnosticLevel</td>
<td>LOW</td>
</tr>
<tr>
<td>DisconnectMessage</td>
<td>True</td>
</tr>
<tr>
<td>DrawingSize</td>
<td>ANSI &quot;U&quot;</td>
</tr>
<tr>
<td>HeatTrackingOptions</td>
<td></td>
</tr>
<tr>
<td>IsometricType</td>
<td>Combined</td>
</tr>
<tr>
<td>IsotScale</td>
<td>100</td>
</tr>
<tr>
<td>MinAngleOffset</td>
<td>0.00 deg</td>
</tr>
<tr>
<td>NoOilDrawings</td>
<td>1</td>
</tr>
<tr>
<td>NorthDirection</td>
<td>Top Left</td>
</tr>
<tr>
<td>OverwriteFile</td>
<td>False</td>
</tr>
<tr>
<td>PipeLineScale</td>
<td>100</td>
</tr>
</tbody>
</table>

Set the Material List Options

To handle material list overflows from sheet to sheet without breaking change management, we
recommend the following isometric option settings:

2. Set MaterialList.OverflowDrawingID to Alpha suffix (for example: 2A, 3A, and so on).

For more information on setting material list options, see Material List Options (on page 550).

**See Also**
- Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115)

**Option Override (Piping Isometric Drawing Shortcut Menu)**

Overides style settings that have been defined for the selected piping isometric drawing. This feature allows you to modify, or even nullify, individual style settings on a per drawing basis without having to create a new style for a single drawing. When you use this command, the software creates a style fragment that is added to the database. When you update the drawing, the style fragment is merged with the isometric drawing style to produce the final style that is used to update the drawing. After the drawing is updated, you can view the style fragment in the Extraction Data dialog box (on page 101).

You can access this command by right-clicking a piping isometric drawing in the **Detail View**.

- Option Override Dialog Box (on page 179)
- Select Options Dialog Box (on page 179)
Override isometric drawing style options

1. Select a Piping Isometric Drawing component or package in the Management Console. The software displays a list of piping isometric drawings in the Detail View.

2. In the Detail View, right-click a piping isometric drawing, and select Option Override. The Option Override command does not display on the shortcut menu if multiple drawings are selected. The Option Override dialog box (on page 179) displays.

3. Click Add. The Select Options dialog box (on page 179) displays.

4. Select the isometric drawing options that you want to override, and click Add. Hold down the CRTL or SHIFT keys to select multiple options.

   **NOTES:**
   - To search for a particular option by name, type any part of the name in the Search box. For example, if you type north, the Properties list updates to display only the Drawing.Controls.NorthDirection and Drawing.Format.NorthArrowBox options.
   - If the Search box is empty, all available options are shown in the dialog box.
   - The software adds the selected isometric drawing options to the list of overridden options in the Option Override dialog box.

5. Click Done. The Select Options dialog box closes.

6. In the Option Override dialog box, change the values of the listed options as needed. When you are finished, click OK. The software creates the style fragment, the Option Override dialog box closes, and you return to the Management Console view.

7. Right-click the piping isometric drawing in the Detail View, and select Update Now. The software applies the style changes to the drawing.

   **NOTE** After the drawing is updated, you can view the resulting style fragment in the View Extraction Data dialog box. For more information, see View style fragment data (on page 100).
Option Override Dialog Box

Displays all of the options that are currently overridden for the selected drawing. You can change the value of any of the options that are listed. You access this dialog box by right-clicking a piping isometric drawing in the Detail View and selecting Option Override.

**NOTE** If the drawing has no overridden options, the dialog box is empty.

- **Property** - Displays the name of the option. This field is read-only.
- **Value** - Specifies the value of the property. The current value displays by default. Change the value as needed.
- **Add** - Opens the Select Options dialog box (on page 179), in which you can specify which options are overridden.
- **Remove** - Removes the selected property from the list of overridden options.
- **OK** - Creates an override style fragment.
- **Cancel** - Closes the dialog without making any changes to the Catalog database.

Select Options Dialog Box

Displays all the options that are available and their current settings.

- **Search**

  Finds an option based on text that you type. This command searches in the Property list. The software returns the results in the table portion of the browser. To find an option, type text in the Search box and press ENTER. For example, if you type s3d, the Property list displays only the options directly associated with Smart 3D and excludes those that are associated with Personal Isogen. You can also type specific option numbers in the Search box. For example, you can type OPT:79 to find option 79. If the Search box is empty, all available options are shown in the dialog box.

- **Property**

  Displays the name of the option. You can select multiple options by pressing CTRL or SHIFT while selecting. When you select an individual property in this list, the grid at the bottom of the dialog box displays a brief description.

- **Value**

  Displays the current setting of the option. This information is read only.

- **Add**

  Adds the selected property to the list of overridden options on the Override Options dialog box.

- **Done**

  Closes the dialog box, and returns to the Override Options dialog box.
SECTION 9

Detail Sketches in Drawings

Detail sketches are small inserted drawings that provide additional details for components. The sketches are typically used to show more information about hangers and supports, branch connections, support lugs, and special welds.

To include detail sketches on your drawing, you must prepare symbols in a graphics package such as SmartSketch, AutoCAD, or MicroStation. Then, you can specify options that control various characteristics of the detail sketch, such as the text formatting and placement. You also must map the sketches to part class names of components. If a component belonging to a specified part class is in the drawing, the software prints a callout next to the component, and the sketch is included on the drawing. An example detail sketch follows.

The software delivers example detail sketch templates to each client in the \{Product Folder\}\Drawings\Templates\DetailSketches folder. These templates provide an easy way to set up detail sketches for testing and review. The sketches are the proper size with correct positioning of labels, so you can save time by re-using these templates when creating your own.

Informational notes are similar to detail sketches. These notes refer to pipelines, spools, or components in the drawing. An example informational note follows.
Add a detail sketch

1. Open SmartSketch.
2. Create a symbol file.

   **TIP** Alternatively, open one of the delivered symbol files (.sym format) and modify it. The delivered symbol files are located on each client in the \[Product Folder\]\Drawings\Templates\DetailSketches folder. Double-clicking these symbol files opens them in the SmartSketch. You can click the commands on the Help menu to find more information about creating and modifying symbols.

3. Save the symbol file.
4. Open the application and switch to the Drawings and Reports task.
5. Right-click a Piping Isometric component or package, and click Edit Options.
6. Under S3D.Supplementary, set the DetailSketches.ShowDetailSketch option to True.
7. Set the Path option to the location of the symbol file. For example, set the path to \[Product Folder\]\Drawings\Templates\DetailSketches\. You must add the \ character on the end manually.
8. Set other options such as the file format, label type, and sketch position.
9. Under S3D.Supplementary.DetailSketches.SketchMapping, map the part classes and symbols.

   **TIP** You can find a list of part classes in the catalog by switching to the Catalog task and browsing the hierarchy to Drawings > Symbol Map.
10. Save the options to the catalog.

**NOTES**

- The software delivers example detail sketch templates in .sym format to each client in the \[Product Folder\]\Drawings\Templates\DetailSketches folder. These templates provide an easy way to set up detail sketches for testing and review. The sketches are the proper size with correct positioning of labels, so you can save time by re-using these templates when creating your own.
- You also can create the sketch symbol in a graphics package with the capability of exporting to .dxf. Then, open the symbol in the SmartSketch to create the symbol file.
Layers

Layers are used to distinguish between graphics within a template or drawing. You can create layers in SmartSketch Drawing Editor with the Tools > Layers command.

Objects like drawing views, key plan views, report views, and drawing property labels are placed on the DwgTemplate layer when you save the drawing document. You should not place manual markups on the DwgTemplate layer.

When placing manual markups, such as graphics or company logos, place them in paper space within the drawing layers, not in model space (inside a drawing view). Markups placed within model space are not preserved. When a graphic rule does not specify a layer, intelligent graphics are placed on the Default layer.

Composed Drawings

When you create composed drawings, you can place manual markups on any layer of the drawing.

Volume (Spatial) and Orthographic Drawings by Query Drawings

For volume drawings, manual markups are preserved on any layer of the drawing, except the DwgTemplate layer. The DwgTemplate layer is reserved for system use. If you placed manual markups on the DwgTemplate layer, they will be lost when you update the drawing document.

Piping Isometric Drawings

If you intend to create manual markups within a Piping Isometric drawing, you should have a layer in the drawing template with a name prefix of User (for example, a layer named UserAnnotationLayer). You could alternatively place your markups on the Default layer. The software preserves these layers when you update drawings. Other layers are not preserved.

If named layers do not exist in the template, the software creates them using the symbology specified in the style XML file. In the Isometric Style Options Browser, expand Drawing.Layers.Layers to create new layers within the style XML file. Map definitions to the layers under Drawing.Definitions.

If the named layers do exist in the template, use Tools > Display Manager in SmartSketch Drawing Editor to change the symbology used within the template.
Map isometric data to drawing layers

The Isometric Style Options Browser maps layers within a previously created drawing border file to isometric data. The options used to define the mapping are the Drawing.Layers and Drawing.Definitions options.

**CAUTION** Layer definitions created with Tools > Display Manager in SmartSketch Drawing Editor override these settings.

1. Right-click a Piping Isometric Drawing component or package, and click Edit Options.

   The Isometric Style Options Browser displays.

2. Expand Drawing.Layers. You can specify a default color to use for all layers if a color is not explicitly set.

3. Expand Drawing.Layers.Layers. The columns represent the mapping of the layers of the isometric drawing to the content for each layer.

   **TIP** With the isometric drawing open in SmartSketch Drawing Editor, you can click Tools > Display Manager to see a list of the layers for the isometric drawing.

4. Expand Drawing.Definitions. The definitions specify the layers on the isometric drawing. You can specify scale and line thickness.

5. Click Save To Catalog to save the changes to the Catalog database. You must have write permission to reference data to save changes to the isometric style.

   When you update your drawing document, the new styles are applied.

**NOTE** For more information on the drawing layer and drawing definition options, see Layers (Drawing) (on page 515) and Definitions (Drawing) (on page 439).
SECTION 11

Custom Symbols for Isometric Drawings

You can easily create customized symbols for your isometric drawings using SmartPlant Symbol Editor. With this software, you can easily create new or modify existing XML-based or ASCII symbol files. The symbol editor software allows you to define and modify a component and then export the symbol to an ISOGEN ASCII file so that it can be used in the isometric drawings that you generate with Smart 3D. For information about downloading and installing SmartPlant Symbol Editor, please contact Intergraph Support (http://www.intergraph.com/support).

NOTES

- You must use the Smart 3D **Isometric Style Options Browser** to modify the style settings so that the software supports customized symbols that are in ASCII format.
- After creating the symbol file, you associate the file with an isometric style and test it by extracting isometric drawings.

What do you want to do?

- **Configure the software to use an ASCII symbol file** (on page 184)
- **Create a custom symbol for isometric drawings** (on page 185)

---

**Configure the software to use an ASCII symbol file**

**NOTE** To use these customized symbols in Smart 3D, you must first use the SmartPlant Symbol Editor **Export ISOGEN Symbols** command to generate an ISOGEN ASCII (.asc) symbol file. For more information, see the *SmartPlant Symbol Editor User's Guide*, which is delivered with the Symbol Editor software.

1. Open the Drawings and Reports task.
2. Right-click a piping isometric component or package in the Management Console, then click **Edit Options**.
   
   *The Isometric Style Options Browser displays.*
3. Click **Supplementary.DataFiles.DataFiles**.
4. Select **ASCII-SYMBOLS** in the **FileType** list, and set the path to point to the appropriate .asc file.

![Image of symbol editor]  

**Create a custom symbol for isometric drawings**

1. Open the symbol editor software.
2. In the **Library Explorer**, right-click a component type and then click **New Symbol**.
   
   **NOTE** Alternatively, you can click a component type in the **Library Explorer** and then click **Symbol > New Symbol**.

3. In the **New Symbol** dialog box, specify options for the new symbol.
   
   **TIPS**
   - Use the **Original SKEY** list to specify the standard symbol on which the new symbol is to be based.
   - Select the **Copy Symbol from** box and keep the **Library** option selected.
   - Use the **Spindle SKEY** list to specify the required spindle. For example, select the **01SP** spindle.

4. Click **OK**.

5. Modify the symbol as necessary.
   
   **TIPS**
   - Use the commands on the **Symbol** menu to modify the symbol shape or add tapping points.
   - Click in the **Edit** window and use the commands on the toolbar and the **Symbol** menu to draw additional lines for the symbol. Click **Undo** to correct any mistakes. Right-click to stop drawing lines.

6. Click **File > Export ISOGEN Symbols**, and save the symbol file in .asc format.
   
   **NOTE** ASCII (.asc) format is recommended for the creation and maintenance of all Alias symbols. Binary (.bin) format symbol files may not be portable to future software releases.

7. Click **File > Exit** to close the editor.

8. Open Smart 3D, and switch to the Drawings and Reports task.
9. Right-click a Piping Isometric Drawing component or package, and select Edit Options.
10. Select Supplementary.DataFiles.DataFiles.
11. In the DataFileType column, select ASCII-SYMBOLS.
12. In the FilePath column, click the ellipsis button and browse to the symbols library file (.asc file) you created. If necessary, select All Files (*.*) in the Files of type field.
13. Save the options to the catalog and extract some isometric drawings to test.
**SECTION 12**

**Search Folders**

**Search Folder** allows you to search for documents based on common properties such as out-of-date status, approval, or documents that have been published to a certain contract in integrated environment. You create a search folder by right-clicking the root model or a folder in the Management Console or the Drawing Console and selecting New > Search Folder.

After running the query defined for a search folder, you can perform such tasks as Update or Publish as if you are working from the actual component for the documents.

The documents found by a search folder query are listed in the Detail View. You are able to interact with the search folder documents just as if you were dealing with the actual components that own the documents. Search folders can also be used for reports.

**Search Folder Shortcut Menu**

Right-click a search folder component to display the shortcut menu.

- **Run Query** - Runs the query specified by the search folder setup definition. If you have not run the search folder Setup command, this command is not available.

- **Publish** - Publishes a single document or all documents in the imported folder. This command is only available if the model is registered with SmartPlant Foundation.

- **Update Publish** - Updates and immediately publishes a single document or all documents in the search folder. This command is only available if the model is registered with SmartPlant Foundation.

- **Setup** - Specifies the query to run for the search folder. For more information, see Setup (Search Folder) (on page 189).

  **NOTE** Setup for the search folder does not perform the individual setups for any of the drawing by query documents found in the search folder query and shown in the detail view.

- **Copy** - Copies the search folder. It does not copy the associated documents shown in the detail view area. The search folder setup information is saved with the copy. After you paste the copy to a different location in the Console hierarchy, you can run Setup again as needed for the new search folder.

- **Delete** - Deletes the search folder. It does not delete any of the documents found in the associated detail view.

- **Rename** - Renames the search folder. It does not affect any of the documents found in the associated detail view.

- **Revise** - Allows you to revise all documents in the search folder without publishing them. This command is only available if the model is registered with SmartPlant Foundation. For more information, see Revise (on page 388).

- **Save Package** - Allows you to save the search folder and its definition as a package to be reused in other folder locations in the hierarchy. If you have not run the search folder Setup command, this command is not available.
Properties - Displays the Configuration Properties for the document.

**NOTE**  To change properties on the document, go to the root location of the document. The search folder does not participate in any propagation of properties to its documents.

**NOTES**

- After a search folder is placed in the console, it follows the same localized naming convention as a folder, such as "New Search Folder" and "New Search Folder (2)."
- Unlike a folder , you cannot create child components in a search folder . This includes pasting existing components; however, you can copy the search folder and paste it elsewhere in the hierarchy.
- Performing Publish, UpdatePublish, and Revise on a folder does not include documents under a child search folder. The commands need to be performed separately on the child search folder in order for its documents to be affected.
- You can run commands from the search folder level to modify all of the documents within the folder, or you can modify the individual documents by selecting them in the Detail View.

Create a search folder

1. Right-click the model root or a folder in the Management Console, and select New > Search Folder.
   *The search folder is added to the hierarchy.*

2. Right-click on the new search folder, and select Setup.
   *The Setup dialog box displays.*

3. Select More in the Filter list, and select a filter. Click Properties to display the Filter Properties dialog box.

4. Select More in the Start From list and, select a query location.

5. Click OK.

6. Right-click the search folder, and select Run Query.
   *The documents returned by the query are added to the Search Folder listing in the Detail View.*

7. To rename the folder, right-click the folder, and select Rename, or select the folder, and press F2 on the keyboard. Type a new name.
Setup (Search Folder)

Sets options for creating a search folder. This command is available on the Search Folder shortcut menu and displays the Setup dialog box.

**NOTE** Setup for the search folder does not perform the individual setups for any of the drawing by query documents found in the search folder query and shown in the detail view.

**Setup Dialog Box (Search Folder) (on page 189)**

Setup Dialog Box (Search Folder)

Specifies a filter that identifies the objects to be included in the search folder query. The Setup definition tells the query "where" to look for the objects specified by the component "what" filter.

- **Filter** - Identifies the filter that defines the what portion of the query. The software uses the filter to determine the objects included in the drawings when they are generated. Select More in the Filter list to display the Select Filter dialog box. Click Properties to display the Filter Properties dialog box. For more information, see Search Folder Filters (on page 189).

- **Start From** - Specifies the location in the model from which to start the object search. This is the "where" side of the query. Select More in the Start From combo box to display the Select Location dialog box.

Search Folder Filters

Search folders use filters to specify how the component identifies the documents to include in the search folder. You can use Drawings and Reports object properties to define filters when creating search folder components. This allows you to search for documents based on common properties such as out-of-date status, approval, or documents that have been published to a certain contract in integrated environment.

When you run Setup on a search folder, you can create filters that check for specific drawing or report object properties.
The following examples show how you might create filters to search for specific drawing object properties:

**Basic Drawing Document Properties - Title, Area, and Signature**

You can use the **Drawing Sheet** object and its properties to look for properties associated with the drawing documents. The following procedure shows how to access the Title, Area, and Signature properties on the drawing and report documents.

1. On the **Properties** tab of the **Filter Properties** dialog box, select **More** in the **Property** field. The **Select Properties** dialog box displays.

2. Under **Object type used as the basis for the property identification**, select **Drawing Sheets**.

3. Under **Relationship**, select **Direct Properties of Object Type**.

   You can now search the documents for specified properties under **Select one or more properties**. For example, you can search specifically for the **Date Created** value on the documents.
Issue or Revision Properties

To search specifically for issue or revision properties on the drawing sheet or drawing component, set the Relationship to Drawing Sheet (or Drawing Component) to Drawing Issues or Drawing Sheet (or Drawing Component) to Drawing Revisions when setting the filter properties.

### Select Properties

Object type used as the basis for the property identification:

- Drawing Sheets

Relationship:

- Drawing Sheet to Drawing Issues

Related object type:

- Drawing Issues

Display properties in this category:

- Standard

Select one or more properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Data Type</th>
<th>Unit Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Status</td>
<td>ApprovalStatus</td>
<td>Code listed values</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Date Issued</td>
<td>String</td>
<td></td>
</tr>
</tbody>
</table>

Baseline, Style, Smart 3D, or Custom Attribute Properties

To search specifically for baseline, style, Smart 3D, or custom attribute properties, set the Relationship to Drawing Sheet to Drawing Child Properties, and set Related object type to Drawing Child Properties.

### Select Properties

Object type used as the basis for the property identification:

- Drawing Sheets

Relationship:

- Drawing Sheet to Drawing Child Properties

Related object type:

- Drawing Child Properties

See Also

Setup Dialog Box (Search Folder) (on page 189)
SECTION 13

Imported Folders

Imported Folder allows you to import an external Windows folder containing any type of file available in Windows. You create an imported folder by right-clicking a folder in the Management Console or the Drawing Console and selecting New > Imported Folder.

Imported files are opened using their standard Windows default programs. For example, a .docx file opens in Microsoft Word.

Imported Folder Shortcut Menu

Right-click an imported folder component to display the shortcut menu.

Delete - Deletes the imported folder and its files from the database. Deleting does not affect the original folder and files on the network drive.

Rename - Renames the imported folder. Renaming does not affect the files in the folder or the name of the original folder on the network drive.

Revise - Allows you to revise all documents in the imported folder without publishing them. This command is only available if the model is registered with SmartPlant Foundation and when the documents are persisted in the model database. For more information, see Revise (on page 388) and Setup Dialog Box (Imported Folder) (on page 194).

Export - Exports files in the imported folder to the specified folder path. This command is only available after setup of the imported folder, and when the folder and files are persisted in the database.

Refresh - Refreshes the status of files in the imported folder when the date of a file is earlier than the date of the file the on the network drive. The icon of an out-of-date file is superimposed with X. This command is only available after setup of the imported folder.

Publish - Publishes a single document or all documents in the search folder. This command is only available if the model is registered with SmartPlant Foundation and when the documents are persisted in the model database. For more information, see Setup Dialog Box (Imported Folder) (on page 194).

UpdatePublish - Updates and immediately publishes a single document or all documents in the search folder. This command is only available if the model is registered with SmartPlant Foundation and when the documents are persisted in the model database. For more information, see Setup Dialog Box (Imported Folder) (on page 194).

Setup - Specifies the folder to import. For more information, see Setup (Imported Folder) (on page 193).

Update Now - Updates all files in the imported folder to match the files on the network drive. This command is only available after setup of the imported folder.

Properties - Displays the properties of the folder.
Imported Folders

Imported Files

Right-click an imported file to display the shortcut menu.

Open - Opens the file with the appropriate Windows application.

Properties - Displays the properties of the file.

Update - Updates the file to match the files on the network drive. This command is only available after setup of the imported folder.

**IMPORTANT** Select a shared network folder (with a path beginning with \) instead of a local folder to allow refresh and update of file changes between users.

**NOTE** Unlike a folder, you cannot create or paste other components within the imported folder.

Create an imported folder

1. Right click a folder in the Management Console, and select New > Imported Folder

   *The imported folder is added to the hierarchy.*

2. Right-click the folder, and select Setup

   *The Setup dialog box displays.*

3. Type the path in the Folder to Import box.

   OR

   Click Browse, navigate to the needed folder in the Browse for Folder dialog box, and click OK.

4. In the Setup dialog box, click Persist in Database to add the imported files to the model database.

5. Click OK.

   *The imported folder and its files are added to the hierarchy.*

6. To rename the folder, right-click the folder, and select Rename, or select the folder, and press F2 on the keyboard. Type a new name.

Setup (Imported Folder)

Sets options for importing an external folder and its files. This command is available on the Imported Folder shortcut menu and displays the Setup dialog box.

*Setup Dialog Box (Imported Folder) (on page 194)*
Setup Dialog Box (Imported Folder)

Specifies a folder containing the files to import.

You should import from a shared network folder having a path beginning with \ to allow everyone to have access to the same files and to avoid multiple file copies or unintended overwriting of changes from another user. Windows handles read-only locking of the files when they are open. You cannot import the %Temp% folder because it is used for file processing during import.

**Folder to Import** - Specifies the folder path. Type a path, or click **Browse** to select a path.

**Browse** - Allows you to browse for a folder location. For more information, see **Browse for Folder Dialog Box** (on page 194).

**Persist in Database** - When selected, adds imported files to the model database. When cleared, only the folder path to the files is imported.

**NOTE** Export is not available when **Persist in Database** is cleared.

Browse for Folder Dialog Box

Displays a hierarchical list of folders. Select a folder from this list, and click **OK** to choose it, or double-click a folder to display any sub-folders. The selection you make on this dialog box appears in the **Folder to Import** box of the **Setup** dialog box.

**Make New Folder** - Creates a new folder in the hierarchy, beneath the currently selected folder.
Several tools are provided within the Drawings and Reports task. These tools display on the Tools menu in the Drawings and Reports task.

Reference Data Tools
The following commands on the Tools menu are for use by your reference data administrator. They apply strictly to customizing orthographic drawing and marine mode drawings by rule reference data:

- Define View Style
- Define Layout Style
- Edit Border Template
- Edit Layout Template

You do not use these commands in the normal workflow of creating drawings and reports. For more information, see the Drawings and Reports Reference Data Guide.

Other Tools
You can use the Custom Command tool to set up special macro commands you use in your documents. Batch Management processes drawing updates and printing on a batch server. Convert Legacy Snapshots converts legacy version 6.1 snapshot drawings to composed drawings. For more information, see the Orthographic Drawings User's Guide.

In This Section
Batch Processing - Intergraph Smart Batch Services ................... 195
Batch Processing ........................................................................... 200
Custom Commands................................................................. 223

Batch Processing - Intergraph Smart Batch Services
With batch processing, you can update, print, or refresh your documents without dedicating your workstation to the operation.

Drawings Batch Dialog Box
Updates, prints, and refreshes document batch jobs without requiring a dedicated workstation to the operation.

Available Actions
Lists the actions that you can perform within a batch job. The actions available are based on permissions and document type.
- **Full Update** - Updates all drawings by rule documents, regardless of the current status of the documents. This action is only available in the Marine mode.
- **Update** - Updates documents on a Batch Queue.
- **Refresh** - Refreshes documents on a Batch Queue.
- **Print** - Schedules a document to be printed from a Batch Queue.

**Actions to Queue**

Lists the actions that are performed in the batch job.

- **Remove** - Removes an action from the queue.
- **Clear** - Removes all actions from the queue.

**Action Options**

Defines the parameters of an action.

- **Printer** – Displays all printers configured on the client computer. The name of the printer on the batch queue must match for the print to be successful.
- **Copies** – Specifies the number of copies to print.
- **Black and White** – Prints a black and white drawing, if checked.
- **Orientation** – Indicates the orientation of the printed output. Select **Portrait** or **Landscape**.
- **Paper Size** – Displays the paper sizes supported by the selected printer.
- **Template Name** – Saves print settings as a template. Type a name in the box, and click **Save Settings as Template**. While optional, creating a new template is a quick method to submit a batch job with the specified options.
- **Save Settings as Template** - Creates a user-parameterized action.
- **Delete** - Removes a template from Available Actions. This option is available only on user-created templates.

**Use 64-bit if available**

Updates drawings with 64-bit processes. This option is only available for Update actions performed on composed drawings.

**NOTES**

- If you select Use 64-bit if available and run Update on a folder component containing composed drawings and other drawing types, the composed drawings are updated with 64-bit processes. All other drawings are updated with 32-bit processes.
- You cannot update a composed drawing with 64-bit if the drawing contains a view style that includes PDS reference data.

**Schedule**

Creates the job and opens the Schedule Batch dialog box.

**NOTE** If you click Schedule with no actions in Actions to Queue, you receive a message, and the dialog box remains open.
What do you want to do?

- Update Action (on page 197)
- Refresh Action (on page 197)
- Print Action (on page 198)
- Set Print Options (on page 198)
- Create a Template (on page 199)

Update Action

Updates documents on a batch queue while you continue to work on other tasks. You can set up a batch update job for a single document or for multiple documents.

Single document:
1. Right-click a single document either in the Detail View or in the Drawings Console, and select Batch.

2. Select the Update action, and click Add to move it into Actions to Queue.

3. Click Schedule to create the job, and open the Schedule Batch dialog box.

Multiple documents:
1. Do one of the following:
   a. Right-click a set of multi-selected documents or components in the Detail View, and select Batch.
   b. Right-click a component in the Management Console, Detail View, or Drawings Console, and select Batch.

2. Select the Update action, and click Add to move it into Actions to Queue.

3. Click Schedule to create the job, and open the Schedule Batch dialog box.

For more information about the Schedule Batch dialog box and monitoring your batch jobs with Batch Manager, see Schedule [Task] Dialog Box (on page 199) and the Batch Services Users Guide.

Refresh Action

Refreshes documents on a batch queue while you continue to work on other tasks. You can set up a batch refresh job for a single document or for multiple documents.

1. Do one of the following:
   a. Right-click a single component in the Management Console, Detail View, or the Drawings Console, and select Batch.
   b. Right-click a set of multi-selected components in the Detail View and select Batch.
2. Select the **Refresh** action, and click **Add** to move it into **Actions to Queue**.
3. Add any other actions to the queue.
4. Click **Schedule** to create the job and open the **Schedule Batch** dialog box.

For more information about the **Schedule Batch** dialog box and monitoring your batch job with Batch Manager, see *Schedule [Task] Dialog Box* (on page 199) and the *Batch Services Users Guide*.

### Print Action

Schedules documents to be printed. You can set up batch print jobs for a single document or for multiple documents.

**Single document:**
1. Right-click on a single drawing either in the **Detail View** or in the **Drawings Console**, and select **Batch**.
2. Select the **Print** action, and click **Add** to move it into **Actions to Queue**.
3. Define the **Print** action options. For more information on the **Print** action options, see *Batch Processing - Intergraph Smart Batch Services* (on page 195).
4. Click **Schedule** to create the job and open the **Schedule Batch** dialog box.

**Multiple documents:**
1. Do one of the following:
   a. Right-click a set of multi-selected documents or components in the **Detail View**, and select **Batch**.
   b. Right-click a component in the **Management Console**, **Detail View**, or **Drawings Console**, and select **Batch**.
2. Select the **Print** action, and click **Add** to move it into **Actions to Queue**.
3. Define the **Print** action options. For more information on the **Print** action options, see *Batch Processing - Intergraph Smart Batch Services* (on page 195).
4. Click **Schedule** to create the job and open the **Schedule Batch** dialog box.

For more information about the **Schedule Batch** dialog box and monitoring your batch job with Batch Manager, see *Schedule [Task] Dialog Box* (on page 199) and the *Batch Services Users Guide*.

### Set Print Options

1. Click **Add** to move the **Print** action to **Actions to Queue**.
2. Define **Print** options, such as **Orientation** and **Paper Size**.
3. Click **Schedule**.
Create a Template

Templates are user-parameterized actions that are saved in the session file and available for future batch jobs. You can only create templates based on the Print action.

Create a new template:
1. Select the Print action, and click Add to move it to Actions to Queue.
2. In Action Options, make the necessary changes to the action.
3. Type a new Template Name for the action.
4. Click Save Settings As Template.

Delete a template:
1. Select the template to delete.
2. In Action Options, click Delete.

Schedule [Task] Dialog Box

Queue
Displays the name of the queues configured by an administrator for the job. For more information on configuring the queues, see Configure Queues for Jobs in the Project Management User's Guide.

Run job
Sets the frequency with which the job runs. Jobs can be scheduled to run once or on a regular interval (daily, weekly, or monthly). Depending on the job frequency selected, additional controls display. These controls allow you to define more specific scheduling information. The scheduling controls can be changed only at job submission.

Run on
Sets the time to start running the job.

Options
Opens the Optional Schedule Properties Dialog Box (on page 200) that you can use to define a start and end date.

Run on box
Contains a calendar from which you can select the run date. This option is available when you select Once from Run job.

Every X days
 Specifies how many days pass between job runs. This option is available when you select Daily from Run job.

Every X weeks
 Specifies how many weeks pass between job runs. In addition, you can select on which days the job runs. This option is available when you select Weekly from Run job.

Day X of the month
Specifies on which day of the month the job runs. This option is available when you select Monthly from Run job.

**The X Y of the month**

Specifies on which day of the month the job runs. For example, you can select the last Monday of the month. This option is available when you select Monthly from Run job.

**Job Start**

Notifies you when the job starts, if Outlook is set up.

**Job Completion**

Notifies when the job completes, if Outlook is set up.

**Job Abort**

Notifies you if the job aborts, if Outlook is set up.

**Address Book**

Selects the name of the person to be notified by e-mail of the job status, if Outlook is set up. If Outlook is not available, this option does not work. You can also type the address manually. The person you define here receives an email with the job log files after the job finishes.

**NOTES**

- The Batch Services SMTP option must be configured on the batch server for this to work. For more information, see the Intergraph Smart Batch Services documentation.
- The WinZip application is no longer required on the batch server to compress any emailed attachments. Compression is now done with functionality included in Smart 3D.

**Optional Schedule Properties Dialog Box**

Provides more options on the Schedule Backup dialog box. This dialog box opens when you click Options.

**Start date**

Sets an optional start date.

**End date**

Sets an optional end date, if checked.

**Batch Processing**

With batch processing, you can make sure your documents are updated, printed, or refreshed without having to dedicate your workstation to the operation.

**Batch Updating**

Using Batch > Update, available on the Drawings Batch dialog box, you instruct the software to update documents on a Batch Server while you continue to work on other tasks.

**NOTE** Before using Batch > Update for 3D Model Data documents, you must set the appropriate surface styles and aspects for the model data. For more information, see Set surface styles and aspects for 3D model data documents (on page 45).
Batch Printing

Using the Batch > Print command available on the Drawings Batch dialog box, you can schedule batch printing jobs as needed to free up valuable processing time.

Batch Refreshing

Using the Batch > Refresh command available on the Drawings Batch dialog box, you can schedule batch refresh jobs for multiple drawing documents.

Managing Batch Jobs

Tools > Batch Management allows you to view your batch jobs and make changes. For more information, see Manage batch jobs (on page 202).

Setting Up Batch Processing

Batch Server - The computer on which the batch process runs is called the Drawing Batch Server. The server must have Windows 2000 or Windows 7 and Smart 3D Workstation loaded. The computer designated as the batch server is usually one that is not being used to perform daily tasks, as the process of updating large numbers of documents and drawings can consume a great deal of the computer's resources. You can have one or more batch servers per site database. For more information, see Project Size Estimates and Drawing Batch Server in the Intergraph Smart 3D Installation Guide.

IMPORTANT To initially configure the Batch Server, you must be an administrator on that computer and have write permissions or better on the model, the SharedContent share, and any permission groups that access drawings.

Client - The workstations that send batch processes to the server are called clients.

NOTES:

▪ If the Batch commands are not available on the shortcut menus for your documents, you are not configured to use batch processing.

▪ Most of the scheduling is stored on the Batch Server in the form of scheduled items in the Windows Task Scheduler. After models have been assigned to the Batch Server, new processes display in the Processes tab of the Task Manager dialog box on that computer. The Batch Manager process indicates that at least one model can use this computer as a Batch Server. For each model selected on the Setup 3D Drawings Batch Server dialog box, one Batch Server process displays in the list. If the Batch Manager or Batch Server processes are stopped, the computer does not process batch updates.

▪ You can also have a Batch Tier process running for each of the selected models. This process is created when the Batch Server process finds a batch job and terminates automatically after the Batch Server has been inactive for a while.

See Also

Updating Documents (on page 75)
Batch Update (on page 208)
Batch Print (on page 208)
Batch Refresh (on page 210)
Batch Management

Allows you to view your batch jobs and make changes.

What do you want to do?

- Manage batch jobs (on page 202)
- Edit or delete batch jobs (on page 203)
- Configure batch processing in the Common User’s Guide
- Remove a model from the batch server in the Common User’s Guide

Manage batch jobs

You can only modify or delete batch jobs that you own. You cannot change or delete batch jobs owned by others.

1. Select Tools > Batch Management. The Batch Management dialog box displays, showing the currently scheduled batch jobs with their status. For more information, see Batch Management Dialog Box (Batch Management Command) (on page 204).

2. Click a column header to sort the batch job table by the column definition.

3. Use the View menu items to Refresh the batch job list or toggle the Status Bar on or off.

4. Select one or more batch jobs, and then select Action > Pause to suspend the idle jobs. This command has no effect on jobs that have started processing.

5. Select one or more batch jobs, and then select Action > Resume to continue processing the paused jobs. This command has no effect on jobs that are already processing.

6. To cancel a batch job, select it in the table, and then select Action > Cancel.

7. To modify the batch schedule definition for a batch job, select it, and then select Action > Properties. The Properties dialog box displays, showing the current schedule definition. For more information on modifying the properties, see Properties Dialog Box (Batch Management Command) (on page 205).

**TIP**: You can also right-click a batch job to display a shortcut menu for the Pause, Resume, Cancel, and Properties.
Edit or delete batch jobs

Complete the following steps to edit or delete an existing batch job.

**NOTE** You can also use Tools > Batch Management to update existing batch jobs. For more information, see Manage batch jobs (on page 202).

1. Right-click a document that has a batch job scheduled and select the batch command to run: Update, Print, or Refresh. The Schedule Wizard displays.

2. The default setting is Schedule the Batch Job. Click Next to schedule a new batch job or edit the existing batch job.

3. To edit or delete an existing batch job, select the Edit an existing job option. The table at the bottom of the wizard page enables.

   **NOTE** To schedule a new batch job for this document, select the Schedule new job option and click Next to display the next page of the Schedule Wizard and create a new batch job.
schedule. For more information, see Set Batch Job Frequency (Schedule Wizard) (on page 215).

4. Select a batch job in the table. To delete the batch job, click Delete. To edit the batch job, click Next to display the next page of the Schedule Wizard and edit the batch job properties. For more information, see Set Batch Job Frequency (Schedule Wizard) (on page 215).

**Batch Management Dialog Box (Batch Management Command)**

Displays a list of jobs that have been submitted to the batch server, and allows you to view or manage those jobs. You can open this dialog box by selecting Tools > Batch Management.

**TIP** Click a column header to sort the batch job table by the column definition.

**Job Name**
Displays the name of the batch job.

**NOTE** Non-scheduled batch jobs use the name of the drawing or drawing component type being processed.

**Server**
Displays the name of the batch server processing the batch job.

**NOTE** Batch jobs are submitted to a queue on the model database. The batch servers retrieve the jobs from the queue in a first-in/first-out order.

**Parent Component**
Identifies the name of the parent component for the batch job.

**Filter Name**
Identifies the name of the filter used for the batch job. For more information, see Batch Dialog Box (Submit Batch Job).

**Request**
Displays the type of the batch job request. For example, Update or Print.

**Status**
Indicates the current status of the batch job. For example: Updating, Submitted, Scheduled, or Printing.

**Owner**
Displays the name of the owner of the batch job.

**Submitted**
Shows the date and time that the batch job was submitted or scheduled.

**Scheduled**
Indicates how the batch job has been scheduled. For example: Daily, Weekly, Monthly, One time only, and so forth.

**Action Menu**

**Pause**
Suspends the selected idle jobs. A job that is updating will not pause.

**Resume**
Removes the hold on the paused items. This command has no effect on jobs that are already processing.

**Cancel**
Deletes the selected jobs from the queue.

**Properties**
Displays the **Properties** dialog box for the selected job. This command is inactive if multiple jobs are selected. For more information, see *Properties Dialog Box (Batch Management Command)* (on page 205).

**View Menu**

**Status**
Turns the display of the status bar on/off.

**Refresh**
Refreshes the display of the batch job list.

**See Also**
*Batch Management* (on page 202)

**Properties Dialog Box (Batch Management Command)**
Displays the current batch schedule for the selected batch job, and allows you to modify the schedule. You can open this dialog box by selecting **Action > Properties** in the **Batch Management** dialog box.

The information on this dialog box changes depending on the active schedule definition of the batch job. The active schedule definition is shown at the top of the dialog box.

**Schedule task**
Sets the type of schedule for the task. If you change this setting, the other options on the dialog box change as well.

**Start time**
Specifies the time for the batch job to start. You can select a time using the scroll button or define a time in the format shown.
Batch Jobs Scheduled Once

The following example shows a "once only" batch job:

Start date

Specifies the date on which the batch job update begins.

Batch Jobs Scheduled Daily

If the batch job is scheduled to run daily, the Properties dialog box displays as follows:

Every count day(s)

Specifies a number of days. The batch job runs once per the specified count of days. For example, if you specify 2 as the value, the batch job runs once every two days.

Starting on

Specifies the date on which the batch job schedule begins.
Batch Jobs Scheduled Weekly

If the batch job is scheduled to run weekly, the Properties dialog box displays as follows:

Every count week(s)

Specifies a number of weeks for which the batch job will run.

You can check as many days during the week as required. The batch job runs once per day for the specified count of weeks.

Batch Jobs Scheduled Monthly

If the batch job is scheduled to run monthly, the Properties dialog box displays as follows:

You use the two options to specify when the batch job runs during the month. You can check as many months a required. The batch job runs once on the specified day of the specified month(s).

See Also
Batch Management (on page 202)
Batch Print

Allows you to submit document files directly to a print queue for a printer or schedule the document files to be sent to the print queue at a later date or at recurring intervals. You can set up batch print jobs for a single document or a select set of documents you select in the Detail View. This command is available when you right-click on a single drawing or a select set of drawings in the Detail View.

The Batch > Print command displays the Schedule Wizard so you can specify whether the drawing should be printed now or at a scheduled date and time. The batch print job runs on a batch server. If the command is not available on the shortcut menu for your documents, batch processing is not configured.

To walk-through the Schedule Wizard and set up batch printing, see Batch Print Schedule Wizard Common Tasks (on page 220).

To view and manage current batch jobs, see Manage batch jobs (on page 202).

**NOTES**

- After setting up the batch print job, the software checks to see if any of the documents are being updated. If so, the software holds the print job until the updates are complete.
- As long as a document has a file created for it, you will be able to print the drawing. The software does not check to see if the drawing is up-to-date, out of date, or in an error state.
- The Batch Print command is not available for a MicroStation 3D DGN component document file.
- The drawing is printed on the default printer of the batch server that processes the print job.

**See Also**
Batch Processing (on page 200)
Print Command (on page 42)

Batch Update

Allows you to update documents on a Batch Server while you continue to work on other tasks. You can set up batch update jobs for a single document or a select set of documents you select in the Detail View. This command is available when you right-click on a single drawing or a select set of drawings in the Detail View.

The Batch > Update command displays the Schedule Wizard so you can specify whether the drawing should be updated now or at a scheduled date and time. The batch update job runs on a batch server. If the command is not available on the shortcut menu for your documents, batch processing is not configured.

To walk-through the Schedule Wizard and set up batch updates, see Batch Schedule Wizard Common Tasks (on page 211).

To view and manage current batch jobs, see Manage batch jobs (on page 202).

**NOTES**

- Before using Batch > Update for 3D Model Data documents, you must set the appropriate surface styles and aspects for the model data. For more information, see Set Surface styles and aspects for 3D model data documents (on page 45).
The **Batch > Update** command detects when only border changes have been made and only updates the border portion of the drawing that is out-of-date.

If the software cannot make a SmartPlant Foundation server connection when you use **Batch > Update** for 3D Model Data documents, you are prompted to provide a valid login and password.

**See Also**
- Updating Documents (on page 75)
- Batch Processing (on page 200)

**Batch Local Update**

Allows you to update documents locally while you continue to work on other tasks. This command is available when you right-click on a single drawing. The command triggers a local background update against the drawing document.

To view and manage current batch jobs, see *Manage batch jobs* (on page 202).

**NOTES**
- Before using **Batch > Local Update** for 3D Model Data documents, you must set the appropriate surface styles and aspects for the model data. For more information, see *Set surface styles and aspects for 3D model data documents* (on page 45).
- The default timeout value for updating documents through the Batch Server is 40 minutes. For more information on setting the **Batch timeout (in minutes)** property on a drawing document, see *Style Tab (Properties Dialog Box)* (on page 51).
- You cannot process more than one Batch Local Update at a time. If you attempt to process a second Batch Local Update, an error dialog will display. For more information, see *Updating Documents* (on page 75).
- If the software cannot make a SmartPlant Foundation server connection when you use **Batch > Update** for 3D Model Data documents, you are prompted to provide a valid login and password.

**See Also**
- Updating Documents (on page 75)
- Batch Processing (on page 200)

**Batch Update Document(s)**

**Batch > Update Document(s)** updates existing drawings or reports if they are out-of-date. This command updates all the documents associated with a drawing or report component. You can also multi-select documents within the **Detail View**.

This command is available when you right-click a component in the **Console** hierarchy and point to the **Batch** submenu.

If batch processing is configured for the selected item, the command displays the **Schedule Wizard** so you can specify whether the update should perform now or at a scheduled date and time. The update is performed on the Batch Server. For more information, see *Batch Schedule Wizard Common Tasks* (on page 211).

For volume drawings, the **Batch > Update Document(s)** command is not available until you place drawing volumes for a volume component in the Space Management task. For composed
drawings, this command is not available until you create the drawings in a 3D task. For reports, this command is not available until you create the report by choosing a report template.

To view or modify the currently scheduled batch update jobs, see Manage batch jobs (on page 202).

**NOTES**
- The software preserves many of the modifications you make between regenerations of volume drawings. For example, if you annotate a volume drawing and then regenerate it, your annotations still display on the updated drawing.
- To update a single drawing, right-click a drawing and select Update (for Drawings by Rule) or Update Now.
- If the software cannot make a SmartPlant Foundation server connection when you use Batch > Update for 3D Model Data documents, you are prompted to provide a valid login and password.

**See Also**
Updating Documents (on page 75)

**Batch Refresh**

Allows you to refresh documents on a Batch Server while you continue to work on other tasks. The Batch > Refresh command compares the date of the last update of the document with the modification date in the model for any object that has a positive (can be seen) resymbolization in the drawing. You can set up batch update jobs for a single document or a select set of documents you select in the Detail View. This command is available when you right-click on a single drawing or a select set of drawings in the Detail View.

The Batch > Refresh command displays the Schedule Wizard so you can specify whether the drawing should be updated now or at a scheduled date and time. The batch refresh job runs on a batch server. If the command is not available on the shortcut menu for your documents, batch processing is not configured.

The Batch > Refresh command Schedule Wizard works the same as the one for the Batch > Update command. To walk-through the Schedule Wizard and set up batch refreshes, see Batch Schedule Wizard Common Tasks (on page 211).

To view and manage current batch jobs, see Manage batch jobs (on page 202).

**NOTE** Batch > Refresh is not available for Spreadsheet Report documents. Spreadsheet Report documents regenerate each time you run, update, or print the report. It is supported for all types of drawing documents.

**See Also**
Batch Processing (on page 200)
Batch Update Document(s) (on page 209)
Update Now (on page 77)
Schedule Wizard

The Schedule Wizard displays when you are configured to use batch scheduling, which is available for **Update**, **Refresh**, and **Print**. The **Batch > Update**, **Batch > Refresh**, and **Batch > Print** commands display on the shortcut menu when you select document(s) or components. You can submit an existing batch job request or schedule a new one. You can also multi-select documents within the **Detail View**.

**NOTE** **Batch > Refresh** is not available for Spreadsheet Report documents. Spreadsheet Report documents regenerate each time you run, update, or print the report. It is supported for all types of drawing documents.

If you access the Schedule Wizard for a document that already has a batch job scheduled, you can edit or delete the existing batch job. For more information, see **Edit or Delete Batch Jobs** (on page 203).

You can also manage your existing batch jobs with **Tools > Batch Management**. For more information on using batch processing, see **Batch Processing** (on page 200).

To walk-through the **Schedule Wizard** and set up batch updates, see **Batch Schedule Wizard Common Tasks** (on page 211). For batch printing, see **Batch Print Schedule Wizard Common Tasks** (on page 220).

**NOTE** The default timeout value for updating documents through the Batch Server is 40 minutes. For more information on setting the **Batch timeout (in minutes)** property on a drawing document, see **Style Tab (Properties Dialog Box)** (on page 51).

**See Also**
- **Updating Documents** (on page 75)
- **Batch Processing** (on page 200)
- **Batch Print** (on page 208)
- **Batch Refresh** (on page 210)
- **Batch Update** (on page 208)

**Batch Schedule Wizard Common Tasks**

The following Schedule Wizard tasks are used when you schedule batch update or refresh jobs for drawings and reports documents.

**NOTE** **Batch > Refresh** is not available for Spreadsheet Report documents. Spreadsheet Report documents regenerate each time you run, update, or print the report. It is supported for all types of drawing documents.

The Schedule Wizard displays when you are configured to use a batch server and select **Batch > Update** or **Batch > Refresh** from the shortcut menu for a selected document(s).

**Submitting or Scheduling a Batch Update or Refresh Job**

The initial page of the **Schedule Wizard** allows you to specify whether you want to submit a batch update or refresh job now or schedule it for later. For more information, see **Submit or Schedule a Batch Job (Schedule Wizard)** (on page 213).
Setting Batch Job Frequency

If you selected the Schedule the batch job option on the initial page of the Schedule Wizard, the second page specifies the batch job frequency, or how often you want the batch job to update or refresh. For more information, see Set Batch Job Frequency (Schedule Wizard) (on page 215).

Scheduling a Daily Batch Job

When you select the Daily option on the second page of the Schedule Wizard, you specify the day and time you want the batch job to start. For more information, see Schedule Daily Batch Job (Schedule Wizard) (on page 216).

Scheduling a Weekly Batch Job

When you select the Weekly option on the second page of the Schedule Wizard, you specify the time and day you want the job to start on a per week basis. For more information, see Schedule Weekly Batch Job (Schedule Wizard) (on page 217).

Scheduling a Monthly Batch Job

When you select the Monthly option on the second page of the Schedule Wizard, you specify the time and day you want the batch job to start and the months in which you want the job to run. For more information, see Schedule Monthly Batch Job (Schedule Wizard) (on page 218).

Scheduling a One-Time-Only Batch Job

When you select the One time only option on the second page of the Schedule Wizard, you specify the time and day you want the batch job to start. For more information, see Schedule One-Time-Only Batch Job (Schedule Wizard) (on page 219).

Completing the Scheduling

After you have specified the frequency, date, and time settings for your batch job schedule, the final wizard page displays. This page also displays if you selected the One time only option on the second page of the wizard. For more information, see Complete Batch Schedule (Schedule Wizard) (on page 220).

For documents that have existing batch jobs, the Schedule Wizard initial page is different.

Scheduling a New Batch Job

To create a new batch job for the selected document(s), select the Schedule a new job option. When you click Next, the behavior is the same as the tasks described above, starting with Set Batch Job Frequency (Schedule Wizard) (on page 215).

Editing or Deleting Existing Batch Jobs

When you select Batch > Update or Batch > Refresh on the shortcut menu of a document that already has a scheduled batch job, you can edit or delete an existing batch job by selecting the Edit existing job(s) option on the second page of the Schedule Wizard. For more information, see Edit or Delete Batch Jobs (on page 203).
Submit or Schedule a Batch Job (Schedule Wizard)

Specifies whether you want to submit a batch update or refresh job now or schedule it for later.

Submit the batch job now - Specifies that the job will be automatically named and submitted to the Batch Server when you click Finish. The batch job name defaults using the convention BatchJob1, BatchJob2, and so forth to keep the batch job names unique. This option is specified by default when you select Update from the Batch submenu for a document that has no previously scheduled batch jobs.

Schedule the batch job - Specifies that you want to set a date and time for the batch job to run. Click Next to go to the next page of the wizard to continue scheduling the batch job. For more information, see Set Batch Job Frequency (Schedule Wizard) (on page 215).

NOTES

- If the document from which you accessed the Schedule Wizard already has batch jobs scheduled, the Schedule the batch job option is the default selection. When you click Next, you can either create a new batch job for the document or edit an existing one. You can also delete an existing batch job. For more information, see Update an Existing Batch Job (Schedule Wizard) (on page 214).

- Batch > Refresh is not available for Spreadsheet Report documents. Spreadsheet Report documents regenerate each time you run, update, or print the report. It is supported for all types of drawing documents.

See Also

Schedule Wizard (on page 211)
Updating Documents (on page 75)
Batch Processing (on page 200)
Batch Management (on page 202)
**Update an Existing Batch Job (Schedule Wizard)**

Creates a new batch job for the document, edits the existing batch job, or deletes the existing batch job.

**NOTE** You can also use **Tools > Batch Management** to update existing batch jobs. For more information, see **Manage batch jobs** (on page 202).

Schedule a new job - Specifies that you are creating a new batch job for the document. Click **Next** to display the next page of the Schedule Wizard and define a new batch job. For more information, see **Set Batch Job Frequency (Schedule Wizard)** (on page 215).

Edit an existing job - Specifies that you want to edit or delete an existing batch job definition. When you select this option, the table at the bottom of the page enables.

Delete - Deletes the batch job selected in the table at the bottom of the dialog box. This button is only enabled when a batch job is selected.

Existing batch job table - Lists the batch jobs for the document. To edit a batch job definition, select it in the table and click **Next** to display the next page of the Schedule Wizard. For more information, see **Set Batch Job Frequency (Schedule Wizard)** (on page 215).

See Also

- **Schedule Wizard** (on page 211)
- **Updating Documents** (on page 75)
- **Batch Processing** (on page 200)
Set Batch Job Frequency (Schedule Wizard)

Specifies the frequency with which you want to run the batch job. Update or print this document or set of documents. This page of the wizard displays under two different conditions:

- If the document(s) has no previously schedule batch jobs and you select the Schedule the batch job option on the initial page of the Schedule Wizard.
- If the document(s) has previously scheduled batch jobs in existence, and you select the Schedule a new batch job option on the initial page of the Schedule Wizard.

Type a name for this batch job. - Specifies the batch job name. The batch job name defaults using the convention BatchJob1, BatchJob2, and so forth to keep the batch job name unique. You can change the batch job name.

Perform this job: - Specifies the frequency option for updating the batch job. The options are described as follows:

- **Daily** - The batch job runs daily at the time specified on the next page of the wizard. For more information, see Schedule Daily Batch Job (Schedule Wizard) (on page 216).
- **Weekly** - The batch job runs weekly on the day and time specified on the next page of the wizard. For more information, see Schedule Weekly Batch Job (Schedule Wizard) (on page 217).
- **Monthly** - The batch job runs monthly on the month, day, and time specified on the next page of the wizard. For more information, see Schedule Monthly Batch Job (Schedule Wizard) (on page 218).
- **One time only** - The batch job runs one time only. For more information, see Schedule One-Time-Only Batch Job (Schedule Wizard) (on page 219).

See Also
Schedule Wizard (on page 211)
Updating Documents (on page 75)
Batch Processing (on page 200)
Batch Management (on page 202)
**Schedule Daily Batch Job (Schedule Wizard)**

Specifies the time and day you want the batch job to start. When you click **Next**, the final wizard page displays the batch schedule settings. If the schedule is incorrect, click **Back** to return to previous wizard pages and make corrections.

**Start time** - Specifies the time for the batch job to start. You can select a time using the scroll button or define a time in the format shown.

**Perform the job** - Specifies the day option for updating the batch job. The options are described as follows:

- **Every Day** - The batch job runs every day at the time specified at the top of the wizard page.
- **Weekdays** - The batch job runs every weekday (Monday through Friday) at the time specified at the top of the wizard page.
- **Every** - You specify a number of days in the field provided. The batch job runs once per the specified count of days. For example, if you specified 2 as the value, the batch job runs once every 2 days.

**Start date** - Specifies the date on which the batch job begins.

**See Also**

- *Schedule Wizard* (on page 211)
- *Updating Documents* (on page 75)
- *Batch Processing* (on page 200)
- *Complete Batch Schedule (Schedule Wizard)* (on page 220)
- *Batch Management* (on page 202)
Schedule Weekly Batch Job (Schedule Wizard)

Specifies the time and day you want the batch job to start on a weekly basis. When you click Next, the final wizard page displays the batch schedule settings. If the schedule is incorrect, click Back to return to previous wizard pages and make corrections.

**Start time** - Specifies the time for the batch job to start. You can select a time using the scroll button or define a time in the format shown.

**Every** - Specifies a number of weeks. The batch job runs once per the specified count of weeks. For example, if you specified 2 as the value, the batch job will run once every 2 weeks.

**Day checkboxes** - Specifies the day of the week you want the batch job to run.

See Also

*Schedule Wizard* (on page 211)
*Updating Documents* (on page 75)
*Batch Processing* (on page 200)
*Complete Batch Schedule (Schedule Wizard)* (on page 220)
*Batch Management* (on page 202)


**Schedule Monthly Batch Job (Schedule Wizard)**

Specifies the time and day you want the batch job to start and in which months you want the job to run. When you click **Next**, the final wizard page displays the batch schedule settings. If the schedule is incorrect, click **Back** to return to previous wizard pages and make corrections.

**Start time** - Specifies the time for the batch job to start. You can select a time using the scroll button or define a time in the format shown.

**Day** - Specifies a specific day of the month. The batch job runs once per the day specified. For example, if you specified 2 as the value, the batch job runs on the second day of the selected months.

**The set weekday** - Specifies the day of the week you want the batch job to run. For example, you can set the batch job to run on the **second Tuesday** of every selected month.

**Of the month(s)** - Specifies the months you want the batch job to run. You can select multiple months.

**See Also**

*Schedule Wizard*(on page 211)  
*Updating Documents*(on page 75)  
*Batch Processing*(on page 200)  
*Complete Batch Schedule (Schedule Wizard)* (on page 220)  
*Batch Management*(on page 202)
Schedule One-Time-Only Batch Job (Schedule Wizard)

Specifies the time and day you want the one-time-only batch job to start. When you click Next, the final wizard page displays the batch schedule settings. If the schedule is incorrect, click Back to return to previous wizard pages and make corrections.

Start time - Specifies the time for the batch job to start. You can select a time using the scroll button or define a time in the format shown.

Start date - Specifies the date on which the batch job update begins.

See Also
Schedule Wizard (on page 211)
Updating Documents (on page 75)
Batch Processing (on page 200)
Complete Batch Schedule (Schedule Wizard) (on page 220)
Batch Management (on page 202)
**Complete Batch Schedule (Schedule Wizard)**

Shows the completed schedule setup for the batch job. It displays the name of the batch job and the time and date when the job will run.

If the schedule is incorrect, click **Back** to return to previous wizard pages and make corrections. If the batch job is scheduled correctly, click **Finish** to process the batch job request.

**See Also**
- Schedule Wizard (on page 211)
- Updating Documents (on page 75)
- Batch Processing (on page 200)
- Batch Management (on page 202)

**Batch Print Schedule Wizard Common Tasks**

The following Schedule Wizard tasks are used when you schedule batch print jobs for drawings and reports documents.

The Schedule Wizard displays when you are configured to use a batch server and select *Batch > Print* from the shortcut menu for a selected document(s).

**Submitting or Scheduling a Batch Print Job**

The initial page of the Schedule Wizard allows you to specify whether you want to submit a batch print job now or schedule it for later. For more information, see *Submit or Schedule Printing (Schedule Wizard)* (on page 222).

**Setting Batch Job Frequency**

If you selected the *Schedule the batch job* option on the initial page of the Schedule Wizard, the second page specifies the batch job frequency, or how often you want the batch job to update. For more information, see *Set Batch Job Frequency (Schedule Wizard)* (on page 215).
Scheduling a Daily Batch Job

When you select the **Daily** option on the second page of the **Schedule Wizard**, you specify the day and time you want the batch job to start. For more information, see **Schedule Daily Batch Job (Schedule Wizard)** (on page 216).

Scheduling a Weekly Batch Job

When you select the **Weekly** option on the second page of the **Schedule Wizard**, you specify the time and day you want the job to start on a per week basis. For more information, see **Schedule Weekly Batch Job (Schedule Wizard)** (on page 217).

Scheduling a Monthly Batch Job

When you select the **Monthly** option on the second page of the **Schedule Wizard**, you specify the time and day you want the batch job to start and the months in which you want the job to run. For more information, see **Schedule Monthly Batch Job (Schedule Wizard)** (on page 218).

Scheduling a One-Time-Only Batch Job

When you select the **One time only** option on the second page of the **Schedule Wizard**, you specify the time and day you want the batch job to start. For more information, see **Schedule One-Time-Only Batch Job (Schedule Wizard)** (on page 219).

Completing the Scheduling

After you have specified the frequency, date, and time settings for your batch job schedule, the final wizard page displays. This page also displays if you selected the **One time only** option on the second page of the wizard. For more information, see **Complete Batch Schedule (Schedule Wizard)** (on page 220).

For documents that have existing batch jobs, the **Schedule Wizard** initial page is different.

Scheduling a New Batch Job

To create a new batch job for the selected document(s), select the **Schedule a new job** option. When you click **Next**, the behavior is the same as the tasks described above, starting with **Set Batch Job Frequency (Schedule Wizard)** (on page 215).

Editing or Deleting Existing Batch Jobs

When you select **Batch > Print** on the shortcut menu of a document that already has a scheduled batch job, you can edit or delete an existing batch job by selecting the **Edit existing job(s)** option on the second page of the Schedule Wizard. For more information, see **Edit or Delete Batch Jobs** (on page 203).
Submit or Schedule Printing (Schedule Wizard)

Specifies whether you want to submit a batch print job now or schedule it for later.

![Schedule Wizard dialog box](image)

**Printer** - Specifies the printer to which the document will be submitted.

**Number of copies** - Indicates the number of copies of the document to print.

**Pure black and white** - Specifies that the document should be printed in pure black and white, with the software setting the color alterations based on colors used in the document.

**Schedule the batch job** - Specifies that you want to set a date and time for the batch job to run. Click **Next** to go to the next page of the wizard to continue scheduling the batch job. For more information, see *Set Batch Job Frequency (Schedule Wizard)* (on page 215). If you do not check this box, the document prints immediately to the selected printer.

**NOTE** If the document from which you accessed the **Schedule Wizard** already has batch jobs scheduled, the **Schedule the batch job** option is the default selection. When you click **Next**, you can either create a new batch job for the document or edit an existing one. You can also delete an existing batch job. For more information, see *Update an Existing Batch Job (Schedule Wizard)* (on page 214).

**See Also**
*Batch Schedule Wizard Common Tasks* (on page 211)
*Schedule Wizard* (on page 211)
*Updating Documents* (on page 75)
Custom Commands

Provides you with application programming capability for the 3D software. Using Microsoft® Visual Basic, you can create a custom command that groups a series of commands and instructions into a single command that runs as an operation in the 3D software. As a result, you can access the customized commands that directly relate to the work routine in your operation.

In Visual Basic, the Command Wizard helps you to build a custom command. For example, the first Command Wizard step prompts you to identify general information, including command name, project name, author, and company. You can start the wizard in Visual Basic by clicking Command Wizard on the Add-Ins menu. For more information about installing the Command Wizard and other programming resources, see the Intergraph Smart™ 3D Installation Guide available by clicking Help > Printable Guides in the software.

After adding a custom command in the 3D software, you can edit it. The Edit Custom Command dialog box requires you to specify the program identifier (prog_id), command name and description, command priority, and a command line of arguments in a string.

Delivered Custom Commands

The following list provides descriptions and ProgIDs for the delivered custom commands:

<table>
<thead>
<tr>
<th>Custom Command</th>
<th>ProgID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Database Integrity</td>
<td>SP3DCheckDatabasIntegrity</td>
<td>Creates records for the objects that need to be cleaned. You run this custom command directly on a database (Site, Catalog, or Model). After you run this command, you can generate a report to review the errors that the Check Database Integrity command generated. For more information on the Check Database Integrity command, see the Database Integrity Guide available from Help &gt; Printable Guides.</td>
</tr>
<tr>
<td>Clean Database</td>
<td>SP3DCleanDatabaseCmd</td>
<td>Deletes or cleans an object. This command is used when an action on the Check Database Integrity report is To Be Removed or To Be Repaired. For more information on deleting and cleaning objects in the database, see the Database Integrity Guide available from Help &gt; Printable Guides.</td>
</tr>
<tr>
<td>Compart Query Service</td>
<td>CompartQuery.</td>
<td>Provides queries on compartments, objects, geometry, and loads. You can save a .sat file from the geometry queries.</td>
</tr>
<tr>
<td>Custom Command</td>
<td>ProgID</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Create Drawing View</td>
<td>MenuDrawView, CMenuDrawView</td>
<td>Saves and converts the contents of a three-dimensional graphic view window into a snapshot view. The command creates a rectangular object associated to a clipping volume or volumes in the three-dimensional model. Before you create a snapshot view using this command, you must have added at least one composed drawing type to the Management Console in the Drawings and Reports task. You can save additional views by updating the view contents and then saving the new design. If you used the Tools &gt; Hide command to avoid displaying certain objects, those objects are included in a composed drawing you create. You must have appropriate permissions to access composed drawing types, or you cannot use the Tools &gt; Snapshot View command. If you have only read permission, you receive a message that alerts you to this condition. After you create the snapshot views, you can add them to composed drawings when you use the Tools &gt; Drawings Console command.</td>
</tr>
<tr>
<td>Drawings Check and Repair Utility</td>
<td>DwgCheckUtility, Ingr.SP3D.DwgCheckUtility.RunChecksCmd</td>
<td>Checks drawing items for problems, such as mismatches between views, smartframes, and OIDs; duplications of views, smartframes, and OIDs; and invalid dimensions with missing smartframe attributes. After problems are found, you can run repairs. This command is intended for use by your administrator.</td>
</tr>
<tr>
<td>Custom Command</td>
<td>ProgID</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Find Object by OID</td>
<td>SP3DFindObjectByReport.</td>
<td>Finds objects with integrity problems in a graphic view. Before running this command, you must define your workspace to include these objects. Run a database integrity report, and use the reported OIDs of the objects in the workspace definition. For more information on the Find Objects by OID custom command, see the Database Integrity Guide available from Help &gt; Printable Guides.</td>
</tr>
<tr>
<td>Fix Project Root</td>
<td>SP3DPRJMGTRepairCmd.</td>
<td>Synchronizes the model name in the Model database and the Site database. The name in the Site database prevails.</td>
</tr>
<tr>
<td>Fix Sector Size of Documents</td>
<td>DwgBinaryEditorCmd.</td>
<td>Adjusts the sector size from small to large. Documents that have many sheets and a small sector size can cause the software to run out of memory.</td>
</tr>
<tr>
<td>Reset Design Basis Time</td>
<td>IMSEngFrameworkCmd.</td>
<td>Modifies the Design Basis timestamp. With this command, you can set the time and date back to a point in the past. This command is useful if, for any reason, there are delete instructions that could not be processed.</td>
</tr>
<tr>
<td>Synchronize Drawing Component Templates</td>
<td>DwgSynchTemplatesCmd.</td>
<td>Repairs a drawing component that has become corrupted by synchronizing it with a different, uncorrupted drawing component. This command requires that the source component is the same type as the corrupted component, the source component must have a template, and that the source component cannot be corrupted. Also, the number of views on the source component must be the same as the number of views on the corrupted component. The names of the views on the source component must match the view names of the corrupted component.</td>
</tr>
</tbody>
</table>
Custom Command | ProgID | Description
--- | --- | ---
Verify P&ID Integrity | SP3DDisplayPIDService. VerifyPIDCmd | Validates the internal connections between objects on a P&ID and objects in the Model database. This command is useful when there is a problem displaying a P&ID or selecting objects on a P&ID. The command provides some basic troubleshooting statistics: Number of design basis objects, number of 3D objects (correlated), number of P&ID objects, number of deleted P&ID OIDs, and number of duplicate OIDs.

Create custom commands

1. Open Microsoft® Visual Basic.

   **TIPS**

   - You do not create or modify custom commands within the software. You can edit the code of the command in Visual Basic. You can edit a limited number of items, such as the description of the command, using the **Edit Custom Command** dialog box.
   - You must install the Command Wizard software in Visual Basic. The setup for the Command Wizard is located at [Product Folder]\CommonApp\Tools\CommandWizard.

2. In Visual Basic, click **Add-Ins > Command Wizard**.

3. Complete all steps on each page of the Command Wizard.
Add custom commands
1. Click Tools > Custom Commands.
2. On the Custom Commands dialog box, click Add.
3. On the Add Custom Command dialog box, type the program identifier you assigned to the command in Microsoft® Visual Basic in the Command ProgID box.
4. Type the name you assigned to the command in the Command name box.
5. Type a phrase that describes the command in the Description box.
6. If necessary, change the option in the Priority section.
7. Type command line arguments in a string in the Argument box.

**TIP** After you complete this procedure, the Custom Commands dialog box lists the command you added to the software. You can run the command, edit the settings, or delete the command.

Run a custom command
1. Click Tools > Custom Commands.
   The Custom Commands dialog box opens.
2. To start a custom command you created, select the command in the list box, and click Run.
3. After the command runs, click Close on the Custom Commands dialog box.

Edit a custom command
1. Click Tools > Custom Commands.
   The Custom Commands dialog box opens.
2. To change the options for a custom command, select the command in the list box, and click Edit. For example, you can change the name and description of the command.
3. After completing the needed changes, click Close on the Custom Commands dialog box.
   **NOTE** You must open the command in Microsoft® Visual Basic if you want to edit the underlying code.

Delete a custom command
1. Click Tools > Custom Commands.
   The Custom Commands dialog box opens.
2. Select the command in the list box, and click Delete. The software removes the command from the list box; however, the command code is not deleted.
3. After completing the needed changes, click Close on the Custom Commands dialog box.
   **NOTE** This action does not delete the DLL for the custom command. It just removes access to the custom command from the Custom Commands dialog box.
Custom Commands Dialog Box

Adds and edits customized commands you have created with the **Command Wizard** in Microsoft® Visual Basic. For information on creating custom commands, see *Create custom commands* (on page 226).

**Command names** - Lists the names of commands that have been added.

**Run** - Starts the custom command you select in the list box. For more information, see *Run a custom command* (on page 227).

**Close** - Cancels the **Custom Commands** dialog box.

**Edit** - Opens the **Edit Custom Command** dialog box. You can change settings for the command, such as the program identifier (prog_ID) and command name. For more information, see *Edit a custom command* (on page 227).

**Add** - Installs the custom command into the software. For more information, see *Add custom commands* (on page 227).

**Delete** - Removes the custom command from the software. For more information, see *Delete a custom command* (on page 227).

**Clear** - Deletes the information you have typed in the boxes on the **Custom Commands** dialog box.

**Description** - Contains an identifying phrase so you can better recognize the custom command with which you are working.

Add Custom Command Dialog Box

Accesses a customized command you created in Microsoft® Visual Basic and saves the command within the software.

**Command ProgID** - Identifies the program identifier for the custom command you created in Visual Basic.

**Command name** - Specifies the name you assigned to the custom command.

**Description** - Describes the custom command.

**Priority** - Assigns a priority of **High**, **Normal**, or **Low**.

**Argument** - Specifies command line arguments in a string.

See Also

*Create custom commands* (on page 226)
Edit Custom Command Dialog Box

Changes options for a customized command you added to the software.

- **Command ProgID** - Specifies the program identifier for the custom command you created in Microsoft® Visual Basic.
- **Command name** - Provides a text box for you to change the name you assigned to the custom command.
- **Description** - Provides a text box to provide a descriptive phrase for the custom command.
- **Priority** - Changes priority to **High**, **Normal**, or **Low**.
- **Argument** - Change the command line arguments in a string.
- **Reset Default** - Returns the dialog box to its default settings.

See Also
*Create custom commands* (on page 226)

Delivered Custom Commands

This section describes some of the delivered custom commands. For a comprehensive list of the custom commands, see *Custom Commands* in the *Common User's Guide*.

**Repair Documents Custom Command**

The **Repair Documents** custom command updates invalid **Styles.sha** or **Symbol Browser** file paths on a document or a set of documents. Invalid file paths can occur when you change the symbol share. This causes overhead while editing, saving, or updating documents.

Click **Tools > Custom Commands** to add the command using the ProgID **DwgRepairCmd.RepairDocuments**. For more information, see *Custom Commands* in the *Common User's Guide*.

Each time you use **Repair Documents**, the changes made to the component or document are saved in a log file. You can access the file at %TEMP%\Drawings. The log file name starts with "DwgRepairCmd_" as its prefix. A summary at the end of the log file lists all documents that the command could not repair.

**Repair Documents Dialog Box**

- **Component or Document** - Specifies the component or document to repair.
- **Actions** - Shows the repair options for the selected component or document.
  - **Reset style resources** - Resets the style resource files and to the **Styles.sha** file on the current symbols share.
  - **Set symbol browser home** - Sets the symbol browser home address. You can change this address by typing in a new address or by clicking **More** and opening the file folder.
The following commands are available when you are using SmartSketch Drawing Editor to edit a drawing created and managed through the Drawings and Reports task.

**Edit Sheet Properties** - Specifies properties for the current sheet and document of the open 3D drawing. For more information, see *Edit Sheet Properties Command* (on page 251).

**Place View** - Creates a new drawing view in the drawing area. For more information, see *Place View Command* (on page 254).

**Place Region** - Creates a new drawing region in the drawing area so that drawing views can be managed. For more information, see *Place Region Command* (on page 272).

**Place Snapshot View** - Creates a new snapshot drawing view in the drawing area. For more information, see *Place Snapshot View Command* (on page 275).

**Associate Objects to View** - Allows you to interactively select a volume for the associated views. If the view is a key plan or report view, you specify an associated drawing view. For more information, see *Associate Objects to View Command* (on page 276).

**Remove Associated Inputs** - Allows you to remove the associated volumes, filters, views, and other inputs from the selected view. For more information, see *Remove Associated Inputs Command* (on page 290).

**Place Report View** - Allows you to add a report "view" in the drawing. The report view becomes an embedded report based on the contents of a drawing view. For more information, see *Place Report View Command* (on page 290).

**Place a Label** - Allows you to place labels manually. For more information, see *Place a Label Command* (on page 293).

**Group Selected Labels** - Groups existing labels so that you can move them as a unit. For more information, see *Group Selected Labels* (on page 300).

**2D/3D Selection** - Allows you to move back and forth between the SmartSketch Drawing Editor application window and the 3D task window. For more information, see *2D/3D Selection Command* (on page 322).

**Scaled Sketching** - Enables you to edit or draw new objects at a scale that is different from the drawing scale for the active sheet. For more information, see...
Working with Drawings and Reports and SmartSketch Drawing Editor

Scaled Sketching Command (on page 326).

**Edit Border Family** - Associates a single border or family of borders to the current layout template. For more information, see Edit Border Family Command (on page 368).

**Hide/Show Object** - Hides or displays objects in the drawing view. For more information, see Hide/Show Object Command (on page 335).

**Copy and Paste View** - Copies an orthographic drawing view and places the copy on the same sheet. For more information, see Copy and Paste View Command (on page 337).

**Move View** - Moves one or more views from a composed drawing document to another composed drawing document. For more information, see Move View Command (on page 337).

**Highlight Annotations** - Highlights labels, dimensions, and customized graphics based on the options that you select. For more information, see Highlight Annotations Command (on page 339).

**Clear Manual Edits** - Permanently clears all manual edits made to labels and dimensions in the selected views. For more information, see Clear Manual Edits Command (on page 341).

**Associate Objects to Graphic View** - Associates and disassociates objects to graphic views. For more information, see Associate Graphics to Graphic View Command (on page 341).

**Update View** - Updates the contents for the selected view - drawing, report, key plan, snapshot, and detail/section views. For more information, see Update View Command (on page 370).

**Preview Layout** - Shows a preview of the drawing document based on the current layout. For more information, see Preview Layout Command (on page 370).

**Place Drawing View** - Places a two-dimensional view for orthographic drawings. For more information, see Place Drawing View Command (Template Toolbar) (on page 344).

**Place Report** - Embeds a report in a drawing view on a volume or snapshot drawing. For more information, see Place Report Command (Template Toolbar) (on page 348).

**Place Key Plan** - Places a key plan on a volume drawing template. For more information, see Place Key Plan Command (Template Toolbar) (on page 350).

**Place Border Label** - Positions drawing property labels in the title block of a template when you are editing a 3D drawing border template. For more information, see Place Drawing Property Label Command (Drawing Labels
Working with Drawings and Reports and SmartSketch Drawing Editor

Place Drawing Area - Places a drawing area. You use this command to create a drawing area on a 3D drawing border template that has been imported from other software, such as MicroStation DGN or AutoCAD DWG. For information on this command, see Place Drawing Area Command (on page 366). For more information on editing border templates, see the Drawings and Reports User's Guide.

Drawings View Explorer

The Drawings View Explorer provides access to views and their attributes for the currently displayed drawing or template. For more information, see Drawings View Explorer (on page 233).

Dimensioning in 3D Drawings

You can use the Dimension toolbar to place dimensions on your 3D drawings. For more information, see Dimensioning in 3D Drawings (on page 245).

You can also specify dimensioning for paper space objects (at the proper scale) when they are drawn on top of drawing view objects. For more information, see Dimension Paper Space Objects for 3D Drawings (on page 247).

Cutting Planes, Detail Envelopes, and Section/Detail Views

The following commands allow you to create and edit cutting planes, detail envelopes, and section and detail views in 3D drawings.

Place Detail Envelope - Creates a detail view for an existing drawing view. Detail views are more than enlargements of the main drawing view. They often contain additional graphical information that is not visible in the main drawing view, such as weld or chalk information. For more information, see Place Detail Envelope Command (on page 304).

Place Cutting Plane - Creates a cutting plane on a drawing view. The cutting plane is a marker that indicates where to slice a desired group of objects and from which direction to look at that slice. For more information, see Place Cutting Plane/Section View Command (on page 308).

Place Section/Detail View - Creates both a section view and a detail view based on the selected cutting plane or detail envelope. A detail view is extracted from a main drawing view or another detail view. You can rotate detail views in 2D space, but they remain in the same orientation as the main drawing view. Section views are extracted from main drawing views, detail views, or other section views. Section views are similar to detail views, except that they can display information in an orientation that is different from that of the originating view. For more information, see Place Detail View Command (on page 319).

Converting Excel Spreadsheet Reports to Native Text Boxes

The SP3DConvertExcelEmbedded.dll is a delivered custom command that allows you to convert an Excel spreadsheet report to the native text box format for use in 3D Drawings. For
more information on converting Excel spreadsheet reports, see *Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command* (on page 375).

**Saving Drawings in MicroStation and AutoCAD Format**

You can use the Save As command to assign dimension units and export the drawings to MicroStation or AutoCAD format. For more information, see *Save As MicroStation or AutoCAD Format* (on page 249).

**Drawings View Explorer**

Provides access to views and their attributes for the currently displayed drawing or template.

**Drawings View Explorer**

Displays a list of sheets and views on the active sheet and a list of unplaced views available for placement. This window is available in SmartSketch Drawing Editor when you have a Drawings by Rule template or drawing open. The **Drawings View Explorer** displays by default as a right-side window in SmartSketch Drawing Editor when you:

- Edit a template associated with a Drawings by Rule component. Right-click the component, and select **Edit Template** on the shortcut menu.
- Edit an existing drawing document. Right-click a Drawings by Rule drawing document in the **Detail View** or the **Drawing Console**, and select **Edit** on the shortcut menu.

The **Drawings View Explorer** allows you to see views that are available for the current drawing. Assigned views appear beneath a drawing sheet. Unassigned views appear in the **UnAssigned Folder**. Views are identified by the following icons:
### Shortcut Menu

The **Drawings View Explorer** also allows you to update, refresh, delete, or edit properties by right-clicking on a view or a set of selected views from the same sheet.

**Update** - Performs a smart update of geometry in the view(s). Rules in the software determine whether to perform:
- An incremental update of the geometry for added, modified, and deleted objects.
- A full update of all geometry.

For more information, see *Update and Full Update Commands (on page 385)*.

**NOTE** When **Update** performs the first option, it is usually faster than **Full Update** but still results in all geometry being up-to-date for the view.

**Full Update** - Performs a full update of all geometry in the view. For more information, see *Update and Full Update Commands (on page 385)*.

**Refresh** - Compares the date of the last update of the views with the modification date in the model for any object that has a positive (can be seen) resymbolization in the drawing. For more information, see *Refresh in the Orthographic Drawings User's Guide*.

**Delete** - Moves one or more views to the **UnAssigned Folder**, or deletes views permanently if the view was placed by the drawing rule set. For more information, see *Place View Command (on page 254)*.

**Properties** - Opens the **Drawing View Properties** dialog box, allowing you to change the properties of a drawing view. For more information, see *Drawing View Properties Dialog Box (Place View Command) - Steel Order Drawings (on page 260)*.

**Update Selected** - Performs an update on objects that are first selected in a view or in the 3D model. You can perform **Update Selected** on both full and cropped views. Only the selected geometry is updated in the view. Other geometry affected by the selected geometry is neither checked nor updated. As a result, the view is marked as out-of-date. This option is only available when:

**UnAssigned test**
- The view is assigned to a drawing and all 2D geometry is up-to-date with the 3D model.
- The view is assigned to a drawing and 2D geometry is out-of-date with the 3D model.
- The view is not assigned to a drawing, and is in the **UnAssigned Folder**.
A drawing is created with a Drawings by Rule component. For more information, see the Orthographic Drawings User’s Guide.

2D/3D Selection is clicked. 2D/3D Selection causes geometry in the view to be actively linked to its 3D model object. For more information, see 2D/3D Selection Command (on page 322) in the SmartSketch Drawing Editor User’s Guide.

View Log - Displays a log of the results from the last update performed on the view.

NOTES

- You can also select multiple views from the RAD sheet.
- For more information, see Place an Unassigned View (on page 379).

Move Sheet(s) - Moves the selected sheets from one document to another under the same Drawings by Rule component. For more information, see Move Sheet(s) (on page 235).

Move Sheet(s)

Moves the selected sheets from one document to another under the same Drawings by Rule component.

1. In the Drawings View Explorer, right-click the sheets to be moved, and select Move Sheet(s).
   The Move Sheet dialog box displays.
2. Select the destination document, and click OK.
   Sheets cannot be moved to a document that is being edited or to a document on which you do not have write permissions.
   The sheets are moved to the destination document.

NOTES

- You can only move sheets to documents under the active component.
- When all sheets under a document are moved, an empty sheet with a border template is placed under the source document.
- To perform Move Sheet(s), the component must have at least two documents as children.
- Move Sheet(s) cannot be used by selecting both views and sheets together.
- Upon completion, the status of the source and destination documents is changed to “Out of date.”
Dimensions

In general, dimension rules control the placement of dimensions, and dimension styles control the appearance, including the units, of dimensions in orthographic drawings. However, dimension styles and dimension rules interact in complex ways. There are two methods you can use to cause dimensions to display in drawings. **Automatic dimensioning** and **manual dimensioning** place dimensions in native format drawings.

For **automatic dimensioning**, the view style controls whether or not dimensions are placed. For **manual dimensioning**, you edit an existing drawing and place dimensions manually.

**NOTE** The **Save As** command saves drawings from the database to files and presents additional considerations about dimensions. The files created by the **Save As** command can be native format or a foreign format such as MicroStation or AutoCAD. With the **Save As** command, the software attempts to replicate dimensions as they are shown within a drawing.

Assigning dimension units is different for each method. For more information, see the following sections in the Orthographic Drawings User's Guide:

- **Automatic Dimensioning** (on page 236)
- **Manual Dimensioning** (on page 244)
- **Save As MicroStation or AutoCAD Format** (on page 249)

**NOTE** Isometric drawings use the isometric options settings within their style to determine the dimension appearance, placement, and units. For more information, see **Isometric Drawing Styles** (on page 107) in the **Piping Isometric Drawings User's Guide**.

**Automatic Dimensioning**

When you use automatic dimensioning, the view style controls whether or not dimensions are placed. The following flowchart shows how the **Update Now** command assigns units to automatically placed dimensions.
View Styles
A dimension rule with a view style triggers the automatic placement of dimensions in an orthographic drawing. For more information, see Use View Styles with Dimension Rules (on page 237).

Dimension Rules
Dimension rules control the placement and appearance of automatic dimensions in the drawing. For more information, see Use Dimension Rules (on page 238).

Dimension Templates
The dimension rule is not responsible for assigning the dimension units to automatic dimensions. The dimension rule points to a dimension template XML file that influences the unit assignment. For more information, see Use Dimension Templates (on page 239).

Dimension Styles
You can determine the active style of a dimension by editing the drawing or drawing template in SmartSketch Drawing Editor. For more information, see Edit Dimension Styles (on page 240).

Dimension Style Overrides
You can override dimension style settings in SmartSketch Drawing Editor. For more information, see Override Dimension Styles (on page 242).

See Also
Dimensions (on page 236)

Use View Styles with Dimension Rules
A dimension rule within a view style triggers the automatic placement of dimensions in a drawing.

1. Select Tools > Define View Style.
   The Define View Style dialog box displays.

2. Select New Style 📝 to define a new view style with a dimension rule. You can also edit an existing view style by selecting Properties 📖.

3. On the View Style Properties dialog box, use the Dimension Rule field dropdown to specify a dimension rule for the view style. For more information on this dialog box, see View Style Properties Dialog Box in the Drawings and Reports Reference Data Guide. Select More to display the Select Dimension Rule dialog box. For more information, see Select Dimension Rule Dialog Box in the Drawings and Reports Reference Data Guide.
For information on how dimension rules are maintained, see *Use Dimension Rules* (on page 238).

**NOTE** For more information on defining view styles, see *Define View Style Command* in the *Drawings and Reports Reference Data Guide*, accessible using the **Help > Printable Guides** command in the Drawings and Reports task.

**See Also**
*Automatic Dimensioning* (on page 236)
*Dimensions* (on page 236)

**Use Dimension Rules**

A dimension rule controls the placement and appearance of automatic dimension in the drawing. When you select **More** in the **Dimension Rule** dropdown on the **View Style Properties** dialog box, the **Select Dimension Rule** dialog box displays the list of rules available in the Drawings catalog. For more information, see *Select Dimension Rule Dialog Box* in the *Drawings and Reports Reference Data Guide*. You can access this guide with the **Help > Printable Guides** command in the Drawings and Reports task.

The Drawings catalog is file-based and located on the SharedContent share within the \Drawings\Catalog folder. The available dimension rules are XML files stored in the \Drawings\Catalog\Rules\DimensionRules folder. Several example dimension rules are delivered with the software.

You edit the dimension rule XML files with a text or XML editor. Each dimension rule should point to its own dimension template. Rename any customized dimension rules. Do not use the delivered rule names for customized rules.

**IMPORTANT**

- We recommend that you maintain a separate set of dimension rules for each dimension style used in drawings.

- The dimension rule is not responsible for assigning the dimension units to automatic dimensions. However, the dimension rule points to another XML file, called the *dimension template*, that influences the unit assignment. For more information, see *Use Dimension Templates* (on page 239).

- The drawing dimension XML Files are discussed further in the *Intergraph Smart™ 3D Programmer's Guide* under *Extending the Capabilities of the Software*. Contact your administrator or Intergraph Support if you need the *Intergraph Smart™ 3D Programmer's Guide*. You can find support information on our web site [http://support.intergraph.com](http://support.intergraph.com).
**Use Dimension Templates**

The dimension rule is not responsible for assigning the dimension units to automatic dimensions. However, the dimension rule points to another XML file, called the *dimension template*, that influences the unit assignment. The dimension template XML file contains the settings that further control the placement and appearance of dimension in the orthographic drawings.

You edit the dimension template XML files with a text or XML editor. Rename any customized dimension templates. Do not use the delivered rule names for customized dimension templates.

Several example dimension template XML files are delivered with the software and are located on the SharedContent share in the `\Drawings\Catalog\Dimensions\Templates` folder.

The setting in the template that influences dimension unit display is `<dimensionContentModules>`. In each dimension template, you should set `<dimensionContentModules>` to the dimension style used to create dimensions in the drawing. The values available for this setting determine whether the software places the dimension vertical, horizontal, radial, or angular. To determine the dimension units, the various content modules refer to the dimension formatting saved either in the drawing template file (for volume and by query drawing types) or in the drawing itself (for composed drawings).

**IMPORTANT**

- We recommend that you maintain a separate dimension template for each dimension rule you create.

- For manual dimensioning, the software looks in the Linear_A_HV dimension template for the value of the dimension content module during the update of manually placed dimensions. For more information, see *Manual Dimensioning* (on page 244).

- The `<dimensionStyleSettings>` setting in the dimension templates is not used by the software at this time. However, when creating drawings, we recommend that the active dimension style in the selected border template have the same name as the `<dimensionStyleSettings>` setting in the dimension template to avoid problems in future software releases. Rename any customized border templates. Do not use the delivered border template name for customized border templates.

- The drawing dimension XML Files are discussed further in the *Intergraph Smart*™ 3D Programmer's Guide under Extending the Capabilities of the Software. Contact your administrator or Intergraph Support if you need the *Intergraph Smart*™ 3D Programmer's Guide. You can find support information on our web site [http://support.intergraph.com](http://support.intergraph.com).

**Overall Dimensions**

By default, dimension control generators use the settings in the Linear_A_HV.xml dimension template. By using `<overallDimension>`, you can override Linear_A_HV.xml and select another template for overall dimensions. In the example below, Piping Plan_Pipes_Horizontal.xml is used as the dimension template for piping parts:

```xml
<dimensionSettings>
  <overall>-1</overall>
  <overallDimension value="Piping Plan_Pipes_Horizontal"/>
```
Layering Dimensions

You can define the layer on which your dimensions display in the drawing by editing the dimension rule template XML file. After the `<dimensionStyleSettings>` section of the XML file, add a `<dimensionLayerSettings>` definition using the `<dimLayer>` tag, like the one shown in the example below, that defines the layer on which you want the dimensions placed:

```xml
<dimensionLayerSettings>
  <dimLayer>dimensionLayer</dimLayer>
</dimensionLayerSettings>
```

If the layer does not already exist in the template you are using to create drawings, the software creates the layer automatically.

See Also
Automatic Dimensioning (on page 236)
Dimensions (on page 236)
Use Dimension Rules (on page 238)

Edit Dimension Styles

The software resolves dimension units for a particular drawing from the active dimension formatting in either the drawing template (for volume and by query drawing types) or the drawing itself (for composed drawings). The active dimension formatting is a combination of the settings in the active dimension style plus any dimension style overrides that may be set.

You can determine the active style by editing the drawing or the drawing template in SmartSketch Drawing Editor, selecting one of the placement dimension commands, and checking the style that displays on the resulting ribbon bar. You can view the overrides to the active dimension in the drawing template by selecting Format > Dimension in SmartSketch Drawing Editor.

**IMPORTANT** The Imperial border templates have ANSI as the active dimension style with no overrides set. The Metric border templates have DIN as the active dimension style with no overrides set.

You can create and maintain dimension styles in SmartSketch Drawing Editor.

1. In SmartSketch Drawing Editor, select Format > Style.
The **Style** dialog box displays.

2. Click **Modify**.

   **The Modify Dimension Style** dialog box displays.

3. Modify the appearance of the dimension style as needed, and click **OK**.

4. On the **Style** dialog box, you can either save dimension styles with the files being edited or reference them from other files. You can reference files by selecting **Resources**.

**TIPS**

- The reference files, also called **resource files**, can be any file with an .igr or .sha extension. While referenced dimension styles are available for dimension placement, they cannot be edited. Therefore, the **Style** dialog box only displays dimension styles that are saved locally to the file.

- In cases where a local dimension style has the same name as a referenced dimension style, the software always uses the local style when placing dimensions. Currently, you cannot override local dimension styles with the same name as a referenced dimension style of the same name. Local dimension styles can be renamed so that the referenced dimension style can be used to place dimensions. Local dimension styles are renamed on the **Modify Dimension Style** dialog box. For more information on overriding dimension style settings, see **Override Dimension Styles** (on page 242).

The delivered **Styles.sha** file contains several example dimension styles. This file is located in the Symbols share in the `\Drawings\Catalog\Templates` folder. All drawings created in the Drawings and Reports task reference the **Styles.sha** file.

**IMPORTANT** After updating the drawings, the **Styles.sha** file on the Symbols share is the only file referenced into the drawings. This is true for all orthographic drawings. Any other files previously referenced before the update need to be referenced to the drawing again.

All drawings and drawing templates must have at least one dimension style saved within them. Therefore, if only one dimension style is saved with a file, you cannot delete it. Also, you cannot delete any style from a drawing or drawing template if they are currently used by dimensions in a drawing.
Dimension styles can be added to the list of saved or local styles in a drawing or drawing template in one of two ways:

- Create a new dimension style from the Style dialog box using the New... command.
- Place a dimension in a drawing or drawing template using a reference dimension style. This method copies the referenced dimension style into the drawing or drawing template.

**IMPORTANT**

- We recommend that you maintain a separate set of border templates for each dimension style used for drawings. The border templates within a particular set should have the same active dimension style with the same style settings.
- The <dimensionStyleSettings> setting in the dimension templates is not used by the software at this time. However, when creating drawings, we recommend that the active dimension style in the selected border template have the same name as the <dimensionStyleSettings> setting in the dimension template to avoid problems in future software releases. Rename any customized border templates. Do not use the delivered border template name for customized border templates.
- We recommend that you maintain a complete set of your dimension styles in a renamed version of the Styles.sha file.

**See Also**

Override Dimension Styles (on page 242)

**Override Dimension Styles**

You can override dimension styles in a drawing or drawing template.

**IMPORTANT** We support dimension style overrides, but we do not recommend their use as a standard practice. Overrides are saved in the drawing or drawing template and can be difficult to maintain as dimension styles change. As an alternative, we recommend creating a new dimension style in a reference resource file. For more information, see Edit Dimension Styles (on page 240).

1. Select Tools > Edit Border Template, and select a template to edit.
   - The template opens in SmartSketch Drawing Editor.
2. Select Format > Dimension.
3. On the **Format Dimension** dialog box, select the **Units** tab.

![Format Dimension dialog box](image)

4. If the settings on the **Units** tab are identical to those on the **Modify Dimension Style** dialog box, no overrides are applied to the active dimension style. If a dimension style is changed during a dimension placement command, the override values become identical to the dimension style values. For more information, see *Edit Dimension Styles* (on page 240).

**NOTE** You cannot override local dimension styles with the same name as a referenced dimension style. Local dimension styles can be renamed so that the referenced dimension style can be used to place dimensions. Local dimension styles are renamed on the **Modify Dimension Style** dialog box.

**See Also**
*Automatic Dimensioning* (on page 236)
*Dimensions* (on page 236)
*Use Dimension Rules* (on page 238)
Manual Dimensioning

When you use manual dimensioning, the view style and the dimension rules do not apply for display or placement. However, the logic used to determine manual dimensions is similar to that of automatic dimensions. The following flowchart shows how Update (for marine mode Drawings by Rule) and Update Now (for all other drawing types) assign units to manually placed dimensions.

Dimension templates

For manual dimensioning, the software looks in the dimension template for the value of the dimension content module during the update of manually placed dimensions. For more information, see Use Dimension Templates (on page 239).

Dimension styles

You can determine the active style of a dimension by editing the drawing or drawing template in SmartSketch Drawing Editor. For more information, see Edit Dimension Styles (on page 240).

Dimension style overrides

You can override dimension style settings in SmartSketch Drawing Editor. For more information, see Override Dimension Styles (on page 242).

**NOTE** If you place a manual linear dimension that is chained or stacked with an automatic linear dimension, the manual dimension is immediately replaced with a standalone dimension that is no longer attached to the automatic dimension. The new dimension is attached to a newly-placed point object whose position coincides with the connect point location of the automatic dimension projection line to which the manual dimension was originally attached. Because the new dimension is no longer chained or stacked with the automatic dimension, it does not move if the automatic dimension’s position is modified.
Dimension between views

If you try to place dimensions from one drawing view to another, a status bar message displays **Dimensions between two views will not be remembered between updates.** The dimension is not placed and the command cancels. Other supported types of dimensions remain.

![Dimension between views](image)

**Dimensioning in 3D Drawings**

When you edit a Smart 3D drawing in SmartSketch Drawing Editor, you can use commands on the **Dimension** toolbar to manually place dimensions. When updating the drawing, the software remembers dimensions placed between objects within a single drawing view, dimensions placed from paper space to paper space, and dimensions placed between paper space graphics and model objects. You cannot dimension from one drawing view to another drawing view.

You can place dimensions in drawings by rule and composed drawing views using the standard SmartSketch Drawing Editor dimensioning commands. The commands are enhanced with an additional ribbon to support accurate dimensions of 3D objects in non-planar views.

*Dimensioning Drawing Elements in the SmartSketch Drawing Editor Help*

*Dimension Ribbon in the SmartSketch Drawing Editor Help*

*3D Dimension Ribbon* (on page 246)
The 2D dimension commands treat all geometry in a view as being in the view plane. If the view contains non-planar geometry, such as in an isometric view, the value of the dimension is not accurate, as shown in the following figure.

With the 3D dimension options, the dimension reflects the distance between the 3D objects.

You can specify dimensioning for paper space objects (at the proper scale) when they are drawn on top of drawing view objects. For more information, see Dimension Paper Space Objects for 3D Drawings (on page 247).

3D Dimension Ribbon

The 3D Dimension ribbon appears in addition to the Dimension ribbon for the following dimension commands: SmartDimension, Distance Between, Angle Between, Axis, Coordinate Dimension, and Symmetrical Diameter.

Object Selection Filter - Specifies the type of part that is available to dimension. This option displays all 3D model object types drawn in the views on the displayed sheet. The default value is All. Select one or more object types and click Close.

NOTE The session file retains previously selected object types and displays the object types as the default values in subsequent drawings.

Graphic Filter - Specifies the geometry types of the selected objects that are available for selection. Select one or more filters, and click Close.
• **As Drawn (2D Dimension)** - 2D edges drawn in the view. This option treats the drawing view like a standard 2D SmartSketch Drawing Editor view and is typically not suitable for non-planar views. This is the default value.

• **3D Edge** - Edges and points of a 3D object.

• **Keypoint** - End points of a member. This option is available for prismatic members, designed members, and cans.

• **Axis and Centerline** - The centerline of a member. This option is available for prismatic members, designed members, and cans.

**Dimension Rule** - Specifies the dimension rule used to override 2D dimensions with 3D dimensions. By default, one rule is delivered with the software, and this box is not visible. Your administrator can create additional rules. For more information, see **3D Dimensions** in the *Drawings and Reports Reference Data Guide*.

**NOTES**

• The session file retains previously selected graphic filters and displays the graphic filters as the default values in subsequent drawings.

• Double-click **3D Edge**, **Keypoint**, and **Axis and Centerline** to display a tree view of individual graphic filters and rules. You can separately select or clear each filter or rule. This is an advanced option and is not used for most dimensions.

**Dimension Paper Space Objects for 3D Drawings**

The following procedure shows you how to dimension paper space objects (at the proper scale) when they are drawn on top of a 3D Drawing view object. To accomplish this task, you create a dimension style with the appropriate scale setting in SmartSketch Drawing Editor.

When manually placing dimensions and then updating the drawing, the software remembers dimensions placed between objects within a single drawing view, dimensions placed from paper space to paper space, and dimensions placed between paper space graphics and model objects.

**IMPORTANT** Dimension styles must be defined for paper space objects and their scale factors, otherwise the paper space dimensions will be deleted when the drawing is updated. SmartSketch Drawing Editor will not recognize any possible errors in the dimension style, so be sure that any new dimension styles are correct before updating a drawing. For more information, see **Edit Dimension Styles** (on page 240) and **Manual Dimensioning** (on page 244).
1. Start SmartSketch Drawing Editor. Double-click shape2dserver.exe in the [Product Directory]\Common2D\Shape2D\Bin folder.

2. Use File > Open to open the styles.sha file. This file is located in your [Product Directory]\Common2D\Shape2D\Template\Styles folder.

   **NOTE**: The styles.sha file is delivered as a read-only file. You can change the properties of the file, or you can copy the file to a new name and use the copied file to create your new dimensioning style.

3. Select Format > Style, and on the Style dialog box, click New.

4. On the **New Dimension Style** dialog box, give the new paper space dimension a name.

5. Go to the General tab, and set the scale mode to Manual and set a manual value for the dimensioning. For example, for a scale of 1:100mm, you would set the manual value to 0.01.
When you apply this updated style.sha to your drawings, you can use the new paper space dimension style when placing paper space objects, even when positioned on top of drawing view objects.

**IMPORTANT** Upon resizing a drawing, all automatic dimensions change accordingly, but manual dimensions will not relocate. Manual dimensions between paper space objects and model objects will still exist, but their values will change.

**NOTE** Dimensioning from model objects in one view to model objects in a different view is not supported.

### Save As MicroStation or AutoCAD Format

You can use the *Save As* command to assign dimension units and export the drawings to MicroStation or AutoCAD format. The following flowchart shows how the *Save As* command controls dimensioning during export.
Save As Command

The **Save As** command is available from the shortcut menu for any document or node containing documents in the **Console**. For orthographic drawings, the **Save As** command supports exporting to DGN, DWG, and DXF formats, as well as the native SHA formats. For more information, see "Save As Command (on page 65)" in the **Drawings Help**.

**NOTE** For Piping Isometric Drawings, a file is created for each sheet in the drawing with [drawing name]_[sheet name] as the filename. For example, if the drawing *My_Pipeline* contains Sheet1 and Sheet2, two files will be saved with the names *My_Pipeline_Sheet1* and *My_Pipeline_Sheet2*.

Embedded Object Dimensioning

The model graphics in the drawings are embedded in the drawing file. The dimensions in the drawings are connected directly to the embedded objects.

During export to MicroStation or AutoCAD formats using **Save As**, the software opens the drawings in **SmartSketch Drawing Editor** and the relationship between the embedded objects and the dimensions is broken. The dimension, however, is not removed and still maintains its original value.

Document Properties

Dimensions in drawings exported to the DGN, DWG, and DXF formats do not use the active dimension formatting for their units. Instead, the software determines dimension units from the document properties for the drawing being exported. This behavior applies whether the drawings is a volume, by query, or composed drawing type. You can view and edit the document units by opening the drawing in **SmartSketch Drawing Editor** and selecting **File > Properties**. You can see the current unit settings on the **Units** tab.
We recommend that border templates have identical units and precision values in the document properties set in the active dimension style. This maintains dimension unit accuracy if you export the drawing to a foreign file format.

**See Also**
*Dimensions* (on page 236)

## Edit Sheet Properties Command

- Specifies properties for the current sheet and document. This command is available on the Drawings Compose toolbar in SmartSketch Drawing Editor when you:
  - Edit a template associated with a Drawings by Rule component. Right-click the component and select **Edit Template** on the shortcut menu.
  - Edit an existing drawing document. Right-click a Drawings by Rule drawing document in the **Detail View** and select **Edit** on the shortcut menu.

In both cases, the template or drawing document opens in SmartSketch Drawing Editor with the **Edit Sheet Properties** available on the toolbar above the drawing area. When you click the command, the **Sheet Properties** dialog box appears so you can set the properties for the sheet and the document.

**See Also**
*Sheet Properties Dialog Box* (on page 252)
Change the Border Template for an Existing Sheet

In this workflow, you change the border for an individual sheet to a template different from the border template defined in the component. For example, you may want the first sheet of drawing to use a different border template than all other sheets.

1. Right-click the drawing document in the Management Console Detail View, or in the Drawing Console and select Edit. The drawing opens in SmartSketch Drawing Editor.
2. Select a sheet tab at the bottom of the drawing view.
3. Click Edit Sheet Properties on the toolbar. The Sheet Properties dialog box displays.
4. On the Current Sheet tab, select a new value for Border Template.
5. Click OK. The new border template is applied to the sheet.

NOTES
- Layout Template is inactive, and cannot be changed for an existing sheet
- Border Layout and Template Layout are customizable items.
- For more information about layout properties, see Edit Sheet Properties Command (on page 251) in SmartSketch Drawing Editor Help.

Sheet Properties Dialog Box

Specifies properties for the current sheet and document. This dialog box displays when you click Edit Sheet Properties, which is only available in SmartSketch Drawing Editor when you are editing a Drawings by Rule template or document.

See Also
Edit Sheet Properties Command (on page 251)
Current Sheet Tab (on page 253)
Document Tab (on page 252)

Document Tab

Specifies properties for the document. This dialog box displays when you click Edit Sheet Properties, which is only available in SmartSketch Drawing Editor when you are editing a Drawings by Ruleset template or document.

The properties available are defined as follows:

Document Assignment Rule - Specifies the layout style rule to use for the document. Select More in the dropdown to display the Define Layout Style dialog box and select the layout style to use.

Document Naming Rule - Defines how the document will be named.

Scale Group - Specifies a scale group for the document, such as Metric, Imperial, or Manual Scale. When you select a scale group, the Scale property values update. Selecting Manual Scale shows all scales, metric or imperial.

Scale - Specifies a scale to use for the document. The Scale values update depending on the selected Scale Group.
See Also
Edit Sheet Properties Command (on page 251)
Sheet Properties Dialog Box (on page 252)

Current Sheet Tab

Specifies properties for the current sheet. This dialog box displays when you click Edit Sheet Properties, which is only available in SmartSketch Drawing Editor when you are editing a Drawings by Rule template or document.

The properties available are defined as follows:

**Sheet Assignment Rule** - Specifies the layout style rule to use for the sheet. Select More in the list to display the Define Layout Style dialog box and select the layout style to use.

**Sheet Naming Rule** - Defines how the sheet will be named.

**Scale Group** - Specifies a scale group for the sheet, such as Metric, Imperial, or Manual Scale. When you select a scale group, the Scale property values update. Selecting Manual Scale shows all scales, metric or imperial.

**Scale** - Specifies a scale to use for the sheet. The Scale values update depending on the selected Scale Group.

See Also
Edit Sheet Properties Command (on page 251)
Sheet Properties Dialog Box (on page 252)
Drawings Compose Toolbar

This toolbar is available in SmartSketch Drawing Editor when you click Edit on a drawing document shortcut menu in the Drawings and Reports task. For more information, see Drawing Document Shortcut Menu and Edit Command (on page 37) in the Drawings and Reports Reference Data Guide.

Place View Command

Creates a new drawing view in the drawing area. This command is only available in SmartSketch Drawing Editor when you create a new drawing or open an existing drawing from a 3D task.

When you click Place View, you click and drag to define the new view. The Drawing View Properties dialog box appears so that you can define the properties associated with the view. The properties shown change depending on the View Style type you select, such as Orthographic View or Key Plan View.

After creating the view and defining its properties, use the Associate Objects to View command to specify the content of the view. You can also move the view around, crop it, or align it in the drawing sheet.

NOTE You can create drawing views outside the drawing area. Also, when you stretch the drawing area to match the border file, the software retains your offsets so that a view or region outside the drawing area remains outside the drawing area even after it is placed in the border file.

You can create a drawing view outside a region, but this makes the drawing view an "unmanaged view," meaning the properties of the region do not impact the drawing view. However, if a view is entirely inside a region or touching a region, the region manages the drawing view and, when you update the drawing in a 3D task, the software pulls the drawing view into the region and updates it based on the region layout style.

See Also
Drawing View Properties Dialog Box (Place View Command) - Composed Drawings (on page 255)
Update View Command (on page 370)
**Drawing View Properties Dialog Box (Place View Command) - Composed Drawings**

Specifies properties for the selected drawing view in a composed drawing. You can access this dialog box when you right-click on a drawing view and then select **Properties** on the shortcut menu.

For more information on creating a composed drawing, see *Create a new composed drawing* in the *Orthographic Drawings User's Guide*.

![Drawing View Properties Dialog Box](image)

**Info Tab (Drawing View Properties Dialog Box)** (on page 255)

**Format Tab (Drawing View Properties Dialog Box)** (on page 256)

**View Tab (Drawing View Properties Dialog Box)** (on page 256)

**See Also**

*Place View Command* (on page 254)

**Info Tab (Drawing View Properties Dialog Box)**

Specifies general view properties.

- **Type** - Displays the category of the selected element.
- **Sheet** - Displays the name of the drawing sheet that contains the selected element.
- **Layer** - Shows the layer that contains the selected element.
- **Origin** - Specifies the coordinates, or location, of an element along the X- and Y-axes.
**Format Tab (Drawing View Properties Dialog Box)**

Formats the frame around a drawing view.

- **Show Border** - Displays the frame around the object.
- **Color** - Sets the color of the frame.
- **Line Width** - Sets the line thickness on the frame.
- **Line Type** - Overrides a line type for a drawing sheet or embedded object and sets another line style for an element or a linked object.

**View Tab (Drawing View Properties Dialog Box)**

Sets the drawing view style and other properties for a selected drawing view in a composed drawing.

- **Style**
  
  Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the **Select View Style** dialog box.

- **Name**
  
  Specifies a name for the view. You must type a name in order to create a view.

- **View Style**
  
  Identifies the view style used within the rule set associated with this drawing document. This is a read-only field and is shown for Ruleset view styles only.

**Coordinate System Properties**

- **Annotation Coordinate System**
  
  Specifies the coordinate system used to place annotations (labels and dimensions) on the drawing. This property is not supported in Ruleset view styles. Choose a coordinate system from the list, or click More... to choose another coordinate system with the **Select System** dialog box.

- **View Direction Coordinate System**
  
  Specifies the coordinate system to use with regard to the "looking direction" for the drawing view contents. The coordinates listed are defined for the model. This property is not supported in Ruleset view styles. Choose a coordinate system from the list, or click More... to choose another coordinate system with the **Select System** dialog box.

**Example 1**

The global coordinate system is selected for both **Annotation Coordinate System** and **View Direction Coordinate System**. A plan view is created, and the global view direction coordinate system North points up. Because the North arrow annotation is also defined by the global coordinate system, the North arrow annotation also points up.
Example 2

The global coordinate system is selected for Annotation Coordinate System and a local coordinate system is selected for View Direction Coordinate System. North on the local coordinate system is rotated 90° counter-clockwise relative to the global coordinate system. A plan view is created, for which North of the local view direction coordinate system points up, rotating the view 90° clockwise. Because the North arrow annotation is defined by the global coordinate system, the North arrow annotation points to the right.

Orientation Properties

Orientation Rule

Specifies the rules available for orientations for the current view type. The Orientation Rule drives the values for the Orientation View Direction and Orientation Up Direction properties. This property is only shown for Ruleset view styles.

Orientation View Direction

Indicates the elevation direction in which you want the drawing view to "look" at the drawing objects. This property is only shown for Ruleset view styles.

Orientation Up Direction
Indicates the x- and y-axis direction with which you want the drawing view to "look" at the drawing objects. This property is only shown for Ruleset view styles.

**Scale Properties**

**Scale Family**

Specifies a scale family for the drawing view, such as Metric, Imperial, or Manual Scale. When you select a scale family, the **Scale** property values update. Selecting **Manual Scale** shows all scales, metric or imperial.

**User Selected Scale**

Specifies a scale to use for the drawing view. The **Scale** values update depending on the selected **Scale Family**.

- For **Custom** scale, the default is the unit of measure setting of the document. For example, if you type values of 1 in to 1 ft, the values are converted to mm if that is the default unit of measure.
- Do not use negative values when typing custom scale values.

**Navigation Rule Properties**

**HngSupSimpleNavigator.dll**

Returns support components, supporting objects, supported objects, and design children. This rule also returns the control points on the components. This rule is specific to objects created in the Hangers and Support task.

**HngSupRangeNavigator.dll**

Returns support components, supporting objects, supported objects, and design children collections that extend the Hangers and Support range. This rule also returns the control points on the components. This rule is specific to objects created in the Hangers and Support task, and operates similarly to the **HngSupSimpleNavigator.dll** rule.

**DrawingSpoolNavigator.dll**

Returns the spool, its connected parts and their features. This rule is specific to pipe spools.

**AssemblyNavigator.dll**

Returns the assemblies, pipe spool, penetration spool, its connected parts, and their features. This rule is specific to assemblies.

**Margin Properties**

**Margin Left/Margin Right/Margin Top/Margin Bottom**

Defines the marginal distance for the drawing view. The margin is the distance surrounding the drawing view SmartFrame. This area is used for labels and dimensions that have been designed to incorporate margins in their search for clear space.
For example, you could have several drawing views, each with different margin settings:

Other General Properties

Look Direction

Indicates the direction in which you want the drawing view to "look" at the associated volume or objects.

Description

Describes the content of the view. This description is optional.

View Offset

Expands the view on the drawing sheet in all directions in order to prevent matchline distortion and grid plane clipping. The default offset value is 2 mm for composed views and 0 mm for ruleset views. The offset does not affect the size of the volume that is associated with the view.

- View Offset is only available for views that are associated to a volume. Section and detail views do not have this property value.
- Negative values are not permitted for this property.
- In ruleset views, if you change the view style before editing View Offset for the first time, View Offset displays the offset value as defined in the .xml template of the view style. Make sure that your View Offset value is correct before closing the Drawing View Properties dialog box.

Flush Threshold

Sets a parameter for memory management, and helps improve drawing update performance. When the number of objects processed for a drawing document reaches the Threshold value, they are removed from memory. If they are needed later, they are recalled from the database. The Flush Threshold property is only available for composed drawing documents. The default value is 2000, with a range of 5-5000. Higher values are faster but use more memory, which is acceptable for smaller drawings. Lower values are slower but allow larger drawings to complete faster.

- If a drawing document does not successfully update in the Drawings and Reports 3D task, check the error log for the drawing document. If the error log shows memory overflow...
errors, lower the **Flush Threshold** value.

**VHL Precision**

Sets a parameter for Hidden Line removal processing to consider two lines as identical. This property setting has a direct impact on the visibility of the lines in the drawing. It improves drawing update performance, but it may reduce drawing quality. The VHL precision property is only available for composed drawing documents. The default value is 0.000001, with a range of 0.001 to 0.000001. The smaller the value, the more accurate the graphic elements are in the 2D view.

**NOTE** If some intersections of complex surfaces appear on/off along the curve, the precision of the VHL may be too restrictive compared with the precision by which the surfaces were created. Lowering the VHL precision value may help the display of the intersections, but lowering the value too much could degrade the overall quality and the visibility of the drawing details.

**Geometry Validation**

Sets a parameter for drawing completion and quality to improve drawing update performance. The Geometry Validation property is available for composed drawing documents only. The default value is Off. When set to Off, the drawing document completes, but invalid geometries are left out. If set to On, the drawing document does not complete if invalid geometries are encountered during update.

**Angle for Target Evaluation** (Marine mode only)

Defines the allowable angle from the view plane for a target plate. The Angle for Target Evaluation property is available for the scantling view style only. Additionally, this property is used only with the Place Detail View or the Place Section View command in the SmartSketch Drawing Editor and only when a reference plane selected for the Any system, part, or reference plane Drawing by Rule query has been set. When plates or profiles are selected in the query, target evaluation is determined by a combination of levels and type of connection. The default value is 20º.

**NOTES:**

- The angle is displayed in the units specified in the session file, which is degrees by default.
- For more information about Any system, part, or reference plane, see Drawings by Rule Queries in Queries Tab (Setup Dialog Box - Drawings by Rule).

**Drawing View Properties Dialog Box (Place View Command) - Steel Order Drawings**

Specifies properties for the selected drawing view in a steel order drawing. You can access this dialog box when you select and right-click on a drawing view and then select Properties on the shortcut menu.
For more information on creating a scantling drawing, see the Orthographic Drawings User's Guide.

**Info Tab (Drawing View Properties Dialog Box) (on page 255)**

**Format Tab (Drawing View Properties Dialog Box) (on page 256)**

**View Tab (Drawing View Properties Dialog Box - Drawings View Explorer) (on page 262)**

**See Also**

Place View Command (on page 254)

**Info Tab (Drawing View Properties Dialog Box)**

Specifies general view properties.

- **Type** - Displays the category of the selected element.
- **Sheet** - Displays the name of the drawing sheet that contains the selected element.
- **Layer** - Shows the layer that contains the selected element.
- **Origin** - Specifies the coordinates, or location, of an element along the X- and Y-axes.

**Format Tab (Drawing View Properties Dialog Box)**

Formats the frame around a drawing view.

- **Show Border** - Displays the frame around the object.
- **Color** - Sets the color of the frame.
- **Line Width** - Sets the line thickness on the frame.
- **Line Type** - Overrides a line type for a drawing sheet or embedded object and sets another line style for an element or a linked object.
**View Tab (Drawing View Properties Dialog Box - Drawings View Explorer)**

Sets the drawing view style and other properties for a selected drawing view in a steel order drawing.

**Style**

Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the Select View Style dialog box.

**Name**

Specifies a name for the drawing view.

**Coordinate System Properties**

**Coordinate System**

Specifies a coordinate system to include in the drawing.

**Orientation Properties**

**Orientation Rule**

Specifies the rules available for orientations for the current view type. The Orientation Rule drives the values for the Orientation View Direction and Orientation Up Direction properties. This property is only shown for rule set view styles.

**Orientation View Direction**

Indicates the elevation direction in which you want the drawing view to "look" at the drawing objects. This property is only shown for rule set view styles.

**Orientation Up Direction**

Indicates the x- and y-axis direction with which you want the drawing view to "look" at the drawing objects. This property is only shown for rule set view styles.

**Scale Properties**

**Scale Family**

Specifies a scale family for the drawing view, such as Metric, Imperial, or Manual Scale. When you select a scale family, the Scale property values update. Selecting Manual Scale shows all scales, metric or imperial.

**User Selected Scale**

Specifies a scale to use for the drawing view. The Scale values update depending on the selected Scale Family.

**NOTES**

- For Custom scale, the default is the document's unit of measure setting. For example, if you type values of 1 in to 1 ft, the values are converted to mm if that is the default unit of measure.
- Do not use negative values when typing custom scale values.
Margin Properties

**Margin Left/Margin Right/Margin Top/Margin Bottom**

Defines the marginal distance for the drawing view. The margin is the distance surrounding the drawing view SmartFrame. This area is used for labels and dimensions that have been designed to incorporate margins in their search for clear space.

For example, you could have several drawing views, each with different margin settings:

![Image of drawing views with margins]

Other General Properties

**Description**

Provides a description of the drawing view. This description is optional.

**View Offset**

Expands the view on the drawing sheet in all directions in order to prevent matchline distortion and grid plane clipping. The default offset value is 2 mm for composed views and 0 mm for ruleset views. The offset does not affect the size of the volume that is associated with the view.

**NOTES:**

- **View Offset** is only available for views that are associated to a volume. Section and detail views do not have this property value.
- Negative values are not permitted for this property.
- In ruleset views, if you change the view style before editing **View Offset** for the first time, **View Offset** displays the offset value as defined in the .xml template of the view style. Make sure that your **View Offset** value is correct before closing the **Drawing View Properties** dialog box.
- View annotations, such as the ruler and view name, are automatically adjusted in relation to the **View Offset** value.

**VHL Precision**

Sets a parameter for Hidden Line removal processing to consider two lines as identical. This property setting has a direct impact on the visibility of the lines in the drawing. It improves drawing update performance, but it may reduce drawing quality. The **VHL precision** property is only available for composed drawing documents. The default value is 0.000001, with a
range of **0.001 to 0.000001**. The smaller the number, the more accurate the graphic elements are in the 2D view.

**Geometry Validation**

Sets a parameter for drawing completion and quality to improve drawing update performance. The **Geometry Validation** property is available for composed drawing documents only. The default value is **Off**. When set to **Off**, the drawing document completes, but invalid geometries are left out. If set to **On**, the drawing document does not complete if invalid geometries are encountered during update.

**See Also**

rawings View Explorer (see "Drawings View Explorer" on page 233)

**Automatic Resize Behavior of Composed Views**

For Composed drawings, views that are too small to display the associated volume or are larger than the volume are automatically resized to fit unless the view is set to **Fit to Scale** or is managed by a region. The view size grows or shrinks from the center of the view and view proportions may change after the resize. The drawing must be saved to make the resize of the view permanent.

**NOTE** You cannot crop a composed drawing view that is scaled. Views that are set to **Fit to Scale** can be cropped.

The following examples are common workflows that are affected by the automatic resizing behavior of the composed drawing view.

**Overlapping Volumes Modification**

If you manually shift the sides of an associated volume such that the new volume location overlaps a portion of the old volume, the associated view resizes to mirror the volume changes. You must update the drawing or drawing view for these changes to take place. Manually-placed graphics and labels stay in the correct location on the drawing after the volume size modification and view update.

<table>
<thead>
<tr>
<th></th>
<th>Before</th>
<th>After</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Volume Modification</strong></td>
<td><img src="image1.png" alt="Before Image" /></td>
<td><img src="image2.png" alt="After Image" /></td>
</tr>
<tr>
<td><strong>View Update</strong></td>
<td><img src="image3.png" alt="Before Image" /></td>
<td><img src="image4.png" alt="After Image" /></td>
</tr>
</tbody>
</table>
Non-overlapping Volumes Modification
If you manually shift the sides of an associated volume, or move the volume, such that the new volume location does not overlap a portion of the old volume, the associated view resizes symmetrically around the previous center point of the view. If the volume is moved to a new location, the view does not resize. In either case, the view contents are updated with the volume contents. You must update the drawing or drawing view for these changes to take place.

<table>
<thead>
<tr>
<th>Volume Modification</th>
<th>Before</th>
<th>After</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Before Image" /></td>
<td><img src="image2" alt="After Image" /></td>
<td></td>
</tr>
</tbody>
</table>

View Update

![View Update](image3)

View to Volume Association
If you associate a view to a volume with the **Associate Objects to View** command, the view resizes symmetrically around the center point to match the volume size. The view resizes to match a larger or smaller volume.

<table>
<thead>
<tr>
<th>First Volume</th>
<th>Second Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="First Volume Image" /></td>
<td><img src="image5" alt="Second Volume Image" /></td>
</tr>
</tbody>
</table>

View Scale Modification
If you change the view scale on the **Drawing View Properties** dialog box, the view resizes symmetrically around the center point to accommodate the new scale. Depending on the scale...
change, the view grows or shrinks in size. You do not need to update the view to see these changes, but in order to populate any new objects that are inside the view, an update is required.

<table>
<thead>
<tr>
<th>Small Scale</th>
<th>Larger Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Small Scale Image]</td>
<td>![Larger Scale Image]</td>
</tr>
</tbody>
</table>

**View Look Direction Modification**

If you change the **Look Direction** from the **Drawing View Properties** dialog box, the view resizes symmetrically around the center point to match the volume size according to the new look direction. You do not need to update the view to see these changes, but in order to populate any new objects that are inside the view, an update is required.

<table>
<thead>
<tr>
<th>Volume Modification</th>
<th>Before, Looking Plan</th>
<th>After, Looking East</th>
</tr>
</thead>
</table>
View Direction Coordinate System Modification

If you change the View Direction Coordinate System in the Drawing View Properties dialog box, the view resizes symmetrically around the center point to accommodate the new view direction coordinate system. You do not need to update the view to see these changes, but in order to populate any new objects that are inside the view, an update is required.

**NOTE** If the new coordinate system has the same orientation as the previous coordinate system, the view does not resize.

### Place a Manual View

The following workflows allow you to place a manual view in a Ruleset drawing either by Parts or by Reference Plane and Block.

**See Also**

*Place a Manual View (By Parts)* (on page 267)
*Place a Manual View (By Reference Plane and Block)* (on page 269)

**Place a Manual View (By Parts)**

In this workflow, you directly select detailed parts to associate with the view.
1. In Smart 3D, switch to a task other than Drawings and Reports, such as Molded Forms or Structural Detailing.

2. Select **Tools > Drawing Console**.

   *The Drawing Console dialog box displays.*

3. Right click a drawing document and select **Edit**.

   *SmartSketch Drawing Editor displays. In the Drawings View Explorer, a single sheet displays as a child of the drawing document.*

4. In SmartSketch Drawing Editor, click the **Place View** command. Click and drag in the drawing area to place a graphic view.

   *The Drawing View Properties dialog box displays.*

5. On the **View** tab, select **More** for the **Style** property.

   *The Select View Style dialog box displays.*

6. Navigate through the hierarchy to **Ruleset Styles**. Select an appropriate steel order ruleset view style, such as **Steel Order (Decks)**, and click OK.

   *Additional properties display in the View tab of the Drawing View Properties dialog box.*

7. On the **View** tab, type a value for **Name**.

8. On the **View** tab, select the needed values for **Coordinate System**, **Scale Family**, and **User Selected Scale**.

9. On the **View** tab, select **Scantlings for Plate / Profile** as the **Orientation Rule** value.

10. Click **OK**.

    *In the Drawings View Explorer, the view displays as a child of the drawing sheet.*

11. Select the graphic view in the drawing area and click **Associate Objects to Views**.

12. Select the 3D application window to make it the active window.

    *The Associate ribbon displays in the 3D window.*

13. To associate parts, select **1. Structural Parts or Plane** as the value for **Query** on the Associate ribbon.

14. In the Workspace Explorer, select plates to associate to the view. Select detailed parts, light (non-detailed) parts, systems, or leaf systems.

15. Click **Finish** on the Associate ribbon to complete the association to the drawing view.
In SmartSketch Drawing Editor, preview geometry of the selected plate parts displays.

Place a Manual View (By Reference Plane and Block)

In this workflow, you select a grid plane or an offset from a grid plane to associate parts with the view and select a block, assembly block or assembly to clip the plane selected. You can use the workflow to place a major view, such as the view for a deck, transverse bulkhead, or longitudinal bulkhead.

1. In Smart 3D, switch to a task other than Drawings and Reports, such as Molded Forms or Structural Detailing.

2. Select Tools > Drawing Console.

   The Drawing Console dialog box displays.

3. Right click a drawing document and select Edit.

   SmartSketch Drawing Editor displays. In the Drawings View Explorer, a single sheet displays as a child of the drawing document.

4. In SmartSketch Drawing Editor, click the Place View command. Click and drag in the drawing area to place a graphic view.

   The Drawing View Properties dialog box displays.

5. On the View tab, select More for the Style property.

   The Select View Style dialog box displays.

6. Navigate through the hierarchy to Ruleset Styles. Select an appropriate steel order ruleset view style, such as Steel Order (Reference Plane), and click OK.

   Additional properties display in the View tab of the Drawing View Properties dialog box.

7. On the View tab, type a value for Name.

8. On the View tab, select the needed values for Coordinate System, Scale Family, and User Selected Scale.

9. On the View tab, select Scantlings for Plate / Profile as the Orientation Rule value.

10. Click OK.

   In the Drawings View Explorer, the view displays as a child of the drawing sheet.
11. Select the graphic view in the drawing area and click **Associate Objects to Views**.

12. Select the 3D application window to make it the active window.

   *The Associate ribbon displays in the 3D window.*

13. To associate parts by grid plane, select **1. Structural Parts or Plane** as the value for **Query** on the **Associate** ribbon. In the Workspace Explorer, select a reference plane coincident with the needed plate parts. For the example in this workflow, a transverse reference plane is selected.

14. To associate parts by an offset from a grid plane, select **7. Offset (Optional)** as the value for **Query** on the **Associate** ribbon. In the Workspace Explorer, select a reference plane. Type an offset value in **Value** on the **Associate** ribbon.

15. Select plate parts to associate to the view. For the example in this workflow, select plate parts.

16. Select **2. Block, Volume or Assembly (Optional)** as the value for **Query** on the **Associate** ribbon.

17. In the Workspace Explorer, select the **Assembly** tab.

18. Select a block, assembly block or assembly that will define the extents of the plane that is associated with the view being created.

19. Click **Finish** on the **Associate** ribbon to complete the association to the drawing view.

   *In SmartSketch Drawing Editor, preview geometry of the plate parts displays. Only parts within the selected block or assembly and coincident with the selected reference plane are associated with the view. The block boundaries are also displayed.*

---

**Update a Manual View**

1. Right-click the out-of-date view in the Drawings View Explorer and select **Update**.
2. After the view updates, the view frame in the graphics area shows all geometry defined by the component view style. The view is up-to-date in the Drawing View Explorer.

### NOTES
- You can delete a manual view permanently, or select **UnAssign** to move the view in the UnAssigned Folder. If you delete a view that is a parent of other views, such as a detail or section view, the Convert or Delete dialog box displays. Select **Convert to independent drawing view(s)** to save the child view as an independent drawing view, or select **Delete** to delete the child view.
- A sheet cannot be deleted unless all views on the sheet are removed first.
- All views within the drawing must be up-to-date or the drawing status will be out-of-date.
- For information on the 2D commands available for editing, see the SmartSketch Drawing Editor Help.

### Move a Drawing View

Plant, marine, and material handling mode drawing views can only be moved while holding the ALT key when selecting the view. This includes drawing, section, key plan, and detail views that contain any graphics.

1. Press and hold the ALT key.
2. Select a view.
3. Drag the view to a new location.

### NOTES
- Drawing views that have not been updated can be moved without pressing the ALT key.
- Empty views and embedded reports views can be moved without pressing the ALT key.
The Move, Nudge, Drag, and Select All commands found on the Change toolbar also requires the use of the ALT key when selecting a view.

You must use the Fence Select or Select All commands to select multiple views. You cannot use the CTRL key to select multiple views.

### Place Region Command

Create a new drawing region in the drawing area. A region is a container that controls the arrangement of the views inside by means of an associated layout style. Views controlled by a region are called managed views. You can manage any type of drawing view (report, key plan and graphic views) with a region.

This command is available in SmartSketch Drawing Editor when you edit a layout template or edit an existing drawing.

When you click Place Region, you click and drag to define the new region. The Region Properties dialog box appears so that you can define the properties associated with the region.

After creating the region and defining its properties, use the Place View or Place Report View command to place views within the region.

### Region Behavior

- You can place a drawing view outside a region, but this makes the drawing view an "unmanaged view," meaning the properties of the region do not control the drawing view. However, if a view is inside a region or touching a region, the region manages the drawing view and, when you update the drawing in the 3D Drawings and Reports task, the software pulls the drawing view into the region and updates it based on the region layout style and layout processor.

- If a region refuses to accept a drawing view (for example: the region is defined for three views, and you are attempting to add a fourth view), the drawing view is added as an unmanaged
view, just outside and to the upper left of the region. If another region occupies this space in
the drawing area, the unmanaged view is placed as close to the original region as possible.

- If a drawing view "straddles" two or more regions, the region that contains more of the drawing
  view manages it. If the drawing view equally straddles two or more regions, the software uses
  the first drawing view point to measure distance and determine which region manages the
drawing view.

- If a region contains a drawing view and the drawing view properties make it ineligible for the
  region, the software removes the drawing view from the region automatically and places it in
  the upper left of the drawing area, outside of other regions.

- If you switch the border of a drawing using the **Switch Border** command, views may
  reposition or resize with the new border template based on the following conditions:
  - Managed views are resized and repositioned according to the new border template.
  - Unmanaged views are not resized and repositioned.
    
    For more information, see **Switch Border** (on page 371).

**Deleting a Region**

Regions are used to manage the positioning of views within a layout template. When you delete a
region, any views that were managed by the region become "unmanaged" views.

1. To delete a region from a layout template, you should use **PickQuick** to select the outer
   boundary of the region.
2. After selecting the region outer boundary, select **Edit > Delete** to remove the region definition. You can also press the **Delete** key on the keyboard. Any views placed within the region remain on the layout template as unmanaged views.

**See Also**
*Region Properties Dialog Box* (on page 274)

**Region Properties Dialog Box**

Specifies properties for the selected region. This dialog box displays after you have created a new region using the **Place Region** command, which is only available in **SmartSketch Drawing Editor**.

**Description** - Provides a description of the region.

**Layout Style** - Specifies the layout style to associate with this region. The layout style dictates the order and placement of the drawing views managed by the region. Select **More** to display the **Define Layout Style** dialog box and select the layout style from a list of available styles. For more information, see *Define Layout Style Dialog Box* (on page 275).

**Maintain Aspect** - Specifies whether or not the aspect ratio for each drawing view and region is maintained within the layout. This property is useful when you are "stretching" a layout into a border or when you are changing the border.

**Lock Region** - Locks the positioning of the drawing views within the region. This property also prevents you from adding or deleting existing views.

**See Also**
*Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command* (on page 375)
*Place Region Command* (on page 272)
Define Layout Style Dialog Box

Specifies a layout style to associate with a drawing region. This dialog box displays when you select More in the Value field for the Layout Style property on the Region Properties dialog box. The hierarchy shows all available layout styles.

See Also
Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command (on page 375)
Place Region Command (on page 272)
Region Properties Dialog Box (on page 274)

Place Snapshot View Command

Creates a new snapshot drawing view in the drawing area. This command is only available in SmartSketch Drawing Editor when you create a new drawing or open an existing drawing from a 3D task.

**NOTE** Before you place snapshot views, you need to create a snapshot using the 3D task Tools > Snapshot View command. If you do not have any snapshot views, a message displays and you can go back to a 3D task and create the snapshot views.

When you click Place Snapshot View, you click and drag to define the new view. You specify the snapshot view properties in the Snapshot View ribbon displayed above the drawing area.

<table>
<thead>
<tr>
<th>View Name:</th>
<th>View Style:</th>
<th>View Scale:</th>
</tr>
</thead>
<tbody>
<tr>
<td>SnapshotView</td>
<td>Orthographic P</td>
<td>Ft To Scale</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:00 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1:30 min</td>
</tr>
</tbody>
</table>

When you edit a drawing that contains a snapshot view, you can right-click the view and select Properties to change the style or scale used in the snapshot view.

To update the contents of the snapshot view, right-click the view and select Update View.

See Also
Update View Command (on page 370)
Place Snapshot View Ribbon (on page 275)
Drawing View Properties Dialog Box (Drawing View Shortcut Menu) (on page 345)

Place Snapshot View Ribbon

Sets options for placing a snapshot drawing view. These options include the view name, style, and scale.

View Name

Displays the name of the view you created in a 3D task.

View Style

Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the Select View Style dialog box.

View Scale
Specifies a scale. You can choose **No Scale** if the view is not to scale. Choose **Custom** if you want to specify your own scale and then type values in the two boxes at the right of the ribbon. If you choose **Custom** for the scale, you must type values that are greater than zero in the boxes at the right. If you select **Fit to Scale**, the software places the snapshot to fit the scale of the view you place. If you select one of the scale families, such as **Metric Scales**, the software sets the cursor for placement at the selected scale.

See Also
Place Snapshot View Command (on page 275)

**Associate Objects to View Command**

Allows you to interactively specify volumes or other model objects as input for the selected drawing views. If the view is a key plan or report view, you specify an existing drawing view. This command is also used in creating composed drawings in a 3D task. The command is only available in **SmartSketch Drawing Editor** when you create a new drawing or open an existing drawing from a 3D task.

When you select a view and click **Associate Objects to View**, the **Associate Objects to View** ribbon appears on the 3D task window. ** Associate Objects to View** turns off 2D/3D Selection so that you can move back and forth between the 3D application and SmartSketch Drawing Editor, selecting views and associating volumes or model objects.

**Orthographic View Ribbon**

If you are associating volumes to a graphic drawing view, the following ribbon options appear:

**Select View**

Shows either all of the graphic views in the drawing or a list of selected views from the drawing. You can multi-select views before running the **Associate Objects to View** command to populate the list with only the selected views. As you click volumes to associate them to the currently shown view, the list scrolls to the next view automatically. The views are listed in alphabetical order.

**Exclude Objects**

Allows you to select objects to exclude from the drawing view or to view objects that have been previously selected for exclusion from the drawing view. When you click **Exclude Objects**, the **Accept/Cancel** buttons enable on the ribbon so that you can confirm the selection. Excluded objects are highlighted.

**NOTES**

- You should associate your volume before excluding objects from the volume.
- You can select the objects from the model, or from the **Workspace Explorer**, but you cannot select referenced objects that originate from files on the **Reference** tab of the **Workspace Explorer**.
- You can clear objects that have previously been excluded from the drawing view by clicking on the object.
- If you exclude an object while the related tab of the **Workspace Explorer** is active, the child objects are automatically excluded. For example, if the **System** tab is active when you exclude a system object, then all of the children objects are also excluded. If the related WSE tab is not active, only the object that you specifically select is excluded. For
example, if you exclude a pipe run while the **Space** tab is active, the child parts of the pipe run are not excluded.

**Select Volume**

Sets the command in select mode so that you can select a volume graphically or from the **Workspace Explorer**. After you select a volume in the workspace window, you can use the other controls on the ribbon to further define the objects collected for the drawing view. This is the default setting when the command ribbon appears.

**Cancel**

Clears all objects selected for exclusion from the drawing view and returns you to the previous **Select volume** command step.

**Accept**

Accepts all objects selected for exclusion from the drawing view and returns you to the **Select volume** command step.

**Filter**

Specifies a filter to restrict the objects to include in the volume. You can right-click and select **More** to select a filter from an existing list of filters or to create a new filter.

**NOTES:**

- You should not use filters from the **My Filters** folder when using the **Filter** option on the **Associate Objects to View** ribbon.
- Section and detail views inherit filters used by the **Filter** option from the parent view.

**Properties**

Displays the properties for the selected filter.

**Clear Filter**

Clears the currently selected filter. This button only enables when you have selected a filter in the **Filter** dropdown field.

**Look Direction**

Indicates the view direction for the drawing view. The current setting is taken from the drawing view properties, set when the view was created with the **Place View** command in SmartSketch Drawing Editor. If you change the **Look Direction**, you are also changing the view direction property on the drawing view. If you select **From Active View**, the software uses the **Look Direction** of the active graphic view.

**Rule Set View Ribbon (List-Based)**

When the graphic view has a rule set view style, the following ribbon options appear:

**Query**

Specifies the query to apply to the drawing view. The selected query tells the software which objects to include in the drawing view.

**NOTE:** A view query specifies the type of model object or parameter value used by the view definition. The list of available queries is specific to the selected package. If you are a reference data administrator customizing a drawing package, view queries are parts of the rule set defined on the **Actions** tab of the **Edit Ruleset View Style** dialog box in the Drawings
and Reports task. For more information, see the appropriate drawing type under Drawings by Rule View Style Rule Sets in the Drawings and Reports Reference Data Guide.

**Value**

Specifies a value required by the selected query. The type of value is defined by the query. You may need to select a value from a list, type a value, or turn an option on or off.

**Finish**

Saves the specified query and value to the selected drawing view.

### Rule Set View Ribbon (Step-Based)

When the graphic view has a rule set view style, the following ribbon options appear:

- ** Associate Objects to View**
  
  Displays the default parts available for the view. Select the needed parts to add them to the view.
  
  - If all needed parts are displayed, select them in the graphic view, and then click Finish to return to SmartSketch Drawing Editor.
  
  - If all needed parts are not displayed, select them using the Create Volume or Gather Objects options.

- ** Create Volume**
  
  Changes the default volume definition for the drawing view. For more information, see Create Volume Options, below.

- ** Gather Objects**
  
  Changes the default part type definitions to include in the volume. For more information, see Gather Objects Options, below.

- ** Orient View**
  
  Changes the default view direction and orientation. For more information, see Orient View Options, below.

  **TIP** With this option, you can orient the drawing view by the local coordinate system of a part selected in the graphic view.

**Finish**

Saves the specified options to the drawing view and returns to SmartSketch Drawing Editor.

- ** Reject**
  
  Clears the selected option.

- ** Accept**
  
  Accepts the selected options.

### Create Volume Options

**Volume Creation Rule** - Defines the volume for the view by one of the following methods:
• **Create volume along surface of input parts with boundary extents** - The volume follows the surfaces of the selected parts resulting from **Any system, part, or reference plane**. The volume depth (normal to the view) is extended by the values of **Volume growth into drawing** and **Volume growth out of drawing**. The volume area (in the plane of the view) is extended to (or clipped by) the boundaries defined by **Boundary (Block, volume, or assembly)**.

**Example**: Corrugated bulkhead

![Diagram](image1.png)

1 - Cross-section of volume
2 - Volume growth
3 - Additional part not gathered into view
4 - View direction
5 - Volume extended to boundaries

• **Create volume along surface of input parts without boundary extents** - The volume follows the surfaces of the selected parts resulting from **Any system, part, or reference plane**. The volume depth (normal to the view) is extended by the values of **Volume growth into drawing** and **Volume growth out of drawing**. The volume area (in the plane of the view) is not extended to (nor clipped by) the boundaries defined by **Boundary (Block, volume, or assembly)**.

**Example**: Corrugated bulkhead

![Diagram](image2.png)

1 - Cross-section of volume
2 - Volume growth
3 - Additional part not gathered into view
4 - View direction

• **Create volume from range box around input parts with boundary extents** - The volume is a rectangular range box around the selected parts resulting from **Any system, part, or reference plane**. The volume depth (normal to the view) is extended by the values of **Volume growth into drawing** and **Volume growth out of drawing**. The volume is extended to (or clipped by) the boundaries defined by **Boundary (Block, volume, or assembly)**. See the corrugated bulkhead example below.

**Example**: Corrugated bulkhead

![Diagram](image3.png)

1 - Cross-section of volume
2 - Volume growth
3 - Additional part gathered into view
4 - View direction
5 - Volume extended to boundaries
- Create volume from range box around input parts without boundary extents - The volume is a rectangular range box around the selected parts resulting from Any system, part, or reference plane. The volume depth (normal to the view) is extended by the values of Volume growth into drawing and Volume growth out of drawing. The volume is not extended to (nor clipped by) the boundaries defined by Boundary (Block, volume, or assembly). See the corrugated bulkhead example below.

Example: Corrugated bulkhead

- Create oriented volume around input parts without boundary extents - The volume is a rectangular box around the parts. The box is oriented around parts to minimize the volume. The parts are typically not orthogonal, but the view direction is typically normal to the box. The volume depth (normal to the view) is extended by the values of Volume growth into drawing and Volume growth out of drawing.

NOTES

- If the view direction is not normal to the box, then the volume is extended to (or clipped by) the boundaries defined by Boundary (Block, volume, or assembly) instead of Volume growth into drawing and Volume growth out of drawing.

- If the view direction is normal to the box, then the volume is extended to (or clipped by) Volume growth into drawing and Volume growth out of drawing. These values can be positive or negative.
Example: Non-orthogonal member

- Cross-section of volume
- Volume growth
- Additional part gathered into view
- View direction

- Do not create volume - A volume is not used to restrict gathering using gathering rule. For example, a shell longitudinal profile view does not use a volume. It instead uses levels to gather secondary parts.

Depth Into

Defines a distance into the drawing to extend the depth of a thin volume. Parts within the thin volume are displayed in the view. A value for this query is optional.

Depth Out Of

Defines a distance out of the drawing to extend the depth of a thin volume. Parts within the thin volume are displayed in the view. A value for this query is optional.

Boundary Overlap

Defines the distance that parts extend past the view boundary.

Offset

Defines the distance from a reference plane used to create the view plane. A positive value offsets the view plane out of the drawing. A negative value offsets the view plane into the drawing. This value can be used in combination with Volume growth into drawing and
**Volume growth out of drawing** to create a thin volume. A value for this query is optional.

1 - Reference plane  
2 - View direction  
3 - Offset out of drawing (positive value)  
4 - Offset into drawing (negative value)  
5 - View plane offset out of drawing  
6 - View plane offset into drawing

**Clip to Volume**
Clips part visibility in the graphic view to the boundaries of the volume.

**Gather Objects Options**

**Gathering Rule**
Defines the type of parts gathered in the drawing view. The rule provides a definition of the objects to be gathered and drawn in a view. Select a rule that supports the type of drawing view you want to create, such as **Steel Order**, **Piping**, **Pipe Supports**, or **Assembly**.

**Include all objects in volume**
Defines how gathered parts are included in the drawing view. Select to gather all parts in the volume even if they are not connected to the selected parts. Clear to gather only the selected parts and parts connected to the selected parts.

**Show Objects Gathered**
Highlights the gathered parts.

**Orient View Options**

**Orientation Rule**
Specifies the rule used to define the view orientation. Select options such as **Global Coordinate System**, **Local Coordinate System**, **Scantlings for Plate/Profile**, and **Scantling By Plate Normal**.

**View Direction**
Defines the direction of the view. The available options are defined by the selected orientation rule.

**Up Direction**
Defines the up direction of the view. The available options are defined by the selected orientation rule.
Orient Display to View Direction
Changes the orientation of the graphic view to match the view orientation. This option is only available when Local Coordinate System is selected for Orientation Rule.

Key Plan or Report View Ribbon
When the view you selected is specified as a report or key plan view style, you need to associate a drawing view to populate the contents of the report or key plan. The following ribbon options appear:

View
Displays a list of views available for association with the report or key plan.

Finish
Returns you to SmartSketch Drawing Editor with the selected view associated to the report or key plan view.

Expansion View Ribbon
Provides options for generating expansion views. An overview of the required inputs is shown in the following graphic:

![Expansion View Graphic]

**NOTE** This ribbon displays only when the Associate Views to Object Command option is set to Expansion. For more information, see General Tab (Edit Ruleset View Style Dialog Box) in the Drawings and Reports Reference Data Guide. You can access this document using the Help > Printable Guides command in the Drawings and Reports task.

Expansion Surface
Select a plate system or plate part for which you want expansion drawings. You can select multiple plate systems or plate parts.

Cutting Planes Axis
Select a coordinate system axis for defining the cutting planes.

Base Plane Definition
Select a plane that is normal to the grid planes of the cutting plane axis.
Offset Plane

Select a plane that is perpendicular to the grid planes of the base plane and cutting plane axes. This plane is the reference plane from which the curve is expanded. This is an optional input.

Expansion Direction

Defines the expansion direction. This option is available only when the base plane intersects the expansion surface. If you select Positive Direction, the expansion surface on the positive side of the base plane will be expanded and its corresponding drawing will be generated. If you select Negative Direction, the expansion surface on the negative side of the base plane will be expanded and its corresponding drawing will be generated. If you select Both, the expansion surface will be expanded completely and its corresponding drawing will be generated.

Block or Volume

Select a bounding block or volume. This is an optional input.

Cancel

Clears the selected options and allows you to continue the selection process.

Accept

Accepts the selected options.

Finish

Finishes the command.

For workflows using this command, see Associate Objects to Views (on page 285) and Associate Objects to a Drawings by Rule View (on page 289).

NOTES

- When using a Snapshot view style, all objects within the associated volume are included in the drawing view, regardless of exclusions made using Associate Objects to View.
- When using a Volume view style, only the objects returned by the filters in the view style are included in the drawing view.
- An error message displays if a volume is not selected in the 3D application.
- If a 3D task process is running (for example: a recompute of relationships after moving a grid plane), an informational message displays and Associate Objects to View is canceled.
- Views that are too small to display the volume are automatically sized larger to fit unless the view is set to Fit to Scale or is managed by a region. Likewise, views that are larger than the volume are automatically resized to fit unless the view is set to Fit to Scale or is managed by a region. The view size grows or shrinks from the center of the view and view proportions may change after the resize. The drawing must be saved to make the resize of the view permanent. For more information, see Automatic Resize Behavior of Composed Views (on page 264).
- To remove associated inputs from a view, use Remove Associated Inputs. For more information, see Remove Associated Inputs Command (on page 290).
- Section and detail views inherit filters used by the Filter option from the parent view.
See Also
Place View Command (on page 254)
Update View Command (on page 370)

Associate Objects to Views

The following procedure steps you through associating volumes to drawings views in a 3D composed drawing. The procedures assumes you have already opened a 3D drawing in SmartSketch Drawing Editor to place and associate views. The example workflow uses a drawing with two drawing views already placed.

NOTE For more information on 3D composed drawings, see the Orthographic Drawings User's Guide. For information on the commands available for editing 3D drawings, see Working with Drawings and Reports and SmartSketch Drawing Editor (on page 230).

Associate Drawing Views with Orthographic View Styles

1. In SmartSketch Drawing Editor, select the orthographic drawing views that you want to associate, and then click Associate Objects to View.
2. In the 3D application, notice the **Associate Objects to View** ribbon above the active window. If the selected drawing view has an orthographic view style, the **Select View** dropdown includes the names of the drawing views you selected in the drawing.

3. Click volume graphically or in the **Workspace Explorer** to associate to the current drawing view. The **Select View** dropdown scrolls automatically to the next drawing view in the list. Click another volume to associate with the second drawing view.

4. When you are done associating volumes to drawing views, return to SmartSketch Drawing Editor, and click **Place View**.

5. To update the view contents with the associated volumes, select and right-click the view and select **Update View** on the shortcut menu. For more information, see *Update View Command* (on page 370).

6. Save the drawing document and exit SmartSketch Drawing Editor.

7. Update and complete your drawing document.

**Exclude Objects from the Volume**

The **Associate Objects to View** command ribbon allows you to further define the objects associated to the drawing view. You can use filters to restrict the objects collected from the volume. You can also exclude objects from the volume if you do not want them included in the drawing.
In the following graphic, the **Associate Objects to View** ribbon shows how you can use a filter, such as **Equipment**, to define the objects shown in the drawing.

In the next example, the same **Equipment** filter is applied to the volume. However, a **Vertical Tank** is excluded from the filter. You achieve this output as follows:

1. Select the **Filter**, then click **Exclude Objects**.
2. Select the objects inside the volume that you want to exclude from the drawing.

**NOTES:**

- We recommend that you associate your volume before excluding objects from the volume.
- You can select the objects from the model, or from the **Workspace Explorer**, but you cannot select referenced objects that originate from files on the **Reference** tab of the **Workspace Explorer**.
- You can unselect objects that have previously been excluded from the drawing view by clicking on the object.
- If you exclude an object while the related tab of the **Workspace Explorer** is active, the child objects are automatically excluded. For example, if the **System** tab is active when you exclude a system object, then all of the children objects are also excluded. If the related WSE tab is not active, only the object that you specifically select is excluded. For example, if you exclude a pipe run while the **Space** tab is active, the child parts of the pipe run are not excluded.

3. Click **Accept** to save the change to the volume definition.
4. Go back to SmartSketch Drawing Editor and update the view contents with the associated volumes with the **Update View** command on the shortcut menu of the view. The **Vertical Tank** does not appear in the drawing view.

5. Save the drawing document and exit SmartSketch Drawing Editor.

6. Update and complete your drawing document.

**Associate Key Plan or Report Views**

1. Select a key plan or report view in the drawing document.
2. Click **Associate Objects to View**.
3. In the 3D application, select a view from the **View** dropdown. The **View** dropdown contains a list of all the drawing views available in the current drawing document open in SmartSketch Drawing Editor.
4. Click **Finish** to save the association to the key plan or report view.
5. Go back to SmartSketch Drawing Editor to update the view contents. Select and right-click the view and select **Update View** on the shortcut menu. For more information, see **Update View Command** (on page 370).
6. Save the drawing document and exit SmartSketch Drawing Editor.
7. Update and complete your drawing document.

**Associate to a Drawing View with a Ruleset View Style**

Ruleset view styles are only used in Smart 3D drawings.

1. Select a drawing view with a ruleset view style then click **Associate Objects to View**.
2. In the 3D application, select a query from the **Query** dropdown. Depending on the query, you may need to specify a value or select objects graphically.
3. Click **Finish** to save the association to the drawing view.
4. Go back to SmartSketch Drawing Editor to update the view contents. Select and right-click the view and select **Update View** on the shortcut menu. For more information, see **Update View Command** (on page 370).

5. Save the drawing document and exit SmartSketch Drawing Editor.

6. Update and complete your drawing document.

**See Also**
- **Place View Command** (on page 254)
- **Associate Objects to View Command** (on page 276)

### Associate Objects to a Drawings by Rule View

1. In Smart 3D, switch to a task other than Drawings and Reports, such as Molded Forms or Structural Detailing.

2. Click **Tools > Drawing Console**.
   - **The Drawing Console** dialog box displays.

3. Right-click an existing Drawings by Ruleset drawing document and click **Edit**.
   - **SmartSketch Drawing Editor** displays.

4. In SmartSketch Drawing Editor, click **Place View**. Click and drag in the drawing area to place a graphic view.
   - **The Drawing View Properties Dialog Box** displays.

5. On the **View** tab, select **More** for the **Style** property.
   - **The Select View Style** dialog box displays.

6. Navigate through the hierarchy and select a drawing view style, and then click **OK**.
   - **Additional properties display on the View tab of the Drawing View Properties dialog box.**
   - **NOTE**: For more information about ruleset view style definitions, see **Define View Style Command** in the Drawings and Reports Reference Data Guide. You can access this document using the **Help > Printable Guides** command in the Drawings and Reports task.

7. On the **View** tab, type a value for **Name**, and then select the needed values for **Coordinate System**, **Scale Family**, and **User Selected Scale**.

8. Click **OK**.

9. Select the graphic view in the drawing area and click **Associate Objects to View**.

10. Select the 3D application window to make it the active window.

11. Use the ribbon that displays in the 3D window to define the necessary options.

**NOTES**
- For more information, see **Place View Command** (on page 254) and **Associate Objects to View Command** (on page 276).
- The software displays either the **Drawing Ruleset Ribbon** or the **Expansion Ribbon**, depending on how you defined the **Associate Objects to View** options for the selected view style. For more information about this option, see **General Tab (Edit Ruleset View Style Dialog Box)** in the Drawings and Reports Reference Data Guide.
Remove Associated Inputs Command

Allows you to remove the associated volumes, filters, views, and other inputs from the selected view. It works with all graphic and non-graphic (report and keyplan) views. The command is available on the Compose toolbar when creating a new 3D composed drawing or editing a 3D composed drawing.

When you click Remove Associated Inputs, a status bar message instructs you to select a single drawing view. After you select a drawing view, a confirmation message displays. Click Yes to continue and remove the associated inputs from the selected view, or click No to cancel the command.

**NOTE** You cannot Undo or Redo actions performed by the Remove Associated Inputs command.

**See Also**
Place View Command (on page 254)
Associate Objects to View Command (on page 276)
Update View Command (on page 370)

Place Report View Command

Adds a report "view" in the drawing. The report view becomes an embedded report based on the contents of a drawing view. You could create Bill of Material, Issue Record, or a Revision report tied to the contents of a specified drawing view. This command is only available in SmartSketch Drawing Editor when you create a new drawing or open an existing drawing from a 3D task.

When you click Place Report, you click and drag to define the new report view. The Report Properties dialog box appears so you can define the properties associated with the report view.

When you select a report view and click Associate Objects to View, the Associate Objects to View ribbon appears on the 3D task window. For more information, see Associate Objects to View Command (on page 276).

For information on creating new views, see Place View Command (on page 254).
For a list of reports that can be embedded in a drawing successfully, see *Reports Compatible with Drawings* (on page 292).

**NOTES**

- You can associate multiple reports to the same view, but you cannot associate multiple views to the same report.
- You cannot multi-select report views to associate to a single view. The relationship is one-to-one from report view to graphic drawing view. Also, you cannot multi-select report views and graphic views. Other objects (such as lines or symbols) are ignored if they are in the select set with the report view when you run the **Associate Objects to View** command.

**See Also**

- *Report Properties Dialog Box (Place Report View Command)* (on page 291)
- *Update View Command* (on page 370)
- *Report Properties Dialog Box (Place Report View Command)* (on page 291)

**Report Properties Dialog Box (Place Report View Command)**

Specifies properties for the selected report view. This dialog box displays after you have placed a new report view using the **Place Report View** command or when you edit properties for an existing report view.

**Name** - Specifies a name for the report view.

**Description** - Provides a description of the report view.

**Report Template** - Specifies the report template to use when populating the report view. Select **More** in the **Value** list to display the **Select Template** dialog box. For more information, see *Select Template Dialog Box* (on page 292).

**Report Template Output** - Specifies how the report output will be formatted. Select **Excel** to output the report as an Excel spreadsheet or **Native text boxes** to use a text box format. The **Undefined** value means the software uses the default output format for the report (Excel spreadsheet).

**Report Justification** - Specifies the justification of the report window. Select **Top-Left**, **Top-Right**, **Center-Center**, **Bottom-Left**, or **Bottom-Right** to align the report to one of these positions. For example, if you select **Top-Right**, the top-right corner of the report window is aligned to the top-right corner of the view. The **Center-Center** option is the only justification option that scales the report window to fit the view. The other justification options do not scale to the view. For example, if you choose **Top-Right** and the report window is either larger or smaller than the view, it is not resized automatically to fit the view.

**NOTE**  The **Report Output Format** setting must be set to **Native text boxes** for justification to function. Otherwise, the justification setting is automatically set to **Center-Center**.

After creating the view and defining its properties, use the **Associate Objects to View** command to specify the content of the view.

The **SP3DConvertExcelEmbedded.dll** is a delivered custom command that allows you to convert an Excel spreadsheet report to the native text box format for use in 3D Drawings. For information on converting Excel spreadsheet reports, see *Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command* (on page 375).

**See Also**

- *Place Report View Command* (on page 290)
Select Template Dialog Box

Specifies a template to associate with the selected view.

This dialog box appears when you click More in the Value dropdown on the Report Properties dialog box while placing a new report view on the drawing sheet. For more information, see Place Report View Command (on page 290).

Click OK to return to the Report Properties dialog box.

See Also
Place Report View Command (on page 290)
Report Properties Dialog Box (Place Report View Command) (on page 291)

Reports Compatible with Drawings

There are three conditions that must be satisfied before a report can be successfully embedded in a drawing and produce useful results.

- Pure SQL queries are not supported
- Report must have a column named OID and LocatableOID
- There must be a column named ItemNum

The following reports can be embedded in a drawing successfully. The product allows you to embed any of the delivered reports in a drawing, but the following reports provide more meaningful results when embedded in a drawing. The following reports are the only reports that are compatible with the bubble label (Reference_Circle_CA_L) in drawings. For more information on each report, see the Smart 3D Reports User's Guide.

PipeRuns by Drawing (Deliverables\PipeRuns by Drawing)
Equipment Material Take-Off (Equipment)
Solids of Design Equipment with Composite CoG (Equipment)
Hangers and Supports for Components - Drawings (Hangers and Supports)
Hangers and Supports for Supported Route - Drawing (Hangers and Supports)
Hangers and Supports for Supporting Structure - Drawing (Hangers and Supports)
Hangers and Supports End View - Drawing (Hangers and Supports)
Hangers and Supports ISO View - Drawing (Hangers and Supports)
Hangers and Supports Side View - Drawing (Hangers and Supports)
Hangers and Supports Pipe Rack Sorted by Name - Export to Icarus (Hangers and Supports)
Equipment Piping Trim (Piping)
HVAC Material Take-Off (HVAC)
Piping Fittings - Export to Icarus
Piping Material Take-Off (Piping)
Piping Pipe Line List (Piping)
Place a Label Command

Manually labels items on a drawing. This command is available when you are editing a 3D drawing in SmartSketch Drawing Editor. When you click Place a Label, the Place a Label ribbon appears in the toolbar area.

You can choose one of the delivered label rules, or you can customize your own label rule.

You can place labels on drawings after they have been generated. For example, you can place a label manually on a drawing to emphasize certain objects in the drawing view.

When you place labels using this command, the software automatically saves the labels to the DwgTemplate layer so they will be preserved when you update the drawing document.

TIP To move the label after it has been placed, click and drag the label by its origin point, identified by the green circle in the middle of the label object. In the graphic below, the Drum label is moved. Snapping behavior is automatic. If you click and drag the Drum label by its origin point and hover over another label, then release the label, it snaps to the new label position.

See Also
Place a Label Ribbon (on page 293)

Place a Label Ribbon

Sets options for label placement on a drawing. To access this ribbon, click Manual Place Labels. When you place labels using this command, make sure you are on the DwgTemplate layer of the drawing so the software preserves the manually placed labels when you update the drawing.

Object filter - Specifies what type of objects can be selected in the drawing when placing a label.

Label Specification - Specifies a label rule. The label rules are located in the [Reference Data Folder]\SharedContent\Drawings\Catalog\Rules\LabelRules folder.

Font - Overrides the text font in the label.

Text size - Overrides the text font size in the label.

Text color - Applies a different color to text.

Bold - Applies bold formatting to text.

Italic - Applies the italic font to text.

Underline - Underlines the text.
Shape - Choose a shape for the enclosure of the label.

Orientation - Specifies horizontal or vertical text in the label.

Leaderline on/off - Specifies whether you want a leader line pointing to the object.

Leaderline jog on/off - Specifies whether a jog in the leader line is acceptable.

Leader color - Applies a different color to the leader line.

Boundary - Specifies whether the leader terminator originates inside or outside of the object.

Leader Tolerance - Specifies the required distance between the labeled object and the label before a leader appears. For example, if the leader tolerance value is set to 10mm, the label must be at least 10mm away from the labeled object before a leader will appear.

Dimension Label - Places a label in a dimension format. Choose from Distance Between, Coordinate Dimension, SmartDimension, and Angle Between. When placed, a label is placed instead of a dimension value.

As Drawn - Specifies that the label be shown as it was designed in the label rule. Font, text size, text color, and other formatting on the ribbon do not apply.

See Also
Place a Label Command (on page 293)

Place a Manual Label

1. Right-click a drawing, and click Edit on the shortcut menu. The drawing opens for editing in SmartSketch Drawing Editor.

2. On the toolbar, click Manually Place Labels.

3. Click an object in a drawing view to label.

4. (This step is only for marine mode) Use the Object Filter to enable only certain objects for selection. For example, selecting Physical Connections in the Object filter list only allows you to select physical connections.

5. In the Label Name drop-down menu, select a label. The labels are located on the application server in the $Symbols$\Drawings\Catalog\Labels\Templates folder.

6. To pick from a hierarchical list, select More. The Select Label dialog box displays.

7. Select a label template folder in the left pane of the dialog box, select a specific label name in the right pane, and then click OK.

8. In the Font box, specify the font.

9. In the Text size box, specify the size of the text.

10. Click Text Color, and select a color for the label text.

11. Click the Bold, Italic, and Underline buttons to achieve the necessary formatting.

12. Click Shape flyout to choose the shape of the label border.

13. Click Orientation to specify horizontal or vertical text.
14. Specify the leader line and jog as necessary.

15. Click **Leader Color**, and select a color for the leader.

16. Choose the **Boundary** option to clip the leader at the object boundary, or choose the **Inside** option to extend the leader to the inside of the object.

17. Key in a value for the **Leader Tolerance** value. This value determines the distance required for a leader to appear. For example, if the leader tolerance value is set to 10mm, the label must be at least 10mm away from the labeled object before a leader will appear.

18. Choose a dimension label in order to place a dimension that displays a label instead of a dimension value. For more information, see *Dimensioned Label Command* (on page 298).

19. Select an elevation label if you want to place an elevation label that displays the elevation of the routable object. For more information, see *Elevation Label Command* (on page 360).

20. Select **As Drawn** if you want the label appearance to reflect the label definition only and not have any formatting overrides.

   **TIP** If you select **As Drawn**, the label appearance is determined by the label definition. You cannot set the font, text size, text color, and so forth for the label.

21. Click the drawing to place the label.

   **TIP** During placement, the label will automatically align to the left or right side of an existing label. You can also align the label to any object keypoints in the drawing. For more information on using alignment settings, see *Align Dimensions Command in the SmartSketch Drawing Editor Help*.

22. Continue placing labels on the drawing if necessary.

23. Right-click to end the command.

24. Save your changes before exiting **SmartSketch Drawing Editor**.

**NOTE** You can remove manual edits from a drawing using **Clear Manual Edits** in **SmartSketch Drawing Editor**. For more information, see *Clear Manual Edits Command* (on page 341).

### Place a Manual Weld Label

1. Right-click a drawing, and click **Edit** on the shortcut menu. The drawing opens for editing in **SmartSketch Drawing Editor**.

2. On the toolbar, click **Manually Place Labels**.

3. (This step is only for marine mode) Use the **Object Filter** to enable only certain objects for selection. For example, selecting **Physical Connections** in the Object filter list only allows you to select physical connections.

4. In the **Label Name** drop-down menu, select a label rule.

   **TIP** The label rules are located on the application server in the Symbols\Drawings\Catalog\Labels\Templates folder.

5. To pick from a hierarchical list, select **More**.
The Select Label dialog box displays.

6. Select a label template folder in the left pane of the dialog box, select a specific label name in the right pane, and then click OK.

7. Click on a physical connection.

The correct weld symbol automatically displays based on the physical connection properties.

8. In the Font box, specify the font.

9. In the Text size box, specify the size of the text.

10. Click Text Color, and select a color for the label text.

11. Click the Bold, Italic, and Underline buttons to achieve the necessary formatting.

12. Click Orientation to specify horizontal or vertical text.

13. Select a leader and leader jog.

14. Click Leader Color, and select a color for the leader.

15. Choose the Boundary option to clip the leader at the object boundary, or choose the Inside option to extend the leader to the inside of the object.

16. Key in a value for the Leader Tolerance value. This value determines the distance required for a leader to display. For example, if the leader tolerance value is set to 10mm, the label must be at least 10mm away from the labeled object before a leader displays.

17. Choose a dimension label in order to place a dimension that acts as a label. For more information, see Dimensioned Label Command (on page 298).

18. Select As Drawn if you want the label appearance to reflect the label definition only and not have any formatting overrides.

TIPS

- If you select As Drawn, the label appearance is determined by the label definition. You cannot set the font, text size, text color, and so forth for the label.

- Click the drawing to place the label. If you hover directly over the physical connection, the label will snap to the physical connection line, but will not align.

- To move the label after it has been placed, click and drag the label by its origin point, identified by the green circle in the middle of the label object. In the graphic below, the weld symbol is moved.

- To rotate the label after it has been placed, select the label and click the green circle located on the outside of the label. Drag the green circle until the label is aligned correctly to the physical connection.

1. Continue placing labels on the drawing if necessary.
Working with Drawings and Reports and SmartSketch Drawing Editor

2. Right-click to end the command.

3. Save your changes before exiting SmartSketch Drawing Editor.

**NOTE** You can remove manual edits from a drawing using Clear Manual Edits in SmartSketch Drawing Editor. For more information, see Clear Manual Edits Command (on page 341).

**See Also**
Place a Manual Label (on page 294)

---

**Place a Manual Flow Arrow on an Orthographic Drawing**

You can place flow arrows on pipe objects in orthographic drawings with the Place a Label command in SmartSketch Drawing Editor.

You can also add flows arrows as part of the drawing view style definition. For more information, see Add Flow Arrows to Orthographic Drawings in the Drawings and Reports Reference Data Guide.

1. Right-click a drawing, and click Edit on the shortcut menu. The drawing opens for editing in SmartSketch Drawing Editor.

2. On the toolbar, click Manually Place Labels.

3. (This step is only for marine mode) Use the Object Filter to enable only certain objects for selection. For example, selecting Physical Connections in the Object filter list only allows you to select physical connections.

4. Click an object in a drawing view to label.

5. In the Label Name drop-down menu, select More to display the Select Label dialog box.

6. Select a flow label template folder in the left pane of the dialog box, select a specific label name in the right pane, and then click OK.

7. Select a pipe object in the drawing to place the label.
If the arrow has a red-crossed circle over it, the selected pipe does not have flow direction defined.

8. Right-click to end the command.
9. Save your changes before exiting **SmartSketch Drawing Editor**.

**NOTES**

- To move the flow arrow after it has been placed, click and drag the arrow by its origin point, identified by the green circle in the middle of the flow arrow object.
- You can remove manual edits from a drawing using **Clear Manual Edits** 🪜 in **SmartSketch Drawing Editor**. For more information, see **Clear Manual Edits Command** (on page 341).
- Centerlines must display for pipelines before flow arrows can be placed.

**Dimensioned Label Command**

Places a label with dimension formatting. The dimension displays the label instead of a dimension value. **Dimensioned Label** is an option on the **Place a Label** 📝 ribbon. You can select **Distance Between**, **Coordinate Dimension**, **SmartDimension**, or **Angle Between** ✡️. For more information on the formatting of each dimension type, see **Distance Between Command**, **Coordinate Dimension Command**, **SmartDimension Command**, and **Angle Between Command** in the **SmartSketch Drawing Editor Help**.
Before selecting **Dimensioned Label**, you must select an appropriate label from **Label Specification** on the **Place a Label** ribbon. The following example shows a dimensioned label on a composed drawing. A **Distance Between** dimension is placed between two pumps with the **Equipment_Plane Equipment_Name** label selected.

![Piping Isometric Drawings Example](image)

**NOTE** Only two objects can be selected with **Dimensioned Label**. The label placed is determined by the first object you select, not the second.

**See Also**
- *Place a Dimensioned Label* (on page 299) (Marine mode only)
- *Place a Dimensioned Label* (on page 359) (Plant mode only)

**Place a Dimensioned Label**

This workflow demonstrates the ability to place a dimensioned label on a marine mode Steel Order drawing by placing a dimension-like label on two edges of a plate. For more information on dimensioned labels, see *Dimensioned Label Command* (on page 298).

1. Right-click a Steel Order drawing, and click **Edit** on the shortcut menu. The drawing opens in SmartSketch Drawing Editor.

2. On the toolbar, click **Place a Label**.

3. Use the **Object Filter** to enable only **Plate Parts** for selection.

4. In the **Label Name** drop-down menu, select the **Block Parent** label from the delivered Steel Order folder.

   **NOTE** To pick from a hierarchical list, select **More**.

5. Select the **Distance Between** dimension label command from the drop-down menu. The dimensioned label ribbon displays.

6. Select the edge of a plate that you want to label.

   **NOTE** The first selected object is labeled, not the second.

7. Select a second edge. For example, select the opposite edge of the plate you selected.

   **NOTE** The second point only determines how long the dimension line will be.
8. After selecting the second object, the correct label will display.

You can use custom dimension styles when placing dimension-like labels. For more information, see *Dimension Paper Space Objects for 3D Drawings* (on page 247) in the *SmartSketch Drawing Editor User’s Guide*.

9. Continue placing labels on the drawing if necessary.

10. Right-click to end the command.

11. Save your changes before exiting SmartSketch Drawing Editor.

**See Also**

*Dimensioned Label Command* (on page 298)
*Place a Manual Label* (on page 294)

**Group Selected Labels**

Groups existing labels so that you can move them as a unit. You can choose to stack the labels directly above one another, or stack them diagonally. This simplifies the final formatting of labels that Smart 3D generates automatically.

**Group Selected Labels Ribbon**

**Select by Labels**
 Indicates that the software selects labels to form the group. You can select the labels individually, by fence, or by dragging a line through the labels.

**Select by Objects**
 Indicates that the software selects objects to form the label group. You can select the objects individually, by fence, or by dragging a line through the objects.

**Labels Selection Filter**
 Specifies a filter to limit the labels you can select. The default option is *All*, which lets you select any label to add to your group. To refine the filter, select as many of the filters from the list as you need. You can select only those labels that match the filter.

**Leaderline On/Off**
 Specifies whether you want a leader line pointing to the object.
Leaderline Jog On/Off

Specifies whether a jog in the leader line is acceptable.

Leader Color

Defines the color of the leader line.

Selecting the Labels to Group

You have several options to select the labels to group. If you click Select by Labels, the software only lets you select labels. Click Select by Objects to select objects.

- Press CTRL, and then individually click the labels or objects to group.

- Drag a fence around the labels or objects to group. The fence must start and stop in empty space.

- Press CTRL, and then drag a line through the labels or objects to group. The line must start and stop in empty space.

The software places the group of labels without crossing the leader lines, even if the heights of the labels differ, and aligns the labels to the leader connection side.
The software sorts the labels so that no leaders in the group cross.

**NOTE** To change the distance between each label in the stack, your administrator can add a `<clearance>` tag to the label template.

```xml
<!--Positioning Settings-->
<posSettings>
</posSettings>
```

Clearance value of 0.0  Clearance value of 0.002

**Group existing labels**

1. In the Drawings console, right-click a drawing, and click **Edit** on the shortcut menu. The drawing opens for editing in **SmartSketch Drawing Editor**.

2. On the **Drawings Compose** toolbar, click **Group Selected Labels**.

3. Click **Select by Labels** or **Select by Objects** to indicate how you want to make the selections for the group.

4. If necessary, select filters to refine the **Label Filter**, and then click **Close**.

5. Use the tools on the ribbon to specify the leader for the labels. For more information, see **Group Selected Labels** (on page 300).

6. Select the labels or objects to group. You can use any of the following techniques:
Press CTRL, and then individually click the labels or objects to add to the group.

Drag a fence around the labels or objects to group. The fence must start and stop in empty space.

Press CTRL, and then drag a line through the labels or objects to group. The line must start and stop in empty space.

The software displays a blue preview outline to give you an approximation of the size of the stacked labels. The preview moves with the cursor.

7. If necessary, press CTRL to change the preview from stacked to diagonal.
8. Click the location for the relocated labels.

To diagonally space the labels, press CTRL and click to indicate the location.

**Place Detail Envelope Command**

Creates a detail view for an existing drawing view. Detail views are more than enlargements of the main drawing view. They often contain additional graphical information that is not visible in the main drawing view, such as weld or chalk information. You specify the detail view by drawing a circle or polygon around a portion of the main drawing view. The shape created is called the *detail envelope*. The **Place Detail Envelope** command is only available in **SmartSketch Drawing Editor** when you create a new Composed drawing or open an existing Composed drawing from a 3D task. For example, the following graphic shows the main drawing view and a detail view:
When you select an existing detail envelope, it highlights within the drawing view and the Edit ribbon appears so you can make modifications to the selected cutting plane. To place a detail envelope, select a drawing view and click the **Place Detail Envelope** command.

**Callouts**

Detail envelopes use callouts, or labels, that match the caption for the associated detail view. By default, the command places callouts in a fixed position on the main drawing view when you place the detail envelope. You can click-and-drag the callout to a new position, if necessary.

Callouts do not highlight when you select the detail envelope. You select callouts separate from the detail envelope.

**Handles**

Handles help you modify the shape and placement of the detail envelopes. Circle detail envelopes have two handles, a center point and an edge handle. The center point handle allows you to move the circle, while the edge handle allows you to change the size and shape of the circle. Polygon shapes have handles at each vertex. You can use the handles to move and change the shape of the polygon shape.

After you modify a detail envelope, click **Finish** to save the changes.

**Delete Behavior**

To delete a detail envelope, select it and press **Delete**. Deleting the detail envelope does not affect the drawing view. However, if there is an associated detail view, a message displays, asking if you want to convert the detail view to a normal drawing view or delete it with the detail envelope.

**NOTE** You can place detail envelopes inside section views and detail views.
See Also
Place Cutting Plane Ribbon (on page 309)
Place Detail Envelope Command (on page 304)
Place Detail Envelope Ribbon (on page 306)
Edit Detail Envelope Ribbon (on page 306)

Place Detail Envelope Ribbon

Sets options when placing a new detail envelope. This ribbon displays when you select a drawing view, then click Place Detail Envelope in the toolbar area.

If you are editing an existing detail envelope, the Edit Detail Envelope ribbon appears. For more information, see Edit Detail Envelope Ribbon (on page 306).

- Circle - Specifies that you want to draw a round detail envelope shape.
- Polygon - Specifies that you want to draw a polygon detail envelope shape.

Reference mark - Displays the reference text below the detail view and on the detail view callout on the main drawing view.

Additional callout text - Provides a second line of text for the detail view callout.

See Also
Place Detail Envelope Command (on page 304)

Edit Detail Envelope Ribbon

Sets options when editing an existing detail envelope. This ribbon displays when you select a detail envelope on the drawing sheet, then click Place Detail Envelope in the toolbar area. If you have more than one detail envelope selected, this ribbon is disabled.

If you are placing a new detail envelope, the Place Detail Envelope ribbon appears. For more information, see Place Detail Envelope Ribbon (on page 306).

Reference mark - Displays the reference text below the detail view and on the detail view callout on the main drawing view.

Additional callout text - Provides a second line of text for the detail view callout.

NOTE The Reference mark and Additional callout text always show the current values for the detail envelope. The fields are disabled if the detail envelope is associated with a detail view.

See Also
Place Detail Envelope Command (on page 304)
Place a Detail Envelope

The following steps describe the basic workflow for placing a detail envelope on a drawing view.

1. In the 3D application, edit a drawing document. The drawing opens in SmartSketch Drawing Editor.

2. In the drawing document, select a drawing view. Zoom in on the area of the main drawing view to the location you want to place the detail envelope geometry.

3. In the toolbar area, click Place Detail Envelope 📦. The Place Detail Envelope ribbon appears in the toolbar area.

4. Click Circle ⭕ or Polygon 🗻 so you can begin placing points to define the detail envelope. For more information, see Place Detail Envelope Ribbon (on page 306).

5. Click points as needed to create the detail envelope geometry. If you are creating a polygon shape for your detail envelope, complete the polygon by moving the cursor over the starting point until the Close Polygon symbol appears, then click to close the polygon.

Edit a Detail Envelope

To edit an existing detail envelope, select the detail envelope. The Edit Detail Envelope ribbon appears so you can edit the settings on the detail envelope.

For more information on working with detail envelopes, see Place Detail Envelope Command (on page 304).
Place Cutting Plane/Section View Command

创建工作图和报告与智能素描绘图编辑器

在绘图视图上创建切割平面。工作平面是一个注释标记，指示要从一个区域中切片所需的组和查看该切片的方向。切割平面由一个或多个线段组成。当由多个线段组成时，切割平面也称为“弯角”切割平面。Place Cutting Plane命令仅在SmartSketch绘图编辑器中可用时创建新的绘图或编辑从3D任务创建的绘图。例如，以下图形显示了绘图视图、切割平面和派生的剖视图：

您只能创建从绘制在有效图形视图上的切割平面派生的视图。有效图形视图包括正常视图、剖视图、详图视图和快照视图，但不包括基线视图。有效图形视图必须与模型中的体积相关联，并至少更新一次。如果您删除包含切割平面的绘图视图，则切割平面也会被删除。会显示一个确认消息，询问您是否要将关联的剖视图转换为普通视图或也删除它们。

一旦定义了切割平面，光标上就会出现一个绘图视图。点击将视图放置在绘图表上。有关更多信息，请参阅Place a Cutting Plane/Section View（在第312页）。

当您选择切割平面时，它会以高亮显示，同时会出现Editribbon，您可以对选中的切割平面进行修改。要放置切割平面，请选择有效的绘图视图并点击Place Cutting Plane命令。您也可以首先选择该命令并选择视图。

单个段切割和弯角切割平面具有端点、中点和深度点。您可以更改选定切割平面的几何形状，拖动其句柄。
Dragging a mid-point handle moves the associated line segment, maintaining its length and slope while altering any adjacent line segments. Dragging a vertex or end-point alters the length and/or slope of the attached line segment(s). Dragging a depth handle alters the depth of the associated section view.

You can move a single-segment cutting plane by clicking and dragging its mid-point handle to the new position. You can move a jogged cutting plane by clicking on a point of the line segment and dragging it; do not click a handle to move the jogged cutting plane.

After modifying a cutting plane, click **Finish** to save the changes. Selecting the **Update section** check box will cause an update of the related section view when the **Finish** button is clicked. The **Update section** option is remembered globally for all section views.

To delete a cutting plane, select it and press the DELETE key. Deleting the cutting plane does not affect the drawing view, but if there is an associated section view, you are asked if you want to convert the section view to a normal drawing view or delete it as well.

**Shortcut Menu**

When you select an existing cutting plane, you can right-click to get the cutting plane shortcut menu. The shortcut menu allows you to make the following modifications to the cutting plane: **Bring to Front, Send to Back, Pull Up, and Push Down**.

**See Also**

*Place Cutting Plane Ribbon* (on page 309)
*Place a Cutting Plane/Section View* (on page 312)
*Section View Orientation Rules in Drawings by Rule* (on page 380)

**Place Cutting Plane Ribbon**

Sets options when placing a cutting plane. This ribbon displays when you select a drawing view. Click **Place Cutting Plane** command to place a new cutting plane.

**Reference 1** - Displays the text shown for the first arrow of the cutting plane.

**Reference 2** - Displays the text shown for the second arrow of the cutting plane.

**NOTE** The **Reference 1** is always assigned to the point of the cutting plane that you placed first, while the **Reference 2** text is always assigned to the point of the cutting plane that you placed last.

**Depth** - Sets the depth of the cutting plane. This box only accepts positive values.
See Also
Place Cutting Plane/Section View Command (on page 308)
Place Section View Ribbon (on page 310)
Place a Cutting Plane/Section View (on page 312)

Place Section View Ribbon

Sets options when placing a section view. This ribbon displays after you have completed the placement of a cutting plane.

Update section
When checked, the section view updates after it is placed. This option is unchecked by default, but the last setting is saved as a session file preference.

View Style
Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the Select View Style dialog box.

NOTE Changing the view style for the section view can result in symbology different from that used in the parent view.

View Scale
Sets the scale family and scale used for the section view. The default scale setting is inherited from the parent view.

See Also
Place Cutting Plane/Section View Command (on page 308)
Place Cutting Plane Ribbon (on page 309)
Place a Cutting Plane/Section View (on page 312)

Edit Cutting Plane Ribbon

Sets options when editing a cutting plane. This ribbon displays when you select an existing cutting plane that is associated with a section view.

Finish - Saves the changes to the cutting plane. If the cutting plane is associated with a section view, the section view contents change if the Update section check box is selected.

Update section - When checked, the section view updates after it is placed. This option is not checked by default, but the last setting is remembered as a session file preference.

Reference 1 - Displays the text shown for the first arrow of the cutting plane.

Reference 2 - Displays the text shown for the second arrow of the cutting plane.

Depth - Sets the depth of the cutting plane. This box only accepts positive values.

See Also
Place Cutting Plane/Section View Command (on page 308)
Place Cutting Plane Ribbon (on page 309)
**Edit Section View Ribbon**

Sets options when editing a section view. This ribbon displays when you select a section view.

**Properties**

Opens the Drawing View Properties dialog box, allowing you to change the properties of a drawing view. For more information, see Drawing View Properties Dialog Box (Place View Command) - Steel Order Drawings (on page 260).

**Finish**

Saves the changes to the section view.

**Update section**

When checked, the section view updates when you select Finish. This option is unchecked by default, but the last setting is remembered as a session file preference.

**View Style**

Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the Select View Style dialog box.

**NOTE** Changing the view style for the section view can result in symbology different from that used in the parent view.

**View Scale**

Sets the scale family and scale used for the section view. The default scale setting is inherited from the parent view.

**Rotate**

Rotates the section view clockwise by multiples of 90 degrees. When the view is rotated, user-placed and user-modified dimensions in the section view are deleted.

**NOTE** To rotate a section view, you must bulkload the following files to the database:

- [Product Folder]\CatalogData\BulkLoad\AdditionalDataFiles\Delta2009.1to2011\1_AMD_Delta_2009.1_2011_Drawings.xls
- [Product Folder]\ShipCatalogData\BulkLoad\AdditionalDataFiles\DeltaSMV2011toV2011SP1\1_AMD_Delta_V2011_2011SP1_SM_ShipDrawings.xls. (Marine mode only)

**See Also**

Place Cutting Plane/Section View Command (on page 308)
Place Section View Ribbon (on page 310)
Place a Cutting Plane/Section View

Follow the general steps below to place a cutting plane on a drawing view.

1. In a 3D application, edit a drawing document. The drawing opens in SmartSketch Drawing Editor.
2. In the drawing document, select a drawing view.
3. In the toolbar area, click Place Cutting Plane. The Place Cutting Plane ribbon appears in the toolbar area. For more information, see Place Cutting Plane Ribbon (on page 309).
4. On the Place Cutting Plane ribbon, type the names for the reference text string you want shown on the cutting plane.
5. Click the first point in the line string, then proceed entering as many points as you need to define the cutting plane geometry.
   
   NOTE: Jogged cutting planes are not supported in Ruleset drawings.
6. Right-click when you have finished defining the cutting plane line segments and are ready to define the depth of the cutting plane.
7. To change the view direction, move the cursor to the appropriate side of the cutting plane. The direction automatically changes according to which side of the cutting plane segment the cursor is on.
8. Click to define the section depth and view direction. You can also key in a value in the Depth field and click to define the view direction. The value displayed in the Depth field is defined in model space, not paper space.

The drawing view automatically appears on your cursor.

NOTES:

- Selecting the Update section check box will cause an update of the related section view when the view is placed. This option is not checked by default, but the last setting is saved as a session file preference.
- The section view inherits the scale from the parent view by default.
- You can change the View Style or View Scale before placing the view.

1. Click to place the view on the sheet.

Edit a Cutting Plane

- To edit an existing cutting plane, select the cutting plane. The Edit Cutting Plane ribbon appears so you can edit the settings on the cutting plane. For more information, see Edit Cutting Plane Ribbon (on page 310).

Edit a Section View

- To edit an existing section view, select the section view. The Edit Section View ribbon appears so you can edit the settings on the section view. For more information, see Edit Section View Ribbon (on page 311).
Delete a Cutting Plane or Section View

- To delete a cutting plane, select it and press the DELETE key. If the cutting plane has an associated section view, a confirmation box appears allowing you to either convert the section view to a normal drawing view or delete the section view with the cutting plane.
- To delete a section view, select it and press the DELETE key. The associated cutting plane line remains, but only as a paper space graphic.

For more information on working with cutting planes, see *Place Cutting Plane/Section View Command* (on page 308).

**Section View Orientation Rules in Orthographic Drawings**

**Section View Orientation Behavior**

The software automatically determines the "up" direction for section views. In most cases, the up direction is "up," or +Z. In cases where using +Z is impossible (for example, if the section view direction is Looking Plan or Looking Up.), the software orients the view to the North direction.

The following examples outline common section view orientations:

**Looking Plan**

![Diagram showing section view orientations](image)
Looking East | Looking South | Looking South, East
--- | --- | ---
Up direction is up. | Up direction is up. | Up direction is up.

Looking North

E1 Cutting Plane | E2 Cutting Plane | E3 Cutting Plane
--- | --- | ---
Looking South | Looking Plan | Looking South, Plan
Up direction is up. | Up direction is North. | Up direction is up.
Looking East

<table>
<thead>
<tr>
<th>E4 Cutting Plane</th>
<th>E5 Cutting Plane</th>
<th>E6 Cutting Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking South</td>
<td>Looking Plan</td>
<td>Looking South, Plan</td>
</tr>
<tr>
<td>Up direction is up.</td>
<td>Up direction is North.</td>
<td>Up direction is up.</td>
</tr>
</tbody>
</table>
Place a Section View

The following procedure describes editing a drawing document to add a section view.

Section views are extracted from main drawing views or other section views. Section views are similar to detail views, except that they display information in an orientation that is different from that of the originating view. The cutting plane is an annotation marker that indicates where to slice a needed group of objects and from which direction to look at that slice. The cutting plane is comprised of one or more line segments. When comprised of multiple line segments, cutting planes are referred to as "jogged" cutting planes.

NOTES

- For more information on the SmartSketch Drawing Editor commands used in this procedure, see Place Detail Envelope Command (on page 304) and Place Cutting Plane/Section View Command (on page 308) in the SmartSketch Drawing Editor Help.
- For information on the toolbar used in this procedure, see Drawings Compose Toolbar (on page 254) in the SmartSketch Drawing Editor Help.
- For information on the 2D commands available for editing, see the SmartSketch Drawing Editor Help.

Place a Cutting Plane

The following steps describe the basic workflow for placing a cutting plane on a drawing view used in creating a section view.

1. Open a drawing in SmartSketch Drawing Editor.
2. Click Cutting Plane on the toolbar.
3. In the drawing document, select a drawing view.
4. Type in text for the first arrow of the cutting plane in Reference 1. Type in text for the second arrow of the cutting plane in Reference 2.
5. To define the length of the cutting plane segment, click in the view to define the location of the first point, then click to define the location of the second point.
The cutting plane segment displays on the drawing, with arrows showing the default view direction.

6. To jog the cutting plane, click to define additional line segments. When you are ready to define the depth, right-click to proceed to the next step.

**NOTE** The cutting plane jogging behavior is not available in Ruleset drawings.

7. To change the view direction, move the cursor to the appropriate side of the cutting plane.

*The direction automatically changes according to which side of the cutting plane segment the cursor is on.*

**NOTE** The view direction is always perpendicular to the first cutting plane segment.

8. To define the section depth, click to define the distance and view direction. You can also key in a value in **Depth** and click to define the view direction.

**NOTE** The section depth is defined in model space, not paper space.

The drawing view automatically displays on your cursor.

![View Options](image)

**NOTE** Selecting the **Update section** check box causes an update of the related section view when the view is placed. The **Update section** option is remembered globally for all section views.

**TIP** You can change the **View Style** or **View Scale** before placing the view.

9. Click to place the view on the sheet.

**NOTE** The child view inherits the scale from the parent view by default.

**Modify the Width, Depth, and Location of a Cutting Plane**

The following steps describe the basic workflow for modifying the width of a cutting plane.

1. Open a drawing in **SmartSketch Drawing Editor**.

2. Click on an existing cutting plane.

*The Edit Cutting Plane ribbon displays in the toolbar area.*

3. Click and drag the outside handles of the cutting plane segment in order to change its length.

**NOTES**

- The cutting plane handles correspond to the sides of the section view that are opposite to the section view depth handles. Changing the overall length of a cutting plane changes the corresponding sides of the related section view.
- In the case of a jogged cutting plane, each cutting plane segment will have its own modification handles.

4. To change the location of the cutting plane segment, click and drag the middle handle that lies between the width handles.

**NOTE** To change the location of an entire jogged cutting plane, click and drag the line segment; do not click a handle to move the jogged cutting plane.
5. Click and drag the handle opposite of the location handle to modify the cutting plane depth. You can also key in a value in **Section depth** and click in the view to define the view direction.

**Single Cutting Plane**

![Single Cutting Plane Diagram]

**Jogged Cutting Plane**

![Jogged Cutting Plane Diagram]

**NOTE**: Selecting the **Update section** check box causes an update of the related section view when the **Finish** button is selected. The **Update section** option is remembered globally for all section views.

6. When the appropriate changes have been made to the cutting plane, select **Finish** in the **Edit Cutting Plane** ribbon.

7. Right-click the view and select **Update**.

**Modify the Size of a Section View**

The following steps describe the workflow for modifying the size of an existing section view.

1. Open a drawing in **SmartSketch Drawing Editor**.
2. Click on an existing section view.
The *Edit Section View* ribbon displays in the toolbar area.

![Edit Section View Ribbon](image)

**NOTE** The ribbon allows you to change the **View Style** and **View Scale**, as well as edit the **View Properties**.

3. Click and drag the handles on the top and bottom (or left and right sides) of the section view in order to change the view size.

**NOTE** Selecting the **Update section** check box causes an update of the section view when the **Finish** button is selected. The **Update section** option is remembered globally for all section views.

4. When the appropriate changes have been made to the volume size, select **Finish** in the **Edit Section View** ribbon.

5. Right-click the view and select **Update**.

### Place Detail View Command

**Primary**

Creates a detail view based on the selected detail envelope. A detail view is extracted from a main drawing view, a section view, or another detail view.

The drawing view style defines how objects appear in the detail views.

**NOTE** Detail views are based on detail envelopes. For more information, see *Place Detail Envelope Command* (on page 304).

### Edit Detail View Properties

You can edit the properties associated with the detail view. When you access the properties through one of the following methods, the **Drawing View Properties** dialog box appears. For more information, see *Drawing View Properties Dialog Box (Drawing View Shortcut Menu)* (on page 345).

- Right-click the view and select **Properties** on the shortcut menu.
- Select the view, then select **Edit > Properties**.

### Delete Behavior

To delete a detail view, select it and press **Delete**. Deleting the detail view does not delete the corresponding detail envelope.

**See Also**

*Place Cutting Plane Ribbon* (on page 309)
*Place a Detail View* (on page 320)
*Place Detail View Ribbon* (on page 320)
**Place Detail View Ribbon**

Sets options when placing or editing a detail view. This ribbon displays when you select a detail envelope, then click **Place Detail View**.

For information on placing detail envelopes, see **Place Detail Envelope Command** (on page 304).

**Sheet Name**

Indicates the drawing sheet where the detail view is placed. By default, the detail view is placed on the same sheet as the main drawing view.

**View Style**

Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click **More...** to display the **Select View Style** dialog box.

**NOTE** Changing the view style for the detail view can result in symbology different from that used in the parent view.

**View Scale**

Sets the scale family and scale used for the detail view. The default scale setting is inherited from the parent view.

**See Also**

**Place Detail Envelope Command** (on page 319)

**Place a Detail View**

The following procedure steps you through editing a drawing document to add a detail view.

A detail view is extracted from a main drawing view, a section view, or another detail view. Detail views are more than enlargements of the main drawing view. They often contain additional graphical information that is not visible in the main drawing view, such as weld or chalk information. You specify the detail view by drawing a circle or polygon around a portion of the main drawing view. The shape created is called the **detail envelope**.

**NOTES**

- For more information on the SmartSketch Drawing Editor command used in this procedure, see **Place Detail Envelope Command** (on page 304).
- For information on the toolbar used in this procedure, see **Drawings Compose Toolbar** (on page 254).
- For information on the 2D commands available for editing, see the **SmartSketch Drawing Editor Help**.

**Place a Detail Envelope**

The following steps describe the basic workflow for placing a detail envelope on a drawing to be used in creating a detail view.

**NOTE** **Detail Envelope** is only available when you create or open a Composed drawing from a 3D task.
1. Right-click a Composed drawing document in the **Detail View** and select **Edit**.

   *The drawing opens in SmartSketch Drawing Editor.*

2. Click **Detail Envelope** on the toolbar.

   *The Place Detail Envelope ribbon bar displays.*

3. In the drawing document, select a drawing view. Zoom in on the area of the main drawing view to the location you want to place the detail envelope geometry.

4. Click **Circle** or **Polygon** so you can begin defining the detail envelope.

5. Type the text for the detail view name in **Reference mark**. If a second line of text is needed, type the text in **Additional callout text**.

6. For a **Circle** detail envelope, click at the center of the circle, drag for the radius, and click again to set the radius.

7. For a **Polygon** detail envelope, click points as needed to create the detail envelope geometry. Complete the polygon by moving the cursor over the starting point until the **Close Polygon** symbol displays, then click to close the polygon.

8. You can now use this detail envelope to place a detail view in the drawing.

**Place a Detail View**

The following steps describe the basic workflow for placing a detail view based on a detail envelope.

1. Right-click a drawing document in the **Detail View** and select **Edit**.

   *The drawing opens in SmartSketch Drawing Editor.*

2. In the drawing document, select a detail envelope to place a detail view. Select from the drawing area or in the Drawing View Explorer.

3. Click **Place Detail View** on the toolbar.

   *The Place Detail View ribbon bar displays.*

4. On the **Place Detail View** ribbon, make sure the settings are appropriate for your new detail view:

   - **Sheet Name** is disabled. By default, the view must be on the same sheet as the detail envelope.
   - Specify the **View Style** used for the view contents. Select **More** in the **View Style** list to view more style options.
   - Set the **View Scale** as needed. By default, the scale for the detail view is **Fit to Scale**.

5. Drag the preview outline of the view in the drawing area to the needed location. Click to place the view.

   *An outline of the view is placed.*

6. Right-click the view in the drawing area and select **Update View**.

   *Geometry, labels, and other annotations as defined by the view style display in the view.*

7. Crop the view as needed by selecting the view and dragging the handles on the sides of the view.
Delete a Detail Envelope from a Drawing

1. Right-click a drawing document in the **Detail View** and select **Edit**.
   
   The drawing opens in SmartSketch Drawing Editor.

2. If a detail view has not been created, right-click a detail envelope in the Drawing View Explorer and select **Delete**.

3. If a detail view has been created, right-click the detail envelope and select **Delete**.
   
   The **Convert or Delete** dialog box displays.

4. To convert the existing view(s) associated to the detail envelope to an independent view(s), select the **Convert to independent drawing view(s)** option and click **OK**. To delete the existing drawing view(s) associated to the detail envelope, select the **Delete** option and click **OK**.

Delete a Detail View from a Drawing (Marine mode only)

1. Right-click a drawing document in the **Detail View** and select **Edit**.
   
   The drawing opens in SmartSketch Drawing Editor.

2. In the Drawing View Explorer, right-click a view assigned to a drawing and select **Delete**.

3. Select **Delete** to delete the view permanently, or select **Unassign** to move the view in the **Unassigned Folder**.

**NOTES**

- You can either move a view created by rules to the **Unassigned Folder** or permanently delete a view.

- If you delete a view that is a parent of other views, such as a detail or section view, the **Convert or Delete** dialog box displays. Select **Convert to independent drawing view(s)** to save the child view as an independent drawing view, or select **Delete** to delete the child view. The view is deleted.

- When a view is out-of-date, the view icon looks like this: ![icon_outdated](image).

- When a view is up-to-date, the view icon looks like this: ![icon_up_to_date](image).

- When a view is unassigned and in the **Unassigned Folder** of Drawing View Explorer, the view icon looks like this: ![icon_unassigned](image).

2D/3D Selection Command

- Allows you to move back and forth between the SmartSketch Drawing Editor application window and the 3D window. This command is only available in SmartSketch Drawing Editor when you create a new drawing or open an existing drawing from a 3D task. This command is turned off by default when you open a document in the SmartSketch Drawing Editor.

**Behavior while Turned On (Object Select/Highlight Mode)**

When the command is on, you can select geometry in a drawing view, and the software highlights and selects the corresponding object in the 3D model. The object is selected even if it is not currently visible or displayed in the 3D workspace. If you select an object in the 3D task window,
the software highlights the corresponding geometry in the drawing view in SmartSketch Drawing Editor. However, if the object is not included in the drawing view, no geometry highlights. The filters in the drawing view style dictate the content of the drawing view.

You can also multi-select 2D objects (groups and views) using the **CTRL** key.

**NOTE** If you select a drawing view (instead of geometry in the view), the 2D/3D Selection command turns off automatically and the Associate Objects to View command is active. You can then modify the volumes or views associated to the selected view. For more information, see Associate Objects to View Command (on page 276).

**Behavior while Turned Off (View Input Mode)**

The command is off by default when you open a drawing.

When this command is off, geometry selected in a view is not actively linked to its 3D model object and the drawing document is in view input mode. You can modify the layout and contents of the drawing sheet and the properties of the drawing views.

**NOTE** When 2D/3D Selection is off, you can click Associate Objects to View, then move back and forth between the 3D application and SmartSketch Drawing Editor to associate drawing views to volumes in the model. For more information, see Associate Objects to View Command (on page 276).

**Considerations for Using the 2D/3D Selection Command**

- **2D/3D Selection**, by default, only allows selection of 2D group elements that correspond to 3D model objects.

- You can use the spacebar key to toggle the selected drawing view when this command is used to associate objects to objects in the model. For more information, see Associate Objects to View Command (on page 276).

- Selecting a smart label in a SmartSketch Drawing Editor document selects the associated 3D object in the 3D application.

- Selecting a volume in the 3D application selects the associated views in the SmartSketch Drawing Editor document.

- The 2D select set is cleared when you close the drawing document.

**Compare 2D Drawing Object to 3D Model Object**

The following steps show you how to compare drawing objects to 3D model objects.

1. In a 3D modeling task, such as Common, select **Tools > Drawings Console**.

2. Right-click a drawing document and select **Edit** to open a drawing document in **SmartSketch Drawing Editor**.

3. In **SmartSketch Drawing Editor**, zoom into a drawing view to select the drawing object you want to compare to the 3D model.
4. Click **2D/3D Selection** to move focus to the 3D application. The 3D model object selects and highlights in the graphic windows.

Considerations for Using the 2D/3D Selection Command

The **2D/3D Selection** command, by default, only allows selection of 2D group elements that correspond to 3D model objects.

- You can use the spacebar key to toggle the selected drawing view when this command is used to associate objects to objects in the model.
- Selecting a SmartLabel in **SmartSketch Drawing Editor** document selects the associated 3D object in the 3D application.
- Selecting a volume in the 3D application selects the associated views in the **SmartSketch Drawing Editor** document.
- The 2D select set is cleared when you close the drawing document.

For more information on the commands available in **SmartSketch Drawing Editor**, see the **SmartSketch Drawing Editor Help**. You can also refer to the **Common User's Guide** for information on the **Tools > Drawings Console** command.

Using Scaled Sketching

In drawings, you can have multiple embedded views on a drawing sheet that are at different model scales (e.g. 1/4” = 1’ and 1/8” = 1’). You can add graphics to the views and treat them as if they were actual model graphics. Use the Scaled Sketching command to draw all graphics at a consistent scale factor. The scale factor used is based on a user-selected SmartFrame.

For more information, see **Dimensioning Drawing Elements** in the **SmartSketch Drawing Editor User's Guide**.

See Also

- Scaled Sketching Command (on page 326)
- Scaled Sketching Ribbon (on page 326)
- Draw or Edit Objects at the Same Scale Factor (on page 325)
- Move a View with Scaled Sketching Objects (on page 326)
Draw or Edit Objects at the Same Scale Factor

Follow the steps below to use the Scaled Sketching command to draw or edit objects at a specific scale factor.

**NOTE** Make sure you have added the Scaled Sketching command to your Smart 3D toolbar. See Add the Scaled Sketching Button to the Smart 3D Toolbar.

1. Click **Scaled Sketching** to open the **Scaled Sketching** ribbon.

   ![Scaled Sketching Ribbon](on page 326)

2. To set the color of any objects not being edited using the scale factor, click **Select color for referenced data**. Click on the desired color from the color palette.

3. Insert a SmartFrame (see Working with Object, Linking and Embedding) and set the scale factor of the SmartFrame, or click on an existing SmartFrame. The scale is read and taken from that SmartFrame. The selected scale type is displayed in the **Scaled Sketching** ribbon.

   **IMPORTANT**
   - Do not create or edit any layers when using the scaled sketching command.
   - To get accurate dimensional data about scaled objects, be sure to dimension them while in scaled sketching mode. The dimensions are automatically configured to display at the value in which they were drawn.

4. Click **Enter Scaled Sketch mode** to start drawing at the selected scale.

   *The system scales the drawing sheet to match the specified scale value.*

5. Use the application’s drawing/editing commands to draw the desired graphics.

6. Click **Finish** to end the selected scale mode.

   **NOTES**
   - The only way to exit scaled sketching is to click Finish. All modifications you made in the document are retained.
   - Whenever you finish using scaled sketching, the undo history is cleared and you cannot undo any previous edits. The Undo command becomes enabled once you continue working in SmartSketch Drawing Editor.
Leaders must be placed on objects (Labels, Text Boxes, and so forth) that were placed during Scaled Sketch mode. If the objects were not placed during Scaled Sketch mode, the leader is not remembered in the SmartFrame after the view is updated.

**Scaled Sketching Command**

Enables you to edit or draw new objects at a scale that is different from the drawing scale for the active sheet. You can select a SmartFrame in the current document. The system then uses the scale factor of that SmartFrame.

**See Also**

*Draw or Edit Objects at the Same Scale Factor* (on page 325)

**Scaled Sketching Ribbon**

The Scaled Sketching ribbon displays when you click **Scaled Sketching** on the Smart 3D Drawings Compose toolbar.

**Select color for referenced data** - displays a color palette for you to set the color of any objects not being edited using the scale factor.

**Scale Setting** - displays the scale taken from the selected SmartFrame.

**Enter Scaled Sketch Mode** - starts the system in using the scale factor for objects being drawn or edited.

**Finish** - ends the scale mode.

**See Also**

*Scaled Sketching Command* (on page 326)

*Draw or Edit Objects at the Same Scale Factor* (on page 325)

**Move a View with Scaled Sketching Objects**

Follow the steps below to move a View that has objects drawn with the Scaled Sketching command.

1. If you are using the Scaled Sketching command, exit the command.
   
   **NOTE** You cannot move a view while using the Scaled Sketching command.

2. Press **ALT** and click on the view you want to move.

3. Release **ALT**.

4. Move the view to a new location.

When you press and release **ALT** while clicking on the view, all of the Scaled Sketching objects move with the view.
Draw a Grate Opening with Scaled Sketching

Follow the steps below to use the Scaled Sketching command to draw a grate opening in a slab at a specific scale factor.

1. From the Drawings environment, open a drawing. In this example, the drawing contains equipment.

2. Click Scaled Sketching to open the Scaled Sketching ribbon.

3. Click Select color for referenced data to set the color of any objects not being edited using the scale factor.

4. Click the SmartFrame in which you would like to sketch. The scale automatically matches the SmartFrame scale.

5. Click Enter Scaled Sketch mode to start drawing at the selected scale.

   *The system scales the drawing sheet to match the specified scale value.*

6. Use the Rectangle tool to draw an opening on the slab.
7. Use the Fill tool to place a Grid fill in the opening.

8. Click Finish to end the selected scale mode.

**NOTES**
- Any objects drawn while in Scaled Sketching mode will move with the view if it is moved.
- The only way to exit scaled sketching is to click Finish. All modifications you made in the document are retained.
- Whenever you finish using scaled sketching, the undo history is cleared and you cannot undo any previous edits. The Undo command becomes enabled once you continue working in SmartSketch Drawing Editor.

**Draw a Centerline with Scaled Sketching**

Follow the steps below to use the Scaled Sketching command to draw a centerline on an equipment object at a specific scale factor.

1. From the Drawings environment, open a drawing. In this example, the drawing contains equipment.

2. Click Scaled Sketching to open the Scaled Sketching ribbon.

3. Click Select color for referenced data to set the color of any objects not being edited using the scale factor.

4. Click the SmartFrame in which you would like to sketch. The scale automatically matches the SmartFrame scale.

**IMPORTANT**
- Do not create or edit any layers when using the scaled sketching command.
- To get accurate dimensional data about scaled objects, be sure to dimension them while in scaled sketching mode. The dimensions are automatically configured to display at the value in which they were drawn.
5. Click **Enter Scaled Sketch mode** to start drawing at the selected scale. 

   *The system scales the drawing sheet to match the specified scale value.*

6. Use the **Line** tool to draw a centerline on the equipment.

7. Use the **Distance Between** tool to place a dimension between the two equipment centerlines.

8. Click **Finish** to end the selected scale mode.

**NOTES**

- Any objects drawn while in Scaled Sketching mode will move with the view if it is moved.
- The only way to exit scaled sketching is to click Finish. All modifications you made in the document are retained.
- Whenever you finish using scaled sketching, the undo history is cleared and you cannot undo any previous edits. The Undo command becomes enabled once you continue working in SmartSketch Drawing Editor.
Draw a Textured Fill with Scaled Sketching

Follow the steps below to use the Scaled Sketching command to draw a grate opening in a slab at a specific scale factor.

1. From the Drawings environment, open a drawing. In this example, the drawing contains equipment.

2. Click Scaled Sketching to open the Scaled Sketching ribbon.

3. Click Select color for referenced data to set the color of any objects not being edited using the scale factor.

4. Click the SmartFrame in which you would like to sketch. The scale automatically matches the SmartFrame scale.

   **IMPORTANT**
   - Do not create or edit any layers when using the scaled sketching command.
   - To get accurate dimensional data about scaled objects, be sure to dimension them while in scaled sketching mode. The dimensions are automatically configured to display at the value in which they were drawn.

5. Click Enter Scaled Sketch mode to start drawing at the selected scale.

   *The system scales the drawing sheet to match the specified scale value.*

6. Use the Fill tool to place an Earth fill texture inside a shape.

   ![Earth fill texture]

   **TIP** You can also draw your own fill using Scaled Sketching. Below is an example of a manually drawn concrete fill.

   ![Concrete fill]

7. Click Finish to end the selected scale mode.

   **NOTES**
   - Any objects drawn while in Scaled Sketching mode will move with the view if it is moved.
Working with Drawings and Reports and SmartSketch Drawing Editor

- The only way to exit scaled sketching is to click **Finish**. All modifications you made in the document are retained.

- Whenever you finish using scaled sketching, the undo history is cleared and you cannot undo any previous edits. The Undo command becomes enabled once you continue working in SmartSketch Drawing Editor.

- Fills can be placed while in scaled sketching mode if they are bounded by view objects, scaled sketch objects, or a combination of both.

- Fills are automatically deleted when you click **Finish** on the Scaled Sketching toolbar and:
  - Use scaled sketching for view A and place a fill on a scaled sketch object in view B.
  - Use scaled sketching for view A and place a fill on an object in view B.
  - Use scaled sketching for a view and place a fill on a non-scaled sketch, manually-drawn graphic.

**Draw Rebar with Scaled Sketching**

1. From the Drawings environment, open a drawing. In this example, the drawing contains equipment.
2. Click **Scaled Sketching** to open the **Scaled Sketching** ribbon.
3. Click **Select color for referenced data** to set the color of any objects not being edited using the scale factor.
4. Click the SmartFrame in which you would like to sketch. The scale automatically matches the SmartFrame scale.
   **IMPORTANT**
   - Do not create or edit any layers when using the scaled sketching command.
   - To get accurate dimensional data about scaled objects, be sure to dimension them while in scaled sketching mode. The dimensions are automatically configured to display at the value in which they were drawn.
5. Click **Enter Scaled Sketch mode** to start drawing at the selected scale.
   *The system scales the drawing sheet to match the specified scale value.*
6. Use the tools in the Draw toolbar to draw rebar-reinforced concrete.

7. Click Finish to end the selected scale mode.

**NOTES**

- Any objects drawn while in Scaled Sketching mode will move with the view if it is moved.
- The only way to exit scaled sketching is to click Finish. All modifications you made in the document are retained.
- Whenever you finish using scaled sketching, the undo history is cleared and you cannot undo any previous edits. The Undo command becomes enabled once you continue working in SmartSketch Drawing Editor.

**Draw an Opening in a Plate with Scaled Sketching**

Follow the steps below to use the Scaled Sketching command to draw an opening in a plate at a specific scale factor.

1. From the Drawings environment, open a drawing. In this example, the drawing contains equipment.

2. Click Scaled Sketching to open the Scaled Sketching ribbon.

3. Click Select color for referenced data to set the color of any objects not being edited using the scale factor.

4. Click the SmartFrame in which you would like to sketch. The scale automatically matches the SmartFrame scale.

**IMPORTANT**

- Do not create or edit any layers when using the scaled sketching command.
- To get accurate dimensional data about scaled objects, be sure to dimension them while in scaled sketching mode. The dimensions are automatically configured to display at the value in which they were drawn.
5. Click **Enter Scaled Sketch mode** to start drawing at the selected scale. The system scales the drawing sheet to match the specified scale value.

6. Use the **Circle** tool to draw an opening on the plate.

7. Use the **Fill** tool to add a **Mesh** fill to the opening.

8. Click **Finish** to end the selected scale mode.

**NOTES**

- For information on how to move a view that contains objects drawn using the Scaled Sketching command, see *Move a View with Scaled Sketching Objects* (on page 326).
- If a view is deleted and moved to the UnAssigned Folder, any sketches made in Scaled Sketching mode reside in the view. If the view is reassigned to a drawing, your sketches will appear in the view.
- The only way to exit scaled sketching is to click **Finish**. All modifications you made in the document are retained.
- Whenever you finish using scaled sketching, the undo history is cleared and you cannot undo any previous edits. The **Undo** command becomes enabled once you continue working in SmartSketch Drawing Editor.

**See Also**

*Using Scaled Sketching* (on page 324)
Retain Edits made inside a Drawing View

1. Double-click a drawing view's border to open the drawing view.
2. Make the desired changes to the drawing view.
3. Click *File > Update* to save the changes.
4. Click *File > Close*.
5. Repeat the steps above as desired for all other views.
6. Save and close the document.

The changes that are saved include:

- Layer-related changes (creating new layers, modifying a graphic's layer, and changing how layers are displayed using the Display Manager Dialog Box).
- Using the Drawing Editor to sketch new graphics, copy intelligent graphics, add text boxes, place fills, or place symbols.

When a drawing view is opened, the new window is maximized to fit the graphics within the view. Like the Scaled Sketching command, the sheet scale changes to match the view scale. If the view scale is not Fit to Scale, manual graphics drawn outside of the rectangle, enclosing the graphics within the view, are not visible after the next update.

**NOTES**

- Particular changes made to intelligent graphics affects what is retained when a drawing view is updated:
  - Copies of intelligent graphics are treated as manual graphics.
  - When no graphic rule is specified for a filter, or when the graphic rule does not specify a layer, intelligent graphics are placed onto the Default layer.
  - Intelligent graphics remain intelligent graphics after their layer is changed. If the corresponding 3D object is deleted, the layer change operation is lost.
  - It is recommended that you include any dimensions or leaders in the drawing sheet, instead of the drawing view, as dimensions and leaders connected to intelligent graphics are not retained when the view is updated.
  - Intelligent graphics that are deleted will reappear after the drawing view is updated. Select Hide to temporarily remove intelligent graphics.
Hide/Show Object Command

Hides or displays objects in the drawing view. You can hide certain objects from the drawing view by selecting object types from a list. You can also show objects that you have hidden using the same command.

When objects are hidden, they are added to a different drawing layer that is created automatically. When the objects are shown, they are restored to their original drawing layer and all annotations are restored.

**NOTE** You can also hide/show symbol objects that have **Replace Object(s) with Symbol** rule applied on them.

**See Also**
- **Hide/Show Object Ribbon** (on page 335)
- **Hide an Object** (on page 336)
- **Show an Object** (on page 336)
- **Copy an Object** (on page 337)

**Hide** - Subtracts objects from the view.

**Show** - Adds objects to the view.

**View Name** - Displays the selected view name.

**Hide Options** - Displays the list of hide options available in the selected drawing view. The default option is **All**.

- **All** - Hides graphics, labels and dimensions.
- **Graphics only** - Hides only graphics.
- **Graphic/Labels** - Hides graphics and corresponding labels.
- **Graphic/Dimensions** - Hides graphics and related dimensions.

**Object Filter** - Displays a list of object types in the selected drawing view. The default option is **All**. When you select an object in the drawing, the **Object Filter** displays associated object type automatically.

**Copy Graphics** - Copies only graphics into the smart frame. Ignores any applied hide options. By default it is disabled. Click **Hide** to enable this command.

**Finish** - Saves and exits the **Hide/Show** command. Click on the drawing view to enable this command.

**NOTE** You must update the drawing after hiding or showing objects.
Hide an Object

1. In the Draw toolbar, click Hide/Show.
   The Hide/Show ribbon appears in the toolbar area.

   **NOTE** The Hide mode is selected by default.

2. Select a drawing view.

   Hide gets disabled.

3. Select an hide option from the Hide Options list.

4. Select an object type from the Object Filter list.

5. Select the objects you want to hide.

   As you select the objects, the Finish command is enabled, and the selected objects are highlighted in the drawing view depending on the hide option. For example, if the hide option is Graphics/Labels, the selected graphic and related labels are highlighted in the drawing view.

6. Click Finish to save your changes.

   **NOTE** You must update the drawing after hiding objects.

Show an Object

1. In the Draw toolbar, click Hide/Show.
   The Hide/Show ribbon appears in the toolbar area.

2. Click Show.

3. Select a drawing view.

   All hidden objects in the selected view are highlighted. Except for Show, the remaining options on the ribbon bar are disabled and set to their respective default values.

4. Select the objects you want to hide. Only highlighted objects are displayed in the drawing view.

   The Finish command is enabled.

5. Click Finish to save your changes.

   **NOTE** You must update the drawing after showing objects.
Copy an object

1. In the Draw toolbar, click Hide/Show 🗝. The Hide/Show ribbon appears in the toolbar area.

   **NOTE** The Hide 🗝 mode is selected by default.

2. Select a drawing view.

3. Click Copy Graphics 🉽.

4. Select an object to copy.

5. Click Finish to save your changes.

   *You can see the copied object with no labels.*

   **NOTE** To view the copied object, double-click the drawing view. Move the copied object, and then turn on the hidden layer. For more information on layer display, see Layers Command in the SmartSketch Drawing Editor User's Guide.

Copy and Paste View Command

เยอะ Copies an orthographic drawing view and places the copy on the same sheet.

**NOTE** You can only copy a view using Copy and Paste View 🉽. You cannot copy a view by CTRL + Drag or CTRL+V.

1. Select an orthographic drawing view, and then click Copy and Paste View 🉽.

2. On the target drawing sheet, click Paste 🇲.

   *The view displays.*

3. Drag the drawing view to a new location on the sheet.

Move View Command

Moves one or more views from a composed drawing document to another composed drawing document. The new drawing can be in the same component or in a different component.

A moved section view keeps its association with its cutting plane in the parent view, even when the parent view is in a different drawing. A moved detail view keeps its association with its envelope in the parent view, even when the parent view is in a different drawing.

Report and key plan views are moved automatically if the parent view is also moved. Dependent report and key plan views cannot be moved if the parent view is not moved.

Views cannot be moved to a drawing that is being edited or to a drawing to which you do not have write permissions.

**NOTES**

- Views cannot be moved in orthographic drawings by query or volume (spatial) drawings.
For a marine mode drawing by rule, views cannot be moved to a document in a different component with Move View. Views can be moved to a document in the same component, and to a different sheet in the same document.

**Move View Dialog Box (on page 339)**

**What do you want to do?**
- Move a view to a different drawing (on page 338)
- Move multiple views to a different drawing (on page 338)

### Move a view to a different drawing

1. Click Move View.
2. Select a view in the drawing area.
   - **NOTE:** Alternatively, select the view first, and then click Move View.
   
   The **Move View** dialog box appears.
3. Expand the appropriate folder and component, and select the destination drawing document.
4. Click OK.
   
   The selected view is moved to the destination drawing.

### Move multiple views to a different drawing

1. Select two or more views in the drawing area.
2. Click Move View.
   
   The **Move View** dialog box appears.
3. Expand the appropriate folder and component, and select the destination drawing document.
4. Click OK.
   
   The selected views are moved to the destination drawing.
Move View Dialog Box

Displays the Drawings and Reports tree view of folders, components, and drawings in the model. The tree view displays only drawings to which you have write permissions. Expand the appropriate folder and component, and then select the drawing to which you want to move your selected views.

**OK** - Closes the dialog box and moves the view to the selected drawing document.

**Cancel** - Closes the dialog box without moving the view.

**NOTE** For drawings by rule, you can only move the selected view to drawings and drawing sheets under the same component as the selected view. Only the drawings and sheets in that component are displayed.

Highlight Annotations Command

- Highlights labels, dimensions, and customized graphics based on the options that you select. The options display on the left side of the drawing window.

This command is useful when you are troubleshooting labels and dimensions, such as when you update a drawing and are looking for certain label or dimension types.

Highlight Dialog Box (on page 339)

Highlight Dialog Box

Allows you to specify label and dimensions that you want to see highlighted on a drawing. This dialog box appears docked on the left side of the drawing by default. You can undock it if needed.

To see all of the options, use the scroll bar on the right side of the dialog box.

**Highlight** - Click this button to highlight the specified items in the drawing.

**Clear** - Clears all highlighted items on the drawing and removes all the items in the select set.

**Clear Options** - Clears all options on this dialog box.

**Close** - Ends this command.

**Add to Select Set** - Adds the highlighted items to the set of all selected items.

**Choose Highlight Color** - Specifies the color of the selected items on the drawing.

Labels

**Unmodified System Placed** - Highlights labels that have not been modified on the drawing and that were placed by the software.

**User Placed** - Highlights labels that a user placed on the drawing.

**Modified System Placed** - Highlights labels that have been modified on the drawing and that were placed by the software.

**Deleted** - Highlights labels that have been deleted.

**Unassociated** - Highlights manual labels that are no longer associated to at least one of their original geometry elements. Loss of association can occur after a view update when the Default
Graphics or Drawable Default Graphics custom graphic modules are used in a view style. For more information, see Default Graphics and Drawable Default Graphics in the Drawings and Reports Reference Data Guide.

Additional Label Filters

Labels By Name - Click this option in order to choose a specific label type. When you check this box, the dropdown list is enabled. You can choose More in the dropdown list to view all label types in the current drawing.

Corrupt - Highlights labels that have a problem, such as not being connected to the correct object.

Include

Include Related Leaders - Highlights leaders that are related to the specified labels.

Include Other Relations - Highlights cutting planes or detail envelopes that are related to the specified labels.

Include Related Lines - Highlights lines that are related to the specified labels.

Dimensions

Unmodified System Placed - Highlights dimensions that have not been modified and that were placed by the software.

User Placed - Highlights dimensions that a user placed on the drawing.

Modified System Placed - Highlights dimensions that have been modified and that were placed by the software.

Deleted - Highlights dimensions that have been deleted.

Paper To Model - Highlights dimensions from an object drawn on the paper to an object that is in the model.

Unassociated - Highlights manual dimensions that are no longer associated to at least one of their original geometry elements. Loss of association can occur after a view update when the Default Graphics or Drawable Default Graphics custom graphic modules are used in a view style. For more information, see Default Graphics and Drawable Default Graphics in the Drawings and Reports Reference Data Guide.

Additional Dimension Filters

Dimensions By Name - Click this option in order to choose a specific dimension type. When you check this box, the dropdown list is enabled. You can choose More in the dropdown list to view all dimension types in the current drawing.

User Graphics

User Graphics - Highlights items, such as lines, that a user placed on the drawing.

User Scaled Dimensions - Highlights dimensions on the items that a user placed on the drawing.

Leaders

Disconnected Leaders - Highlights leaders that are disconnected from labels on the drawing.
Clear Manual Edits Command

Permanently clears all manual edits made to labels and dimensions in the selected views.

You must first select one or more views before clicking this command.

Associate Graphics to Graphic View Command

Associates and disassociates manually drawn objects, such as lines, circles, symbols, and text boxes, to graphic views. You can use Associate Graphics to Graphic View in composed drawings and Drawings by Rule components. You cannot associate objects with a report view or a pasted view, or if the objects are already associated with another view. To associate the objects to another view, you must first dissociate the objects.

**NOTES**

- You can use Move View to move the view and the associated objects.
- To view all objects that are associated with a graphic view, press ALT and select the graphic view.

What do you want to do?

- Associate Graphics to Graphic View (on page 341)
- Disassociate Graphics from Graphic View (on page 343)

Associate Graphics to Graphic View

1. Select a graphic view.
2. In the selected graphic view, select the objects to associate to the graphic view.

3. Click **Associate Graphics to Graphic View**.

   *A message displays the number of associated objects.*

4. Click **OK**.
Disassociate Graphics from Graphic View

1. Select the objects to disassociate from the graphic view.

2. Click Associate Graphics to Graphic Views. A warning message displays.

3. Click Yes to remove all associated inputs from each object. A message displays the number of disassociated objects.

4. Click OK.

Template Toolbar

This toolbar is available when you click Edit Template on a component shortcut menu.
Place Drawing View Command (Template Toolbar)

Placing a two-dimensional drawing view for 3D volume drawings. This command is available when you use the Edit Template command available on the shortcut menu for a volume drawing component in the Drawings and Reports task.

When you place drawing views, the software automatically saves the views to the DwgTemplate layer when you save the document.

See Also
Manual Place View Ribbon (on page 348)
Drawing View Properties Dialog Box (Drawing View Shortcut Menu) (on page 345)

Place a Drawing View for Volume Drawings

Before placing a drawing view for a volume drawing, you must have a View Style. For more information, see Define View Style Command in the Drawings and Reports Reference Data Guide, accessible using the Help > Printable Guides command in the Drawings and Reports task.

1. Right-click a volume drawing component in the Management Console, and then click Edit Template on the shortcut menu.
2. Select a template on the Select Template dialog box and click OK. The drawing template opens in SmartSketch Drawing Editor.
3. Click Place Drawing View on the toolbar.
4. Click a point on the drawing sheet to define the first corner of a rectangle, and hold the mouse button down while dragging the mouse diagonally. Release the button at a second point.

The drawing view highlights on the drawing and the Drawing View Properties dialog box displays.

5. On the Drawing View Properties dialog box, define the necessary information on the View tab in the Name and Description boxes.
6. In the Style box, select a view style.
7. In the Orientation box, select an orientation such as Looking Plan.
8. In the Scale box, select a scale, or choose Custom and define the values in the boxes to the right.

   - If you choose Custom, you must type values that are greater than zero in the boxes at the right. For example, if you type values of 1 in to 1 ft, the values are converted to mm if that is the default unit of measure.
   - Do not use negative values when typing custom scale values.
9. Specify additional information as necessary on the Format tab.
10. Click OK.
11. Click File > Save and exit SmartSketch Drawing Editor.

**NOTES**
- To associate volumes with the view, switch to the Space Management task and click one of the Place Drawing Volume commands.
- You can resize a drawing view by dragging its handles.
- You cannot undo a drawing view delete operation. A message box displays when you press Delete for a selected view, providing a chance to cancel the operation.

**Drawing View Properties Dialog Box (Drawing View Shortcut Menu)**

Sets drawing view properties for a 3D volume drawing. This dialog box appears when you select a drawing view in a volume drawing then right-click and select Properties on the shortcut menu.

**See Also**
- Place Drawing View Command (Template Toolbar) (on page 344)
- Info Tab (Drawing View Properties Dialog Box) (on page 345)
- Format Tab (Drawing View Properties Dialog Box) (on page 345)
- View Tab (Drawing View Properties Dialog Box) (on page 346)

**Info Tab (Drawing View Properties Dialog Box)**

Provides information about the frame around a drawing view. This information is view-only. You cannot make changes.

**Type** - Displays the category of the selected element.

**Sheet** - Displays the name of the drawing sheet that contains the selected element.

**Layer** - Shows the layer that contains the selected element.

**Origin** - Specifies the coordinates, or location, of an element along the X- and Y-axes.

**See Also**
- Place Drawing View Command (Template Toolbar) (on page 344)
- Drawing View Properties Dialog Box (Drawing View Shortcut Menu) (on page 345)

**Format Tab (Drawing View Properties Dialog Box)**

Formats the frame around a drawing view.

**Show Border** - Displays the frame around the object.

**Color** - Sets the color of the frame.

**Line Width** - Sets the line thickness on the frame.

**Line Type** - Overrides a line type for a drawing sheet or embedded object and sets another line style for an element or a linked object.

**See Also**
- Place Drawing View Command (Template Toolbar) (on page 344)
- Drawing View Properties Dialog Box (Drawing View Shortcut Menu) (on page 345)
**View Tab (Drawing View Properties Dialog Box)**

Sets the drawing view style and other properties for a selected drawing view in a 3D volume drawing.

**NOTE** If the drawing document is a 3D composed drawing, refer to *Drawing View Properties Dialog Box (Place View Command) - Steel Order Drawings* (on page 260) for information on the properties shown on this tab.

**Name**
Specifies a name for the view. You must type a name in order to create a view.

**Description**
Describes the content of the view. This description is optional.

**Style**
Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the Select View Style dialog box.

**Orientation**
Positions the view in the model. For example, the view can look north, south, east, or west in the model.

**Use object coordinate system**
Specifies that the drawing takes its viewing direction directly from the object within the drawing view, not from the orientation of the drawing view.

**Scale**
Sizes the view as a ratio of drawing size to actual model size. If you select Custom for the scale, you must type values that are greater than zero in the boxes at the right to set the scale-to-scale ratio for object-to-drawing view.

**NOTES**
- For Custom scale, the default is to the document’s unit of measure setting. For example, if you enter values of 1 in to 1 ft, the values are converted to mm if that is the default unit of measure.
- Do not use negative values when entering custom scale values.
- For volume drawings, if the volume is too big for the drawing view, the software centers the volume in the drawing view.

**Navigation rule**
Specifies the navigation rule to use to traverse elements to be included in the range for Orthographic Drawings by Query. This dropdown only appears when you are placing views on drawings created by the Orthographic Drawings by Query component in the Drawings and Reports 3D task. The navigation rule can also optionally return separate object collections, whose range is included in the 3D object range. If no navigation rule is specified, the drawing object collection includes everything in the 3D object range. The delivered rules are:

- **HngSupSimpleNavigator.dll** - Specific to Hanger and Support objects. Returns the HangersSupport objects, support components, supporting objects, supported objects,
and the design children (recursively). It also returns the control points on the HangerSupport objects and support components.

- **HngSupRangeNavigator.dll** - Same as HngSupSimpleNavigator.dll with design children collection to extent the HangerSupport range.
- **DrawingSpoolNavigator.dll** - Specific to Spools. Returns the Spool, its connected parts, and their features.
- **AssemblyNavigator.dll** - Specific to Assemblies. Returns the assemblies, pipe spool, penetration spool, its connected parts, and their features.

Convert report output to text boxes (no Excel)

Specifies that any report associated with this drawing view will be converted automatically to native text box format, even if the report is an Excel spreadsheet report. For information on converting Excel spreadsheet reports, see *Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command* (on page 375).

Flush Threshold

Sets a parameter for memory management. When the number of objects processed for a drawing document reaches the **Threshold** value, they are removed from memory. If they are needed later, they are recalled from the database. This property helps improve drawing update performance. The **Flush Threshold** property is only available for composed drawing documents. The default value is **2000**, with a range of **5-5000**. The higher number is faster but uses more memory, which is acceptable for smaller drawings. Lower numbers are slower but allow larger drawings to complete faster.

**NOTE** If a drawing document does not successfully update in the Drawings and Reports 3D task, check the error log for the drawing document. If the error log shows memory overflow errors, lower the **Flush Threshold** value.

VHL Precision

Sets a parameter for Hidden Line removal processing to consider two lines as identical. This property setting has a direct impact on the visibility of the lines in the drawing. It improves drawing update performance, but it may reduce drawing quality. The **VHL precision** property is only available for composed drawing documents. The default value is **0.000001**, with a range of **0.001 to 0.000001**. The smaller the number, the more accurate the graphic elements are in the 2D view.

**NOTE** If some intersections of complex surfaces appear on/off along the curve, the precision of the VHL may be too restrictive compared to the precision by which the surfaces were created. Lowering the **VHL Precision** value may help the display of the intersections, but lowering the value too much could degrade the overall quality and the visibility of the drawing details.

Geometry Validation

Sets a parameter for drawing completion and quality to improve drawing update performance. The **Geometry Validation** property is available for composed drawing documents only. The default value is **Off**. When set to **Off**, the drawing document completes, but invalid geometries are left out. If set to **On**, the drawing document does not complete if invalid geometries are encountered during update.

Tag

Identifies the reference mark for the selected detail view. This property is only available when a detail or section view is selected.
Caption
Identifies the callout text assigned to the selected detail view. This property is only available when a detail or section view is selected.

See Also
Place Drawing View Command (Template Toolbar) (on page 344)
Drawing View Properties Dialog Box (Drawing View Shortcut Menu) (on page 345)

Manual Place View Ribbon
Sets options for placing a snapshot drawing view. These options include the view name, style, and scale.

View Name
Displays the name of the view you created in a 3D task.

View Style
Specifies a view style, which includes rules for filters, updates, and graphics. The view style controls the output characteristics of the view on the generated drawing. The list displays the 10 most recently used view styles in the session. Click More... to display the Select View Style dialog box.

View Scale
Specifies a scale. You can choose No Scale if the view is not to scale. Choose Custom if you want to specify your own scale and then type values in the two boxes at the right of the ribbon. If you choose Custom for the scale, you must type values that are greater than zero in the boxes at the right.

See Also
Place Drawing View Command (Template Toolbar) (on page 344)

Place Report Command (Template Toolbar)
Embeds a report in a drawing view on a 3D drawing. You must select a drawing view on the drawing before you can embed a report.

The report queries on the items in the drawing view.

When you place reports, the software automatically places them on the DwgTemplate layer so that they will be preserved when you update the drawing document.

NOTES

- For embedded reports to run on computers with Microsoft Office XP, you must modify the security settings in Excel to allow Visual Basic projects to run. To change this setting, open Excel, and click Tools > Macros > Security. On the Trusted Sources tab, select Trust access to Visual Basic Project. This setting must be modified before you update the drawing and generate the report within it.

- When defining embedded report layout (sizing of columns and rows), consider the report usage first. Because of a Microsoft limitation concerning the size of Windows metafile objects within other applications, the data displayed may be incomplete. Therefore, no column should be out of screen when using 100 percent zoom for the report. Otherwise some columns are ignored when the report is embedded within the drawing. The same limitation exists for rows. To preserve the maximum number of rows displayed, the total header row(s) height should be
Working with Drawings and Reports and SmartSketch Drawing Editor

a minimum of the overall report. Using Microsoft Excel default settings, the maximum number of columns is approximately 20 and the maximum number of rows is approximately 75 (including header rows). For more information on setting the defaults in Microsoft Excel, see your Microsoft Excel documentation.

See Also

Report Properties Dialog Box (Place Report View Command) (on page 291)

Place an Embedded Report in a Volume Drawing

1. For volume drawings, right-click the volume drawing component in the Drawing Console and select Edit Template.
2. Select a template on the Select Template dialog box and click OK. The drawing template opens in SmartSketch Drawing Editor.
3. Click Place Report , and then click on the drawing view border.
4. On the Select Template dialog box, select a report template from the hierarchy. For example, you can select Piping Pipelines Sorted by Name report.

5. Click OK on the dialog box.
6. In SmartSketch Drawing Editor, click to place the report.

NOTES

- Only one report per drawing view is permitted.
- For more information about Microsoft Office and service packs, refer to the Microsoft web site (http://www.microsoft.com/).
- If you are using Office 2003, in Microsoft Excel under Tools > Macro > Security > Trusted Publishers tab, check the Trust Access to Visual Basic Project option.
- If you are using Office 2007 and Office 2010, click the Microsoft Office button to access Excel Option. Go to the Trust Center category and select the Trust Center Settings button.
Select the **Macro Settings** category and check Trust access to the VBA project object model.

- When defining embedded report layout (sizing of columns and rows), consider the report usage first. Because of a Microsoft limitation concerning the size of Windows metafile objects within other applications, the data displayed may be incomplete. Therefore, no column should be out of screen when using 100 percent zoom for the report. Otherwise some columns are ignored when the report is embedded within the drawing. The same limitation exists for rows. To preserve the maximum number of rows displayed, the total header row(s) height should be a minimum of the overall report. Using Microsoft Excel default settings, the maximum number of columns is approximately 20 and the maximum number of rows is approximately 75 (including header rows). For more information on setting the defaults in Microsoft Excel, see your Microsoft Excel documentation.

**Select Report Template Dialog Box**

Selects a report template. This dialog box appears when you click **Place Report** when editing a 3D drawing template. By browsing through the hierarchy, you can find any report template in the Catalog database. After you select a template, the software generates the report. You can resize the dialog box and the columns to view the information more clearly.

- **Properties** - Displays the properties of the selected item. All properties on the Properties dialog box are read-only.
- **List View** - Sets the dialog box to display items in a list view.
- **Grid View** - Sets the dialog box to display items in a spreadsheet-style grid view.

**NOTE** The Place Report commands creates reports based on a selected report template. You can also select a report template and view its properties. The buttons that are grayed out are not available when using these commands.

**Place Key Plan Command (Template Toolbar)**

Places a key plan on a drawing template. The Place Key Plan command is enabled when you select a drawing view. The command displays the Select Key Plan dialog box to specify a key plan type to associate with the selected drawing view.
When you place key plan views, the software automatically places them on the **DwgTemplate** layer so that they will be preserved when you update the drawing document.

A key plan is a small graphical representation of a drawing volume you defined in the geographic area where engineering is taking place. One key plan may serve for an entire project. Multiple key plans may be established per discipline. One drawing view may have multiple key plans.

**See Also**
*Select Key Plan Style Dialog Box* (on page 351)

**Select Key Plan Style Dialog Box**

Specifies a style for the selected key plan on a volume- drawing template. Select a style from the **Rule Name** hierarchy.

**See Also**
*Key Plan Properties Dialog Box* (on page 351)
*Place Key Plan Command (Template Toolbar)* (on page 350)

**Key Plan Properties Dialog Box**

Sets options for a key plan on a drawing template.

**See Also**
*Place Key Plan Command (Template Toolbar)* (on page 350)
*Info Tab (Key Plan Properties Dialog Box)* (on page 351)
*Format Tab (Key Plan Properties Dialog Box)* (on page 352)
*Key Plan Tab (Key Plan Properties Dialog Box)* (on page 352)

**Info Tab (Key Plan Properties Dialog Box)**

Provides information about a key plan. This information is read-only. You cannot make changes.

**Type** - Displays the category of the selected element.

**Sheet** - Displays the name of the drawing sheet that contains the selected element.

**Layer** - Shows the layer that contains the selected element.

**Origin** - Specifies the coordinates, or location, of an element along the X- and Y-axes.

**See Also**
*Key Plan Properties Dialog Box* (on page 351)
*Place Key Plan Command (Template Toolbar)* (on page 350)
Format Tab (Key Plan Properties Dialog Box)

Formats the frame around a key plan.

Show Border - Displays the frame around the object.

Color - Sets the color of the frame.

Line Width - Sets the line thickness on the frame.

Line Type - Overrides a line type for a drawing sheet or embedded object and sets another line style for an element or a linked object.

See Also
Place Key Plan Command (Template Toolbar) (on page 350)
Key Plan Properties Dialog Box (on page 351)

Key Plan Tab (Key Plan Properties Dialog Box)

Sets the properties for a selected key plan.

Name - Specifies a unique name for the key plan.

Description - Describes the key plan contents.

Style - Indicates the key plan view style used. Select More to display the Select Key Plan Style dialog box. For more information, see Select Key Plan Style Dialog Box (on page 351).

Scale - Indicates the scale assigned to the key plan with regard to the associated drawing view. If you select Custom for the scale, you must type values that are greater than zero in the boxes at the right to set the scale-to-scale ratio for key plan-to-drawing view.

NOTES:

- For Custom scale, the default is to the document's unit of measure setting. For example, if you enter values of 1 in to 1 ft, the values are converted to mm if that is the default unit of measure.

- Do not use negative values when entering custom scale values.

- Orientation of the key plan graphic is specified as part of the key plan style.

See Also
Key Plan Properties Dialog Box (on page 351)
Place Key Plan Command (Template Toolbar) (on page 350)

Place a Key Plan

1. In the Management Console, right-click a volume drawings component, then click Edit Template.

2. If no template is defined for the volume drawings component, select a template in the Select Template dialog box, and click OK.

3. Select a drawing view on the template.

4. On the Template toolbar, click Place Key Plan. 


5. Click two points to place the key plan view.

On the second click, the software displays the **Key Plan Properties** dialog box.

6. On the dialog box, specify the settings for the key plan.

**NOTES**
- Multiple key plans can be associated with a single drawing view.
- For **Custom** scale, the default is to the document's unit of measure setting. For example, if you type values of 1 in to 1 ft, the values are converted to mm if that is the default unit of measure.
- Do not use negative values when typing custom scale values.
- Orientation of the key plan graphic is specified as part of the key plan style. For more information, see "Define View Style Command (Tools Menu)" in the *Drawings and Reports Reference Data Guide*.

For more information, see Key Plan Drawing Requirements and Key Plan View Styles in the *Drawings and Reports Reference Data Guide*.

---

**Edit Border Template Toolbar**

Available when you click **Tools > Edit Border Template** in the Drawings and Reports task.

**Place Drawing Property Label Command (Drawing Labels Toolbar)**

Positions drawing property labels in the title block of a template. The command allows you to place drawing properties defined in the 3D drawing XML schema file as title block information on the drawing. When you click **Place Drawing Property Label**，the **Place Drawing Property Label** ribbon appears in the toolbar area.

*Place Drawing Property Label Ribbon* (on page 354)
When placing drawing property labels, zoom into the border area where you want to place the label for more precise placement.

**Place Drawing Property Label Ribbon**

Sets options for drawing property label placement on a border template. You can access this ribbon when you click the Place Drawing Property Label command when editing a border template in SmartSketch Drawing Editor.

When you place drawing property labels, the software automatically makes the DwgTemplate layer active. The labels need to be on this layer so that they are preserved when you update the drawing.

![Layer: DwgTemplate](Layer: DwgTemplate)

You set options as needed within the Place Drawing Property Label ribbon, then place the label in the drawing border title block area.

**Label Set** - Specifies a property category. This list shows the categories of drawing properties available for the current drawing. The label set controls the fields listed in the Field dropdown list and the enabling of other options on the ribbon.

**Fields** - Lists the properties available in the selected Label Set. This is the information you are placing on the title block of the drawing.

**Function** - Provides positioning functions for the label. The options available are **Index**, **First**, and **Last**. This control works with the **Function Operator** and **Function Argument** fields to set the position of the label within the title block area.

**Function Operator** - Works with the Function and Function Argument fields to set the position of the label within the title block area. The value is controlled by the Function selection. This field is not editable.

**Function Argument** Sets a value to add or subtract from the **First** or **Last** settings in the Function field. This field works also works with the **Function Operator** field to set the position of the label within the title block area.

**Alternative Text Value** - Specifies alternative text to use if the selected property has no current value.
Display Label Names - Turns the label names on/off in the open border template:

More - Expands the ribbon to include additional formatting controls.

The controls on the expanded ribbon include:

Style - Sets the overall style used within the label.
Font - Sets the font for the label text.
Font Size - Sets the font size for the label text.
Textbox Width - Specifies the width of the text box.

Place a Drawing Property Label on a Template

If you want to place a custom attribute label on a template, see Place a Custom Drawing Property Label on a Template (on page 356).

1. Click Tools > Edit Border Template.
   The Select Template dialog box displays.
2. Select a template, and click OK.
   The template opens in SmartSketch Drawing Editor.
   The Place Drawing Property Label ribbon displays.
4. In the Label Set list (the first dropdown on the ribbon), select a label set (set of drawing properties). The list reflects the label sets within the drawing XML schema. The Label Set selection controls the contents of the Fields list and the enabling of other controls on the ribbon.
5. In the Fields list (the second dropdown on the ribbon), select a field to use as your title block label.
6. Specify a Function, setting the Function Argument if needed.
7. Provide alternative text for cases when the label property could be blank.
8. Click More to expand the ribbon and set formatting options. Select the Style, Font, Font Size, Text Color, Textbox Height, and Textbox Width.

9. Zoom into the area of the border where you want to place the drawing property label. Click the template to place the label.

10. Continue placing labels on the template as necessary. For example, the following border shows that the General label for the Location property has been placed as Huntsville.

11. Right-click to end the command.

12. Save the changes to the template before closing SmartSketch Drawing Editor.

See Also
Publishing Title Blocks (on page 393)

Place a Custom Drawing Property Label on a Template

The following steps show how to add a custom attribute drawing property label to a drawing template. To add non-custom property labels to the template, see Place a Drawing Property Label on a Template (on page 355).

1. Create a Custom Attribute workbook using Excel. This is the bulkload file for the custom attribute and names the attribute. For example, you could create a file calledCustomAttributes.xls that contains the definition for a custom attribute. For more information on the format for the workbook, see Drawings-ExtendCustomAttributes Workbook in the Drawings and Reports Reference Data Guide.

2. Bulkload the Custom Attribute workbook. For more information on populating Excel workbooks and bulkloading, see the Reference Data Guide available from Help > Printable Guides.

3. Create an .xsd file and add a line that defines the attribute in the dropdown list when you edit a template and use the Place Drawing Property Label command. For example, using
DrawingCustom1 as the attribute name, the line would be `<xs:element name="DrawingCustom1">`.

**NOTE** You can only use letters, numbers, and underscores when defining the element name. The name must also begin with a letter.

4. Add a line that points to the AttributeName property of the bulkloaded attribute. For example, using the above attribute name, the necessary line would be `<pk name="DrawingCustom1">`. Your .xsd file would look similar to the following:

```xml
<xs:element name="DrawingCustom1">
  <xs:annotation>
    <xs:appinfo>
      <pk name="DrawingCustom1"/>
    </xs:appinfo>
  </xs:annotation>
</xs:element>
```

**NOTE** The pk name in the Custom.xsd file must match the related AttributeName property of the bulkloaded attribute.

5. Make sure the .xsd file is in the \Symbols\Drawings\Catalog\Labels\Border\Schema folder.

6. In the Drawings and Reports task, click Tools > Edit Border Template.

7. On the Select Template dialog box, select a template, and click OK. The template opens in SmartSketch Drawing Editor.

8. In the Label Set list (the first dropdown on the ribbon), select Custom.

9. In the Fields list (the second dropdown on the ribbon), select the Custom attribute property to use as your title block label.

10. Zoom into the area of the border where you want to place the drawing property label. Click the template to place the label.

11. Continue placing labels on the template as necessary.

12. Right-click to end the command.

13. Save the changes to the template before closing SmartSketch Drawing Editor.

14. Update any drawing documents associated with the modified template. For more information, see Updating Documents (on page 75) in the Drawings Help.

15. Right-click the drawing and select Properties.

16. Go to the Custom tab. The new Custom attribute property is shown on the tab.
17. To verify the custom drawing property is added to the drawing title block, right-click the drawing and select **Open**. The custom drawing property includes the Custom Property attribute in the title block.

**Dimensioned Label Command**

Places a label with dimension formatting. The dimension displays the label instead of a dimension value. **Dimensioned Label** is an option on the **Place a Label** ribbon. You can select **Distance Between**, **Coordinate Dimension**, **SmartDimension**, or **Angle Between**. For more information on the formatting of each dimension type, see **Distance Between Command**, **Coordinate Dimension Command**, **SmartDimension Command**, and **Angle Between Command** in the **SmartSketch Drawing Editor Help**.

Before selecting **Dimensioned Label**, you must select an appropriate label from **Label Specification** on the **Place a Label** ribbon. The following example shows a dimensioned label on a composed drawing. A **Distance Between** dimension is placed between two pumps with the **Equipment_Plane Equipment_Name** label selected.

**NOTE** Only two objects can be selected with **Dimensioned Label**. The label placed is determined by the first object you select, not the second.

**See Also**

- Place a Dimensioned Label (on page 299) (Marine mode only)
- Place a Dimensioned Label (on page 359) (Plant mode only)
Place a Dimensioned Label

This workflow places a dimensioned label on a composed drawing.

1. Right-click a drawing, and click **Edit** on the shortcut menu.
   
   *The drawing opens in **SmartSketch Drawing Editor**.*

2. On the toolbar, click **Manually Place Labels**.

3. In the **Label Name** drop-down menu, select the **Structural Framing Elevation_Grid Line_TOS** label from the delivered folder.
   
   **NOTE**: To pick from a hierarchical list, select **More**.

4. Select **Coordinate Dimension** from the dimension label drop-down menu. The dimensioned label ribbon displays.
   
   **NOTE**: You can select any of the dimension commands from the drop-down menu.

5. Select a structure member to label.

6. Click to place the Coordinate Dimension label.

   ![TOS 30 ft 0 in](image)

   **TIP**: You can use custom dimension styles when placing dimension-like labels. For more information, see **Dimension Properties Dialog Box** in the **SmartSketch Drawing Editor User’s Guide**.

7. Continue placing labels if necessary.

8. Right-click to end the command.

9. Save your changes and exit **SmartSketch Drawing Editor**.

**See Also**

*Dimensioned Label Command* (on page 298)

*Place a Manual Label* (on page 294)
**Elevation Label Command**

Pipe BOP places a label that displays the elevation or inverted elevation value of the route object. For more information, see *Elevation versus Invert Elevation* below.

The Pipe BOP is available only if you select one of the following templates:

- **Piping Plan_Routable_Center Elev_M** - Select to place a label for the center elevation of the pipe.
- **Piping Plan_Routable_INV Elev_M** - Select to place a label for the inverted elevation of the pipe.
- **Piping Plan_Routable_WPBOP Elev_M** - Select to place a label for the working point of the pipe.

The following example shows an elevation label being used on a composed drawing. An inverted elevation is placed on a pipeline with the Piping Plan_Routable_INV Elev_M template selected.

NOTE: Elevation labels support only manual placement and label templates for piping disciplines. To apply these templates to other disciplines, such as HVAC, cable tray, and conduit, modify and use these templates or create a new label template based on these templates.

**Elevation versus Invert Elevation**

Inverted elevation is the inside elevation of a pipe, HVAC, cable, or conduit route object. Elevation and inverted elevation can be calculated at following locations:
Leader Point Connection

When you click on the route object the leader point is automatically placed near port point, working point or clipping point, whichever is nearest to where you clicked. For example, if you click at the red point the leader point is moved to nearest clipping point (1). If you click at the green points, the leader point is moved to the nearest working point (2). If you click at the cyan points, then the leader point is moved to nearest port point (3).

Place an Elevation Label

This workflow places an elevation label on a composed drawing.

1. Right-click a drawing, and click Edit on the shortcut menu. The drawing opens in SmartSketch Drawing Editor.

2. On the horizontal toolbar, click Manually Place Labels.

3. In the Label Name drop-down menu, select the needed label. For example, to place an inverted elevation label select Piping Plan_Routable_INV_Elev_M.

   The Pipe BOP command gets activated after you select the label template.

   **NOTE** To pick a label template from a hierarchical list, select More.

4. Select a route object to label.

5. Click on any point in the empty space to place the elevation label.
6. Continue placing labels if necessary.
7. Right-click to end the command.
8. Save your changes and exit SmartSketch Drawing Editor.

See Also
Elevation Label Command (on page 360)
Place a Manual Label (on page 294)

Place a Manual Label
1. Right-click a drawing, and click Edit on the shortcut menu. The drawing opens for editing in SmartSketch Drawing Editor.
2. On the toolbar, click Manually Place Labels.
3. Click an object in a drawing view to label.
4. (This step is only for marine mode) Use the Object Filter to enable only certain objects for selection. For example, selecting Physical Connections in the Object filter list only allows you to select physical connections.
5. In the Label Name drop-down menu, select a label.
   TIP The labels are located on the application server in the \Symbols\Drawings\Catalog\Labels\Templates folder.
6. To pick from a hierarchical list, select More.
   The Select Label dialog box displays.
7. Select a label template folder in the left pane of the dialog box, select a specific label name in the right pane, and then click OK.
8. In the Font box, specify the font.
9. In the Text size box, specify the size of the text.
10. Click Text Color, and select a color for the label text.
11. Click the Bold, Italic, and Underline buttons to achieve the necessary formatting.
12. Click Shape flyout to choose the shape of the label border.
13. Click Orientation to specify horizontal or vertical text.
14. Specify the leader line and jog as necessary.
15. Click Leader Color, and select a color for the leader.
16. Choose the Boundary option to clip the leader at the object boundary, or choose the Inside option to extend the leader to the inside of the object.
17. Key in a value for the Leader Tolerance value. This value determines the distance required for a leader to appear. For example, if the leader tolerance value is set to 10mm, the label must be at least 10mm away from the labeled object before a leader will appear.
18. Choose a dimension label in order to place a dimension that displays a label instead of a dimension value. For more information, see Dimensioned Label Command (on page 298).
19. Select an elevation label  if you want to place an elevation label that displays the elevation of the routable object. For more information, see Elevation Label Command (on page 360).

20. Select As Drawn  if you want the label appearance to reflect the label definition only and not have any formatting overrides.

  **TIP**  If you select As Drawn, the label appearance is determined by the label definition. You cannot set the font, text size, text color, and so forth for the label.

21. Click the drawing to place the label.

  **TIP**  During placement, the label will automatically align to the left or right side of an existing label. You can also align the label to any object keypoints in the drawing. For more information on using alignment settings, see Align Dimensions Command in the SmartSketch Drawing Editor Help.

22. Continue placing labels on the drawing if necessary.

23. Right-click to end the command.

24. Save your changes before exiting SmartSketch Drawing Editor.

  **NOTE**  You can remove manual edits from a drawing using Clear Manual Edits  in SmartSketch Drawing Editor. For more information, see Clear Manual Edits Command (on page 341).

**Place a Manual Flow Arrow on an Orthographic Drawing**

You can place flow arrows on pipe objects in orthographic drawings with the Place a Label command in SmartSketch Drawing Editor.

You can also add flows arrows as part of the drawing view style definition. For more information, see Add Flow Arrows to Orthographic Drawings in the Drawings and Reports Reference Data Guide.

1. Right-click a drawing, and click Edit on the shortcut menu. The drawing opens for editing in SmartSketch Drawing Editor.

2. On the toolbar, click Manually Place Labels.

3. (This step is only for marine mode) Use the Object Filter to enable only certain objects for selection. For example, selecting Physical Connections in the Object filter list only allows you to select physical connections.

4. Click an object in a drawing view to label.

5. In the Label Name drop-down menu, select More to display the Select Label dialog box.

6. Select a flow label template folder in the left pane of the dialog box, select a specific label name in the right pane, and then click OK.
7. Select a pipe object in the drawing to place the label.

If the arrow has a red-crossed circle over it, the selected pipe does not have flow direction defined.

8. Right-click to end the command.

9. Save your changes before exiting SmartSketch Drawing Editor.

**NOTES**

- To move the flow arrow after it has been placed, click and drag the arrow by its origin point, identified by the green circle in the middle of the flow arrow object.

- You can remove manual edits from a drawing using **Clear Manual Edits** in SmartSketch Drawing Editor. For more information, see **Clear Manual Edits Command** (on page 341).

- Centerlines must display for pipelines before flow arrows can be placed.

**Place a Manual Weld Label**

1. Right-click a drawing, and click **Edit** on the shortcut menu. The drawing opens for editing in SmartSketch Drawing Editor.

2. On the toolbar, click **Manually Place Labels**.
3. (This step is only for marine mode) Use the **Object Filter** to enable only certain objects for selection. For example, selecting **Physical Connections** in the Object filter list only allows you to select physical connections.

4. In the **Label Name** drop-down menu, select a label rule.

   **TIP** The label rules are located on the application server in the \Symbols\Drawings\Catalog\Labels\Templates folder.

5. To pick from a hierarchical list, select **More**.

   *The Select Label dialog box displays.*

6. Select a label template folder in the left pane of the dialog box, select a specific label name in the right pane, and then click **OK**.

7. Click on a physical connection.

   *The correct weld symbol automatically displays based on the physical connection properties.*

8. In the **Font** box, specify the font.

9. In the **Text size** box, specify the size of the text.

10. Click **Text Color**, and select a color for the label text.

11. Click the **Bold**, **Italic**, and **Underline** buttons to achieve the necessary formatting.

12. Click **Orientation** to specify horizontal or vertical text.

13. Select a leader and leader jog.

14. Click **Leader Color**, and select a color for the leader.

15. Choose the **Boundary** option to clip the leader at the object boundary, or choose the **Inside** option to extend the leader to the inside of the object.

16. Key in a value for the **Leader Tolerance** value. This value determines the distance required for a leader to display. For example, if the leader tolerance value is set to 10mm, the label must be at least 10mm away from the labeled object before a leader displays.

17. Choose a **Dimension label** in order to place a dimension that acts as a label. For more information, see *Dimensioned Label Command* (on page 298).

18. Select **As Drawn** if you want the label appearance to reflect the label definition only and not have any formatting overrides.

   **TIPS**

   + If you select **As Drawn**, the label appearance is determined by the label definition. You cannot set the font, text size, text color, and so forth for the label.
   
   + Click the drawing to place the label. If you hover directly over the physical connection, the label will snap to the physical connection line, but will not align.
   
   + To move the label after it has been placed, click and drag the label by its origin point, identified by the green circle in the middle of the label object. In the graphic below, the weld symbol is moved.
   
   + To rotate the label after it has been placed, select the label and click the green circle located on the outside of the label. Drag the green circle until the label is aligned correctly to the physical connection.
1. Continue placing labels on the drawing if necessary.
2. Right-click to end the command.
3. Save your changes before exiting **SmartSketch Drawing Editor**.

**NOTE** You can remove manual edits from a drawing using **Clear Manual Edits** in **SmartSketch Drawing Editor**. For more information, see **Clear Manual Edits Command** (on page 341).

**See Also**
*Place a Manual Label* (on page 294)

---

**Place Drawing Area Command**

Places a drawing area for drawing border templates. This command is available when you are editing a drawing border template for which a drawing area is not defined. If a drawing area already exists, an error message displays. You can delete the existing drawing area and place a new one.

A drawing area is a property of the border template that defines the "useful" area of a drawing sheet. During the creation of a new composed drawing, the layout template containing the managed views fits inside the drawing area of the border template.

By defining a drawing area in each border template, a single layout template can be fit into any size border. The proportion of the drawing area devoted to a particular region in the layout does not change when the border template changes. For example, if you apply a region to the bottom half of a layout (and the layout is merged into a border template), the region always consumes the bottom half of the drawing, regardless of how it is stretched or resized by different border templates.
After you click **Place Drawing Area**, click and drag to place the drawing area.

Save the border template file and exit SmartSketch Drawing Editor. You can use the border file to create new 3D composed drawings. For more information, see the *Drawings and Reports User’s Guide* or the *Common User’s Guide*.

**NOTES**

- Editing a border template on the **Symbols** share does not affect an existing drawing since the border template associated to a drawing is stored in the database. To change the border template used by an existing drawing, you must replace the stored border template using the **Switch Border** command.

- If no drawing area exists in the border template used to create a composed drawing, one is computed based on the white space in the border template. This computed drawing area is not saved with the border template.

- The existence of a drawing area in the border template associated to a drawing has an impact on the behavior of the **Switch Border** command.

**See Also**

Switch Border (on page 371)

**Change the Border for an Individual Drawings by Rule Sheet**

The following procedure steps you through changing the border for an individual sheet to a template different from the border template defined in the Drawings by Rule component. For example, you may want the first sheet of drawing to use a different border template than all other sheets.

**NOTE** For more information on **SmartSketch Drawing Editor** commands used in this procedure, see the *SmartSketch Drawing Editor Help*.

**Change the Border Template for an Existing Sheet**

1. Right-click a drawings by rule document in the Detail View and select **Edit**.

   _The drawing opens in **SmartSketch Drawing Editor**._
2. Select a sheet tab at the bottom of the drawing view.

3. Click **Edit Sheet Properties** on the toolbar.

   The **Sheet Properties** dialog box displays.

4. On the **Current Sheet** tab, select a new value for **Border Template**.

5. Click **OK**.

   The new border template is applied to the sheet.

   **NOTE** Layout Template is inactive, and cannot be changed for an existing sheet.

### Apply a Border and Layout Template to a New Sheet

1. Right-click a drawings by rule document in the Detail View and select **Edit**.

   The drawing opens in **SmartSketch Drawing Editor**.

2. Right-click a sheet tab at the bottom of the drawing view and select **Insert**.

   A new sheet is created and the **Sheet Properties** dialog box displays.

3. On the **Current Sheet** tab, select a value for **Border Template** and **Layout Template**.

4. Click **OK**.

   The border and layout templates are applied to the new sheet.

   **NOTE** A sheet cannot be deleted unless all views on the sheet are removed first.

### Edit Layout Template

Available when you click **Tools > Edit Layout Template** in the Drawings and Reports task.

### Edit Border Family Command

Allows you to change the border family associated with the current layout template. This command is available when you edit a layout template.

When you click **Edit Border Family**, the **Select Border Family** dialog box appears so that you can select border templates to associate to the current layout template.

**See Also**

*Select Border Family Dialog Box (on page 369)*
Select Border Family Dialog Box

Specifies the border templates to associate with the current layout template. This dialog box displays when you click Edit Border Family on page 368, which is only available in SmartSketch Drawing Editor. You can multi-select borders by holding down the CTRL key while selecting borders from the hierarchy.

![Select Border Family Dialog Box](image)

See Also

Edit Border Family Command (on page 368)
Preview Layout Command

Shows a preview of the drawing document based on the current layout. A preview is shown for each of the borders chosen in the Border Family for the layout template.

This command is only available in SmartSketch Drawing Editor when you edit a layout template.

Shortcut Menus

Commands available when using right-click shortcut menus.

Update View Command

Updates the contents for the selected drawing, report, key plan, snapshot, or detail/section view. This command is available for composed drawing views only. Right-click a selected view and select Update View on the shortcut menu. The view contents update against the current 3D model. When working with the Update View command:

- If the software encounters a problem before or during the drawing update, it stops updating, displays either an error status or error message, and saves the errors to the log file. For more information, see Conditional Drawing Update (on page 81) in the Orthographic Drawings User's Guide.

- You cannot multi-select views. The command is not available on the shortcut menu if more than one view is selected.

- The inputs for the view (the associated volume or drawing view) must be defined and valid.

- If a report is defined as part of a drawing view definition, the Update View command is not available.

- If the drawing document is read-only, the Update View command is not available.

Notes

- To remove associated inputs from a view, use the Remove Associated Inputs command. For more information, see Remove Associated Inputs Command (on page 290).
To associate a view to a volume or another drawing view, use the **Associate Objects to View** command. For more information, see *Associate Objects to View Command* (on page 276).

- For composed drawings, views that are too small to display the volume are automatically sized larger on update to fit unless the view is set to **Fit to Scale** or is managed by a region. Likewise, views that are larger than the volume are automatically resized to fit unless the view is set to **Fit to Scale** or is managed by a region. The view size grows or shrinks from the center of the view and view proportions may change after the resize. The drawing must be saved to make the resize of the view permanent. For more information, see *Automatic Resize Behavior of Composed Views* (on page 264).

**See Also**

- *Place View Command* (on page 254)
- *Associate Objects to Views* (on page 285)
- *Place Snapshot View Command* (on page 275)
- *Place Report View Command* (on page 290)

**Switch Border**

Allows you to switch the border template associated with the composed drawing documents selected in the Detail View. This command is available on the shortcut menu when you select a composed drawing document. It displays the **Drawing Sheet Properties** dialog box so you can change the associated border template.

Editing a border template in the SharedContent folder does not affect an existing drawing because the border template associated to a drawing is stored in the database. To change the border template used by an existing drawing, you must replace the stored border template using the **Switch Border** command.

After switching the border template, the software computes a new position and size for any regions and managed views contained in the drawing. The shift and resize of the view is proportional to the size of the drawing areas in the border templates. If the border template does not contain a drawing area, the drawing boundary is computed automatically.

The software does not distinguish between different types of drawing views (report, key plan, and graphic views) when switching the border.

**NOTES**

- If you switch the border template of a drawing, views may resize or reposition with the new border template based on the following conditions:
  - Managed views are proportionately resized and repositioned according to the size of the new border template.
  - Unmanaged views are not resized and repositioned.
- Drawings must be updated after switching the border template in order to ensure all automated annotation is positioned correctly on the drawing.
- For views that are resized after the border template switch, drawing views using **Fit to Scale** show the same content. Views with a scale may have content clipped out if the view is made smaller after the switch.

For more information, see *Place Region Command* (on page 272).
**Drawing Sheet Properties Dialog Box**

Shows the drawing sheet properties associated with the selected drawing document(s) and allows you to change the border template file. When displayed for the **Switch Border** command on selected composed drawing documents, the only property available is **Border Template**. Select **More** in the **Value** field to display the **Select Template** dialog box and specify a new border template. Click **OK** to associate the new border template file to the selected drawing documents.

You need to update the drawings to regenerate them with the new border template file.

**See Also**

*Switch Border* (on page 371)
Add a Sheet to Drawing

In this workflow, you change the border for an individual sheet to a template different from the border template defined in the component. For example, you may want the first sheet of drawing to use a different border template than all other sheets.

1. Right-click a drawings by rule document in the Detail View and select Edit. The drawing opens in SmartSketch Drawing Editor.
2. Right-click a sheet tab at the bottom of the drawing view and select Insert. A new sheet is created and the Sheet Properties dialog box displays.
3. On the Current Sheet tab, select values for Border Template and Layout Template. Click Use Default to apply the default values for the drawing, as shown on the Default tab.
4. Click OK. The border and layout templates are applied to the new sheet.

Layers (SmartSketch Drawing Editor Tools Menu)

Layers are used to distinguish between graphics within a template or drawing. You can create layers in SmartSketch Drawing Editor with the Tools > Layers command.

Objects like drawing views, key plan views, report views, and drawing property labels are placed on the DwgTemplate layer when you save the drawing document. You should not place manual markups on the DwgTemplate layer.

When placing manual markups, such as graphics or company logos, place them in paper space within the drawing layers, not in model space (inside a drawing view). Markups placed within model space are not preserved. When a graphic rule does not specify a layer, intelligent graphics are placed on the Default layer.

Composed Drawings

When you create composed drawings, you can place manual markups on any layer of the drawing.

Volume (Spatial) and Orthographic Drawings by Query Drawings

For volume drawings, manual markups are preserved on any layer of the drawing, except the DwgTemplate layer. The DwgTemplate layer is reserved for system use. If you placed manual markups on the DwgTemplate layer, they will be lost when you update the drawing document.

Piping Isometric Drawings

If you intend to create manual markups within a Piping Isometric drawing, you should have a layer in the drawing template with a name prefix of User (for example, a layer named
UserAnnotationLayer). You could alternatively place your markups on the Default layer. The software preserves these layers when you update drawings. Other layers are not preserved.

If named layers do not exist in the template, the software creates them using the symbology specified in the style XML file. In the Isometric Style Options Browser, expand Drawing.Layers.Layers to create new layers within the style XML file. Map definitions to the layers under Drawing.Definitions.

If the named layers do exist in the template, use Tools > Display Manager in SmartSketch Drawing Editor to change the symbology used within the template.

Modify an Existing Border File

You can create a piping isometric drawing border from scratch using SmartSketch Drawing Editor. You use the commands available within SmartSketch Drawing Editor to place graphics and create appropriate layers.

You should name new border files with the name of the needed isometric style, such as Iso_Pipeline or Iso_Piperun.

1. Navigate to [Reference Data Folder]\SharedContent\PmfgIsoStyleData folder, and copy the appropriate existing border igr file to the [Reference Data Folder]\SharedContent\Drawings\Catalog\Templates folder. You can create a subfolder for the new file.

2. Rename the copied file with the .sha extension.

3. Open the copied .sha files with SmartSketch Drawing Editor.

4. Fit the view.


6. Select Tools > Display Manager. On the Layers tab, scroll down to see the values currently set in the .sha file. These are the color, line type, and width values for the named layers.

7. Make changes as needed, save the file, and exit SmartSketch Drawing Editor. The next time you use this .sha file as your drawing border template, the graphics will show the changes you made.

Isometric Drawing Styles (on page 107) in the Piping Isometric User's Guide

Custom Commands

Custom commands used in SmartSketch Drawing Editor.
Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command

The SP3DConvertExcelEmbedded.dll is a delivered custom command that allows you to convert an Excel spreadsheet report to the native text box format for use in 3D Drawings. The DLL to execute this command is located on the client machine in the %Program Files%\SmartPlant\3D\Drawings\Client\Bin folder. To run this custom command, select Tools > Custom Commands and browse to the DLL location on the machine.

To convert an embedded report, you must set the properties correctly on the associated views. For a 3D composed drawing, set the Report Output property for a report view as needed. For more information, see Report Properties Dialog Box (Place Report View Command) (on page 291). For a 3D volume drawing, select the Convert report output to text boxes (no Excel) property for the drawing view associated to the report view. For more information, see View Tab (Drawing View Properties Dialog Box) (on page 346).

When you run this command, the Convert dialog appears so you can specify the appropriate options for the convert operation:

- **Convert embedded Excel spreadsheet** - Indicates that the specified report will be converted to native text box format.
- **Convert and embed an Excel spreadsheet** - Indicates that the specified report will be converted to native text box format and then embedded in the current drawing document.
- **Replace converted spreadsheet with a new converted version from Excel** - Specifies that a converted spreadsheet report will be replaced with a new version of the same report.
- **File** - Indicates the report file to convert. Click the ellipsis button to browse to the appropriate file.

See Also
Region Properties Dialog Box (on page 274)

Edit a Composed Drawing

This procedure steps you through editing a composed drawing from either the Drawings and Reports task Management Console or from a 3D modeling task using the Tools > Drawings Console command. For additional information on any of the SmartSketch Drawing Editor commands mentioned in this procedure, see the SmartSketch Drawing Editor Help.

1. Right-click an existing composed drawing in the Management Console or the Drawings Console. The document opens in SmartSketch Drawing Editor. You can use the editing tools in SmartSketch Drawing Editor to modify the appearance of your drawing. You can also use the Composed Drawing tools to place new regions, drawing views, report views, and snapshot views on the drawing area. You can also place labels manually on the drawing.

   **NOTE**: When you place objects like drawing views, key plan views, report views, and drawing property labels, the software automatically places them on the DwgTemplate layer when you save the drawing document. You should not place manual markups on the DwgTemplate layer.

   If you use other native SmartSketch Drawing Editor commands (such as Place Line or Place Dimension) to add manual markups to the template, put them on the Default or a layer with "User" as the prefix (for example, a layer named UserAnnotationLayer to preserve the
changes when you update drawings. For more information on layers, see Layers (SmartSketch Drawing Editor Tools Menu) on page 373.

Layer: [UserAnnotation_2]

2. To place a new region in the drawing area, use the Place Region command. Regions are used to manage drawing views. Click and drag to place the new region. The Region Properties dialog box displays after you place the region shape. Specify the properties for the region you are adding and click OK to complete the creation.

3. To place a new drawing view, use the Place View command. If you want your new region to manage this drawing view, place the new drawing views within or touching the region. You can also place "unmanaged" views outside existing regions. Click and drag to create the drawing view shape. The Drawing View Properties dialog box displays so you can define the drawing view. For more information on the Drawing View Properties dialog box, see Drawing View Properties Dialog Box (Place View Command) - Steel Order Drawings (on page 260). For more information on how regions and views work together, see Composed Drawings in the Orthographic Drawings User’s Guide.

4. To place a report view, click Place Report View. The drawing view you select can be managed by a region or unmanaged (outside all regions). Click and drag to place the report on the drawing area. The Report Properties dialog box displays so you can specify the properties for the report. Click More in the Report Template property box to select from available reports. You can set the output format of the report using the Report Output Format and Report Justification properties on this dialog box. For more information, see Report Properties Dialog Box (Place Report View Command) (on page 291).

NOTES:

- The report view you create is empty. Use the Associate Objects to View command to associate a drawing view to the new report view. For more information, see Associate Objects to View Command (on page 276). The drawing view you select must already be associated with a volume in the model.
- You can associate multiple reports to the same view, but you cannot, in the current release, associate multiple views to the same report.

5. You can also place snapshot views on your composed drawing. You create the snapshot view content in a 3D task using the Tools > Snapshot View command. For more information on creating the snapshot view, see Snapshot View Command in the Common User’s Guide available from Help > Printable Guides.

To place the snapshot view on the composed drawing, use the Place Snapshot View command. Click and drag to place the snapshot view shape. The Drawing View Properties dialog box displays so you can specify the properties for the snapshot view.

6. You can place manual labels on the composed drawing using the Place Label command. For more information on placing labels manually, see Place a Manual Label (on page 294).

7. If a view association is incorrect, click Remove Associated Inputs. This command allows you to select a view and remove all associations to volumes, folders, and other views.

8. If you decided to delete a drawing view, a message box displays when you press Delete for a selected view, providing a chance to cancel the operation. After a drawing view is deleted from the drawing, the operation cannot be reversed.
9. To update the contents of a view, select and right-click the view then select **Update View** on the shortcut menu. The view is updated with the associated 3D model objects or report, depending on the association you made with the **Associate Object to View** command.

10. Save your drawing changes before exiting **SmartSketch Drawing Editor**.

11. Update the modified drawing to incorporate the changes. You can open the drawing to check the new layout and view content.

## Edit the Drawing Template

1. Right-click the component and select **Edit Template**. SmartSketch Drawing Editor and the **Sheet Properties** dialog box displays.

2. On the **Sheet** tab, select values for **Sheet Assignment Rule**, **Sheet Naming Rule**, **Border Template**, and **Layout Template**. These values are used for the first sheet when a drawing document is created.

3. On the **Document** tab, select values for **Document Assignment Rule**, **Document Naming Rule**, **Border Template**, and **Layout Template**. These values are used for sheets added to a drawing document after it is created.

   **NOTE** You can also click **Edit Sheet Properties** on the **Edit Template** ribbon toolbar to change values in the **Sheet Properties** dialog box.

4. Click **File > Save**.

5. Click **File > Exit**. The SmartSketch Drawing Editor window closes.

## Modify View Ribbon

Modifies the view size. This ribbon displays after a view is selected in SmartSketch Drawing Editor.

- **Finish** - Saves changes to the view.
- **Update View** - Select to update the view (Drawing) gets updated along with the parent volume in the model.
- **Undo Crop** - Select to remove an existing crop on the view. The view returns to its original boundaries. This option is not available for a view that cannot be cropped, such as a composed drawing view.

   **NOTE** Removal of cropping with **Undo Crop** is not visible on a view until the view is updated. Select **Update View**, and click **Finish** to see the results immediately. The results will also be visible after using **Update** or **Batch Update** in the Drawings and Reports task at a later time.
Crop a Drawings by Rule 2D Drawing View and the 3D Model Volume

When an orthographic steel order view in a drawings-by-rule drawing is based on a volume in the model, you can crop the view, and also resize the model volume to match the cropped view.

1. Select the view in SmartSketch Drawing Editor.
   
   *Four handles display on the view frame and Modify View ribbon displays.*

2. Drag the handles to resize the view to the needed size.

3. To immediately update the view, select Update View.

4. Click Finish.
   
   *The cropped view is saved and parent volume in the model is resized.*

**TIPS**

- To cancel the changes to the view size, click outside of the view without clicking Finish.

- If Update View is not selected, the view is marked out-of-date 🚨 in the Drawings View Explorer. You can right-click the view 🚨 and select Update.

**NOTES**

- The 2D view and the 3D volume maintain the cropped size with subsequent updates.

- Shell expansions are not based on a volume and cannot be cropped. For more information, see Create a shell expansion drawing in the Orthographic Drawings User’s Guide.

- Section and Detail views use their own commands for cropping. For more information, see Place a Section View (on page 316) and Place a Detail View (on page 320).
See Also
Drawings View Explorer (on page 233)

Remove Cropping on a Drawings by Rule View

1. Select a previously-cropped view in SmartSketch Drawing Editor.
   Four handles appear on the view frame and Modify View ribbon displays.

2. Select Undo Crop and Update View.
3. Click Finish.

   The view (and the parent volume in the model) changes to its original size.

Place an Unassigned View

The following steps describe the basic workflow for placing an existing view that is not assigned to a drawing.

1. Right-click a drawing document in the Detail View and select Edit. The drawing opens in SmartSketch Drawing Editor.
2. Drag an unassigned view from the Unassigned Folder in the Drawings View Explorer to the graphics view of the drawing.

   The view displays in the graphics view and the view icon ( or ) displays under the drawing sheet in the Drawings View Explorer.

   NOTES
   Dragging more than one view onto an existing drawing may require:
   - Deleting the existing drawing region, and dragging the views onto the drawing without a region.
Section View Orientation Rules in Drawings by Rule

**Plant Mode Section View Orientation Behavior**

The software automatically determines the "up" direction for section views. In most cases, the up direction is "up," or +Z. In cases where using +Z is impossible (for example, if the section view direction is Looking Plan or Looking Up), the software orients the view to the North direction.

The following examples outline common section view orientations:

**Looking Plan**

<table>
<thead>
<tr>
<th>P1 Cutting Plane</th>
<th>P2 Cutting Plane</th>
<th>P3 Cutting Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking East</td>
<td>Looking South</td>
<td>Looking South, East</td>
</tr>
<tr>
<td>Up direction is up.</td>
<td>Up direction is up.</td>
<td>Up direction is up.</td>
</tr>
</tbody>
</table>
Looking North

<table>
<thead>
<tr>
<th>E1 Cutting Plane</th>
<th>E2 Cutting Plane</th>
<th>E3 Cutting Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking South</td>
<td>Looking Plan</td>
<td>Looking South, Plan</td>
</tr>
<tr>
<td>Up direction is up.</td>
<td>Up direction is North.</td>
<td>Up direction is up.</td>
</tr>
</tbody>
</table>
Looking East

<table>
<thead>
<tr>
<th>E4 Cutting Plane</th>
<th>E5 Cutting Plane</th>
<th>E6 Cutting Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking South</td>
<td>Looking Plan</td>
<td>Looking South, Plan</td>
</tr>
<tr>
<td>Up direction is up.</td>
<td>Up direction is North.</td>
<td>Up direction is up.</td>
</tr>
</tbody>
</table>
Marine Mode Section View Orientation Behavior

The software automatically determines the "up" direction for section views. In most cases, the up direction is "up," or +Z. In cases where using the z-axis is impossible (for example, if the section view direction is Looking Plan or Looking Up), the software orients the view to the Port direction.

Additionally, angled sections of elevation views, and any section of a non-standard view direction (in which it is possible) uses Port orientation.

The following examples outline common section view orientations:

**Looking Plan**

<table>
<thead>
<tr>
<th>P1 Cutting Plane</th>
<th>P2A-P2B Cutting Plane</th>
<th>P3 Cutting Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking Fore</td>
<td>Looking Starboard</td>
<td>Looking Fore, Starboard</td>
</tr>
<tr>
<td>Up direction is up</td>
<td>Up direction is up.</td>
<td>Up direction is up.</td>
</tr>
</tbody>
</table>

![Diagram of Marine Mode Section View Orientation Behavior](image-url)
Looking Aft

<table>
<thead>
<tr>
<th>E1 Cutting Plane</th>
<th>E2 Cutting Plane</th>
<th>E3 Cutting Plane</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looking Port</td>
<td>Looking Plan</td>
<td>Looking Port, Plan</td>
</tr>
</tbody>
</table>

Up direction is up. Up direction is Port. Up direction is Port.

Looking Port

<table>
<thead>
<tr>
<th>E4 Cutting Plane</th>
<th>E5 Cutting Plane</th>
<th>E6 Cutting Plane</th>
</tr>
</thead>
</table>
Looking Fore | Looking Plan | Looking Fore, Plan
Up direction is up. | Up direction is Port. | Up direction is Port.

For more information, see Orientation Rules in Drawings by Rule in the Drawings and Reports Reference Data Guide.

Update and Full Update Commands

The Update and Full Update commands are available when you right-click a drawing view in the Drawings View Explorer.

**Full Update** performs a full update of all geometry in the view. It does not consider whether the model objects associated with the geometry has changed.

**Update** performs a smart update of the view or a set of selected views from the same sheet. If a set of criteria is met, then an incremental update is performed only for the geometry of added, modified, and deleted objects. If the criteria are not met, then a full update — the equivalent of **Full Update** — is performed.

All of the following criteria must be met for **Update** to trigger an incremental update:

- The view has had at least one full update previously performed.
- The only view properties that have changed are name and description. For more information, see **View Tab (Drawing View Properties Dialog Box)** (on page 256).
- The numbers of added, modified, or deleted objects are less than set quantities.
- The software allows incremental updates for the selected view type.

Any one of the following criteria cause **Update** to trigger a full update:

- The view is new and has never had a full update.
- The view is a section or detail view. For more information, see **Place Detail Envelope Command** (on page 304) and **Place Cutting Plane/Section View Command** (on page 308).
- The view has been cropped. For more information, see **Crop a Drawings by Rule 2D Drawing View and the 3D Model Volume** (on page 378).
- The view style, scale, orientation, or coordinate system have changed. For more information, see **View Tab (Drawing View Properties Dialog Box)** (on page 256).
A primary plate object in the view has been split or unsplit.

The numbers of added, modified, or deleted objects are greater than a set percentage of the total number of objects.

The software does not allow incremental updates for the selected view type.

**NOTES**

- An incremental update is usually faster than a full update, but still results in completely up-to-date geometry for the view.
- The **View Log** command displays a log of the results from the last update performed on the view with the **Update** or **Full Update** commands.

**See Also**

*Drawings View Explorer* (on page 233)

**Run Update or Full Update**

You run **Update** or **Full Update** after structure displayed in a view has been modified in other tasks, such as Molded Forms or Structural Detailing.

1. Right-click a drawing document in the **Drawing Console** or the Detail View of the Drawings and Reports task, and select **Edit**.

   *The drawing opens in SmartSketch Drawing Editor.*

2. If you know that objects in a view have changed, even if the view is still marked as up-to-date in the **Drawings View Explorer**, right-click the view in the **Drawings View Explorer** and select **Update** or **Full Update**.

   *A progress bar displays, detailing the update process.*

**NOTE** You can update multiple views in the same sheet by selecting the sheet node or the individual sheets.

1. If you do not know if objects in a view have changed:

   - Right-click the view in the drawing area or the **Drawings View Explorer**, and select **Refresh**. The view is marked out-of date in the **Drawings View Explorer** if objects have changed.

   - Right-click the view in the **Drawings View Explorer**, and select **Update** or **Full Update**.

2. Optionally, right-click the view in the **Drawings View Explorer**, and select **View Log** to check the results of the update.
Delete Views

Delete Views Placed by the Place View Command
1. Right-click a view placed by using Place View.
2. Select Delete.
   The Delete Views dialog box displays.
3. Select Yes to delete the view permanently. To cancel the operation, click No.

Delete Views Placed by Rules
1. Right-click a view in Drawing View Explorer.
2. Select Delete.
   The Delete Views dialog box displays.
3. Select Delete to delete the view permanently.
   Notes:
   - The UnAssign option moves the view to the UnAssigned Folder. The Cancel option cancels the operation.
   - If you delete a view that is a parent of other views, such as a detail or section view, the Convert or Delete dialog box displays. Select Convert to independent drawing view(s) to save the child view as an independent drawing view, or select Delete to delete the child view.

Delete Views from the UnAssigned Folder
1. Right-click a view from the UnAssigned Folder.
2. Select Delete.
   The Delete Views dialog box displays.
3. Select Yes to delete the view permanently. To cancel the operation, click No.
Revising

The document revision process is separate from the publishing process, making it possible to revise a document locally and save it to the database without re-publishing it. The Revise command is available on the right-click menu for drawings, reports, and 3D Model Data documents. In an integrated environment, all revisions are handled by SmartPlant Foundation.

Revising and publishing are two separate actions. You specify the document revision using the Revise command, which creates a Revision for the document with Major and Minor set, depending on the revision schema selected. If you are working in an integrated environment, you can modify the other revision information on the document.

After setting the revision number, right-click the document and select Properties. Select the Revision tab and edit the Revision fields. You should update documents to include any new title block information.

You can now re-publish the document with the new revision information.

NOTES

- You can use the Revise command if your model has been registered using the SmartPlant Registration Wizard. For more information on registering, see the Project Management User's Guide under Help > Printable Guides.
- If the drawing document that you are looking at in the Detail View has a yellow icon (for example: ), the drawing document is a version 6.1 legacy Snapshot drawing. You should use the Tools > Convert Legacy Snapshots command to convert this document to a Composed Drawing for use in the current version of the software. If you do not convert the legacy snapshot drawing, you cannot perform edit operations on the drawing, including update, revise, and publish.

See Also
Publishing Documents (on page 391)
Revise (on page 388)
Revise a document (on page 389)

Revise

Revising and publishing are two separate actions. You specify the document revision using the Revise command, which creates a Revision for the document with Major and Minor set, depending on the revision schema selected. If you are working in an integrated environment, you cannot modify the Major and Minor revision data, but you can modify the other revision information on the document.

After reserving the revision number, right-click the document and select Properties. Select the Revision tab and edit the Revision fields. You should update documents to include any new title block information.

You can now re-publish the document with the new revision information.

Revise Dialog Box (on page 390)
Revising

NOTE You can use the Revise command if you have registered your model using the SmartPlant Registration Wizard. For more information on registering, see the Project Management User's Guide under Help > Printable Guides.

Revise a document

You can revise drawings, reports, and 3D Model Data documents if you have registered your model using the SmartPlant Registration Wizard. For more information about using the SmartPlant Registration Wizard, see the Project Management User's Guide under Help > Printable Guides.

1. Right-click a document and select Revise. The Revise dialog box displays.

   TIPS
   - You can also multi-select documents in the Detail View, or you can select a folder in the Management Console hierarchy to select all of the documents within the folder if they all have the same revision level.
   - If the Revise command is not available on the shortcut menu, check the properties on the document. Right-click the document and select Properties. Go to the WBS tab and make sure that you have a Document type and Discipline set for the document. For more information, see Set properties for publishing documents (on page 396).

2. For a new document or a document that does not yet have a defined revision scheme, select the revision scheme that you want to use from the Revision Scheme list.

   NOTE Only revision schemes that are applicable to the configuration (plant) or classification (document type) are available in the shortcut menu. The revision schemes related to a configuration or classification are not available for any other configurations or classifications. If none of the revision schemes are related to the configuration or classification, then all revision schemes are available unless they are related to any other configuration or classification. For more information on revision scheme configuration, see Configuring Different Revision Scheme Strategies in the How to Configure Document Management guide.

3. In the Revise in Tool section, select the next available major and minor revision numbers.

4. Click OK. The document is saved to the model database. The command creates a revision record by adding it to the document Revision properties. The command also reserves the revision number.

5. Right-click the document and select Properties.

6. Go to the Revision tab and edit the values in the new revision row.

7. Update the document to update any document property title block information. For more information, see Updating Documents (on page 75).

8. Re-publish the document. The stored document is not updated until you publish it.
Revise Dialog Box

Allows you to revise a document in the database of the authoring tool without publishing it.

**NOTE** Fields with a shaded background are read-only fields and cannot be edited.

**Selected documents** - Displays a list of the documents selected to be revised or for which you want to reserve a set of revision numbers. You populate this list by selecting documents before you use the **Revise** command.

**Engineering Tool** - Opens an authoring tool-specific dialog box that allows you to select documents to add to the **Selected documents** list. This option is not available in Smart 3D.

**Revision Scheme** - If you have selected a new document or a document for which no revision scheme has been selected, choose the revision scheme to be applied from the list of available options. Only revision schemes that are applicable to the configuration (plant) or classification (document type) are available in the shortcut menu. The revision schemes related to a configuration or classification are not available for any other configurations or classifications. If none of the revision schemes are related to the configuration or classification, then all revision schemes are available unless they are related to any other configuration or classification. For more information on revision scheme configuration, see Configuring Different Revision Scheme Strategies in the How to Configure Document Management guide.

**Current Revision in Tool Major** - For existing documents, this field displays the current major revision of the document, as defined in the authoring tool, in a read-only format. For new documents, this field is empty.

**Current Revision in Tool Minor** - For existing documents, this field displays the current minor revision of the document, as defined in the authoring tool, in a read-only format. If the revision scheme does not use minor revision, or if the selected document has not yet been revised, this field is empty.

**Revise in Tool Major** - From this list box, choose the next available major revision number for the document to revise it locally, without publishing the new information. If you do not want to revise the document at this time, in other words, if you want to reserve revisions numbers without revising the document, leave this field empty.

**Revise in Tool Minor** - From this list box, choose the next available minor revision number for the document to revise it locally, without publishing the new information. If you do not want to revise the document at this time, in other words, if you want to reserve revisions numbers without revising the document, leave this field empty. If minor revisions are not supported for the document, no options are available in this list.

**IMPORTANT** If you do not use the **Minor** field when revising a document for the first time, the minor revision option will never be available for that document for future revisions.

**Next Major** - Updates the document revision to the next major revision.
Publishing Documents

When you work in an integrated environment with SmartPlant Enterprise, you must publish documents containing the drawing data and relationships before other authoring tools can share this information. You can publish your documents from the Drawings and Reports task Management Console or from a 3D modeling task by using the Tools > Drawings Console command.

Before you can publish documents in the software, you must install the SmartPlant Client and the SmartPlant Schema Component, then register the model using the SmartPlant Registration Wizard.

In a 3D task, you can use SmartPlant > Retrieve to create and update the Design Basis objects.

The software allows you to publish modified and new objects with the Changes Only option. Publish tasks processed through the Changes Only workflow are smaller compared to All publishes, and are queued to Load and Consolidate before the merge operation. The merge operation combines the delta data with the previous complete publish data. After the merge operation succeeds, the information is retrievable. The Changes Only publishes are not retrievable. To retrieve a Changes Only publish, you must perform an All publish, which only happens after the load and consolidate processes.

The Publish and UpdatePublish commands are available for the following document types:

- 3D Model Data (SmartPlant Review file type)
  
  **NOTE** The 3D Model Data component is capable of publishing many object types (for example: Piping, Equipment, Cable Trays) depending on the definition of the filter during component setup.

- Orthographic Drawings (viewable file with links to data)

- Piping Isometric Drawings (viewable file with links to data)
  
  **NOTE** Isometric Style Options Browser allows publishing additional files (for example: PCF, POD) along with the SHA drawing. For more information, see Published Files (S3D Supplementary) (on page 673).

- Reports (viewable file with links to data)

**NOTES**

- The viewable files created when you publish drawings and reports provide relationship links to the 3D Model Data. You must also publish the 3D Model Data to provide the navigation between the viewable files and the 3D Model Data.

- The Publish > UpdatePublish command updates and then immediately publishes the selected documents in one step. This command is available only if the model is registered with SmartPlant Foundation.

- If the drawing document you are looking at in the Detail View has a yellow icon (for example: ![]), the drawing document is a version 6.1 legacy Snapshot drawing. You should use the Tools > Convert Legacy Snapshots command to convert this document to a Composed Drawing for use in the current version of the software. If you do not convert the legacy snapshot drawing, you cannot perform edit operations on the drawing, including update, revise, and publish.
If you are publishing 3D Model Data documents, set the surface style rules and aspects before publishing the documents.

Every time you generate drawings and reports from Smart 3D in an integrated environment, a SmartPlant Foundation token is used.

When you publish documents, the software:

- Publishes a visual representation of the document that you can view without Smart 3D. For drawings, this is an Intergraph proprietary file, called a RAD file (.sha). For reports, the viewable file is a Microsoft Excel workbook. You can review and mark up the visual representation of the document using SmartPlant Markup Plus or SmartSketch.
- Places the published XML file and any viewable files in the appropriate SmartPlant Foundation vault. This XML file can be retrieved when you are in other authoring tools.

Reasons to Publish

You publish documents and associated data for several reasons:

- Exchanging of data with other tools
- Sharing common data between tools
- Providing enterprise-wide accessibility to published documents
- Managing change, including workflow history, document revisions, and title block information

Revisions and Versions of Published Documents

The first time that you publish a document, the software creates a new document master and the first revision. A revision (major) is an officially recognized change to a document. A version (minor) is an intermediate update that you have published. Revisions can be published for sharing or they can go through an approval process, depending on your needs. Each revisions of a document can have multiple versions.

You can also include revision information within the title block of a drawing by placing drawing property labels within the drawing template.

NOTE When you publish data from any authoring tool, you may not be able to view all of the properties that you published in the SmartPlant Client. You can customize view definitions to allow you to see additional properties. For more information on defining view definitions in the SmartPlant schema, see the SmartPlant Schema Editor User’s Guide. For further assistance with viewing data, contact Intergraph Support Services. You can find support information on our web site, http://support.intergraph.com (http://support.intergraph.com/).
Publishing Title Blocks

The title block is generally displayed at the bottom of a drawing template. It can include signatures, revision and issue information, and other properties associated with the drawing.

You add drawing properties, such as revision information or issue requests, to the title block using the **Place Drawing Property Label** command when editing a template.

When you update the revision information or receive an issue request on a drawing document, the associated properties must be updated. You update the drawing document to incorporate the property changes for any drawing property labels included in the title block.

After you update the drawing document, you can re-publish it and the appropriate title block information is recorded in SmartPlant Foundation. Publishing your drawing document helps you manage the changes, including workflow history, document revisions, and title block information.

The general workflow for including information in the drawing title block is:

1. Edit a template and include drawing property labels for revision or issue request - *Place a Drawing Property Label on a Template* (on page 355).
2. Create drawing documents using the template.
3. Publish the drawings - *Publish documents* (on page 399).
4. Revise the drawing document or receive an issue request from SmartPlant Foundation - *Revise a document* (on page 389) or *Issue request documents* (on page 403).
5. Update the drawing documents to include the new revision, issue, or other drawing property information in the title block.

**See Also**
*Delivered Drawing Types* (on page 23)
*Publishing Documents* (on page 391)
*Updating Documents* (on page 75)
Publish Common Tasks

The following tasks are used to publish documents. If the documents are drawings or reports, the Publish command publishes a viewable file with links to the data. If publishing a 3D Model Data document, the software creates a SmartPlant Review file and publishes it.

**NOTE** The viewable files created when you publish drawings and reports provide relationship links to the 3D Model Data. You must also publish the 3D Model Data to provide the navigation between the viewable files and the 3D Model Data.

Setting Properties for Publishing

Before using the Publish command, you should set certain properties on your documents.

If you are publishing 3D Model Data documents, set the surface style rules and aspects as needed before publishing.

Creating and Reserving Revision Numbers

You should create your documents by right-clicking them and selecting Create Document(s). After they are created, if you require revision numbers for the documents, use the Revise command to reserve the revision numbers.

Update the Documents

Update the documents, right-click the component and select the appropriate Update command. You can also use Batch > Update if you are configured to use a batch server.

Publish Data

If you have registered your model using the SmartPlant Registration Wizard, you can publish your documents for retrieval and use in other tools. You can use the Publish > Update command to update drawings and publish them in one step. You can also use the SmartPlant > Find Documents to Publish command to generate a list of documents that need to be published and to publish terminations for deleted drawings, isos, and so on.

Issue Request Documents

You can also use the Publish command to issue a contract request for documents. For more information, see Issue request documents (on page 403).
Publish

Publishes the information in the selected documents. You can access the **Publish Documents** command by right-clicking a component or document.

The **Publish** and **UpdatePublish** commands are available for the following types of documents:

- 3D Model Data (SmartPlant Review file type)
- Orthographic Drawings, including Volume and Composed drawings (viewable file with links to data)
- Piping Isometric Drawings (viewable file with links to data)
- Reports (viewable Microsoft Excel workbook file with links to data)

**NOTES**

- The viewable files created when you publish drawings and reports provide relationship links to the 3D Model Data. You must also publish the 3D Model Data to provide the navigation between the viewable files and the 3D Model Data.
- The **Publish > UpdatePublish** command updates and then immediately publishes the selected documents in one step. This command is available only if the model is registered with SmartPlant Foundation.

**IMPORTANT** When you publish a 3D model, you must now enable the **Scheduler** and **Loader** in SmartPlant Foundation to make the 3D model data document retrievable. The load, consolidate, and merge tasks must complete successfully before the 3D model document can be retrieved.

Define the **Discipline** and **Document Type** properties to enable publishing for the documents. For more information see **Set properties for publishing documents** (on page 396).

**NOTE** For 3D model data, the **Discipline** and **Document Type** properties are already populated.

You may also want to specify documents to be revised, not published, or reserve revision numbers. For more information, see **Revising** (on page 388).

To generate a list of documents that need to be published, you can use **SmartPlant > Find Documents to Publish**. For more information, see **Find Documents to Publish** (on page 408).

You can publish isometric drawings to SmartPlant Foundation in additional file formats other than the **SHA** drawing file format. These additional files along with the **SHA** drawing are generated by the update process. When publishing isometric drawings you can also publish other available data files and reports generated by the update process. For more information, see **Published Files (S3D Supplementary)** (on page 673).

*Publish Dialog Box* (on page 404)
Set properties for publishing documents

1. In the **Console**, right-click an item in the hierarchy, then select **Properties** on the shortcut menu.
2. Go to the **WBS Tab**.
3. Set the **Document Type** property as needed, such as Civil Plan. This property specifies the document subtype when published.
4. Set the **Document Style** property as needed, such as Ortho for an orthographic drawing.
5. Set the **Discipline** property. If your model has been registered using the SmartPlant Registration Wizard, this property adds the **Publish** command to the right-click menu for the selected document or documents. For a 3D Model Data document, the property is set to **SmartPlant Review Document**. For a drawing or report document, set the discipline to match the type of document.
6. Set the **Allow Publish** property to **Yes**.

**NOTES**

- If you do not want an item to acquire a property from its parent, select the **Override** column on the **Properties** dialog box, then type a new value. This value propagates to other items deeper in the hierarchy.
- The software treats blank or cleared property values as overrides.
- Before you can publish documents, you must:
  - Install the SmartPlant Client and the SmartPlant Schema Component.
  - Register your model using the SmartPlant Registration Wizard.
  - Revise and update each document.

For more information about configuration, see the *Intergraph Smart™ 3D Installation Guide*, available from Help > Printable Guides.

Support for Handling Large Publishes

The number of objects published from Smart 3D can become so large that the normal update and publish processing uses up the resources such as memory and address space on the client and server computers. To address these resource issues, Smart 3D now supports the concept of using a cache to keep track of objects that have changed and to only publish these objects. Thus, the software avoids processing objects that have not changed. The mechanisms for doing this are called delta update, delta publish, and auto-scoping. These processes are not visible to the user.

- **Delta update** - Updates only the objects that are modified, deleted, or moved and then process these. Because only changes are updated, you can produce larger XML and graphics files without prior address space limitations.
- **Delta publish** - Leverages the cached information provided by delta update to determine which objects need to be published. Because only changes are published, you can produce larger files in the data warehouse.

Because the complete set of objects will not be published each time, it is up to Smart 3D to keep track of deleted and moved objects. These moved or deleted objects will be sent with the
published objects, eliminating the need to probe the adapter for the existence of missing objects.

**IMPORTANT**  When you publish a 3D model, you must now enable the **Scheduler** and **Loader** in SmartPlant Foundation to make the 3D model data document retrievable. The load, consolidate, and merge tasks must complete successfully before the 3D model document can be retrieved.

Both delta update and delta publish can publish larger documents by automatically splitting the data into smaller sections in Smart 3D. If your publish data is split into smaller sections, the document version number increments for each section.

For example, if you publish a document that is split into four smaller sections, the **Version** field contains all resulting version numbers. In the following dialog box, the published documents are published to SmartPlant Foundation as 4 different versions (11-14). The last version contains all of the updated information from the publish.

**Published Documents - Load, Consolidated, and MergeDelta Tasks (S3D)**

A tool published document results in a document version object in SmartPlant Foundation. A document version has four files attached to it.

1. **Data XML file** – Contains published objects, relationships and correlations (SameAs relationships).
2. **Meta data XML file** – Contains meta data about the published document version.
3. **Instructions XML file** – Contains instructions for deleted objects and relationships. Also contains resurrect instructions for objects that were deleted previously and resurrected as a result of restoring a tool database.
4. **View file** – This is a file in the tool format that represents the (graphical) view of the published document.
When a document is submitted to a workflow that has a load process step, the following tasks are created.

**NOTE** If the document is not published to such a workflow, and when the **Load document** command in SmartPlant Foundation Desktop Client is run on the published document, the same tasks are created.

- **Load Task** - This task processes the objects and relationships in the data XML by loading them into a publish domain. This task also processes the instructions in an Instructions XML file. For example, the delete instruction would result in termination of the object referenced in the delete instruction.

- **Consolidate Task** - This task processes the correlations (SameAs relationships) in the data XML file. A SameAs is a correlation relationship published by tools indicating that a published object is identical to an object published by another tool. The correlation of the object in the current publish domain (say, local object) to the external object (object published by another tool in another publish domain) is done by creating a shared object in the Data Warehouse domain. The local and external objects are linked through SPFComprisedOf relationships; for example, one SPFComprisedOf relationship between the local object and the shared object, and a second SPFComprisedOf relationship between the external object and the shared object.

  **NOTE** An object that is not correlated also has a shared object created in the Data Warehouse domain in preparation for future correlation.

  The consolidate task also creates a hidden file, known as graphical mapping file, which has mappings between objects in the database and graphical elements in the view file. This file is used by SmartPlant Foundation Desktop Client for navigation between published objects in the list view and their graphical representations in the view file.

- **MergeDelta Task** - This is a task created for delta publishes of Smart 3D. A delta publish contains new, modified and deleted objects in a document since the last publish of that document. Only Smart 3D has the capability to do a delta publish. Other tools publish full data where every object is published whether it is modified or not since last publish.

  Because a delta published data XML file and view file only contains the delta, it is required that it becomes a full data XML and full view file for complete view of the data and graphics of that document. The MergeDelta task converts the delta data XML file into a full XML file by merging data from the previous full XML file into the delta XML file.

  **IMPORTANT** When you publish a 3D model, you must enable the Scheduler and Loader to make the 3D model data document retrievable. The load, consolidate, and merge tasks must complete successfully before the 3D model document can be retrieved. For more information, see Schedulers and Queue Management.

  **NOTE** If you are using **SmartPlant Basic Integrator**, only the merge task must complete successfully before the 3D model document can be retrieved. For more information, see Schedulers and Queue Management.

  The merge involves the following:
  a. Replace modified objects and relationships in the full publish XML, view file, and the hidden graphic map file.
  b. Delete objects and relationships that are identified in the delete, and move instructions in the delta instructions XML file, view file, and the hidden graphic map file.
Publishing Documents

c. Add new objects and relationships to the full publish XML, view file, hidden graphic map file.
d. Replaces the delta XML file in the vault with the updated full publish XML file, view file, and the hidden graphic map file.

Set SmartPlant Foundation to Tolerate Failed Loads

For working in any integrated environment, a new site configuration flag in SmartPlant Foundation Server Manager allows the SmartPlant Foundation Loader to skip a published document that failed during load and continue processing other documents in the queue.

In SmartPlant Foundation Server Manager, set the SkipFailedDocumentsInLoad flag to True to allow failed documents to be skipped and other documents to continue processing. Typical behavior is that after a document is successfully loaded, any previous failed document is removed from the queue.

The behavior during a Smart 3D publish is different. If any Smart 3D publish, either a full publish or delta publish, fails to load, the failed versions remain in the load queue until a full publish successfully loads. If a delta publish loads successfully following these failures, it does not remove any previous failed version from the queue because the data in delta publishes is different from version to version, so a failed previous version needs to stay in the queue until you resolve the failure or a full publish is loaded. A second reason is this gives an indication to you that a full publish is needed. When a full publish is loaded, all failed delta publishes are removed from the queue.

Publish documents

Before you can publish documents, you must ensure that your computer is configured properly. The configuration includes installing the SmartPlant Client and the SmartPlant Schema Component and registering the model through the SmartPlant Registration Wizard.

You must use the SmartPlant > Retrieve command in one of the 3D tasks to import published data.

**Important** When you publish a 3D model, you must now enable the Scheduler and Loader in SmartPlant Foundation to make the 3D model data document retrievable. The load, consolidate, and merge tasks must complete successfully before the 3D model document can be retrieved.

**Note** The SmartPlant menu is not available in all tasks.

1. Right-click a component and select Publish. The Publish dialog box displays.

   **Notes**

   - If the Publish command is not available on the shortcut menu for the component or document, check the document properties and make sure that the documents are up-to-date and have been revised first.
   - You can use the Publish > UpdatePublish command to update drawings and publish them in one step. This command is available only if the model is registered with SmartPlant Foundation.

2. Edit information as necessary for the selected documents.

   When multiple documents are selected, only property values shared by all of the selected documents display in the table. Changing a value in the table changes that value for all of the selected documents.
3. Select the **Publish Type**.
   - Smart 3D supports **Publish Type** for delta publish.

   **NOTES**
   - The default setting for **Publish Type** is **Changes Only**. If the 3D model has not been published before, the software automatically selects **All** and performs a complete publish to ensure all filtered data is published and loaded into SmartPlant Foundation.
   - For subsequent publishes, select **All** to publish all filtered data in the 3D model, even if it is unchanged. Select **Changes Only** to publish only the changes in the 3D model since the last successful publish.
   - If the 3D model does not publish successfully during a delta publish, select **All** so that data from the previous publish is published and loaded into SmartPlant Foundation.
   - Other SmartPlant applications do not support **Publish Type**. For these SmartPlant applications, the default setting for **Publish Type** is **All**, and it cannot be changed.

4. Select one of the following operations:
   - **Publish** to publish the selected documents immediately.
   - **Background publish** to publish as a separate process so that you can continue working in the application.
   - **Scheduled publish** to publish in the batch mode by the authoring tool. The documents are not published immediately. Instead, the selected documents are scheduled for publish at a later time and may be scheduled as a recurring operation.

5. Click **OK** to publish the selected documents.

   **NOTES**
   - You can verify the publishing process by starting the SmartPlant Client on your computer and searching for the published document.
   - When publish is complete, the following message displays: **Documents have been published successfully**. If the **View Log** button is enabled, messages are available concerning the operation. These messages include errors, warning, and informational messages. Click **View Log** to review these messages.

### Publish Workflows

When a SmartPlant application publishes, the user can publish documents using a workflow. The following list describes the delivered publish workflows and use cases for the workflows.
<table>
<thead>
<tr>
<th>Workflow</th>
<th>Workflow Description</th>
<th>Workflow Use Cases</th>
</tr>
</thead>
</table>
| Auto-Correlate    | Compares the objects in a published document to the objects that are already in SmartPlant Foundation. If the object correlates (by name) to an object with the same shared object definition, SmartPlant Foundation automatically correlates the objects. If the object can correlate to more than one object through multiple shared object definitions, a task is placed in the To Do list to allow the user to select the correlation. | Use Auto-correlate  
- When a publishing tool does not have correlation functionality.  
- When a publishing tool does not retrieve.  
- When using SmartPlant Foundation to perform consistency checking and the authoring applications do not retrieve.  
- When Shared Objects To Correlate option is used to configure which types of objects are auto-correlated. |
| AutoLoadPublish   | Generates a document load task and consolidate task for the publishing document. These tasks are performed by the SmartPlant Foundation Scheduler.                                                                 | Use AutoLoadPublish when you intend to load the published document data into SmartPlant Foundation.                                                 |
| AutoLoadPublishMerge | Publish large 3D models. Creates the published 3D document, loads the 3D data in SmartPlant Foundation, then merges these object sets into a new composite document that represents the entire 3D model. | Use AutoLoadPublishMerge when you intend to view or navigate multiple 3D models as one composite 3D model document in one 3D view. |
| Correlate         | Places published objects with possible correlations in the To Do list. From the To Do list, the user manually correlates selected items. SmartPlant Foundation creates a shared object. | Correlate works similar to Auto-Correlate except you can view the possible correlations before the actual correlation takes place. |
| Publish           | Takes the document through an approval step. Upon approval, it creates the document load and consolidate tasks.                                                                                                    | Use Publish when you want the published document approved before it is loaded into SmartPlant Foundation. The approval step is added to the To Do list. |
| PublishWithDocLoad | Loads document into a document configuration and submits document to approval step. Upon approval, it creates document the load and consolidate tasks.                                                              | Use PublishWithDocLoad when you want to view the document data in SmartPlant Foundation before approval. The approval step is added to the To Do list. |
Publishing Documents

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Workflow Description</th>
<th>Workflow Use Cases</th>
</tr>
</thead>
</table>
| Auto-Correlate   | Compares the objects in a published document to the objects that are already in SmartPlant Foundation. If the object correlates (by name) to an object with the same shared object definition, SmartPlant Foundation automatically correlates the objects. If the object can correlate to more than one object through multiple shared object definitions, a task is placed in the To Do list to allow the user to select the correlation. | Use Auto-correlate  
▪ When a publishing tool does not have correlation functionality.  
▪ When a publishing tool does not retrieve.  
▪ When using SmartPlant Foundation to perform consistency checking and the authoring applications do not retrieve.  
▪ When Shared Objects To Correlate option is used to configure which types of objects are auto-correlated. |
| PublishForLoadOnly | Generates a document load task and consolidate task for the publishing document and makes the documents irretrievable by any tool. These tasks are performed by the SmartPlant Foundation Scheduler. | Use PublishForLoadOnly when you want to publish documents to view, navigate and also for consistency checking in SmartPlant Foundation without the possibility of the document being retrieved by any tool. |

Publish a large 3D model to SmartPlant Foundation

Publishing large 3D models to SmartPlant Foundation has reached memory and file transfer limitations. To make publishing 3D models more efficient, you can publish models in distinct object sets that accommodate your memory resources. Distinct object sets mean that an object in the 3D model must appear in only one published model. You publish these object sets using a workflow called **AutoLoadPublishWithMerge**. This workflow has **MergePublishedFile** process step configured. This workflow creates the published 3D document, loads the 3D data in SmartPlant Foundation, then merges these object sets into a new composite document that represents the entire 3D model. The name of the composite document is same as the name of the workflow to which the Published 3D model is submitted. If you have existing published 3D models in SmartPlant Foundation and want to merge these into one representative model document, you can create a 3D composite document manually, and then relate the published models to the document.

1. Create filters for segregating and selecting data that will be in the published model documents. For example, you can create filters for equipment, piping, structural, and HVAC.
2. In the **Drawings and Reports** task, create your separate model documents.
3. Publish each model document separately.

**NOTE** The software publishes a new version of the 3D document, for example, a model document called Equipment-1-001, to SmartPlant Foundation. This document is related to **AutoLoadPublishWithMerge**, a zvf file, and a mapping file.
4. On the **Publish** tab on the **Publish** dialog box, select the **AutoLoadPublishWithMerge** from the **Workflow** list.

**Issue request documents**

Before you can publish documents, you must ensure that your computer is configured properly. The configuration includes installing the SmartPlant Client and the SmartPlant Schema Component and registering the model with the SmartPlant Registration Wizard. For more information, see the *Intergraph Smart™ 3D Installation Guide* available from **Help > Printable Guides**. For more information on the steps involving the SmartPlant Foundation Desktop Client, see the *SmartPlant Foundation Desktop Client User’s Guide*.

**NOTE** This functionality is only available in project mode. It is not supported in integration mode.

You must use the **SmartPlant > Retrieve** command in the Common task to import published data.

1. Right-click a component and select **Publish**. The **Publish** dialog box displays.

   **NOTE** If the **Publish** command is not available on the shortcut menu for the component or document, check the document properties and make sure that the documents are up-to-date. For more information, see *Set properties for publishing documents* (on page 396).

2. Click the **Issue Request** tab.

3. In the **Issue to** field, select the contract that you want to assign the document or documents.

4. Under **Selected documents**, select the documents that you want to associate with the specified contract.

5. Click **Add** to add the documents to the **Issue Request** list. To remove documents from the list, select them and click **Remove**. Click **Engineering Tools** to add documents from engineering tools, such as P&IDs or PFDs. Click **File System** to add documents from another file system, such as Microsoft Word documents or Microsoft Excel workbooks.

6. Click **OK** to issue the contract request for the selected documents.

7. Start SmartPlant Foundation Desktop Client on your computer and search for the published document to verify the publishing process.

8. Right-click the document in the Desktop Client tree view and select **Refresh**.

9. Return to the Drawings and Reports task and update the document to incorporate the new Issue information. For more information, see *Updating Documents* (on page 75).

10. Review the Issue properties. Right-click the document and select **Properties**. Select the **Issue** tab to see the Issue information. You can also open the document to see the Issue information in the title block if you added it.

11. Publish the document with the updated Issue information. For more information, see *Publishing Documents* (on page 391).

**NOTES**

- Only updated documents can be published.
- You can verify the publishing process by starting the SmartPlant Client on your computer and searching for the published document.
Publish Dialog Box

Provides a list of documents selected to publish.

Publish Tab (Publish Dialog Box) (on page 404)
Issue Request Tab (Publish Dialog Box) (on page 407)

See Also
Publish documents (on page 399)
Find Documents to Publish (on page 408)
Publish (on page 395)
Document Properties Dialog Box (on page 407)

Publish Tab (Publish Dialog Box)

Displays the properties of the selected document or documents. If only one document is selected in the tree view, the properties displayed on this tab are the properties of that one document. If multiple documents are selected, only the properties with the same value for all documents display. Any properties with varying values across the documents display with blank values in these fields.

You can change some of the values assigned to one or more documents by changing the value displayed in the table. The value you type here overrides any existing values for all selected documents.

Selected documents - Displays a list of the documents selected for publishing. You must populate this list by selecting documents in the Management Console or Detail View before you use the Publish command. For each document, this list displays the name, the type of document, the workflow from which the document was last published, the revision and version numbers, the revision scheme, and the date when the document was last published.

Engineering Tool - Opens a dialog box to select documents to add to the Selected documents list. This functionality is not available in the current release.

File System - Opens a standard Microsoft dialog box that allows you to select documents to add to the Selected documents list. When you select a file with this Select File dialog box, the Document Properties dialog box displays, allowing you to specify information about the file, such as whether it is a new file; the category, type, and subtype of the document; and the name, description, and title of the document.

Find - Opens the Find Documents to Publish dialog box, which allows you to search for documents to add to the Selected documents list. For more information, see Find Documents to Publish Dialog Box (on page 409).

Last Published - Indicates the date on which the document or documents were last published.

Name - Displays the name of the document.

Source - Indicates the authoring tool in which the document was created.

Type - Displays the type of document or documents selected.
Comment - Allows you to type information about the selected documents that are publishable.

Issue Only - Allows you to issue request documents without, necessarily, republishing them. Use this option when no changes were made to a drawing and you only want to add it to a contract.

**TIPS**

- Even with this option set, you can still publish the documents. If any of the documents have never been published, they must be published, regardless of this setting.

- You will receive an error message if you select multiple documents and activate this option when one or more of the selected documents cannot be changed. For example, the error message displays if the selected set of documents includes both a new document (for which this field can be set only to No) and current or locked documents (for which this field can be set only to Yes). The error message prompts you to select a smaller set of documents.

Owning Group - Select an owning group from the drop down list to which the document belongs.

**NOTES**

- By default, the owning group selected for the previous version, if any, is shown.

- All the owning groups configured in SmartPlant Foundation are listed.

Revision - Displays the current revision number of the selected document or documents.

**TIP** You will receive an error message if you attempt to change the value in this field when you have selected one or more documents that have conflicting revision schemes or different possible revisions. The error message prompts you to select a smaller set of documents.

Revision Scheme - Displays the revision scheme applied to the selected document or documents.

**NOTE** Only revision schemes that are applicable to the configuration (plant) or classification (document type) are available in the shortcut menu. The revision schemes related to a configuration or classification are not available for any other configurations or classifications. If none of the revision schemes are related to the configuration or classification, then all revision schemes are available unless they are related to any other configuration or classification. For more information on revision scheme configuration, see Configuring Different Revision Scheme Strategies in the How to Configure Document Management guide.

**TIP** You will receive an error message indicating that this field cannot be edited if one or more of the documents that you have selected are not new or will have a revision scheme supplied by the authoring tool. The error message prompts you to select a smaller set of documents.

Version - Indicates the current version of the document or documents.

Workflow - Indicates the workflow to which the selected document or documents are assigned.

Publish Type - Allows you to publish all data in a 3D model or only the changes to the model since the last successful publish. If the 3D model has not been published before, the software automatically selects All and performs a complete publish to ensure all filtered data is published and loaded into SmartPlant Foundation.

<table>
<thead>
<tr>
<th>Publishing documents</th>
<th>Publish Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>First publish after creating the document</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>All objects</td>
</tr>
</tbody>
</table>
You will receive an error message indicating that this field cannot be edited if one or more of the documents that you have selected have conflicting sets of possible workflows. The error message prompts you to select a smaller set of documents.

**Check and publish released claims for previously deleted items** - Specifies that you want to resolve issues where deleted items were restored from an earlier version and the claim on them was released. This check takes additional time and should only be used when deleted items have been restored. This option is not supported in this release.

**Operation** - Specifies the operation to perform on the selected documents.
- **Publish** - Selected documents are published immediately.
- **Background publish** - Selected documents are published immediately as a separate process, allowing you to perform other tasks at the same time.
- **Scheduled publish** - Selected documents are published in the batch mode by the authoring tool. This option is available only for tools that support batch mode and are processed by the authoring tool, not the SmartPlant Client. The documents are not published immediately. Instead, the selected documents are scheduled for publish at a later time and may be scheduled as a recurring operation.

**Check for deleted objects no longer on documents** - Select this option if you want to process the move instructions while publishing.

**See Also**
- Publish documents (on page 399)
- Find Documents to Publish (on page 408)
- Publish (on page 395)
- Document Properties Dialog Box (on page 407)
**Issue Request Tab (Publish Dialog Box)**

Displays the documents associated with a specific issue request and allows you to add documents to or remove documents from a request.

**Selected documents** - Displays a list of the documents selected for publishing. You must populate this list by selecting documents in the Management Console or Detail View before you use the Publish command. For each document, this list displays the name, the type of document, the workflow from which the document was last published, the revision and version numbers, the revision scheme, and the date when the document was last published.

**Engineering Tool** - Opens a dialog box to select documents to add to the Selected documents list. This option is not supported in this release.

**File System** - Opens a standard Microsoft dialog box that allows you to select documents to add to the Selected documents list. When you select a file with this Select File dialog box, the Document Properties dialog box displays, allowing you to specify information about the file, such as whether it is a new file; the category, type, and subtype of the document; and the name, description, and title of the document.

**Find** - Opens the Find Documents to Publish dialog box, which allows you to search for documents to add to the Selected documents list.

**Issue to** - Contains a list of all objects (contracts) that can support issue requests. When you select an item from this list, the names of any documents associated with that object display in the table.

**Add** - Creates a new item in the table for any documents highlighted in the Selected documents tree view.

**Remove** - Deletes a selected document from the table.

**Document Name** - Displays the names of all documents associated with the object in the Issue to field.

**See Also**
* Publish documents (on page 399)
* Find Documents to Publish (on page 408)
* Publish (on page 395)
* Document Properties Dialog Box (on page 407)

**Document Properties Dialog Box**

Provides details about a new or existing document selected for publishing. You can access this dialog box using the following procedure:

2. Select a file to display the Document Properties dialog box and specify information about the file.

**Tip** An asterisk (*) next to a field indicates that the field must be completed before the software enables the OK button.

**Selected file** - Displays the name of the file that you selected on the Select File dialog box.

**New document** - Indicates that this document has not previously been published.
Published previously - Indicates that the file has already been published at least once before.

Document category - Select the category for the document.

Document type - Select the type of document. The options that display in this list are determined by the selection that you make in the Document category field.

Document subtype - If applicable, select the subtype for the document. The options that display in this list are determined by the selection that you make in the Document type field.

Name - Type the name of the file as it will be known in the integrated environment.

Descriptions - Type a brief description of the file. This description displays later to help you recognize the file.

Title - Type the official title of the document.

See Also
Find Documents to Publish Dialog Box (on page 409)
Publish Dialog Box (on page 404)
Issue Request Tab (Publish Dialog Box) (on page 407)
Publish Tab (Publish Dialog Box) (on page 404)

Find Documents to Publish

Generates a list of documents that either have not been published or have been modified and need to be published again or have been deleted since the last publish. The command is found on the SmartPlant menu in the Drawings and Reports task.

**TIP** This command can also be accessed from using the Find button on the Publish tab of the Publish dialog box. For more information, see Publish Tab (Publish Dialog Box) (on page 404).

Documents must be up-to-date, and the required Discipline property must be defined in order for the documents to be available for publishing. An error message displays if one or more of the documents found by the Find Documents to Publish command do not meet this criterion. All items matching the publish criteria continue through the process. For more information on setting the appropriate properties, see Set properties for publishing documents (on page 396). For more information on updating documents, see Updating Documents (on page 75).

The SmartPlant > Find Documents to Publish command looks for the following:

- Documents created but never published
- Documents modified since their last publish
- Documents deleted after being published

The command looks for documents that need to be republished in the active WBS project. For example, if Project A is the active project, the Find Documents to Publish command looks for documents in Project A only. You set the active WBS project in the Active Project box on the main toolbar. For more information, see Manage Projects (on page 410).

Find Documents to Publish Dialog Box (on page 409)
Find documents to publish

Documents must be up-to-date, and the required Discipline property must be defined in order for the documents to be available for publishing. An error message displays if one or more of the documents found by the Find Documents to Publish command do not meet this criterion. For more information on setting the appropriate properties, see Set properties for publishing documents (on page 396). For more information on updating documents, see Updating Documents (on page 75).

1. From the Drawings and Reports task, click SmartPlant > Find Documents to Publish.

   TIPS
   - This command is available only if you have registered the model using the SmartPlant Registration Wizard.
   - This feature is also available by clicking the Find button on the Publish dialog box.
   - The Find Documents to Publish command determines which documents need to be published or re-published and displays the results of the search in the Find Documents to Publish dialog box.

2. From the Select documents to publish list, check the boxes corresponding to the documents that you want to publish.

   TIP You can quickly select the entire list by clicking Select All, or you can clear the entire list by clicking Clear All.

3. Click OK to accept the selections. The documents selected for publishing now display in the Documents to Publish list on the Publish dialog box and can be saved by publishing the documents. For more information, see Publish documents (on page 399).

Find Documents to Publish Dialog Box

Allows you to search for documents that have been updated since they were last published. Additionally, you can use this dialog box to terminate documents that were previously published but no longer exist in the authoring tool. You can access the Find Documents to Publish dialog in two ways:

- Select SmartPlant > Find Documents to Publish.
- Click Find on the Publish command dialog box.

Last Published - Displays the date when the files were last searched. The information displaying in the lists on this dialog box was found on this specified date and time. This option is not available in the current release.

Update - Displays the Update dialog box, which allows you to define new search criteria for finding documents to publish. This option is not available in the current release.

Select documents to publish - Displays a list of files that were either updated since they were last published or files that have not yet been published. For each file, this list displays the file name and type, and the date on which the document was last published. If the file has not been published, the Last Published field for the document is New.

Select documents to terminate - Displays a list of the files that were previously published but have since been removed from the project. For each file, this list box displays the file name and type, and the date on which the document was last published.
Select All - Selects all of the files in the associated list of documents.
Clear All - Clears any selected documents in the associated list.

See Also
Publishing Documents (on page 391)
Find Documents to Publish (on page 408)
Publish Tab (Publish Dialog Box) (on page 404)

Manage Projects

The Work Breakdown Structure (WBS) project is shown in the dropdown at the upper left-hand corner of the Drawings and Reports task window, next to the Permission Group dropdown. It shows the current active project.

![Permission Group](Project ABC]

In the Common task, you can create new WBS items and projects or edit existing ones. For more information, see the Common User's Guide.

You use projects in conjunction with publishing. The active project must be set before using the Final Publish command on the SmartPlant menu.

See Also
Publishing Documents (on page 391)
Select Active Project Dialog Box (on page 410)

Select Active Project Dialog Box

Specifies the active project. You can access the Select Active Project dialog box by clicking More in the Active Project box on the main toolbar. You define whether you want to look in the local Workspace or in the Database for the project by selecting the options at the top of the dialog box. The project hierarchy updates with the selection of the option.

See Also
Manage Projects (on page 410)
Appendix: Troubleshooting Drawings and Reports

This section describes Drawings and Reports error levels and error logging. You can use log files to review activities and errors that occur when working with the software.

Error Levels

You can specify the settings for drawings error logging by modifying switches in the registry. For more information, contact Intergraph Support Services. You can find support information on our web site at [http://support.intergraph.com](http://support.intergraph.com).

Generally speaking, the larger the number for the error level, the more exhaustive is the logging of errors. The error levels are as follows:

1 - General user error. This is the default level. At this level, log files only contain error messages for certain anticipated error conditions (such as a missing filter or a missing view style), as well as some unanticipated error messages.

101 - Development-specific error level. At this level, log files include everything from the previous error level, as well as certain development-specific error or informational messages.

201 - General Information. At this level, log files include everything from the previous error levels, as well as informational messages about what projects and methods are being called.

251 - Batch Information. At this level, log files include everything from the previous error levels, as well as special batch-specific informational messages.

999 - Exhaustive. At this level, log files contain all informational and error messages.

When the error level is set to 999, the error log files can become very large.

You can also run the `%Product Folder%\Core\Tools\Administrator\Bin\ErrorLogEnable.exe` tool to enable detailed error logging in the SP3DErrors.log.

Log Files

There are three categories of orthographic drawings error log files. These files are all located in your temporary (Temp) folder. For example, your Temp folder might be located at C:\Documents and Settings\login name\Local Settings\Temp.

You can type `%Temp%` in the Address box at the top of Windows Explorer to go to your Temp location.

The log files are:

- `%TEMP%\Drawings.log` and `%TEMP%\Errors.log` - General purpose error log file. Most of the errors encountered in Drawings and Reports are logged here.

- `%TEMP%\Drawings_Batch.log` - The batch service-specific error log file. Any errors or information messages related to the batch service are found here.
Appendix: Troubleshooting Drawings and Reports

- `%TEMP%\DwgBatchServer_ < Process ID >_< yyyy_mm_dd_hh_nn_ss >.log` - The batch server-specific error log files. Any errors or information messages related to the batch servers are found here.
- `%TEMP%\DwgBatchTier_<Process ID>_ < yyyy_mm_dd_hh_nn_ss >.log` - The batch tier-specific error log files. Any errors or information messages related to the batch tier services are found here.
- Generation-time error logs (for example, error log files generated during a drawing update operation). You can easily view these files by right-clicking a drawing in the software and selecting View Log on the shortcut menu.

**TIP** The Temp location also includes .xml files. The software creates one .xml file for each graphical view in a drawing as it processes the drawing.

**Out of Memory Tips**

If you are receiving Out of Memory errors when processing very large drawings, check the following:

- Set the **Intersection Edges** option in the view style to **Off**. Sometimes, this option is set to **High Resolution** for large drawings. High Resolution is typically useful for drawings of one object, such as a hanger drawing or an equipment drawing, where you want to see detail such as the coped intersection of a nozzle with a tank cylinder. If you have this option set high in a large plan drawing, then the software examines every small beam, cylinder, or nut and tries to draw coped intersections or rounded edges in the webs. This operation uses a lot of time and memory.

- Make sure the **Preserve Z Order** option in the view style is turned off unless you really need it. A case where you might need it is in a cable tray drawing where trays are stacked or crossing in plan. However, for most drawings, this setting just leads to increased processing time and high memory usage for little gain.

- Make sure multiple aspects have not been chosen in the VHL graphic rules.

- If you have a very large session active in the host and then update a drawing, the update process starts at the large memory usage in the active session. So, if you limit your workspace to a very small set of objects or even one object, the update process has a better chance of succeeding. If you use batch updates instead of local updates, workspace is not an issue unless you are using your local computer as the batch server.

- Decrease the **Flush Threshold** setting (the default is 2000). This setting is available on the **Drawing View Properties** dialog box for a view in a composed drawing. In some instances, increasing the number may help. During the update process, the Drawings software asks Core for the monikers of all the objects it has to process. Core passes in the monikers and Drawings binds them, thus using memory. The software binds up to 2000 of the objects before it releases the memory and grabs the next 2000. If you reduce this number, say in increments of 500, the memory gets released much more often and can lead to a successful update. It is an iterative process to figure out a good number. This value should be from 5 to 5000 with a default of 2000.

- Set the **Geometry Validation** setting to **ON** (the default is **OFF**). This setting is available on the **Drawing View Properties** dialog box for a view in a composed drawing or a marine mode drawings-by-rule drawing. If the drawing has SAT or DGN files, there are sometimes many invalid geometry errors that can use increasing amounts of memory. With this setting as **On**, the software analyzes geometry, then discards and does not draw invalid geometry, thus freeing up resources and reducing update time. The caveat is that the drawing may not be
100% accurate because invalid geometries may represent legitimate items but are removed from the drawing. If the reference file is there just as background, this situation might be acceptable.

- In general, you should not place huge SAT files as equipment shapes. If you must place them as shapes, break them into smaller files.
- The range inside reference files should be kept as small as possible. For example, if the file contains a pipe rack far away from the global origin, place the file in the model and then move it to the appropriate position.

**Isometric Drawings**

The isometric drawing log files reside at the location specified in your Temp environment variable. For example, the path to the log might be C:\Documents and Settings\username\Local Settings\Temp.

You can view message files (.mes), piping component files (.pcf), and .xml files for the isometric drawing generation process.

**VHL Precision**

Objects can be displayed as Vector Hidden Line (VHL). There can be instances when you may want the hidden line information for a model. For example, it may be useful to know how the edges in the hidden line view are occluded. In general, VHL Precision should not be set, unless you have some parts in the model that have been modeled with a precision different from rest of the system. The values you can set impact the VHL calculations. The VHL Precision setting must be a positive number between 0.001 and 0.000001. This setting is available on the Drawing View Properties dialog box for a view in a composed drawing or a marine mode drawings-by-rule drawing.

**ISOKEEPFILES Variable**

This variable exports XML settings to the location specified in your Temp environment variable. An XML file contains the name of the isometric view style currently being used. This information can be used to troubleshoot isometric drawing settings.

**Tip:** The XML file containing the isometric view style will be approximately 27 KB in size.

The ISOKEEPFILES variable is not a Drawings and Reports setting, it is a System Properties setting.

1. Click **Start** and right-click **My Computer**.
2. Select **Properties**.
3. Select the **Advanced** tab.
4. Click **Environment Variables**.
   The Temp environment variable is listed under **User variables for username**. If you are unsure of where your Temp folder is, the location is noted in this box.
5. On the **Environment Variables** dialogue box, select **New** under the **System variables** box.
6. Type **ISOKEEPFILES** in the **Variable** box and type **YES** in the **Value** box.
7. Click **OK**.
You must set this variable before entering Drawings and Reports and creating the isometric drawings.

**Reports**

The log file for reports (SP3DReports.log) resides at the location specified in your Temp environment variable. For example, the path to the log might be `C:\Documents and Settings\login name\Local Settings\Temp`.

**See Also**

*Drawings and Reports* (on page 21)

*Troubleshooting Linked Servers* (on page 414)

---

**Troubleshooting Linked Servers**

If your Site/Catalog/Plant database server is different from your Reports database server, you can use linked servers for communication between the data sources. However, if linked servers are not configured correctly, the login may fail when you run queries against a linked server.

For linked servers to work correctly, the following must be true:

- The database link must be created on the Site/Catalog/Plant database server, not the Reports database server.
- The linked server must support Windows Authentication Mode.
- You must be connected to SQL Server using Windows Authentication Mode on both servers.
- Security account delegation must be available on the client and the sending server.

For more information about setting up linked servers, see Microsoft SQL Server documentation.

**See Also**

*Appendix: Troubleshooting Drawings and Reports* (on page 411)
Appendix: Isometric Drawing Options

The isometric drawing options define the drawing output, which includes drawing symbols, dimensions, layers, drawing frame, attributes, material lists, weld lists, and detail sketches. Each isometric drawing style is associated with a set of options. You can specify the options using the Edit Options command.

For more information about the ISOGEN options, see the Alias document titled Option Switches Reference Guide, available from the Help > Printable Guides command.

The following list describes the option folders:

- **AlternativeTexts** - Specifies text on the drawing that is different from the ISOGEN text. You can substitute your own text terminology or language in place of the standard ISOGEN words on the isometric drawing. For more information, see Alternative Text Options (on page 416).

- **Drawing** - Defines general options for the isometric drawing style. For more information, see Drawing General Options (on page 417).

- **DrawingFrame** - Specifies the content and format of the drawing frame on a drawing. The drawing frame area can include attribute text such as the drawing number and date. For more information, see Drawing Frame Options (on page 543).

- **MaterialList** - Provides options to control the material list report on the isometric drawing. For more information, see Material List Options (on page 550).

- **WeldList** - Controls the ISOGEN weld list on the isometric drawing and controls the way that ISOGEN counts welds. For more information, see Weld List Options (on page 589). Options that deal with the representation of welds on the drawing are in the Welds folder under Drawing. A user defined weld list is allowed only with a backing sheet. That is, if an ISOGEN-generated drawing frame is in use, only the fixed layout and variable layout styles are available.

- **CutList** - Provides options for the cut list, which provides a list of pipes that are cut into smaller lengths during construction. For more information, see Cut List Options (on page 598).

- **Supplementary** - Provides additional options for input and output files. For more information, see Supplementary Options (on page 609).

- **S3D** - Provides additional non-ISOGEN options that are specific to Smart 3D. For more information, see S3D Options (on page 646).

See Also

Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115)
Alias Documentation

The software delivery includes the ISOGEN SKEY Definitions document published by Alias, the company that makes ISOGEN.

You can open this document from the Help > Printable Guides command in the software.

To learn more about Alias, visit their web site (http://www.alias.ltd.uk/) (http://www.alias.ltd.uk).

See Also
Appendix: Isometric Drawing Options (on page 415)
Alternative Text Options (on page 416)

Alternative Text Options

Sets options for substitute text on the isometric drawing.

AText is an abbreviation for alternative text, an ISOGEN feature that allows you to change or remove any text on the isometric drawing.

AText operates by assigning a unique identification number to each standard text string. The software refers to this number whenever the text string that the number represents needs to change. By definition, a standard text string can be a single character, a single word, or a group of words. Furthermore, some AText is set, by default, to an all-blank word.

AText allows you to substitute your own text terminology or language in place of the standard ISOGEN words on the isometric drawing. To change alternative text, you do not have to replace all of the standard AText; you can change only one word, if needed.

NOTE The representation for coordinates on piping isometric drawings (ISOMOD) can be achieved by setting ATEXT -443 to -448 as shown below:

-443  +?/^  
-444  -?/^  
-445  +?/^  
-446  -?/^  
-447  +?/^  
-448  -?/^  

Where ? is the coordinate and ^ is the reference plane name.

For more information about AText, see Appendix: AText Reference Data (on page 816).

IMPORTANT Although the AText feature has a considerable degree of built-in flexibility, you must exercise a certain amount of care when defining your own words, particularly with respect to word lengths. As a general rule, newly defined words or word strings should be about equal in length or shorter than the text that is being replaced.

ISOGENTextID  AlternateText

Provides a value corresponding to the ISOGEN text to replace. For a listing of these values, see

Specifies the text you want to display on the drawing.
Appendix: Isometric Drawing Options

Grouping of AText Listings (on page 819).

NOTES

- You can click any value in the ISOGENTextID dropdown list. Do not type a value manually because it may not be supported.
- In the AlternateText column, you do not need to type single quotation marks around the text string. You can just type the text.
- You can use AText to control the output of specification break notes. If AText is set to blank, the note is disabled.

See Also
Appendix: Isometric Drawing Options (on page 415)

Drawing General Options

Sets general options for the isometric drawing style.

The Drawing folder contains the following groups of options:

- **Content** - Defines various options about the content of the drawing, such as whether or not to display enclosures and coordinates. For more information, see Content (Drawing) (on page 418).
- **Controls** - Defines various system controls on the isometric drawing. For more information, see Controls (Drawing) (on page 428).
- **Definitions** - Customizes line weight, size, and output level of the data on the isometric drawing. For more information, see Definitions (Drawing) (on page 439).
- **Dimensions** - Controls the dimensions of the different components on the isometric drawing. For more information, see Dimensions (Drawing) (on page 442).
- **Format** - Defines various options about the format of the drawing, including the isometric type and enclosure shapes. For more information, see Format (Drawing) (on page 479).
- **Layers** - Changes the default color for layers. For more information, see Layers (Drawing) (on page 515).
- **Dynamic Fonts** - Contains a collection of options that is used to store the parameters of the user-defined fonts that are available for output on the isometric drawing. For more information, see Dynamic Fonts (Drawing) (on page 516).
- **End Connections** - Stores the definitions of the end connection identifiers. For more information, see End Connections (Drawing) (on page 517).
- **Revisions** - Controls the output of revision changes on the isometric drawing. For more information, see Revisions (Drawing) (on page 522).
- **Welds** - Specifies information about welds on the isometric drawing. For more information, see Welds (Drawing) (on page 524).

Visible

Controls whether the drawing is generated.

- **True** - Generate the drawing.
Appendix: Isometric Drawing Options

- **False** - Suppress drawing generation.

**Defines**
OS 21, Pos 1

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

### Content (Drawing)

Sets options for the content on isometric drawings.

**ShowBIP**

Controls whether the coordinate information for break-in points is shown on the isometric drawing. The default setting is **True**.

- **True** - Display the coordinates on the isometric drawing.
- **False** - Suppress the display of coordinates on the isometric drawing.

**Defines**
OS 5 Pos 8

**ShowClosedEnd**

Controls whether the coordinate information for closed end of pipe work and ISO TEXT are shown on the isometric. The default setting is **True**.

- **True** - Display the coordinates.
- **False** - Suppress the display of the coordinates.

**NOTE** The AText number for the ISO TEXT used for closed end is **-241**; the default is **Blank**.

**Defines**
OS 5 Pos 4

**ShowContAtSplitPoint**

Controls the location of drawing continuation messages at drawing split points on the isometric drawing. This option works in conjunction with ShowCoordAtSplitPts.
Appendix: Isometric Drawing Options

- **True** - Output a drawing continuation message that points to the drawing split point. If `ShowCoordAtSplitPts` is also set to **True**, coordinate data is displayed (1). However, if `ShowCoordAtSplitPts` is set to **False**, the software displays the drawing continuation message but suppresses the display of coordinate data (2).

- **False** - Output a drawing continuation message that points to the end of continuation components, and suppress the output of coordinate data (1). Requires that `ShowCoordAtSplitPts` also be set to **False**. If `ShowCoordAtSplitPts` is set to **True**, the software displays a full set of coordinates and a drawing continuation message that points to the drawing split point (2).

**NOTE** Setting AText -209 and -276 to **Blank**, suppresses the isometric output of the `ShowContAtSolitPoint` and `ShowCoordAtSplitPts` settings.

**Defines**

OS 66 Pos 4

**ShowCoordAtRefItem**

Controls whether the coordinate information for referenced Items is shown on the isometric. The default setting is **False**.

- **True** - Display the coordinates.
- **False** - Suppress the display of the coordinates.

**Defines**

OS 66 Pos 5

**ShowCoordAtSplitPts**

Controls whether the connections coordinates at split points and ISO TEXT are shown on the isometric. The default setting is **False**.

- **True** - Display a full set of connection coordinates in both drawings when a user-defined split point is used.
- **False** - Suppress the display of connection coordinates at split points.

**Defines**
ShowCptFlowArrows
Controls the use of flow arrows that are plotted alongside certain types of in-line components. Their purpose is to show the fluid or gas flow direction in a pipeline. The default setting is True.

- **True** - Display flow arrows.
- **False** - Suppress the display of flow arrows.

Defines

ShowDrainPosition
Controls whether the coordinate information at drain positions and ISO TEXT are shown on the isometric. The default setting is True.

- **True** - Display the coordinate information.
- **False** - Suppress the display of the coordinate information.

NOTE The AText number for the ISO TEXT used for drain position is -239; the default text is DRAIN.

Defines

ShowEquipConn
Controls whether the coordinate information at connection to equipment nozzles and ISO TEXT are shown on the isometric drawing. The default setting is True.

- **True** - Display the coordinate information.
- **False** - Suppress the display of the coordinate information.

NOTE The AText number for the ISO TEXT used for connections to equipment nozzles is -208; the default is CONN. TO.

Defines

ShowFlangeRotation
Controls the output of flange rotation angles, which are used by the fabricator when welding on flanges that have to be rotated away from the normal off-centre axes. Although the facility can be used on all types of isometrics, it is particularly beneficial on spool isometrics.

NOTE There are a variety of enclosure box styles that can be used for the output of flange rotation angles on the isometric controlled by FlangeRotationStyle property.

- **True** - Display flange rotation angles.
- **False** - Suppress the display of flange rotation angles.

Defines
ShowFlowArrows

Controls the use of flow arrows that are plotted directly on the pipe. Their purpose is to show the flow direction of fluid or gas in the pipeline. The size of the flow arrow is controlled by FlowArrowScale.

- **True** - Show flow arrows on pipe on isometric. When you set this option to **True**, you must also set the Drawing.Format.SegmentFlowArrowPlacement option to a value other than None.
- **False** - Suppress flow arrows on pipe on isometric.

**NOTES**

- You can generate this type of flow arrow only if the relevant information is included in the input pipeline data file.
- You can also use a separate type of flow arrow that is plotted alongside in-line fittings, either as well as, or instead of, the one output on pipe. For more information, see Drawing.Content.ShowCptFlowArrows.

**Defines**

OS 112 Pos 1,2

ShowGaskets

Controls the output of gaskets on the isometric drawing.

**NOTE**  ISOGEN does not normally output a fitting shape to depict a gasket on the isometric drawing. Where a gasket is present between two flanged components, a gap appears between the components.
Appendix: Isometric Drawing Options

- **True** - Output a gasket fitting shape on the isometric drawing.
  
  ![Diagram of a gasket fitting shape on an isometric drawing]

- **False** - Suppress output of a gasket fitting shape on the isometric drawing.
  
  ![Diagram of a gasket fitting shape suppressed on an isometric drawing]

**Defines**

OS 17 Pos 2

**ShowIsometricSpindles**

Controls the display of valve and instrument spindles in isometric projection.
Appendix: Isometric Drawing Options

- **True** - Display valve and instrument spindles in isometric projection.

- **False** - Display valve and instrument spindles as flat.

**Defines**

OS 95 Pos 6

**ShowMiscPosition**

Controls whether the coordinate information at miscellaneous positions and ISO TEXT is shown on the isometric drawing. The default setting is **True**.

- **True** - Display the coordinate information.
- **False** - Suppress the display of the coordinate information.

**Note** The AText number for the ISO TEXT used for miscellaneous positions is -242; the default is **Blank**.

**Defines**

OS 5 Pos 7

**ShowNozzles**

Controls whether equipment nozzle indicators are plotted (in dotted line style) on the isometric drawing. The default setting is **False**.

- **True** - Display equipment nozzle indicators.
- **False** - Suppress the display of equipment nozzle indicators.

**Defines**

OS 111 Pos 1
Appendix: Isometric Drawing Options

ShowNSUnitsInReports

Controls how nominal size information is output in a number of summary report files. ISOGEN does not have an option when outputting the nominal size on whether the units (typically the “character) is appended to the output text. To give you control over the output of the nominal size units, the software adds keywords to the appropriate control files.

- **True** - Append the keyword **OUTPUT-UNITS** to **N.S., N.S.SEC** and **N.S.THIRD** when this appears in the control files for summary report files. An example is shown below.

```
PRINTED-M/C-DATA-ITEMS
'PIPELINE-REFERENCE' 1 L
'REVISION' 18 L
'ITEM-CODE' 24 L
'N.S.' 41 L OUTPUT-UNITS
'QTY' 57 N
'GROUP' 64 L
'WEIGHT' 77 N
```

- **False** - Append the keyword **SUPPRESS-UNITS** to **N.S., N.S.SEC** and **N.S.THIRD** when this appears in the control files for Operations List and Site Assembly Report File (these reports have units output by default).

**NOTE** You can control nominal size units for the following output tables and report files:

- Material List – Style 2
- Material List – Style 3
- Material List – Style 4
- Material Control File
- Cut Pipe List
- Cut Pipe Report File
- Weld List
- Welding Report File
- Site Welding Report File
- Operations List (default – units output)
  - Site Assembly Report File (default – units output)

ShowNSUnitsOnDrg

Controls how nominal size information is output in a number of tables and lists appearing on the isometric drawing. ISOGEN does not have an option when outputting the nominal size on whether the units (typically the “character) is appended to the output text. To give you control over the output of the nominal size units, the software adds keywords to the appropriate control files.

- **True** - Appends the keyword **OUTPUT-UNITS** to **N.S., N.S.SEC** and **N.S.THIRD** when this appears in the control files for tables and lists appearing on the isometric drawing. An example is shown below.
Appendix: Isometric Drawing Options

PRINTED-M/C-DATA-ITEMS
'PIPELINE-REFERENCE' 1 L
'REVISION' 18 L
'ITEM-CODE' 24 L
'N.S.' 41 L OUTPUT-UNITS
'QTY' 57 N
'GROUP' 64 L

- **False** - Appends the keyword **SUPPRESS-UNITS** to **N.S**, **N.S.SEC** and **N.S.THIRD** when this appears in the control files for tables and lists appearing on the isometric drawing.

**NOTE** You can control nominal size units for the following output tables and report files:

- Material List – Style 2
- Material List – Style 3
- Material List – Style 4
- Material Control File
- Cut Pipe List
- Cut Pipe Report File
- Weld List
- Welding Report File
- Site Welding Report File
- Operations List (default – units output)
- Site Assembly Report File (default – units output)

**ShowOpenEnd**

Controls whether the coordinate information at the open end of pipe work and ISO TEXT are shown on the isometric drawing. The default setting is **True**.

- **True** - Display the coordinate information.
- **False** - Suppress the display of the coordinate information.

**NOTE** The AText number for the ISO TEXT used for open end is **-240**; the default is **Blank**.

**Defines**

OS 5 Pos 3

**ShowPipeLineCont**

Controls whether the coordinate information for pipeline continuations and ISO TEXT are shown on the isometric drawing. The default setting is **True**.

- **True** - Display the coordinate information.
- **False** - Suppress the display of the coordinate information.

**NOTE** The AText number for the ISO TEXT used for pipeline continuation is **-209**; the default is **CONT. ON**.

**Defines**
Appendix: Isometric Drawing Options

OS 5 Pos 1

**ShowReferenceDims**
Controls whether reference dimensions are output on the isometric drawing.

- **True** - Output reference dimensions.
- **False** - Suppress the output of reference dimensions.

**Defines**
OS 119 Pos 3

**ShowRPads**
Controls the automatic generation of an item code and a material description on the material list and a plotted shape for the pad on the isometric drawing. The default setting is **False**.

- **True** - Generate an item code and a material description and plotted pad shape to be shown on the isometric drawing.

- **False** - Suppress the generation of an item code and a material description and plotted pad shape.

**Defines**
OS 77 Pos 3

**ShowSiteAssemblyTable**
Controls the display of the site assembly table on the isometric drawing. The default setting is **False**.

- **True** - Display the site assembly table.
- **False** - Suppress the display of the site assembly table.

**Defines**
OS 79 Pos 4

**ShowSupports**
Controls the display of pipe supports on the isometric drawing.
Appendix: Isometric Drawing Options

- **True** - Display pipe supports on the isometric drawing and in the material list.

- **False** - Suppress the display of pipe supports on the isometric drawing and the material list.

**Defines**
OS 40 Pos 1

**ShowTabBrnchCoords**
Controls the output of coordinates at tapped branch connection points—the point on the host component where the tapped branch is connected.

- **True** - Output the coordinates.
- **False** - Suppress the output of the coordinates.

**Defines**
OS 122 Pos 1

**ShowVentPosition**
Controls the display of coordinate information at vent positions and ISO TEXT on the isometric. The default setting is **True**.

- **True** - Display the coordinate information.
- **False** - Suppress the display of the coordinate information.

**NOTE** The AText number for the ISO TEXT used for connections to vent positions is -230; the default text is **VENT**.
Appendix: Isometric Drawing Options

Defines
OS 5 Pos 5

SuppressJacketedConnection
Controls the display of coordinate data for jacketed connections on the isometric drawing. The default setting is True.

- **True** - Display coordinate data on the isometric drawing.
- **False** - Suppress the display of coordinate data on the isometric drawing.

Defines
OS 5 Pos 9

See Also
Appendix: Isometric Drawing Options (on page 415)

Controls (Drawing)
Sets options for system controls.

AutoDrawingSplit
Invokes automatic splitting of drawings.

- **True** - Calculate the volume of pipeline graphics that can be satisfactorily displayed on the selected drawing size, and generate the required number of isometrics to contain the complete pipeline.
- **False** - Use NoOfDrawings to specify a fixed number of drawings. Setting to False allows you to directly dictate how many isometric drawings are to be produced for a pipeline.

**IMPORTANT**

- Only set the number of drawings in special cases, such as for single pipeline runs, because the setting is applied to all the pipelines in a run.
- If you need to use the MaterialList.UserDefinedMaterialPartNumber option, it is recommended that you set the ISOGEN option AutoDrawingSplit option to False to force single sheet isometric drawings. For more information, see Material List Options (on page 550).

Defines
OS 7 Pos 1, 2

ContinuationGraphicsonSpoolIsos
Controls the display of continuation graphics at the ends of spool isometric drawings. Where a spool continues on another spool, an appropriate continuation message is also output on the isometric drawing.

- **False** - Display continuation graphics on spool isometric drawings.
- **True** - Suppress display of continuation graphics on spool isometric drawings.

Defines
Appendix: Isometric Drawing Options

OS 38 Pos 5

**DateFormat**

Controls the format of the date that is to be output on the isometric and in summary files.

- **None** - Display no date.
- **British** - Display the date in British format (dd/mm/yy)
- **European** - Display the date in European format (dd/mm/yy).
- **American** - Display the date in American format (mm/dd/yy).

**Defines**

OS 6 Pos 1

OS 6 Pos 2

**DataSource**

Takes the actual date that is output from either the pipeline data file that has been created by the host 3D design system or the computer system date at run time.

- **DataFile** - Use the date contained in the pipeline data file.
- **System** - Use the system clock date.

**Defines**

OS 6 Pos 2

OS 55 Pos 1

**DiagnosticLevel**

Controls the amount of information written to the message file.

- **Low** - Write ISOGEN software version and plot file generation messages to the message file.
- **Medium** - Write plot and module run messages to the message file.
- **High** - Write plot, module run, and ISOPLOT messages to the message file.

**Defines**

OS 55 Pos 2

OS 55 Pos 2

**DisconnectionMessage**

Specifies an IDFGEN-generated diagnostic and controls output of disconnection messages on the isometric drawing.

- **True** - Output disconnection message local to pipeline break where increased tolerance is used to connect pipeline.
- **False** - Suppress output of local disconnection message where increased tolerance is used to connect pipeline.

**Defines**

OS 55 Pos 2
Appendix: Isometric Drawing Options

**DrawingRotationAngle**

Controls the rotation of the isometric drawing in a clockwise direction by a user-specified number of degrees. Where pipelines are oriented in a non-primary, or skewed, direction, the subsequent isometric drawing output can be congested and difficult to read. The ability to orient pipelines in the horizontal plane so that the majority of skewed pipeline sections are rotated to a primary direction can simplify isometric drawing output.

The example below shows pipe oriented in a southeasterly direction:

![Diagram of pipe in southeasterly direction]

The next example shows the same pipe rotated 45° so that it is now in a southerly direction:

![Diagram of pipe rotated 45°]

- **0** - Orient isometric drawings in the horizontal plane using the value specified by `Drawing.Controls.NorthDirection`. This is the default setting.
- **Value** - Orient isometric drawings in the horizontal plane in a clockwise direction by the specified number of degrees. Type a value in tenths of a degree up to a maximum of 3600. **NOTE** The user-specified value overwrites the `Drawing.Controls.NorthDirection` setting.

**Defines**

OS 42, Pos 4-7

**DrawingSize**

Specifies a standard paper size for the isometric drawing.

Supported sizes are listed below:

- **Custom**
- **European Sizes**
  - **A0** - 841 x 1189 mm
Appendix: Isometric Drawing Options

- A1 - 594 x 841 mm
- A2 - 420 x 594 mm
- A3 - 297 x 420 mm
- A4 - 210 x 297 mm

ANSI Sizes
- A - 8.5" x 11"
- B - 11" x 17"
- C - 17" x 22"
- D - 22" x 34"
- E - 34" x 44"

**NOTE** If **Drawing Size** is set to **Custom**, then you must also set **DrawingFrame.CustomHeight** and **DrawingFrame.CustomWidth**.

**Defines**
OS 14 Pos 1, 2

**FlatSpoolOrientation**
Controls placement of the longest pipe in a flat spool drawing. Acceptable options are:
- **Maximum Legs Flat**
- **Parallel Legs Flat**
- **Longest Leg in E/W plant, Second Longest in N/S plane**

**NOTE** Setting **FlatSpoolOrientation** to **Parallel Legs Flat** is not recommended.

**Defines**
OS 42 Pos 3

**FlatSpoolUpArrow**
Allows the Up direction to be displayed on the isometric drawing. The Up direction shown is relevant to the longest leg length output in the horizontal plane (bottom left to top right) of the isometric drawing.
- **True** - Display Up direction on longest leg of flat spool. This setting is only applicable when **FlatSpoolOrientation** is set to **Longest Leg in E/W plant, Second Longest in N/S plane**.
- **False** - Display North arrow on all drawings except flat spool isometric drawings.
Appendix: Isometric Drawing Options

The following example shows the Up direction rotated 90-degrees counter clockwise:

![Isometric Drawing Example]

Defines
OS 42 Position 2

FourDigitYear
Controls whether the year portion of the date is output as two or four digits.
- **True** - Output four-digit year, such as 2009.
- **False** - Output two-digit year, such as 09.

Defines
OS 6 Pos 3

HeatTracingOptions
Controls heat tracing options.
- **On** - Use heat tracing options.
- **Off** - Suppress the use of heat tracing options.

Defines
OS 21 Pos 4

IgnoreUserSplitPoints
- **True** - Ignore user-defined drawing split points present in the piping data file.
- **False** - Process user-defined drawing split points present in the piping data file.

Defines
OS 7 Pos 3

IsometricType
Sets the required isometric type.
- **Combined** - Fabrication, erection, and offshore information.
- **Erection/Offshore** - Erection/offshore type isometric drawing.
- **Fabrication Only** - Fabrication only isometric.
- **Combined Material** - Combined material list only, without pipeline graphics.
Appendix: Isometric Drawing Options

- **Erection Material** - Erection material list only, without pipeline graphics.
- **Fabrication Material** - Fabrication material list only, without pipeline graphics.
- **Spool Material** - Spool material list only, without spool graphics.

**Defines**

OS 21 Pos 1 & 2

**IsoScale**

Controls the finished isometric drawing size. You can increase or decrease the final plotted isometric size from the size defined by **DrawingSize**, or **CustomHeight** and **CustomWidth**.

- **0 or 100** - No scaling change (100% of set size). The software generates the isometric drawing at the size defined by **DrawingSize** or **CustomHeight** and **CustomWidth**.
- **n** - Scale the drawing to increase or decrease the final isometric size by n%, where n is an integer number. For example, n = 71 generates a reduced size drawing at 71% of the set size, such as A2 reduced to A3. Whereas n = 120 generates an increased size drawing at 120% of the set size.

**Defines**

OS 32

**LinearWeightDenominator**

Specifies the units for the linear weight denominator, regardless of the units used for weights.

- **None** - The linear denominator is the default. For example: LBS/FT when weight is in LBS, and KGS/M when weight is in KGS.
- **Metric** - The linear denominator is in meters. For example: LBS/M when weight is in LBS, and KGS/M when weight is in KGS.
- **Imperial** - The linear denominator is in feet. For example: LBS/FT when weight is in LBS, and KGS/FT when weight is in KGS.

**NOTE** The weight unit is specified in the **WeightOutput** property.

**Defines**

OS 41 Pos 4

**MinAngleOffset**

Controls how the software interprets and acts on small angular deviations detected in the pipeline input data. These deviations can lead to small unwanted skews being generated on the isometric. You can define an angular cut-off value with this property so that any skew that is found to have an angular deviation below this value is ignored by the software and not treated as a skew. The default setting is 0.

- **0** - Use no angular offset tolerance.
- **Value** - Use the user-defined required angle tolerance. Type a value in range 1-10, such as 0.5 for 0.5-degrees.

**Defines**

OS 115
Appendix: Isometric Drawing Options

NoOfDrawings
Specifies the number of drawing sheets required for split control.
- 0 - Automatic control of drawing numbers.
- Value - User-defined number of drawings. Type a value in range 1-99

NOTES
- This option dictates how many drawing sheets are extracted for a pipeline. Therefore, you should use this option only for special cases for single pipe runs as the setting applies to all the pipelines in a run.
- To use the NoOfDrawings option, you must set the AutoDrawingSplit option to False.

Defines
OS 7 Pos 1 & 2

NorthDirection
Controls the viewing direction (isometric orientation), or the direction that the north arrow points on the isometric drawing. There are four orientation options you can choose:
- Top Left
- Top Right
- Bottom Left
- Bottom Right
The option you select is indicated on the isometric drawing by the direction the north arrow is pointing.

Defines
OS 42 Pos1

OverwritePlotFile
Overwrites and deletes any plot files existing with the same name.
- True - Allocate plot file name using selected sequence method after deleting previously generated files.
- False - Allocate next available plot file, generate name using selected sequence method.

Defines
OS 31 Pos 2

PipeLineScale
Increases or decreases the scale of the pipeline picture part of the isometric only, while leaving all other parts, such as the drawing frame, material list, title block and line summary areas, unaltered. Using this property, you can re-scale the pipeline picture and all text pointing to it.
- 0 or 100 - Use the default scale.
- Value - Use the user-defined integer number to increase or decrease the scaling effect as a percentage.
Appendix: Isometric Drawing Options

### PipeLineSplitting

Controls the amount of drawing data that triggers a drawing split. This value is a scale factor expressed as a percentage. Setting a value less than 100 causes less of the pipeline to appear on each drawing before automatic splitting occurs, resulting in a less crowded drawing.

This option is intended only for modest modifications of the drawing whitespace. Specify a value in the range 90-110. If a particular value does not work, gradually adjust the value and re-extract the drawing to check the results.

- **0 or 100** - Default for what ISOGEN considers to be the limit for drawing information content. This limit is set within the software and varies for each size of drawing.
- **Value** - Increase or decrease the drawing information content as a percentage.

### PipeNameInContMessages

Controls whether the pipeline name is output as part of the drawing continuation message on the isometric.

- **True** - Output pipeline name as part of the drawing continuation message.
- **False** - Output a standard drawing message.

### PipeNameStyle

Controls the style of pipeline name output for drawing continuation messages.

If **PipeNameInContMessages** is **True**.

- **Blank** - Output a standard drawing continuation message.
- **Drawing Identifier** - Output a drawing continuation message that includes CLIENT-DRAWING-IDENTIFIER.
- **Pipe Reference** - Output a drawing continuation message includes pipeline name.
- **Sequence Number** - Output a drawing continuation message that includes PIPELINE-DRAWING-SEQUENCE-NUMBER.
- **Spool Drawing Sequence Number** - Output a drawing continuation message that includes SPOOL-DRAWING-SEQUENCE-NUMBER.
Appendix: Isometric Drawing Options

PlotFilePath
Specifies the folder into which drawings are written. Click the browse button at the right side of the cell to display a dialog box and browse for the required directory.<

Defines
Isogen attribute

PostScriptSize
Specifies the PostScript plotter size.

European Sizes:
- A0 - 841 x 1189 mm
- A1 - 594 x 841 mm
- A2 - 420 x 594 mm
- A3 - 297 x 420 mm
- A4 - 210 x 297mm

ANSI Sizes
- A - 8.5" x 11"
- B - 11" x 17"
- C - 17" x 22"
- D - 22" x 34"
- E - 34" x 44"

Defines
OS 14 Pos 3 & 4

PrintedOutputPageLen
Controls the number of lines per page on any printed output (reports) generated by the ISOGEN system.
- 0 - Use the default for 55 lines per page.
- Value - Specify the required number of lines to be output per page. Type the required value (integer number).

Defines
OS 63

SetPipeLineDisconnected
Specifies an IDFGEN-generated diagnostic.
- True - Set pipeline to disconnected when an increased tolerance is used to connect the pipeline. Output a disconnected pipeline message at the top of the drawing.
Appendix: Isometric Drawing Options

- **False** - Suppress output of disconnected pipeline message at top of drawing if pipeline has connected using the increased tolerance.

  **NOTE** Message is always output if pipeline does not connect using increased tolerance.

**Defines**
OS 55 Pos 3

**ShowISOGENVer**
Controls the optional plotting of the ISOGEN version banner together with the run date and generation time of the isometric. The information is plotted on a single line located at the bottom left-hand corner of the isometric, but inside any cut marks that can be present.

- **True** - Plot the banner.
- **False** - Suppress plotting of the banner.

**Defines**
OS 127

**StartDrawingNumber**
Allows the first sheet to start at an alternative number instead of starting with drawing number 1

- **0** - Start first sheet at drawing number 1.
- **x** - Start first sheet at x+1.

**Defines**
OS 31, Pos 3-5

**SupportAdditionsWeight**
Controls inclusion of the weight of additional material associated with supports when performing center-of-gravity calculations. The default setting is **Include**.

- **Include** - Include the weight of additional materials.
- **Ignore** - Ignore the weight of additional materials.

**Defines**
OS 40 Pos 6

**TrueScale**
Attempts to adjust the length of sections of pipe to be proportional to their actual physical length.

- **True** - Use true scaling of isometrics (proportional pipe lengths).
- **False** - Use normal scaling of isometrics (variable pipe lengths).

**Defines**
OS 95 Pos 3

**Units**
 Defines the style of units used throughout: Metric or Imperial.
Appendix: Isometric Drawing Options

- **Metric / MM Bores** - Use millimeter lengths and millimeter pipe bores.

- **Metric / Inch Bores** - Use millimeter lengths and inch pipe bores.

- **Imperial / Inch Bores** - Use inch lengths and inch pipe bores.

- **Imperial / MM Bores** - Use inch pipe bores with lengths in feet and inches.

**NOTE** You can specify the changeover point from where lengths are reported in inches only, to feet and inches.

- **Imperial / MM Bores** - Use inch pipe bores with lengths in feet and inches.

**NOTE** The combination MM bore, FT-IN dimensions is invalid.

**Defines**

OS 41 Pos 1

**WeightOutput**

Controls how component weights are displayed on the isometric drawing. The default setting is **None**.

- **None** - Output no weight information. Applies to all outputs, including such things as material lists, weight output on drawing frame, and material control files.
- **Kg** - Input and output all weights in kilograms (Kgs).
- **Lb** - Input and output all weights in pounds (Lbs.)

**NOTE** *LinearWeightDenominator* specifies the units used for the linear weight denominator, irrespective of the units used for weights.

**Defines**

OS 41 Pos 4

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

**Definitions (Drawing)**

The *Definitions (Drawing)* folder contains a collection of options called Definitions, which is used to define how to represent pipeline components or facilities on the drawing. For more information, see *Drawing Definitions Collection* (on page 440).

**LineStyleTable**

Displays the *LineStyle Table* window, which is a free format text field that you can use to define a standard name to line style number mapping. Any line style number that you type here is displayed in the `Drawing.Definitions.LineStyle` list.

1. Click \( \text{ } \) in the *LineStyle Table Value* box.

   *The software displays the *LineStyle Table* window.*

2. Type a line style number and its corresponding line style name.

3. Continue typing line style numbers and names as needed, pressing Enter after each entry.

4. When you are finished, click OK to save the line styles.

**NOTES**

- The entry must be the name of a line style defined in the output CAD system.
- The software supports up to 1000 user-defined line styles.
Count
Displays the number of definitions stored in the Drawing Definitions collection.

**Drawing Definitions Collection**

Defines how to represent pipeline components or facilities on the drawing. For example, you can specify that valves are to be drawn 1.5 times normal size with a line thickness of 1 on layer 5, and display in the color blue. This collection is used to construct the corresponding drawing definition file.

**NOTE** The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

**Definition Type**
Specifies the type of definition. For example, you can choose Fitting, Variable Bore, and so forth.

**Applies To**
Specifies the component type. This is set using a list, which includes the allowable settings for this property.

**DScale**
Specifies an integer value for the scale that represents an increase or decrease to the basic 100% standard symbol size for all types of fitting. This value must be in the range 75 - 200.

**Layer**
Defines a number that corresponds to the layer. This number is an integer that identifies the required layer (level) to which the component type is to be assigned. You must use a value in the range 1-50.

**Thickness Actual**
Defines the actual thickness (width) of the plotted line in millimetres (a real number). This value is in the range 0.0 to 10.0.

**Thickness Logical**
Specifies an integer for the required thickness. This value is in the range 0 - 99.

**Upper Bore**
Defines the maximum bore as an integer or real number. This value must be in the current nominal size units.

**Lower Bore**
Defines the minimum bore as an integer or real number. This value must be in the current nominal size units.
Appendix: Isometric Drawing Options

**Colour**

Specifies the index number that represents a specific colour as defined in the output drawing software.

The table below shows the index numbers applicable to the software and their mapped colours.

<table>
<thead>
<tr>
<th>Numeric Value</th>
<th>Mapped Colour</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Black</td>
</tr>
<tr>
<td>1</td>
<td>Blue</td>
</tr>
<tr>
<td>2</td>
<td>Cyan</td>
</tr>
<tr>
<td>3</td>
<td>Green</td>
</tr>
<tr>
<td>4</td>
<td>Magenta</td>
</tr>
<tr>
<td>5</td>
<td>Red</td>
</tr>
<tr>
<td>6</td>
<td>Yellow</td>
</tr>
<tr>
<td>7</td>
<td>White</td>
</tr>
<tr>
<td>8</td>
<td>Dark Blue</td>
</tr>
<tr>
<td>9</td>
<td>Dark Cyan</td>
</tr>
<tr>
<td>10</td>
<td>Dark Green</td>
</tr>
<tr>
<td>11</td>
<td>Dark Magenta</td>
</tr>
<tr>
<td>12</td>
<td>Dark Red</td>
</tr>
<tr>
<td>13</td>
<td>Dark Yellow</td>
</tr>
<tr>
<td>14</td>
<td>Dark Gray</td>
</tr>
<tr>
<td>15</td>
<td>Light Gray</td>
</tr>
</tbody>
</table>

**Category**

Specifies the category for the definition. For example, you can choose Fabrication, Erection, Offshore, and so forth.

**LineStyle**

Specifies the number that corresponds to the line style that is to be output on the isometric drawing. A line style is a simple pattern of lines and gaps. In the LineStyle list, the 12 line styles generated by ISOGEN, shown below, are listed by default.

<table>
<thead>
<tr>
<th>LineStyle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>1001</td>
<td></td>
</tr>
</tbody>
</table>
You can define additional line styles using `Drawing.Definitions.LineStyleTable`.

**NOTE**  The ISOGEN-generated line styles only apply for showing heat tracing on the isometric drawing. They do not apply for piping. User-defined line styles can be applied for showing either heat tracing or piping.

**See Also**
`Appendix: Isometric Drawing Options` (on page 415)

## Dimensions (Drawing)

Sets options for dimension display on the isometric drawing.

### AdditionalAllowanceFormat

Controls how additional allowances are displayed alongside or as part of dimensions.

- **Suppress** - Display no additional allowances.
- **Dim + Allowance** - Display dimension plus allowance.
- **Dim Includes Allowance** - Add allowance to dimension.

**IMPORTANT**  Only use **Dim Includes Allowance** if you are using a Spool style.

**Defines**

OS 9 Pos 5

### AddRoundOff

Controls the Dimension Round Off Carry-Over function, which is used to control how remainders are handled when dimensions are calculated and output on the isometric. At branch locations, or
components, this permits the remainder part of a dimension either to be carried over and added to the next dimension, or discarded.

- **Normal** - Round off dimensions to + or - 1mm, or 1/16th-inch, and carries over any reminder to the next dimension.
- **Branch Intersect** - Round off dimensions to + or - 1mm or 1/16th-inch with no carry-over of the remainder beyond a branch intersection.
- **Current Component** - Round off dimensions to + or - 1mm or 1/16th-inch with no carry-over of the remainder beyond current component.

** Defines 
OS 117

**BranchBoreLimit**

Specifies a branch bore limit to suppress dimensions. The acceptable range of values is 0-999. **BranchBoreLimit** works in conjunction with **BranchCptLimit**, if defined.

- **0** - Dimension all pipe.
- **Value** (in range 0-999) - Suppress the dimensions of branches having a bore equal to or less than the defined value. Value is in 1/16th of an inch or mm, depending on the bore units. For example, the branch in the following illustration has a pipe bore of less than the value stated in **BranchBoreLimit**; consequently, it is not dimensioned.

![Diagram showing dimension suppression](image)

**NOTES**

- Any branch containing pipe (100 record), fixed length pipe (101 record) or pipe block (103 record) does not have branch dimension suppression applied to it.
- Branch dimension suppression using this property does not apply to tapped branches.
- **BranchBoreLimit** and **BranchCptLimit** work either independently of each other or together, depending upon your requirements.

** Defines 
OS 81 Pos 4,5,6

**BranchCptLimit**

Controls the dimensioning of branches based on the number of components. Works in conjunction with **BranchBoreLimit**, if defined.

Branches with a specified number of components are un-dimensioned.

- **Blank** - Dimension all branches.
Appendix: Isometric Drawing Options

- **Value** (in range 0-99) - Suppress dimensions for branches having a number of components equal to or less than the specified value. Gasket and bolt entries are counted as components. For example, the branch in the following illustration has six components: a weldolet, a weld neck flange, two gaskets, a valve and a blind flange. In this example, **BranchCptLimit** has been set to 7, so the branch has not been dimensioned.

![Image](image_url)

**NOTES**
- Any branch containing pipe (100 record), fixed length pipe (101 record) or pipe block (103 record) does not have branch dimension suppression applied to it.
- Branch dimension suppression using this property does not apply to tapped branches.
- The **BranchBoreLimit** and **BranchCptLimit** properties work either independently of each other or together, depending upon your requirements.

**Defines**

OS 81 Pos 7 & 8

**CoordOutputBends**

Controls whether coordinates and elevations are printed at bends and elbows on the isometric drawing.

- **None** - Output no elevation coordinates.
- **Elev at changes** - Output elevations when changed.
- **Elev and coords at changes** - Output elevations and coordinates that have changed.
- **Full** - Output a full set of coordinates.

**Defines**

OS 66 Pos 2

**CoordOutputBranches**

Controls the coordinate display at branch intersections.

- **None** - Output no elevation coordinates.
- **Elev at changes** - Output elevations when changed.
- **Elev and coords at changes** - Output elevations and co-ordinates that have changed.
- **Full** - Output a full set of coordinates.

**Defines**

OS 81 Pos 7 & 8
Appendix: Isometric Drawing Options

OS 66 Pos 3

**CoordOutputHTCpts**

Controls whether coordinates are output on heat traced components.
- **On** - Output coordinates on heat traced components.
- **Off** - Suppress coordinates on heat traced components.

**Defines**
OS 66 Pos 9

**CoordSupports**

Controls output of coordinates at different types of pipe supports.
- **None** - Suppress display of coordinates on pipe supports.
- **Fabrication** - Output coordinates at Fabrication pipe supports only.
- **Erection** - Output coordinates at Erection pipe supports only.
- **Offshore** - Output coordinates at Offshore pipe supports only.
- **All** - Output coordinates at all pipe supports.

**Defines**
OS 66 Pos 6

**CoordType**

Controls the output type for supplementary coordinates, that is, coordinates at bends or at branches. You can choose output with arrows or witness lines. The default setting is *Arrowed*.

**NOTE** This option does not apply to end connection coordinates. It also does not apply when **CoordOutputBends** or **CoordOutputBranches** is set to Full.
- **Arrowed** - Output coordinates and elevations as arrowed-out message type.
- **Witness Lines** - Output coordinates and elevations along witness lines.

**Defines**
OS 66 Pos 1

**CurvedPipeDimensioning**

Controls the dimensioning of curved pipe.
- **Message** - Output curved pipe dimensions as a message.
- **Standard** - Output curved pipe dimensions as a standard dimension.
- **Suppress** - Suppress curved pipe dimensions.

**Defines**
OS 84 Pos 1
Appendix: Isometric Drawing Options

DoubleUnits
Controls whether measurements are output in both imperial and metric units, or just one. The default setting is **False**.
- **True** - Output measurements in both imperial and metric units.
- **False** - Output measurements in one type of unit only.

Defines
OS 9 Pos 7

FabWeldsInPipe
Controls dimensioning of fabrication welds in pipe.
- **True** - Show dimension to fabrication weld.
- **False** - Suppress dimension to fabrication weld.

Defines
OS 119 Pos 4

Format
Controls the dimension format on the isometric drawing.
Appendix: Isometric Drawing Options

- **Basic** - Plot ordinary string dimensions, support/message dimensions, and reference dimensions on the isometric drawing. This is the default setting.

- **Combined Erec/Offsh - Basic** - Plot ordinary string dimensions. Do not dimension separately erection pipe fittings (bends, elbows, tees, and so forth), support/message dimensions and reference dimensions on the isometric drawing.
- **Composite** - Plot composite dimensions together with support/message dimensions and reference dimensions on the isometric drawing.
- **Combined Erec/Offsh - Composite** - Plot composite dimensions. Do not dimension separately erection pipe fittings (bends, elbows, tees, and so forth), support/message dimensions and reference dimensions on the isometric drawing.
Appendix: Isometric Drawing Options

- **Support** - Plot only support/message and reference dimensions on the isometric drawing.

- **Reference Only** - Plot only reference dimensions on the isometric drawing. Suppress all other dimensions.
Appendix: Isometric Drawing Options

- **Full String** - Plot full string dimensions, support/message dimensions, and reference dimensions on the isometric drawing. All components are dimensioned individually.

- **Pipe Only** - Plot pipe dimensions, support/message dimensions, and reference dimensions on the isometric drawing. Suppress fitting dimensions.

**Defines**

OS 9 Pos 1

**FtInTolerance**

Defines a value below which a ft-in dimension appears in inches. Type a value in whole inches. This value must be greater than 12.

In the example below, the 19.9/16" long pipe is dimensioned as 1' 7.9/16", as **FtInTolerance** is set at 19.
In the next example, the same pipe is dimensioned as 19.9/16", as **FtInTolerance** is set at 20.

**GasketDimPrecision**

Controls precise dimensioning of gaskets.

- **True** - Output gasket dimensions to the nearest 1/10th mm.
  - [Diagram showing gasket dimensions.

- **False** - Output gasket dimensions to the nearest mm.
  - [Diagram showing gasket dimensions.

**Gaskets**

Specifies gasket dimensions. You can choose to not show gasket dimensions, to include the dimension with the component, or to treat the dimension separately.
Appendix: Isometric Drawing Options

- **None** - Suppress gasket dimensions.

  ![Diagram](image1)

  **NOTE**: Gasket thicknesses are not included. The component dimension is indicated by the presence of two leader lines.

- **Included** - Include gasket dimensions with the component.

  ![Diagram](image2)

  **NOTES**:
  - Gasket thicknesses are included. The component dimension is indicated by the presence of only single leader lines.
  - The length of the valve has now increased by the thickness of the gaskets (2mm in this case) either side.

- **Separate** - Dimension gaskets separately.

  ![Diagram](image3)

  **Defines**
  
  OS 9 Pos 2
Appendix: Isometric Drawing Options

IdfgenConnectionTolerance
Controls the tolerance to be used when connecting components in IDFGEN. Set a value in mm.

Backward Compatibility
To avoid problems where this control is set as a single value, no tolerance is set in Option Switch 116, Positions 4-6. IDFGEN continues to use positions 1-3 to determine the connection tolerance.

Defines
116 Pos 4-6

ImperialFormat
Controls the format of imperial measurements used on the isometric drawing.
- **Standard** - Output standard ft/in format: 6’ 10.3/4”.
- **Standard dash** - Add a dash between the feet and inches: 6’-10.3/4”.
- **Space dash** - Use a blank space instead of a dot (.) between inches and fractions of an inch: 6’-10 3/4”.
- **Stacked fractions with dash** - Output stacked fractions with a dash: 6’-10½”.
- **Stacked fractions without dash** - Output stacked fractions without a dash: 6’ 10½”.
- **1DecimalPlace** - Output decimal inches to 1 decimal place.
- **2DecimalPlace** - Output decimal inches to 2 decimal places.
- **3DecimalPlace** - Output decimal inches to 3 decimal places.
- **4DecimalPlace** - Output decimal inches to 4 decimal places.

**NOTE** The **Stacked fractions** options only apply to MicroStation DGN output.

Defines
OS 41 Pos 3

Inches
Controls whether pipes are dimensioned in inches only or in feet and inches. The default setting is **False**.
- **True** - Output dimensions in inches.
- **False** - Output dimensions in feet/inches for any dimensions greater than 24-inches.

**NOTE** **Inches** overrides **FtInTolerance**.

Defines
OS 41 Pos 6

JacketDimensioning
Controls the dimensioning used for jacketed pipework on the isometric drawing.
- **Full** - Display full jacket dimensioning.
Appendix: Isometric Drawing Options

- **Minimal** - Display minimal detail.

**Defines**
OS 9 Pos 9

**Metres Coordinates**
Determines whether to plot coordinates in M.mm format
- **mm** - Output coordinates in mm format.
- **m** - Output coordinates in M.mm format.
- **10th mm** - Output coordinates in 10th mm format. The following example shows dimensions to nearest 10th mm:

![Isometric Drawing Example]

**Defines**
OS 41 Pos 2

**Metres Dimensions**
Determines whether to plot metric dimensions in M.mm format
- **mm** - Output dimensions in mm format.
- **m** - Output dimensions in M.mm format.
- **10th mm** - Output dimensions in 10th mm format.

**Defines**
OS 41 Pos 2

**MinOffset**
Controls how small dimensional deviations detected in the input pipeline data file are to be interpreted and acted upon. These deviations can lead to small, unwanted skews being generated on the isometric drawing. You can use **MinOffset** to define a dimensional cut-off value, whereby any offset coordinate numerically below this value is ignored by the software.

- **0** - Use the default for no dimensional offset tolerance to be set.
Appendix: Isometric Drawing Options

- **Value** - Use the user-defined value (real number). Set to the required dimensional tolerance in mm or inches, depending on the setting of the drawing units. For example, you can type **1.0 mm** or **0.04 inch**.

  **Defines**
  OS 116 Pos 1-3

---

**NominalSize**

Controls whether nominal size is output at branch (tee/olet/cross) and reducer locations.

- **True** - Output nominal size information at branches and reducers as normal.

- **False** - Suppress output of nominal size information at branches and reducers.

**Defines**
OS 41 Pos 8

---

**NonLinearValves**

Produces arrowed dimensions for angle, 3-way, and 4-way valve and instrument legs. Otherwise, the software prints a message. The default setting is **False**.
- **True** - Dimension angle, 3-way and 4-way valve and instruments normally.

![Diagram of True option]

- **False** - Dimension angle, 3-way and 4-way valve and instruments using message.

![Diagram of False option]

**Defines**
OS 9 Pos 8

**Overall**
Controls the use of overall dimensions. You can specify whether overall dimensions are plotted, and if they are, which type.
Appendix: Isometric Drawing Options

- **None** - Plot no overall dimensions.

- **Across Branches** - Plot overall dimensions across branches (tees, olets and crosses).

- **Stop At Branches** - Plot overall dimensions that stop at branches.

- **Valves / Across Branches** - Plot overall dimensions to valve centres and across branches.

- **Valves / Stop At Branches** - Plot overall dimensions to valve centres, stopping at branches.
Overall dimensions to valve centres are only available to valves that have a spindle.

**Defines**
OS 118 Pos 1

**OverallAcrossFabItemsOnly**
Controls the output of overall dimensions across spool breaks.
- **True** - Output overall dimensions across fabrication items only.
- **False** - Output overall dimensions across component categories.

**Defines**
OS 118 Pos 4

**PipesThroughPenetrationPlates**
Controls the dimensioning of pipes passing through penetration plates.
- **Dimension From Adjacent Plate Face** - Dimension pipes passing through penetration plates from adjacent plate face.
- **Dimension From Same Plate Face** - Dimension pipes passing through penetration plates dimensioned from same plate face.

**Defines**
OS 119 Pos 6

**SeparatePulledBend**
Controls how bends are dimensioned. The default setting is **False**.
- **True** - Plot separate dimensions for the pipe and bend sections of pulled bends.
- **False** - Plot combined dimensions for the pipe and bend sections of pulled bends.

**Defines**
OS 9 Pos 6

**StandOutComposite**
Controls dimension line standout distances for the following:
1. String and composite dimensions that are normally plotted as the middle layer of multi-layer dimensions.
2. Dimensioned messages, support dimensions and reference dimensions on the inner layer, but only when **SuppStandOut** is not set.

3. Overall dimensions on the outer layer, but only when **StandOutOverall** is not set.

In the **StandOutComposite** box, type one of the following:

- **0** - If the value is set to 0 (zero), the default, then the following standard dimension line standouts are used:
  
  When **TextSize** is set to

  - **Small**
    - String / Composite Dimension Standout = 12mm.
    - Messages / Support & Reference Dimension Standout = 6mm.
    - Overall Dimension Standout = 18mm.
  
  - **Medium**
    - String / Composite Dimension Standout = 14mm.
    - Messages / Support & Reference Dimension Standout = 7mm.
    - Overall Dimension Standout = 21mm.
  
  - **Large**
    - String / Composite Dimension Standout = 16mm.
    - Messages / Support & Reference Dimension Standout = 8mm.
    - Overall Dimension Standout = 24mm.
  
  - **XLarge**
    - String / Composite Dimension Standout = 18mm.
    - Messages / Support & Reference Dimension Standout = 9mm.
    - Overall Dimension Standout = 27mm.
  
  - **XXLarge**
    - String / Composite Dimension Standout = 20mm.
    - Messages / Support & Reference Dimension Standout = 10mm.
    - Overall Dimension Standout = 30mm.
  
  - **XXXLarge**
    - String / Composite Dimension standout = 22mm.
    - Messages / Support & Reference Dimension Standout = 11mm.
    - Overall Dimension Standout = 33mm.
Appendix: Isometric Drawing Options

- **Value** - Set a value in the data field, where value (real number) equals the required standout distance for string and composite dimensions on the middle layer in mm or inches. In the following illustration, **StandOutComposite** is set to 18, so all dimension lines are 18 mm away from the pipe.

![Isometric Drawing](example_image)

**NOTES**

- Values set to \(\leq 11\) mm are ignored by the software and substituted by the appropriate standard dimension line standout distance.
- When the value is set \(> 11\) mm, that value is used by the software to set the dimension line standout distance for string and composite dimensions on the middle layer. The inner dimension layer for dimensioned messages, Support dimensions and reference dimensions are then set to 0.5 X this distance, while the outer layer overall dimensions is set to 1.5 X this distance.

**Defines**

OS 8 Pos 1,2

**StandOutOverall**

Controls the standout distance for overall dimensions. The acceptable range of values is between 0 and 99. The default is **0**.

- **0** - No overall dimension standout is set.
- **Value** - Specify the overall dimension standout distance in mm or inches, depending on the setting of the drawing units. For example, you can type **40** to set the **Value** at **40 mm**.

![Isometric Drawing](example_image)

**Defines**
StandOutVertical

- **True** - Position the standout dimension vertically, if possible.
- **False** - Use normal standout rules. This is the default setting.

Defines

OS 8 Pos 4

SuppDimAsDim

Controls which side of the pipeline the supports are drawn.

- **True** - Draw support dimensions on the same side of pipe as the normal dimensions.
- **False** - Draw support dimensions on the opposite side of the pipe to the normal dimensions.

When this option is set to **False**, the software ignores any distance set in the `Drawing.Dimension.SuppStandOut` option.
**SuppDimToCentre**

Controls whether support dimensioning obeys the same rules as centreline pipe dimensioning.

- **True** - Obey the same rules as centerline pipe dimensioning. The following example shows centerline string dimensions to the support:

![Centerline String Dimensions](image1.png)

- **False** - Obey normal string/overall rules. The following example shows normal string dimensions to the support:

![Normal String Dimensions](image2.png)

**Defines**

OS 40 Pos 7

**SuppFormat**

Specifies the format for support dimensions.
Appendix: Isometric Drawing Options

- **None** - Support dimensions not shown on the isometric.

- **String** - Pipe supports dimensioned in string format.

- **Overall** - Pipe supports dimensioned in overall format

- **Included** - Pipe supports dimensioned in included format.

- **Suppress** - Pipe supports dimensions are suppressed.

 Defines
 OS 40 Pos 1

 SuppOptions
 Defines selective support dimensioning.

- **All** - Dimension all supports.

- **Fabrication** - Dimension only fabrication supports.
Erection - Dimension only erection supports. The following example shows only one of two supports dimensioned. The support that is dimensioned has its category set to Erection.

Offshore - Dimension only offshore supports.
Erection and Offshore - Dimension only erection and offshore supports.

Defines
OS 40 Pos 5

SuppStandOut
Specifies the support dimension standout. The acceptable range of values is between 0 and 99. The default is 0.

- 0 - No support dimension line stand-out distance set. The software default is used for all support dimensions.
- Value - Specify the required support dimension line stand-out distance in mm or inches, depending on the setting of the drawing units. The software ignores this option when the Drawing.Dimensions.SuppDimAsDim option is set to False.

Defines
OS 40 Pos 3,4

TapBranchDimension
Controls the dimensioning of tee and tap branches to allow dimensioning to the edge of pipe.
Appendix: Isometric Drawing Options

- **Centreline**- Originate dimensions from the centrelines of the main run.

  ![Diagram of Centreline]

- **TapAndSetOnStartPoint** - Dimension to the edge of pipe

  ![Diagram of TapAndSetOnStartPoint]

- **TapStartPoint** - Define tap dimensions only.

  ![Diagram of TapStartPoint]

Defines
TapOnCpt
Controls the dimensioning of tapped branches on actual fitting components, such as valves and flanges.

**NOTE** A tapped branch is a collection of components attached to a connection tapping point.

- **None** - Suppress the display of tapped branch dimensions.

![Tapped Branch Diagram](image1)

- **Full** - Display dimensions for tapped branches as set for the main pipeline.

![Tapped Branch Diagram](image2)

- **Pipe Only** - Display dimensions for pipes and pipe type components (elbows, tees, reducers, and so forth) only.

![Tapped Branch Diagram](image3)

Defines
OS 121 Pos 1

TapOnPipe
Controls the dimensioning of tapped branches on pipe-type components, such as elbows, tees, and pipe. The default setting is **None**.

**NOTE** A tapped branch is a collection of components attached to a connection tapping point.
Appendix: Isometric Drawing Options

- **None** - Turn off dimensions for tapped branch dimensions.

- **Full** - Turn on tapped branch dimensions.

- **Pipe Only** - Turn off tapped branch dimensions, except for those on pipe and pipe-type components.

**Defines**

OS 121 Pos 2

**TapOnPipeFittings**

Controls the dimensioning of tapping points on pipe type components, such as elbows/teed elbows, bends/teed bends, tees, and crosses.

**NOTE** A tapped branch is a collection of components attached to a connection tapping point.

- **None** - Suppress dimensioning of tapped branches on pipe fittings.
- **Full** - Dimension tapped branches on pipe fittings.

**Defines**

OS 121 Pos 3

**TeedBendBranchDimension**

Controls the dimensioning of tee bend/elbows.

- **Connection** - Dimension tee bend/elbows from connection point.
- **Centre-line Intersection** - Dimension tee bend/elbows from centreline intersection point.
Appendix: Isometric Drawing Options

Defines
OS 119 Pos 2

USAStyle
Controls whether the dimension line is broken to make space for the dimension characters.

- **True** - Use USA dimensioning style--positioned on top of dimension line.

- **False** - Use regular dimensioning style--inserted into dimension line.

Defines
OS 9 Pos 3

ValvBW
Displays the dimension to the centre of butt weld valves. Butt weld valves and straight through Instruments, which have a spindle, can optionally be dimensioned to their centre points rather than to their ends, using either string or composite dimensions. The default setting is **False**.

**NOTE** The **ValveBW** property can operate in conjunction with **ValveLimit**, which adds bore selectivity.
- **True** - Dimension components with butt-weld ends to their centre point.

- **False** - Dimension butt-weld ends across their length.

**Defines**
OS 80 Pos 1

**ValveCP**
Displays the dimension to the centre of compression valves. Compression type valves and straight through Instruments, which have a spindle, can optionally be dimensioned to their center points rather than to their ends, using either string or composite dimensions.

**NOTE** ValveCP can operate in conjunction with ValveLimit, which adds bore selectivity.
- **True** - Dimension components with compression ends to their centre point.

- **False** - Dimension components with compression ends across their length.

**Defines**

OS 80 Pos 2

**ValveFL**

Displays the dimension to the centre of flanged valves. Flanged valves and straight through Instruments, which have a spindle, can optionally be dimensioned to their centre points rather than to their ends, using either string or composite dimensions.

**NOTE** ValveFL can operate in conjunction with ValveLimit, which adds bore selectivity.
Appendix: Isometric Drawing Options

- **True** - Dimension components with flanged ends to their centre point.

![Diagram showing True option]

- **False** - Dimension components with flanged ends across their length.

![Diagram showing False option]

**Defines**

OS 80 Pos 5

**ValveHY**

Displays the dimension to the centre of hygienic valves. Hygienic type valves and straight through instruments, which have a spindle, can optionally be dimensioned to their centre points rather than to their ends, using either string or composite dimensions. The default setting is **False**.

**NOTE** `ValveHY` can operate in conjunction with the `ValveLimit` property, which adds bore selectivity.
Appendix: Isometric Drawing Options

- **True** - Dimension components with hygienic ends to their centre point.

- **False** - Dimension components with hygienic ends across their length.

**Defines**

OS 80 Pos 7

**ValveLimit**

Provides the bore limit. Type a value in range 0-999. The default setting is 0.

**NOTE** If you set **ValveLimit** and the valve is above this limit, the software generates end dimensions.

- **0** - Dimension valves/instruments that have their end type set in **ValveBW, ValveCP**, and so on, to their centre point.

- **Value** - Dimension valves/instruments that have their end type set in **ValveBW, ValveCP**, and so on, and have a bore equal to or less than the value set to their centre point. Value is in 1/16th of an inch or mm, depending on the bore units. For example, 32 x 1/16th is equivalent to 2" bore.

**Defines**

OS 81 Pos 1,2,3

**ValvePL**

Displays the dimension to the centre of plain valves. Plain-ended valves and straight through instruments, which have a spindle, can optionally be dimensioned to their centre points rather than to their ends, using either string or composite dimensions.

**NOTE** **ValvePL** can operate in conjunction with **ValveLimit**, which adds bore selectivity.
Appendix: Isometric Drawing Options

- **True** - Dimension components with plain ends to their centre points

- **False** - Dimension components with plain ends across their length.

**Defines**
OS 80 Pos 6

**ValveSC**
Displays the dimension to the centre of screwed valves. Screwed valves and straight through instruments, which have a spindle, can optionally be dimensioned to their centre points rather than to their ends, using either string or composite dimensions.

**NOTE** *ValveSC* can operate in conjunction with *ValveLimit*, which adds bore selectivity.
Appendix: Isometric Drawing Options

- **True** - Dimension components with screwed ends to their centre points.

- **False** - Dimension components with screwed ends across their length.

**Defines**

OS 80 Pos 3

**ValveSW**

Displays the dimension to the center of socket weld valves. Socket weld valves and straight through instruments, which have a spindle, can optionally be dimensioned to their center points rather than to their ends, using either string or composite dimensions. The default setting is **False**.

**NOTE** ValveSW can operate in conjunction with ValveLimit, which adds bore selectivity.
Appendix: Isometric Drawing Options

- **True** - Dimension components with socket weld ends to their center points.

- **False** - Dimension components with socket weld ends to be across their length.

**Defines**

| OS 80 Pos 4 |

**VertOption**

Controls how vertical pipe positions are indicated on the isometric drawing.
Appendix: Isometric Drawing Options

- **Normal** - Display normal vertical pipe dimensions, with elevations at intersection points when the level changes.

- **Suppressed** - Suppress all vertical pipe dimensions, replaced by elevations in the form of text messages at all positions where dimensions would normally be output.

- **Elevation** - Display vertical dimensions and elevations at all normal dimensioning positions.
Appendix: Isometric Drawing Options

Defines
OS 119

WeldDimensionAccuracy
Allows welds to be dimensioned to the nearest 10th mm.
- **Nearest mm** - Dimension welds to the nearest mm.
- **Nearest 10th mm** - Dimension welds to the nearest 10th mm. If the decimal place value is zero, the dimension is output in whole millimetres.

Defines
OS 119 Pos 8

WeldDimensioning
Controls the dimensioning of welds.
- **True** - Dimension welds.
- **False** - Suppress dimensioning of welds.

Defines
OS 119 Pos 7

See Also
*Appendix: Isometric Drawing Options* (on page 415)
Format (Drawing)
Sets options for the isometric drawing format, including text size and skew dimensions.

AdditionalEnclosureStyle
Specifies the style for part number enclosures.

Type 1:
- None - Display no enclosure style.
- Type 1 Square
- Type 1 Round
- Type 1 Diamond

Type 2 - Use the Drawing.Format.PartNoEnclosureStyle option to define the style of end used with Type 2 additional enclosure.
- Type 2 Square
Appendix: Isometric Drawing Options

- **Type 2 Round**

- **Type 2 Diamond**

**NOTES**

- **Drawing.FormatPartNoSpaces** needs to be set to control the number of blank spaces used.
- If **Drawing.Format.PartNoEnclosureStyle** is set to **Circle**, **Double Circle** or **Ellipse**, then Type 2 **AdditionalEnclosureStyle** is switched off, as this uses the same setting.
- For Type 2, the enclosure style for the box with the part numbers in it is defined using **PartNoEnclosureStyle**.
- All pipe part numbers, which are usually output as messages along the pipe, are converted to arrowed out type messages.

**Defines**

- OS 73 Pos 5
- OS 76 Pos1

**AdditionalWeldEnclosure**

Controls special part number box for welds.

- **True** - Display a special part number box for welds.

- **False** - Suppress display of a special part number box for welds.

**NOTE** Welds must have part numbers and descriptions, and the **MLType** property must be set to **Special**.

**Defines**

- OS 73 Pos 6,7
Appendix: Isometric Drawing Options

AdditionalWeldEnclosureSpaces
Sets the number of spaces used when AdditionalWeldEnclosure is set to True.

- **Value** - Specify the number of spaces to be used. If no value is set, the software uses a default value of 2.

**Defines**
OS 73 Pos 6,7

AngleAccuracy
Controls the accuracy at which angle information is output on the isometric drawing.

- **Default** - Output all angles to ISOGEN default accuracy of 0.1 degrees with no trailing zeros. For example, 80.16 is output as 80.2 degrees, and 80.01 is output as 80 degrees.
- **Nearest Degree** - Output angles to the nearest degree.
- **Nearest 10th Degree (1 decimal place)** - Output angles to the nearest 0.1 degrees.
- **Nearest 100th Degree (2 decimal places)** - Output angles to the nearest 0.01 degrees.

**Defines**
OS 67 Pos 4

AngleStyle
Controls the output of angle information for bends and elbows in the pipeline.

- **All** - Output all angle information on the isometric (including angles that are exactly 90- and 180-degrees.)
- **All except 90/180 deg** - Output all angle information on the isometric drawing except angles that are within 0.5-degrees of 90- and 180-degrees.
- **All except within 10th degree of 90/180 deg** - Output angle information on the isometric drawing unless when rounded angles are within .1-degree of 90- and 180-degrees.
- **None** - Suppress angle information on the isometric drawing.

**Note** You must set this option to None if you are using AngleStyle with the Drawing.Format.ShowBendAngle option.

**Defines**
OS 67 Pos 2

AngleType
Controls whether the angles output for bends and elbows are the included or deflected angle.
Appendix: Isometric Drawing Options

- **Deflected**

![Deflected Diagram]

If set, AText -396 is combined with the angle information and displayed on the isometric drawing.

- **Included**

![Included Diagram]

If set, AText -396 is combined with the angle information and displayed on the isometric drawing.

If not set (default), only the angle information is output.

**Defines**

OS 67 Pos 3

**AssemblyIDSequencing**

Controls how assembly identifiers are sequenced.

- **Combined** - Sequence all assembly identifiers.
- **Category** - Sequence assembly identifiers by category.

**Defines**

OS 79 Pos 7

**BendRadius**

Sets the bend radius in millimetres. Use this option only if you set the bend representation to round.
Appendix: Isometric Drawing Options

- **Value** - Type a value in the range of 0-9. In the following example, the **BendRadius** is 8mm.

![Bend Representation Diagram]

**NOTE** If you specify a value of 0, the software uses a default radius of 3mm.

**Defines**
ISOGEN attribute

**BendRepresentation**
Defines how bends look on the isometric drawing.

- **Square**

- **Round**

**Defines**
ISOGEN attribute

**ComponentLegLength**
Specifies a plotted leg length for elbows, tees, and crosses. **ComponentLegLength** does not apply to fabricated (pulled) bends or set-on (stub-in) type tees or crosses.

**Value** - Specify the required leg length in whole millimetres. For example, for a 12 mm leg length, type 12.

**NOTES**

- Use this option with care, as it can produce undesirable results on the drawing. The maximum suggested value is 18 (18 mm), and the minimum suggested value is 6 (6 mm).
- If you set the **Value** to 0, the software uses a default value of 9 mm.

**Defines**
Appendix: Isometric Drawing Options

ConnectionIDCategory
Controls which category of end connections is assigned an identifier.
- **All** - Assign an identifier to all end connections.
- **Fabrication** - Assign an identifier only to Fabrication end connections.
- **Erection** - Assign an identifier only to Erection end connections.
- **Offshore** - Assign an identifier only Offshore end connections.
- **Erection and Offshore** - Assign an identifier only to Erection and Offshore end connections.

Defines
OS 79 Pos 8

CptAttributesEnclStyle
Contains the text output to the Data Definition File (DDF) for the component attribute enclosure. Adheres to the following format:

```
Message-Type Attribute
```

**Message-Types:**
- MESSAGE-POINTED
- MESSAGE-ROUND
- MESSAGE-TRIANGLE
- MESSAGE-DIAMOND
- MESSAGE-SQUARE
- MESSAGE-CIRCLE
- MESSAGE-UNBOXED

**Attributes:**
- COMPONENT-NAME
- COMPONENT-ATTRIBUTE1 to COMPONENT-ATTRIBUTE10

You can output attributes to the following:
- Material list (Variable and UserDefined)
- Printed material list
- Material control file
- Cut list report
- Cut list file

CptTagEnclStyle
Controls the enclosure shapes used for components if **CptTagsStyle** is set to **Boxed**.
- Square-ended box
Appendix: Isometric Drawing Options

- Diamond-ended box
- Round-ended box
- Triangular
- Diamond
- Rectangular
- Circular
- Elliptical
- Hexagonal

**Defines**
OS 60 Pos 3

**CptTagStyle**
Defines the style for tag numbers on inline items.

- **None** - Suppress plotting of tags/names.
- **Boxed** - Plot and box in tags/names.
- **Unboxed** - Plot tags/names without boxing in.

**NOTES**
- Tagging of pipe and pipeline elements made from pipe is not supported.
- For instruments, see `Drawing.Format.InstIDEnclosureStyle`.

**Defines**
OS 60 Pos 1

**CurvedPipeAngleStyle**
Controls the dimensioning of curved pipe.

- **Suppress** - Suppress curved pipe angles.
- **With dimension** - Output curved pipe angles as part of dimensions.
- **Message** - Output curved pipe angles as a message.

**Defines**
OS 84 Pos 2

**CurvedPipeRadiusStyle**
Controls the dimensioning of curved pipe.

- **Message** - Output curved pipe radii as a message.
- **Suppress** - Suppress curved pipe radii.

**Defines**
Appendix: Isometric Drawing Options

OS 84 Pos 3

**CurveThreshold**
Defines the minimum radius at which bends are output as curved pipe on the isometric drawing.
- **Value** - Type a value in the range of 0-99.

**NOTE** Curved pipe can be drawn only in primary planes.

**CutPieceEnclosureStyle**
Controls the shape of the enclosure used to surround the cut piece numbers on the isometric.
- `<n>` Default
- Circle
- Diamond
- Diamond Ends
- Double Circle
- Double Ellipse
- Ellipse
- Hexagon Ends
- Round Ends
- Square Ends
- Triangle

**Defines**
OS 2 Pos 7

**CutPieceNoLength**
Sets a fixed (1-9 characters or variable) length for part numbers.
- **Value** - Specify the fixed length.

**Defines**
OS 72 Pos 2

**ElbowRadius**
Controls the radius depiction (in millimetres) on the isometric drawing for elbows. Acceptable values are in range 3mm to 9mm.
Appendix: Isometric Drawing Options

- **Value** - Specify the elbow radius. In the following illustration, `ElbowRadius` is set at 4.5mm.

  ![Elbow Representation Diagram](image)

**NOTES**
- Use this option only if you set `ElbowRepresentation` to `Round`.
- The default radius used for elbows is 3mm.

**Defines**
ISOGEN attribute

**ElbowRepresentation**
Defines how elbows look on the isometric drawing.

- **Square**

  ![Square Elbow Diagram](image)

- **Round**

  ![Round Elbow Diagram](image)

**Defines**
ISOGEN attribute

**FabricationAssemblyIDEnclosure**
Controls the enclosure style for Fabrication assembly identifiers output on the isometric drawing.

- **None** - Display assembly identifiers with no box enclosure.
- **Diamond Ended** - Display assembly identifiers in a diamond-ended box enclosure.
- **Round Ended** - Display assembly identifiers in a round-ended box enclosure.
- **Triangle** - Display assembly identifiers in a triangular-shaped enclosure.
- **Diamond** - Display assembly identifiers in a diamond-shaped enclosure.
- **Square Ended** - Display assembly identifiers in a square-ended box enclosure.
- **Circle** - Display assembly identifiers in a circular enclosure.
Appendix: Isometric Drawing Options

- **Suppress** - Suppress the display of assembly identifiers.
- **Double Circle** - Display assembly identifiers in a circular-shaped enclosure inside another circle.
- **Ellipse** - Display assembly identifiers in an elliptical-shaped enclosure.

**Defines**

OS 79 Pos 5

**FallCutOff**

Defines the minimum slope treated as a fall. Slopes steeper than the cut-off value are shown with a 2D or 3D box or triangle skew indication as appropriate.

- **0** - Use the default for 5° angle cut-off or its equivalent depending upon the type of indication selected by **FallRepresentation**.
- **Value** - Define a cut-off number to suit the type of indication selected by **FallRepresentation**.
  - For fall cut off of 5 Degrees, type 5 or 0.
  - For fall cut off of 1:11 Ratio, type 11.
  - For fall cut off of 9 Percent, type 9.
  - For fall cut off of 5 Grads, type 5.
  - For fall cut off of 1" Per foot, type 1.
  - For fall cut off of 88 mm per metre, type 88.

**NOTE** Always set **FallCutOff** to 0 when sloping pipeline indication has been suppressed by **FallRepresentation**.

**Defines**

OS 20

**FallRepresentation**

Specifies how sections of falling pipelines (downward slopes) are indicated on the isometric drawing. This option determines the method of how the fall value is indicated numerically on the isometric drawing, as specified by one of the options shown below.

- **None** - Suppress falling line indication.
- **D deg** - Output angle to nearest degree.
- **D.d deg** - Output angle to nearest 1/10th degree.
- **D.dd deg** - Output angle to nearest 1/100th degree.
- **deg.min** - Output angle in degrees and minutes.
- **G grad** - Output gradient to nearest grad.
- **G.g grad** - Output gradient to nearest 1/10th grad.
- **G.gg grad** - Output gradient to nearest 1/100th grad.
- **Incline~1/16th”/ft** - Output incline to nearest 16th of an inch per foot.
Appendix: Isometric Drawing Options

- **Incline~1/100”/ft** - Output incline to nearest 100th of an inch per foot.
- **Incline~1mm/m** - Output incline to nearest mm per metre.
- **Incline~5mm/m** - Output incline to nearest 5mm per metre.
- **Incline~10mm/m** - Output incline to nearest 10mm per metre.
- **P%** - Output percentage to nearest whole value.
- **P.p%** - Output percentage to nearest 1 decimal place.
- **P.pp%** - Output percentage to nearest 2 decimal place.
- **Ratio~5 (>1:30)** - Output ratio to nearest 5 when greater than 1:30.
- **Ratio~5 (>1:100)** - Output ratio to nearest 5 when greater than 1:100.
- **Ratio~1** - Output ratio to nearest 1.
- **Ratio~25 (>1:500)~10 (>1:100)~5 (>1:50)~2 (>1:30)~1** - Output ratio according to the following: to nearest 25 when greater than 1:500, to nearest 10 when greater than 1:300, to nearest 5 when greater than 1:50, to nearest 2 when greater than 1:30, and to nearest 1 in all other circumstances.

- **Symbol Only** - Show only the Fall indicator symbol. Suppress output of associated text.

**Defines**

OS 19

**FlangeRotationStyle**

Specifies the style of the enclosure box for flange rotation angles on the isometric drawing, when `Drawing.Content.ShowFlangeRotation` is set to **True**.

- **No box** - Output un-boxed angle output.
- **Diamond ends** - Output a diamond-ended enclosure box.
- **Round ends** - Output a round-ended enclosure box.
- **Square ends** - Output a square-ended enclosure box.

**Defines**

OS 124 Pos 2

**FlowArrowScale**

Scales flow arrows that are plotted directly on the pipe. Flow arrows are used to show the flow direction of fluid or gas in the pipeline.

- **Value** - Plot pipeline flow arrows at an alternative scale factor (default 8) in the range value 5 to 15 (value 5 produces smaller arrows, 15 larger).

**NOTES**

- You can generate this type of flow arrow only if the relevant information is included in the input pipeline data file.
- You can also use a separate type of flow arrow, which is plotted alongside in-line fittings, either as well as or instead of, the flow arrow annotation output on pipe.
Appendix: Isometric Drawing Options

Defines
OS 112 Pos 1,2

GhostGapDimension
Controls the plotted length of a ghost gap element. A ghost gap element is a physical gap on the plotted isometric that can be used when generating individual pipeline isometrics, or as a link between related, but unconnected, pipelines on a system type isometric. The default setting is 0.

- **0** - Use the normal minimum gap as controlled by ISOGEN.
- **Value** - Specify a user-defined minimum gap dimension in whole millimeters.

**NOTES**
- The smallest allowable value is 18 mm, and the largest allowable value is 60 mm.
- The software defaults to using the appropriate maximum value if it detects a setting outside these limits.

Defines
OS 110

InstIDEnclosureSize
Specifies the size of the enclosure for instrument text. You can choose 1 through 4 characters on each of the two available lines within an instrument balloon, or you can specify no balloon.

- **No Balloon** - Suppress plotting of a balloon around the instrument name.
- **1 character** - Plot a balloon size at least 1 character on each line.
- **2 character** - Plot a balloon size at least 2 characters on each line.
- **3 character** - Plot a balloon size at least 3 characters on each line.
- **4 character** - Plot a balloon size at least 4 characters on each line.

**NOTE** A two line name output is derived by inputting a $ character in the name at the point a new-line is required, such as CV$101.
5 character - Plot a balloon size at least 5 characters on each line.

NOTE A variety of other box type enclosures is available by using **InstIDEnclosureStyle**.

**InstIDEnclosureStyle**
Specifies the shape of the instrument name box.

- **No Box** - Revert to using the setting for **InstIDEnclosureSize**.
- **Diamond** - Display a diamond-ended box enclosure.
- **Round** - Display a round-ended box enclosure.
- **Triangular** - Display a triangle-shaped enclosure.
- **Diamond** - Display a diamond-shaped enclosure.
- **Square** - Display a square-ended box enclosure.
- **Circle** - Display a circular-shaped enclosure.
- **Ellipse** - Display an elliptical-shaped enclosure.
- **Hexagon** - Display a hexagonal-shaped enclosure.

NOTE To reduce the chances of these enclosures becoming quite large, especially the diamond and triangle enclosures, limit the display to only 2 or 3 characters.

**InstIdentification**
Specifies whether to use the instrument tag or item code in the material list or any material control file that is generated. Typically, 3D design systems have parameters for both the instrument name (tag) and the specification reference (Item code), but only one of these can be selected for output.

- **Use Tag** - Output the default for the instrument name (tag).
- **Use Item Code** - Output the instrument item code.

**InsulationStyle**
Specifies whether to show insulation along pipe only or along pipe and components.

- **None** - Suppress insulation indication.
- **Alongside Pipe** - Plot dashed insulation lines alongside pipe only, with a gap of 1 mm.
- **Alongside Pipe and Components** - Plot dashed insulation lines alongside pipe and all components, both with a 1 mm gap.
MessageCircleEnclosure

Controls the physical size of the circle enclosure used to contain user input messages. This is achieved by specifying a mixture of new line and blank character indicators that are used by the software to pad-out the normal message record to effectively increase the size of the enclosure. The size of the text `Drawing.Format.TextSize` displayed within any increased size enclosure is not increased in size.

The data string associated with each identifier consists of a combination of @, $ and ? characters.

- The @ character signals a blank (space) requirement.
- The $ character signals a new line requirement.
- The ? character indicates where the actual data from the declared record is located in the padded-out record.

Setting the value to the text string `@@?@@` increases the message enclosure as shown in the following illustration:

![Diagram](image)

**NOTE** Ideally, the message enclosure should only contain two or three characters, and should also be used with care, as a large circle message considerably affects the isometric representation.

**Defines**

ISOGEN attribute

MessageDiamondEnclosure

Controls the physical size of the diamond enclosure used to contain user input messages. Acceptable value is a data string consisting of @, $, and ? characters. For more information about the data string, see `Drawing.Format.MessageCircleEnclosure` in this topic.

**Defines**

ISOGEN attribute

MessagePointedEnclosure

Controls the physical size of the pointed-ended enclosure used to contain user input messages. Acceptable value is a data string consisting of @, $, and ? characters. For more information about the data string, see `Drawing.Format.MessageCircleEnclosure` in this topic.

**Defines**
ISOGEN attribute

**MessageRoundEnclosure**
Controls the physical size of the round-ended enclosure used to contain user input messages. Acceptable value is a data string consisting of @, $, and ? characters. For more information about the data string, see `Drawing.Format.MessageCircleEnclosure` in this topic.

**Defines**
ISOGEN attribute

**MessageSquareEnclosure**
Controls the physical size of the square enclosure used to contain user input messages. Acceptable value is a data string consisting of @, $, and ? characters. For more information about the data string, see `Drawing.Format.MessageCircleEnclosure` in this topic.

**Defines**
ISOGEN attribute

**MessageTriangleEnclosure**
Controls the physical size of the triangle enclosure used to contain user input messages. An acceptable value is a data string consisting of @, $, and ? characters. For more information about the data string, see `Drawing.Format.MessageCircleEnclosure` in this topic.

**Defines**
ISOGEN attribute

**MultiPortConnections**
Controls the connection leg depiction of multi-port components.
- **All Dotted** - Display dotted connection lines on all multi-port connections.
- **Dotted for Clarity** - Display dotted connection lines only when necessary for picture clarity, such as when two or more ports are positioned on the same side with attached pipe work running parallel to each other.
- **Not shown** - Suppress the display of dotted connection lines shown.

**Defines**
OS 95 Pos 5

**NorthArrowBox**
Controls whether the north arrow, as specified by `Drawing.Controls.NorthDirection`, is displayed in an enclosing box.
- **True** - Display the north arrow in an enclosing box.
- **False** - Suppress the display of the north arrow in an enclosing box.
Appendix: Isometric Drawing Options

Defines
OS 42 Pos 1

OffshoreAssemblyIDEnclosure
Controls the enclosure style for Offshore assembly identifiers output on the isometric drawing.
- None - Display assembly identifiers in no box enclosure.
- Diamond Ended - Display assembly identifiers in a diamond-ended box enclosure.
- Round Ended - Display assembly identifiers in a round-ended box enclosure.
- Triangle - Display assembly identifiers in a triangular-shaped enclosure.
- Diamond - Display assembly identifiers in a diamond-shaped enclosure.
- Square Ended - Display assembly identifiers in a square-ended box enclosure.
- Circle - Display assembly identifiers in a circular enclosure.
- Suppress - Suppress the display of assembly identifiers.
- Double Circle - Display assembly identifiers in a circular-shaped enclosure inside another circle.
- Ellipse - Display assembly identifiers in an elliptical-shaped enclosure.

Defines
OS 79 Pos 6

OletBranchOrientationMessage
Controls the output of an orientation message on undeveloped olet branches that are in primary directions.
- Create Orientation Message - Output an orientation message on undeveloped olet branches in a primary direction.
- No Message - Suppress output of an orientation message on the isometric drawing.

Defines
OS 70 Pos 4

OrientationFrom
Controls the output of Skew orientation.
- **Previous Position** - Output the orientation direction message showing rotation relative to previous position.

- **Primary Direction** - Output the orientation direction message showing rotation from primary direction.

**Defines**

OS 70 Pos 3

**PartNoEnclosureStyle**

Specifies the part number enclosure box shape.

- **None** - No enclosure box. Only plots part numbers.

- **Square Ends**
Appendix: Isometric Drawing Options

- Round Ends

- Diamond Ends

- Circle

- Double Circle

- Ellipse

**NOTE** The size at which the circle, double circle and ellipse is drawn is controlled by **PartNoEnclosureSize** (default 2 characters), which defines the minimum size for the enclosure. If there are more characters than the value set, the enclosure dynamically adjusts to accommodate.

**Defines**

OS 76 Pos 1 and 2
Appendix: Isometric Drawing Options

**PartNoEncSize**

Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default is 2, and the valid entries are from 1 to 8 characters, or set to **Variable size**, which dynamically sizes the enclosure.

The following example shows the default size of 2 used for the circle enclosure style:

![Diagram showing default size of 2 for circle enclosure style]

NOTE The number of characters defines the minimum size that the circle, double circle and ellipse is drawn at. If there are more characters than the value that is defined, the enclosure dynamically adjusts to suit. If the option is set to **Variable size**, this allows the circle, double circle and ellipse to be smaller than the default of 2 characters, but again dynamically adjust to suit the number of characters.

**Defines**

OS 76 Pos 3

**PartNoLength**

Sets a fixed length for part numbers (1-9 characters or variable).

- **Value** - Specify a fixed length for part numbers.

**Defines**

OS 76 Pos 4

**PartNoSpaces**

Sets the number of spaces used in the Type 1 and Type 2 part number boxes specified by **Drawing.Format.AdditionalEnclosureStyle**.

- **Value** - Specify the number of spaces to be used. A default value of 2 is used if no value is set.

**Defines**

OS 73 Pos 1 and 2 or
OS 73 Pos 3 and 4

**PartNoVisible**

Suppresses the plotting of part numbers and associated enclosure boxes on the drawing.
Appendix: Isometric Drawing Options

- **True** - Display part numbers on the isometric drawing.
- **False** - Suppress the display of part numbers on the isometric drawing.

**Defines**

OS 76 Pos 1

**ReferenceNameStyle**

Controls the physical size of the characters that are used for dimensions, co-ordinates and message text on the ‘picture section’ of the isometric.

- **Default (Along Reference Lines)**

- 1 Character Circular Enclosure
- 2 Characters
- 3 Characters
- 4 Characters
- 5 Characters
- 6 Characters
- 7 Characters
- 8 Characters
- 9 Characters
Appendix: Isometric Drawing Options

Defines
OS 123 Pos 5

SiteAssemblyIDEnclosure
Controls the enclosure style used for site assemblies on the isometric drawing.
Appendix: Isometric Drawing Options

- **None** - Display no box enclosure.

- **Diamond** - Display a diamond-ended box enclosure.

- **Round** - Display a round-ended box enclosure.

- **Triangular** - Display a triangular-shaped enclosure.

- **Diamond** - Display a diamond-shaped enclosure.

- **Rectangular** - Display a rectangular-shaped enclosure.

- **Circular** - Display a circular-shaped enclosure.
Appendix: Isometric Drawing Options

- **Double Circle** - Display a circular-shaped enclosure inside another circle.

- **Ellipse** - Display an elliptical-shaped enclosure.

**NOTES**

- The site assembly uses AText -478, default J--such as J1 or JA--to prefix the flange assembly identification.

- The size that the circle, double circle and ellipse is drawn at is controlled by `Drawing.Format.SiteAssemblyIDEnclSize` (default 2 characters) which defines the minimum size for the enclosure. If there are more characters than the value set, the enclosure dynamically adjusts to suit.

**Defines**

OS 79 Pos 3

**SiteAssemblyIDEnclSize**

Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default is 2, and the valid entries are from 1 to 8 characters or set to **Variable size**, which dynamically sizes the enclosure.
The following example shows the default size of 2 used for a circle style enclosure:

![Circle Style Enclosure Diagram]

**NOTE** The number of characters defines the minimum size that the circle, double circle and ellipse is drawn at. If there are more characters than the value set, the enclosure is dynamically adjusted to suit. Setting the size to **Variable size**, allows the circle, double circle and ellipse to be smaller than the default of 2 characters, but again dynamically adjusts to suit the number of characters.

**Defines**
OS 79 Pos 9

### SiteAssemblyIDs
Controls site assembly information displayed on the isometric drawing.

- **Off** - Suppress display of flange assembly identification.
- **Numeric** - Display numeric flange assembly identification.

- **Alphabetic** - Display alphabetic flange assembly identification.

**Defines**
OS 79 POS 1

### SiteAssemblyIDsPerDrawing
Controls whether site assemblies are numbered per drawing or per pipeline.

- **True** - Number flange assembly identification per drawing.
- **False** - Number flange assembly identification per pipeline.

**Defines**
OS 79 Pos 2

### SiteWeldsNotAssignedToSpools
By default, site welds are assigned to spools if they are adjoining.
Appendix: Isometric Drawing Options

- **True** - Suppress assignment of site welds to adjoining spools.
- **False** - Assign site welds to adjoining spools.

**Defines**

OS 83 Pos 1

**SkewAngleStyle**

Controls the output of skew angles on skewed section of pipeline.

- **Both Angles With Arrowheads** - Display both skew angles with arrow heads on the arc radius.
- **Both Angles Without Arrowheads** - Display both skew angles without arrow heads on the arc radius.
- **Not Shown** - Suppress output of skew angles.
- **With Arrowheads** - Display a single skew angle with arrow heads on the arc radius.
- **Without Arrowheads** - Display a single skew angle without arrow heads on the arc radius.

**Defines**

OS 99 Pos 3

**SkewDimStandout**

Controls the dimension line standout distance used on boxed or triangle skew dimensions.

- **0** - Use the dimension line standout setting defined in `Drawing.Dimensions.StandOutComposite`, except when `SkewDimStyle` is set to **Triangle - Alternative**, in which case the default dimension position is 4 mm.
- **Value** - Specify the value (real number) used as an alternative dimension line standout in mm or inches, depending on the setting of the drawing units. Used when `SkewDimStyle` is set to **Triangle - Skew standout**.

**Defines**

OS 100

**SkewDimStyle**

Specifies how skewed pipe sections are drawn on the isometric, along with the form of skew dimensioning to be used.

- **Box - normal standout** - Depict skew box with normal dimensioning.
- **Triangle - normal standout** - Depict skew triangle with normal dimensioning.
- **Triangle - skew standout** - Depict skew triangle with normal dimensioning. Uses the value set in `SkewDimStandout`.
- **Triangle - alternative** - Depict skew triangle with alternative dimensioning. Actual dimensions are positioned close to the sides of triangle with no witness lines.
Appendix: Isometric Drawing Options

**SkewHatchCptGap**
Specifies the gap left unhatched for inline components. This value is in 1/10 millimetres. Acceptable values are in the range 0-99.

**SkewHatchDimText**
Specifies the gap left unhatched for dimensions and text. This value is in 1/10 millimeters.

**SkewHatching**
Specifies whether skew hatching is on or off.
**SkewHatchPipeGap**

Controls the physical size of the unhatched gaps (white space) to be left local to the pipeline. The default value is **2.5 mm**.

- **0** - Use the default value for the gap local to pipeline.
- **Value** - Specify the value (in the range 0-10) used for the alternative gap.

**Defines**

OS 102 Pos 1, 2

**SkewHatchSpacing**

Controls the spacing of the hatching lines used in hatched triangles.

- **Value** - Specify the value (in range 0-10) that equals the alternative hatch line spacing.

**Defines**

OS 101 Pos 1, 2

**SkewInVerticalBranch**

Controls the drawing depiction method used when a vertical branch connection is made to a sloping (falling) pipeline using a special zero length bend component. The default setting is **True**.

This special bend (which has no length) is used to carry the angle between the vertical branch and the sloping pipeline. Two drawing methods are available. One shows a small 2D skew box section between the branch and the main pipe, while the other does not.

Where olets are used in such cases, a text message indicates the orientation direction if the branch is not developed.

- **True** - Show the short tee branch leg section of pipe skewed. Olets have an orientation message instead of a skewed section. Both are dimensioned separately to the connecting pipe.
- **False** - For no separate skew sections, the vertical branch is connected straight into the main pipe. Olets do not have an orientation message. Both are included in a single inclusive dimension.

**NOTE** In both cases the angle between the vertical branch and the sloping (falling) pipeline will be indicated.

**Defines**

OS 68

**SkewMinCpts**

Optionally permits simple skewed branch legs to have the normal skew box/triangle enclosure suppressed and replaced by a single pipe length dimension and a text message giving the branch orientation. Acceptable range of values is 0-99. The default value is **0**.
When used to suppress the normal box enclosure, the value set represents the maximum number of fittings permitted in the branch. Branches found to contain more fittings than this are drawn with the normal skew box/triangle enclosure.

- **0** - Draw all branches with normal skew box/triangle depiction.
- **Value** - Suppress skew box/triangle depiction on branch legs whose number of components is less than or equal to the value set, and output an orientation message.

**NOTE** This facility is only available on straight through branches. Any change in direction along the branch automatically causes the software to default to normal skew box/triangle output.

**Defines**

OS 70

**SkewMixed**

Shows 3D skew boxes and 2D skew triangles.

- **True** - For mixture of skew indication types--3D skews are indicated with boxes, and 2D skews are indicated with triangles.
- **False** - All skew indications similar, as defined by **SkewDimStyle**.

**Defines**

OS 99 Pos 2

**SkewOverall**

Controls how skew pipe sections containing branch connections are depicted in terms of the skew indication on the isometric drawing. Such skews may be shown as either a single, overall enclosure or as a series of separate box or triangle enclosures.

- **Individual** - Depict skews with a series of separate box or triangle enclosures, one enclosure per branch.
- **Overall** - Depict a single overall skew.

**Defines**

OS 97

**SkewRepresentation**

Controls the method used to depict sloping (falling) sections of a pipeline that are skewed in the horizontal plane.

- **3D box** - Show the full 3D box or triangle.
- **2D Skew + Fall** - Show the 2D skew box or triangle plus fall indicator.

**Defines**

OS 67
**SkewTriangleRightAngleIndication**
Controls the method used to depict sloping (falling) sections of a pipeline that are skewed in the horizontal plane.

- **3D box** - Show the full 3D box or triangle.
- **2D Skew + Fall** - Show the 2D skew box or triangle plus fall indicator.

**Defines**
OS 67

**SpecBrkEnclosure**
Controls the shape of the enclosure that surrounds the indication of a specification break (specification change) on the isometric drawing.

- **None** - Suppress the display of an enclosure around the specification break reference on the isometric drawing.
- **Square Ended** - Display a square-shaped box enclosure around the specification break reference on the isometric drawing.
- **Diamond Ended** - Display a diamond-shaped enclosure around the specification break reference on the isometric drawing.
- **Round Ended** - Display a round-ended box enclosure around the specification break reference on the isometric drawing.
- **Hexagonal Ended** - Display a hexagonally-shaped enclosure around the specification break reference on the isometric drawing.

**Defines**
OS 114 Pos 2

**SpecBrkRepresentation**
Specifies single or dual specification break indication boxes on the isometric drawing

- **Single** - Indicate a single specification. Boxed message consisting of the new specification reference pointing to the position on the pipeline where the change occurs.
- **Dual** - Indicate two specifications. Two boxed messages containing the current and new specification references are positioned at the point on the pipeline where the change occurs.

**Defines**
OS 114 Pos 1

**SpoolIDEnclosure**
Specifies the enclosure shape for the spool identifiers.
Appendix: Isometric Drawing Options

- **None** - Use no enclosure.

- **Square Brackets** - Enclose spool identifiers in the standard square brackets or a double box enclosure.

- **Diamond Ends** - Enclose spool identifiers in a diamond-ended box.

- **Round** - Enclose spool identifiers in a round-ended box.

- **Triangular** - Enclose spool identifiers in a triangle-shaped box.
Appendix: Isometric Drawing Options

- **Diamond Box** - Enclose spool identifiers in a diamond-shaped box.

- **Square Box** - Enclose spool identifiers in a square-ended box.

- **Circle** - Enclose spool identifiers in a circle.

- **Double Circle** - Enclose spool identifiers in a double circle.

- **Ellipse** - Enclose spool identifiers in an ellipse.

**NOTE** The size that the circle, double circle and ellipse will be drawn at, is controlled by `SpoolIDSize` (default 2 characters), which defines the minimum size for the enclosure. If there are more characters than the value set, the enclosure dynamically adjusts to suit.

**Defines**

OS 39 Pos 3, 8

**SpoolIDEnclosureStyle**

Increases the size of the SpoolID enclosure.

This is achieved by specifying a mixture of new line and blank character indicators that are used by the software to pad-out the SpoolIDEnclosure record to effectively increase the size of the enclosure. The size of the text `Drawing.Format.TextSize` displayed within any increased size...
enclosure is not increased in size. The data string associated with each identifier consists of a combination of @, $ and ? characters.

- The @ character signals a blank (space) requirement.
- The $ character signals a new line requirement.
- The ? character indicates where the actual data from the declared record should be located in the 'padded-out' record.

Setting the value to the text string @@@@?@@@$@ increases the SpoolIDEnclosure with the diamond-end enclosure as shown in the following illustration:

![Diagram of isometric drawing with enclosure]

**NOTE** Use the increase in size with care as it affects the isometric representation considerably.

**Defines**

ISOGEN attribute

**SpoolIDType**

Turns on and off the display of spool identifiers.

- **None** - Turn off the display of spool identifiers to be suppressed.
- **Numeric** - Include model spool numbers on the isometric drawing.

**NOTES**

- If you require alphabetic spool identifiers, you can create a spool naming rule which applies an alpha suffix to the spool numbers in the model. Naming rules are discussed further in the Smart3D Programmer's Guide under Customizing Naming Rules. Contact your administrator or Intergraph Support if you need the Programmer's Guide.
- This option can be used in the place of Drawing.Content.ShowSpoolID, which is no longer supported by ISOGEN.

**Defines**

OS 39 Pos 1

**SupportIdentification**

Specifies whether support names are shown on the isometric drawing and whether the names are boxed or unboxed. This option also controls whether supports are in the material list (BOM) and whether the tag or specification reference (item code) is in the item code field.

- **No Tags / Spec Ref** - Suppress output of support names (tags) on the isometric drawing and output of the specification reference (item code) in the item code field of the material list.
Appendix: Isometric Drawing Options

- **Unboxed Tags / Tags** - Output unboxed support names (tags) on the isometric drawing, and outputs support names in the item code field of the material list.

- **Boxed Tags / Spec Ref** - Output boxed support names (tags) on the isometric drawing, and outputs the specification reference in the item code field of the material list.

- **Unboxed Tags** - Output unboxed support names (tags) on the isometric drawing, and excludes supports from the material list.

- **Boxed Tags** - Output boxed support names (tags) on the isometric, and excludes supports from the material list.

**Defines**
OS 64 Pos 1

**SupportTagEnclStyle**

If **SupportIdentification** is set to **Boxed Tags / Spec Ref** or **Boxed Tags**, controls the enclosure shapes used for supports.

- **Default Rectangle**
- **Round Ends**
- **Diamond Ends**
- **Triangle**
- **Diamond**
- **Rectangle**
- **Circle**
- **Ellipse**
- **Hexagon**

**Defines**
OS 64 Pos 3

**TapBranchInlineScale**

Provides a tapped branch scaling factor for taps on inline items such as valves and flanges. The value represents a percentage of the main pipeline size. The minimum value is 75 and the maximum is 125.

- **0** - Default for no tapped branch scaling. Tapped branches shown the same size as the main pipeline (100%).
- **Value** - Specify a value that represents an alternative tapped branch scaling factor. For example, type **110** to increase scaling, **90** to decrease scaling.

**NOTES**

- A tapped branch is a collection of components attached to a connection tapping point. The components in a tapped branch can be scaled up or down from the size used for the main pipeline.
- **50%** is the minimum recommended value.
Defines
OS 120 Pos 1,2,3

**TapBranchPipeScale**
Provides a tapped branch scaling factor for taps on pipe type components.
Examples of pipe type components are elbows, tees, reducers, and so forth. The value represents a percentage of the main pipeline size. The minimum value is 1 and the maximum is 99 (%).
- **0** - Use the default for tapped branch scaling at 65% of main pipeline size.
- **Value** - Specify a number that represents an alternative tapped branch scaling factor. For example, type **80** to increase scaling, **45** to decrease scaling.

Defines
OS 120 Pos 4,5

**TapBranchSuppression**
Tapped branch connections can sometimes be difficult to draw clearly on an isometric, particularly where a number of fittings are in close proximity. ISOGEN suppresses the drawing of tapped branches for particular components. This allows the alternative of using a detailed sketch to show branch connections instead.
Where tapped branches have been suppressed, part numbers and weld numbers can still be output on the isometric.
The suppressed components are defined by either by component type SKEY--such as VALVEVB**--or component type as follows:
- **ALL** - Suppress the output of all tapped branches.
- **PIPE** - Suppress the output of all tapped branches on pipe.
- **FITTING** - Suppress the output of all tapped branches on fittings.
- **FLANGE** - Suppress the output of all tapped branches on flanges.
- **VALVE** - Suppress the output of all tapped branches on valves.
- **INSTRUMENT** - Suppress the output of all tapped branches on instruments.
- **MISC-ITEM** - Suppress the output of all tapped branches on misc. components.
Double-clicking this property opens the **TapBranchSuppression** dialog box, into which you can type the component types you want to suppress.

**TeeCrossNS**
Controls the nominal size (N.S.) output at set-on type tees and crosses.
Appendix: Isometric Drawing Options

- **Combined** - Display nominal size output at set-on tees and crosses as combined.

- **Separate** - Display nominal size output at set-on tees and crosses separately.

**TextFont**
Specifies a font number corresponding to a font entry in the .fif file.

**Defines**
OS 4 Pos 7, 8, and 9

**TextSize**
Specifies the size of the text characters on the drawing. The default setting is **Medium (2.5 mm)**.

- **Small (2.1 mm)** - Output small characters, 2.1mm high.
- **Medium (2.5 mm)** - Output medium-sized characters, 2.4mm high.
- **Large (2.8 mm)** - Output large-sized characters, 2.8mm high.
- **XLarge (3.5 mm)** - Output extra large characters, 3.5mm high.
- **XXLarge (4.2 mm)** - Output extra large characters, 4.2mm high.
- **XXXLarge (4.9 mm)** - Output extra large characters, 4.9mm high.
- **Or User** - Output characters with a height defined by **UserTextSize**.

**NOTE** Title block text, which is always output using large characters (2.8mm) and material list text, which is controlled by properties of the material list object, are not affected by this setting.
Appendix: Isometric Drawing Options

Defines
OS 4 Pos 1

TextWeight
Specifies the thickness of the text. Specify a value between 1 and 9. Used only for MicroStation.

Defines
OS 4 Pos 5

TextWidth
Specifies the character width if you are using a fixed-width font. Type a value in range 10-99 in 1/10 millimetres.

Defines
OS 4 Pos 3,4

TracingStyle
Specifies where heat tracing is shown on the isometric drawing.

- **Alongside Pipe** - Use the default to plot chain dotted tracing lines alongside the pipe only, with a gap of 1 mm.
- **None** - Suppress tracing indication.
- **Alongside Pipe and Components** - Plot chain dotted tracing lines alongside pipe and all components, both with a 1 mm gap.

Defines
OS 62

UserTextSize
Specifies a user-defined size. Type the required value in 1/10 millimetres (in range 10-99).

**NOTE** Use this option only if TextSize is set to User.

Defines
OS 4 Pos 1,2

See Also

*Appendix: Isometric Drawing Options* (on page 415)
Layers (Drawing)

Sets the default color for the layer.

The Layers (Drawing) also folder contains a collection of options that are used to list the layers of the isometric drawing and the content for each layer. With the isometric drawing open in SmartSketch Drawing Editor, you can click Tools > Display Manager to see a list of the layers for the isometric drawing. For more information, see Layers Collection (Drawing Layers) (on page 515).

DefaultColour

Identifies an integer value that corresponds to a colour as defined in an output drawing system, such as MicroStation or AutoCAD. This colour is the default colour for all layers, if a colour is not set explicitly.

Defines

ISOGEN attribute

Count

Displays the number of layers defined in the current style and stored in the Drawing.Layers.Layers collection.

See Also

Appendix: Isometric Drawing Options (on page 415)

Layers Collection (Drawing Layers)

Lists the layers of the isometric drawing and the content for each layer. With the isometric drawing open in the SmartSketch Drawing Editor, you can click Tools > Display Manager to see a list of the layers for the isometric drawing.

NOTE The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

LayerColour

Specifies the optional colour integer number to override the default colour.

LayerNumber

Specifies the integer number that corresponds to the layer used in the Drawing.Definitions object.

Name

Specifies the name for the layer with this LayerNumber.

See Also

Appendix: Isometric Drawing Options (on page 415)
Dynamic Fonts (Drawing)

The Dynamic Fonts (Drawing) folder contains a collection of options called Dynamic Fonts, which is used to store the parameters of the user-defined fonts that are available for output on the isometric drawing. For more information, see Dynamic Fonts Collection (Drawing Dynamic Fonts) (on page 516).

Count
Displays the number of dynamic fonts defined in the current style and stored in the Dynamic Fonts collection.

Dynamic Fonts Collection (Drawing Dynamic Fonts)
Controls the output of user-defined dynamic fonts on the isometric drawing.

NOTE The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

FontNumber
Specifies the ISOGEN font number. The value you type must be 3 digits and cannot exist in the ISOGEN font information file (Fontstd.fif). The first 300 numbers are reserved exclusively for use in the .fif file. As such, the value you type must be 301 or higher.

FontName
Specifies the name of the user-specified font. The TrueType font that you type must already be installed on the computer. Type the name of the font exactly as it appears in the C:\Windows\Fonts folder.

NOTE To view a list of installed fonts, click Start > Control Panel > Fonts.

FontCorrectionFactor
Specifies the factor by which the width of characters are adjusted so that the font neither falls short of nor overlaps the boxes/gaps that are provided for the text on the drawing. The default setting is 1. Typically, this value is adjusted up or down by 1 or 2 after viewing the isometric drawing output.

FontStyleName
Specifies the AutoCAD text style name.

FontMicrostationNumber
Specifies the MicroStation-specific index number of the required font. This option is required only if you want to view the correct font on the screen.

FontMultibyteWidth
Specifies the factor by which the width of all multibyte characters are adjusted so that the font neither falls short of nor overlaps the boxes/gaps that are provided for the text on the drawing. The default setting is 2. Typically, this value is adjusted up or down by 1 or 2 after viewing the isometric drawing output.
End Connections (Drawing)

The **End Connections (Drawing)** folder contains a collection called End Connections, which is used to store the definitions of end connection identifiers. For more information, see *End Connections Collection (Drawing End Connections)* (on page 517).

**Count**

Displays the number of end connections defined in the current style and stored in the End Connections collection.

**End Connections Collection (Drawing End Connections)**

Stores the definitions of the end connection identifiers.

**NOTE** The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

**SKEY**

Identifies the end connection that is being defined. You can specify any of the following:

- **SW** - Socket Weld
- **SC** - Screwed
- **CP** - Compression
- **FL** - Flanged
- **PL** - Plain End
- **BW** - Butt Weld
- **CL** - Clamped
- **GL** - Glued
- **FA** - Flared
- **PF** - Push Fit

**Group**

Controls which group of end connections are assigned identifiers on the isometric drawing.

- **Individual** - Assign end connection identifiers to each individual occurrence of the specified end connection.
- **Assembly** - Assign end connection identifiers to assemblies.
- **Weld** - Assign end connection identifiers to welds.

**GroupFab**

Controls which group of Fabrication category end connections are assigned identifiers on the isometric drawing.
Appendix: Isometric Drawing Options

- **Individual** - Assign end connection identifiers to each individual Fabrication occurrence of the specified end connection.
- **Assembly** - Assign identifiers to Fabrication assemblies.
- **Weld** - Assign identifiers to Fabrication welds.

**GroupErec**
Controls which group of Erection category end connections are assigned identifiers on the isometric drawing.

- **Individual** - Assign end connection identifiers to each individual Erection occurrence of the specified end connection.
- **Assembly** - Assign identifiers to Erection assemblies.
- **Weld** - Assign identifiers to Erection welds.

**GroupOffsh**
Controls which group of Offshore category end connections are assigned identifiers on the isometric drawing.

- **Individual** - Assign end connection identifiers to each individual Offshore occurrence of the specified end connection.
- **Assembly** - Assign identifiers to Offshore assemblies.
- **Weld** - Assign identifiers to Offshore welds.

**Format**
Controls the format of end connection identifiers that are output on the isometric drawing.

- **Numeric** - Assign numeric values to end connection identifiers.
- **Alphabetic** - Assign alphabetic characters to end connection identifiers.

**NOTE** This option is only relevant if **Group** is set to **Individual**.

**Prefix**
Controls the prefix used when outputting end connection identifiers on the isometric drawing.

**PrefixFab**
Controls the prefix used when outputting Fabrication end connection identifiers output on the isometric drawing.

**PrefixErec**
Controls the prefix used when outputting Erection category end connection identifiers output on the isometric drawing.
Prefix Offsh
Controls the prefix used when outputting Offshore end connection identifiers output on the isometric drawing.

Origin
Controls the origin of sequencing of end connection identifiers.

- **Pipeline** - Sequence end connection identifiers on a per pipeline basis. This is the default setting.
- **Drawing** - Sequence end connection identifiers on a per drawing basis.

**NOTE** This option is only relevant if **Group** is set to **Individual**.

Accumulation
Controls how end connection identifiers are sequenced.

- **Combined** - Sequence end connection identifiers as combined. This is the default setting.
- **Category** - Sequence end connection identifiers on a category basis.

**NOTE** This option is only relevant if **Group** is set to **Individual**.

Enclosure
Controls the type of enclosure that is used for end connection identifiers output on the isometric drawing.

- **Circle** - Display end connection identifiers inside a circular enclosure.
- **Circle Double** - Display end connection identifiers inside a circular-shaped enclosure inside another circle.
- **Diamond Double** - Display end connection identifiers inside a diamond-shaped enclosure inside another diamond-shaped enclosure.
- **Diamond Ended** - Display end connection identifiers inside a diamond-ended box enclosure.
- **Diamond Ended Double** - Display end connection identifiers inside a diamond-ended box enclosure inside another diamond-ended enclosure.
- **Ellipse** - Display end connection identifiers inside an elliptical-shaped enclosure.
- **Ellipse Double** - Display end connection identifiers inside an elliptical-shaped enclosure inside another ellipse.
- **Round Double** - Display end connection identifiers inside a round-ended box enclosure inside another round-ended enclosure.
- **Round Ended** - Display end connection identifiers inside a round-ended box enclosure.
- **Square Ended** - Display end connection identifiers inside a square-ended box enclosure.
- **Square Ended Double** - Display end connection identifiers inside a square-ended box enclosure inside another square-ended enclosure.
Appendix: Isometric Drawing Options

- **Suppressed** - Suppress the display of an enclosure.
- **Triangle** - Display end connection identifiers inside a triangular-shaped enclosure.
- **Triangle Double** - Display end connection identifiers inside a triangular-shaped enclosure inside another triangle.
- **Unboxed** - Display end connection identifiers as unboxed.

**EnclFab**

Controls the type of enclosure that is used for Fabrication end connection identifiers output on the isometric drawing.

- **Circle** - Display end connection identifiers inside a circular enclosure.
- **Circle Double** - Display end connection identifiers inside a circular-shaped enclosure inside another circle.
- **Diamond Double** - Display end connection identifiers inside a diamond-shaped enclosure inside another diamond-shaped enclosure.
- **Diamond Ended** - Display end connection identifiers inside a diamond-ended box enclosure.
- **Diamond Ended Double** - Display end connection identifiers inside a diamond-ended box enclosure inside another diamond-ended enclosure.
- **Ellipse** - Display end connection identifiers inside an elliptical-shaped enclosure.
- **Ellipse Double** - Display end connection identifiers inside an elliptical-shaped enclosure inside another ellipse.
- **Round Double** - Display end connection identifiers inside a round-ended box enclosure inside another round-ended enclosure.
- **Round Ended** - Display end connection identifiers inside a round-ended box enclosure.
- **Square Ended** - Display end connection identifiers inside a square-ended box enclosure.
- **Square Ended Double** - Display end connection identifiers inside a square-ended box enclosure inside another square-ended enclosure.
- **Suppressed** - Suppress the display of an enclosure.
- **Triangle** - Display end connection identifiers inside a triangular-shaped enclosure.
- **Triangle Double** - Display end connection identifiers inside a triangular-shaped enclosure inside another triangle.
- **Unboxed** - Display Fabrication end connection identifiers as unboxed.

**EnclErec**

Controls the type of enclosure that is used for Erection end connection identifiers output on the isometric drawing.

- **Circle** - Display end connection identifiers inside a circular enclosure.
- **Circle Double** - Display end connection identifiers inside a circular-shaped enclosure inside another circle.
- **Diamond Double** - Display end connection identifiers inside a diamond-shaped enclosure inside another diamond-shaped enclosure.
### Appendix: Isometric Drawing Options

- **Diamond Ended** - Display end connection identifiers inside a diamond-ended box enclosure.
- **Diamond Ended Double** - Display end connection identifiers inside a diamond-ended box enclosure inside another diamond-ended enclosure.
- **Ellipse** - Display end connection identifiers inside an elliptical-shaped enclosure.
- **Ellipse Double** - Display end connection identifiers inside an elliptical-shaped enclosure inside another ellipse.
- **Round Double** - Display end connection identifiers inside a round-ended box enclosure inside another round-ended enclosure.
- **Round Ended** - Display end connection identifiers inside a round-ended box enclosure.
- **Square Ended** - Display end connection identifiers inside a square-ended box enclosure.
- **Square Ended Double** - Display end connection identifiers inside a square-ended box enclosure inside another square-ended enclosure.
- **Suppressed** - Suppress the display of an enclosure.
- **Triangle** - Display end connection identifiers inside a triangular-shaped enclosure.
- **Triangle Double** - Display end connection identifiers inside a triangular-shaped enclosure inside another triangle.
- **Unboxed** - Display Erection end connection identifiers as unboxed.

#### EnclOffsh

Controls the type of enclosure that is used for Offshore end connection identifiers output on the isometric drawing.

- **Circle** - Display end connection identifiers inside a circular enclosure.
- **Circle Double** - Display end connection identifiers inside a circular-shaped enclosure inside another circle.
- **Diamond Double** - Display end connection identifiers inside a diamond-shaped enclosure inside another diamond-shaped enclosure.
- **Diamond Ended** - Display end connection identifiers inside a diamond-ended box enclosure.
- **Diamond Ended Double** - Display end connection identifiers inside a diamond-ended box enclosure inside another diamond-ended enclosure.
- **Ellipse** - Display end connection identifiers inside an elliptical-shaped enclosure.
- **Ellipse Double** - Display end connection identifiers inside an elliptical-shaped enclosure inside another ellipse.
- **Round Double** - Display end connection identifiers inside a round-ended box enclosure inside another round-ended enclosure.
- **Round Ended** - Display end connection identifiers inside a round-ended box enclosure.
- **Square Ended** - Display end connection identifiers inside a square-ended box enclosure.
- **Square Ended Double** - Display end connection identifiers inside a square-ended box enclosure inside another square-ended enclosure.
- **Suppressed** - Suppress the display of an enclosure.
Appendix: Isometric Drawing Options

- **Triangle** - Display end connection identifiers inside a triangular-shaped enclosure.
- **Triangle Double** - Display end connection identifiers inside a triangular-shaped enclosure inside another triangle.
- **Unboxed** - Display Offshore end connection identifiers as unboxed.

**Revisions (Drawing)**

Controls the output of revision changes on the isometric drawing. Revision output is triggered only when the component and pipeline revisions match. During isometric drawing generation, the software considers each component individually. When a revision match occurs, the component is highlighted on the isometric drawing. For information about using revision clouds on the isometric drawing, see *Enable revision clouds* (on page 126).

**Colour**

Controls the colour of the revision box. The default setting is the colour associated with the *Layer* attribute.

**Value** - Type the index number that corresponds to the colour defined in the drawing system.

**Distance**

Controls the distance from the component centerline to the revision cloud. This value should not exceed the setting of a standard leg length.

**Value** - Type a value in 1/10th mms. The default setting is 50.

**Enabled**

Controls the output of the Revision block to the Data Definition file (DDF). When the component revision matches the pipeline revision, the revision output is triggered.

- **True** - Output the revision block to the DDF.
- **False** - Suppress output of the revision block to the DDF.

**EnclosureType**

Controls the output of the enclosure type that surrounds the revision block to the Data Definition file.
• **Polygon** - Highlight revised components with a polygon. This is the default setting.

• **Cloud** - Highlight revised components with a cloud.

**FillColour**

Controls the fill colour of the revision box when **EnclosureType** is set to **Polygon**. The default setting is the colour associated with the **Layer** attribute.

**Value** - Type the index number that corresponds to the colour defined in the drawing system. For example, in AutoCAD 1 = Red and 2 = Yellow.

**Layer**

Controls on what layer the revision box is placed.

• **Value** - Type the number that corresponds to the layer in the drawing system. The default setting is 0.

**MaxCloudArc**

Defines the maximum pitch of the cloud enclosure. This option is required only when you set **EnclosureType** to **Cloud**.

**Value** - Type a value in 10th mms. The default setting is 60.
Appendix: Isometric Drawing Options

MinCloudArc
Defines the minimum pitch of the cloud enclosure. This option is required only when you set EnclosureType to Cloud.
Value - Type a value in 10th mms. The default setting is 20.

Welds (Drawing)
Sets options for the display of welds on the isometric drawing.

The Welds (Drawing) folder also contains a collection called Weld Enclosures, which is used to store the definitions of special enclosures. There are several different formats for the enclosure, which are controlled by the settings of the EnclosureType property. For more information, see Welds Enclosures (Drawing Welds) (on page 540).

ErectPrefix
Sets the prefix used for erection type welds.
In the following illustration, the prefix is set to E.

ErectSupportPrefix
Sets the prefix used for erection support welds.
In the following illustration, the prefix is set to ES.

ErectSupportWeldEnclosure
Specifies the style of the weld number enclosure for this weld type.

- Default Circle - Display a fixed-sized circle enclosure.
Appendix: Isometric Drawing Options

- **Diamond End** - Display a diamond-ended box enclosure.
  
  ![Diamond End](image)

- **Round End** - Display a round-ended box enclosure.
  
  ![Round End](image)

- **Small Triangle** - Display a small, triangular-shaped enclosure.
  
  ![Small Triangle](image)

- **Small Diamond** - Display a small, diamond-shaped enclosure.
  
  ![Small Diamond](image)

- **Square** - Display a square-ended box enclosure.
  
  ![Square](image)

- **Dynamic Circle** - Display a dynamically-sized circle enclosure.
  
  ![Dynamic Circle](image)

- **Double Circle** - Display a dynamically-sized double circle enclosure.
- **Ellipse** - Displays an elliptical enclosure.
  
  ![Ellipse](image)

- **None** - Suppress the display of a weld number enclosure.
  
  ![None](image)

**NOTES**

- All the previous illustrations use weld prefixes except for **Default Circle**, where weld prefixes cannot be used, as this is limited to numeric values (3 characters maximum).
- The size at which the circle, double circle and ellipse are drawn is controlled by **ErectSuppWeldEnclSize** (default 2 characters), which defines the minimum size for the
enclosure. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit.

- When the weld number enclosure style is not the original circular type, then the weld number character size is controlled by `Drawing.Format.TextSize` and not `WeldNumberSize`.

**Defines**

OS 78 Pos 3

---

**ErectSupportWeldStartNo**

Sets a start weld number for erection support welds in the weld definition file (WDF).

**ErectSuppWeldEnclSize**

Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default setting is 2, and the valid entries are from 1 to 8 characters and **Variable size**, which dynamically sizes the enclosure.

**NOTE** The number of characters defines the minimum size that the circle, double circle, and ellipse are drawn at. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit. Setting `ErectSupportWeldEnclSize` to **Variable size** allows the circle, double circle and ellipse to be smaller than the default 2 characters, while also allowing the enclosure to dynamically adjust to suit the number of characters.

**Defines**

OS 54 Pos 6

**ErectWeldEnclosure**

Sets the style of enclosure for erection welds.

- **Default Circle** - Display a fixed-sized circle enclosure.
- **Diamond End** - Display a diamond-ended enclosure.
- **Round End** - Display a round-ended enclosure.
- **Small Triangle** - Display a small triangular-shaped enclosure.
- **Small Diamond** - Display a small diamond-shaped enclosure.
- **Square** - Display a square-ended box.
- **Dynamic Circle** - Displays a dynamically-sized circle.
- **Double Circle** - Display a dynamically-sized double circle enclosure.
- **Ellipse** - Display an elliptical enclosure.
None - Suppress the display of a weld number enclosure.

NOTES

- The size at which the Circle, Double Circle and Ellipse are drawn is controlled by ErectWeldEnclSize (default 2 characters), which defines the minimum size for the enclosure. If there are more characters than the value set, the enclosure dynamically adjusts to suit.

- When the weld number enclosure style is not the original circular type, then the weld number character size is controlled by Drawing.Format.TextSize and not by WeldNumberSize.

Defines

OS 75 Pos 3, 8

ErectWeldEnclSize

Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default setting is 2, and the valid entries are from 1 to 8 characters and Variable size, which dynamically sizes the enclosure.

NOTE: The number of characters defines the minimum size at which the circle, double, circle, and ellipse are drawn. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit. Setting ErectWeldEnclSize to Variable size allows the circle, double circle and ellipse to be smaller than the default 2 characters, while also allowing the enclosure to dynamically adjust to suit the number of characters.

Defines

OS 54 Pos 3

ErectWeldStartNo

FabPrefix

Sets the prefix used for fabrication type welds. In the following illustration, the prefix is set to F.

FabSupportPrefix

Sets the prefix used for fabrication support welds.
In the following illustration, the prefix is set to **FS**.

![Image](https://example.com/image.png)

**FabSupportWeldEnclosure**

Sets the style of enclosure for fabrication welds.

- **Default Circle** - Display a fixed-sized circle enclosure.
- **Diamond End** - Display a diamond-ended enclosure.
- **Round End** - Display a round-ended enclosure.
- **Small Triangle** - Display a small, triangular-shaped enclosure.
- **Small Diamond** - Display a small, diamond-shaped enclosure.
- **Square** - Display a square-ended enclosure.
- **Dynamic Circle** - Display a dynamically-sized circle enclosure.
- **Double Circle** - Display a dynamically-size double circle enclosure.
- **Ellipse** - Display an elliptical enclosure.
- **None** - Suppress the display of a weld number enclosure.

**NOTES**

- The size at which the circle, double circle and ellipse are drawn is controlled by **FabSuppWeldEnclSize** (default 2 characters), which defines the minimum size for the enclosure. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit.
- When the weld number enclosure style is not the original circular type, then the weld number character size is controlled by **Drawing.Format.TextSize** and **not** **WeldNumberSize**.

**Defines**

OS 78 Pos 1, 7

**FabSupportWeldStartNo**

Sets a start weld number for fabrication support welds in the weld definition file (WDF).
Appendix: Isometric Drawing Options

**FabSuppWeldEncSize**
Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default setting is 2, and the valid entries are from 1 to 8 characters or **Variable size**, which dynamically sizes the enclosure.

**NOTE** The number of characters defines the minimum size that at which the circle, double, circle, and ellipse are drawn. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit. Setting **FabSuppWeldEncSize** to **Variable size** allows the circle, double circle and ellipse to be smaller than the default 2 characters, while also allowing the enclosure to dynamically adjust to suit the number of characters.

**Defines**
OS 54 Pos 5

**FabWeldEnclosure**
Sets the style of enclosure for fabrication welds.
- **Default Circle** - Display a fixed-sized circle enclosure.
- **Diamond End** - Display diamond-ended box enclosure.
- **Round End** - Display a round-ended box enclosure.
- **Small Triangle** - Display a small, triangular-shaped enclosure.
- **Small Diamond** - Display a small, diamond-shaped enclosure.
- **Square** - Display a square-ended box enclosure.
- **Dynamic Circle** - Display a dynamically-sized circle enclosure.
- **Double Circle** - Display a dynamically-sized double circle enclosure.
- **Ellipse** - Displays an elliptical enclosure.
- **None** - Suppress the display of a weld number enclosure.

**NOTES**
- The size at which the circle, double circle and ellipse are drawn is controlled by **FabWeldEncSize** (default 2 characters), which defines the minimum size for the enclosure. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit.
- When the weld number enclosure style is not the original circular type, then the weld number character size is controlled by **Drawing.Format.TextSize** and not **WeldNumberSize**.

**Defines**
OS 75 Pos 1, 7
Appendix: Isometric Drawing Options

**FabWeldEnclSize**

Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default setting is 2, and the valid entries are from 1 to 8 characters or **Variable size**, which dynamically sizes the enclosure.

![F3](image)

**NOTE** The number of characters defines the minimum size at which the circle, double circle and ellipse enclosures are drawn. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit. Setting **FabWeldEnclSize** to **Variable size** allows the circle, double circle and ellipse to be smaller than the default of 2 characters, but again all will dynamically adjust to suit the number of characters.

**Defines**

OS 54 Pos 2

**FabWeldStartNo**

Sets a start weld number for fabrication welds in the weld definition file (WDF).

**GeneralPrefix**

General weld prefix used when none of the separate weld prefixes are set.

**GeneralWeldStartNo**

Sets a general start weld number in the WDF.

**MessageArrowheads**

Controls whether messages to welds (including weld numbers and attributes) have arrowheads attached to message leader lines.
Appendix: Isometric Drawing Options

- **On** - Show arrowheads on message leader lines.

- **Off** - Suppress arrowheads on message leader lines.

**Defines**
OS 54 Pos 9

**OffshorePrefix**
Sets the prefix used for offshore type welds.
In the following illustration, the prefix is set to **O**.

**OffshoreSupportPrefix**
Sets the prefix used for offshore support welds.
In the following illustration, the prefix is set to **OS**.

**OffshoreSupportWeldEnclosure**
Specifies the style of the weld number enclosure for this weld type.
- **Default Circle** - Displays a fixed-sized circle enclosure.
- **Diamond End** - Display a diamond-ended box enclosure.
- **Round End** - Display a round-ended box enclosure.
Appendix: Isometric Drawing Options

- **Small Triangle** - Display a small, triangular-shaped enclosure.
- **Small Diamond** - Display a small, diamond-shaped enclosure.
- **Square** - Display a square-ended box enclosure.
- **Dynamic Circle** - Display a dynamically-sized circle enclosure.
- **Double Circle** - Display a dynamically-sized double circle enclosure.
- **Ellipse** - Display an elliptical enclosure.
- **None** - Suppress the display of a weld number enclosure.

**Defines**

OS 78 Pos 5

**OffshoreSupportWeldStartNo**

Sets a start weld number for offshore support welds in the weld definition file (WDF).

**OffshoreSuppWeldEnclSize**

Controls the number of characters used for the size of circle, double circle, and ellipse enclosure style. The default setting is 2, and the valid entries are from 1 to 8 characters or **Variable size**, which dynamically sizes the enclosure.

![OS1 Diagram](image)

**NOTE** The number of characters defines the minimum size at which the circle, double circle, and ellipse are drawn. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit. Setting **OffshoreSuppWeldEnclSize** to **Variable size** allows the circle, double circle, and ellipse to be smaller than the default 2 characters, while also allowing the enclosure to dynamically adjust to suit the number of characters.

**Defines**

OS 54 Pos 7

**OffshoreWeldEnclosure**

Sets the style of enclosure for offshore welds.

- **Default Circle** - Display a fixed-sized circle enclosure.
- **Diamond End** - Display a diamond-ended box enclosure.
- **Round End** - Display a round-ended box enclosure.
- **Small Triangle** - Display a small, triangular-shaped enclosure.
- **Small Diamond** - Display a small, diamond-shaped enclosure.
- **Square** - Display a square-ended box enclosure.
Appendix: Isometric Drawing Options

- **Dynamic Circle** - Display a dynamically-sized circle enclosure.
- **Double Circle** - Display a dynamically-sized double circle enclosure.
- **Ellipse** - Display an elliptical enclosure.
- **None** - Suppress the display of a weld number enclosure.

Defines
OS 75 Pos 5

**OffshoreWeldEnclSize**
Controls the number of characters used for the size of circle, double circle and ellipse enclosure style. The default setting is 2, and the valid entries are from 1 to 8 characters or **Variable size**, which dynamically sizes the enclosure.

**NOTE** The number of characters defines the minimum size at which the circle, double circle, and ellipse are drawn. If there are more characters than the value that is set, the enclosure dynamically adjusts to suit. Setting *OffshoreWeldEnclSize* to **Variable size** allows the circle, double circle and ellipse to be smaller than the default 2 characters, while also allowing the enclosure to dynamically adjust to suit the number of characters.

Defines
OS 54 Pos 4

**OffshoreWeldStartNo**
Sets a start weld number for offshore welds in the weld definition file (WDF).

**ShowErectSupportWeldNos**
Displays weld numbers for the specified weld type.

- **True** - Display erection support weld numbers on the plotted isometric.
- **False** - Suppress erection support weld numbers on the plotted isometric.

Defines
OS 78 Pos 3
Appendix: Isometric Drawing Options

ShowErectSupportWeldPrefix

- **True** - Show erection support weld prefixes on the plotted isometric.
- **False** - Suppress erection support weld prefixes on the plotted isometric.

Defines
OS 78 Pos 4

ShowErectWeldNos
Displays the erection weld numbers on the isometric drawing.

- **True** - Display erection weld numbers on the plotted isometric.
- **False** - Suppress erection weld numbers on the plotted isometric.

Defines
OS 75 Pos 3

ShowErectWeldPrefix

- **True** - Show erection weld prefixes on the plotted isometric.
- **False** - Suppress erection weld prefixes on the plotted isometric.

Defines
OS 75 Pos 4

ShowFabSupportWeldNos
Displays weld numbers for the specified weld type.

- **True** - Display fabrication support weld numbers on the plotted isometric.
- **False** - Suppress fabrication support weld numbers on the plotted isometric.

Defines
OS 78 Pos 1

ShowFabSupportWeldPrefix

- **True** - Show fabrication support weld prefixes on the plotted isometric.

- **False** - Suppress fabrication support weld prefixes on the plotted isometric.

Defines

OS 78 Pos 2

ShowFabWeldNos

Displays the fabrication weld numbers on the isometric drawing.

- **True** - Display fabrication weld numbers on the plotted isometric.
- **False** - Suppress fabrication weld numbers on the plotted isometric.

Defines

OS 75 Pos 1

ShowFabWeldPrefix

- **True** - Show fabrication weld prefixes on the plotted isometric.

- **False** - Suppress fabrication weld prefixes on the plotted isometric.

Defines

OS 75 Pos 2

ShowOffshoreSupportWeldNos

Displays weld numbers for the specified weld type.

- **True** - Display offshore support weld numbers on the plotted isometric.
Appendix: Isometric Drawing Options

- **False** - Suppress offshore support weld numbers on the plotted isometric.

**Defines**
OS 78 Pos 5

**ShowOffshoreSupportWeldPrefix**
- **True** - Show offshore support weld prefixes on the plotted isometric.
- **False** - Suppress offshore support weld prefixes on the plotted isometric.

**Defines**
OS 78 Pos 6

**ShowOffshoreWeldNos**
Displays the offshore weld numbers on the isometric drawing.
- **True** - Display offshore weld numbers on the plotted isometric.
- **False** - Suppress offshore weld numbers on the plotted isometric.

**Defines**
OS 75 Pos 5

**ShowOffshoreWeldPrefix**
- **True** - Shows offshore weld prefixes on the plotted isometric.
- **False** - Suppresses offshore support weld prefixes on the plotted isometric.

**ShowWeldNumbers**
Turns on and off the display of weld numbers on the isometric drawing.
- **True** - Turn on the display of weld numbers on the plotted isometric.
- **False** - Turn off the display of weld numbers on the plotted isometric.
Appendix: Isometric Drawing Options

**NOTE** You can set this option to True and use the **Drawing.Welds.WeldNumberLabel** to specify a label to use with the weld number.

**Defines**
OS 53 Pos 1

**ShowWelds**
Turns on and off the display of welds and weld numbers on the isometric drawing.
- **True** - Display welds and weld numbers on the isometric drawing.
- **False** - Suppress the display of welds and weld numbers on the isometric drawing.

**Defines**
OS 53 Pos 1
OS 54 Pos 1

**SpecialSiteWeldCategory**
Assigns special site welds to a specific category. You can select **Erection Type** or **Fabrication Type**.

**Defines**
OS 83 Pos 3

**SpecialStatusWeldIdentifiers**
Controls the generation of weld numbers on special status welds.
- **True** - Generate weld numbers on special status welds.
- **False** - Suppress generation of weld numbers on special status welds.

**Defines**
OS 83 Pos 2

**SupportWeldNumbers**
Numbers support welds separately. The default is **False**.
- **True** - Number support welds separately.
- **False** - Number support welds using the same sequence as standard welds.

**NOTE** If set to **True**, then **SupportWeldTypeNos** is used to determine whether each category of weld has its own sequence or not.

**Defines**
OS 53 Pos 6

**SupportWeldSeq**
Controls whether the support weld numbers continue across drawings, or start again on each new drawing.
Appendix: Isometric Drawing Options

- **Per Drawing** - Re-start support weld numbering sequence on each drawing.
- **Continuous** - Continue support weld numbering sequence across drawings.

**NOTES**
- The numbers used depend on the settings defined by **SupportWeldTypeNos**.
- If you set **SupportWeldNumbers** to **True**, **SupportWeldSeq** controls weld numbering, similar to **WeldNumberSequence**.

**Defines**
OS 53 Pos 7

**SupportWeldTypeNos**
Controls the numbering of support welds. The default is **False**.
- **True** - The software numbers each type of support weld in a different sequence.
- **False** - The software numbers each type of support weld using the same sequence for numbers.

**Defines**
OS 53 Pos 6

**WeldNumberLength**
Controls the number of characters output for a weld number. For numeric weld numbers, leading zeros are output; for alphabetic weld numbers, spaces are output
- **Variable** - Output the weld number without leading zeros or spaces.
- **1 to 9** - Set the number of characters to be output. For example, 3 outputs 001 through to 999 for numeric weld numbers.

**Defines**
OS 53 Pos 9

**WeldNumbers**
Controls the generation of weld numbers for any welds that do not have weld numbers defined in the Piping Component File (PCF) or Intermediate Data File (IDF).
- **True** - Generate weld numbers.
- **False** - Suppress weld numbers.

**Defines**
OS 53 Pos 8

**WeldNumberSize**
Controls the size of plotted weld numbers, if welds appear.
- **Small** - Plot small weld numbers (1.5 mm).
- **Medium** - Plot medium-sized weld numbers (1.8 mm).
- **Large** - Plot large weld numbers (2.1 mm).
These size values are only valid for the original circular style enclosure. If one of the alternative enclosure styles is being used, then TextSize is used.

**Defines**

OS 53 Pos 1

**WeldNumberType**

Controls whether weld numbers are numeric or alphabetic.

- **Numeric** - Numeric weld identifiers.
- **Alphabetic** - Alphabetic weld identifiers. Generates A to Z, and then starts AA, AB, AC, and so on.

**Defines**

OS 53 Pos 8

**WeldTypeIdentifiers**

Defines the text to be output to the weld definition file (WDF) for weld type identifiers. Click the button in the WeldTypeIdentifiers field. The software opens the WeldTypeIdentifiers text editor, in which you can input the required data as follows:

1. Piping Specification
2. Minimum Nominal size
3. Maximum Nominal size
4. Weld Type (replacement for BW welds)
5. Wall Thickness / Schedule (optional)

**WeldTypes**

Controls whether all welds are numbered/plotted or allows single weld category (Fabrication, Erection or Offshore) to be numbered/plotted.

- **All** - Number/plot all welds.
- **Fabrication Only** - Number/plot only fabrication welds.
- **Erection Only** - Number/plot only erection welds.
- **Offshore Only** - Number/plot only offshore welds.

**NOTE** If Offshore Only is set, then erection welds are plotted but not numbered. This is a general control, but there is also a separate control for all six weld types. If the separate weld types are set not to be plotted, then this control still causes a weld number to be generated for those welds so that they can be used on weld reports.

**Defines**

OS 53 Pos 1, 4
See Also
Appendix: Isometric Drawing Options (on page 415)

Welds Enclosures (Drawing Welds)
Defines special types of enclosure used for welds in order to display attributes set on the weld in the PCF/IDF.

**NOTE**  The special weld enclosure supersedes weld enclosure styles set as a property of the Drawing.Welds object for each category of weld or all welds, depending on the Category setting on the WeldEnclosure collection.

**AttributeName**
Specifies the name of the attribute being defined. Use the AttributeName list to select the required attribute.

**Category**
Specifies the category. Use the Category list to select the appropriate one: Fabrication, Erection, Offshore or All.

**EnclosureType**
Controls the type of enclosure to be used.

- **Pointed**
  ![Pointed Enclosure](image)

- **Round**
  ![Round Enclosure](image)

- **Triangle**
  ![Triangle Enclosure](image)

- **Diamond**
  ![Diamond Enclosure](image)

- **Square**
  ![Square Enclosure](image)
Appendix: Isometric Drawing Options

- **Circle**
  ![Circle](image)

- **Unboxed**
  ![Unboxed](image)

- **SpecialPointed**
  ![SpecialPointed](image)

- **SpecialRound**
  ![SpecialRound](image)

- **SpecialSquare**
  ![SpecialSquare](image)

**ForceAllWeldAsSpecial**

Only applies to objects with **EnclosureType** set to **SpecialPointed**, **SpecialRound**, or **SpecialSquare** and **AttributeName** mapped to **WELD-NO**.

- **True** - Force all welds to adopt the special layout for their enclosure.
  ![True](image)

- **False** - Allow the generation of an enclosure containing only the weld number, when the data for all the other fields in an enclosure are missing.
  ![False](image)
NonSpecialPosition

Defines the position for the specified weld attribute to be output along the horizontal display. Type the position number.

Applies only to the following enclosure types, all of which allow multiple attributes displayed horizontally:

- Pointed
- Round
- Square

SpecialPosition

Controls selection of the compartment or quadrant (position) for the weld number when weld attributes are to be output in a special enclosure. Select the position from the following list of choices: Top, TopLeft, TopRight, Bottom, BottomLeft, and BottomRight.

In the following example, the weld number is output TopRight, where 1 denotes the weld number and there are three weld attributes (T2, R2, and F8).

NOTES

- You can divide special enclosures into two compartments (top and bottom) or four compartments (quadrants).
- The maximum number of compartments is four.
- This attribute only applies to SpecialPointed, SpecialRound, or SpecialSquare enclosure types.
- The previous example is SpecialRound.

Width

Specifies the number of characters.
Appendix: Isometric Drawing Options

Drawing Frame Options

Sets options for the drawing frame on isometric drawings.

The **Drawing Frame** folder also contains the following groups of options:

- **Attributes** - Maps ISOGEN attributes to attributes in the software and specifies the X- and Y-coordinates of the attribute placement. For more information, see Attributes (Drawing Frame) (on page 545).

- **Table Attributes** - Stores the definitions of text used on the drawing frame. For more information, see Table Attributes (Drawing Frame) (on page 546).

- **Symbol Table** - Defines the properties for symbol shape frame positioning. For more information, see Symbol Table (Drawing Frame) (on page 548).

**BottomMargin**

Specifies the distance between the outer edge of the drawing sheet and the outer line of the drawing frame at the bottom of the drawing.

- **0** - Use the default for no reserved area.

**Value** - User-defined distance between the outer edge of the drawing sheet and the outer line of the drawing frame that is being used. Type a value in millimetres. **Defines**

OS 13

**CustomHeight**

Sets the height of a non-standard paper size. That is, sizes that do not conform to either the metric-based European A series or the imperial-based American ANSI sizes.

- **0** - Use a non-standard drawing height.

- **Value** - User-defined overall drawing height. Type a value in millimeters.

**IMPORTANT** You must use **CustomHeight** and **CustomWidth** together. Set both to suitable values or zero. For PostScript output, set the paper size using the **DrawingSize** option.

**Defines**

OS 15

**CustomWidth**

Sets the width of a non-standard paper size. That is, sizes that do not conform to either the metric-based European A series or the imperial-based American ANSI sizes.

- **0** - Use a non-standard drawing width.

- **Value** - User-defined overall drawing width. Type a value in mm.

**Defines**

OS 16
**LeftMargin**
Specifies the distance between the outer edge of the drawing sheet and the outer line of the drawing frame on the left side of the drawing.
- **0** - Use the default for no reserved area.
- **Value** - User-defined distance (in mm) between the outer edge of the drawing sheet and the outer line of the drawing frame that is being used.

**Defines**
OS 10

**ReservedAreaDrawing**
Provides the distance between the bottom of the drawing area and the outer line of the drawing frame.
- **0** - Use the default for no reserved area.

**Value** (real number) - User-defined value (in mm) equal to the depth of the required reserved area along the bottom of the isometric, measured from the outer line of the drawing frame. **Defines**
OS 35 Pos 1, 2, 3

**ReservedAreaDrawingTop**
Defines the reserved area along the top of the isometric.
- **0** - Use the default for no reserved area.

**Value** (real number) - User-defined value (in mm) equal to the depth of the required reserved area along the top of the isometric, measured from the outer line of the drawing frame. **Defines**
OS 35 Pos 7, 8 and 9

**ReservedAreaMatList**
Provides the distance between the bottom of the material list and the outer line of the drawing frame.
- **Blank** - Use the default for no reserved area.

**Value** (real number) - User-defined value (in mm) equal to the depth of the required reserved area along the bottom of the material list measured from the outer line of the drawing frame. **Defines**
OS 35 Pos 4, 5, 6

**RightMargin**
Specifies the distance between the outer edge of the drawing sheet and the outer line of the drawing frame on the right side of the drawing.
- **0** - Use the default for no reserved area.
- **Value** - User-defined distance (in mm) between the outer edge of the drawing sheet and the outer line of the drawing frame that is being used.

**Defines**
OS 11
Appendix: Isometric Drawing Options

TopMargin
Specifies the distance between the outer edge of the drawing sheet and the outer line of the drawing frame at the top of the drawing.

- **0** - Use the default for no reserved area.
- **Value** (real number) - User-defined distance (in mm) between the outer edge of the drawing sheet and the outer line of the drawing frame that is being used.

Defines
OS 12

See Also
Appendix: Isometric Drawing Options (on page 415)

Attributes (Drawing Frame)
Specifies attributes to plot in the drawing frame. You use these options with the Attribute Map and other Drawing Frame options.

Many of the attributes for the drawing frame originate from the pipe runs in the model. During an extraction, the software obtains the values for pipe run attributes from the run with the largest NPD.

For more information, see Set drawing frame options (on page 120).

AttributeName
Specifies an attribute you want to display in the drawing frame. This text can be any alphanumeric string. You map this string to an ISOGEN attribute in the AttributeMap option before the string will have meaning in the software. Unless an attribute has been mapped in the AttributeMap, the name used is the ISOGEN name.

**Note** When editing the Drawing Frame.Attributes, do not remove the Pipeline Reference from the AttributeName list.

CharHeight
Specifies the character height of the attribute text. This value is in millimeters.

XPos
Sets the X-coordinate location of the attribute text in the title block. This value is in millimeters.

YPos
Sets the Y-coordinate location of the attribute text in the title block. This value is in millimeters.

Font
Specifies the font to use for the attribute text. Select a font from the dropdown list.

Barcode
Several barcode standards exist worldwide to suit different industries, but the software has standardized on just three. Type 1, 2 or 3 for the appropriate barcode:
Appendix: Isometric Drawing Options

- 1 - Barcode 39
- 2 - Barcode 25
- 3 - Barcode 25 Interleaved

**CharWidth**
Specifies the character width of the attribute text. This value is in millimeters.

**Justification**
Sets the justification for the attribute text. Values are **Left** and **Right**.

**Layer**
Specifies the layer of the drawing on which you want to place the attribute text.

**Colour**
Type the integer number that represents the colour number as defined in the output drawing system (MicroStation or AutoCAD).

**RotationAngle**
Sets the rotation angle for the attribute text. Specify a value in degrees.

**TextWeight**
Sets the line weight for the font used in the attribute text. Specify a numeric line weight value.

**TruncationLength**
Sets the number of output characters. Specify a numeric value.

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Table Attributes (Drawing Frame)**
Stores the definitions of text used on the drawing frame.

**AttributeName**
Specifies the name of the attribute being defined. Use the **AttributeName** list to select the required attribute.

**CharHeight**
Sets the character height for the text. Type the required size in mm or Inches (as a real number).

**XPos2**
Defines the X position for the text in mm or inches (set as real number).
Appendix: Isometric Drawing Options

**YPos2**
Defines the Y position for the text in mm or inches (set as real number).

**Font**
Defines the font to be used. Use the Font list to select an appropriate font.

**BarCode**
Several barcode standards exist worldwide to suit different industries, but the software has standardized on just three. Type 1, 2 or 3 for the appropriate barcode:
- 1 - Barcode 39
- 2 - Barcode 25
- 3 - Barcode 25 Interleaved

**CharWidth**
Sets the character height for the text. Type the required size in mm or Inches (as a real number).

**Justification**
Sets the alignment of the text. Specify Left or Right.

**Layer**
Specify the integer number that identifies the required layer to which the definition is applied.

**Colour**
Type the integer number that represent the colour number as defined in the output drawing system (MicroStation or AutoCAD).

**RotationAngle**
Defines the angle of rotation in degrees clockwise.

**TextWeight**
Controls the character thickness. Type a value between 1 and 9. Used for MicroStation only

**TruncationLength**
Defines the number of output characters.

**ColumnsNumber**
Specifies the number of columns in the table.

**Direction**
Specifies the table direction.
Appendix: Isometric Drawing Options

**LineNumber**
Specifies the number of lines in the table.

**XSpacing**
Specifies the table offset dimension in X (horizontal) direction.
Type a value in mm or inches (set as a real number). For example, you can type 50mm or 2.0 inch.

*NOTE* The value can be a negative number.

**YSpacing**
Specifies the table offset dimension in Y (vertical) direction.
Type a value in mm or inches (set as a real number). For example, you can type 50mm or 2.0 inch.

*NOTE* The value can be a negative number.

**Symbol Table (Drawing Frame)**
Defines the properties for symbol shape frame positioning

**Drawing Layer**
Sets the drawing layer for symbol shape frame positioning. Type a value in the range of 1 to 50.

**Horizontal Spacing**
Sets the horizontal spacing required between each column of the symbol shape output when the table is horizontally formatted or two dimensional. Type a value in mm or inches (as a real number).

**Layout**
Controls whether the table is in horizontal, vertical, or multiple style.
- **SingleVertical** - Defines a single vertical table.
- **SingleHorizontal** - Defines a single horizontal table.
- **MultipleVertical** - Defines a multiple vertical table.
- **MultipleHorizontal** - Defines a multiple horizontal table.

**MaxColumns**
Defines the maximum number of columns before a new row is started when using multiple tables or the maximum number of entries for a single horizontal table.
MaxRows
Defines the maximum number of rows before a new column is started when using multiple tables or the maximum number of entries when the table is vertical.

PipeLength
Specifies a single value for the length of pipe (including symbols), with a maximum value of 15mm or 0.5 inches. A negative value (-1) suppresses the output of pipe.
Type a value (real number) in mm or inches.

StartX
Defines the bottom left-hand X position of the first symbol shape in mm, or inches (as a real number).

StartY
Defines the bottom left-hand Y position of the first symbol shape in mm, or inches (as a real number).

SymbolList
Specifies the symbols and associated text to be output. Each line must contain the symbol name and associated text separated by a space, as shown in the following examples:
- O1HG Pipe Support
- WS Site Weld
- WW Workshop Weld
- TRACING Tracing
- LAGGING Lagging

SymbolScale
Specifies a single value for the percentage symbol scale factor. Used to control the scaling of symbol shapes.

SymbolSelect
Controls whether to output all the symbols that are defined or only those that are used on the drawing.
- Fixed - All the symbols defined are output.
- Dynamic - Only those symbols which are used on the drawing are output.

TextFont
Defines the font to be used. Use the TextFont list to specify the font type.

TextHeight
Specifies the text height to be used. Type a value (real number) in mm or inches.
Appendix: Isometric Drawing Options

TextOffsetX
Specifies a single value for the horizontal movement from the symbol origin to the text origin. Type a value (real number) in mm or inches.

TextOffsetY
Specifies a single value for the vertical movement from the symbol origin to the text origin. Type a value (real number) in mm or inches.

TextWeight
Controls the character thickness. Specify a value between 1 and 9. Used only for MicroStation.

TextWidthFactor
Specifies the text width as a percentage of the text height to be used for output of the cut list.

VerticalSpacing
Sets the vertical spacing required between each row of the symbol shape output when the table is vertically formatted or two dimensional.
Type a value in mm or inches (as a real number).

Visible
Controls whether symbol shape frame positioning is used. If it is set to True, then the definitions in the Symbol table are written to the data definition (DDF) file, which switches on the facility.

Material List Options
Sets options for controlling position, format, and contents of the parts list.
The Material List folder contains the following groups of options:

- **Fixed Layout** - Defines the original ISOGEN material list options. ISOGEN plots the column headings. For more information, see Fixed Layout (Material List) (on page 561).

- **Variable Layout** - Defines the alternative variable layout material list. This style is a variation of the basic fixed layout type, with additional user options for header text. For more information, see Variable Layout (Material List) (on page 564).

- **User Defined** - Defines the user defined material list. The software prints this type of list into a drawing frame that contains a pre-existing table with header text. For more information, see User Defined (Material List) (on page 568). A user defined material list is allowed only with a backing sheet. That is, if an ISOGEN-generated drawing frame is in use, only the fixed layout and variable layout styles are available.

- **Summary File** - Controls the summary file for the material list. For more information, see Summary File (Material List) (on page 582).

- **Transfers** - Reassigns particular record types to a new sort group. For more information, see Transfers (Material List) (on page 586).
Appendix: Isometric Drawing Options

Fixed Layout produces a simple material list. Variable Layout and User Defined are fully user-definable: Variable Layout is based on columns and lines, and User Defined is based on X- and Y-coordinate positions.

**ActiveList**
Controls the format of the material list. You can specify **Fixed, Variable, or UserDefined**.

*NOTE* You can use only a **Fixed** material list with an ISOGEN drawing frame. If the **Visible** option under **DrawingFrame** is **False**, you must set **ActiveList** to **Fixed**.

**Defines**
OS 23 Pos 3

**BoltAccumulation**
Controls how bolt components are included on or excluded from the material list.

- **None** - Each occurrence of an item results in an individual entry on the material list
- **Normal** - Accumulate bolts normally.
- **Suppress** - Suppress all bolts.

*NOTE* This option does not apply to a User Defined material list, nor when the **MLType** option for the Fixed or Variable styles is set to **Special**.

**Defines**
OS 74 Pos 5

**BoltDiameterUnits**
Controls the units used for bolt diameters.

- **As Drawing** - Same as the **Drawing.Control.Units** option.
- **INCH** - For inch diameters.
- **MM** - For millimetres diameters.

**Defines**
OS 65 Pos 2

**BoltLengthUnits**
Controls the units used for bolt lengths.

- **As Drawing** - Same as the **Drawing.Control.Units** option.
- **INCH** - For inch diameters.
- **MM** - For millimetres diameters.

**Defines**
OS 65 Pos 1

**CentrelineLengths**
Controls how ISOGEN determines the length of bends and elbows.
Appendix: Isometric Drawing Options

- **Calculate the distance around curve of Bends/Elbows** - Calculate the centerline length using the distance around the radius.

- **Calculate the distance to intersection of Bends/Elbows** - Calculate the centerline length using the distance from the end point to the intersection point.

**Defines**

OS 24 Pos 4

**ComponentsWithNoItemCodesInPCF**

Controls IDFGEN's output of components present in the PCF that have no item code specified.

- **Default** - Set components with no item code to Not On Material List.

- **Generate Blank Item Code** - Assign a blank item code and description and output to the material list.

**Defines**

OS 74 Pos 8

**Drg1of1OnSingleIsos**

Allows a single drawing to be identified as Drg 1 of 1 on single-sheet isometric drawings.

- **True** - Write Drg 1 of 1 on isometrics consisting of one drawing.

- **False** - Drg 1 of 1 is not written on isometrics consisting of one drawing

**Defines**

OS 30

**ErectAccumulation**

Controls the accumulation of erection material. The default setting is **Normal**.

- **Normal** - Accumulate erection materials normally.

- **Pipe Only** - Accumulate only piping

- **Suppress** - Suppress display of erection items in the material list.

**NOTE** This option does not apply to a User Defined material list, nor when the **MLType** option for the Fixed or Variable styles is set to **Special**.

**Defines**

OS 74 Pos 2

**FabAccumulation**

Controls the accumulation of fabrication materials. The default is **Normal**.

- **None** - Suppress accumulation of fabrication items but list them separately in the material list.

- **Normal** - Accumulate fabrication materials normally.

- **Pipe Only** - Accumulate only pipe.
Appendix: Isometric Drawing Options

- **Suppress** - Suppress the display of fabrication items in the material list.

**NOTES**

- This option does not apply to a **UserDefined** material list, nor when the **MLType** option for the **Fixed** or **Variable Layout** styles is set to **Special**.
- The **FabAccumulation** option is not compatible with the **UserDefinedMaterialPartNumber** option, which overrides Isogen's accumulation of parts in the Material List. If Isogen accumulation options are enabled, Isogen will attempt to collect the components that do not have part numbers with those that have part numbers. For more information, see the **UserDefinedMaterialPartNumber** option description in this section.

**Defines**

OS 74 Pos 1

**FixedPipeAccumulation**

Controls the accumulation of fixed pipe materials.

ISOGEN considers fixed pipe as a component and accumulates materials by quantity. However, you can use **FixedPipeAccumulation** to specify that ISOGEN accumulate fixed pipe materials by length for output to Material List and Material Control files.

- **By Quantity** - Accumulate fixed pipe by quantity.
- **By Length** - Accumulate fixed pipe by length.

**Defines**

OS 74 Pos 7

**NOTE** ISOGEN identifies fixed pipes by the **PIPE-FIXED** keyword in the input piping component file (PCF). The software writes out **PIPE-FIXED** on the isometric drawing for any pipe that is flanged or that has mixed ends, such as bell and spigot ends.

**GasketAccumulation**

Controls the accumulation of gaskets.

- **Normal** - Accumulate gaskets normally.
- **None** - Non-accumulation of gaskets.
- **Suppress** - Suppresses all gaskets.

**NOTE** This option does not apply to a **UserDefined** material list, nor when the **MLType** option for the **Fixed** or **Variable Layout** styles is set to **Special**.

**Defines**

OS 74 Pos 4

**ItemCodeLength**

Sets the number of characters in the material list item code.

- **0** - Use the default for 8 characters in the item code.
- **Value** - Use an alternative number of characters, such as 12. Acceptable values are in the range 6-29.

**NOTES**
- The maximum number of item code characters is 29.
- Changes in this property cause the material list to be correspondingly wider or narrower.

**Defines**
OS 28

**LinearQuantityStyle**
Specifies the style for linear quantities in the material list
- **n. n M n. n ft** - Output pipe length in the form Metres (M) or Feet: 1 decimal place, as in 10.4 M or 10.4'.
- **n MM n ft n in** - Output pipe length in the form Millimetres (MM) or Feet and Inches, as in 1040 MM or 10'5".
- **n. nnn M n. nnn ft** - Output pipe length in the form Metres or Feet: 3 decimal places, as in 1.045 M or 10.375'.

**Defines**
OS 24 Pos 2

**MaterialListOverflow**
Controls the overflow of the material list to subsequent drawings.
- **Same Sheet** - Give automatic overflow onto secondary material list plotted alongside the first. This creates a wider non-standard drawing size.
- **Continuation Sheet** - Give a second "dummy" isometric containing the overflow material list but no pipeline graphics. This isometric is allocated the next drawing (sheet) identifier in the sequence.

**NOTE** If you set `Drawing.Content.ChangeManagementEnabled` to True, we recommend you set this option to Continuation Sheet

**Defines**
OS 30

**MaterialListSplitting**
Controls the plotting of the material list when a pipeline splits onto two or more drawings
- **Per Drawing** - Plot the material list per isometric drawing.
- **Per Pipeline** - Plot the material list per pipeline.

**Defines**
OS 24 Pos 1

**MaterialsBySpool**
Controls the splitting of fabrication materials by spool on the material list.
False - List Fabrication materials as normal under the Fabrication section of material list.
True - Group spool materials separately, with part numbering on a per spool basis.

Defines
OS 24 Pos 3

Offshore Accumulation
Controls the accumulation of offshore materials. The default setting is Normal.
- Normal - Accumulate offshore materials normally.
- Pipe Only - Accumulate only piping.
- Suppress - Suppress display of offshore items in the material list at all.

NOTE This option does not apply to a UserDefined material list, nor when the MLType option for the Fixed or Variable Layout styles is set to Special.

Defines
OS 74 Pos 3

Overflow Drawing ID
Controls the numbering of overflow drawing sheets.
- Next ID - The second isometric drawing has the next sheet number in the sequence.
- Alpha suffix - The second isometric drawing has the same sheet number as the first one, with a character suffix, for example, A, B, and so forth.

NOTES
- This option applies only when you set the Material List.MaterialListOverflow option to Continuation Sheet, in order to produce a second sheet displaying the material list continuation.
- If you set Drawing.Content.ChangeManagementEnabled to True, we recommend you set this option to Alpha suffix.

Defines
OS 30 Pos 1

Sheet Number Format
Controls the number of characters output for the sheet number. If the sheet number output has less than the requested number of characters, leading zero(s) are inserted where appropriate.
- 0 - No leading zeros
- 1 Character - Fixed number of characters
- 2 Characters
- 3 Characters
- 4 Characters
Appendix: Isometric Drawing Options

- 5 Characters
- 6 Characters
- 7 Characters
- 8 Characters
- 9 Characters

Defines
OS 30 Pos 3

SmallxLargeNS
Free format text field that allows you to type a table of record ids and SKEYs, which are output with the nominal size in small x large order.

The following example illustrates the required format (Record identifier SKEY (optional)):

```
50  AR
80
100 RAFL
```

Defines
ISOGEN attribute

SupportsWithMatchingNamesAccumulation
Controls the accumulation of supports with matching tags.

Off - Support with matching names (tags) not accumulated.
On - Support with matching names (tags) accumulated.

Defines
OS 64 Pos 4

TextFont
Specifies a font corresponding to a font entry in the .fif file.

Defines
OS 27 Pos 7, 8, 9

Visible
Controls the display of the material list.

- True - Plot the material list.
- False - Turn off all material list types, except the material control file and cut list. The software controls these files separately.

Defines
OS 23 Pos 1
WastageArea1

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

Defines

OS 43

WastageArea2

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

Defines

OS 44

WastageArea3

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.
Appendix: Isometric Drawing Options

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

**Defines**

OS 45

**WastageArea4**

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

**Defines**

OS 46

**WastageArea5**

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
Appendix: Isometric Drawing Options

- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

**Defines**
OS 47

**WastageArea6**
Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting
- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

**Defines**
OS 48

**WastageArea7**
Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- **0** - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- **1** - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting
- **Value** - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

**Defines**
OS 49
WastageArea8

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- 0 - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- 1 - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
- Value - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

Defines

OS 51

WastageArea9

Controls any additional pipe quantity that needs to be added to the material list to allow for wastage during fabrication.

The property is one of nine that holds a percentage factor that is used to calculate pipe wastage allowances. Each of the nine properties is applicable to a particular Plant area, which can be identified in the input Pipeline data file.

- 0 - Use a percentage multiplication factor of zero. This setting allows you to obtain no increase in pipe material quantity even though a value may have been included in the input pipeline data file.
- 1 - Use a percentage multiplication factor of 1. This value does not increase the basic wastage percentage that can be set in application records in the input pipeline data file. This is the default setting.
- Value - Use the specified value as an additional factor that is multiplied by the basic wastage factor (input on appropriate records in the pipeline data input file) to arrive at a final wastage factor percentage. For example, a value of 2 gives a final percentage of twice the value of any figure included in the input pipeline data file.

Defines

OS 51

WeightsStyle

Controls the output of component weights.

- Total - Each component weight is a total weight. For example: quantity x unit weight.
- Individual - Each component weight is the individual weight of the component type. The quantity is not multiplied by the unit weight.
Appendix: Isometric Drawing Options

- **None** - Suppress the output of component weight on material lists.

  **Defines**
  OS 41 Pos 5

**WeldAccumulation**

Controls the accumulation of welds.

- **Normal** - Accumulate welds normally.
- **None** - Suppress accumulation of weld items but list them separately in the material list.
- **Suppress** - Suppress display of welds in the material list.

  **Defines**
  OS 74 Pos 6

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Fixed Layout (Material List)**

Sets options for the fixed layout material list format. This format produces a simple material list. You can use either a user-defined drawing frame or the standard ISOGEN drawing frame.

**InsertBlankLines**

Sets whether the software inserts blank lines

- **True** - Insert blank lines after single line entries in the material list.
- **False** - Blank lines not inserted following single line entries. This provides the possibility of the material list being shorter.

  **Defines**
  OS 26 Pos 2

**Layout**

Specifies the material list layout pattern.

- **Standard** - Produce the standard sectionalized type with group headings and component sub-group headings.
- **Continuous** - Produce a layout without headings and sub-headings.

  **NOTE** This type of list is partitioned with horizontal dividing lines between the logical groups, such as pipe, flanges, and fittings. If required, you can switch off the dividing lines using **ShowDividingLines**.

  **Defines**
  OS 23 Pos 5
**LineSpacing**
Controls the line spacing distance on a plotted material list. This value is a ratio that applies to standard line spacing. For example, a value of 90 reduces the line spacing, while a value of 110 increases it.

Type a value in the range 75-125. The default is 100.

**Defines**

OS 29

**MLType**
Controls the type of material list.

- **Normal** - The software does not create a special type of material list.
- **Special** - Give every item a separate entry except gaskets and bolts, which are accumulated. Pulled bends get **U** prefixes, and welds have **W** or **B** prefixes.
- **Normal with alpha pointers** - The software does not create a special type of material list. The software uses an alpha system of material list pointers (**A**, **B**, **C**) instead of the default numeric system.

**Defines**

OS 23 Pos 2

**RightSide**
Sets the position of the material list.

- **True** - Print the material list on the right side of the drawing.
- **False** - Print the material list on the left side of the drawing.

**Defines**

OS 25 Pos 1

**ShowDividingLines**
Specifies lines in the material list. This option provides a way to separate the different groups in the material list when the list does not have headings and sub-headings.

- **True** - Display dividing lines between groups, such as PIPES, FLANGES, or FITTINGS.
- **False** - Display no horizontal dividing lines between the logical groups.

**Note** This option works only when the MaterialList.FixedLayout.Layout option is set to Continuous and the MaterialList.FixedLayout.MLType is set to Special.

**Defines**

OS 23 Pos 5
ShowItemDescriptions

Controls whether item descriptions are printed on the material list. When item descriptions are suppressed, the material list becomes correspondingly narrower.

- **True** - Print item descriptions on the material list.
- **False** - Suppress the printing of item descriptions on the material list.

Defines
OS 26 Pos 1

TextSize

Controls the material list text size. The default setting is **Medium (2.5 mm)**.

- **Small (2.1 mm)** - Output characters 2.1mm high.
- **Medium (2.5 mm)** - Output characters 2.4mm high.
- **Large (2.8 mm)** - Output characters 2.8mm high.
- **XLarge (3.5 mm)** - Output characters 3.5mm high.
- **XXLarge (4.2 mm)** - Output characters 4.2mm high.
- **XXXLarge (4.9 mm)** - Output characters 4.9mm high.
- **Or User** - Output characters with a height defined by **UserTextSize**.

Defines
OS 27 Pos 1

TextWeight

Specifies the thickness of the text. Type a value in the range 0-9.

Defines
OS 27 Pos 5

TextWidth

Specifies the character width if you are using a fixed-width font. Type a value (real number) in the range 0-99 in 1/20 millimetres.

Defines
OS 27 Pos 3, 4

TitleblockPos

Controls the position of the title block.

- **Pipeline** - Position the title block at the bottom right corner of pipeline drawing area. This is the default position.
- **MatList** - Position the title block at the bottom of material list.
Appendix: Isometric Drawing Options

Defines
OS 25 Pos 2

TitleblockVisible
Controls whether the title block appears on the drawing.
- **True** - Display the title block as defined by TitleblockPos.
- **False** - Suppress the title block.

Defines
OS 25 Pos 2

UserTextSize
Specifies a user-defined size in 1/10 millimetres for text output in the fixed material list. Type a value (integer) in range 10-99.

**NOTE** Only use this option if TextSize is set to **User**.

Defines
OS 27 Pos 1, 2

See Also
Appendix: Isometric Drawing Options (on page 415)

Variable Layout (Material List)
Sets options for the variable layout material list format. This format includes options to define column headers. You can use either a user-defined drawing frame or the standard ISOGEN drawing frame.

The Variable Layout (Material List) folder also contains a collection of options that are used to define the columns for a variable layout material list. For more information, see Variable Layout Collection (Material List Variable Layout) (on page 568)

Count
Displays the number of VariableLayouts currently defined in the style.

DefaultDescriptionWidth
Specifies the default number of characters for the description. You can override this option by setting the **Width** property for this column. The column width for fixed-width fonts is important only for this attribute.

Type an appropriate value in the range 0-130.

Defines
ISOGEN attribute
Appendix: Isometric Drawing Options

HeaderLines
Specifies a text string for the column header.
- \ - Start a new line.
- | - Produce a vertical break.

The HeaderLines width is defined by the length of the last line, terminated with the pipe character (|). The length of the last line should be at least as long as the total width of data to be displayed below it.

Column description text in the HeaderLines field must lie in the column bounds as defined.

NOTES
- Do not put text in columns that are not within the specified range of column.
- You must ensure that the column headers match the column positions set in the material list definition (MLD) file.
- You can use the @ symbol instead of a space when you create headings for variable layout bills of materials. ISOGEN interprets the @ symbol as a null character. It is easier to count the number of spaces between the individual headers if you use the @ symbol instead of using spaces.

Defines
ISOGEN attribute

InsertBlankLines
Sets whether the software inserts blank lines.
- True - Insert blank lines after single line entries in the material list.
- False - Blank lines not inserted following single line entries. This provides the possibility of the material list being shorter.

Defines
OS 26 Pos 2

Layout
Specifies the material list layout pattern.
- Standard - Produce the standard sectionalized type with group headings and component sub-group headings.
- Continuous - Produce a layout without headings and sub-headings.

NOTE This type of list is partitioned with horizontal dividing lines between the logical groups, such as pipe, flanges, and fittings. If required, you can switch off the dividing lines using ShowDividingLines.

Defines
OS 23 Pos 5
Appendix: Isometric Drawing Options

**LineSpacing**
Controls the line spacing distance on a plotted material list. This value is a ratio that applies to standard line spacing. For example, a value of 90 reduces the line spacing, while a value of 110 increases it.

Type a value in the range 75-125. The default is 100.

**Defines**
OS 29

**MLType**
Controls the type of material list.

- **Normal** - Create a special type of material list.
- **Special** - Give every item a separate entry except gaskets and bolts, which are accumulated. Give pulled bends a U prefix and welds a W or B prefix.
- **Normal with alpha pointers** - Suppress creation of a special type of material list. The software uses an alpha system of material list pointers (A, B, C) instead of the default numeric system.

**Defines**
OS 23 Pos 2

**RightSide**
Sets the position of the material list.

- **True** - Print the material list on the right side of the drawing.
- **False** - Print the material list on the left side of the drawing.

**Defines**
OS 25 Pos 1

**ShowDividing Lines**
Specifies lines in the material list. This option provides a way to separate the different groups in the material list when the list does not have headings and sub-headings.

- **True** - Displays dividing lines between groups, such as PIPES, FLANGES, or FITTINGS.
- **False** - No horizontal dividing lines between the logical groups.

**NOTE**  This option works only when the MaterialList.VariableLayout.Layout option is set to Continuous and the MaterialList.VariableLayout.MLType is set to Special.

**Defines**
OS 23 Pos 5

**TextSize**
Controls the material list text size. The default setting is Medium (2.5 mm).
Appendix: Isometric Drawing Options

- **Small (2.1 mm)** - Output characters 2.1mm high.
- **Medium (2.5 mm)** - Output characters 2.4mm high.
- **Large (2.8 mm)** - Output characters 2.8mm high.
- **XLarge (3.5 mm)** - Output characters 3.5mm high.
- **XXLarge (4.2 mm)** - Output characters 4.2mm high.
- **XXXLarge (4.9 mm)** - Output characters 4.9mm high.
- **Or User** - Output characters with a height defined by **UserTextSize**.

**Defines**

OS 27 Pos 1

**TextWeight**

Specifies the thickness of the text. Type a value in the range 0-9.

**Defines**

OS 27 Pos 5

**TextWidth**

Specifies the character width if you are using a fixed-width font. Type a value (real number) in range 10 - 99 in 1/20 millimetre.

**Defines**

OS 27 Pos 3, 4

**UniqueDelimiter**

Defines the character used as a delimiter when the file format is delimited. The possible characters are:

- Blank
- Comma (,)
- Semi-colon (;)
- Colon (:)

**UserTextSize**

Specifies a user-defined text size in millimetres. Type a value (integer) in range 10 to 99.

**Note** Only applicable if **TextSize** is set to **User**.

**Defines**

OS 27 Pos 1, 2
See Also
Appendix: Isometric Drawing Options (on page 415)

Variable Layout Collection (Material List Variable Layout)

Specifies the columns for a variable layout material list.

**NOTE** The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

getAttribute

Specifies a property to appear in the column. Use the **AttributeName** list to select the required attribute.

**Justification**

Sets the alignment of the text. Specify **Left**, **Right**, or **Numeric**.

**Start**

Specifies the starting point of the column. The valid range is 1-999.

**MaxChars**

Defines the maximum amount of characters.

**Comment**

Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

See Also
Appendix: Isometric Drawing Options (on page 415)

User Defined (Material List)

Sets options for the user-defined material list format. The user-defined material list offers more flexibility than the other two material list styles.

**NOTE** This style of material list requires a user-defined backing sheet.

The **User Defined (Material List)** folder also contains the following groups of options:

- **One Section** - Sets options for the user-defined material list format. This format displays one section in the material list. For more information, see One Section (Material List User Defined) (on page 573).

- **Two Section** - Sets options for the user-defined material list format. This format displays two sections in the material list. For more information, see Two Section (Material List User Defined) (on page 574).

- **Three Section** - Sets options for the user-defined material list format. This format displays three sections in the material list. For more information, see Three Section (Material List User Defined) (on page 576).
Appendix: Isometric Drawing Options

- **Remarks Box** - Sets options for the user-defined material list remarks box. For more information, see *Remarks Box (Material List User Defined)* (on page 578).

- **Spool Table** - Stores the settings for spool table quantities, which can be output as part of a user-defined material list. For more information, see *Spool Table (Material List User Defined)* (on page 579).

- **User Defined Collection** - Defines the columns for a user-defined material list. For more information, see *User Defined Collection (Material List User Defined)* (on page 581).

**AccumulatedPipeDesc**

Specifies the horizontal offset in millimetres to horizontal offset to accumulated pipe description. The offset is from the material list **StartX** option.

**Define**

ISOGEN attribute

**AccumulatedPipePosition**

Specifies the horizontal offset in millimetres to contents of Alternate Text –394. The offset is from the material list **StartX** option.

**Define**

ISOGEN attribute

**AccumulatedPipeQuantity**

Specifies the horizontal offset in millimetres to horizontal offset to accumulated pipe quantity. The offset is from the material list **StartX** option.

**Define**

ISOGEN attribute

**ActiveSection**

Defines the number of sections in the material list.

- 1 - Use the **OneSection** object properties for material list layout.
- 2 - Use the **TwoSection** object properties for material list layout.
- 3 - Use the **ThreeSection** object properties for material list layout.

**Define**

ISOGEN attribute

**CategoryHeadingX**

Defines the displacement in X from **StartX** for the category heading. Type a value (real number) in millimetres.
Appendix: Isometric Drawing Options

**Defines**
ISOGEN attribute

**CategoryUnderline**
Controls whether category headings are underlined. If set to True, the category heading is underlined.

**Defines**
ISOGEN attribute

**DefaultDescriptionWidth**
Specifies the default number of characters to use for the Description. You can override this option by setting the Width property for this column. The column width for fixed-width fonts is important only for this attribute.
Type a value in the range 1-130.

**Defines**
ISOGEN attribute

**DrawingColour**
Specifies a number that represents the colour number as defined in the output drawing system (MicroStation or AutoCAD). Type the required value (integer).

**Defines**
ISOGEN attribute

**DrawingLayer**
Sets the drawing layer for material list text. Type a value (integer) in the range of 1-50.

**NOTE** For more information about drawing layers, see Definitions (Drawing) (on page 439).

**Defines**
ISOGEN attribute

**GroupHeadingX**
Specifies the displacement from the StartX setting for the group heading. Type a value (integer) in millimetres.

**Defines**
ISOGEN attribute

**GroupUnderline**
Controls whether group headings are underlined. If set to True, the group heading is underlined.

**Defines**
ISOGEN attribute
MLType
Controls the type of material list.
- **Normal** - The software does not create a special type of material list.
- **Special** - Gives every item a separate entry except gaskets and bolts, which are accumulated. Pulled bends get U prefixes, and welds have W or B prefixes.
- **Normal with alpha pointers** - The software does not create a special type of material list. The software uses an alpha system of material list pointers (A, B, C...) instead of the default numeric system.

Defines
OS 23 Pos 2

ShowAccumulatedPipeData
Controls the plotting of accumulated pipe information in a material list containing non-accumulated quantities. That is, for pipe only, it is possible to have both accumulated and non-accumulated information in the same material list. The default setting is **False**.
- **True** - Export AccumulatedPipePosition, AccumulatedPipeQuantity and AccumulatedPipeDesc to the material list definition (MLD) file.
- **False** - The properties defined previously (as set when True is selected) are not exported to the material list definition file.

Defines
ISOGEN attribute

ShowCategoryHeadings
Specifies whether or not the category headings appear.
- **True** - Display group category headings.
- **False** - Suppress the display of group category headings.

Defines
ISOGEN attribute

ShowGroupHeadings
Specifies whether group headings are displayed.
- **True** - Display group headings.
- **False** - Suppress the display of group headings.

Defines
ISOGEN attribute

ShowRemarks
Controls the appearance of a remarks list, as defined by the separate Remarks options. For more information about remarks, see Remarks Box (Material List User Defined) (on page 578).
- **True** - Display the Remarks list.
**False** - Suppress the display of the Remarks list.

**Defines**
ISOGEN attribute

**StartX**
Defines the bottom left X position of the first line of the material list. Type a value (integer).

**Defines**
ISOGEN attribute

**StartY**
Defines the bottom left Y position of the first line of the material list. Type a value (integer).

**Defines**
ISOGEN attribute

**TextFont**
Specifies a font corresponding to a font entry in the .fif file. Use the **TextFont** list to specify the font type.

**Defines**
ISOGEN attribute

**TextHeight**
Specifies the text height. The text height applies to all sections in the material list. Type a value (real number) in millimetres.

**Defines**
ISOGEN attribute

**TextWeight**
Specifies the text weight. Type a value (integer) between 1 and 9.

**Defines**
OS 27 Pos 5

**TextWidthFactor**
Defines the ratio of width to height of the text in the material list. Type a value (integer).

**Defines**
ISOGEN attribute
UniqueDelimiter
Defines the character used as a delimiter when the file format is delimited. The possible characters are:
- Blank
- Comma (,)
- Semi-colon (;)
- Colon (:)
Defines ISOGEN attribute

VerticalSpacing
Specifies the vertical spacing between the lines of data. The vertical spacing applies to all sections in the material list. Type a value (real number).
Defines ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

One Section (Material List User Defined)
Sets options for the user-defined material list format. This format displays one section in the material list.

Content
Selects the category of data for the material list content. The default is Continuous.
- Continuous - List all items in the material list.
- Fabrication - List fabrication components only.
- Erection - List erection components only.
- Offshore - List offshore components only.
- Erection/Offshore - List erection/offshore components only.
Defines ISOGEN attribute

ListDown
Specifies the plotting of the material list.
- True - Plot the material list from top to bottom.
- False - Plot the material list from the bottom up.

NOTE For a three section material list, all section must be in the same direction.
Appendix: Isometric Drawing Options

**Defines**  
ISOGEN attribute

**MaxEntries**  
Sets the maximum number of entries in the material list before an overflow sheet is generated.  
Type the required value (positive integer).

**Defines**  
ISOGEN attribute

**See Also**  
*Appendix: Isometric Drawing Options* (on page 415)

**Two Section (Material List User Defined)**

Sets options for the user-defined material list format. This format displays two sections in the material list.

**Section1Content**  
Selects the category of data for the material list content in Section 1. The default setting is **FABRICATION**.

- **FABRICATION** - List only fabrication components.
- **ERECITION** - List only erection components.
- **OFFSHORE** - List only offshore components.
- **ERECITION/OFFSHORE** - List only erection/offshore components.

**Defines**  
ISOGEN attribute

**Section1Down**  
Specifies the plotting of the material list.

- **True** - Plots data from the top down in Section 1.
- **False** - Plots data from the bottom up in Section 1.

**Defines**  
ISOGEN attribute

**Section1MaxEntries**  
Sets the maximum number of entries in Section 1 of the material list before an overflow sheet is generated. Type the required value (integer),

**Defines**  
ISOGEN attribute
Appendix: Isometric Drawing Options

Section2Content
Selects the category of data for the material list content in Section 2. The default setting is ERECTION. This option cannot be same as Section1Content.
- **FABRICATION** - List only fabrication components.
- **ERECTION** - List only erection components.
- **OFFSHORE** - List only offshore components.
- **ERECTION/OFFSHORE** - List only erection/offshore components.

Defines
ISOGEN attribute

Section2Down
Specifies the plotting of the material list. The default setting is True.
- **True** - Plots data from the top down in Section 2.
- **False** - Plots data from the bottom up in Section 2.

Defines
ISOGEN attribute

Section2MaxEntries
Controls the maximum number of entries for Section 2 of the material list before an overflow sheet is generated. Type the required value (integer).

Defines
ISOGEN attribute

Section2YOffset
Controls the Y offset for section 2 of the material list with reference to the StartX and StartY options under Material List.User Defined. Type a value (integer).

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)
**Three Section (Material List User Defined)**

Sets options for the user-defined material list format. This format displays three sections in the material list.

**ListDown**

Sets the plotting of the material list. The default setting is **True**.

- **True** - Plot data from the top down.
- **False** - Plot data from the bottom up.

**Note** For a three section material list, all section must be in the same direction.

**Section1Content**

Selects the category of data for the material list content in Section 1. The default is **FABRICATION**.

- **FABRICATION** - List only fabrication components.
- **ERECTION** - List only erection components.
- **OFFSHORE** - List only offshore components.
- **ERECTION/OFFSHORE** - List only erection/offshore components.

**Section2Content**

Selects the category of data for the material list content in Section 2. The default setting is **ERECTION**.

**Note** This option cannot be the same as **Section1Content**.

- **FABRICATION** - List only fabrication components.
- **ERECTION** - List only erection components.
- **OFFSHORE** - List only offshore components.
- **ERECTION/OFFSHORE** - List only erection/offshore components.
Appendix: Isometric Drawing Options

Defines
ISOGEN attribute

Section2MaxEntries
Sets the maximum number of entries in Section 2 of the material list before an overflow sheet is generated. Type the required value (integer).

Defines
ISOGEN attribute

Section2YOffset
Controls the Y offset for section 2 of the material list with reference to the StartX and StartY options under Material List.User Defined. Type the required value (integer).

Defines
ISOGEN attribute

Section3Content
Selects the category of data for the material list content in Section 3 of the material list. The default setting is OFFSHORE.

- **FABRICATION** - List only fabrication components.
- **ERECPTION** - List only erection components.
- **OFFSHORE** - List only offshore components.
- **ERECPTION/OFFSHORE** - List only erection/offshore components.

Defines
ISOGEN attribute

Section3MaxEntries
Sets the maximum number of entries in Section 3 of the material list before an overflow sheet is generated. Type the required value (integer).

Defines
ISOGEN attribute

Section3YOffset
Controls the Y offset for section 3 of the material list with reference to the StartX and StartY options under Material List.User Defined. Type the required value (integer).

Defines
ISOGEN attribute
See Also
Appendix: Isometric Drawing Options (on page 415)

Remarks Box (Material List User Defined)
Sets options for the user-defined material list remarks box.

DrawingLayer
Sets the drawing layer for material list text. Type a value (integer) in the range 1-50.

\[\text{NOTE}\] For more information about drawing layers, see Definitions (Drawing) (on page 439).

Defines
ISOGEN attribute

MaxCharacters
Sets the maximum number of characters per line in the remarks box. Type a value (positive integer).

Defines
ISOGEN attribute

MaxEntries
Sets the maximum number of entries in the remarks box. Type a value (positive integer).

\[\text{NOTE}\] When the maximum is reached, ISOGEN does not output any further lines, and a warning message is output to the message file.

Defines
ISOGEN attribute

StartX
Specifies the X-coordinate of the starting position for the remarks box. Type a positive real number in millimetres.

Defines
ISOGEN attribute

StartY
Specifies the Y-coordinate of the starting position for the remarks box. Type a positive real number in millimetres.

Defines
ISOGEN attribute

TextHeight
Specifies the height of the characters in remarks text. Type a positive real number in millimetres.
Appendix: Isometric Drawing Options

Defines
ISOGEN attribute

TextWeight
Specifies the weight of the characters in remarks text. Type a positive real number in millimetres.

Defines
OS 27 Pos 5

VerticalSpacing
Sets the vertical spacing between the horizontal lines of remark text. Type a positive real number in millimetres.

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

Spool Table (Material List User Defined)
Stores the settings for the spool table quantities, which can be output as part of a user-defined material list.

ColumnOffset
Controls the horizontal offset between each column of spool quantities on the material list. Type a value in mm or inches (as a real number).

DataOffsetX
Sets the X offset to the first spool quantities position in mm or inches (as a real number).

DataOffsetY
Sets the Y offset to the first spool quantities position in mm, or inches (as a real number).

DrawingLayer
Sets the drawing layer for the spool table text. Type a value in the range of 1 to 50.

Enabled
Controls whether the spool table settings are written to the material list definition (MLD) file.

HeaderOffsetX
Sets the X offset to the spool identifier position in mm or inches (as a real number).
Appendix: Isometric Drawing Options

**HeaderOffsetY**
Sets the Y offset to the spool identifier position in mm or inches (as a real number).

**NoColumns**
The maximum number of spool quantity columns that can fit on the backing sheet.

**OutputLinesTube**
Used in conjunction with AText -537 to control the number of lines used for output of pipe lengths.
The form of length output on the material list is controlled by **LinearQuantityStyle**; however, in order to save space, it is possible to have a two line format.
By default, **OutputLinesTube** is set to 1, which uses the default **LinearQuantityStyle**. If AText -537 is being used, then **OutputLinesTube** must be set to 2.

**Note**: AText -537 is used to indicate the new line by using the $ and the setting for the units indication to be output, as shown in the following example:

| -537$m | 13.5 | m |
| -537$mm | 13500 | mm |
| -537$FT | 19.5 | Ft |
| -537$FT | 13.5 | Ft (instead of 13.5') |

**Notes**
- Do not use AText -537 if pipe quantities are requested in Ft-Ins (13'-5") units.
- If set, this AText takes over control of the units indication output on all styles of material list, as well as allowing a new line indicator to force two line output. If it is not set, then normal defaults apply.

**TableOverflow**
Indicates if automatic spool table overflow on to a second sheet is allowed.

- **True** - Overflow is allowed.
- **False** - Overflow is not allowed.

**TextHeight**
Sets the text height to be used.
Appendix: Isometric Drawing Options

Type a value (real number) in mm or inches.

**TextHeightMultiple**
Sets the height of the text to be output in multiple line form on the material list.
Type the value (real number) in mm or inches.

**TextWeight**
Controls the character thickness. Type a value between 1 and 9. Used for MicroStation only.

**User Defined Collection (Material List User Defined)**
Specifies the columns for a user-defined material list.

**NOTE** The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

**AttributeName**
Specifies a property to appear in the column. Use the **AttributeName** list to select the required property.

**offset**
Specifies the starting point of the column. The valid range is 1-999.

**MaxChars**
Sets the width of the column.

**Comment**
Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)
Summary File (Material List)
Sets options for the material list summary file.

The Summary File (Material List) folder also contains a collection of options that are used to define the columns for a material list summary file. For more information, see Summary File Collection (Material List Summary File) (on page 585).

Append
Defines whether the file is opened in appended mode or overwrite mode.
- True - Append the file.
- False - Overwrite the file.

Defines
ISOGEN attribute

Count
Specifies the number of SummaryFiles currently defined in the style.

Delimiter
Defines the character used as a delimiter when the file format is delimited. The possible characters are
- Blank
- Comma (,)
- Semi-colon (;)
- Colon (:)

Defines
ISOGEN attribute

Enabled
Specifies whether the summary file is created.
- True - Create the summary file.
- False - Suppress creation of the summary file.

Defines
ISOGEN attribute

FileFormat
Defines the format of the output file
- Fixed - Output a fixed format file.
- Delimited - Output a delimited file.
ISOGEN attribute

**HeaderLines**
Specifies the text string for the column header.
- \ - Start a new line.
- | - Produce a vertical break.

The **HeaderLines** width is defined by the length of the last line, terminated with the bar character |. The length of the last line should be at least as long as the total width of data to be displayed below it.

Column description text in the **HeaderLines** field must lie in the column bounds as defined.

**NOTES**
- You must ensure that the column headers match the column positions set in the material list definition (MLD) file.

Do not put text in columns that are not within the specified range of column.

**Defines**
ISOGEN attribute

**IncludeBolts**
Specifies whether bolts are included in the summary file. The default setting is **True**.
- **True** - Include bolts included in the material control file.
- **False** - Exclude bolts from the material control file

**Defines**
OS 65 Pos 1

**IndividualEntries**
Controls whether Individual entries are output to the material control file when material accumulation is being used on the material list. This allows components with different attributes to be listed correctly but avoids non-accumulation of materials which can often create overflow drawings.
- **True** - Output individual entries to the material control file.
- **False** - Suppress output of individual entries.

**Defines**
ISOGEN attribute

**MaterialHeadings**
Controls whether there is a single output of material headings or for each pipe/drawing.
- **Pipeline** - Output headings for each pipeline.
- **Drawing** - Output headings for each drawing.
- **Single** - Output a single output of the headings.
Appendix: Isometric Drawing Options

Defines
ISOGEN attribute

Path
Specifies the full path location and filename of the summary file. Type the full path and file name.

**NOTE**: Do not include special characters in the summary filename.

Defines
ISOGEN attribute

ShowHeaders
Specifies whether the header lines are shown.
- True - Display header lines.
- False - Suppress the display of header lines.

Defines
ISOGEN attribute

ShowTitles
Specifies whether the title line is shown.
- True - Display the title line.
- False - Suppress the display of the title line.

Defines
ISOGEN attribute

TitleText
Specifies text for the title.

Defines
ISOGEN attribute

UniqueDelimiter
Defines the character used as a delimiter when the file format is delimited. The possible characters are:
- Blank
- Comma (,)
- Semi-colon (;)
- Colon (:)

UserDefined
Specifies whether the software creates the old standard material control file, or the software uses the properties of the summary file object to control the data output to the material control file.
Appendix: Isometric Drawing Options

- **True** - Create the material control file using the summary file object properties.
- **False** - Create a standard material control file.

**Defines**

OS 23 Pos 4

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

**Summary File Collection (Material List Summary File)**

Specifies the columns for a material list summary file.

**NOTE** The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

**AttributeName**

Specifies the name of the attribute being defined. Use the **AttributeName** list to select the required attribute.

**Justification**

Sets the alignment of the text. Specify **Left** or **Right**.

**Start**

Specifies the starting point of the column. The valid range is 1-999.

**MaxChars**

Sets the width of the column.

**Comment**

Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)
Transfers (Material List)

Stores the information that allows you to move a component from one sort group to another on the material list. For example, a blank flange can be moved to the FLAN sort group.

The Transfers (Material List) folder contains a collection of options called Transfers, which is used to store the components to be transferred. For more information, see Transfers (Material List) (on page 586).

Count

Displays the number of items in the Transfers collection. Each represents a material that is to be assigned to a group other than its default.

Transfers (Material List)

Moves components from one sort group to another. For example, by default a blind flange is listed in the Valves/Inline item group in the material list. Using the Transfers functionality, you can specify that blind flanges are listed in the Flanges group in the material list instead.

NOTE When you transfer components on a Variable Layout or User Defined material list, you must also change the material list headings by specifying AText -307, -308, -309, -311, -312, -313, -314, -315, -339, and -375. For more information, see Appendix: AText Reference Data (on page 816).

RecordID

Specifies the record ID of the component type. This is the IDF record number for the component, such as 107 for a blank flange or 90 for a control valve. Valid IDs are integers in the range 0-999. For more information, see Record Identification Numbers (on page 587).

NewGroup

Specifies a new group for the component type. Available sort groups include:

- PIPE (pipe)
- VALV (valves and inline items)
- FITT (fittings)
- INST (instruments)
- FLAN (flanges)
- SUPP (supports)
- GASK (gaskets)
- MISC (miscellaneous)
- BOLT (bolts)
- WELD (welds)
### SKEY

Transfers a record ID to a component group based on a user-defined SKEY. In the following example, record ID 90 (instrument) is transferred to the valve group (VALV) but only instruments that have an SKEY of CV** (refers to a control valve with any end preparation).

<table>
<thead>
<tr>
<th>RecordID</th>
<th>Group</th>
<th>SKEY</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>VALV</td>
<td>CV**</td>
</tr>
</tbody>
</table>

#### See Also

*Appendix: Isometric Drawing Options* (on page 415)

### Record Identification Numbers

#### Spool and In-Line Fitting Records

<table>
<thead>
<tr>
<th>Spool/Fitting Type</th>
<th>In Leg</th>
<th>First Branch Leg</th>
<th>Second Branch Leg</th>
<th>Out Leg</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bend</td>
<td>30</td>
<td>-</td>
<td>-</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Elbow</td>
<td>35</td>
<td>-</td>
<td>-</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Olet</td>
<td>40</td>
<td>41</td>
<td>-</td>
<td>42</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Tee</td>
<td>45</td>
<td>46</td>
<td>-</td>
<td>47</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Cross</td>
<td>50</td>
<td>51</td>
<td>52</td>
<td>53</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Reducer (Con/Ecc)</td>
<td>55</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Tee Reducer (Con/Ecc)</td>
<td>60</td>
<td>61</td>
<td>-</td>
<td>62</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Reducing Flange</td>
<td>65</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Tee Bend/Elbow</td>
<td>70</td>
<td>71</td>
<td>-</td>
<td>72</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Angle Valve</td>
<td>75</td>
<td>-</td>
<td>-</td>
<td>76</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>3 Way Valve</td>
<td>80</td>
<td>81</td>
<td>-</td>
<td>82</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>4 Way Valve</td>
<td>85</td>
<td>86</td>
<td>87</td>
<td>88</td>
<td>Plus a 0 record</td>
</tr>
<tr>
<td>Instrument</td>
<td>90</td>
<td>91</td>
<td>92</td>
<td>93</td>
<td>A straight through type instrument has only 90 and 93 record ID numbers. Instrument dials have only a 90 record.</td>
</tr>
</tbody>
</table>
### Appendix: Isometric Drawing Options

<table>
<thead>
<tr>
<th>Description</th>
<th>Code</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pcom (Misc. Pipe Component)</td>
<td>95</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>96</td>
</tr>
<tr>
<td>Pipe (Tube)</td>
<td>100</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Fixed Length Pipe</td>
<td>101</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Pipe Block (Fixed Length)</td>
<td>102</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Pipe Block (Variable Length)</td>
<td>103</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Flange</td>
<td>105</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Lap Joint Stub End</td>
<td>106</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Blank Flange (Blind)</td>
<td>107</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Gasket</td>
<td>110</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Bolt</td>
<td>115</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Weld</td>
<td>120</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Cap</td>
<td>125</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Coupling</td>
<td>126</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Union</td>
<td>127</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Valve</td>
<td>130</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Trap</td>
<td>132</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Vent</td>
<td>134</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>136</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>User Positioned Comment</td>
<td>149</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Pipe Hanger/Support</td>
<td>150</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>180 to</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reserved for internal ISODAT processing.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bore Record</td>
<td>0</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

*Used to define position*

---

Piping Isometric Drawings User's Guide 588
Weld List Options

Sets options for the ISOGEN weld list. For options that control weld representation on the drawing, see Welds (Drawing) (on page 524).

**NOTE** The weld list is the report that displays on the drawing, while the weld list summary file is the weld data formatted in a text file.

The Weld List folder contains the following groups of options.

- **Fixed Layout** - Defines the fixed layout weld list. For more information, see Fixed Layout (Weld List) (on page 590).
- **Variable Layout** - Defines the alternative variable layout weld list. The fixed layout list is a fixed-format list that you cannot modify. The variable layout list is a column-based list. For more information, see Variable Layout (Weld List) (on page 590).
- **User Defined** - Defines the alternative user defined weld list. The software prints this type of list into a drawing frame that contains a pre-existing table with header texts. The user defined list is a collection of start positions expressed in millimeters. For more information, see User Defined (Weld List) (on page 592).
- **Summary File** - Defines the titles section of a user-defined weld summary file and contains a series of column definitions. You can suppress the display of title and column header information to produce a more readily machine-readable summary file. For more information, see Summary File (Weld List) (on page 595).

**ActiveList**

- Defines which of the three weld list styles is being used. You can select **UserDefined**, **FixedLayout** or **VariableLayout**.

**Defines**

- OS 53 Pos 2

**ClampWelds**

Controls the number of weld numbers allocated to Victaulic welded/gorged ring type clamps (CLVR). Type a value in the range of 1 to 9.

**NOTE** If set to 0 (the default value), two weld numbers are allocated.

**Defines**

OS 77 Pos 7

**TackWeldNumbers**

Controls the allocation of weld numbers on tack welds.

- **True** - Allocate weld numbers.
Appendix: Isometric Drawing Options

- **False** - Suppress the allocation of weld numbers.

**Defines**
OS 77 Pos 5

**Visible**

Turns on or off the display of the weld or operations summary on the drawing.

- **True** - Plot the weld list.
- **False** - Suppress plotting of plot the weld list.

**Defines**
OS 53 Pos 2

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Fixed Layout (Weld List)**

Sets options for the fixed layout weld list format. This format produces a simple weld list. You can use either a user-defined drawing frame or the standard ISOGEN drawing frame.

**ShowOperationsBox**

Controls whether the weld operations box is shown.

- **True** - Display the weld operations box. This operations box replaces the original weld list if the WeldList.Visible option is set to True.
- **False** - Suppress the display of the weld operations box. The original weld list is plotted if the WeldList.Visible option is set to True.

**Defines**
OS 53 Pos 2

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Variable Layout (Weld List)**

Sets options for the variable layout weld list format. This format includes options to define column headers. You can use either a user-defined drawing frame or the standard ISOGEN drawing frame.

The **Variable Layout (Weld List)** folder also contains a collection of options that are used to define the columns for a variable layout weld list. For more information, see *Variable Layout Collection (Weld List Variable Layout)* (on page 591).

**Count**

Displays the number of definitions in the Variable Layout collection. This value is defined by the software.
HeaderLines
Controls the column header text in the material list.
- \ - Start a new line.
| - Produce a vertical break.

**NOTE** Makes sure that the column headers match the column positions when you use this option.

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

**Variable Layout Collection (Weld List Variable Layout)**

Specifies the columns for a variable layout weld list.

**NOTE** The value that displays in parentheses after the collection name is a count of how definitions are stored in the collection.

AttributeName
Specifies the name of the attribute being defined. Use the AttributeName list to select the required attribute.

Justification
Sets the alignment of the text. Specify Left, Right, or Numeric.

Start
Specifies the starting point of the column. The valid range is 1 to 999.

MaxChars
Sets the width of the column. Type a value of zero or greater.

Comment
Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>AttributeName</th>
<th>Offset</th>
<th>MaxChars</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT NO</td>
<td>0 mm</td>
<td>2</td>
<td>PART NO</td>
</tr>
<tr>
<td>N.S.</td>
<td>13 mm</td>
<td>17</td>
<td>NOM. SIZE</td>
</tr>
<tr>
<td>Item Code</td>
<td>40 mm</td>
<td>18</td>
<td>COMM. CODE</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>79 mm</td>
<td>91</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>165 mm</td>
<td>95</td>
<td>QUANTITY</td>
</tr>
</tbody>
</table>
The next example illustrates how the text comment is output to the relevant file.

```plaintext
STYLE3-DATA-ITEMS
 'PT-NO' 396 2 | PART-NO
 'N.S.' 409 17 | NOM. SIZE
 'ITEM-CODE' 436 16 | COMM. CODE
 'DESCRIPTION' 4?5 31
 'QTY' 561 9 | QUANTITY
```

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

---

**User Defined (Weld List)**

Sets options for the user-defined weld list format. The user-defined weld list offers more flexibility than the other two weld list styles.

The **User Defined (Weld List)** folder also contains a collection of options that are used to define the columns for a user-defined weld list. For more information, see *User Defined Collection (Weld List User Defined)* (on page 595).

### Count

Indicates the number of definitions in the User Defined collection. This value is defined by the software.

### DrawingColour

Specifies a number that represents the colour number as defined in the output drawing system (MicroStation or AutoCAD). Type the required value (integer).

### Defines

**ISOGEN** attribute

### DrawingLayer

Sets the drawing layer for weld list text. For more information about drawing layers, see *Definitions (Drawing)* (on page 439). Type a value (integer) in range 1-50.

### HorizontalSpacing

Sets the horizontal spacing required between each column of the weld list output when the table is horizontally formatted or two dimensional. Type the required value (integer).

### ListDown

Sets the plotting of the weld list.

- **True** - Plot the material list from the top down.
- **False** - Plot the material list from the bottom up.

**Defines**
Appendix: Isometric Drawing Options

ISOGEN attribute

MaxCols
Defines the maximum number of columns before a new row is started when using multiple tables or the maximum number of entries when the table is horizontal. Type the required value (integer).

MaxEntries
Sets the maximum number of entries for the weld list. Type the required value (integer).

Defines
ISOGEN attribute

MaxRows
Defines the maximum number of rows before a new column is started when using multiple tables or the maximum number of entries when the table is vertical. Type the required value (integer).

StartX
Defines the bottom left X position of the first line of the weld list. Type a value (integer).

Defines
ISOGEN attribute

StartY
Defines the bottom left Y position of the first line of the weld list. Type the required value (integer).

Defines
ISOGEN attribute

TableLayout
Controls the order in which a Weld list table is organized.
Appendix: Isometric Drawing Options

- **Horizontal** - Plot data from left to right.

<table>
<thead>
<tr>
<th>WELD NO.</th>
<th>SIZE</th>
<th>TYPE</th>
<th>SHOP/FLD</th>
<th>LOC</th>
<th>WELD NO.</th>
<th>SIZE</th>
<th>TYPE</th>
<th>SHOP/FLD</th>
<th>LOC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2&quot;</td>
<td>SDB</td>
<td>FIELD</td>
<td>1-4</td>
<td>9</td>
<td>4&quot;</td>
<td>FW</td>
<td>FIELD</td>
<td>1-6</td>
</tr>
<tr>
<td>2</td>
<td>2&quot;</td>
<td>BW</td>
<td>FIELD</td>
<td>4-5</td>
<td>10</td>
<td>2&quot;</td>
<td>LET</td>
<td>SHOP</td>
<td>1-2</td>
</tr>
<tr>
<td>3</td>
<td>2&quot;</td>
<td>BW</td>
<td>FIELD</td>
<td>5-4</td>
<td>11</td>
<td>2&quot;</td>
<td>BW</td>
<td>OFFS</td>
<td>2-8</td>
</tr>
<tr>
<td>4</td>
<td>2&quot;</td>
<td>FW</td>
<td>FIELD</td>
<td>4-7</td>
<td>12</td>
<td>2&quot;</td>
<td>BW</td>
<td>OFFS</td>
<td>8-9</td>
</tr>
<tr>
<td>5</td>
<td>1&quot;</td>
<td>TRN</td>
<td>FIELD</td>
<td>4-7</td>
<td>13</td>
<td>2&quot;</td>
<td>BW</td>
<td>OFFS</td>
<td>9-8</td>
</tr>
<tr>
<td>6</td>
<td>1&quot;</td>
<td>TRN</td>
<td>FIELD</td>
<td>4-7</td>
<td>14</td>
<td>1&quot;</td>
<td>AB</td>
<td>OFFS</td>
<td>8-10</td>
</tr>
<tr>
<td>7</td>
<td>4&quot;</td>
<td>TRN</td>
<td>FIELD</td>
<td>1-6</td>
<td>15</td>
<td>2&quot;</td>
<td>FW</td>
<td>OFFS</td>
<td>8-10</td>
</tr>
<tr>
<td>8</td>
<td>4&quot;</td>
<td>FW</td>
<td>FIELD</td>
<td>1-6</td>
<td>16</td>
<td>4&quot;</td>
<td>SDF</td>
<td>SHOP</td>
<td>1-3</td>
</tr>
</tbody>
</table>

- **Vertical** - Plot data from top to bottom.

**TextFont**
Defines the font to be used. Use the **TextFont** list to specify the font type.

**TextHeight**
Specifies the text height in millimetres. Type the required value (real number).

**Defines**
ISOGEN attribute

**TextWeight**
Specifies the character thickness. Type the required value (real number) in millimetres.

**Defines**
ISOGEN attribute

**TextWidthFactor**
Specifies the text width as a percentage of the text height to be used for output of the weld list on the isometric. Type the required value (real number).

**VerticalSpacing**
Specifies the vertical spacing between each horizontal line. Type the required value (real number).

**Defines**
ISOGEN attribute

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)
User Defined Collection (Weld List User Defined)

Specifies the columns for a user-defined weld list.

**NOTE** The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

**AttributeName**

Specifies the name of the attribute being defined. Use the **AttributeName** list to select the required attribute.

**offset**

Specifies the starting point of the column. The valid range is 1-999.

**MaxChars**

Sets the width of the column. The width must be zero or greater.

**Comment**

Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment—preceded by a |-to the relevant data or summary report file.

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>AttributeName</th>
<th>Offset</th>
<th>MaxChars</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-No</td>
<td>0 mm</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>N.S.</td>
<td>13 mm</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>Item Code</td>
<td>40 mm</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>79 mm</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>165 mm</td>
<td>31</td>
<td>95 QUANTITY</td>
</tr>
</tbody>
</table>

The next example illustrates how the text comment is output to the relevant file.

STYLE3-DATA-ITEMS
'PT-N0' 396 2 | PART-N0
'N.S.' 409 17 | NOM. SIZE
'ITEM-CODE' 436 16 | COMM. CODE
'DESCRIPTION' 475 31
'QTY' 561 9 | QUANTITY

**See Also**

Appendix: Isometric Drawing Options (on page 415)

Summary File (Weld List)

Sets options for the titles and column headers in a user-defined weld summary file. You can suppress the display of title and column header information in order to produce a more readily machine-readable summary file.

The **Summary File (Weld List)** folder also contains a collection of options that are used to define the columns for a weld list summary file. For more information, see **Summary File Collection (Weld List Summary File)** (on page 598)
Append
Specifies an append file for welds.
- **True** - Create an append file. The current pipeline is added to an accumulation file.
- **False** - Create a new file.

Defines
ISOGEN attribute

Count
Displays the number of definitions in the Summary File collection. This value is defined by the software.

Delimiter
Specifies a delimiter to use for the header lines that appear at the top of a Weld List Summary file. The possible characters are:
- Blank
- Comma (,)
- Semi-colon (;)
- Colon (;)

Defines
ISOGEN attribute

Enabled
Controls whether weld summary file is created.
- **True** - Create the weld summary file. If you want to set this option to **True**, you first must specify the columns under **Weld List.Summary.Column**.
- **False** - Suppress creation of the weld summary file.

Defines
ISOGEN attribute

FileFormat
Sets the format of the site weld file.
- **Fixed** - Produce a fixed format file.
- **Delimited** - Produce a delimited file. The delimiter is specified in the **Delimiter** option

Defines
ISOGEN attribute
HeaderLines
Controls the column header text in the weld list. Specify the text string for the column header.
- \ - Start a new line.
- | - Produce a vertical break.

*NOTE* Check that the column headers match the column positions set in the welding list definition (WLD) file.

Defines
ISOGEN attribute

Path
Specifies a path to the summary file. Type the full path and filename.

*NOTE* Do not include special characters in the summary file name.

Defines
ISOGEN attribute

ShowHeaders
Controls whether column headers appear.
- **True** - Display header lines.
- **False** - Suppress the display of header lines.

Defines
ISOGEN attribute

ShowTitles
Controls whether titles appear in the weld summary file. This option overrides the setting in TitleText.
- **True** - Display the title line.
- **False** - Suppress the display of the title line.

Defines
ISOGEN attribute

TitleText
Constructs the weld summary file title block. Type the text to be used for the title.

Defines
ISOGEN attribute

See Also
*Appendix: Isometric Drawing Options* (on page 415)
Summary File Collection (Weld List Summary File)

Specifies the columns for a weld list summary file.

AttributeName

Specifies the name of the attribute being defined. Use the AttributeName list to select the required attribute.

Justification

Sets the alignment of the text. Specify Left, Right, or Numeric.

Start

Specifies the starting point of the column. The valid range is 1-999.

MaxChars

Sets the width of the column. Type a value of zero or greater.

Comment

Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment—preceded by a !—to the relevant data or summary report file.

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>AttributeName</th>
<th>Offset</th>
<th>MaxChars</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-No</td>
<td>0</td>
<td>2</td>
<td>PART-No</td>
</tr>
<tr>
<td>N.S.</td>
<td>13</td>
<td>17</td>
<td>NOM. SIZE</td>
</tr>
<tr>
<td>Item Code</td>
<td>40</td>
<td>18</td>
<td>COMM. CODE</td>
</tr>
<tr>
<td>Description</td>
<td>79</td>
<td>91</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>165</td>
<td>99</td>
<td>QUANTITY</td>
</tr>
</tbody>
</table>

The next example illustrates how the text comment is output to the relevant file.

STYLE3-DATA-ITEMS
'PT-No' 396 2 | PART-No
'N.S.' 409 17 | NOM. SIZE
'Item-Code' 436 16 | COMM. CODE
'Description' 475 31
'QTY' 561 9 | QUANTITY

See Also
Appendix: Isometric Drawing Options (on page 415)

Cut List Options

Sets options for the cut list, which provides a list of pipes that are cut into smaller lengths during construction.

The Cut List folder contains the following groups of options:

- **Fixed Layout** - Defines the fixed layout cut list format. For more information, see Fixed Layout (Cut List) (on page 601).
Appendix: Isometric Drawing Options

- **User Defined** - Defines the user-defined cut list format. For more information, see *User Defined (Cut List)* (on page 602).
- **Summary File** - Sets options for the cut list summary file. For more information, see *Summary File (Cut List)* (on page 606).

**ActiveList**
Controls the format of the cut list.

- **Fixed** - Use the properties of `MaterialList.CutList.FixedLayout`.

**Defines**
ISOGEN attribute

**CutPieceID**
Specifies the cut piece identifier type at the appropriate positions along pipelines.

- **Numeric** - Display cut piece identifiers that are numeric.
- **Alphabetic** - Display cut piece identifiers that are alphabetic.

**Defines**
OS 2 Pos 3

**CutPieceSequence**
Specifies whether cut piece numbers increase across drawings.

- **Continuous** - Increase cut piece numbers across drawings.
- **Per drawing** - Start cut piece numbers at 1 (one) or A on each drawing, depending on the setting of `CutPieceID`.

**Defines**
OS 2 Pos 1

**DecimalInchOutput**
Specifies the output of cut piece lengths in decimal inches for imperial units used.

- **True** - Output supplementary cut lengths in decimal inches format in the *REMARKS* column of the new style cut piece list. This option only applies to imperial units users.
- **False** - Output standard cut lengths only.

**Defines**
OS 2 Pos 4

**IncludeAdditionalMaterial**
Controls how additional material is handled in the cut list.
Appendix: Isometric Drawing Options

- None - No entry to cut list for additional material.
- Pipe Only - Add entry to cut list for additional material (PIPE).
- Misc Only - Add entry to cut list for additional material (MISC).
- Pipe and Misc - Add entry to cut list for additional material (PIPE and MISC).

Defines

OS 2 Pos 9

LengthToBranchPoint

Controls the calculation of branch cut length to the branch point position.

- True - Calculate the cut length to whatever the branch point position implies, that is, no adjustment to cut length is made.
- False - Calculate to the centreline of the main pipeline in all situations.

**Note** LengthToCL and LengthToBranchPoint are mutually exclusive; setting one True sets the other one to False.

Defines

OS 2 Pos 5 = 2

LengthToCL

Specifies the calculation of branch cut length. You can specify that the length be measured to the actual branch connection point or to the run centreline.

- True - Calculate to the centreline of the main pipeline in all situations.
- False - Calculate the cut length to whatever the branch point position implies. That is, no adjustment to cut length is made.

**Note** LengthToCL and LengthToBranchPoint are mutually exclusive; setting one to True sets the other one to False.

Defines

OS 2 Pos 5

OffShoreAllowance

Sets the amount of extra pipe that is added at loose flange and field fit weld (FFW) positions for offshore piping. Extra pipe is added both to cut pipe length dimensions and to pipe quantities on the isometric drawing.

- 0 or Blank - Obtain 0 (zero) mm allowance.
- Value (real number) - Use the value (in range 0-999) of an alternative allowance.

Defines

OS 22 Pos 4-6
Appendix: Isometric Drawing Options

OnShoreAllowance
Sets the amount of extra pipe that is added at loose flange and field fit weld (FFW) positions for onshore piping. Extra pipe is added both to cut pipe length dimensions and to pipe quantities on the isometric drawing.

- 0 or Blank - Obtain 0 (zero) mm allowance.
- Value (real number) - Use the value (in range 0-999) of an alternative allowance.

Defines
OS 22 Pos 1-3

ShopWeldAllowance
Sets the amount of extra pipe that is added for shop test purposes where certain welds are cut-off together with a short length of pipe after testing.

- 0 or Blank - Obtain 0 (zero) mm allowance.
- Value (real number) - Use the value (in range 0-999) of an alternative allowance.

*NOTE* ShopWeldAllowance is applied only to shop test welds.

Defines
OS 22 Pos 7-9

Visible
Turns on and off the display of the cut piece list and cut piece identifiers. The cut list is a report on the cut pieces that ISOGEN has determined to be in the pipeline.

- True - Show the cut piece list and numbers on the isometric drawing.
- False - Suppress the display of cut piece list and numbers on the isometric drawing.

Defines
OS 2 Pos 1

See Also
Appendix: Isometric Drawing Options (on page 415)

Fixed Layout (Cut List)
Defines the fixed layout cut list format.

Content
Specifies a limited or full cut list.

- Standard - Use the old style cut list with limited information.
- Extended - Use the new style cut list with full information.

Defines
OS 2 Pos 2
Appendix: Isometric Drawing Options

See Also
Appendix: Isometric Drawing Options (on page 415)

User Defined (Cut List)
Defines the user-defined cut list format.

The User Defined (Cut List) folder also contains a collection of options that are used to define the columns for the user defined cut list. For more information, see User Defined Collection (Cut List User Defined) (on page 605).

AllowOverflowDrawings
Controls whether the cut list causes an overflow drawing. True is the default setting.

- **True** - Cut list can cause an overflow drawing.
- **False** - Cut list cannot cause an overflow drawing. If AllowOverflowDrawings is set to False, and there was no overflow drawing created for any other reason, then the cut list overflow data is lost.

Defines
ISOGEN attribute

Count
Displays the number of columns in the user-defined cut list report plotted on the isometric drawing. This value is defined by the software.

DrawingLayer
Sets the drawing layer for the cut list text. Type an integer in the range 1-50.

Defines
ISOGEN attribute

HorizontalDirection
Sets the horizontal direction for the cut list. The default setting is **Right**.

- **Right** - Cut list is to the right.
- **Left** - Cut list is to the left.

Defines
ISOGEN attribute

HorizontalSpacing
Sets the horizontal spacing required between each column of the cut pipe list output when the table is horizontally formatted or two-dimensional. Type a value (integer).

Defines
ISOGEN attribute
## Layout

Controls whether the table is horizontal, vertical, or multiple style.

- **SingleVertical** - Output same data items vertically against their relevant heading. Number of columns output dependent on **MaxRows** setting.

<table>
<thead>
<tr>
<th>Field No.</th>
<th>N.S.</th>
<th>Length</th>
<th>Item Code</th>
<th>Item</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>B</td>
<td>B</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>C</td>
<td>C</td>
<td>500</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>D</td>
<td>D</td>
<td>500</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>E</td>
<td>E</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>F</td>
<td>F</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>G</td>
<td>G</td>
<td>1750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>H</td>
<td>H</td>
<td>1200</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>I</td>
<td>I</td>
<td>1750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
</tbody>
</table>

- **SingleHorizontal** - Output same data items horizontally against their relevant heading. Number of columns output dependent on **MaxRows** setting.

<table>
<thead>
<tr>
<th>Field No.</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>N.S.</td>
<td>4&quot;</td>
<td>4&quot;</td>
<td>4&quot;</td>
<td>4&quot;</td>
<td>4&quot;</td>
<td>4&quot;</td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>750</td>
<td>750</td>
<td>750</td>
<td>750</td>
<td>750</td>
<td>750</td>
<td></td>
</tr>
<tr>
<td>ISOGEN</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>ISOGEN</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

- **MultipleVertical (Across/Down)** - Layout of data items is Across > Down. Number of columns output dependent on **MaxRows** setting.

<table>
<thead>
<tr>
<th>Field No.</th>
<th>N.S.</th>
<th>Length</th>
<th>Item Code</th>
<th>Item</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>B</td>
<td>2&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>C</td>
<td>3&quot;</td>
<td>1000</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>D</td>
<td>4&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>E</td>
<td>5&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>F</td>
<td>6&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>G</td>
<td>7&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>H</td>
<td>8&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>I</td>
<td>9&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
</tbody>
</table>

- **MultipleVertical (Down/Across)** - Layout of data items is Down > Across. Number of columns output dependent on the **MaxRows** property.

<table>
<thead>
<tr>
<th>Field No.</th>
<th>N.S.</th>
<th>Length</th>
<th>Item Code</th>
<th>Item</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>B</td>
<td>2&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>C</td>
<td>3&quot;</td>
<td>1000</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>D</td>
<td>4&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>E</td>
<td>5&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>F</td>
<td>6&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>G</td>
<td>7&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>H</td>
<td>8&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
<tr>
<td>I</td>
<td>9&quot;</td>
<td>750</td>
<td>BEVEL</td>
<td>BEVEL</td>
<td>BEVEL</td>
</tr>
</tbody>
</table>

### MaxColumns

Defines the maximum number of columns before a new row is started when using multiple tables or the maximum number of entries for a single horizontal table. Type a value (integer).

### Defines

ISOGEN attribute

### MaxRows

Defines the maximum number of rows before a new column is started when using multiple tables or the maximum number of entries when the table is vertical. Type a value (integer).
Appendix: Isometric Drawing Options

Defines
ISOGEN attribute

ShowEnclosure
Controls whether cut list enclosures are shown.
- **True** - Display cut list enclosures.
- **False** - Suppress the display of cut list enclosures.

Defines
ISOGEN attribute

StartX
Defines the bottom left X position of the first line of the cut list. Type a value (integer).

Defines
ISOGEN attribute

StartY
Defines the bottom left Y position of the first line of the cut list. Type a value (integer).

Defines
ISOGEN attribute

TextFont
Specifies a font corresponding to a font entry in the .fif file. Select an appropriate font from the list.

Defines
ISOGEN attribute

TextHeight
Sets the height of the text in the cut list. Type a value (as a real number).

Defines
ISOGEN attribute

TextWeight
Sets the character thickness. Type a value (as a real number) in millimetres.

Defines
ISOGEN attribute

TextWidthFactor
Defines the ratio of width to height of the text in the cut list. Type a value (integer).
Appendix: Isometric Drawing Options

Defines
ISOGEN attribute

VerticalDirection
Sets the vertical direction for the cut list.
- Up - Cut list goes up.
- Down - Cut list goes down.

Defines
ISOGEN attribute

VerticalSpacing
Sets the vertical spacing required between each row of the cut list output when the table is vertically formatted or two dimensional. Type a value (integer).

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

User Defined Collection (Cut List User Defined)

Specifies the columns for the user defined cut list.

NOTE The value that displays in parentheses after the collection name is a count of how definitions are stored in the collection.

AttributeName
Specifies the name of the attribute being defined. Use the AttributeName list to select the required attribute.

offset
Specifies the starting point of the column. Type a value in range 1-999.

MaxChars
Sets the width of the column.

Comment
Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.
Appendix: Isometric Drawing Options

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Offset</th>
<th>MaxChars</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-NO</td>
<td>0 mm</td>
<td>2</td>
<td>PART-NO</td>
</tr>
<tr>
<td>N.S.</td>
<td>13 mm</td>
<td>17</td>
<td>NOM. SIZE</td>
</tr>
<tr>
<td>Item Code</td>
<td>40 mm</td>
<td>18</td>
<td>COMM. CODE</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>79 mm</td>
<td>91</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>165 mm</td>
<td>91</td>
<td>QUANTITY</td>
</tr>
</tbody>
</table>

The next example illustrates how the text comment is output to the relevant file.

STYLE3-DATA-ITEMS
'PT-NO' 396 2 | PART-NO
'N.S.' 409 17 | NOM. SIZE
'ITEM-CODE' 436 16 | COMM. CODE
'DESRIPTION' 475 31
'QTY' 561 9 | QUANTITY

See Also
Appendix: Isometric Drawing Options (on page 415)

Summary File (Cut List)

Sets options for the cut list summary file.

The Summary File (Cut List) folder also contains a collection of options that are used to define the columns for a material list summary file. For more information, see Summary File Collection (Cut List Summary File) (on page 608).

Append

Defines whether the file is opened in appended mode or overwrite mode.

- **True** - Append the file.
- **False** - Overwrite the file.

Defines

ISOGEN attribute

Count

Displays the number of attributes to be output to the material list cut list summary file.

Delimiter

Defines the character used as a delimiter when the file format is delimited. The possible characters are:

- Blank
- Comma (,)
- Semi-colon (;)
- Colon (:)

Defines

ISOGEN attribute
Appendix: Isometric Drawing Options

**Enabled**
Specifies whether the summary file is created.
- **True** - Enable the export of cut list summary details to the material list definition (MLD) file.
- **False** - Suppress the export of cut list summary details to the material list definition (MLD) file.

**Defines**
ISOGEN attribute

**FileFormat**
Defines the format of the output file.
- **Fixed** - Output a fixed format file.
- **Delimited** - Output a delimited file.

**HeaderLines**
Specifies the text string for the column header. You must ensure that the column headers match the column positions set in the Material List Definition (MLD) file.
- \ - Start a new line.
- | - Produce a vertical break.

The **HeaderLines** width is defined by the length of the last line, terminated with the pipe character (|). The length of the last line should be at least as long as the total width of data to be displayed below it.

Column description text in the **HeaderLines** field must lie in the column bounds as defined.

**Defines**
ISOGEN attribute

**Path**
Specifies a path to the summary file. Type the full path and filename.

**Defines**
ISOGEN attribute

**ShowHeaders**
Controls whether header lines are shown.
- **True** - Display header lines.
- **False** - Suppress the display of header lines.

**Defines**
ISOGEN attribute
ShowTitles
Specifies whether the title line is shown.
- **True** - Display the title line.
- **False** - Suppress the display of the title line.

Defines
ISOGEN attribute

TitleText
Specifies the text for the title.
Defines
ISOGEN attribute

UserDefined
Specifies whether the cut list summary file uses the properties of the summary file object to control the data and headings output to the material control file or if the old standard cut list summary file is created.
- **True** - Use the properties of the summary file object.
- **False** - Create the old standard material control file.

Defines
OS 23 Pos 4

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Summary File Collection (Cut List Summary File)**
Specifies the columns for a material list summary file.

**NOTE**  The value that displays in parentheses after the collection name is a count of how definitions are stored in the collection.

AttributeName
Specifies a property to appear in the column

Justification
Sets the alignment of the text. Specify **Left**, **Right**, or **Numeric**.

Start
Specifies the starting point of the column for the output data on a fixed format file, and specifies the field number for a delimited file.
MaxChars

Sets the width of the column.

Comment

Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value 1</th>
<th>Value 2</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-N0</td>
<td>396</td>
<td>2</td>
<td>PART-N0</td>
</tr>
<tr>
<td>N.S.</td>
<td>409</td>
<td>17</td>
<td>NOM. SIZE</td>
</tr>
<tr>
<td>Item Code</td>
<td>436</td>
<td>16</td>
<td>COMM. CODE</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>475</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>561</td>
<td>9</td>
<td>QUANTITY</td>
</tr>
</tbody>
</table>

The next example illustrates how the text comment is output to the relevant file.

STYLE3-DATA-ITEMS
'PT-N0' 396 2 | PART-N0
'N.S.' 409 17 | NOM. SIZE
'ITEM-CODE' 436 16 | COMM. CODE
'Description' 475 31
'QTY' 561 9 | QUANTITY

See Also

Appendix: Isometric Drawing Options (on page 415)

Supplementary Options

Sets options for various input and output files.

The Supplementary folder contains the following groups of options:

- **Additional Data** - Defines the DDF file. For more information, see Additional Data (Supplementary) (on page 610).
- **Auxiliary Programs** - Lists programs that run before or after ISOGEN. For more information, see Auxiliary Programs (Supplementary) (on page 611).
- **Bending Report** - Activates and configures the bending report. For more information, see Bending Report (Supplementary) (on page 612).
- **Centre of Gravity** - Specifies options about the center of gravity for pipes. For more information, see Centre of Gravity (Supplementary) (on page 613).
- **Data Files** - Provides the names of input data files that ISOGEN uses in various functions. For more information, see Data Files (Supplementary) (on page 615).
- **Detail Sketches** - Defines detail sketches on the isometric drawing. For more information, see Detail Sketches (Supplementary) (on page 615).
- **Drawing Information File** - Stores the definitions for the Drawing Information Cross Reference output file in the DwgInfoFile collection. For more information, see Drawing Information File (Supplementary) (on page 622).
Appendix: Isometric Drawing Options

- **Fonts** - Controls the use of the ISOGEN font information file. If required, it can be used to turn Off the use of fonts in the ISOGEN output files. For more information, see Fonts (Supplementary) (on page 623).

- **Heat Treatment** - Sets up heat treatment /NDE testing data. For more information, see Heat Treatment (Supplementary) (on page 623).

- **Instrument SKEYs** - Specifies user-defined symbol keys. ISOGEN treats these keys as instruments. For more information, see Instrument SKEYs (Supplementary) (on page 624).

- **Pipeline Attributes** - Defines the PIPELINE-REFERENCE-LOCATION-DEFINITION attribute in the data definition file (DDF). For more information, see Pipeline Attributes (Supplementary) (on page 629).

- **Reference Planes** - Defines reference planes on the isometric drawing. For more information, see Reference Planes (Supplementary) (on page 629).

- **Report Files** - Provides the names of supplementary output files. For more information, see Report Files (Supplementary) (on page 634).

- **Site Weld File** - Defines the site weld file. For more information, see Site Weld File (Supplementary) (on page 635).

- **Spool Attributes** - Defines the data required for the output of spool attributes data on the isometric and to summary report files, such as the spool Information file. For more information, see Spool Attributes (Supplementary) (on page 637).

- **Spool Information** - Stores the definitions for the spool information file in the Columns collection. For more information, see Spool Information (Supplementary) (on page 638).

- **Table Attributes** - Stores the definitions of the DFTable Attributes. For more information, see Table Attributes (Supplementary) (on page 640).

- **Title Texts** - Specifies user-defined text strings to be plotted on an ISOGEN-generated drawing frame. The Visible option for the drawing frame must be set to False. For more information, see Title Texts (Supplementary) (on page 642).

- **Traceability** - Defines a unique part numbers table that can be output on the isometric drawing and a traceability output file. For more information, see Traceability (Supplementary) (on page 643).

- **Printed Material List** - Defines the header content of the printed material list. For more information, see Printed Material List (Supplementary) (on page 645).

- **Neutral File** - Defines the basic format and content of the Neutral report file. For more information, see Neutral File (Supplementary) (on page 624).

See Also
Appendix: Isometric Drawing Options (on page 415)

**Additional Data (Supplementary)**

Defines additional data for the Data Definition file (DDF).

**DDFLines**

Specifies a block of text to be added to the Data Definition File (DDF).

**Defines**

ISOGEN attribute
Appendix: Isometric Drawing Options

Enabled

Controls whether the data in the property DDFLines is added to the Drawing Definition file (DDF).

- True - Include the data.
- False - Exclude the data.

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

Auxiliary Programs (Supplementary)

Specifies information about pre- and post-processor programs.

EndProgram

Specifies a post-processor application to run after Personal ISOGEN finishes processing. Type the full path location and filename of the required file.

Defines
ISOGEN attribute

PodGraphicsProgram

Specifies an external program to run before ISOGEN's output is translated to the final drawing output, which allows you to complete some minor editing of the drawing output.

Defines
ISOGEN attribute

PodGraphicsTimeout

Specifies the number of seconds before the external program specified by PodGraphicsProgram is terminated and ISOGEN begins processing.

Defines
ISOGEN attribute

StartProgram

Specifies the pre-processor application to run before Personal ISOGEN. Type the full path location and filename of the required file.

Defines
ISOGEN attribute

StartTimeout

Defines the number of seconds that elapse before the pre-processor application specified by the StartProgram setting is terminated and ISOGEN begins processing. Type the required value (integer). The default time is 60 seconds.
Appendix: Isometric Drawing Options

Defines
ISOGEN attribute

StopOnError
Controls whether Personal ISOGEN runs if the pre-processor application experiences an error and fails.
- **True** - Suppress running Personal ISOGEN if the pre-processor application fails.
- **False** - Run Personal ISOGEN even if the pre-processor application fails.

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

Bending Report (Supplementary)
Controls options for bending pipe reports.

Append
Defines whether the file is opened in appended mode or overwrite mode.
- **True** - Append the file.
- **False** - Overwrite the file.

Defines
ISOGEN attribute

Enabled
Controls whether the properties bending report is created.
- **True** - Create the file.
- **False** - Suppress creation of the file.

Defines
ISOGEN attribute

Path
Provides the path to the Bending report. Type the full path and filename of the report.

Defines
ISOGEN attribute

ReportContents
Determines the information included in the Bending Report.
- **Standard** - Include pipe fabrication information including details of each cut piece, listing the length, diameter, end preparation, material part number, and other related details to assist
manufacturing. In addition bending information giving distances to/between bends, angle and radius details are also output.

- **Full** - Include the same pipe fabrication information as with **Standard**, with the addition of details to enable profiling the shaped ends of pipe and the cutting of holes, such as for tees, olets, crosses, and so on.

**Defines**

ISOGEN attribute

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

### Centre of Gravity (Supplementary)

Specifies options for center of gravity and weight calculations.

**Enabled**

Controls whether any centre-of-gravity and weight calculations are done.

- **True** - Calculate those centre-of-gravity and weight calculations which are set by **ForDryPipe**, **ForWetPipe**, **ShowInsulationWeight** and **ShowWetWeight**.
- **False** - Suppress all four centre-of-gravity and weight calculations.

**Defines**

OS 82 Pos 1

**ForDryPipe**

Controls which centre-of-gravity calculations are done for dry (empty) pipe. Calculated values can then be output on the drawing using text positioning facilities, or output in a Weight/CoG summary report.

- **Not Required** - Centre-of-gravity for dry pipe not required.
- **Calc C of G** - Calculate centre-of-gravity for dry pipe.
- **Calc C of G with Insulation** - Calculate centre-of-gravity for insulated dry pipe.
- **Calc C of G with and without Insulation** - Calculate centre-of-gravity for dry pipe and insulated dry pipe.

**Defines**

OS 82 Pos 4

**ForWetPipe**

Controls which centre-of-gravity calculations are done for wet (full) pipe. Calculated values can then be output on the drawing using text positioning facilities or output in a Weight/CoG summary report.

- **Not Required** - Centre-of-gravity for wet pipe not required.
Appendix: Isometric Drawing Options

- **Calc C of G** - Calculate centre-of-gravity for wet pipe.
- **Calc C of G with Insulation** - Calculate centre-of-gravity for insulated wet pipe.
- **Calc C of G with and without Insulation** - Calculate centre-of-gravity for wet pipe and insulated wet pipe.

**Defines**

OS 82 Pos 5

**PerPipeLine**

Controls whether the centre-of-gravity and weight calculations are per pipeline or per drawing/spool.

**NOTE** **Enabled** must also be set to **True**.

- **True** - Calculations are per pipeline.
- **False** - Calculations are per drawing/spool.

**Defines**

OS 82 Pos 1

**ShowInsulationWeight**

Controls whether insulation weight is calculated. Insulation weight can then be output on the drawing using text positioning facilities or in a Weight/CofG summary report.

- **True** - Calculate insulation weight.
- **False** - Suppress the calculation of Insulation weight.

**Defines**

OS 82 Pos 3

**ShowWetWeight**

Controls whether wet (full) weight is calculated. Wet weight can then be output on the drawing using text positioning facilities or in a Weight/CofG summary report.

- **True** - Calculate wet weight.
- **False** - Suppress calculation of wet weight.

**Defines**

OS 82 Pos 2

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)
Appendix: Isometric Drawing Options

Data Files (Supplementary)
Contains a collection of options that are used to store the names of the input files used by ISOGEN. For more information, see Data Files Collection (Supplementary Data Files) (on page 615).

Count
Displays the number of data entries stored in the Data Files collection.

Data Files Collection (Supplementary Data Files)
Provides the names of input and output data files ISOGEN uses in various functions. For example, ISOGEN can calculate weights of components if a data file containing weight information is available.

NOTE The value that displays in parentheses after the collection name is a count of how many definitions are stored in the collection.

FileType
Specifies the type of input file.

FilePath
Browses your computer or network for a file name.

FileText
Allows you to edit the contents of the text file.

See Also
Appendix: Isometric Drawing Options (on page 415)

Detail Sketches (Supplementary)
Specifies the characteristics of detail sketches on the isometric drawing.
The Detail Sketches (Supplementary) folder also contains the following groups of options:

Local Sketches - Stores the properties for local detail sketches and information notes. For more information, see Local Sketches (Supplementary Detail Sketches) (on page 621).

Colour
Sets the drawing colour for the detail sketch. This value is expressed as an integer number representing the colour number as defined in the output drawing system (MicroStation or AutoCAD).

Defines
ISOGEN attribute
Appendix: Isometric Drawing Options

FileFormat
Sets the format of the detail sketch symbols. In most cases, this setting agrees with the drawing output format.

NOTE The IGR option corresponds with the Intergraph SmartSketch product.

Defines
ISOGEN attribute

LabelLayer
Specifies the layer on which the label text resides. For example, the label text in Detail A is the letter A.

Defines
ISOGEN attribute

LabelType
Specifies whether you want sketches ordered alphabetically (A, B, C...) or numerically (1, 2, 3...).

- Alpha - Order sketches alphabetically.

- Number - Order sketches numerically.

Defines
ISOGEN attribute
Appendix: Isometric Drawing Options

**LabelX**
Provides the X-coordinate of the label text, relative to the bottom left corner of a sketch.

![Sketch Origin Diagram]

The Sketch origin is always at the bottom LH corner.

Type a value (real number) in millimeters.

**Defines**
ISOGEN attribute

**LabelY**
Provides the Y-coordinate of the label text, relative to the bottom left corner of a sketch. Type a value (real number) in millimeters.

**NoteFormat**
Specifies the format of informational notes, which refer to a pipeline, spool, or component in the drawing.

**Defines**
ISOGEN attribute

**NoteHeight**
Specifies the height of the informational notes. Type a value (as a real number) in millimeters.

![Note Width Diagram]

**Defines**
ISOGEN attribute
NotePosition
Specifies the location of informational notes.
- Default - Plots notes along the bottom of the drawing.
- Local - Plots notes along the bottom of the isometric, near the reference.
- OverFlow - In the case of duplicate occurrences, only one copy of each unique information note is output on a single isometric.

Defines
ISOGEN attribute

NoteWidth
Specifies the height of the informational notes. Type a value (as a real number) in millimeters.

Defines
ISOGEN attribute

Path
Defines the full path to the detail sketch folder containing SYM or DXF data, or sets the location of a DGN CEL file, which is a cell library.

NOTE Specify the symbol filename in Supplementary.Detail Sketches.SketchMapping (SketchSymbol column).

Defines
ISOGEN attribute

PositionFix
This style setting is not used in the current version of the software.
- False - Observes normal detail sketch placement—sketches run right to left along the top of the drawing border.
**SketchHeight**
Sets the height of user-generated sketches. This setting must be the same for all sketches. Type a value in millimeters. The value can be an integer or decimal number but should not exceed 50 mm.

**Defines**
ISOGEN attribute

**SketchPosition**
Defines the location of detail sketches on the isometric drawing.

- **Default** - Plots detail sketches along the top of the drawing. The horizontal positioning of the detail sketches is controlled by the North arrow setting. Under normal circumstances, ISOGEN displays the sketches from right to left (Figure 1). However, if there is no North arrow, the sketches are displayed from left to right (Figure 2), as shown in the figures below.

- **Fixed** - Plots detail sketches along the top of the drawing from right to left, regardless of the position of the North arrow.
- **Local** - Plots detail sketches as close as possible to the related pipeline component.
- **Overflow** - Overflows detail sketches to a separate sheet.

**Defines**
ISOGEN attribute
Appendix: Isometric Drawing Options

**SketchWidth**
Sets the width of user-generated sketches. Type a value in millimeters. The value can be an integer or decimal number but should not exceed 50 mm.

**Defines**
ISOGEN attribute

**TextFont**
Specifies a font corresponding to a font entry in the .fif file.

**Defines**
ISOGEN attribute

**TextHeight**
Specifies the size of the label text. Type a value in millimeters. The value can be an integer or real number. This setting overrides `Drawing.Format.TextSize`.

**Defines**
ISOGEN attribute

**TextWeight**
Controls the character thickness. Specify a value between 1 and 9.

**Defines**
ISOGEN attribute
See Also
Appendix: Isometric Drawing Options (on page 415)

Local Sketches (Supplementary Detail Sketches)
Stores the properties for local detail sketches and information notes.

ID
Specifies the detail sketch or Information note string identifier. The following are examples:

- **Detail Sketch** - SK1.dxf
- **Information Note** - note_N.dxf or note_S.dxf

**NOTES**
- For AutoCAD and SmartSketch, the file format extension must be shown in the ID, such as SK1.dxf or SK1.igr.
- For MicroStation, specify just the name of the sketch as found in the graphic cell library, as in SK1.
- Inclusion of _N - as in GenNote_N.dxf or GenNote_N - as part of the information note name signifies a general note, which is output on every sheet.
- Inclusion of _S - as in SpecNote_S.dxf or SpecNote_S - signifies a specific note, which is only output on the sheet on which the component having this particular note attached is output.

Height
Specifies a single value for the height of the detail sketch / Information note in mm.

Width
Defines the width of the detail sketch/information note. Specify a single value in mm.

LabelX
Specifies the horizontal cross-reference position measured from the bottom left corner of the detail sketch in mm.

LabelY
Specifies the vertical cross-reference position measured from the bottom left corner of the detail sketch in mm.

TextHeight
Sets the text height to be used. Type a value (real number) in mm or inches.
Appendix: Isometric Drawing Options

Drawing Information File (Supplementary)

The DwgInfoFile (Supplementary) folder stores the definitions for the Drawing Information Cross Reference output file in the DwgInfoFile collection.

Enabled
Controls whether a file is created.
- **True** - File is created.
- **False** - File is not created.

Path
Specifies the full path location and filename of the appropriate file. You can use the **Browse** button to navigate to the file.

HeaderLines
Specifies the text string for the column header.
- \ - Starts a new line.
- | - Produces a vertical break.

**NOTE** You must ensure that the column headers match the column positions set in the material list definition (MLD) file.

Count
Displays the number of columns in the Drawing Information Cross Reference file to be output.

DwgInfoFile Collection (Supplementary DwgInfoFile)

Store the definitions of the data to be output to the Drawing Cross Reference summary report file.

AttributeName
Specifies the name of the attribute to be output to the drawing information file.

Justification
Sets the alignment of the text. Specify **Left** or **Right**.

Start
Specifies the character position at which the attribute is output.

MaxChars
Defines the maximum number of characters to be output.
Comment
Outputs the specified text as a comment--preceded by a "!"--to the relevant data or summary report file.

Fonts (Supplementary)
Controls the use of the ISOGEN font information file. If required, it can be used to turn Off the use of fonts in the ISOGEN output files.
By default, there is always a path to the supplementary fonts file. If one does not exist - for example, you delete it - it is recreated automatically. However, if you set the Enabled switch, this setting is persisted.

Enabled
Controls whether fonts are enabled.
- True - Enable fonts.
- False - Disable fonts.

Path
Specifies the full path location and filename for the ISOGEN font information file (.fif).

Heat Treatment (Supplementary)
Enabled
Controls whether the heat treatment/NDE file is created.
- True - Create the file.
- False - Suppress creation of the file.

Path
Specifies the full path location and filename for the heat treatment/NDE file.

Text
Specifies the data required for heat treatment/NDE testing. Type the required data in the Text box. This data is written to the data definition file (DDF) when Enabled is set to True.
Instrument SKEYs (Supplementary)

Specifies user-defined symbol keys.

ISKEYText

Specifies a symbol key text string.

See Also
Appendix: Isometric Drawing Options (on page 415)

Neutral File (Supplementary)

Controls the basic format and content of the Neutral report file.

The Neutral File folder also contains the following groups of options:

- Neutral File Output - Controls which groups of components are output in the Neutral report file. For more information, see Neutral File Output (Supplementary) (on page 626).

- Neutral File Collection - Stores the content and format of each record to written to the Neutral report file. For more information, see Neutral File Collection (Supplementary) (on page 628).

Append

Controls whether the file is opened in appended mode or overwrite mode. The default setting is False.

- True - Append the file.
- False - Overwrite the file.

Count

Displays the number of entries stored in the Neutral File collection.

Delimiter

Defines the separator used between each record in the Neutral report file. Defining this option is only necessary when Supplementary.NeutralFile.FileFormat is set to Fixed. The possible characters are listed below. The default setting is Semi Colon.

- Tab
- Comma (Field1,Field2,Field3)
- Semi Colon (Field1;Field2;Field3)

Enabled

Controls creation of the Neutral report file. The default setting is FALSE.

- True - Create the Neutral report file.
- False - Suppress creation of the Neutral report file.
Appendix: Isometric Drawing Options

**FileFormat**
Defines the format of the output file. The default setting is **Fixed**.

- **Delimited** - Output a delimited file. Use the field separator defined by `NeutralFile.Delimiter`.

- **Fixed** - Output a fixed format file.

**GroupBy**
Specifies how components are grouped in the Neutral report file. The default setting is **Pipeline**.

- **Pipeline** - Group component output on a per pipeline basis.

- **Sheet** - Group component output on a per sheet basis.

**HeaderLines**
Controls the column header text in the report file. Specify the text string for the column header.

**NOTE** Make sure that the column headers match the column positions when you use this option.

**OutputCutPieces**
Controls whether components are output grouped by cut piece. The default setting is **False**.

- **True** - Output components to the report file grouped by cut piece.

- **False** - Suppress grouping of components by cut piece. Each component has its own entry in the Neutral report file.

**NOTE** To illustrate, consider the component grouping Pipe-Pulled Bend-Pipe. Because these three components form a single cut piece, if `NeutralFile.OutputCutPieces` is set to **True**, only one entry is written to the Neutral report file. However, if `NeutralFile.OutputCutPieces` is set to **False**, three entries are written to the report file—one for each component.

**Path**
Specifies the full path location and filename of the Neutral report file. Type the full path and file name.

**NOTE** Do not include special characters in the Neutral report filename.

**RecordLength**
Defines the length of each record. This option is only applicable when `NeutralFile.FileFormat` is set to **Fixed**.

- **0** - Trim trailing white space from each record.

- **Value** - Pad or truncate, as appropriate, to the number of characters specified. Type a real number in the range of 1 to 9999.
Neutral File Output (Supplementary)

Controls which groups of components are output in the Neutral report file.

Bolts

Controls the output of bolt components in the Neutral report file. The default setting is include.

- Include - Output bolt components to the report file.
- Exclude - Suppress the output of bolt components.

Default

Controls the output of components in the Neutral report file.

- Include - Output all components to the report file. This is the default setting.
- Exclude - Suppress the output of all components.

**NOTES**

- This option implies all components. However, you can use the individual group type setting to override Supplementary.NeutralFile.Output.Default. The table below illustrates the relationship between the Default setting and the settings of the individual group types.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Setting</th>
<th>Report File Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Include</td>
<td>Output all components.</td>
</tr>
<tr>
<td>Default</td>
<td>Exclude</td>
<td>Output all components except</td>
</tr>
<tr>
<td>Bolts</td>
<td></td>
<td>bolts.</td>
</tr>
<tr>
<td>Default</td>
<td>Exclude</td>
<td>Suppress output of all</td>
</tr>
<tr>
<td>Flanges</td>
<td>Include</td>
<td>components except flanges.</td>
</tr>
</tbody>
</table>

- Penetration plates and pseudo-components, such as set on tees and taps, are not output to the Neutral report file.

Fittings

Controls the output of fittings in the Neutral report file. The default setting is include.

- Include - Output fittings to the report file.
- Exclude - Suppress the output of fittings.

Flanges

Controls the output of flange components in the Neutral report file. The default setting is include.

- Include - Output flange components to the report file.
- Exclude - Suppress the output of flange components.
Appendix: Isometric Drawing Options

- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`.

**Gaskets**
Controls the output of gasket components in the Neutral report file. The default setting is **Include**.
- **Include** - Output gasket components to the report file.
- **Exclude** - Suppress the output of gasket components.
- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`.

**Instruments**
Controls the output of instrument components in the Neutral report file. The default setting is **Include**.
- **Include** - Output instrument components to the report file.
- **Exclude** - Suppress the output of instrument components.
- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`.

**Miscellaneous**
Controls the output of miscellaneous components in the Neutral report file. The default setting is **Include**.
- **Include** - Output miscellaneous components to the report file.
- **Exclude** - Suppress the output of miscellaneous components.
- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`.

**Pipe**
Controls the output of pipe components in the Neutral report file. The default setting is **Include**.
- **Include** - Output pipe components to the report file.
- **Exclude** - Suppress the output of pipe components.
- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`.

**Supports**
Controls the output of supports in the Neutral report file. The default setting is **Include**.
- **Include** - Output supports to the report file.
- **Exclude** - Suppress the output of supports.
- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`.

**Valves**
Controls the output of valve components in the Neutral report file. The default setting is **Include**.
- **Include** - Output valve components to the report file.
- **Exclude** - Suppress the output of valve components.
- **Inherit** - Use the setting defined in `Supplementary.NeutralFile.Output.Default`. 
Appendix: Isometric Drawing Options

Welds
Controls the output of welds in the Neutral report file. The default setting is Include.

- **Include** - Output welds to the report file.
- **Exclude** - Suppress the output of welds.
- **Inherit** - Use the setting defined in Supplementary.NeutralFile.Output.Default.

Neutral File Collection (Supplementary)
Stores the content and format of each record to be written to the Neutral report file.

Group
Specifies the component group output in the current report file record. Select a component group in the list:

- Default
- Bolts
- Fittings
- Flanges
- Gaskets
- Instruments
- Miscellaneous
- Pipe
- Supports
- Valves
- Welds

Enabled
Controls the display of data in the report file for the component group defined by the Supplementary.NeutralFile.NeutralFile.Group setting.

- **True** - Display component data for the specified group.
- **False** - Suppress the display of component data for the specified group.

Start
Specifies the starting point of the column. The valid range is 1-999.

MaxChars
Specifies the maximum number of characters allowed per column.

Context
Defines the mechanism by which Neutral file data is accessed. Acceptable values are:
Appendix: Isometric Drawing Options

- POD
- Pipeline
- Component
- Material

**NOTE** You must use the correct context and attribute name combination. If the combination expressed by the Supplementary.NeutralFile.NeutralFile. Context and Supplementary.NeutralFile.NeutralFile.AttributeName settings does not exist, the report file displays a blank value.

**AttributeName**
Specifies the name of the attribute being defined. Use the **AttributeName** list to select the required attribute.

### Pipeline Attributes (Supplementary)

**Enabled**
Controls whether a file is created.
- **True** - Create the file.
- **False** - Suppress creation of the file.

**Path**
Specifies the full path location and filename for the pipeline attributes file.

**Text**
Type in the data required for the PIPELINE-REFERENCE-LOCATION-DEFINITION. This data is written to the Data Definition file (DDF) when **Enabled** is set to **True**.

### Reference Planes (Supplementary)

Defines reference planes for the Reference Plane Definition file (RPDF). The Reference Planes options provide the ability to reference grids for coordinate callouts on isometric drawings. You also have the option to override world coordinates in the coordinate callouts on the isometric drawing. If you are using location points, they honor the **Supplementary.ReferencePlanes** options, as do all end-point coordinates displayed on the drawing.

In marine mode, location points allow you to insert markers anywhere along the pipeline to indicate the requirement for a location point symbol and to identify text to be output on the plotted isometric drawing. The software uses the location point input to calculate a coordinate offset to the nearest grid point from a predefined matrix of reference planes.
Using reference planes, you can output location points and other pipeline coordinates relative to the nearest reference plane in each of the three directions: X (forward and aft), Y (transverse), and Z (elevation). An example of ship reference planes as they relate to internal structure is shown below:

![Isometric Drawing Example](image)

Alternative Text (AText) records -443 through -448 are assigned to output relative directions. The representation of relative directions on the isometric drawing is done by setting the AText record as shown below, where the question mark character ( ? ) is the distance from the nearest reference plane and the caret character ( ^ ) is the reference plane name:

-443  +?/^  
-444  -?/^  
-445  +?/^  
-446  -?/^  
-447  +?/^  
-448  -?/^  

An example of the output of relative directions on the isometric drawing is shown below:
Appendix: Isometric Drawing Options

NOTE For more information about AText records, see Appendix: AText Reference Data (on page 816).

Reference Plane Definition Files (RPDF)

NOTE If you are using reference plane definition (Supplementary.ReferencePlanes.Enabled = True), you must also specify the Reference Plane Definition file location with the Supplementary.DataFiles option. For more information, see Data Files (Supplementary) (on page 615).

The Reference Plane Definition file (RPDF) is an input text file, not an output file. The text file enables you to specify the vertical and horizontal positions from which location points can be related. Relative locations in the vertical plane (Z-plane) can be from the nearest plane or from the plane below. To control which option the software uses, you must add one of the following entries to the RPD file: NEAREST-A-PLANE or LOWER-Z-PLANE. Below is a sample Smart 3D marine mode RPD file:

```
FRAMEWORK-UNITS FEET
X-PLANES
LS02  2.0
LS01  1.0
CL    0
LP01  -3.0
LP02  -2.0

Y-PLANES
FRA   0
FRB   -1.0
FRC   -2.0
FRO   -3.0
FRE   -4.0
FRF   -5.0
FRG   -6.0
FRH   -7.0
FRI   -8.0

Z-PLANES
MAINDK 2.0
DK1    1.0
DK2    0
DK3    -1.0
BASE   -2.0

NEAREST-Z-PLANE
```

NOTE Use the SPACE bar to separate the plane name and its position.

Sub-Volumes

In marine mode, the reference plane system can also support sub-volumes. Each sub-volume is defined by assigning a name, an optional priority, and a bounding box defined by two sets of coordinates. The coordinates that define the bounding box are taken as the ends of a diagonal through a box aligned with a principle axis. Within each sub-volume, you can define a set of X, Y and Z plane reference data.

If a location point or other coordinate is output to the isometric drawing, the reference system the software uses is obtained from the highest priority sub-volume in which the point is found. If the point is not in any of the sub-volumes, the software determines its reference point from the global reference system.
If a component is located near, but outside, the boundaries of all the sub-volume boundaries, the component is usually reported with reference to the grid planes of the master volume. However, there is an option to define a tolerance for the boundary planes. For example, if a line routing is 1m out of a building, it may make more sense to reference the components to the building and not to the absolute master coordinates. If no tolerance is defined, the tolerance defaults to zero.

Enabling sub-volumes requires that you include additional data in the RPD file. The file can contain global and sub-volume information. You must input the data using the following sequence:

1. Unit data
2. Global data
3. Volume data
4. Volume data

The sample syntax below shows a new sub-volume called V1 (in bold):

```
FRAMEWORK-UNITS MMS
X-PLANES
GLOBAL_X1 E500

Y-PLANES
GLOBAL_Y1 N500

Z-PLANES
GLOBAL_Z1 EL500

NEAREST-Z-PLANE

VOLUME V1
PRIORITY 1
LIMIT1 20000 1800 0
LIMIT2 32000 13800 12500

X-PLANES
V1_X1 E20000
V1_X2 E23000
V1_X3 E26000
V1_X4 E29000
V1_X5 E32000

Y-PLANES
V1_Y1 N1800
V1_Y2 N5800
V1_Y3 N9800
V1_Y4 N13800

Z-PLANES
V1_EL1 EL0
V1_EL2 EL2500
V1_EL3 EL5000
V1_EL4 EL7500
V1_EL5 EL10000
V1_EL6 EL12500
```
Appendix: Isometric Drawing Options

NEAREST-Z-PLANE

NOTES

- If you set `Supplementary.ReferencePlanes.Enabled` to `True`, you must specify the location of the input data file. It is recommended that the Reference Plane Definition file be located on a share, such as the SharedContent share, so that it can be used by multiple clients. The extension of the file is not important, but for recognition purposes, you may want to use the extension .rpdl.

- If the `Supplementary.ReferencePlanes.Enabled` to `True` but no file is specified using `Supplementary.DataFiles`, the relative coordinates cannot be called out in the isometric drawing.

- If the isometric drawing's `Coordinate System` property is set to `CS_2`, the `World Coordinates` value for `CoordStyle` and `CoordStyleAtLocationPts` corresponds to the `CS_2` coordinate system, not global coordinates. To check this property setting, right-click the isometric drawing in the `Detail View` and select `Properties`. On the `Properties` dialog box, go to the `Style` tab to review the `Coordinate System` setting. For more information, see `Style Tab (Properties Dialog Box)` (on page 51).

Reference Plane options are listed below:

**CoordStyle**

Specifies the reference plane coordinate style to be used in the RPDF.

- **World Coordinates** - Return coordinates with respect to the global coordinate system.
- **Relative Coordinates** - Return coordinates (on the isometric drawing) with respect to the volume referenced in the RPDF.

**Defines**

OS 66 Pos 7

**CoordStyleAtLocationPts**

Specifies the coordinate style used for location points.

- **None** - Suppress the display of coordinates at location points.
  - **World Coordinates** - Return location point coordinates with respect to the global coordinate system.
  - **Relative Coordinates** - Return location point coordinates (on the isometric drawing) with respect to the volume referenced in the RPDF.

**Defines**

OS 66 Pos 7

**Enabled**

Controls processing of the reference plane data.

- **True** - Enable processing of the reference plane data.
- **False** - Suppresses processing of the reference plane data.
LocationPtStyle
Specifies the style used for location points on the isometric drawing.

- **Special Text Symbol (****)** - Show a box containing “****”.
- **Square Ended Box** - Show a box containing the contents of AText –nnn, such as AText -471 LOCATION$POINT?

Defines
OS 123 Pos 4

Path
Specifies the filename and full path location to the reference plane definition file.

Defines
ISOGEN attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

Report Files (Supplementary)
Provides the names of supplementary output files. One example is a file containing centerline lengths.

**NOTE** To add a new row to the grid, click in the blank area of the right pane, and press Insert on the keyboard.

FileType
Specifies the type of output file. In some cases, this option also specifies the behavior of the file, such as append or overwrite.
FilePath
Browses your computer or network for a file name.

FileText
Allows you to edit the contents of the text file.

See Also
Appendix: Isometric Drawing Options (on page 415)

Site Weld File (Supplementary)

Specifies information about the site weld file.
The Site Weld File (Supplementary) folder also contains a collection of options that define the columns for the site weld file. For more information, see Site Weld File Collection (Supplementary Site Weld File) (on page 636).

Count
Displays the number of data entries stored in the Site Weld File collection.

Delimiter
Specifies a delimiter to use for the header lines that appear at the top of a SiteWeldInfo file. The possible characters are
- Blank
- Comma (,)
- Semi-colon (;)
- Colon (:)

Defines
ISOGEN attribute

Enabled
Controls whether site weld file is created.
- True - Create the file.
- False - Suppress creation of the file.

Defines
ISOGEN attribute

FileFormat
Sets the format of the site weld file.
- Fixed - Output a fixed format file.
- Delimited - Output a delimited file.

Defines
ISOGEN attribute

**HeaderLines**
Specifies the text string for the column header.
- \ - Start a new line.
- | - Produce a vertical break.

**NOTE** You must make sure the column headers match the column positions set in the Material List Definition (MLD) file.

**Defines**
ISOGEN attribute

**Path**
Provides the path to the site weld file. Type the full path and filename of the file.

**Defines**
ISOGEN attribute

**ShowTitles**
Specifies whether the title line is shown.
- **True** - Display the title line.
- **False** - Suppress the display of the title line.

**TitleText**
Specifies text for the title.

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Site Weld File Collection (Supplementary Site Weld File)**
Specifies the columns for the site weld file.

**NOTE** The value that displays in parentheses after the collection name is a count of how definitions are stored in the collection.

**AttributeName**
Specifies a property to appear in the column. Use the **AttributeName** list to select the required attribute.

**Justification**
Sets the alignment of the text. Specify **Left**, **Numeric**, or **Right**.

**Start**
Specifies the starting point of the column. The valid range is 1-999.
MaxChars
Sets the width of the column. The width must be zero or greater.

Comment
Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>MaxChars</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-NO</td>
<td>396</td>
<td>2</td>
<td>PART-NO</td>
</tr>
<tr>
<td>N.S.</td>
<td>409</td>
<td>17</td>
<td>NOM. SIZE</td>
</tr>
<tr>
<td>Item Code</td>
<td>436</td>
<td>16</td>
<td>COMM. CODE</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>475</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>561</td>
<td>9</td>
<td>QUANTITY</td>
</tr>
</tbody>
</table>

The next example illustrates how the text comment is output to the relevant file.

STYLE3-DATA-ITEMS
'PT-NO' 396 2 | PART-NO
'N.S.' 409 17 | NOM. SIZE
'ITEM-CODE' 436 16 | COMM. CODE
'DESCRIPTION' 475 31
'QTY' 561 9 | QUANTITY

See Also
Appendix: Isometric Drawing Options (on page 415)

Spool Attributes (Supplementary)
Defines the data required for the output of spool attributes data on the isometric and to summary report files, such as the spool information file.

The Spool Attributes (Supplementary) folder also contains a collection of options that are used to control the assignment of enclosure styles to spool attributes used to plot them on the isometric. For more information, see Spool Attributes Enclosures (Supplementary Spool Attributes) (on page 638).

Enabled
Controls the creation of spool attributes.
  ▪ **True** - Attributes are created.
  ▪ **False** - Attributes are not created.

Path
Specifies the filename and full path location to the spool attribute file.

ReferenceIDLocation
Sets the spool record as the key to map spool attributes.
  ▪ **Value** - Spool records for possible mapping to spool attribute file:
The following is an example of the typical input in the DDF file:

```
SPOOL-REFERENCE-LOCATION-DEFINITION
RECORD-ID -28
```

**Count**
Displays the number of Spool Attributes Enclosures definitions defined.

**Spool Attributes Enclosures (Supplementary Spool Attributes)**
Controls the assignment of enclosure styles to spool attributes used to plot them on the isometric.

**NOTE** The value that appears in parentheses after the collection name is a count of how many definitions are stored in the collection.

**EnclosureType**
Specify the name of the enclosure type. Use the EnclosureType list to select the required description.

**AttributeName**
Specifies the name of the attribute being defined. Use the AttributeName list to select the required attribute.

**Spool Information (Supplementary)**
Stores the definitions for the spool information file in the Columns collection.

The Spool Information (Supplementary) folder also contains the following collection of options that are used to store the definitions of the data to be output to the spool information file. For more information, see Spool Information Collection (Supplementary Spool Information) (on page 639).

**Append**
Defines whether the file is opened in appended mode or overwrite mode.

- **True** - Append the file.
- **False** - Overwrite the file.

**Count**
Displays the number of data entries stored in the Spool Information collection.

**Delimiter**
Defines the character used as a delimiter when the file format is delimited. The possible characters are

- **Blank**
- **Comma (,)**
Appendix: Isometric Drawing Options

- Semi-colon (;)
- Colon (:)

Enabled
Controls whether the creation of the spool information file.
- **True** - File is created.
- **False** - File is not created.

FileFormat
Defines the format of the output file.
- **Fixed** - Outputs a fixed format file.
- **Delimited** - Output a delimited file.

HeaderLines
Specify the text string for the column header.
- \ - Starts a new line.
| - Produces a vertical break.

Path
Specifies the filename and full path location to the spool information file.

ShowTitles
Specifies whether the title line is shown.
- **True** - Display the title line.
- **False** - Suppress the display of the title line.

TitleText
Specifies text for the title.

**Spool Information Collection (Supplementary Spool Information)**
Stores the definitions of the data to be output to the spool information file.

**NOTE** The value that appears in parentheses after the collection name is a count of how many definitions are stored in the collection.

AttributeName
Specifies the name of the attribute being defined. Use the **AttributeName** list to select the required attribute.

Justification
Sets the alignment of the text. Specify **Left** or **Right**.
Appendix: Isometric Drawing Options

Start
Defines the start column for the output data on a fixed format file, and specifies a field number for a delimited file.

MaxChars
Defines the maximum number of characters.

Comment
Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

In the example below, a text comment has been specified for the part number, nominal size, item code, and quantity attributes.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Start</th>
<th>MaxChars</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT-NO</td>
<td>0</td>
<td>2</td>
<td>PART-NUM</td>
</tr>
<tr>
<td>N.S.</td>
<td>13</td>
<td>17</td>
<td>NOM. SIZE</td>
</tr>
<tr>
<td>Item Code</td>
<td>40</td>
<td>19</td>
<td>COMM. CODE</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>79</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>QTY</td>
<td>165</td>
<td>9</td>
<td>QUANTITY</td>
</tr>
</tbody>
</table>

The next example illustrates how the text comment is output to the relevant file.

STYLE3–DATA–ITEMS
'PT-NO' 396 2 ! PART-NO
'N.S.' 409 17 ! NOM. SIZE
'ITEM-CODE' 436 16 ! COMM. CODE
'DESCRIPTION' 475 31
'QTY' 561 9 ! QUANTITY

Table Attributes (Supplementary)
Contains a collection of options that are used to store the definitions of the data to be output as a table on the isometric drawing. For more information, see Table Attributes Collection (Supplementary Table Attributes) (on page 641).

Count
Displays the number of definitions in the Table Attributes collection.
Table Attributes Collection (Supplementary Table Attributes)

Stores the definitions of the data to be output as a table on the isometric.

AttributeName
Specifies the name of the attribute being defined. Use the AttributeName list to select the required attribute.

CharHeight
Sets the character height for the text. Type the required size in mm or inches (as a real number).

XPos2
Defines the X position for the text in mm or inches.

YPos2
Defines the Y position for the text in mm or inches.

Font
Defines the font to be used when plotting the attribute in the table.

BarCode
Several barcode standards exist worldwide to suit different industries, but Alias has standardized on just three. Type 1, 2 or 3 for the appropriate barcode:
- 1 - Barcode 39
- 2 - Barcode 25
- 3 - Barcode 25 Interleaved

CharWidth
Sets the character height for the text. Type the required size in mm or inches (as a real number).

Justification
Sets the alignment of the text. Specify Left or Right.

Layer
Specify the integer number that identifies the required layer (in the Drawing.Layers Layers collection) to which the definition is applied.

Colour
Type the integer number that represent the colour number as defined in the output drawing system (MicroStation or AutoCAD).
RotationAngle
Defines the angle of rotation in degrees clockwise.

TextWeight
Controls the character thickness. Type a value between 1 and 9. Used for MicroStation only.

TruncationLength
Defines the number of output characters.

ColumnsNumber
Specifies the number of columns in the table.

Direction
Specifies the table direction.

LineNumber
Specifies the number of lines in the table.

XSpacing
Specifies the table offset dimension in X (horizontal) direction. Type a value in mm or inches (set as a real number). For example, you can type 50mm or 2.0 inch.

NOTE The value can be a negative number.

YSpacing
Specifies the table offset dimension in Y (vertical) direction. Type a value in mm or inches (set as a real number). For example, you can type 50mm or 2.0 inch.

NOTE The value can be a negative number.

Title Texts (Supplementary)
Specifies user-defined text strings for plotting on an ISOGEN-generated drawing frame.

Count
Displays the number of definitions in the Title Texts collection.

See Also
Appendix: Isometric Drawing Options (on page 415)
Traceability (Supplementary)

Defines a unique part numbers table that can be output on the isometric drawing and in a traceability output file.

The Traceability (Supplementary) folder also contains a collection of options that define the data output to the traceability file. For more information, see Traceability Collection (Supplementary Traceability) (on page 645).

ContinuousDown
Controls the direction of the unique part numbers table.
- **True** - Table direction is down.
- **False** - Table direction is up.

Count
Displays the number of definitions in the Traceability collection.

DrawingLayer
Sets the drawing layer for the unique part number table. Type a value in the range of 1 to 50.

Enabled
Controls the creation of the traceability file.
- **True** - Turn on the creation of the traceability file.
- **False** - Turn off the creation of the traceability file.

IdentifierSuffix
Controls sequencing of the IdentifierSuffix used for part numbering on the isometric.
- **Continuous** - Generate unique part number suffixes as a continuous sequence across all output drawings, such as 6.1 to 6.6 on Drg 1 of 2 and 6.7 to 6.11 on Drg 2 of 2, and so on.
- **PerDrawing** - Generate unique part number suffixes with a new sequence for each drawing, such as 6.1 to 6.6 on Drg 1 of 2 and 6.1 to 6.5 on Drg 2 of 2, and so on.

MaxEntries
Controls the maximum number of entries before an overflow drawing is created if the TableOverflow property is set to True.

Path
Defines the output location of the traceability file.

PlotUniquePtNoTable
Controls whether the unique part numbers table is plotted.
Appendix: Isometric Drawing Options

- **True** - Plot the table.
- **False** - Suppress plotting of the table.

**StartX**
Defines the starting X position of the list in mm or inches (as a real number).

**StartY**
Defines the starting Y position of the list in mm or inches (as a real number).

**TableOverflow**
Controls whether an overflow drawing is created when the **MaxEntries** setting is exceeded.
- **True** - Create an overflow drawing.
- **False** - Suppress creation of an overflow drawing.

**TextHeight**
Sets the text height to be used. Type a value (real number) in mm or inches.

**UniqueNosBolts**
Controls output of unique part numbers on bolts.
- **Yes** - Output unique part numbers on bolts.
- **No** - Suppress output of unique part numbers on bolts.

**UniqueNosGaskets**
Controls output of unique part numbers on gaskets.
- **Yes** - Output unique part numbers on gaskets.
- **No** - Suppress output of unique part numbers on gaskets.

**UniquePartNumber**
Controls the type of suffix used for the unique part number and whether unique part numbers are used.
- **Alpha** - Use an alphabetic suffix.
- **Numeric** - Use a numeric suffix.
- **Off** - Switch off all unique part number facilities.

**VerticalSpacing**
 Sets the vertical spacing between each horizontal line in mm or inches (as a real number).
**Traceability Collection (Supplementary Traceability)**

Stores the definitions of data for the output of unique part numbers.

**NOTE** The value that appears in parentheses after the collection name is a count of how many definitions are stored in the collection.

**AttributeName**

Specifies the name of the attribute being defined. Use the **AttributeName** list to select the required attribute.

**Justification**

Sets the alignment of the text. Specify **Left** or **Right**.

**Start**

Defines the start column for the output data on a fixed format file, and specifies a field number for a delimited file.

**MaxChars**

Defines the maximum number of characters.

**Comment**

Outputs a text comment for any definition contained in the previous columns. If any text is typed in this field, it is output as a comment--preceded by a !--to the relevant data or summary report file.

**Printed Material List (Supplementary)**

**Enabled**

Controls creation of the printed material list.

- **True** - Create the printed material list.
- **False** - Suppress creation of the printed material list.

**Path**

Specifies the filename and full path location to the printed material list.

**FileFormat**

Defines the format of the printed material list.

- **Fixed** - Output the printed material list in a fixed format.
- **Delimited** - Output the printed material list in a delimited format.
Appendix: Isometric Drawing Options

Delimiter
Specifications a delimiter to use for the header lines that appear at the top of a printed material list. The possible characters are

- Blank
- Comma (,)
- Semi-colon (;)
- Colon (;)

TitleText
Specifies text for the title.

ShowTitles
Specifies whether the title line is shown.

- **True** - Display the title line.
- **False** - Suppress the display of the title line.

S3D Options

The S3D options define the drawing output, which includes drawing symbols, dimensions, layers, drawing frame, attributes, material lists, weld lists, and detail sketches. Each isometric drawing style is associated with a set of options. You can specify the options using the **Edit Options** command.

The following list describes the S3D options folders:

- **Drawing** - Defines general options for the drawing style. For more information, see *Drawing Options (S3D)* (on page 647).
- **DrawingFrame** - Specifies the content and format of the drawing frame on a drawing. The drawing frame area can include attribute text such as the drawing number and date. For more information, see *Drawing Frame Options (S3D)* (on page 662).
- **MaterialList** - Provides options to control the material list report on the isometric drawing. For more information, see *Material List Options (S3D)* (on page 666).
- **Supplementary** - Provides additional options for input and output files. For more information, see *Supplementary Options (S3D)* (on page 671).
- **NeutralFile** - Sets options for the material take-off neutral file. For more information, see *Neutral File Options (S3D)* (on page 674).
- **Labels** - Specifies options for different labels on the isometric drawing. For more information, see *Labels Options (S3D)* (on page 678).
- **SymbolMap** - Maps part classes and ISOGEN symbol keys. For more information, see *Symbol Mapping Options (S3D)* (on page 684).
- **IntergraphAlternativeTexts** - Allows you to modify the values of text strings on isometric drawings. For more information, see *Intergraph Alternative Text Options (S3D)* (on page 686).
Appendix: Isometric Drawing Options

- **AttributeMAP** - Maps the ISOGEN properties with user-defined strings. For more information, see Attribute Mapping Options (S3D) (on page 687).
- **Comments** - Allows you to add information to the isometric style file that is not included in the drawing configuration or definition, such as date created and who created the style or modifications and modification dates. For more information, see Comments Options (S3D) (on page 688).

**See also**
Appendix: Isometric Drawing Options (on page 415)

**Drawing Options (S3D)**

Sets general Smart 3D-specific options for the isometric drawing style.

The Drawing (S3D) folder also contains the following groups of options:

- **Controls** - Defines various system controls on the isometric drawing. For more information, see Controls (S3D Drawing) (on page 648).
- **Format** - Defines various options about the format of the drawing, including the isometric type and enclosure shapes. For more information, see Format (S3D Drawing) (on page 649).
- **Dimensions** - Controls the dimensions of the different components on the isometric drawing. For more information, see Dimensions (S3D Drawing) (on page 654).
- **Welds** - Specifies information about welds on the isometric drawing. For more information, see Welds (S3D Drawing) (on page 655).
- **Content** - Defines various options about the content of the drawing, such as whether to display enclosures and coordinates. For more information, see Content (S3D Drawing) (on page 655).
- **Key Point Notes** - Provides options for controlling the key point notes that display on the isometric drawing. For more information, see Key Point Notes (S3D Drawing) (on page 660).

**BorderTemplate**

Specifies the customized border template file (.sha) to use. If this option is undefined, the software uses the default backing sheet template from the Catalog. Click the ellipsis button to display the Open dialog box and then navigate to the .sha file.

**DrawingClass**

Specifies the type of drawing. Available options are Standard, Penetration, and System. For Iso_Piperun and Iso_Pipeline isometrics, select the Standard option. For Penetration Spool isometrics, select the Penetration option. For Iso_WBS and Iso_System, select System option.

**NOTE** If you set DrawingClass to System, the software ignores the SortInputParts setting and automatically sorts parts by pipeline.

**SortInputParts**

Controls the processing of drawing parts that are added. This option has the following possible values:

- **Default** - Suppress additional processing of the parts that make up the drawing.
Appendix: Isometric Drawing Options

- **Connected Sets** - Organize the parts into connected sets. Each set produces its own drawing in the SHA file and is output to the PCF with its own header. This setting enables support for multiple connected networks in the same drawing.

- **Pipeline** - Organize the parts into pipelines. Each pipeline produces its own drawing in the SHA file, and is output to the PCF with its own header. This setting enables support for a multi-pipeline drawing.

  **NOTE** For more information about disconnected and multi-pipeline drawings, see *Isometric Drawing Types* (on page 109).

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Controls (S3D Drawing)**

Sets options for system controls.

- **AppendBoltLength**
  
  Appends the bolt length to the description in the material list. Acceptable values are *True* and *False*.

- **Defines**
  
  Smart 3D attribute

- **GenerateImpliedMat**
  
  Generates implied materials, including bolts. Acceptable values are *True* and *False*.

- **Defines**
  
  Smart 3D attribute

- **IncludePipeSupport**
  
  Includes pipe supports in the material list. Acceptable values are *True* and *False*.

- **Defines**
  
  Smart 3D attribute

- **NoSymbolMapOK**
  
  Continues to extract the isometric pipeline if the software cannot find the SKEY of a component. Set this option to *True* to continue extraction of the isometric pipeline and create the drawing with the token SKEY symbol replacement. Set *NoSymbolMapOK* to *False* to extract the pipeline data and extraction log that contains information of unmapped symbol components.

- **Defines**
  
  Intergraph Option 17

- **PCFOutputOnly**
  
  Specifies that the software creates the Piping Component File (PCF) only. Acceptable values are *True* and *False*. 
Appendix: Isometric Drawing Options

Defines
Smart 3D attribute

ValOpr2ndOrient
Enables secondary orientation notes for valve operators. Acceptable values are True and False.

Only valves that have operators of the following types will include the secondary operator orientation callouts in the drawings:
- Wrench, short (codelist 9)
- Wrench, long (codelist 11)
- Wrench, special (codelist 271)
- Lever (codelist 17)
- Lever, quick-action, (codelist 39)
- Gear, side mounted handwheel Type 1 (codelist 331)
- Gear, side mounted handwheel Type 2 (codelist 332)
- Gear, side mounted handwheel Type 3 (codelist 333)
- Gear, side mounted handwheel Type 4 (codelist 334)
- Gear, side mounted handwheel Type 5 (mirror of Type 1) (codelist 1035)
- Gear, side mounted handwheel Type 6 (mirror of Type 2) (codelist 1040)
- Gear, side mounted handwheel Type 7 (mirror of Type 3) (codelist 1045)
- Gear, side mounted handwheel Type 8 (mirror of Type 4) (codelist 1050)
- Gear, side mounted inclined handwheel Type 1 (codelist 351)
- Gear, side mounted inclined handwheel Type 2 (mirror of Type 1) (codelist 1055)

Defines
Smart 3D attribute

Format (S3D Drawing)
Sets Smart 3D-specific options for the isometric drawing format, including text size and skew dimensions.

The Format (S3D Drawing) folder also contains the following group of options.
- Dotted Symbology - Provides options for setting dotted symbology on specific isometric parts. For more information, see Dotted Symbology (S3D Drawing Format) (on page 652).

BendRadiusFormat
Controls the appearance of the bend radius for pipe bends on the isometric drawing.
Appendix: Isometric Drawing Options

- **Absolute Length** - Displays the length of the bend radius.

- **Radius Multiplier** - Displays the radius multiplier of the bend radius.

**SegmentFlowArrowPlacement**
Controls flow arrow placement. Options are listed in order from placement of the fewest to the most flow arrows.

- **None** - Suppress placement of the flow arrow.
- **Pipe Run** - Place the flow arrow on the longest header pipe feature of the run.

- **Branch** - Place the flow arrow on the branch pipes connected to header pipes.

- **Pipe Feature** - Places the flow arrow on each pipe feature in a run. Use this option if a drawing may be split into multiple sheets, such as from the creation of spool sheets in ISOGEN. Flow arrows are then placed on each sheet.

**Defines**

Smart 3D battribute
Appendix: Isometric Drawing Options

ShowBendAngle
Writes the bend angle length to the PCF file. Acceptable values are True and False. Set this option to True to write the calculated length for a bent pipe to the PCF file.

NOTE Use the Drawing.Format.AngleStyle option to write the bend angle to the isometric drawing.

Defines
Smart 3D attribute

ShowBendRadius
Displays the bend radius for pipe bends on the drawings. Acceptable values are True and False.

Defines
Smart 3D attribute

Dotted Symbology (S3D Drawing Format)
Provides options for setting dotted symbology on specific isometric parts.

DottedDimensionedFilter
Specifies a user-defined filter that selects all the parts that need to be shown dotted and dimensioned on the isometric drawing.

Defines
ISOGEN attribute

DottedDimensionedLabel
Specifies a label that selects all the parts that need to be shown dotted and dimensioned on the isometric drawing. In many cases using this option is faster than using DottedDimensionedFilter.

Defines
ISOGEN attribute

DottedUnDimensionedFilter
Specifies a user-defined filter that selects all the parts that need to be shown dotted and undimensioned on the isometric drawing.

Defines
ISOGEN attribute

DottedUnDimensionedLabel
Specifies a label that selects all the parts that need to be shown dotted and undimensioned on the isometric drawing. In many cases using this option is faster than using DottedUnDimensionedFilter.

Defines
ISOGEN attribute

To create the **DottedDimensionedLabel** and the **DottedUnDimensionedLabel**:

1. From the Catalog task, select **Tools > Define Label** and create a COM label.
2. In the **Label Editor** dialog box, click **Add** to open the **Select Properties** dialog box. For more information, see the **Smart 3D Drawings and Reports Reference Data Guide**.
3. Select Piping Parts as the object type, select the **Reporting Requirement** property, and then click **OK**.
   
   The **Label Editor** dialog box opens.

4. Add the **Reporting Requirement** property to the Layout tab.
5. In the Layout text field, delete "<F>Reporting Requirement</F>", and then type "DOTTED-DIMENSIONED" or "DOTTED-UNDIMENSIONED".
6. Select the text in the Label text field, and then click **Block Definition**.
   
   The **Block** dialog box opens.

7. Define the property as "Reporting Requirement", the operator as "=" , and the value as "Not to be reported".
8. Click **OK** to exit out of the **Block** dialog box, and then click **OK** again to finish creating the label.

**NOTE** You can test the label as a Tool Tip on piping parts. The output of the label is shown as "DOTTED-DIMENSIONED" or "DOTTED-UNDIMENSIONED".

**Enabled**

Enables dotted symbology for parts specified by **DottedDimensionedFilter** or **DottedUnDimensionedFilter** options. If both parts connected at a weld are dotted, the weld is dotted also. If a part is returned by both filters, the part is dimensioned. Acceptable values are **True** and **False**.

**Defines**

ISOGEN attribute

**NOTES**

- In many cases, using a label is faster than using a filter. To speed up the generation of isometric drawings use **DottedDimensionedLabel** and **DottedUnDimensionedLabel** instead of the filter versions.

- To use the filter versions of the options ensure that the label versions are not set.

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

*Format (Drawing)* (on page 479)
Appendix: Isometric Drawing Options

**Dimensions (S3D Drawing)**
Sets Smart 3D-specific options for dimension display on the isometric drawing.

The **Dimensions (S3D Drawing)** folder also contains the following group of options:

**Column Reference** - Specifies the column references for isometric drawings. For more information, see *Column Reference (S3D Drawing Dimensions)* (on page 654).

**CoordOutputBOP**
Generates BOP coordinates at changes in pipeline elevation. Acceptable values are **True** and **False**.

**Define**
Smart 3D attribute

---

**Column Reference (S3D Drawing Dimensions)**
Specifies the columns for isometric drawing dimensions.

**DimensionType**
Specifies the dimension type as either prime or skewed. Acceptable values are **Prime** and **Skew**.

**Enable**
Allows placement of reference dimensions from either a structural column or a grid line to one item on the isometric drawing. Acceptable values are **True** and **False**. If set to **True**, the placement occurs.

**Enclosure**
Specifies the type of enclosure to use for the column name or grid callout. Acceptable values are **None**, **Square Ends**, **Round Ends**, **Diamond Ends**, **Circle**, **Double Circle**, and **Ellipse**.

**MaximumDistance**
Restricts the items that are considered by the **StructureReferenceFilter** to a cube that surrounds the placement point. The value for **MaximumDistance** determines the distance between the reference point and the edges of the cube. **UseMaximumDistance** must be set to **True**.

**Placement**
Specifies the placement point used for the structural reference. Acceptable values are **Start Point** and **1st Component**.

**ReferenceLocation**
Specifies the structural reference location as either a column on the object or a grid line. Acceptable values are **Column** and **GridLine**.
StructureReferenceFilter
Specifies a filter to use as the structural reference filter. Displays the Select Filter dialog box.

UseMaximumDistance
Acceptable values are True and False. If set to True, MaximumDistance is enabled.

See Also
Appendix: Isometric Drawing Options (on page 415)

Welds (S3D Drawing)
Sets Smart 3D-specific options for the display of welds on the isometric drawing.

WeldNumberLabel
Specifies a label to use with the weld number on the isometric drawing. Click the ellipsis button in the field to display the Catalog Labels dialog box and select a label. There are two delivered weld number labels you can use with this option: Piping Isometric Weld Sequence Number and Piping isometric Weld Type and Sequence Number.

NOTES
- You must set the Drawing.Welds.ShowWeldNumbers option to True to use this option.
- The label you select for the WeldNumberLabel cannot result in the generation of weld identifiers with spaces. Intergraph does not support weld identifiers with spaces.

Defines
Intergraph attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

Content (S3D Drawing)
Sets Smart 3D-specific options for the content on isometric drawings.

BoreOutputUnit
Prints all bores in inches on the isometric drawing. Acceptable values are True and False. Make sure that the setting for this option corresponds with the setting for Drawing > Dimensions > Units.

Defines
Intergraph option 43

ChangeManagementEnabled
Turns piping isometric change management on and off. For more information on piping isometric change management, see Change Management in Piping Isometric Drawings (on page 173). You can also override this style option with the Change Management property on the piping isometric drawing document. For more information, see Style Tab (Properties Dialog Box) (on page 51). The default setting is False.
Appendix: Isometric Drawing Options

- **True** - Turn on change management. When set to **True** and the `S3D.MaterialList.UserDefinedMaterialPartNumbersEnabled` option is also set to **True**, if there is a conflict in settings, a warning message is output to the Drawing log. For more information on the `S3D.MaterialList.UserDefinedMaterialPartNumbersEnabled` option, see *Material List Options* (on page 550).

- **False** - Turn off change management.

  **NOTE** Even if `ChangeManagementEnabled` is set to **False** in the Isometric Style, you can enable it on a piping isometric drawing document by setting the document style property for `ChangeManagement` to **Enabled**. If a conflict occurs, the conflict warning displays in the Drawings Log. For more information, see *Style Tab (Properties Dialog Box)* (on page 51).

**Defines**

Smart 3D attribute

**ExcludeContinuationParts**

Specifies whether continuation parts are excluded from drawing content. Acceptable values are **True** and **False**. If set to **True**, implied material data - such as gaskets, bolt data, and end continuation data (for example, connection-pipeline equipment) - is omitted from the drawing.

  **NOTE** Only use the `ExcludeContinuationParts` option for Spool drawings.

**ExcludeUnconnectedTap**

Specifies whether unconnected taps are excluded from drawing content. Acceptable values are **True** and **False**. If set to **True**, unconnected taps are excluded.

**Defines**

Smart 3D attribute

**HonorSpoolAtBranch**

Includes parts of other pipelines at branches in order to maintain spool continuity on the isometric drawing. Acceptable values are **True** and **False**. For more information on using this option, see *Control drawing content* (on page 122).

  **NOTE** When using the `HonorSpoolAtBranch` option, generate the spools with `Include Stub-Ins` with `Header Spool` set to **True**. For more information, see the *Piping User's Guide*, available from *Help > Printable Guides*.

**Defines**

Smart 3D attribute

**InstrumentTagLenLimit**

Specifies the number of characters after which the software inserts a line feed in instrument tag numbers for display in an instrument bubble. If you set this value to 1, the software inserts a line feed after the first character. If you set this value to 10, the software replaces the embedded dash within the tag number with a line feed.

**Defines**

Smart 3D attribute
Appendix: Isometric Drawing Options

NozzleTagLabel
Uses the system-defined nozzle connection note. The default setting for this option is True for all isometric styles. Acceptable values are True and False.

Defines
Smart 3D attribute

PreserveUserAnnotation
Preserves user annotation data during re-extraction. The user annotation layer name must be PMFGUSER. Acceptable values are True and False.

Defines
Smart 3D attribute

RpadItemCode
Specifies whether to generate an item code and a material description for reinforcement pads on the material list. Acceptable values are True and False. If you set this option to True, the software generates an item code and a material description for reinforcement pads on the material list, and plots the symbols for reinforcement pads on the drawing. The default setting for this option is False.

Defines
OS 77 Pos 3

ShowCptTags
Shows component tags or names on graphics. Acceptable values are True and False.

Defines
OS 60 Pos 1

SupportFilter
Specifies a user-defined filter that determines which supports are included in the isometric drawing. If no filter is specified, all associated supports display on the drawing. Click the ellipsis button in the Value field to display the Select Filter dialog box.

Defines
Smart 3D attribute

TreatTapsOnPipeAsTeeStubs
Controls how the software manages taps on pipe during isometric drawing generation or the creation of a piping component file (PCF). By default, all taps that you place on pipe in the model also appear as taps on the piping isometric drawing and in the PCF. Two fundamental consequences result from this behavior:

1. Smart 3D dimensions the branch to the tap point, which is the surface on the pipe. Typically, the requirement is for the dimension to run to the centerline of the header.
2. ISOGEN expects taps on pipes to be the exception rather than the rule. As such, large numbers of taps can prevent ISOGEN from positioning them correctly on the isometric drawing.

The resolution of both issues is for the software to treat taps on pipe as set-on tees, or tee stubs, when generating the isometric drawing or when creating a PCF.

- **True** - Treat taps on pipe as set-on tees.

- **False** - Treat taps on pipe as taps. This is the default setting.
You can place taps only in a radial configuration (A). Placement of taps in a non-radial configuration (B) is not currently supported.

**NOTE**

Defines

Smart 3D attribute

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)
**Key Point Notes (S3D Drawing)**

Sets Smart 3D-specific options for controlling notes associated with key points. You can filter the notes that display on the isometric drawing according to the type of component, purpose of the note, specific key point, and message enclosure type.

**NOTE** For information about creating key point notes, see *Create a key point note* (on page 124).

The **Key Point Notes (S3D Drawing)** folder contains a collection called Key Point Notes, which is used to store the definitions of key point notes. For more information, see *Key Point Notes Collection (S3D Drawing Key Point Notes)* (on page 661).

**Count**

Displays the number of key point notes defined in the current style and stored in the Key Points Notes collection. This is a system-generated value.
**Key Point Notes Collection (S3D Drawing Key Point Notes)**

Sets options to control how key point notes display on the isometric drawing. A key point refers to a specific location on a component. Key point notes are associated with individual component key points and contain user-specified text that provides special instructions or requirements for a given component. The examples below show a key point note that has been assigned to a valve in the model, followed by the resulting output on the isometric drawing.
Part Type
Identifies the type of component to which the note applies. Available component types are Instrument, Pipe, Pipe-Component, Pipe-Support, RPad, Specialty, and Valve.

Purpose
Indicates the reason for associating the note with the component. The items that display in this list are defined on the NotePurpose sheet in the AllCodeLists.xls workbook. For more information, see the Smart 3D Reference Data Guide delivered with the software.

Keypoint
Indicates the specific location on the component to which the note is associated. The key point that you select determines where on the component the note leader line points. Select Any, or select one of the key points that displays in the list.

MessageEnclosure
Indicates the shape of the enclosure used to contain the note that ISOGEN outputs on the isometric drawing. Available options are Message, Message-Circle, Message-Diamond, Message-Pointed, Message-Round, Message-Square, and Message-Triangle.

Drawing Frame Options (S3D)
Sets Smart 3D-specific options for the drawing frame on isometric drawings.

The Drawing Frame (S3D) folder also contains the following groups of options:

- Units of Measure - Specifies the units for drawing frame reporttext. For more information, see Units of Measure (S3D Drawing Frame) on page 663.
- Pipeline List - Creates an embedded Excel workbook object on the isometric drawing. This object contains information about multiple pipe runs on an isometric drawing. For more information, see Pipeline List (S3D Drawing Frame) on page 663.
- Custom MTO - Calls a ProgID at the end of an isometric extraction to embed a custom object on the isometric drawing. For more information, see Custom MTO (S3D Drawing Frame) on page 665.

SP3DBorderData
Turns on and off the plotting of the title block and border data from the database. Acceptable values are True and False.

Defines
Smart 3D attribute
**Units of Measure (S3D Drawing Frame)**

Specifies the unit of measure format for values given in the drawing frame.

**Pressure**

Specifies a label for the pressure units of measure. Click the ellipsis button in the Value cell to display the Catalog Labels dialog box and select a label to use.

**Temperature**

Specifies a label for the temperature units of measure. Click the ellipsis button in the Value cell to display the Catalog Labels dialog box and select a label to use.

**See Also**

Appendix: Isometric Drawing Options (on page 415)

**Pipeline List (S3D Drawing Frame)**

Specifies an Excel workbook object that communicates multiple pipe run information on the isometric drawing.

The Pipeline List (S3D Drawing Frame) folder also contains the following groups of options:

- **Column** - Specifies the column layout of an Excel workbook object on the isometric drawing. For more information, see Column (S3D Drawing Frame Pipeline List) (on page 665).

- **ReportTemplate** - Specifies the report template used for the pipeline list in the drawing. For more information, see Report Template (S3D Drawing Frame Pipeline List) (on page 665).

**BoxOrigin**

Defines the origin location of the pipeline list. Acceptable values are Bottom Left, Bottom Right, Top Left and Top Right.

**Defines**

Smart 3D attribute

**BoxOriginX**

Defines the X-coordinate (value in millimeters) of the pipeline list.

**Defines**

Smart 3D attribute

**BoxOriginY**

Defines the Y-coordinate (value in millimeters) of the pipeline list.

**Defines**

Smart 3D attribute

**Layer**

Specifies the layer for the pipeline list. This value (integer) is in the range 1 - 50.
Appendix: Isometric Drawing Options

**ReportOutputFormat**
Specifies the report output format for the Pipe Line List Report as Excel spreadsheet or native text box format.

**IMPORTANT** If you use the **Native text boxes** option, you must add gridlines to the template background sheet in the drawing.

**ShowPipeLineListBox**
Defines whether to display the pipeline list. Acceptable values are **True** and **False**.

**UseReportTemplage**
Specifies whether or not to use a report template for the pipeline list format. If this option is set to **True**, the software generates the pipeline list using the specified report template. For more information, see *Report Template (S3D Drawing Frame Pipeline List)* (on page 665). Acceptable values are **True** and **False**.

**NOTE** When defining embedded report layout (sizing of columns and rows), consider the report usage first. Because of a Microsoft limitation concerning the size of Windows metafile objects within other applications, the data displayed may be incomplete. Therefore, no column should be out of screen when using 100 percent zoom for the report. Otherwise some columns are ignored when the report is embedded within the drawing. The same limitation exists for rows. To preserve the maximum number of rows displayed, the total header row(s) height should be a minimum of the overall report. Using Microsoft Excel default settings, the maximum number of columns is approximately 20 and the maximum number of rows is approximately 75 (including header rows). For more information on setting the defaults in Microsoft Excel, see your Microsoft Excel documentation.

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)
Appendix: Isometric Drawing Options

**Column (S3D Drawing Frame Pipeline List)**

Specifies the column layout of an Excel workbook object on the isometric drawing.

**Sequence**

Specifies the order of the columns from left to right.

**HeaderColumn**

Sets the text heading of each column.

**PipelineData_Att**

Sets the contents of each column. For more information, see *Pipeline List Box (S3D Labels)* (on page 684).

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

**Report Template (S3D Drawing Frame Pipeline List)**

Specifies the report template used for the pipeline list in the drawing.

**TemplateName**

Specifies a report template to use for the pipeline list. This option is only available when the *S3D.Drawing.Frame_PipeLineList.UseReportTemplate* option is set to *True*. Click *More* in the *Value* field to open the *Select Template* dialog box and navigate to the report template name.

**Defines**

Smart 3D attribute

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

**Custom MTO (S3D Drawing Frame)**

Calls a *ProgID* at the end of an isometric extraction to embed a custom object on the isometric drawing.

**Enabled**

Controls whether or not a custom object, such as an MTO, will be included on an isometric drawing. Acceptable values are *True* and *False*.

**FramesProgID**

Specifies a user-defined COM object for the post-process of data, such as MTO data, on the isometric drawing.

**Layer**

Specifies the layer in the drawing in which the custom data is included.
ProgramProglD
Identifies the user-defined COM object for the customization of the included data, such as MTO data.

Template Path
Specifies the source location of the report template to use for the custom data.

See Also
Appendix: Isometric Drawing Options (on page 415)

Material List Options (S3D)
Sets Smart 3D-specific options for controlling position, format, and contents of the parts list.

ExcludeNuts
Specifies whether to exclude nut data from the Material List. Acceptable values are True and False.
True - Excludes the nut data.
False - Extracts nut data and includes it in the Material List. This is the default value.

**Note** Nuts must also be set as To be reported. On the Occurrence tab of the Properties dialog box for an item, set the Reporting Requirements property to To be reported.

Defines
Smart 3D attribute.

ExcludeWashers
Specifies whether to exclude washer data from the Material List. Acceptable values are True and False.
True - Excludes the washer data.
False - Extracts washer data and includes it in the Material List. This is the default value.

**Note** Washers must also be set as To be reported in the model. On the Occurrence tab of the Properties dialog box for an item, set the Reporting Requirements property to To be reported.

Defines
Smart 3D attribute.

ExcludeWeightData
Specifies whether to exclude weight data from the Material List and Supplementary reports. Acceptable values are True and False.
- True - Excludes the component weight data extraction.
- False - Extracts component weight data and includes it in the Material List and Supplementary reports.

Defines

Appendix: Isometric Drawing Options

Smart 3D attribute

**InstrSpecialtyItemCode**
Specifies the instrument specialty item code to use in the material list.

**PipeOidAsItemCode**
Specifies a Pipe OID value will be used as the item code in the material list.

**UserComponentQTY**
Specifies user component quantity. This option is a drop-down list that allows you to select a material attribute in which the component quantity for piping components other than pipe is stored.

**UserDefinedBoltMaterialDescription**
Sets a material description for the bolts in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the description for bolts in the material list is the value returned by the associated reports label.

**UserDefinedBoltItemCode**
Specifies a user-defined item code for bolts in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the item code for bolts in the material list is the value returned by the associated reports label.

**UserDefinedClampMaterialDescription**
Sets a material description for the clamps in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the item code for description in the material list is the value returned by the associated reports label.
UserDefinedClampItemCode

 Specifies a user-defined item code for clamps in the material list. Click the ellipsis button in the **Value** field to open the **Catalog Label** dialog box and select a label to use in the material list. If this option is set, the item code for clamps in the material list is the value returned by the associated reports label.

UserDefinedGasketItemCode

 Specifies a user-defined item code for gaskets in the material list. Click the ellipsis button in the **Value** field to open the **Catalog Label** dialog box and select a label to use in the material list. If this option is set, the item code for gaskets in the material list is the value returned by the associated reports label.

UserDefinedGasketMaterialDescription

 Sets a material description for the gaskets in the material list. Click the ellipsis button in the **Value** field to open the **Catalog Label** dialog box and select a label to use in the material list. If this option is set, the description for gaskets in the material list is the value returned by the associated reports label.

UserDefinedInstrumentMaterialDescription

 Sets a material description for the instruments in the material list. Click the ellipsis button in the **Value** field to open the **Catalog Label** dialog box and select a label to use in the material list. If this option is set, the description for instruments in the material list is the value returned by the associated reports label.

UserDefinedItemCode

 Specifies a user-defined item code to use in the material list. Click the ellipsis button in the **Value** field to open the **Catalog Label** dialog box and select a label to use in the material list. If this option is set, the item code for items in the material list is the value returned by the associated reports label.
option is set, the software uses the formatted label output value as the Item-Code of the Iso part. By default, the Item-Code is the ContractorCommodityCode property for the Iso part.

Defines

ISOGEN attribute

UserDefinedMaterialPartNumber

Defines a label to return the SequenceID for a piping part. The value returned from this label must be a positive integer. Any values returned that do not meet this requirement are ignored, and the software automatically generates part numbers for the components. It is recommended that you specify a label that returns the Sequence ID property for the piping part. This option is only available if you set UserDefinedMaterialPartNumbersEnabled to True.

Before using this option in combination with the UserDefinedMaterialPartNumbersEnabled options:

- You must assign Sequence IDs to the piping parts to use this option. It is recommended that you use a custom command to assign the Sequence IDs. Two piping parts cannot have the same Sequence ID number.

- This option is not available for multi-sheet Piping Isometric Drawings. If you need to use the UserDefinedMaterialPartNumber option, it is recommended that you set the Isogen option Drawing.Controls.AutoDrawingSplit option to False to force single sheet isometric drawings. Consider the implications for Piping Component Files (PCF). When the UserDefinedMaterialPartNumbersEnabled option is set to True, REPEAT-PART-NUMBER attributes are written to the PCF components with the value returned by the label specified by UserDefinedMaterialPartNumber. A single HIGHEST-PART-NUMBER entry is made in the PCF heading for Sheet1, with the value of the largest REPEAT-PART-NUMBER in the PCF. For more information on the AutoDrawingSplit option, see Controls (Drawing) (on page 428).

- The UserDefinedMaterialPartNumber option overrides Isogen's accumulation of parts in the Material List. If Isogen accumulation options are enabled, Isogen will attempt to collect the components that do not have part numbers with those that have part numbers. To avoid this problem, make sure the part number sequencing in the model is correct or disable the Isogen Fabrication Accumulation options, see the FabAccumulation option described in this section.

Defines

Smart 3D attribute

UserDefinedMaterialPartNumbersEnabled

Controls the display of the Material Part Number label. If set to True, a part number derived from the model is used as the Part Numbers in the Material List callouts on the drawing. A label specified by the UserDefinedMaterialPartNumber option is used to create the callout from the part object in the drawing. For more information on this using this option, see the description above for the UserDefinedMaterialPartNumber option.

If this option is set to True, the Change Management of material part numbers is disabled. Any time both this option and Drawing.Content.ChangeManagementEnabled are set to True, a message displays in the status field of the Isometric Style Options Browser notifying you of a conflict in settings. For more information on the ChangeManagementEnabled option, see Content (Drawing) (on page 418).
Defines
Smart 3D attribute

UserDefinedNutItemCode
Specifies a user-defined item code for nuts in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the item code for nuts in the material list is the value returned by the associated reports label.

Defines
Smart 3D attribute

UserDefinedNutMaterialDescription
Sets a material description for the nuts in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the description for nuts in the material list is the value returned by the associated reports label.

Defines
Smart 3D attribute

UserDefinedPipeMaterialDescription
Sets a material description for the pipes in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the description for pipes in the material list is the value returned by the associated reports label.

Defines
Smart 3D attribute

UserDefinedSpecialtyMaterialDescription
Sets a material description for the specialty items in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the description for specialty items in the material list is the value returned by the associated reports label.

Defines
Smart 3D attribute

UserDefinedSupportItemCode
Specifies a user-defined item code for pipe support in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the software uses the formatted label output value as the item code for pipe support in the material list.

Defines
ISOGEN attribute
UserDefinedSupportMaterialDescription
Sets a material description for the pipe supports in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the description for pipe supports in the material list is the value returned by the associated reports label.
Defines
Smart 3D attribute

UserDefinedWasherItemCode
Specifies a user-defined item code for washers in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the item code for washers in the material list is the value returned by the associated reports label.
Defines
Smart 3D attribute

UserDefinedWasherMaterialDescription
Sets a material description for the washers in the material list. Click the ellipsis button in the Value field to open the Catalog Label dialog box and select a label to use in the material list. If this option is set, the description for washers in the material list is the value returned by the associated reports label.
Defines
Smart 3D attribute

Supplementary Options (S3D)
Sets Smart 3D-specific options for various input and output files.
The Supplementary (S3D) folder also contains the following group of options:

- **Detail Sketches** - Defines detail sketches on the isometric drawing. For more information, see *Detail Sketches (S3D Supplementary)* (on page 672).
- **Published Files** - Specifies the additional file types that can be published to SmartPlant Foundation. For more information, see *Published Files (S3D Supplementary)* (on page 673).

See Also
*Appendix: Isometric Drawing Options* (on page 415)
**Detail Sketches (S3D Supplementary)**

Specifies the characteristics of detail sketches on the isometric drawing.

**ShowDetailSketch** - Controls the display of Detail Sketch on the isometric drawing. Acceptable values are **TRUE** and **FALSE**.

The **Detail Sketches (S3D Supplementary)** folder also contains the following group of options:

- **Sketch Mapping** - Maps part classes with symbol files for the purpose of defining detailed sketches. For more information, see *Sketch Mapping (S3D Supplementary Detail Sketches)* (on page 672).

**Sketch Mapping (S3D Supplementary Detail Sketches)**

Maps part classes with symbol files for the purpose of defining detailed sketches.

You can map multiple symbol files to a given part class. The software places each symbol as a detail sketch on the isometric drawing and prints the appropriate number of call-outs adjacent to each occurrence of the part class.

You can also specify a label and value. If the value you specify matches the value returned by the label, the software generates a detail on the drawing.

**SP3DPartClass**

Specifies the name of a part class. Part classes and their associated data are defined in the reference data. For information about creating or modifying part classes, see the *Reference Data Guide* available from the **Help > Printable Guides** command.

**SketchSymbol**

Specifies the name of a symbol file for the detail sketch. The software checks to see if this file exists in the **Supplementary.Detail Sketches.Path** location.

**SketchChkLabel**

Names the label, such as SupportPartName.

**SketchChkValue**

Defines a value. If this value matches the value returned by the label, then the software generates a detail on the drawing.

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)
Published Files (S3D Supplementary)

Specifies the additional file types that can be published to SmartPlant Foundation along with the SHA drawing.

**File Type** - Specifies what additional file types can be published. SmartPlant Foundation supports only the following file types:

- **PCF** - The piping component file.
- **POD** - The piping object data file.
- **ISOGEN-NEUTRAL-FILE** - The neutral file generated by the Supplementary.NeutralFile settings.
- **NEUTRAL-FILE** - The neutral file generated by the S3D.NeutralFile settings.
- Other report files - The ISOGEN report files generated by Supplementary.ReportFiles settings.

**SPF File Extension** - Specifies the file extension to use when the file is published to SmartPlant Foundation. If this box is left empty, then it is replaced with the default extension as listed in the table below.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Default SPF File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCF</td>
<td>.PCF</td>
</tr>
<tr>
<td>POD</td>
<td>.POD</td>
</tr>
<tr>
<td>ISOGEN-NEUTRAL-FILE</td>
<td>.B</td>
</tr>
<tr>
<td>NEUTRAL-FILE</td>
<td>.B</td>
</tr>
<tr>
<td>* Other ISOGEN files</td>
<td>.TXT</td>
</tr>
</tbody>
</table>

**IMPORTANT** If the extension is not recognized as a valid file type by SmartPlant Foundation, then the publishing fails.

**NOTE** SmartPlant Foundation does not currently support .pcf format, but it can be added using the SmartPlant Foundation Desktop Client. For more information, contact Intergraph Support Services. You can find support information on our web site [http://support.intergraph.com](http://support.intergraph.com).
Neutral File Options (S3D)

Sets options for the material take-off neutral file. This file has a .b extension and is saved in the output folder.

**NOTE** To exclude items from the neutral file, you can set properties on the items in the model. On the Occurrence tab of the Properties dialog box for an item, set the Reporting Requirements property to **Not to be reported**. Set the Reporting Type property to **<undefined value>**.

The Neutral File (S3D) folder contains the following groups of options:

- **User Attributes** - Specifies the user attributes for the material take-off neutral file. For more information, see [User Attributes (S3D Neutral File)](on page 675).
- **Part Data** - Specifies the part data for the material take-off neutral file. For more information, see [Part Data (S3D Neutral File)](on page 675).
- **Weld Data** - Specifies the weld data for the material take-off neutral file. For more information, see [Weld Data (S3D Neutral File)](on page 676).
- **Bolt Data** - Specifies the bolt data for the material take-off neutral file. For more information, see [Bolt Data (S3D Neutral File)](on page 677).
- **Gasket Data** - Specifies the gasket data for the material take-off neutral file. For more information, see [Gasket Data (S3D Neutral File)](on page 677).

**Enabled**

Produces the Intergraph MTO file. Acceptable values are **True** and **False**.

**Defines**

Smart 3D attribute

**GeneratedBySheet**

Splits the MTO neutral file by sheet. Acceptable values are **True** and **False**.

**Defines**

Smart 3D attribute

**GroupBPIP**

Specifies whether pipe bends (BPIP) are treated as pipe in the neutral file rather than being listed separate in the .b file. Acceptable values are **True** and **False**. When set to **False**, the .b file contains separate entries for pipe bends and straight pipe. If set to **True**, you only get one entry for pipe.

**Defines**

Smart 3D attribute

**GroupPerRun**

Specifies whether a single *.b file is supported for each ISO extraction. If the ISO line count is greater than 1, **Enabled** is set to **True**, and **GroupPerRun** is set to **True**, the group neutral b file is created using the first line's name. For example, "**lineName**-grp.b" will contain all the data of each ISO line in the process.
Appendix: Isometric Drawing Options

Defines
Smart 3D attribute

RecordLength
Uses standard neutral file record length of 256 or expanded length 1024.

Defines
Smart 3D attribute

Sort
Sorts the records returned on the MTO neutral file.

Defines
Smart 3D attribute

See Also
Appendix: Isometric Drawing Options (on page 415)

User Attributes (S3D Neutral File)

Specifies the user attributes for the material take-off neutral file.

Name
Specifies a name corresponding to the attribute.

LabelName
Specifies the catalog label for the attribute. You can click the browse button to navigate the Catalog hierarchy.

See Also
Appendix: Isometric Drawing Options (on page 415)

Part Data (S3D Neutral File)

Specifies the part information for the material take-off neutral file.

The Part Data (S3D Neutral File) folder also contains the following group of options:

- **Column** - Specifies the columns for part data in the MTO neutral file. For more information, see Column (S3D Neutral File Part Data) (on page 676).

Enabled

Produces part data for the MTO file. Acceptable values are True and False.

Defines

Smart 3D attribute

See Also
Appendix: Isometric Drawing Options (on page 415)
Appendix: Isometric Drawing Options

**Column (S3D Neutral File Part Data)**
Specifies the columns for part data in the MTO neutral file.

**Attribute**
Specifies a property to display in the column.

**Start**
Specifies the starting point of the column.

**Width**
Sets the width of the column.

**See Also**
Appendix: Isometric Drawing Options (on page 415)

**Weld Data (S3D Neutral File)**
Specifies the weld information for the material take-off neutral file.

The **Weld Data (S3D Neutral File)** folder also contains the following group of options:

- **Column** - Specifies the columns for weld data in the MTO neutral file. For more information, see `Column (S3D Neutral File Weld Data)` (on page 676).

**Enabled**
Produces weld data for the MTO file. Acceptable values are **True** and **False**.

**Defines**
Smart 3D attribute

**See Also**
Appendix: Isometric Drawing Options (on page 415)

**Column (S3D Neutral File Weld Data)**
Specifies the columns for weld data in the MTO neutral file.

**Attribute**
Specifies a property to display in the column.

**Start**
Specifies the starting point of the column.

**Width**
Sets the width of the column.

**See Also**
Appendix: Isometric Drawing Options (on page 415)
**Bolt Data (S3D Neutral File)**

Specifies the bolt information for the material take-off neutral file.

The Bolt Data (S3D Neutral File) folder also contains the following group of options:

- **Column** - Specifies the columns for bolt data in the MTO neutral file. For more information, see Column (S3D Neutral File Bolt Data) (on page 677).

---

**Enabled**

Produces bolt data for the MTO file. Acceptable values are True and False.

**Defines**

Smart 3D attribute

**See Also**

Appendix: Isometric Drawing Options (on page 415)

---

**Column (S3D Neutral File Bolt Data)**

Specifies the columns for bolt data in the MTO neutral file.

**Attribute**

- Specifies a property to display in the column.

**Start**

- Specifies the starting point of the column.

**Width**

- Sets the width of the column.

---

**Gasket Data (S3D Neutral File)**

Specifies the gasket information for the material take-off neutral file.

The Gasket Data (S3D Neutral File) folder also contains the following group of options:

- **Column** - Specifies the columns for gasket data in the MTO neutral file. For more information, see Column (S3D Neutral File Gasket Data) (on page 678).

---

**Enabled**

Produces gasket data for the MTO file. Acceptable values are True and False.

**Defines**

Smart 3D attribute

**See Also**

Appendix: Isometric Drawing Options (on page 415)
Appendix: Isometric Drawing Options

**Column (S3D Neutral File Gasket Data)**

Specifies the columns for gasket data in the MTO neutral file.

**Attribute**

Specifies a property to display in the column.

**Start**

Specifies the starting point of the column.

**Width**

Sets the width of the column.

**See Also**

Appendix: Isometric Drawing Options (on page 415)

**Labels Options (S3D)**

Sets options for labels on the isometric drawing. You must have a Reports database and Schema in order to use labels on isometric drawings.

The **Labels (S3D)** folder also contains the following groups of options:

- **ComponentNote** - Generates labels for specific components. For more information, see Component Note (S3D Labels) (on page 679).
- **ComponentNoteConditional** - Generates labels for specific components based on test values. For more information, see Component Note Conditional (S3D Labels) (on page 679).
- **ComponentAtts** - Generates labels for specific components based on component attribute. For more information, see Component Atts (S3D Labels) (on page 680).
- **SupportAtts** - Generates labels for the supports based on support attributes in the Piping Component File (PCF). For more information, see Support Atts (S3D Labels) (on page 681).
- **MaterialList** - Generates labels for items in the material list. For more information, see Material List (S3D Labels) (on page 681).
- **MiscSpec** - Generates labels for piperun properties. For more information, see Misc Spec (S3D Labels) (on page 682).
- **InsulationSpec** - Generates labels for piperuns having different specifications. For more information, see Insulation Spec (S3D Labels) (on page 682).
- **TracingSpec** - Generates labels for piperuns having different tracing properties. For more information, see Tracing Spec (S3D Labels) (on page 682).
- **PaintingSpec** - Generates labels for piperuns having different painting properties. For more information, see Painting Spec (S3D Labels) (on page 681).
- **WeldList** - Generates labels for items in the weld list. For more information, see Weld List (S3D Labels) (on page 683).
- **DrawingFrame** - Generates labels with drawing frame text. For more information, see Drawing Frame (S3D Labels) (on page 683).
Appendix: Isometric Drawing Options

- **EndConnection** - Generates labels for end connections. For more information, see *End Connection (S3D Labels)* (on page 683).

- **PipeLineListBox** - Generates labels to use for the PipeLineListBox. For more information, see *PipeLine List Box (S3D Labels)* (on page 684).

This folder also contains the following style properties:

**EnableLabels**

Enables reporting labels. Acceptable values are True and False.

**Defines**

Smart 3D attribute

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

**Component Note (S3D Labels)**

Generates notes that point to specific components on the isometric drawing. The report label definition determines the different types of notes.

**LabelAttribute2**

Selects a component type, such as PIPE, VALVE, or PIPE-SUPPORT.

**LabelName**

Provides the name of the label. You click the Browse button to open a dialog box and select a label definition from the catalog. Commonly, you will choose a label from the Iso category of labels.

**MessageEnclosure**

Provides the type of enclosure for the label.

**See Also**

*Appendix: Isometric Drawing Options* (on page 415)

**Component Note Conditional (S3D Labels)**

Generates notes that point to specific components on the isometric drawing. The report label definition determines the different types of notes based on a test condition.

**LabelAttribute2**

Specifies a component type, such as PIPE, VALVE, or PIPE-SUPPORT.

**TestLabelName**

Identifies a catalog label to use for the test label. Click the ellipsis in the TestLabelName field to open the Catalog Label dialog box and select a label.
Appendix: Isometric Drawing Options

MessageEnclosure

Specifies the type of enclosure for the label. The types provided are Message, Message-Square, Message-Pointed, Message-Round, Message-Circle, Message-Triangle, and Message-Diamond.

TestValues

Identifies the values to use in the test label.

OutputLabelNames

Identifies a catalog label to use for the output label. Click the ellipsis in the OutputLabelName field to open the Catalog Label dialog box and select a label.

See Also

Appendix: Isometric Drawing Options (on page 415)

Component Atts (S3D Labels)

Generates notes that point to specific component attributes on the isometric drawing. The report label definition determines the different types of notes based on attributes.

Type

Specifies a component attribute type.

CompAttribute

Specifies a component attribute.

LabelName

Identifies a catalog label to use for the component attribute label. Click the ellipsis in the LabelName field to open the Catalog Label dialog box and select a label.

ObjectType

Specifies a component object type. The ObjectType is defined as Part by default.

See Also

Appendix: Isometric Drawing Options (on page 415)
Appendix: Isometric Drawing Options

Support Atts (S3D Labels)
Generates notes in the Piping Component File (PCF) that point to specific support attributes on the isometric drawing. The report label definition determines the different types of notes based on attributes.

Open the grid, and then define the attributes listed below as needed.

- **SupportAttribute** specifies a support attribute.
- **LabelName** identifies a catalog label to use for the component attribute label. Click the Browse button to open the Catalog Label dialog box, and then select a label definition from the catalog. SUPPORT-ATTRIBUTE1 through SUPPORT-ATTRIBUTE50 and COMPONENT-ATTRIBUTE1 through COMPONENT-ATTRIBUTE100 are user-specified attributes reported in the PCF.

** Defines: **
Option Switch - N/A
I-Configure - S3D.Labels.SupportAtts

Material List (S3D Labels)
Generates notes that correspond to items in the material list.

**LabelAttribute**
Selects an attribute.

**LabelName**
Provides the name of the label. Click the browse button to open a dialog box and select a label definition from the catalog. MATERIAL-USER0 through MATERIAL-USER99 are user-defined attributes reported in the material list.

**See Also**
Appendix: Isometric Drawing Options (on page 415)

Painting Spec (S3D Labels)
Generates notes that correspond to items in a painting specification.

**LabelAttribute**
Selects an attribute.

**LabelName**
Provides the name of the label. Click the browse button to open a dialog box and select a label definition from the catalog.
**Tracing Spec (S3D Labels)**
Generates notes that correspond to items in a tracing specification.

**LabelAttribute**
Selects an attribute.

**LabelName**
Provides the name of the label. Click the browse button to open a dialog box and select a label definition from the catalog.

**Insulation Spec (S3D Labels)**
Generates notes that correspond to items in an insulation specification.

**LabelAttribute**
Selects an attribute.

**LabelName**
Provides the name of the label. Click the browse button to open a dialog box and select a label definition from the catalog.

**Misc Spec (S3D Labels)**
Generates notes that correspond to items in a miscellaneous specification.

**LabelAttribute**
Selects an attribute.

**LabelName**
Provides the name of the label. Click the browse button to open a dialog box and select a label definition from the catalog. **MISC-SPEC1** through **MISC-SPEC5** are user-defined pipe run properties used to call out attribute breaks in the isometric drawing.

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)
Weld List (S3D Labels)
Generates notes that correspond to items in the weld list.

LabelAttribute
Selects an attribute.

LabelName
Provides the name of the label. Click the ellipsis button to open the Catalog Labels dialog box and select a label to use. WELD-ATTRIBUTE5 through WELD-ATTRIBUTE100 are user-defined weld properties reported in the weld box or weld summary report.

See Also
Appendix: Isometric Drawing Options (on page 415)

Drawing Frame (S3D Labels)
Associates drawing frame formatted text with a report label definition. You can use this option folder to specify labels for the drawing frame. For more information, see Attribute Mapping Options (S3D) (on page 687).

LabelAttribute
Selects an attribute.

LabelName
Provides the name of the label. Click the ellipsis button to open the Catalog Labels dialog box and select a label to use.

OidType
Specifies that an Oid type can be associated with the drawing frame.

See Also
Appendix: Isometric Drawing Options (on page 415)

End Connection (S3D Labels)
Associates a drawing end connection note with a catalog report label template.

LabelAttribute3
Select an attribute for the label.

LabelName
Provides the name of the label. Click the browse button to open a dialog box and select a label definition from the catalog. Commonly, you will choose a label from the Iso category of labels.

MessageEnclosure
Provides the type of enclosure for the label.
See Also
Appendix: Isometric Drawing Options (on page 415)

Pipeline List Box (S3D Labels)
Generates labels to use as part of the PipeLineListBox.

LabelAttribute
Selects an attribute.

LabelName
Provides the name of the label. Click the browse button to open a dialog box and select a label
definition from the catalog. The defined values show up in
DrawingFrame.PipeLineList.Columns so you can give the column a name and the defined
attributes that map to a label. For more information, see Column (S3D Drawing Frame Pipeline
List) (on page 665).

See Also
Appendix: Isometric Drawing Options (on page 415)

Symbol Mapping Options (S3D)
Defines the symbol mapping between the software and ISOGEN, which is the third-party software
used to create isometric drawings. The symbol mapping is defined for each isometric style.
The symbol map must contain all matching data for objects in the model. If the software fails to find
a matching symbol name for each object during the extraction process, a message displays. Your
system administrator then must update the symbol map accordingly.
The content in this option category is similar to the PDS-to-ISOGEN map in PDS (Plant Design
System).
The SymbolMAP (S3D) folder also provides supplement definitions. For more information, see
Supplement (S3D SymbolMAP) (on page 685).

SP3DPartClass
Specifies a part class name for the piping component. These part class names are sheet names in
the Piping.xls workbook.

EndPrepCode
Specifies the codelist number for the end preparation of the piping component. For more details
about the End Preparation codelist, see the AllCodeLists.xls workbook.

IsoGenSkey
Specifies the ISOGEN symbol key for the piping component.
Most components are mapped to an SKEY using an end preparation of 0. You can specify a
wildcard for the end type. For example, when ** is specified for the end type, the software reads
the End Prep from the part and assigns the correct ISOGEN end type.
An important exception is the nipple. You must map two different SKEYs and associated component identifiers based on the end preparation of the nipple. In other words, the SKEY mapping for nipples always requires end-prep information. For more information, see Nipple Symbol Mapping (on page 686).

**ComponentClass**

Specifies the Piping Component File (PCF) identification text for the piping component. This ID must be a valid ISOGEN Component Type Identifier as described in the ISOGEN documentation, which is accessible from the Help > Printable Guides command.

**NOTES**

- In the current version of the software, any part class that represents a spectacle blind, slip ring, paddle spacer, or other part that needs to have a primary direction output on it must be mapped to one of the following SKEYs: SP, SR, or SB. Likewise, it should be mapped to the component class MISC-COMPONENT.
- Because these three SKEYs are user-definable, you can change the graphics of the SKEYs if necessary, but the names of the SKEYs cannot be changed if the direction output is needed.

**See Also**

Appendix: Isometric Drawing Options (on page 415)  
Appendix: Symbols and Symbol Keys (on page 696)

**Supplement (S3D SymbolMAP)**

Defines supplement symbol mapping for end preparation codes.

**EndPrep1**

Provides a user reference for the symbol mapping.

**EndPrepCode**

Specifies a numerical value from the EndPreparation 3D codelist.

**EndPrepMap**

Specifies the ISOGEN allowable end condition code. For more information, see the Symbol Keys Reference Guide available from Help > Printable Guides.

**Description**

Provides a description of the end preparation mapping.

**See Also**

Appendix: Isometric Drawing Options (on page 415)  
Appendix: Symbols and Symbol Keys (on page 696)
**Nipple Symbol Mapping**

You can map most components using an end preparation of 0.

However, a notable exception is the nipple. For nipples, you must use two different SKEYs and PCF component identifiers, based on the end preparation. The SKEY mapping for nipples always requires end-prep information.

The table below shows an example of SKEY mapping for the nipple.

<table>
<thead>
<tr>
<th>CodeList</th>
<th>PartClassName</th>
<th>SKEY</th>
<th>PCFComponentID</th>
</tr>
</thead>
<tbody>
<tr>
<td>301</td>
<td>Nipple</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>331</td>
<td>Nipple</td>
<td>NRSC</td>
<td>COUPLING</td>
</tr>
<tr>
<td>391</td>
<td>Nipple</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>301</td>
<td>NIP</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>331</td>
<td>NIP</td>
<td>NRSC</td>
<td>COUPLING</td>
</tr>
<tr>
<td>391</td>
<td>NIP</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
</tbody>
</table>

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)

**Intergraph Alternative Text Options (S3D)**

Allows you to modify the values of text strings on isometric drawings.

- **TextPurpose** provides a value corresponding to the text to replace. The values provided are Intergraph-specific.
- **AlternateText** specifies the text you want to display on the isometric drawing.

The table below lists the Intergraph Alternative Text options that are currently supported by the software.

<table>
<thead>
<tr>
<th>TextPurpose Value</th>
<th>AlternateText Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO_SPOOL_DEFAULT – Defines the text output on the drawing if there are no spools in the drawing.</td>
<td>NO SPOOL FOUND</td>
</tr>
<tr>
<td>UNDEFINED_TRACING_SPEC_DEFAULT – Defines the text output on the drawing if the tracing specification is undefined for a feature or a run.</td>
<td>UNDEFINED</td>
</tr>
<tr>
<td>UNDEFINED_PAINT_SPEC_DEFAULT – Defines the text output on the drawing if the painting specification is undefined for a feature or a run.</td>
<td>UNDEFINED</td>
</tr>
</tbody>
</table>
Appendix: Isometric Drawing Options

| UNDEFINED_INSULATION_SPEC_DEFAULT – Defines the text output on the drawing if the insulation specification is undefined for a feature or a run. | UNDEFINED |

**Defines:**
- **Option Switch** - N/A
- **I-Configure** - S3D.IntergraphAlternativeTexts

### Attribute Mapping Options (S3D)
Maps ISOGEN attributes to the software attributes.

#### ExternalName
Specifies a text string for the attribute. You select this text string in the Attributes folder under Drawing Frame.

**NOTE** The Intergraph HostAttribute **Drawing Number** must be mapped to IsogenAttribute **DRG** as of Smart 3D version 6.0. In previous versions of the software, **Drawing Number** was mapped to the IsogenAttribute **DRAWING-NUMBER**.

#### Name
Selects an ISOGEN attribute.

**NOTE** You can customize the mapping of ISOGEN Attributes **ATTRIBUTE11** through **ATTRIBUTE99**. **ATTRIBUTE1** through **ATTRIBUTE10** are reserved by Intergraph. We recommend that you start adding your own attributes from **ATTRIBUTE21**. The Intergraph reserved attributes are defined as follows:

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATTRIBUTE1</td>
<td>Maximum Working Pressure</td>
</tr>
<tr>
<td>ATTRIBUTE2</td>
<td>Maximum Testing Temperature</td>
</tr>
<tr>
<td>ATTRIBUTE3</td>
<td>Maximum Testing Pressure</td>
</tr>
<tr>
<td>ATTRIBUTE4</td>
<td>Extracted By</td>
</tr>
<tr>
<td>ATTRIBUTE5</td>
<td>Checked By</td>
</tr>
<tr>
<td>ATTRIBUTE6</td>
<td>Approved By</td>
</tr>
<tr>
<td>ATTRIBUTE7</td>
<td>Parent Piping System</td>
</tr>
<tr>
<td>ATTRIBUTE8</td>
<td>Fluid Code</td>
</tr>
<tr>
<td>ATTRIBUTE9</td>
<td>Extraction Date</td>
</tr>
<tr>
<td>ATTRIBUTE10</td>
<td>Reserved for Future Use</td>
</tr>
</tbody>
</table>

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)
Appendix: Isometric Drawing Options

Comments Options (S3D)

Allows you to add information to the isometric style file that is not included in the drawing configuration or definition, such as date created and who created the style or modifications and modification dates. This section of the isometric style file act as a history. It is not included in the drawings generated using the style.

**Origin**
Identifies the origin of the isometric style file comment. For example, if the file originally was created by Intergraph, this field contains *Intergraph* as the origin.

**Data**
Specifies the date of the isometric style file creation or modification.

**Initials**
Identifies the initials of the person who typed the comment.

**Comment**
Describes the modification or action that took place with regard to the isometric style file.

**See Also**
*Appendix: Isometric Drawing Options* (on page 415)
Appendix: Isometric Drawings and WBS Items

You can document a collection of parts that are assigned to a Work Breakdown Structure (WBS) item with individual isometric drawings.

This section describes the workflow for assigning parts to the WBS item and creating isometric drawings from the WBS information.

1. In the Piping task, assign the piping objects to an active project with the Project > Claim command. For more information on the Claim command, see Claim Objects in the Common User's Guide.

2. After assigning objects to an active project, assign them to a WBS item with the Project > Assign to WBS command. For more information on the Assign to WBS command, see Assign Objects to a WBS Item in the Common User's Guide.

3. In the Drawings and Reports task, create a new Drawings by Query Manager component with the following options:
   - Select the Catalog Filters > Default Filters > SP3D Object Filters > Object Types > Common > WBS Items > WBS Items - Iso Drawing filter
   - Select the WBS Iso - Fabrication package.

   For more information on creating a Drawings by Query Manager component, see Set up a Drawings by Query Manager component (on page 96).

4. Right-click the Drawings by Query Manager component and select Run Query.

5. Right-click the WBS Iso - Fabrication component and select Create Drawing(s).

6. Right-click the WBS Iso - Fabrication component and select Update Now to update the WBS Isometric drawing.
7. After the drawing updates, right-click the drawing and select **Edit**.
## Appendix: Personal ISOGEN Return Values

If an isometric extraction fails, ISOGEN returns an error number which can be referenced from an error message or the extraction error log within the software. Descriptions for the ISOGEN error message numbers are shown in the table below.

<table>
<thead>
<tr>
<th>Error Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1001</td>
<td>Failed to create the specified Pre/Post Processor.</td>
</tr>
<tr>
<td>-1002</td>
<td>Pre/Post Processor has crashed.</td>
</tr>
<tr>
<td>-1003</td>
<td>Pre/Post processor has timed out and the external process has been killed.</td>
</tr>
<tr>
<td>-1004</td>
<td>Pre/Post processor has timed out but the external process cannot be terminated (and is therefore still running).</td>
</tr>
<tr>
<td>-1</td>
<td>Error in Isogen data. Check message file.</td>
</tr>
<tr>
<td>-2</td>
<td>Isogen dll failed to load (possible installation problem, missing dependent file, etc.) or crash occurred during execution, which has been trapped by the error handler.</td>
</tr>
<tr>
<td>-3</td>
<td>Isogen thread filed to finish -- possible execution loop which has been terminated by Personal Isogen.</td>
</tr>
<tr>
<td>0</td>
<td>Iso created successfully.</td>
</tr>
<tr>
<td>1</td>
<td>Personal ISOGEN cannot find the isometric directory specified.</td>
</tr>
<tr>
<td>2</td>
<td>Invalid Style for this project. The specified Style cannot be found under the specified project.</td>
</tr>
<tr>
<td>3</td>
<td>Specified Project not found. The specified project cannot be found.</td>
</tr>
<tr>
<td>4</td>
<td>IDFGEN handshake failed. The handshake passed to the idfdll.dll has not been verified.</td>
</tr>
</tbody>
</table>

**NOTE** A number of other "unexpected" failures have been found to generate this error.

| 5           | Could not access specified PCF in TEMFILES. |
| 6           | ISOGEN DLL failed to establish current directory. |
Appendix: Personal ISOGEN Return Values

7 ISOGEN DLL failed to change directory.

8 The handshake passed to the pisodll.dll has not been verified.

9 Personal ISOGEN failed to produce a valid drawing. View message file for details as there are many possible causes.

10 ISOGEN DLL failed to restore working directory.

11 IDFGEN DLL failed to establish current directory.

12 IDFGEN DLL failed to change directory.

13 IDFGEN did not complete successfully. View message file for details. One common cause is that the components in the PCF do not form a connected system.

14 IDFGEN DLL failed to restore working directory.

15 IDFGEN could not delete IPISOGEN\PROGRAMS\FOR036.DAT from a previous run.

16 IDFGEN was unable to create ISOGEN.IDX file. Error opening isogen.idx. Error closing isogen.idx.

17 IDFGEN was unable to copy ISOGEN.FLS to the PROGRAMS directory. The following errors may have occurred:
   Error allocating memory to store a line.
   Zero line length encountered.
   Error opening source isogen.xls (in specified project\isotype).
   Error opening target isogen.xls (in pisogen\programs).
   Error closing source isogen.xls (in specified project\isotype).
   Error closing target isogen.xls (in pisogen\programs).

18 No description available from Alias Personal ISOGEN.

19 Personal ISOGEN handshake failed. The handshake passed to the pisogen.dll has not been verified.

20 Unknown Error in Personal ISOGEN. An unexpected path through the program has occurred.

21 PISOGEN DLL could not find Current Working Directory. The current directory cannot be identified.

22 PISOGEN DLL could not Change Directory to \PISOGEN\PROGRAMS.

23 ISOGEN failed to write banner to message file. (Probably cannot find message file path). The following errors may have occurred:
Appendix: Personal ISOGEN Return Values

Error opening isogen.fls.
Unable to find MESSAGE line in isogen.fls.
Error closing isogen.fls.
Error opening message file.
Error closing message file.

PISOGEN DLL has been unable to restore current working directory.

The following errors may have occurred:
Error opening i-gen.fls for reading.
Error opening isogen.fls for writing.
Error opening options file specified in i-gen.fls.
Error closing options file specified in i-gen.fls.
Error opening i-gen.opl for writing.
Error closing i-gen.opl.
Error closing i-gen.fls.
Error closing isogen.fls.

Problem with the specified isometric root directory.

Problem setting the current isometric root directory.

Invalid file extension.

Not applicable when running Isogen.

Warning occurred creating a POD (intermediate) file.

Error occurred creating a POD (intermediate) file. Error occurred during "pass 1" when the input IDF file is preprocessed.

Error occurred creating a POD (intermediate) file. Error occurred during "pass 2" when the POD file is being created from Isogen data.

Failed to load PODGRAPHICS DLL - used in the creation of graphics output files such as DWG and IGR.

PODGRAPHICS process failed - IE. a graphics specific process has failed - for example, user requested IGR output but SmartSketch is not installed.

Not used at this time.

Cannot get path to system temp directory.

System temp directory does not exist.
Appendix: Personal ISOGEN Return Values

<table>
<thead>
<tr>
<th>Error Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>43</td>
<td>Unable to set bore units to those specified in the input file.</td>
</tr>
<tr>
<td>44</td>
<td>Unable to perform macro substitution in style ISOGEN.FLS.</td>
</tr>
<tr>
<td>45</td>
<td>Unable to restore original style ISOGEN.FLS.</td>
</tr>
<tr>
<td>46-49</td>
<td>Not used at this time.</td>
</tr>
<tr>
<td>50</td>
<td>Project disk is full - unable to create new output files.</td>
</tr>
<tr>
<td>51</td>
<td>File containing temp directory is full - unable to process file.</td>
</tr>
<tr>
<td>52-999</td>
<td>Not used at this time.</td>
</tr>
<tr>
<td>1000</td>
<td>Expected files missing in Style - E.G. no FLS, no options file.</td>
</tr>
<tr>
<td>1001</td>
<td>Requested units combination is inconsistent - probably means a combination of metric bore and imperial coordinates.</td>
</tr>
<tr>
<td>1002</td>
<td>Invalid drawing format requested.</td>
</tr>
<tr>
<td>1003</td>
<td>Problem deleting an ISOGEN message file.</td>
</tr>
<tr>
<td>1004</td>
<td>Line in the options file has invalid format.</td>
</tr>
<tr>
<td>1005</td>
<td>Too many switches in the options file.</td>
</tr>
<tr>
<td>1006</td>
<td>Too few switches in the options file.</td>
</tr>
<tr>
<td>1007</td>
<td>MicroStation design file output requested but MS.EXE environment variable is not defined.</td>
</tr>
<tr>
<td>1008</td>
<td>MicroStation design file output requested but MicroStation not installed.</td>
</tr>
<tr>
<td>1009</td>
<td>MS_EXE environment variable does not end with a .</td>
</tr>
<tr>
<td>1010</td>
<td>ISOGEN.FLS missing in Style.</td>
</tr>
<tr>
<td>1011</td>
<td>Options file missing specified in ISOGEN.FLS is missing.</td>
</tr>
</tbody>
</table>

The following **warning** messages may also display:

<table>
<thead>
<tr>
<th>Error Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999</td>
<td>Isogen has returned a FAIL for one or more drawings in the set. This means it has been unable to layout the drawing successfully.</td>
</tr>
<tr>
<td>2001</td>
<td>Inconsistent units combination (imperial coordinates and metric bores).</td>
</tr>
</tbody>
</table>
Appendix: Personal ISOGEN Return Values

2022  IDFGEN has detected a disconnected pipeline that cannot be resolved. This is known as a HARD disconnect. Drawings have still been created that will indicate the cause of the disconnection.

2023  IDFGEN has detected a disconnected pipeline that cannot be resolved, but the disconnected items are not considered to be fundamental to the pipeline. This is known as a FLOATING disconnect. Drawings have still been created that will indicate the cause of the disconnection.

2024  IDFGEN has detected a disconnected pipeline that has been resolved. This is known as a SOFT disconnect. Drawings have still been created that will indicate the cause of the disconnection.

See Also
   Edit Options (Piping Isometric Drawing Component Shortcut Menu) (on page 115)
Appendix: Symbols and Symbol Keys

The Drawings and Reports task delivers a symbol library containing ISOGEN symbols. You can use the Alias symbol editor or the PDS Isometric Symbol Editor to modify the symbols.

Each symbol is associated with a unique code called a symbol key (SKEY). SKEYs contain 2-4 letters; the first two letters define the type of component, and the last two letters define the end type such as flanged, butt welded, or screwed. You can specify a wildcard for the end type. For example, when ** is specified for the end type, the software reads the End Prep from the part and assigns the correct ISOGEN end type.

You can map the symbol keys using the Edit Options command. This command displays the Isometric Style Options Browser, the tool used to control all the options related to the appearance and information content of the various styles of isometric drawings.

**NOTES**

- Before you modify a symbol, review the dimensions and connect points. For more information about the position of SKEY connection points, see ISOGEN® SKEY Dimensions (on page 697).
- For a list of delivered piping part classes and their corresponding SKEYs, see ISOGEN Symbol Key Mapping (on page 744).
- Additional SKEYs are available for use in customizing piping part classes. For more information, see the Alias document titled ISOGEN SKEY Definitions, available from Help > Printable Guides.
- When defining 3- and 4-way valves, only define one leg of the valve. The software will copy the re-defined leg to the remaining legs. You must ensure that the leg of the valve you re-define has the connection to the left and the center point or spindle point to the right.
- The @ character in the symbol keys can be replaced with an integer value in the range 1 to 9, inclusive, to denote the number of segments. Currently, regardless of the value assigned to @, the software draws the symbol per the SKEY plotted isometric shape.
- The + character in the symbol keys can be replaced with an integer value in the range 1 to 9, inclusive, to denote the bend radius.
- You can map most components using an end preparation of 0. However, a notable exception is the nipple. For nipples, you must use two different SKEYs and Piping Component File (PCF) component identifiers, based on the end preparation. In other words, the SKEY mapping for nipples always requires end-prep information.
- If, during drawing extraction, the software encounters a component that lacks SKEY mapping data, the extraction continues as long as the Drawing.Controls.NoSymbolMapOk option is set to True. The resulting drawing displays the component with an empty gap, along with an error message that points to the gap. In addition, the message file contains an error message.
In This Appendix
ISOGEN® SKEY Dimensions .................................................................697
ISOGEN Symbol Key Mapping ...............................................................744
Caps (SKEYs) ...................................................................................787
Couplings (SKEYs) ..........................................................................787
Crosses (SKEYs) .............................................................................788
Elbows and Bends (SKEYs) ..............................................................789
End Prep Connections ......................................................................792
Fixed Length Pipes (SKEYs) ............................................................792
Flanges (SKEYs) .............................................................................793
Inline Filters (SKEYs) ......................................................................794
Instruments (SKEYs) ........................................................................795
LJSE Type Flanges (SKEYs) .............................................................798
Miscellaneous Items (SKEYs) ..........................................................800
Miscellaneous Pipe Components (SKEYs) .......................................800
Olets (SKEYs) ..................................................................................802
Operators (SKEYs) ..........................................................................804
Other End Connections (SKEYs) .....................................................805
Reducers (SKEYs) ............................................................................806
Tees (SKEYs) ..................................................................................809
Traps (SKEYs) ...............................................................................811
Valves (SKEYs) ...............................................................................811
Vents (SKEYs) ...............................................................................814
Welds (SKEYs) ..............................................................................814

ISOGEN® SKEY Dimensions

ARFL: Valve - Angle Relief/Vent

[Diagram of ARFL Valve - Angle Relief/Vent]
Appendix: Symbols and Symbol Keys

AVFL: Valve - Angle

AXFL: Valve - Angle Pressure Reducing

BAFL: Block - Angle
Appendix: Symbols and Symbol Keys

**BOFL: Block - Offset**

**BRFL: Block**
Appendix: Symbols and Symbol Keys

C3FL: Valve - Three-Way Control

C4FL: Valve - Four-Way Control
CAFL: Valve - Angle Control

CEBW: Coupling - Elbolet (Butt Weld)

CESC: Coupling - Elbolet (Screwed)
Appendix: Symbols and Symbol Keys

CESW: Coupling - Elbolet (Socket Weld)

CHFL: Hose Coupling

CKFL: Valve - Check

COCP: Coupling - Compression
Appendix: Symbols and Symbol Keys

COSC: Coupling - Screwed

COSW: Coupling - Socket Weld

CPBW: Reducer - Concentric Fabricated from Plate

CPFL: Reducer - Concentric Fabricated from Plate (Flanged)
**Appendix: Symbols and Symbol Keys**

**CSBW:** Reducer - Concentric Swaged From Plate

![Diagram of CSBW symbol]

**CSFL:** Reducer - Concentric Swaged From Plate (Flanged)

![Diagram of CSFL symbol]

**CTBW:** Reducer - Concentric with a Connection (Butt Weld)

![Diagram of CTBW symbol]
Appendix: Symbols and Symbol Keys

CTFL: Reducer - Concentric with a Connection (Flanged)

CTSC: Reducer - Concentric with a Connection (Screwed)

CTSW: Concentric with a Connection (Socket Weld)
Appendix: Symbols and Symbol Keys

CVFL: Valve - Control

CXBW: Reducer - Concentric with a Connection Swaged from Pipe

CXFL: Reducer - Concentric with a Connection Swaged from Pipe (Flanged)

CZBW: Reducer - Concentric with a Connection Fabricated from Plate
CZFL: Reducer - Concentric with a Connection Fabricated from Plate (Flanged)

DR: Rupture Disk

EPBW: Reducer - Eccentric Fabricated from Plate

EPFL: Reducer - Eccentric Fabricated from Plate (Flanged)
**EPSW:** Reducer - Eccentric Fabricated from Plate (Socket Weld)

**ESBW:** Reducer - Eccentric Swaged from Pipe

**ESFL:** Reducer - Eccentric Swaged from Pipe (Flanged)

**EXBW:** Reducer - Eccentric with a Connection Swaged from Pipe
EXFL: Reducer - Eccentric with a Connection Swaged from Pipe (Flanged)

EXFL: Expansion Bellows

EZBW: Reducer - Eccentric with a Connection Fabricated from Plate
EZFL: Reducer - Eccentric with a Connection Fabricated from Plate (Flanged)

FAFL: Filter/Strainer - Angle

FIFL: Filter/Strainer - Straight Through
FLBL: Flange - Blind

FLFL: Flange - Flared/Loose Backing

FLLB: Flange - Backing

FLOW: Flow Arrow
Appendix: Symbols and Symbol Keys

FLRC: Flange - Reducing Concentric

FLRE: Flange - Reducing Eccentric

FLRG: Lap Joint - Ring Loose

FLSC: Flange - Screwed
Appendix: Symbols and Symbol Keys

FLSE: Lap Joint - Stub End Loose

FLSJ: Flange - Slip On with J-type Weld

FLSO: Flange - Slip On

FLSW: Flange - Socket Weld
Appendix: Symbols and Symbol Keys

FLWN: Flange - Weld Neck

FOFL: Filter/Strainer - Offset

FOSO: Flange - Orifice (Slip On)

FOWN: Flange - Orifice (Weld Neck)

FPPL: Fixed Length Pipe - Without Flanged Ends
Appendix: Symbols and Symbol Keys

FRFL: Filter/Strainer - Return

FTFL: Flame Trap

FXFL: Filter/Strainer - Return
Appendix: Symbols and Symbol Keys

H3FL: Valve - Three-Way Control (Hand Indicator)

H4FL: Valve - Four-Way Control (Hand Indicator)

HAFL: Valve - Angle Control (Hand Indicator)

HCSC: Olet - Half Coupling (Screwed)
Appendix: Symbols and Symbol Keys

HCSW: Olet - Half Coupling (Socket Weld)

HVFL: Valve - Control Hand Indicator

IAFL: Instrument - Angle

IDFL: Instrument - Dial (Flanged)

IDPL: Instrument - Dial
Appendix: Symbols and Symbol Keys

IIFL: Instrument

IOFL: Instrument - Offset

IRFL: Instrument - Return
Appendix: Symbols and Symbol Keys

ITFL: Instrument - Tee

KABW: Cap - Butt Weld

KACP: Cap - Compression

KASC: Cap - Screwed

KASW: Cap - Socket Weld

LABW: Olet - Latrolet (Buttweld)
M3FL: Valve - Three-Way Control (Motorized Indicator)

M4FL: Valve - Four-Way Control (Motorized Indicator)

MAFL: Valve - Angle Control (Motorized Indicator)

MVFL: Valve - Control (Motorized Indicator)
Appendix: Symbols and Symbol Keys

NBSC: Nipple - Screwed

NCFL: Non-Category Item

NIPL: Olet - Nipolet (Plain End)

NISC: Olet - Nipolet (Screwed)
NRSC: Nippled - Screwed

OP: Orifice Plate

OTBW: Reducer - Eccentric with a Connection (Butt Weld)

OTFL: Reducer - Eccentric with a Connection (Flanged)
Appendix: Symbols and Symbol Keys

OTSC: Reducer - Eccentric with a Connection (Screwed)

PF: Pipe Block - Fixed Length

PL: Plug

PR: Restrictor Plate

PV: Pipe Block - Variable Length
Appendix: Symbols and Symbol Keys

RAFL: Valve - Angle (Relief/Vent)

RBSC: Reducer - Concentric (Screwed Bush)

RBSW: Reducer - Concentric (Socket Weld)

RCBW: Reducer - Concentric (Butt Weld)
Appendix: Symbols and Symbol Keys

**RCCP: Reducer - Concentric (Compression)**

![RCCP Diagram]

**RCFL: Reducer - Concentric (Flanged)**

![RCFL Diagram]

**RCSC: Reducer - Concentric (Screwed)**

![RCSC Diagram]

**RCSW: Reducer - Concentric (Socket Weld)**

![RCSW Diagram]
Appendix: Symbols and Symbol Keys

RD: Rupture Disk

REBW: Reducer - Eccentric (Butt Weld)

REFL: Reducer - Eccentric (Flanged)

RESC: Reducer - Eccentric (Screwed)
Appendix: Symbols and Symbol Keys

RF: Reducer - Special Reducing Flange

RFPL: Reducer - Connection Block

RNSC: Reducer - Concentric (Nipple)

RP: Restrictor Plate
Appendix: Symbols and Symbol Keys

RVFL: Valve - Relief/Vent

S3FL: Valve - Three-Way Control (Square Indicator)
Appendix: Symbols and Symbol Keys

S4FL: Valve - Four-Way Control (Square Indicator)

SAFL: Valve - Angle Control (Square Indicator)
Appendix: Symbols and Symbol Keys

SB: Spectacle - Blind

SGFL: Sight Glass

SKSW: Olet - Sockolet
Appendix: Symbols and Symbol Keys

SP: Slip Plate

SR: Slip Ring

SVFL: Valve - Control (Square Indicator)
Appendix: Symbols and Symbol Keys

SWBW: Olet Sweepolet

TAFL: Trap - Angle

THSC: Olet - Thredolet
Appendix: Symbols and Symbol Keys

TIFL: Trap - Inline Straight Through

TOFL: Trap - Offset
Appendix: Symbols and Symbol Keys

TRFL: Trap - Return

TUFL: Tundish (Funnel)
UNSC: Union - Screwed

UNSW: Union - Socket Weld
V3FL: Valve - Three-Way

V4FL: Valve - Four-Way

VBFL: Valve - Ball
Appendix: Symbols and Symbol Keys

VCFL: Valve - Check

VDFL: Valve - Diaphragm

VGFL: Valve - Globe
Appendix: Symbols and Symbol Keys

VKFL: Valve - Cock

VNFL: Valve - Needle

VPFL: Valve - Plug
Appendix: Symbols and Symbol Keys

VRFL: Valve - Relief/Vent

VSFL: Valve - Slide

VTFL: Valve - Gate
Appendix: Symbols and Symbol Keys

VVFL: Valve - Basic

VXFL: Valve - Pressure Reducing

VYFL: Valve - Butterfly
WTBW: Olet - Weldolet

X AFL: Valve - Angle (Pressure Reducing)

XVFL: Valve - Pressure Reducing
Appendix: Symbols and Symbol Keys

01HG: Support/Hanger

01SP: Used on valves with AV, V3, V4, VD, VG, or VV as the first two characters of their SKEYs.

02SP: Used on valves with AR, RA, VR as the first two characters of their SKEYs.

03SP: Used on valves with VB, VK, VY as the first two characters of their SKEYs.

04SP: Not Used
Appendix: Symbols and Symbol Keys

05SP: Used on valves with VT as the first two characters of their SKEYs.

06SP: Used on valves with VN as the first two characters of their SKEYs.

07SP: Used on valves with VP as the first two characters of their SKEYs.

08SP: Used on valves with VS as the first two characters of their SKEYs.

09SP: Used on valves with AX, VX, or XA as the first two characters of their SKEYs.
Appendix: Symbols and Symbol Keys

10SP: Used on valves with SA, SV, S3, or S4 as the first two characters of their SKEYs.

11SP: Used on valves with MA, MV, M3, or M4 as the first two characters of their SKEYs.

See Also
Appendix: Symbols and Symbol Keys (on page 696)

ISOGEN Symbol Key Mapping
The table below maps which PCF symbol key and PCF component is used for each Smart 3D part class.

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>11_25DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB163</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB164</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB176</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB177</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB704</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB706</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB707</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB708</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>--------------</td>
</tr>
<tr>
<td>11_25DegElbowPDB709</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB710</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>11_25DegElbowPDB711</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>180DegReturn</td>
<td>0</td>
<td>EU**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>1by8BendDoubleYbyFace</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>1by8BendDoubleYbySeat</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>1by8BendDoubleYF12C</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>1by8BendDoubleYTanLen1</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>1by8BendDoubleYTanLen3</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>1by8BendWyebyFace</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>1by8BendWyebySeat</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>1by8BendWyeF12C</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>1by8BendWyeTanLen1</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>1by8BendWyeTanLen3</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>1by8ReducingWye</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>22_5DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB160</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB161</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB162</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB163</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB164</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB165</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB170</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>22o5DegElboPDB175</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>2205DegElboPDB176</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB177</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB179</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB180</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB185</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB691</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB692</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB694</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB695</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB696</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB697</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB698</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB699</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB700</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElboPDB701</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElbowPDB10</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElbowPDB690</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2205DegElbowPDB693</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>2PRVA1</td>
<td>0</td>
<td>CA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>30DegAsymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB163</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>30DegElbowPDB164</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB176</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB177</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB683</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB684</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB685</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegElbowPDB686</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>30DegSymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>3OP1</td>
<td>0</td>
<td>OP</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>3WayBall</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayBallValve</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayBallValvePDB10</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayBallValvePDB11</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayBallValvePDB13</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayCheckValve</td>
<td>0</td>
<td>K3**</td>
<td>VALVE</td>
</tr>
<tr>
<td>3WayCheckValve1</td>
<td>0</td>
<td>K3**</td>
<td>VALVE</td>
</tr>
<tr>
<td>3WayCheckValve2</td>
<td>0</td>
<td>K3**</td>
<td>VALVE</td>
</tr>
<tr>
<td>3WayControlValvePDB10</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayControlValvePDB11</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayControlValvePDB13</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayDiaDiv</td>
<td>21</td>
<td>C3FL</td>
<td>INSTRUMENT-3WAY</td>
</tr>
<tr>
<td>3WayDiverterValvePDB10</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayDiverterValvePDB11</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>3WayDiverterValvePDB13</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayGlobeValvePDB10</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayGlobeValvePDB11</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayGlobeValvePDB13</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayPlugValvePDB10</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayPlugValvePDB11</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>3WayPlugValvePDB13</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>45Deg3DElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegAngleValPDB13</td>
<td>0</td>
<td>AR**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>45DegAsymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB10</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB161</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB162</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB163</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB164</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB176</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB177</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB179</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB180</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB668</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB669</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>45DegElbowPDB670</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB671</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB672</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB673</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB674</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB675</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB676</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB677</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB678</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegElbowPDB679</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegLRElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegLTElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegStreetElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegStreetElbowFlat</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegStreetElbowHex</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegSymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>45DegUnionElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>4BOX</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>4BOX3</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>4BOX4</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>4CYL</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>4CYL3</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>4CYL4</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>5_625DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------</td>
<td>---------</td>
<td>---------------</td>
</tr>
<tr>
<td>5_625DegElbowPDB163</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB164</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB176</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB177</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB715</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB716</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB717</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>5_625DegElbowPDB718</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegAsymElbow</td>
<td>301</td>
<td>ELBWN</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB10</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB161</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB162</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB163</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB164</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB176</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB177</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB179</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB180</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB653</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>60DegElbowPDB654</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB655</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB656</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB657</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB658</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB659</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB660</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB661</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB662</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB663</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegElbowPDB664</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>60DegSymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB10</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB13</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB161</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB162</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB179</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB180</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB35</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB36</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB642</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB643</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB644</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB645</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB646</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>----------</td>
<td>------------------------</td>
</tr>
<tr>
<td>72DegElbowPDB647</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB648</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>72DegElbowPDB649</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90Deg3DElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegAsymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegLRElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegLTElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegRedElbow</td>
<td>421</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB10</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB13</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB161</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB162</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB163</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB164</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB176</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB177</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB179</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB180</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB35</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB36</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB723</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB724</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB725</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB726</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>------------------------</td>
</tr>
<tr>
<td>90DegRedElbowPDB727</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB728</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB729</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedElbowPDB730</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegRedStreetElbow</td>
<td>441</td>
<td>ERSC</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegReducingElbow</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegReducingStreetElbow</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegReducingYBranch</td>
<td>0</td>
<td>ER**</td>
<td>ELBOW-REDUCING</td>
</tr>
<tr>
<td>90DegSRElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegStreetElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegStreetElbowFlat</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegStreetElbowHex</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegSymElbow</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegUnionElbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DegYBranch</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>90DoubleElbowPDB10</td>
<td>0</td>
<td>ETCP</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowPDB13</td>
<td>0</td>
<td>ETCP</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowPDB35</td>
<td>0</td>
<td>ETCP</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowPDB36</td>
<td>0</td>
<td>ETCP</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowTPDB10</td>
<td>0</td>
<td>ET**</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowTPDB13</td>
<td>0</td>
<td>ET**</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowTPDB35</td>
<td>0</td>
<td>ET**</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>90DoubleElbowTPDB36</td>
<td>0</td>
<td>ET**</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>AdapterFlange</td>
<td>211</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>ANG</td>
<td>0</td>
<td>CA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
</tbody>
</table>
## Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>AngleCheckValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngleControlValve</td>
<td>21</td>
<td>CAFL</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>AngleGlobeValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngleGlobeValve_Asym</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngleHoseValve</td>
<td>441</td>
<td>AVSW</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngleStopCheckValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngleValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngleValve45Deg</td>
<td>21</td>
<td>AVFL</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AngLiftCheckValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AsymAngleGlobeValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AsymAngleStopCheckVal</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>AsymButterflyValveSym</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymButterflyValveVAL</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymButterflyValveVOH</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymDelugeValve</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymDiaphragmValve150</td>
<td>0</td>
<td>VD**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymDiaphragmValve300</td>
<td>0</td>
<td>VD**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymHorLiftCheckValve</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymHorYLiftCheckValve</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymPlugValve</td>
<td>0</td>
<td>VP**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymSngBasketStrainer</td>
<td>0</td>
<td>FI**</td>
<td>FILTER</td>
</tr>
<tr>
<td>AsymStopCheckValve</td>
<td>0</td>
<td>CK**</td>
<td>VALVE</td>
</tr>
<tr>
<td>AsymZeroDeadlegTval</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>AutoRecirculationValve</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>BA3W</td>
<td>0</td>
<td>C3**</td>
<td>INSTRUMENT-3WAY</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>BallGOpAsymmetrical</td>
<td>0</td>
<td>VB**</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValAsymmetrical</td>
<td>21</td>
<td>VBFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValCentertoSeat</td>
<td>421</td>
<td>VBSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValEtoEandValFtoF</td>
<td>21</td>
<td>VBFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValNipleLenValFtoC</td>
<td>21</td>
<td>VBFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValNipleLenValFtoF</td>
<td>21</td>
<td>VBFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValSeattoSeat</td>
<td>421</td>
<td>VBSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValve</td>
<td>0</td>
<td>VB**</td>
<td>VALVE</td>
</tr>
<tr>
<td>BallValve_m</td>
<td>0</td>
<td>VB**</td>
<td>VALVE</td>
</tr>
<tr>
<td>BALR</td>
<td>421</td>
<td>VBSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>BALSP</td>
<td>21</td>
<td>VBFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BasinCross</td>
<td>441</td>
<td>CRSC</td>
<td>CROSS</td>
</tr>
<tr>
<td>BasketStrainer</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>BasketStrainer2</td>
<td>0</td>
<td>FI**</td>
<td>FILTER</td>
</tr>
<tr>
<td>Bellows</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>Bend</td>
<td>421</td>
<td>BESW</td>
<td>BEND</td>
</tr>
<tr>
<td>Bend</td>
<td>301</td>
<td>BEBW</td>
<td>BEND</td>
</tr>
<tr>
<td>Bend</td>
<td>391</td>
<td>PB</td>
<td>BEND</td>
</tr>
<tr>
<td>Bend</td>
<td>0</td>
<td>BEBW</td>
<td>BEND</td>
</tr>
<tr>
<td>BFYYP</td>
<td>211</td>
<td>VYFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BFYHPGO</td>
<td>211</td>
<td>VYFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>BlankDisc</td>
<td>121</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>BlankGateValAsym</td>
<td>0</td>
<td>VT**</td>
<td>VALVE</td>
</tr>
<tr>
<td>BlindFlange</td>
<td>0</td>
<td>FLBL</td>
<td>FLANGE-BLIND</td>
</tr>
<tr>
<td>BlindFlange_m</td>
<td>0</td>
<td>FLBL</td>
<td>FLANGE-BLIND</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>---------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>BlindHub</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>BLPAD</td>
<td>0</td>
<td>SP</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>BLSpA</td>
<td>0</td>
<td>SR</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>BLSPO</td>
<td>0</td>
<td>SB</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>BubbleDetector</td>
<td>441</td>
<td>IISC</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Bushing</td>
<td>0</td>
<td>UN**</td>
<td>UNION</td>
</tr>
<tr>
<td>ButterflyGOpAsym</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
<tr>
<td>ButterflyValve</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
<tr>
<td>ButterflyValve_m</td>
<td>121</td>
<td>VYFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>ButterflyValveArmLength</td>
<td>541</td>
<td>VVPF</td>
<td>VALVE</td>
</tr>
<tr>
<td>ButterflyValveElec</td>
<td>201</td>
<td>CVFL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>ButterflyValveOnOffV</td>
<td>201</td>
<td>CVFL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>ButterflyValveOperHgt</td>
<td>111</td>
<td>VVFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>ButterflyValveVarArmLength</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
<tr>
<td>ButterflyValveVarOpHeigh</td>
<td>0</td>
<td>VY**</td>
<td>VALVE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cap</td>
<td>0</td>
<td>KA**</td>
<td>CAP</td>
</tr>
<tr>
<td>CAPS</td>
<td>0</td>
<td>KA**</td>
<td>CAP</td>
</tr>
<tr>
<td>CAPTC</td>
<td>920</td>
<td>KALC</td>
<td>FLANGE-BLIND</td>
</tr>
<tr>
<td>CheckValve</td>
<td>0</td>
<td>CK**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CheckValve_Fem</td>
<td>0</td>
<td>CK**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CheckValveSwing</td>
<td>0</td>
<td>CK**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CI3WayControlVal</td>
<td>0</td>
<td>C3**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CIAnalyzer</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>CIAngGlobeControlVal</td>
<td>0</td>
<td>CA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIAutoRecirculationVal</td>
<td>0</td>
<td>C3**</td>
<td>INSTRUMENT-3WAY</td>
</tr>
<tr>
<td>CIBallControlValve</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CIBalloonInstrument</td>
<td>0</td>
<td>IDPL</td>
<td>INSTRUMENT-DIAL</td>
</tr>
<tr>
<td>CIDActEPPAngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIDActEPPHWAngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIDActEPPHWGISVal</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CIDActEPPHWTopAngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIDActEPPHWTopGIscVal</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CIElecActTy1AngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIElecActTy2AngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIElecActTy3AngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIElecActTy4AngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIElecActTy5AngVal</td>
<td>0</td>
<td>IA**</td>
<td>INSTRUMENT-ANGLE</td>
</tr>
<tr>
<td>CIFlowNozzle</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CIGateVGearA</td>
<td>0</td>
<td>HV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CGlobeControlVal</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CILevelIndControlType3</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CILevelIndControlType4</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CILevelIndControlType6</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CIPlugControlVal</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CircularSiphonFormD</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CircularSiphonFormG</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CIRoDAcTEPHPHWPosC1Val</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CIRoDAcTEPHPHWPosD1Val</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>CISlideControlValve</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CITempFusiblePlug</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CVacRelRuptureDiscTy1</td>
<td>0</td>
<td>RD</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CVacRelRuptureDiscTy2</td>
<td>0</td>
<td>RD</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CVenturimeter</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CKL</td>
<td>0</td>
<td>CK**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CKLR</td>
<td>421</td>
<td>CKSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>CKS</td>
<td>21</td>
<td>CKFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>CKWF</td>
<td>121</td>
<td>CKFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>Clamp</td>
<td>0</td>
<td>CLMP</td>
<td>CLAMP</td>
</tr>
<tr>
<td>ClampHDHWN_TriClover</td>
<td>920</td>
<td>CLMP</td>
<td>CLAMP</td>
</tr>
<tr>
<td>ClamponFlowSensor</td>
<td>301</td>
<td>IIBW</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CloseCoupledBranchVal</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>CloseCoupledBranchVal2</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>CombinationValve</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>ConcentricReducer</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConcentricReducer_b</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConcentricReducer_m</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConcentricReducer447_1</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConcentricReducer447_2</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConcentricSwage</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConcReducer</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ConductivitySensor</td>
<td>21</td>
<td>IIFL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>ConduitGateValve</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>ConservationVent</td>
<td>21</td>
<td>IIFL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>ControlGateValve</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>ControlGateValveOA</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Coupling</td>
<td>331</td>
<td>COSC</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Coupling</td>
<td>301</td>
<td>CEBW</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Coupling</td>
<td>421</td>
<td>COSW</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Coupling_m</td>
<td>421</td>
<td>COSW</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Coupling_m</td>
<td>331</td>
<td>COSC</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Coupling_m</td>
<td>301</td>
<td>CEBW</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Coupling_PDB</td>
<td>421</td>
<td>COSW</td>
<td>COUPLING</td>
</tr>
<tr>
<td>CPL</td>
<td>421</td>
<td>COSW</td>
<td>COUPLING</td>
</tr>
<tr>
<td>CPLB</td>
<td>0</td>
<td>CLMP</td>
<td>CLAMP</td>
</tr>
<tr>
<td>Cross</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB589</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB590_1</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB590_2</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB591</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB592</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB593</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB594</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB595</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB596</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB597</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB598</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB599</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB600</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>CrossPDB601</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB602</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB603</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB604</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossPDB605</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed589</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed590_1</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed590_2</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed591</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed592</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed593</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed597</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed598</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed599</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed600</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed601</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed602</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed603</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed604</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CrossRed605</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>CS3WayBallCVal</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>CS3WayControlVal</td>
<td>0</td>
<td>C3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>CS3WayGlobeCVal</td>
<td>0</td>
<td>C3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>CS3WayPlugCVal</td>
<td>0</td>
<td>C3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>CS4WayPlugCVal</td>
<td>0</td>
<td>C4**</td>
<td>VALVE-4WAY</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>---------</td>
<td>---------------------</td>
</tr>
<tr>
<td>CSAngGlobeCVal</td>
<td>0</td>
<td>CA**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>CSAutoRecircVal</td>
<td>0</td>
<td>C3**</td>
<td>INSTRUMENT-3WAY</td>
</tr>
<tr>
<td>CSBallCValve</td>
<td>0</td>
<td>VB**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSBallooInstr</td>
<td>0</td>
<td>IDPL</td>
<td>INSTRUMENT-DIAL</td>
</tr>
<tr>
<td>CSBallooInstr</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CSBasketStrainer</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSBoxSinPort</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSCylSinPort</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSExhaustHead</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSExpJointOff</td>
<td>0</td>
<td>EX**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSFreeVent</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSFlowNozzle</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSGlobeCVal</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSIsInLineSilencer</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSISteamTrapTy4</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>CSISteamTrapTy5</td>
<td>0</td>
<td>TR**</td>
<td>TRAP-RETURN</td>
</tr>
<tr>
<td>CSISteamTrapTy6</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>CSISteamTrapTy7</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>CSISteamTrapTy8</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>CSIndCtrlTy3</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CSIndCtrlTy4</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CSIndCtrlTy6</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>CSPlugCVValve</td>
<td>0</td>
<td>VP**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSRDiscVac2</td>
<td>0</td>
<td>RD</td>
<td>SAFETY-DISC</td>
</tr>
<tr>
<td>CSRuptureDiscV1</td>
<td>0</td>
<td>RD</td>
<td>SAFETY-DISC</td>
</tr>
<tr>
<td>CSSlideCVValve</td>
<td>0</td>
<td>VS**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSSprayNozzle</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSTFPlug</td>
<td>0</td>
<td>PL**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSTStrainer</td>
<td>21</td>
<td>TEFL</td>
<td>TEE</td>
</tr>
<tr>
<td>CSTStrainer</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>CSVValve</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSVValveOpGear</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSVValveOpHandwheel</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSVValveOpWrench</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>CSVVentSilencer</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>CSVVenturimeter</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>CSWOSteamTrap</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>CSYStrainer</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>CylinderValve</td>
<td>0</td>
<td>AV**</td>
<td>VALVE-ANGLE</td>
</tr>
<tr>
<td>DIA</td>
<td>21</td>
<td>VDFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>DIALT</td>
<td>301</td>
<td>VDBW</td>
<td>VALVE</td>
</tr>
<tr>
<td>DIAMM</td>
<td>920</td>
<td>VDLC</td>
<td>VALVE</td>
</tr>
<tr>
<td>Diaphragm Valve Body</td>
<td>0</td>
<td>VD**</td>
<td>VALVE</td>
</tr>
<tr>
<td>Diaphragm Valve Body PDB5</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>DIA WM</td>
<td>0</td>
<td>VD**</td>
<td>VALVE</td>
</tr>
<tr>
<td>Distance Piece</td>
<td>121</td>
<td>PFFL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>Doubler Plate_1A</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>DoublerPlate_1D</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>DoublerPlate_7</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>DoubleTaperedSpacer1</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>DoubleTaperedSpacer2</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>DoubleTaperedSpacer3</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>DoubleWye</td>
<td>0</td>
<td>CY**</td>
<td>CROSS</td>
</tr>
<tr>
<td>DoubleWyebySeat</td>
<td>0</td>
<td>CY**</td>
<td>CROSS</td>
</tr>
<tr>
<td>DoubleWyePDB525</td>
<td>0</td>
<td>CY**</td>
<td>CROSS</td>
</tr>
<tr>
<td>DoubleWyePDB526</td>
<td>0</td>
<td>CY**</td>
<td>CROSS</td>
</tr>
<tr>
<td>DoubleWyePDB527</td>
<td>0</td>
<td>CY**</td>
<td>CROSS</td>
</tr>
<tr>
<td>DoubleWyeTanLen1</td>
<td>0</td>
<td>CY**</td>
<td>CROSS</td>
</tr>
<tr>
<td>DresserCoupling</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>DripRingTee</td>
<td>0</td>
<td>IT**</td>
<td>INSTRUMENT-TEE</td>
</tr>
<tr>
<td>E225MiterNCut</td>
<td>301</td>
<td>MIBW</td>
<td>BEND</td>
</tr>
<tr>
<td>E30MiterNCut</td>
<td>301</td>
<td>MIBW</td>
<td>BEND</td>
</tr>
<tr>
<td>E45</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E45LR</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E45LRRJ</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E45LT</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E45LTTtype1</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E45MiterNCut</td>
<td>301</td>
<td>MIBW</td>
<td>BEND</td>
</tr>
<tr>
<td>E45TC</td>
<td>920</td>
<td>ELLC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E60MiterNCut</td>
<td>301</td>
<td>MIBW</td>
<td>BEND</td>
</tr>
<tr>
<td>E90</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E90LR</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>E90LRRJ</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E90LRT</td>
<td>391</td>
<td>ETLR</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>E90LRT</td>
<td>301</td>
<td>ETLR</td>
<td>ELBOW-TEED</td>
</tr>
<tr>
<td>E90LT</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E90LTTType1</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E90MiterNCut</td>
<td>301</td>
<td>MIBW</td>
<td>BEND</td>
</tr>
<tr>
<td>E90SR</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>E90TC</td>
<td>920</td>
<td>ELLC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>EccentricReducer</td>
<td>0</td>
<td>RE**</td>
<td>REDUCER-ECCENTRIC</td>
</tr>
<tr>
<td>EccentricReducer_b</td>
<td>0</td>
<td>RE**</td>
<td>REDUCER-ECCENTRIC</td>
</tr>
<tr>
<td>EccentricReducer_m</td>
<td>301</td>
<td>REBW</td>
<td>REDUCER-ECCENTRIC</td>
</tr>
<tr>
<td>EccentricSwage</td>
<td>0</td>
<td>RE**</td>
<td>REDUCER-ECCENTRIC</td>
</tr>
<tr>
<td>Elbolet</td>
<td>0</td>
<td>CE**</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Elbolet_m</td>
<td>0</td>
<td>CE**</td>
<td>COUPLING</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>421</td>
<td>ELSW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>331</td>
<td>EBSC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>441</td>
<td>ELSC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>11</td>
<td>ELFL</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>391</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow45Deg</td>
<td>21</td>
<td>ELFL</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>441</td>
<td>ELSC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>421</td>
<td>ELSW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>331</td>
<td>EBSC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>11</td>
<td>ELFL</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>391</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Elbow90Deg</td>
<td>21</td>
<td>ELFL</td>
<td>ELBOW</td>
</tr>
<tr>
<td>ElevatedFireMonitorTy1</td>
<td>11</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>ElevatedFireMonitorTy2</td>
<td>11</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>Endolet</td>
<td>0</td>
<td>HC**</td>
<td>OLET</td>
</tr>
<tr>
<td>Endolet_m</td>
<td>0</td>
<td>HC**</td>
<td>OLET</td>
</tr>
<tr>
<td>EqualSteamTrap</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>EqualSteamTrap3</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>ExhaustHead</td>
<td>441</td>
<td>NCSC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>ExpnJoint</td>
<td>11</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>ExpnJointOffset</td>
<td>21</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FBLD</td>
<td>0</td>
<td>FLBL</td>
<td>FLANGE-BLIND</td>
</tr>
<tr>
<td>FemaleAdapter</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FemaleAdapterSizeChange</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FemaleHoseCoupling</td>
<td>0</td>
<td>CH**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FemaleToKwikFl</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FERR</td>
<td>920</td>
<td>FLFL</td>
<td>FLANGE</td>
</tr>
<tr>
<td>FERR</td>
<td>301</td>
<td>FEBW</td>
<td>FLANGE</td>
</tr>
<tr>
<td>Filter</td>
<td>21</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FireHydrant</td>
<td>11</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FittingReducer</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>FlameArrestor</td>
<td>21</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FlangeAdapter</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FlangeConnectionPiece</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
</tbody>
</table>
### Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlangedElbowPipet</td>
<td>0</td>
<td>CEBW</td>
<td>ELBOLET</td>
</tr>
<tr>
<td>FlangOlet</td>
<td>0</td>
<td>WTFL</td>
<td>OLET</td>
</tr>
<tr>
<td>FlexCoupling</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FlexibleCoupling</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FloatTrapType1</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>FloatTrapType2</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>FloatTrapType3</td>
<td>0</td>
<td>TR**</td>
<td>TRAP-RETURN</td>
</tr>
<tr>
<td>FloatTrapType4</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>FloatTrapType5</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>FloatTrapType6</td>
<td>0</td>
<td>TR**</td>
<td>TRAP-RETURN</td>
</tr>
<tr>
<td>FlowMagnetic</td>
<td>21</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>FlowSwitch</td>
<td>331</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>FlowTransmitter</td>
<td>21</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>FootValve</td>
<td>21</td>
<td>VVFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>FreeVent2</td>
<td>11</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>FRFILR</td>
<td>21</td>
<td>FLRC</td>
<td>FLANGE-REDUCING-CONCENTRIC</td>
</tr>
<tr>
<td>FRSW</td>
<td>0</td>
<td>FLRC</td>
<td>FLANGE-REDUCING-CONCENTRIC</td>
</tr>
<tr>
<td>FSW</td>
<td>0</td>
<td>FLSW</td>
<td>FLANGE</td>
</tr>
<tr>
<td>FWN</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>GAT</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValAsymmetrical</td>
<td>21</td>
<td>VTFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValCentertoSeat</td>
<td>421</td>
<td>VTSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValEtoEandValFtoF</td>
<td>21</td>
<td>VTFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValNipleLenValFtoC</td>
<td>21</td>
<td>VTFL</td>
<td>VALVE</td>
</tr>
</tbody>
</table>
## Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>GateValNipleLenValFtoF</td>
<td>21</td>
<td>VTFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValSeattoSeat</td>
<td>421</td>
<td>VTSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValve</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValve_Asym</td>
<td>0</td>
<td>VT**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValve_m</td>
<td>0</td>
<td>VT**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValveAngleOp</td>
<td>0</td>
<td>VT**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GateValveAngleOp.INTD</td>
<td>0</td>
<td>VT**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>GateValveM</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GATF</td>
<td>421</td>
<td>VTSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GATGO1</td>
<td>21</td>
<td>VTFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>GATGO2</td>
<td>21</td>
<td>VTFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>GATR</td>
<td>421</td>
<td>VTSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GATRASYM</td>
<td>0</td>
<td>VT**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GaugeRootValSingleOut</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GaugeRootValSingleOutR</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GaugeValMultiOut</td>
<td>0</td>
<td>V4**</td>
<td>VALVE-4WAY</td>
</tr>
<tr>
<td>GaugeValMultiOutR</td>
<td>0</td>
<td>V4**</td>
<td>VALVE-4WAY</td>
</tr>
<tr>
<td>GLO</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeControlValve</td>
<td>21</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>GlobeValAsymmetrical</td>
<td>21</td>
<td>VGFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValCentertoSeat</td>
<td>421</td>
<td>VGSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValEtoEandValFtoF</td>
<td>21</td>
<td>VGSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValNipleLenValFtoC</td>
<td>21</td>
<td>VGSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValNipleLenValFtoF</td>
<td>21</td>
<td>VGSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValSeattoSeat</td>
<td>421</td>
<td>VGSW</td>
<td>VALVE</td>
</tr>
</tbody>
</table>
## Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>GlobeValve</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValve_Asym</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValve_m</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GlobeValveMotor</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>GLOR</td>
<td>421</td>
<td>VGSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>HalfCoupling</td>
<td>0</td>
<td>HC**</td>
<td>OLET</td>
</tr>
<tr>
<td>HalfCouplingEtoE</td>
<td>0</td>
<td>HCSW</td>
<td>OLET</td>
</tr>
<tr>
<td>HalfCouplingFtoF</td>
<td>0</td>
<td>HCSW</td>
<td>OLET</td>
</tr>
<tr>
<td>HalfCouplingFtoHC</td>
<td>0</td>
<td>HCSW</td>
<td>OLET</td>
</tr>
<tr>
<td>HMI1</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>HorYLiftCheckValveFtoC</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>HorYLiftCheckValveFtoF</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>HoseConnection</td>
<td>0</td>
<td>CH**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>HoseRackStation</td>
<td>441</td>
<td>NCSC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>Hub</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>HubAndSpigotReducer636</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>I2WAY</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>I3WAY</td>
<td>0</td>
<td>C3**</td>
<td>INSTRUMENT-3WAY</td>
</tr>
<tr>
<td>IA1</td>
<td>0</td>
<td>IDPL</td>
<td>INSTRUMENT-DIAL</td>
</tr>
<tr>
<td>IA2</td>
<td>0</td>
<td>IDPL</td>
<td>INSTRUMENT-DIAL</td>
</tr>
<tr>
<td>IADD</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICM1</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>ICM2</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Code</td>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>ICM3</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>ICM4</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>ICM5</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>IDCO</td>
<td>0</td>
<td>NC**</td>
<td></td>
</tr>
<tr>
<td>IDL1C</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDL1D</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDL4C</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDL4D</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDR1A</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDR1B</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDR4A</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IDR4B</td>
<td>0</td>
<td>CV**</td>
<td></td>
</tr>
<tr>
<td>IEAM1</td>
<td>0</td>
<td>MV**</td>
<td></td>
</tr>
<tr>
<td>IEAM2</td>
<td>0</td>
<td>MV**</td>
<td></td>
</tr>
<tr>
<td>IEAM3</td>
<td>0</td>
<td>MV**</td>
<td></td>
</tr>
<tr>
<td>IEAM4</td>
<td>0</td>
<td>MV**</td>
<td></td>
</tr>
<tr>
<td>IEAM5</td>
<td>0</td>
<td>MV**</td>
<td></td>
</tr>
<tr>
<td>IIOI</td>
<td>0</td>
<td>OP</td>
<td></td>
</tr>
<tr>
<td>IIOR</td>
<td>0</td>
<td>OP</td>
<td></td>
</tr>
<tr>
<td>IIIV</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>IKG1</td>
<td>0</td>
<td>SV**</td>
<td></td>
</tr>
<tr>
<td>IKG2</td>
<td>0</td>
<td>SV**</td>
<td></td>
</tr>
<tr>
<td>ILSV</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>IMDC2</td>
<td>0</td>
<td>NC**</td>
<td></td>
</tr>
<tr>
<td>IMFM1</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>IMFM2</td>
<td>0</td>
<td>II**</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Value</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>-------</td>
<td>-----------------</td>
</tr>
<tr>
<td>IMFM3</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IMFM4</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IMOP1</td>
<td>0</td>
<td>OP</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IMRSV</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IncreasingTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>IND</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>InlineSilencerTy1</td>
<td>21</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>InsertPlate</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>InstIndicator</td>
<td>0</td>
<td>IDPL</td>
<td>INSTRUMENT-DIAL</td>
</tr>
<tr>
<td>InstrumentTee</td>
<td>920</td>
<td>ITFL</td>
<td>INSTRUMENT-TEE</td>
</tr>
<tr>
<td>InstrumentTee</td>
<td>301</td>
<td>ITFL</td>
<td>INSTRUMENT-TEE</td>
</tr>
<tr>
<td>InvertedCheckValve</td>
<td>441</td>
<td>VRSC</td>
<td>VALVE</td>
</tr>
<tr>
<td>InvrtdBucktStmTrapTy1</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>InvrtdBucktStmTrapTy2</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>InvrtdBucktStmTrapTy3</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>InvrtdBucktStmTrapTy4</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>InvrtdBucktStmTrapTy5</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>InvrtdBucktStmTrapTy6</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>IOP</td>
<td>0</td>
<td>OP</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA1</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA2</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA3</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA3A</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA4</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA4A</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPDA5</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Symbol</td>
<td>Type</td>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>IPL1C</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPL1D</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPL4C</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPL4D</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPR1A</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPR1B</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPR4A</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPR4B</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPR4D</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPRS1</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPRS2</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPRS3</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IPRS4</td>
<td>0</td>
<td>SV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IR1</td>
<td>0</td>
<td>IR**</td>
<td>INSTRUMENT-RETURN</td>
</tr>
<tr>
<td>IR2</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IR3</td>
<td>0</td>
<td>IR**</td>
<td>INSTRUMENT-RETURN</td>
</tr>
<tr>
<td>IR4</td>
<td>0</td>
<td>IR**</td>
<td>INSTRUMENT-RETURN</td>
</tr>
<tr>
<td>IR5</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IR6</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IR7</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IR8</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IR9</td>
<td>0</td>
<td>IR**</td>
<td>INSTRUMENT-RETURN</td>
</tr>
<tr>
<td>IREG1</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IREG2</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IREG3</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>IREG4</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Symbol</td>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>IREG5</td>
<td>0</td>
<td>CV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IRI2</td>
<td>0</td>
<td>CV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IRVT1</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRVT2</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRVT3</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRVT4</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRVT5</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRVT6</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRVT7</td>
<td>0</td>
<td>RA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>IRXPA</td>
<td>0</td>
<td>SV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>ISCV3</td>
<td>0</td>
<td>CV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>ISSD3</td>
<td>0</td>
<td>C3** INSTRUMENT-3WAY</td>
<td></td>
</tr>
<tr>
<td>ISSDA</td>
<td>0</td>
<td>CA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>ISSDS</td>
<td>0</td>
<td>CV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>ISSPA</td>
<td>0</td>
<td>SA** INSTRUMENT-ANGLE</td>
<td></td>
</tr>
<tr>
<td>ISSPS</td>
<td>0</td>
<td>SV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>ITM</td>
<td>0</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IVM1</td>
<td>0</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IVM2</td>
<td>0</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IVM3</td>
<td>0</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IVM4</td>
<td>0</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>IWFE</td>
<td>0</td>
<td>NC** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>KnifeGateValve</td>
<td>0</td>
<td>VS** VALVE</td>
<td></td>
</tr>
<tr>
<td>KnifeGateValveSM</td>
<td>0</td>
<td>VS** VALVE</td>
<td></td>
</tr>
<tr>
<td>KwikandLargeFl</td>
<td>0</td>
<td>FLWN FLANGE</td>
<td></td>
</tr>
<tr>
<td>LapJointFlange</td>
<td>0</td>
<td>FLSE FLANGE</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Code</td>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------</td>
<td>------</td>
<td>----------------------</td>
</tr>
<tr>
<td>LapJointFlange_m</td>
<td>0</td>
<td>FBSE</td>
<td>FLANGE</td>
</tr>
<tr>
<td>LAT</td>
<td>21</td>
<td>TEFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>Lateral</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>Lateral45</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>LateralPDB608</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>LateralPDB609</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>LateralPDB610</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>Latrolet</td>
<td>301</td>
<td>LABW</td>
<td>OLET</td>
</tr>
<tr>
<td>LevelcontrolvalPDB740</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>LevelcontrolvalPDB741</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>LevelcontrolvalPDB742</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>LOL</td>
<td>0</td>
<td>LABW</td>
<td>OLET</td>
</tr>
<tr>
<td>LongWeldNeckFlange</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>MaleAdapter</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>MaleAdapterSizeChange</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>MaleHoseCoupling</td>
<td>0</td>
<td>CH**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>MaleToKwikFl</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>MassFlow</td>
<td>331</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>MechanicalJtReducer632</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>MinKnifeGateValve</td>
<td>0</td>
<td>VS**</td>
<td>VALVE</td>
</tr>
<tr>
<td>Monitor</td>
<td>11</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>MonitorType1</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>MotOperatedVal</td>
<td>0</td>
<td>MV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>MSCBA3W</td>
<td>0</td>
<td>C3**</td>
<td>INSTRUMENT-3WAY</td>
</tr>
<tr>
<td>MultiportDia2WayG</td>
<td>920</td>
<td>V3LC</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>MultiportDia2WayOptions</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>Symbol</td>
<td>Code</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>------------------------</td>
<td>------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>MultiportDia3Way</td>
<td>920</td>
<td>V4LC</td>
<td>VALVE-4WAY</td>
</tr>
<tr>
<td>MultiportDia3WayOptions</td>
<td>0</td>
<td>V4**</td>
<td>VALVE-4WAY</td>
</tr>
<tr>
<td>NEE</td>
<td>421</td>
<td>VNSW</td>
<td>VALVE</td>
</tr>
<tr>
<td>NIP</td>
<td>301</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>NIP</td>
<td>331</td>
<td>NRSC</td>
<td>COUPLING</td>
</tr>
<tr>
<td>NIP</td>
<td>391</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>Nipolet</td>
<td>0</td>
<td>NIPL</td>
<td>OLET</td>
</tr>
<tr>
<td>Nipple</td>
<td>301</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>Nipple</td>
<td>391</td>
<td>FPPL</td>
<td>PIPE-FIXED</td>
</tr>
<tr>
<td>Nipple</td>
<td>331</td>
<td>NRSC</td>
<td>COUPLING</td>
</tr>
<tr>
<td>NippoletTrim</td>
<td>301</td>
<td>NIBW</td>
<td>OLET</td>
</tr>
<tr>
<td>OletGTrim</td>
<td>301</td>
<td>WTBW</td>
<td>OLET</td>
</tr>
<tr>
<td>OletTrim</td>
<td>301</td>
<td>WTBW</td>
<td>OLET</td>
</tr>
<tr>
<td>OnBranchUnionTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>OneQuarterBendPDB538</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB539</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB540</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB541</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB542</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB543</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB544</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB545</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB546</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB547</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB548</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB549</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Symbol Code</td>
<td>Angle</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>OneQuarterBendPDB550</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB551</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB552</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB553</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB554</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB555</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB556</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB557</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB558</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB559</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB560</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB561</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB562</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB563</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB564</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB565</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB566</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB567</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB568</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB569</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB570</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB571</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB572</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB573</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB574</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB575</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>Symbol</td>
<td>Code</td>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------</td>
<td>-----</td>
<td>-------------------</td>
</tr>
<tr>
<td>OneQuarterBendPDB576</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB577</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB578</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB579</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB580</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB581</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB582</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OneQuarterBendPDB583</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>OnRunUnionTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>OrificeFlange</td>
<td>0</td>
<td>FOWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>OrificeFlangeTwoTaps</td>
<td>0</td>
<td>FOWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>OrificePlates</td>
<td>0</td>
<td>OP</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Paddle</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PinchValve</td>
<td>0</td>
<td>VV**</td>
<td>VALVE</td>
</tr>
<tr>
<td>PipeSleeve</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PipeSleeve_3A</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PipeSleeve_3B</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PipeSleeveWithSeal</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PipeSlvWithPuddleFlg</td>
<td>301</td>
<td>NCBW</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PlainHub</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PlanarUSiphon</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PlateFlange</td>
<td>0</td>
<td>FL**</td>
<td>FLANGE</td>
</tr>
<tr>
<td>Plug</td>
<td>331</td>
<td>PL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>PlugGOpAsymmetrical</td>
<td>0</td>
<td>VP**</td>
<td>VALVE</td>
</tr>
<tr>
<td>PlugValve</td>
<td>0</td>
<td>VP**</td>
<td>VALVE</td>
</tr>
<tr>
<td>PressureGauge</td>
<td>331</td>
<td>IDPL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Symbol</td>
<td>Code</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>------</td>
<td>------------------------------</td>
<td></td>
</tr>
<tr>
<td>PressureReducingValve</td>
<td>21</td>
<td>VXFL VALVE</td>
<td></td>
</tr>
<tr>
<td>PressureRegulator</td>
<td>441</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>PressureReliefValve</td>
<td>0</td>
<td>RA** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>PressureReliefValveASym</td>
<td>0</td>
<td>AR** VALVE-ANGLE</td>
<td></td>
</tr>
<tr>
<td>PressureReliefValveSym</td>
<td>21</td>
<td>ARFL VALVE-ANGLE</td>
<td></td>
</tr>
<tr>
<td>PressureSwitch</td>
<td>441</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>PressureTransmitter</td>
<td>441</td>
<td>II** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>PrRedValveWithStrainr</td>
<td>21</td>
<td>VXFL VALVE</td>
<td></td>
</tr>
<tr>
<td>PrRedValveYType</td>
<td>21</td>
<td>VXFL VALVE</td>
<td></td>
</tr>
<tr>
<td>REDC</td>
<td>0</td>
<td>RC** REDUCER-CONCENTRIC</td>
<td></td>
</tr>
<tr>
<td>REDCLT</td>
<td>301</td>
<td>RCBW REDUCER-CONCENTRIC</td>
<td></td>
</tr>
<tr>
<td>REDCMM</td>
<td>920</td>
<td>RCLC REDUCER-CONCENTRIC</td>
<td></td>
</tr>
<tr>
<td>RedCoupling</td>
<td>0</td>
<td>COVT COUPLING</td>
<td></td>
</tr>
<tr>
<td>REDCRJ</td>
<td>301</td>
<td>RCBW REDUCER-CONCENTRIC</td>
<td></td>
</tr>
<tr>
<td>REDE</td>
<td>0</td>
<td>RE** REDUCER-ECCENTRIC</td>
<td></td>
</tr>
<tr>
<td>REDELT</td>
<td>301</td>
<td>REBW REDUCER-ECCENTRIC</td>
<td></td>
</tr>
<tr>
<td>REDEMM</td>
<td>920</td>
<td>RELC REDUCER-ECCENTRIC</td>
<td></td>
</tr>
<tr>
<td>RedERJ</td>
<td>301</td>
<td>REBW REDUCER-ECCENTRIC</td>
<td></td>
</tr>
<tr>
<td>RedLateral</td>
<td>0</td>
<td>TE** TEE</td>
<td></td>
</tr>
<tr>
<td>RedLateral45</td>
<td>0</td>
<td>TE** TEE</td>
<td></td>
</tr>
<tr>
<td>ReducingBranchCross</td>
<td>0</td>
<td>CR** CROSS</td>
<td></td>
</tr>
<tr>
<td>ReducingControlGateValve</td>
<td>0</td>
<td>CV** INSTRUMENT</td>
<td></td>
</tr>
<tr>
<td>ReducingCoupling</td>
<td>421</td>
<td>COSW COUPLING</td>
<td></td>
</tr>
<tr>
<td>ReducingFlange</td>
<td>0</td>
<td>FLRC FLANGE-REDUCING-CONCENTRIC</td>
<td></td>
</tr>
<tr>
<td>ReducingGateValve</td>
<td>21</td>
<td>IIFL INSTRUMENT</td>
<td></td>
</tr>
</tbody>
</table>
## Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReducingInsert</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>ReducingInstrumentTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>ReducingLateral</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
</tbody>
</table>

**Smart 3D Part Class**

<table>
<thead>
<tr>
<th>Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReducingRunAndBranchCross</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>ReducingRunAndBranchLateral</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>ReducingRunAndBranchTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>ReducingRunBrnchCross</td>
<td>0</td>
<td>CR**</td>
<td>CROSS</td>
</tr>
<tr>
<td>ReducingRunBrnchLateral</td>
<td>21</td>
<td>TEFL</td>
<td>TEE</td>
</tr>
<tr>
<td>ReducingTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>ReducingTee_m</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>ReducingTeeWye</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>ReinforcingPad</td>
<td>0</td>
<td>n/a</td>
<td>REINFORCEMENT-PAD</td>
</tr>
<tr>
<td>ReinforcingPad_m</td>
<td>0</td>
<td>n/a</td>
<td>REINFORCEMENT-PAD</td>
</tr>
<tr>
<td>ReinforcingPadNonRadial</td>
<td>0</td>
<td>n/a</td>
<td>REINFORCEMENT-PAD</td>
</tr>
<tr>
<td>RoseBox</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>RPAD</td>
<td>0</td>
<td>n/a</td>
<td>REINFORCEMENT-PAD</td>
</tr>
<tr>
<td>Saddle</td>
<td>0</td>
<td>WTBW</td>
<td>OLET</td>
</tr>
<tr>
<td>SanitaryCheckValve</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>SanitaryIncreaser625</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SanitaryIncreaser626</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SanitaryIncreaser628</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SanitaryIncreaser630</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SanitaryReducer620</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SanitaryReducer621</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>SanitaryReducer623</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SDG1</td>
<td>0</td>
<td>VD**</td>
<td>VALVE</td>
</tr>
<tr>
<td>SDR1</td>
<td>0</td>
<td>VD**</td>
<td>VALVE</td>
</tr>
<tr>
<td>ShortReducer634</td>
<td>0</td>
<td>RC**</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>ShStRotameter</td>
<td>21</td>
<td>IIFL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>SingleBasketStrainer</td>
<td>21</td>
<td>FIFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SingleBasketStrainer</td>
<td>11</td>
<td>FIFL</td>
<td>FILTER</td>
</tr>
<tr>
<td>SingleTaperedSpacer1</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SingleTaperedSpacer2</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SingleTaperedSpacer3</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SlipOnFlange</td>
<td>0</td>
<td>FLSO</td>
<td>FLANGE</td>
</tr>
<tr>
<td>SlipOnFlange_m</td>
<td>0</td>
<td>FLSO</td>
<td>FLANGE</td>
</tr>
<tr>
<td>SlipOnReducingFlange</td>
<td>0</td>
<td>FLRC</td>
<td>FLANGE-REDUCING-CONCENTRIC</td>
</tr>
<tr>
<td>SMISC1</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>SMR1</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>SocketFlange</td>
<td>0</td>
<td>FLSW</td>
<td>FLANGE</td>
</tr>
<tr>
<td>SocketWeldedFlange</td>
<td>0</td>
<td>FLSW</td>
<td>FLANGE</td>
</tr>
<tr>
<td>SocketweldFlange</td>
<td>0</td>
<td>FLSW</td>
<td>FLANGE</td>
</tr>
<tr>
<td>SocketWeldReducingFlange</td>
<td>0</td>
<td>FLRC</td>
<td>FLANGE-REDUCING-CONCENTRIC</td>
</tr>
<tr>
<td>Sockolet</td>
<td>0</td>
<td>SKSW</td>
<td>OLET</td>
</tr>
<tr>
<td>Sockolet_m</td>
<td>0</td>
<td>SKSW</td>
<td>OLET</td>
</tr>
<tr>
<td>SOL</td>
<td>0</td>
<td>SKSW</td>
<td>OLET</td>
</tr>
<tr>
<td>SolenoidValve</td>
<td>421</td>
<td>CVSW</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>SOP1</td>
<td>0</td>
<td>OP</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>SP1</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>SPACER</td>
<td>0</td>
<td>SR</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SpectacleBlind</td>
<td>0</td>
<td>SB</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SpectacleBlind1</td>
<td>0</td>
<td>SB</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SPR1</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>Sprinkler</td>
<td>331</td>
<td>NCSC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SREG1</td>
<td>0</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>SRV1</td>
<td>0</td>
<td>CV**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>StandardCircularSiphon</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SteamTrap</td>
<td>0</td>
<td>TOSC</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>SteamTrap3</td>
<td>441</td>
<td>TOSC</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>SteamTrapTy4</td>
<td>441</td>
<td>TOSC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SteamTrapTy5</td>
<td>441</td>
<td>TOSC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SteamTrapTy6</td>
<td>0</td>
<td>TO**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SteamTrapTy7</td>
<td>441</td>
<td>TOSC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SteamTrapTy8</td>
<td>11</td>
<td>TOFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>StopCheckValve</td>
<td>0</td>
<td>VG**</td>
<td>VALVE</td>
</tr>
<tr>
<td>StreetTee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>StuddedCross</td>
<td>31</td>
<td>CRFL</td>
<td>CROSS</td>
</tr>
<tr>
<td>StuddedTee</td>
<td>31</td>
<td>TEFL</td>
<td>TEE</td>
</tr>
<tr>
<td>SumpStrainer</td>
<td>441</td>
<td>FISC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>64</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>8</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>95</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>72</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
</tbody>
</table>
### Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Smart 3D Part Class</th>
<th>End Prep Code</th>
<th>PCF Skey</th>
<th>PCF Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUPPORT</td>
<td>74</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>12</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>60</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>21</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>54</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>30</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>44</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>70</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>43</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>15</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>42</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>31</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>41</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>22</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>91</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>90</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>11</td>
<td>01HG</td>
<td>SUPPORT</td>
</tr>
<tr>
<td>Sweepolet</td>
<td>0</td>
<td>SWBW</td>
<td>OLET</td>
</tr>
<tr>
<td>SweepOletTrim</td>
<td>0</td>
<td>SWBW</td>
<td>OLET</td>
</tr>
<tr>
<td>SWGC</td>
<td>391</td>
<td>CSBW</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>SWGE</td>
<td>391</td>
<td>ESBW</td>
<td>REDUCER-ECCENTRIC</td>
</tr>
<tr>
<td>SwingCheckValve</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TankBottomValve</td>
<td>0</td>
<td>VC**</td>
<td>VALVE</td>
</tr>
<tr>
<td>TankDrainValve</td>
<td>21</td>
<td>VVFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>TankVentCheckValve</td>
<td>11</td>
<td>VRFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>TappedWyeF2F</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>TappedWyeF2S</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>TechlokClamp</td>
<td>930</td>
<td>CLMP</td>
<td>CLAMP</td>
</tr>
<tr>
<td>Tee</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>Tee_m</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>Tee_PDB</td>
<td>21</td>
<td>TEFL</td>
<td>TEE</td>
</tr>
<tr>
<td>TeeStrainer</td>
<td>21</td>
<td>FIFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TeeWye</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>TeeWyeReducingRRB</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>TeeWyeReducingRun</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>TempBasketStrainer</td>
<td>111</td>
<td>FIFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TempBasketStrainer1</td>
<td>111</td>
<td>FIFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TempConeStrainer</td>
<td>111</td>
<td>FIFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TemperatureControlValve</td>
<td>441</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>TemperatureSwitch</td>
<td>331</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>TemperatureTransmitter</td>
<td>331</td>
<td>II**</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>TFI</td>
<td>0</td>
<td>IT**</td>
<td>TEE</td>
</tr>
<tr>
<td>ThermoDyTrapType1</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoDyTrapType2</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoDyTrapType3</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoDyTrapType4</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoStmTrapTy1</td>
<td>0</td>
<td>TA**</td>
<td>TRAP-ANGLE</td>
</tr>
<tr>
<td>ThermoStmTrapTy2</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoStmTrapTy3</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>----------</td>
<td>--------------</td>
</tr>
<tr>
<td>ThermoStmTrapTy4</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoStmTrapTy5</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThermoStmTrapTy6</td>
<td>0</td>
<td>TA**</td>
<td>TRAP-ANGLE</td>
</tr>
<tr>
<td>ThermoStmTrapTy7</td>
<td>0</td>
<td>TI**</td>
<td>TRAP</td>
</tr>
<tr>
<td>ThreadedFlange</td>
<td>0</td>
<td>FLSC</td>
<td>FLANGE</td>
</tr>
<tr>
<td>Thredolet</td>
<td>0</td>
<td>THSC</td>
<td>OLET</td>
</tr>
<tr>
<td>Thredolet_m</td>
<td>0</td>
<td>THSC</td>
<td>OLET</td>
</tr>
<tr>
<td>TLT</td>
<td>301</td>
<td>TEBW</td>
<td>TEE</td>
</tr>
<tr>
<td>TMMM</td>
<td>920</td>
<td>TELC</td>
<td>TEE</td>
</tr>
<tr>
<td>TMMMS</td>
<td>920</td>
<td>TELC</td>
<td>TEE</td>
</tr>
<tr>
<td>TMSWMS</td>
<td>301</td>
<td>TEBW</td>
<td>TEE</td>
</tr>
<tr>
<td>TMSWMS</td>
<td>920</td>
<td>TELC</td>
<td>TEE</td>
</tr>
<tr>
<td>TOL</td>
<td>0</td>
<td>THSC</td>
<td>OLET</td>
</tr>
<tr>
<td>TRB</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TRI</td>
<td>0</td>
<td>IT**</td>
<td>TEE</td>
</tr>
<tr>
<td>TrimmableReducingTee</td>
<td>421</td>
<td>TESW</td>
<td>TEE</td>
</tr>
<tr>
<td>TrimmableTee</td>
<td>421</td>
<td>TESW</td>
<td>TEE</td>
</tr>
<tr>
<td>TrimSymElbowType1</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>TrimSymElbowType2</td>
<td>301</td>
<td>ELBW</td>
<td>ELBOW</td>
</tr>
<tr>
<td>TRJ</td>
<td>301</td>
<td>TEBW</td>
<td>TEE</td>
</tr>
<tr>
<td>TRLT</td>
<td>301</td>
<td>TEBW</td>
<td>TEE</td>
</tr>
<tr>
<td>TRMMM</td>
<td>920</td>
<td>TELC</td>
<td>TEE</td>
</tr>
<tr>
<td>TRMMMS</td>
<td>920</td>
<td>TELC</td>
<td>TEE</td>
</tr>
<tr>
<td>TRUBWWM</td>
<td>0</td>
<td>BU**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TrueY</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>TrueY2FC</td>
<td>21</td>
<td>TYFL</td>
<td>TEE</td>
</tr>
<tr>
<td>TrueY3FC</td>
<td>21</td>
<td>TYFL</td>
<td>TEE</td>
</tr>
<tr>
<td>TRUSWWWM</td>
<td>0</td>
<td>BU**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TRWWM</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TRWWMS</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TStrainer</td>
<td>0</td>
<td>FI**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>TWMSW</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TWMW</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TWMM</td>
<td>0</td>
<td>TE**</td>
<td>TEE</td>
</tr>
<tr>
<td>TWWMS</td>
<td>301</td>
<td>TEBW</td>
<td>TEE</td>
</tr>
<tr>
<td>UN</td>
<td>421</td>
<td>UNSW</td>
<td>UNION</td>
</tr>
<tr>
<td>Union</td>
<td>0</td>
<td>UN**</td>
<td>UNION</td>
</tr>
<tr>
<td>UnionHead</td>
<td>0</td>
<td>UN**</td>
<td>UNION</td>
</tr>
<tr>
<td>UnionTail</td>
<td>0</td>
<td>UN**</td>
<td>UNION</td>
</tr>
<tr>
<td>UprightWye</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>UprightWyeF32C</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>USiphon</td>
<td>0</td>
<td>NC**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>VE45</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>VE90Elbow</td>
<td>0</td>
<td>EL**</td>
<td>ELBOW</td>
</tr>
<tr>
<td>VentSilencer2</td>
<td>21</td>
<td>NCFL</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>VentValve</td>
<td>0</td>
<td>VR**</td>
<td>VALVE</td>
</tr>
<tr>
<td>VentValvePDB508</td>
<td>0</td>
<td>VR**</td>
<td>VALVE</td>
</tr>
<tr>
<td>VentValvePDB509</td>
<td>0</td>
<td>VR**</td>
<td>VALVE</td>
</tr>
<tr>
<td>VictaulicClamp</td>
<td>0</td>
<td>EL**</td>
<td>CLAMP</td>
</tr>
<tr>
<td>VictaulicT</td>
<td>0</td>
<td>EL**</td>
<td>TEE</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>VortexFlow</td>
<td>21</td>
<td>IIFL</td>
<td>INSTRUMENT</td>
</tr>
<tr>
<td>VPSCoupling</td>
<td>915</td>
<td>COVT</td>
<td>COUPLING</td>
</tr>
<tr>
<td>VPSElbow45Deg</td>
<td>915</td>
<td>ELLC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>VPSElbow90Deg</td>
<td>915</td>
<td>ELLC</td>
<td>ELBOW</td>
</tr>
<tr>
<td>VPSTee</td>
<td>915</td>
<td>TELC</td>
<td>TEE</td>
</tr>
<tr>
<td>VREDC</td>
<td>1005</td>
<td>RCCL</td>
<td>REDUCER-CONCENTRIC</td>
</tr>
<tr>
<td>VREDE</td>
<td>1005</td>
<td>RECL</td>
<td>REDUCER-ECCENTRIC</td>
</tr>
<tr>
<td>WaferCheckValve</td>
<td>121</td>
<td>CKFL</td>
<td>VALVE</td>
</tr>
<tr>
<td>WaterFilterPorts90deg</td>
<td>21</td>
<td>FAFL</td>
<td>FILTER</td>
</tr>
<tr>
<td>WaterFilterPortsInline</td>
<td>21</td>
<td>FIFL</td>
<td>FILTER</td>
</tr>
<tr>
<td>Weld</td>
<td>35</td>
<td>WS</td>
<td>Field Weld at Assembly Site, including Offshore</td>
</tr>
<tr>
<td>Weld</td>
<td>40</td>
<td>WF</td>
<td>Field Fit Weld at Assembly Site</td>
</tr>
<tr>
<td>Weld</td>
<td>5</td>
<td>WW</td>
<td>Shop Weld</td>
</tr>
<tr>
<td>Weld</td>
<td>20</td>
<td>WM</td>
<td>Miter Weld</td>
</tr>
<tr>
<td>Weld</td>
<td>30</td>
<td>WS</td>
<td>Field Weld at Assembly Site</td>
</tr>
<tr>
<td>Weld</td>
<td>45</td>
<td>WF</td>
<td>Field Fit Weld at Job Site, Including Offshore</td>
</tr>
<tr>
<td>Weld</td>
<td>10</td>
<td>WW</td>
<td>Shop Weld at Job Site Fabrication Shop</td>
</tr>
<tr>
<td>Weld</td>
<td>25</td>
<td>WM</td>
<td>Miter Weld at Job Site Fabrication Shop</td>
</tr>
<tr>
<td>Weld</td>
<td>15</td>
<td>WWA</td>
<td>Automatic Shop Weld</td>
</tr>
<tr>
<td>Weld</td>
<td>50</td>
<td>WFT</td>
<td>Field Weld at Job Site for Loose Flange</td>
</tr>
<tr>
<td>WeldNeckExpanderFlange</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>WeldNeckFlange</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>Smart 3D Part Class</td>
<td>End Prep Code</td>
<td>PCF Skey</td>
<td>PCF Component</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>WeldNeckFlange</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>WeldNeckFlange_m</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>WeldNeckFlangeNonCir</td>
<td>0</td>
<td>FLWN</td>
<td>FLANGE</td>
</tr>
<tr>
<td>Weldonlet</td>
<td>0</td>
<td>WTBW</td>
<td>OLET</td>
</tr>
<tr>
<td>Weldonlet_m</td>
<td>0</td>
<td>WTBW</td>
<td>OLET</td>
</tr>
<tr>
<td>WeldonletNonRadial</td>
<td>0</td>
<td>BWTT</td>
<td>OLET</td>
</tr>
<tr>
<td>WOL</td>
<td>0</td>
<td>WTBW</td>
<td>OLET</td>
</tr>
<tr>
<td>WOSSteamTrap</td>
<td>441</td>
<td>TOSC</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>WOSSteamTrap3</td>
<td>0</td>
<td>TO**</td>
<td>TRAP-OFFSET</td>
</tr>
<tr>
<td>WOSSteamTrapOA</td>
<td>0</td>
<td>TO**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>WyeStrainer</td>
<td>0</td>
<td>FI**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>WyeStrainer</td>
<td>0</td>
<td>FI**</td>
<td>FILTER</td>
</tr>
<tr>
<td>WyeStrainer2</td>
<td>441</td>
<td>FISC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>WyeStrainer3</td>
<td>441</td>
<td>FISC</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>XLT</td>
<td>301</td>
<td>CRBW</td>
<td>CROSS</td>
</tr>
<tr>
<td>XMMMM</td>
<td>920</td>
<td>CRLC</td>
<td>CROSS</td>
</tr>
<tr>
<td>XRLT</td>
<td>301</td>
<td>CRBW</td>
<td>CROSS</td>
</tr>
<tr>
<td>XRMMM</td>
<td>920</td>
<td>CRLC</td>
<td>CROSS</td>
</tr>
<tr>
<td>Y</td>
<td>0</td>
<td>TY**</td>
<td>Y-PIECE-FITTING</td>
</tr>
<tr>
<td>YStrainer</td>
<td>0</td>
<td>TY**</td>
<td>TEE</td>
</tr>
<tr>
<td>YStrainer2</td>
<td>0</td>
<td>FI**</td>
<td>MISC-COMPONENT</td>
</tr>
<tr>
<td>ZeroDeadlegTval</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
<tr>
<td>ZeroDeadlegTval2</td>
<td>0</td>
<td>V3**</td>
<td>VALVE-3WAY</td>
</tr>
</tbody>
</table>
### Caps (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cap - Butt Weld</td>
<td>KABW</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Cap - Compression</td>
<td>KACP</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Cap - Screwed</td>
<td>KASC</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Cap - Socket Weld</td>
<td>KASW</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
</tbody>
</table>

**See Also**

*Appendix: Symbols and Symbol Keys (on page 696)*

### Couplings (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nipple - Screwed (Running)</td>
<td>NRSC</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Nipple - Screwed (Barrel)</td>
<td>NBSC</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Coupling - Compression</td>
<td>COCP</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Coupling - Screwed</td>
<td>COSC</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
<tr>
<td>Coupling - Socket Weld</td>
<td>COSW</td>
<td><img src="image_url" alt="Image" /></td>
<td>Y</td>
</tr>
</tbody>
</table>
### Crosses (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross - Butt Weld</td>
<td>CRBW</td>
<td><img src="image" alt="Cross - Butt Weld" /></td>
<td>N</td>
</tr>
<tr>
<td>Cross - Compression</td>
<td>CRCP</td>
<td><img src="image" alt="Cross - Compression" /></td>
<td>N</td>
</tr>
<tr>
<td>Cross - Flanged</td>
<td>CRFL</td>
<td><img src="image" alt="Cross - Flanged" /></td>
<td>N</td>
</tr>
<tr>
<td>Cross - Screwed</td>
<td>CRSC</td>
<td><img src="image" alt="Cross - Screwed" /></td>
<td>N</td>
</tr>
<tr>
<td>Cross - Set On</td>
<td>CRSO</td>
<td><img src="image" alt="Cross - Set On" /></td>
<td>N</td>
</tr>
<tr>
<td>Cross - Set On Reinforced</td>
<td>CRRF</td>
<td><img src="image" alt="Cross - Set On Reinforced" /></td>
<td>N</td>
</tr>
<tr>
<td>Cross - Socket Weld</td>
<td>CRSW</td>
<td><img src="image" alt="Cross - Socket Weld" /></td>
<td>N</td>
</tr>
</tbody>
</table>
**Elbows and Bends (SKEYs)**

The @ character in the symbol keys can be replaced with an integer value in the range 1 to 9, inclusive, to denote the number of segments. Currently, regardless of the value assigned to @, the symbol is drawn per the SKEY plotted isometric shape. The + character in the symbol keys may be replaced with an integer value in the range 1 to 9, inclusive, to denote the bend radius.

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elbow - Butt Weld (90 and 45)</td>
<td>ELBW</td>
<td><img src="image1" alt="Elbow - Butt Weld (90 and 45) SKEY" /></td>
<td>N</td>
</tr>
<tr>
<td>Elbow - Butt Weld (90 and 45) With A Connection</td>
<td>ETBW</td>
<td><img src="image2" alt="Elbow - Butt Weld (90 and 45) With A Connection SKEY" /></td>
<td>N</td>
</tr>
<tr>
<td>Elbow - Butt Weld 180 Return (U Elbow)</td>
<td>EUBW</td>
<td><img src="image3" alt="Elbow - Butt Weld 180 Return (U Elbow) SKEY" /></td>
<td>N</td>
</tr>
<tr>
<td>Elbow - Compression (90 and 45)</td>
<td>ELCP</td>
<td><img src="image4" alt="Elbow - Compression (90 and 45) SKEY" /></td>
<td>N</td>
</tr>
<tr>
<td>Elbow - Compression (90 and 45) With A Connection</td>
<td>ETCP</td>
<td><img src="image5" alt="Elbow - Compression (90 and 45) With A Connection SKEY" /></td>
<td>N</td>
</tr>
<tr>
<td>Elbow - Screwed (90 and 45) With Male Ends</td>
<td>EBSC</td>
<td><img src="image6" alt="Elbow - Screwed (90 and 45) With Male Ends SKEY" /></td>
<td>N</td>
</tr>
<tr>
<td>Elbow - Screwed (90 and 45) With Female Ends</td>
<td>ELSC</td>
<td><img src="image7" alt="Elbow - Screwed (90 and 45) With Female Ends SKEY" /></td>
<td>N</td>
</tr>
</tbody>
</table>
Appendix: Symbols and Symbol Keys

Elbow - Screwed - Female (90 and 45) With A Connection  ETSC  N

Elbow - Socket Weld  ELSW  N

Elbow - Socket Weld With A Connection  ETSW  N

Bend - Flanged (All Angles)  BEFL  N

Bend - Flanged (All Angles) With A Connection  BTFL  N

Bend - Flanged 180 Return (U Bend)  BUFL  N

Bend - Miter Flanged  MIFL  N

Bend - Miter Flanged With A Connection  MTFL  N

Bend - Miter Butt Weld  MIBW  N
Appendix: Symbols and Symbol Keys

- Bend - Miter Butt Weld With A Connection: MTBW
- Bend - Lobster Back Flanged: L@FL
- Bend - Lobster Back Flanged With A Connection: T@FL
- Bend - Lobster Back Butt Weld: L@BW
- Bend - Lobster Back Butt Weld With A Connection: T@BW
- Bend - Pulled (All Angles): PB+D
- Bend - Pulled 180 Return (U Bend): BU+D
- Bend - Pulled (All Angles) With A Connection: TB+D

See Also

Appendix: Symbols and Symbol Keys (on page 696)
## End Prep Connections

You can replace the ** characters in the symbol keys with one of the following end prep types:

<table>
<thead>
<tr>
<th>End Type</th>
<th>End Prep Codelist Value Range</th>
<th>End Prep Type (**)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flanged</td>
<td>2-199</td>
<td>FL (Flanged)</td>
</tr>
<tr>
<td>Male</td>
<td>321 - 329</td>
<td>LC (Liner - clamped)</td>
</tr>
<tr>
<td></td>
<td>331 - 339</td>
<td>SC (Screwed)</td>
</tr>
<tr>
<td></td>
<td>341 - 349</td>
<td>LC (Liner - clamped)</td>
</tr>
<tr>
<td></td>
<td>351 - 359</td>
<td>LC (Liner - clamped)</td>
</tr>
<tr>
<td></td>
<td>361 - 369</td>
<td>CP (Compression)</td>
</tr>
<tr>
<td></td>
<td>371 - 379</td>
<td>SC (Screwed)</td>
</tr>
<tr>
<td></td>
<td>381 - 389</td>
<td>SC (Screwed)</td>
</tr>
<tr>
<td>Female</td>
<td>420 - 429</td>
<td>SW (Socket Weld)</td>
</tr>
<tr>
<td></td>
<td>440 - 449</td>
<td>SC (Screwed)</td>
</tr>
<tr>
<td>All Other Codelist Values</td>
<td></td>
<td>BW (Butt Weld)</td>
</tr>
</tbody>
</table>

### See Also

*Appendix: Symbols and Symbol Keys* (on page 696)

## Fixed Length Pipes (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Length Pipe - With Flanged Ends</td>
<td>FPFL</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Fixed Length Pipe - Without Flanged Ends</td>
<td>FPPL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### See Also

*Appendix: Symbols and Symbol Keys* (on page 696)
## Flanges (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flange - Blind (Blank)</td>
<td>FLBL</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Flared/Loose Backing</td>
<td>FLFL</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Loose Backing</td>
<td>FLLB</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Reducing Concentric</td>
<td>FLRC</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Reducing Eccentric</td>
<td>FLRE</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Slip On</td>
<td>FLSO</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Slip On With 'J' Type Weld</td>
<td>FLSJ</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Orifice Slip On</td>
<td>FOSO</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Socket Weld</td>
<td>FLSW</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flange - Weld Neck</td>
<td>FLWN</td>
<td></td>
<td>Y</td>
</tr>
</tbody>
</table>
See Also
Appendix: Symbols and Symbol Keys (on page 696)

**Inline Filters (SKEYs)**

You can replace the ** characters in the symbol keys with an end prep type. For more information, see End Prep Connections (on page 792).

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter/Strainer - Straight Through</td>
<td>FI**</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Filter/Strainer - Angle</td>
<td>FA**</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Filter/Strainer - Offset</td>
<td>FO**</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Filter/Strainer - Return</td>
<td>FR**</td>
<td></td>
<td>N</td>
</tr>
</tbody>
</table>
**See Also**
*Appendix: Symbols and Symbol Keys (on page 696)*

**Instruments (SKEYs)**

You can replace the ** characters in the symbol keys with an end prep type. For more information, see *End Prep Connections* (on page 792).

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument</td>
<td>II**</td>
<td><img src="image1" alt="Instrument Icon" /></td>
<td>Y</td>
</tr>
<tr>
<td>Instrument - Angle</td>
<td>IA**</td>
<td><img src="image2" alt="Instrument Angle Icon" /></td>
<td>N</td>
</tr>
<tr>
<td>Instrument - Offset</td>
<td>IO**</td>
<td><img src="image3" alt="Instrument Offset Icon" /></td>
<td>N</td>
</tr>
<tr>
<td>Instrument - Return</td>
<td>IR**</td>
<td><img src="image4" alt="Instrument Return Icon" /></td>
<td>N</td>
</tr>
<tr>
<td>Instrument - Dial</td>
<td>IDPL</td>
<td><img src="image5" alt="Instrument Dial Icon" /></td>
<td>N</td>
</tr>
<tr>
<td>Instrument - Dial Flanged</td>
<td>IDFL</td>
<td><img src="image6" alt="Instrument Dial Flanged Icon" /></td>
<td>N</td>
</tr>
</tbody>
</table>
Appendix: Symbols and Symbol Keys

- Orifice Plate  OP  Y
- Restrictor Plate  PR  Y
- Rupture Disk  DR  Y
- Valve - Angle Relief/Vent  RA**  Y
- Valve - Angle Pressure Reducing  XA**  Y
- Valve - Control  CV**  Y
- Valve - Angle Control  CA**  Y
- Valve - 3-Way Control  C3**  N
Appendix: Symbols and Symbol Keys

Valve - 4-Way Control  C4**  N

Valve - Control Square Indicator  SV**  Y

Valve - Angle Control Square Indicator  SA**  Y

Valve - 3-Way Control Square Indicator  S3**  N

Valve - 4-Way Control Square Indicator  S4**  N

Valve - Control Motorized Indicator  MV**  Y

Valve - Angle Control Motorized Indicator  MA**  Y

Valve - 3-Way Control Motorized Indicator  M3**  N

Valve - 4-Way Control Motorized Indicator  M4**  N
### Appendix: Symbols and Symbol Keys

Valve - Control Hand Indicator

![HV** Y]

Valve - Angle Control Hand Indicator

![HA** Y]

Valve - 3-Way Control Hand Indicator

![H3** N]

Valve - 4-Way Hand Indicator

![H4** N]

Valve - Pressure Reducing

![XV** Y]

Valve - Relief/Vent

![RV** Y]

**See Also**

*Appendix: Symbols and Symbol Keys* (on page 696)

## LJSE Type Flanges (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lap Joint Ring (Loose Backing Flange)</td>
<td>FLRG</td>
<td>![FLRG]</td>
<td>Y</td>
</tr>
<tr>
<td>Lap Joint Stub End (Loose Backing Flange)</td>
<td>FLSE</td>
<td>![FLSE]</td>
<td>Y</td>
</tr>
</tbody>
</table>
Appendix: Symbols and Symbol Keys

Miscellaneous Items (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow Indicator</td>
<td>FLOW</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Hanger/Support</td>
<td>01HG</td>
<td></td>
<td>Y</td>
</tr>
</tbody>
</table>

See Also
Appendix: Symbols and Symbol Keys (on page 696)

Miscellaneous Pipe Components (SKEYs)

You can replace the ** characters in the symbol keys with an end prep type. For more information, see End Prep Connections (on page 792).

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block - Angle</td>
<td>BA**</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Expansion Bellows</td>
<td>EX**</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flame Trap</td>
<td>FT**</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Flexible Hose</td>
<td>FX**</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Component</td>
<td>Symbol</td>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>--------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>Hose Coupling</td>
<td>CH**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Non-Category Item</td>
<td>NC**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Block Offset</td>
<td>BO**</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Plug</td>
<td>PL</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Restrictor Plate</td>
<td>RP</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Block - Return</td>
<td>BR**</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Sight Glass</td>
<td>SG**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Slip Plate</td>
<td>SP</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Slip Ring</td>
<td>SR</td>
<td>Y</td>
<td></td>
</tr>
</tbody>
</table>
### Olets (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Olet - Half Coupling Screwed</td>
<td>HCSC</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Olet - Half Coupling Socket Weld</td>
<td>HCSW</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Olet - Latrolet Butt Weld</td>
<td>LABW</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Olet - Latrolet Screwed</td>
<td>LASC</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Olet - Latrolet Socket Weld</td>
<td>LASW</td>
<td></td>
<td>Y</td>
</tr>
</tbody>
</table>
Appendix: Symbols and Symbol Keys

Olet - Nipolet Screwed  NISC  Y

Olet - Nipolet Plain End  NIPL  Y

Olet - Sockolet  SKSW  Y

Olet - Sweebolet  SWBW  Y

Olet - Thredolet  THSC  Y

Olet - Weldolet  WTBW  Y

Instrument Tee - Flanged  ITFL  N

See Also
Appendix: Symbols and Symbol Keys (on page 696)
## Operators (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fittings used on valves with <strong>AV</strong>, <strong>V3</strong>, <strong>V4</strong>, <strong>VD</strong>, <strong>VG</strong>, and <strong>VV</strong> as the first two characters of the SKEY</td>
<td>01SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on valves with <strong>AR</strong>, <strong>RA</strong>, and <strong>VR</strong> as the first two characters of the SKEY</td>
<td>02SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on valves with <strong>VB</strong>, <strong>VK</strong>, and <strong>VY</strong> as the first two characters of the SKEY</td>
<td>03SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on valves with <strong>VT</strong> as the first two characters of the SKEY</td>
<td>05SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on valves with <strong>VT</strong> as the first two characters of the SKEY</td>
<td>06SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on valves with <strong>VP</strong> as the first two characters of the SKEY</td>
<td>07SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on valves with <strong>VS</strong> as the first two characters of the SKEY</td>
<td>08SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
<tr>
<td>Fittings used on control valves with <strong>AX</strong>, <strong>VX</strong>, and <strong>XA</strong> as the first two characters of the SKEY</td>
<td>09SP</td>
<td><a href="#">Diagram</a></td>
<td>Y</td>
</tr>
</tbody>
</table>
Fittings used on control valves with SA, SV, S3, and S4 as the first two characters of the SKEY

Fittings used on control valves with MA, MV, M3, and M4 as the first two characters of the SKEY

Fittings used on control valves with HA, HV, H3, and H4 as the first two characters of the SKEY

Fittings used on control valves with CA, CV, C3, and C4 as the first two characters of the SKEY

See Also
Appendix: Symbols and Symbol Keys (on page 696)

Other End Connections (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erection Weld or Connection on fittings with an SW end</td>
<td>SW</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Erection Weld or Connection on fittings with an SC end</td>
<td>SC</td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Erection Weld or Connection on fittings with a CP end</td>
<td>CP</td>
<td></td>
<td>Y</td>
</tr>
</tbody>
</table>

NOTE For SW, SC, or CP type end connections, the software fills in the plotted shapes for erection items and leaves the shapes open for fabrication type items. If the connecting pipe fabrication category is erection, then the software overrides whatever is defined in the fitting.

See Also
Appendix: Symbols and Symbol Keys (on page 696)
#Reducers (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reducer - Concentric Butt Weld</td>
<td>RCBW</td>
<td><img src="image1" alt="RCBW Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Fabricated From Plate</td>
<td>CPBW</td>
<td><img src="image2" alt="CPBW Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Swaged From Pipe</td>
<td>CSBW</td>
<td><img src="image3" alt="CSBW Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Butt Weld With a Connection</td>
<td>CTBW</td>
<td><img src="image4" alt="CTBW Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Fabricated From Plate With a Connection</td>
<td>CZBW</td>
<td><img src="image5" alt="CZBW Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Swaged From Pipe With a Connection</td>
<td>CXBW</td>
<td><img src="image6" alt="CXBW Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Compression</td>
<td>RCCP</td>
<td><img src="image7" alt="RCCP Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Flanged</td>
<td>RCFL</td>
<td><img src="image8" alt="RCFL Diagram" /></td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Concentric Fabricated From Plate Flanged</td>
<td>CPFL</td>
<td><img src="image9" alt="CPFL Diagram" /></td>
<td>Y</td>
</tr>
</tbody>
</table>
Reducer - Concentric Swaged From Pipe Flanged  
CSFL  

Reducer - Concentric Fabricated From Plate Flanged w/ Connection  
CZFL  

Reducer - Concentric Swaged From Pipe Flanged w/ Connection  
CXFL  

Reducer - Concentric Nipple  
RNSC  

Reducer - Concentric Screwed  
RCSC  

Reducer - Concentric Screwed w/ Connection  
CTSC  

Reducer - Concentric Screwed Bush  
RBSC  

Reducer - Concentric Socket Weld Bush  
RBSW  

Reducer - Eccentric Butt Weld  
REBW  

Reducer - Eccentric Fabricated From Plate  
EPBW
<table>
<thead>
<tr>
<th>Reducer - Eccentric Swaged From Pipe</th>
<th>ESBW</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reducer - Eccentric Butt Weld With a Connection</td>
<td>OTBW</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Fabricated From Plate</td>
<td>EZBW</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Swaged From Pipe</td>
<td>EXBW</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Screwed</td>
<td>RESC</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Screwed With a Connection</td>
<td>OTSC</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Flanged</td>
<td>REFL</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Fabricated From Pipe Flanged</td>
<td>EPFL</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Swaged From Pipe Flanged</td>
<td>ESFL</td>
<td>Y</td>
</tr>
<tr>
<td>Reducer - Eccentric Flanged With a Connection</td>
<td>OTFL</td>
<td>Y</td>
</tr>
</tbody>
</table>
### Reducer - Eccentric Fabricated From Plate
- Key: EZFL
- Flanged With a Connection

### Reducer - Eccentric Swaged From Pipe
- Key: EXFL
- Flanged With a Connection

### Reducing Block
- Key: RFPL

---

**See Also**
*Appendix: Symbols and Symbol Keys (on page 696)*

---

## Tees (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tee - Butt Weld</td>
<td>TEBW</td>
<td><img src="image" alt="Tee - Butt Weld" /></td>
<td>N</td>
</tr>
<tr>
<td>Tee - Compression</td>
<td>TECP</td>
<td><img src="image" alt="Tee - Compression" /></td>
<td>N</td>
</tr>
<tr>
<td>Tee - Flanged</td>
<td>TEFL</td>
<td><img src="image" alt="Tee - Flanged" /></td>
<td>N</td>
</tr>
<tr>
<td>Tee - Screwed</td>
<td>TEFL</td>
<td><img src="image" alt="Tee - Screwed" /></td>
<td>N</td>
</tr>
<tr>
<td>Tee - Set-on</td>
<td>TESO</td>
<td><img src="image" alt="Tee - Set-on" /></td>
<td>N</td>
</tr>
</tbody>
</table>
### Appendix: Symbols and Symbol Keys

<table>
<thead>
<tr>
<th>Symbol Description</th>
<th>Code</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tee - Set-on Reinforced</td>
<td>TERF</td>
<td><img src="image" alt="Tee - Set-on Reinforced" /></td>
</tr>
<tr>
<td>Tee - Socket Weld</td>
<td>TESW</td>
<td><img src="image" alt="Tee - Socket Weld" /></td>
</tr>
<tr>
<td>Tee - Swept Branch Butt Weld</td>
<td>TSBW</td>
<td><img src="image" alt="Tee - Swept Branch Butt Weld" /></td>
</tr>
<tr>
<td>Tee - Swept Branch Flanged</td>
<td>TSFL</td>
<td><img src="image" alt="Tee - Swept Branch Flanged" /></td>
</tr>
<tr>
<td>Tee - Swept Branch Compression</td>
<td>TSCP</td>
<td><img src="image" alt="Tee - Swept Branch Compression" /></td>
</tr>
<tr>
<td>Tee - Swept Branch Socket Weld</td>
<td>TSSW</td>
<td><img src="image" alt="Tee - Swept Branch Socket Weld" /></td>
</tr>
</tbody>
</table>

**See Also**

*Appendix: Symbols and Symbol Keys* (on page 696)
### Traps (SKEYs)

You can replace the ** characters in the symbol keys with an end prep type. For more information, see *End Prep Connections* (on page 792).

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trap - In-Line</td>
<td>TI**</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>(Straight Through)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trap - Angle</td>
<td>TA**</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Trap - Offset</td>
<td>TO**</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Trap - Return</td>
<td>TR**</td>
<td>N</td>
<td></td>
</tr>
</tbody>
</table>

**See Also**

*Appendix: Symbols and Symbol Keys* (on page 696)

### Valves (SKEYs)

You can replace the ** characters in the symbol keys with an end prep type. For more information, see *End Prep Connections* (on page 792).

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valve - Angle</td>
<td>AV**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Valve - Angle Pressure Reducing</td>
<td>AX**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Valve Type</td>
<td>Symbol</td>
<td>Key</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>Angle Relief/Vent Valve</td>
<td>AR**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Ball Valve</td>
<td>VB**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Basic Valve</td>
<td>VV**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Butterfly Valve</td>
<td>VY**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Check Valve</td>
<td>VC**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Cock Valve</td>
<td>VK**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Diaphragm Valve</td>
<td>VD**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Gate Valve</td>
<td>VT**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Globe Valve</td>
<td>VG**</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Needle Valve</td>
<td>VN**</td>
<td>Y</td>
<td></td>
</tr>
</tbody>
</table>
### Three-Way Valves

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valve - 3-Way</td>
<td>V3**</td>
<td><img src="image" alt="Three-Way Valve" /></td>
<td>Y</td>
</tr>
</tbody>
</table>

### Four-Way Valves

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valve - 4-Way</td>
<td>V4**</td>
<td><img src="image" alt="Four-Way Valve" /></td>
<td>Y</td>
</tr>
</tbody>
</table>

**See Also**

*Appendix: Symbols and Symbol Keys* (on page 696)
## Vents (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rupture Disk</td>
<td>RD</td>
<td><img src="image" alt="Rupture Disk" /></td>
<td>Y</td>
</tr>
</tbody>
</table>

**See Also**  
*Appendix: Symbols and Symbol Keys (on page 696)*

## Welds (SKEYs)

<table>
<thead>
<tr>
<th>Description</th>
<th>Key</th>
<th>Plotted Isometric Shape</th>
<th>User-Definable (Yes/No)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weld - Site</td>
<td>WS</td>
<td><img src="image" alt="Weld - Site" /></td>
<td>Y</td>
</tr>
<tr>
<td>Weld - Field Fitted</td>
<td>WF</td>
<td><img src="image" alt="Weld - Field Fitted" /></td>
<td>Y</td>
</tr>
<tr>
<td>Weld - Workshop</td>
<td>WW</td>
<td><img src="image" alt="Weld - Workshop" /></td>
<td>Y</td>
</tr>
<tr>
<td>Weld Mitre (Shop)</td>
<td>WM</td>
<td>![Weld Mitre (Shop)]</td>
<td>N</td>
</tr>
<tr>
<td>Weld Mitre (Site)</td>
<td>WM</td>
<td>![Weld Mitre (Site)]</td>
<td>N</td>
</tr>
<tr>
<td>Weld Mitre (Offshore)</td>
<td>WM</td>
<td>![Weld Mitre (Offshore)]</td>
<td>N</td>
</tr>
<tr>
<td>Weld Mitre (Field Fit)</td>
<td>WMF</td>
<td>![Weld Mitre (Field Fit)]</td>
<td>N</td>
</tr>
</tbody>
</table>
Appendix: Symbols and Symbol Keys

Weld Mitre (Field Fit)  WMF  \[\text{MITRE 90.0}^\circ\]  N

Offshore Weld  WO  Y

Offshore Weld-Field Fit  WOF  Y

See Also

Appendix: Symbols and Symbol Keys (on page 696)
Alternative Text (AText) is a powerful ISOGEN feature that enables you to easily change or remove any text on the isometric drawing.

The feature operates by assigning a unique identification number to each standard text string. The ID number is then referred to whenever a change is required to the text string that the number represents.

**NOTE** For a complete list of available ATexts and their default values, see *Grouping of AText Listings* (on page 819).

By definition, a standard text string can be a single character, a single word, or a group of words. However, some ATexts are, by default, set to an all blank word. The total number of separate standard text strings held by the software in this way is in excess of 300.

### Identification Number Format

Because identification numbers are always negative, they must be preceded by a minus sign. For example, **AText -249** represents the default word **WEST**, which is used in the main isometric drawing area.

**NOTE** Some text output on the drawing is controlled by Intergraph Alternative Texts, rather than ISOGEN AText. For more information, see *Intergraph Alternative Text Options (S3D)* (on page 686).

### Using Alternative Text

AText allows you to substitute your own text terminology or language in place of the standard ISOGEN words on the isometric. To make a word change, you do not have to replace the entire standard AText--you can change as little as just one word if that is all is required.

Although the AText feature has a considerable degree of built-in flexibility, you must exercise a certain amount of care when defining your own words, particularly in terms of word lengths. As a general rule, newly defined words or word strings should be about equal in length or shorter than the text that is being replaced. Obvious exceptions to this are the cases of the single line headings in the material list region. In this respect, you must take full responsibility for word definition. ISOGEN does not warn you in cases where words are too long and cannot be accommodated in the standard space provided on the isometric. Badly designed AText can lead to undesirable results, such as over-writing or incorrectly positioned text.

### Special Characters

The following special characters further extend the functionality of ATexts:

**The Dollar ($) Sign** - The $ character, which is used in ISOGEN to force a new line in regular isometric message text, can also be used with ATexts. However, when using the $ character, it is recommended that you carefully check the output results of each occurrence.

**The Question Mark (?)** - The ? character has the following two different uses:
In ATexts -210, -211 and -212 to suppress the plotting of the single characters normally associated with these ATexts, without switching off their associated facility, as would normally happen when an AText is set to blank. For example, setting AText -210 ? suppresses the F that is normally plotted. It does not completely suppress the plotting of the flange material list part number as would normally happen when an AText item is set to blank. Using the ? character is particularly advantageous on spool isometrics.

In some special ATexts at points where the software dynamically inserts information. By default, AText -456 is set to DETAIL ?. As a result, the software inserts either a letter or a number, depending upon which system you have specified at the position of the ? character.

The "At" (@) Sign - You can use the @ character to pad out an AText string with trailing blanks. As a result, the text that follows the AText has a series blanks between it and the AText.

Foreign Language Use

AText is particularly beneficial to foreign language users who want to produce isometrics containing text in their native language. However, there are restrictions governing which characters are permissible. Those restrictions are outlined in The Usable Character Set.

The Usable Character Set

You can only use the following standard English and special purpose characters in AText definitions:

- Upper- or lower-case letters in the range A to Z.
- Numeric characters in the range 0 to 9 inclusive.
- A blank space character.
- The following special purpose symbols: * + - . , : [ ] ( ) # ' < > = | & %

IMPORTANT Other foreign language characters, such as those used in the Cyrillic, Greek, or Chinese alphabets are excluded, as are specially accentuated characters, such as à, à, ã, and so on.

AText and the Drawing Frame Symbols

The AText feature goes further than just controlling text characters. The standard symbols appearing in the line summary area across the bottom of the standard ISOGEN drawing frame, viz. for shop weld, field weld, and so on through traced pipe, can all be suppressed when they are not required by setting their associated ATexts to blank.

Composite Text Messages

Composite text messages are made up of more than one text item and the composition is done by ISOGEN automatically. Such messages can be composed in either of the following two ways:-

- By combining two or more related ATexts
- By combining AText and an associated design database attribute value

Generally, in those cases where AText operates together with design database attribute information to form a composite message, setting the AText part to blank to suppress the plotting of it causes suppression of the attribute text also. For example, if the composite message BATCH
REF: 12/100A/C in the title block area needs to be completely suppressed, then setting AText -252, which contains the words BATCH REF, to blank causes both this and the attribute part, 12/100A/C, not to be plotted.

See Also
Examples (on page 818)
Grouping of AText Listings (on page 819)

Examples

The following are some examples of standard ATexts:

- The material list heading ERECTION MATERIALS.
- The isometric connection messages CONN. TO and CONT. ON in the main drawing area.
- The BATCH REF and PIPING SPEC headings in the title block area.

Each of these are default AText words that are programmed in by ISOGEN but which you can re-program, if required, as explained in the following examples.

Example 1: ERECTION MATERIALS

You can find ERECTION MATERIALS as AText -310 (see "Plotted Material and Cut Pipe List Heading Texts" on page 832). To change the default heading (ERECTION MATERIALS) to CONSTRUCTION MATERIALS, the entry - 310 CONSTRUCTION MATERIALS must appear in the appropriate data input file.

Example 2: CONN.TO

CONN TO. is an example of a composite message that is used at locations where pipelines are connected to equipment nozzles. You can find it as AText -208.

To change the message CONN. TO to JOIN TO, the entry -208 JOIN TO must appear in the appropriate data input file. Information regarding the joined to component, that is, the nozzle name as extracted from the design database, is automatically appended to the AText by ISOGEN to form a composite message, such as JOIN TO D45-NZ12.

Example 3: BATCH REF

BATCH REF is another composite message example--AText -252 (see "Title Block/Drawing Frame" on page 830). The message is used to convey plant zone or area information in the title block area of the isometric where the contents of the BATCH (AREA) type record in the pipeline input data file is automatically appended by ISOGEN. An example of this kind of message is BATCH REF : AR-A/TF/N12.

To remove the batch reference entry from the isometric, set the AText entry in the input data file (IDF) to blank, thus: -252

Doing so removes the entire composite message from the isometric, both the AText BATCH REF : part and the following design database attribute that holds the batch reference information.
Grouping of AText Listings

All the AText listings are logically grouped into the following isometric drawing regions:

- Isometric Drawing Area (on page 819)
- Plotted Material and Cut Pipe List Heading Texts (on page 832)
- Specification Change Indication (on page 829)
- Title Block/Drawing Frame (on page 830)
- Line Summary Area (on page 839)
- Printed Material List (on page 840)
- Weld Box Summary (on page 840)
- Flat Spools and Flange Rotation (on page 843)
- Compipe Material Control Links (on page 844)
- SPOOLGEN (FFISYS) Screen Display (on page 844)
- Reference Plane System (on page 848)

### Isometric Drawing Area

<table>
<thead>
<tr>
<th>Code</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-201</td>
<td>E</td>
<td>Denotes East at east coordinates.</td>
</tr>
<tr>
<td>-202</td>
<td>N</td>
<td>Denotes North at north coordinates.</td>
</tr>
<tr>
<td>-203</td>
<td>W</td>
<td>Denotes West at west coordinates.</td>
</tr>
<tr>
<td>-204</td>
<td>S</td>
<td>Denotes South at south coordinates.</td>
</tr>
<tr>
<td>-205</td>
<td>EL +</td>
<td>Denotes a positive Elevation at elevation coordinates.</td>
</tr>
<tr>
<td>-206</td>
<td>EL -</td>
<td>Denotes a negative Elevation at elevation coordinates.</td>
</tr>
<tr>
<td>-207</td>
<td>? NS</td>
<td>Denotes the pipe nominal size. By setting the AText to blank, the nominal size message is suppressed. Using a ? symbol determines the format used for outputting the nominal size message.</td>
</tr>
<tr>
<td>-208</td>
<td>CONNECT TO</td>
<td>Denotes CONNected TO, where a pipeline/branch end is connected to a nozzle.</td>
</tr>
<tr>
<td>-209</td>
<td>CONT. ON</td>
<td>Denotes CONTinued ON at the point, where a pipeline/branch end is continued onto another pipeline. Used in conjunction with END-CONNECTION type record. Is also used with AText -255 to create a CONT. ON DRG 2 type message when a pipeline is split into multiple drawings. (Isometric drawing area and Material List overflow).</td>
</tr>
<tr>
<td>-210</td>
<td>F</td>
<td>Denotes flange--the letter used with the material list cross-reference</td>
</tr>
</tbody>
</table>
pointer for flanges.

-211 G  Denotes gaskets--the letter used with the material list cross-reference pointer for gaskets.

-212 B  Denotes bolts--the letter used with the material list cross-reference pointer for bolts.

-213 SPINDLE  Indicates the direction of an operating spindle on a valve when it is not pointing in a primary direction.

-214 MM  Denotes millimetres. Used with arrowed dimensions on angle and multi-way valves to indicate leg length.

-215 REDUCING FLANGE  Denotes a reducing flange. The indicator points to the location of the reducing flange.

-216 OFFSET  Indicates a dimensional offset, such as eccentric reducer, offset reducing flange, all forms of offset blocks.

You can use a ? symbol to determine format used for outputting the offset messages. By setting this AText to blank, the offset message is suppressed.

-217 MITRE  Denotes mitered bends. (It is used in conjunction with AText -231 BEND).

-218 LOBSTER  Indicates lobster back bends. (It is used in conjunction with AText -231'BEND).

-219 REINFORCED  Plots an identification message that points to a reinforced tee or cross when the symbol key is TERF or CRRF and no reinforcement pad component is called for.

-220 LEFT LOOSE  Plots a distinguishing message that points to a flange where the LOOSE indicator is set.

-221 FFW  Plots a distinguishing message that points to a field fit weld.

-222 FALL  Denotes a FALLing line. Used in conjunction with the Fall symbol.

You can use a ? symbol to determine the format used for outputting the falling line messages. By setting this AText to blank, the falling line message is now suppressed, but the fall indication symbol is still shown.

-223 (Normally blank)  Produces a software-generated degree (°) symbol, which is output at all angle indicators requiring a degree symbol (bends, falls, and so on).

-224  This symbol is used for falling lines specified with a ratio, such as 1:10.
Appendix: AText Reference Data

-225 (Normally blank) Produces a system-generated percent (%) symbol used on falling pipelines specified with a percentage indication.

-226 GRAD Indicates a falling line specified in gradients.

-227 PER M Indicates a falling line specified as an incline in Metric units, such as millimetres per metre.

-228 PER FT Indicates a falling line that is specified as an incline in Imperial units, such as inches per foot.

-229 SCREWED END Plots an indicator that points to a pipe end that has been set to screwed in the pipeline input data file.

-230 VENT Plots an indicator that points to a vent position at any open ended pipe. It is used in conjunction with an END-POSITION-VENT type record.

-231 BEND Identifies miter and lobster back type bends. Used in conjunction with AText -217 and AText -218.

-232 SPEC Plots an identification message points to any place in the pipe where the piping specification changes. The name of the new specification is automatically indicated.

-233 C Identifies a connector as part of a material list cross-reference, such as C13 in a box.

-234 (Normally blank) Prefixes liners and nut material part numbers that are output on the isometric drawing. Clamps use AText -233 to prefix their part number.

-235 (default) Plots a user-defined start point message on the isometric drawing. Use the special characters listed below to output other items of information as part of the message:

- $ - Split message over several lines.
- ? - Output the system/pipeline reference (IDF record -25 or -6)
- ?? - Output the spool reference (IDF record -7 or -28)
- #nnn - Output the pipeline attribute. Where nnn is set to 0 to 99, outputs ATTRIBUTES0 to ATTRIBUTES99 (IDF records -600 to -699). Where nnn is set to 100 to 199, outputs ATTRIBUTES100 to ATTRIBUTE199 (IDF records -900 to -990)

-236 S Identifies a support as part of a material list cross-reference, such as S22 in a box.

-237 " Denotes the inch sign indicator is used in Imperial dimensions coordinates and nominal size outputs.
Appendix: AText Reference Data

-238  ' Denotes the feet sign indicator used in imperial dimensions and coordinates.

-239  DRAIN Plots a message that points to a drain position any open-ended pipe. It is used in conjunction with an END-POSITION-DRAIN type record.

-240  (Normally blank) This AText is blank by default but can be used to produce a message at any open-ended pipe. It is used in conjunction with an END-POSITION-OPEN type record.

-241  (Normally blank) This AText is blank by default but can be used to produce a message at any closed-ended pipe. It is used in conjunction with an END-POSITION-CLOSED type record.

-242  (Normally blank) This AText is blank by default but can be used to produce a message at any miscellaneous pipe end. It is used in conjunction with an END-POSITION-NULL type record.

-243  (Normally blank) This AText has no default text, but if you set it to a word, such as FLAT, then that text acts as a trigger to output the flat direction of eccentric reducers that have their flat side pointing in a primary direction. (Is used in conjunction with ATexts -244 to -249 inclusive).

NOTE The following six ATexts (-244, -245, -246, -247, -248, and -249) are used to output directions in conjunction with other ATexts on items that carry a direction setting on the component record in the pipeline input data file.

-244  UP Appends a primary direction as part of a composite message. Used in conjunction with ATexts -243, -278, -280, -281 and -282.

-245  DOWN Appends a primary direction as part of a composite message. Used in conjunction with ATexts -243, -278, -280, -281 and -282.

-246  NORTH Appends a primary direction as part of a composite message. Used in conjunction with ATexts -243, -278, -280, -281 and -282.

-247  SOUTH Appends a primary direction as part of a composite message. Used in conjunction with ATexts -243, -278, -280, -281 and -282.

-248  EAST Appends a primary direction as part of a composite message. Used in conjunction with ATexts -243, -278, -280, -281 and -282.

-249  WEST Appends a primary direction as part of a composite message. Used in conjunction with ATexts -243, -278, -280, -281 and -282.

-275  SWEPT TEE Plots a message that points to a tee whose symbol key starts with the characters TS.
Appendix: AText Reference Data

-276 CONT. FROM Denotes CONTinued FROM. This message is plotted when a pipeline is split onto two or more drawings, such as CONT. FROM DRG 1. (The text DRG comes from AText -255. For more information about this AText, see Title Block/Drawing Frame (on page 830).

-277 ORIFICE FLANGE Outputs text that points to orifice flanges.

-278 DIAL FACE Outputs text that points to instruments dials whose symbol key starts with the characters ID and is followed by a relevant direction letter. See the following Notes for more information.

-279 L Denotes lap joint stub end the letter used with the material list cross-reference pointer for LJSE’s.

-280 TAPPING Outputs text that points to orifice plates and is followed by a relevant direction letter. See the following Notes for more information.

-281 TAIL Outputs text that points to spectacle blinds and slip plates and is followed a by relevant direction letter. See the following Notes for more information.

-282 WINDOW Outputs text that points to a site glass and is followed by a relevant direction letter. See the following Notes for more information.

-283 FLAT Identifies non-primary flat directions on eccentric reducers. The contents of this AText is output in front of the contents of a DIRECTION record containing the flat skew direction.

NOTES

- AText Numbers -243, -278, -280, -281 and -282 are only output if a primary direction is set in the component record in the pipeline input data file.
- The appropriate direction (as defined by ATexts -244 to -249) is appended to the specific fitting text to make a composite message—such as DIAL FACE WEST. Alternatively, the content of any DIRECTION (Compound Directions) record can be appended.

-284 TEE BEND Plots text at bends that have an off-line leg.

-285 RATING FLANGE Provides an extra message at a flange that has a different pressure rating to standard. This is achieved by giving the mating gasket a symbol key of the required rating (such as 300#) in the Intermediate Data File (IDF). The facility is only used on fixed length piping.

-286 (Normally blank) This AText is blank by default but if set it will output the text as a message on screwed erection (construction) fittings.
<table>
<thead>
<tr>
<th>AText No.</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>-287</td>
<td>ORIENTATION DIRECTION</td>
<td>Identifies the direction of skewed branches in cases where skew box indication has been suppressed. A software-generated direction will be appended to this text to form a complete message.</td>
</tr>
<tr>
<td>-288</td>
<td>PIPE</td>
<td>Denotes the position(s) of a change in the pipeline reference on system isometrics</td>
</tr>
<tr>
<td>-298</td>
<td>TEE ELBOW</td>
<td>Identifies a tee elbow fitting.</td>
</tr>
<tr>
<td>-337</td>
<td>D BEND RADIUS</td>
<td>Outputs the text D bend radius on individual pulled bends where the bend radius is expressed in terms of a number of pipe diameters. The bend radius value is extracted from a BEND-RADIUS type record in the pipeline input data file and used as a prefix to this AText.</td>
</tr>
<tr>
<td>-338</td>
<td>BEND RADIUS</td>
<td>Outputs the text bend radius on individual pulled bends where the bend radius is expressed in terms of the dimensional units in use. The bend radius value is extracted from a BEND-RADIUS type record in the pipeline input data file and used as a prefix to this AText.</td>
</tr>
<tr>
<td>-346</td>
<td>GEARBOX ORIENTATION</td>
<td>Is used in conjunction with directional information taken from a GEARBOX type record in the pipeline input data file and which is appended to this AText.</td>
</tr>
<tr>
<td>-349</td>
<td>PP</td>
<td>Indicates personal protection type insulation on insulation Indication symbols having the symbol key 'NPP.</td>
</tr>
<tr>
<td>-350</td>
<td>REDUCING ELBOW</td>
<td>Indicates a reducing elbow on fittings having the symbol key ER**.</td>
</tr>
<tr>
<td>-356</td>
<td>U</td>
<td>Identifies special type pulled bends. Is used both on the isometric area and on the material list.</td>
</tr>
<tr>
<td>-357</td>
<td>B</td>
<td>Identifies special type erection welds. Is used both on the isometric area and on the material list.</td>
</tr>
<tr>
<td>-358</td>
<td>W</td>
<td>Identifies special type fabrication welds. Is used both on the isometric area and on the material list.</td>
</tr>
<tr>
<td>-362</td>
<td>ENDSONE</td>
<td>Identifies a specific end on a spool isometric. Used in special circumstances. It also appears in the cut pipe list section for use as a column heading on the cut pipe list.</td>
</tr>
<tr>
<td>-388</td>
<td>TANGENTIAL CONNECTION</td>
<td>Identifies tangential / offset connections. In cases where the tapping point method is used, the existing TAPPING CONNECTION (AText No. -451) message will not be output.</td>
</tr>
<tr>
<td>-389</td>
<td>OFFSET CONNECTION</td>
<td>Identifies tangential / offset connections. In cases where the tapping point method is used, the existing TAPPING</td>
</tr>
<tr>
<td>AText No.</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>-390</td>
<td>FROM ? ORIGIN</td>
<td></td>
</tr>
<tr>
<td>-391</td>
<td>(Normally Blank)</td>
<td></td>
</tr>
<tr>
<td>-392</td>
<td>MULTIPLE</td>
<td></td>
</tr>
<tr>
<td>-394</td>
<td>TOT</td>
<td></td>
</tr>
<tr>
<td>-395</td>
<td>?</td>
<td></td>
</tr>
<tr>
<td>-396</td>
<td>? INC ANGLE</td>
<td></td>
</tr>
<tr>
<td>-399</td>
<td>N or U</td>
<td></td>
</tr>
<tr>
<td>-425</td>
<td>SEAL WELD</td>
<td></td>
</tr>
<tr>
<td>-433</td>
<td>(Normally blank)</td>
<td></td>
</tr>
<tr>
<td>-434</td>
<td>STUB IN</td>
<td></td>
</tr>
<tr>
<td>-243</td>
<td>(Normally blank)</td>
<td></td>
</tr>
<tr>
<td>-437</td>
<td>(Normally blank)</td>
<td></td>
</tr>
<tr>
<td>-439</td>
<td>(EOP)</td>
<td></td>
</tr>
<tr>
<td>-440</td>
<td>NOZZLE?</td>
<td></td>
</tr>
</tbody>
</table>

CONNECTION (AText No. -451) message is not output.

Identifies tangential / offset connections. In cases where the tapping point method is used, the existing TAPPING CONNECTION (AText No. -451) message is not output.

Identifies tangential / offset connections. In cases where the tapping point method is used, the existing TAPPING CONNECTION (AText No. -451) message is not output.

Indicates that multiple components attributes are present for a particular material entry.

Distinguishes an accumulated pipe sub-total from an individual pipe entry.

Outputs a modified heat tracing component part number. Default is ?.

Default is blank. If OS 67 set to 1 and this AText set ? character is substituted by angle value and combined with INC ANGLE text to indicate that angles displayed for elbows and bends on isometric are included (not deflected) angles.

Labels the viewpoint direction arrow. N denotes north and U denotes up. The default label for combined, fabrication, erection and normal spool isometrics is N, while U is the default label for flat spool isometrics. If set to Blank, the viewpoint direction arrow is suppressed.

Indicates the weld type for seal welds on the isometric drawing.

Plots a message that points to a user-positioned set on connections.

Plots a message that points to a user-positioned set in connections.

This AText has no default text but if it is set to a word (such as FLAT) by the user then that text acts as a trigger to output the flat direction of eccentric reducers that have their flat side pointing in a primary direction. (Is used in conjunction with ATexts -244 to -249 inclusive).

Allows metric dimensions to have their dimensional units output on the isometric drawing.

Shows edge of pipe dimensions.

Indicates the nozzle names attached to items of equipment.
### Appendix: AText Reference Data

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>-441</td>
<td>EQUIPMENT LOCATION</td>
<td>Indicates equipment location.</td>
</tr>
<tr>
<td>-451</td>
<td>TAPPING CONNECTION</td>
<td>Is output along with coordinate values at the tapping point on a user-defined fitting. Requires Option Switch 122 to be set to 1 for tapping coordinates output on the isometric drawing.</td>
</tr>
<tr>
<td>-452</td>
<td>UNACCEPTABLE SPLIT</td>
<td>Indicates that an unacceptable drawing split point has been found in tube. When used, the message is output in the top left-hand corner of each affected drawing.</td>
</tr>
<tr>
<td>-454</td>
<td>CONNECTION ORIENTATION</td>
<td>Indicates undeveloped set-on tees and olets, which have no branch leg and are indicated in dotted form on the pipeline, where the intended branch connection is in a skewed direction. A system-generated direction word is appended to this text to form a composite message.</td>
</tr>
<tr>
<td>-455</td>
<td>(Normally blank)</td>
<td>Indicates the elevation coordinate of the flange connection face. Used at flange positions in vertical pipe legs. The special characters ? and $ can be combined with this AText to allow you to control the final form of the output text. ? is used to cause the insertion of elevation value, and $ forces a new line of text. For example, a setting of ?$FLANGE FACE produces EL +22613 FLANGE FACE. In this situation, the EL characters are obtained by the software also using AText -205 automatically.</td>
</tr>
<tr>
<td>-456</td>
<td>SEE DETAIL ?</td>
<td>Provides a cross-reference message for detail sketches. This AText appears on the drawing part of the isometric. The sketch identifying number or letter is edited in by the software at the ? position.</td>
</tr>
<tr>
<td>-457</td>
<td>MITRE ?</td>
<td>Identifies miter welds. The software edits in the miter angle into the text string at the ? position which can be positioned anywhere in the string.</td>
</tr>
<tr>
<td>-458</td>
<td>(Normally Blank)</td>
<td>Indicates the nominal size for metric bore units. For example, if set to mm the output is 32mm NS; if set to Blank, then 32NS is output.</td>
</tr>
<tr>
<td>-459</td>
<td>?THK</td>
<td>Shows thickness of a penetration plate on the drawing.</td>
</tr>
<tr>
<td>-469</td>
<td>REFERENCE POINT</td>
<td>Identifies a reference dimension Item coordinates.</td>
</tr>
<tr>
<td>-470</td>
<td>SUPPORT LOCATION</td>
<td>Identifies pipe support coordinates.</td>
</tr>
<tr>
<td>-477</td>
<td>CUT OUT ?</td>
<td>Shows the location of where material should be removed.</td>
</tr>
<tr>
<td>-479</td>
<td>PORT REF</td>
<td>Displays a reference message at each port on the isometric drawing. If set to Blank, the message is suppressed.</td>
</tr>
</tbody>
</table>
Appendix: AText Reference Data

-480 PORT CO-ORDS Displays coordinate information at each port on the isometric drawing. If set to Blank, the display of coordinate data output is suppressed.

**NOTES**

- The following nine ATexts are all used for the identification of external reference items when using the reference dimension facility. Any associated text elements will be automatically pre-fixed or appended, as appropriate, to the specified AText element.
- The $ character causes a new line to be plotted, and a ? character is where the software edits in the element name (from any -37, 70, 71 or 72 type record) to derive the full text string.

-460 BEAM$? Identifies horizontal steel-work element (SKEY HST*).
-461 COLUMNS$? Identifies vertical steel-work element (SKEY VST*).
-462 ?$BUILDING CL Identifies centreline of building (SKEY BLD*).
-463 CL EQUIPMENT$? Identifies centreline of equipment (SKEY EQU*).
-464 CL PIPELINES$? Identifies centreline of pipeline (SKEY PIP*).
-465 ?$FLOOR LEVEL Identifies specified floor level (SKEY FLR*).
-466 ?$WALL Identifies specified wall position (SKEY WAL*).
-467 GRID LINES$? Identifies project grid line (SKEY GRD*).
-468 ? Used for miscellaneous user-defined elements (SKEY XXX*). The default ? character causes any identification name associated with the miscellaneous reference to be used when no other AText setting is made.

-471 LOCATION-POINT? Indicates a location point position on the plotted isometric. If more than one is included on any single isometric, a simple ID number is generated and output in the position indicated by the ?.
-475 (Normally blank) Indicates the position of any location points that are included in an incoming pipeline data file. Used in the SmartPlant Spoolgen Probing module. Value must be defined.
-476 (Normally blank) Trigger the indication of drawing identifiers. Used in SmartPlant Spoolgen.
-498 (Normally blank) Points to a site weld. Value must be defined.
-499 SHOP TEST WELD Points to either a site weld or a field fit weld that requires a shop test weld to be performed at the same location. (That is welds with the key WSST or WFST).
-501 (Normally blank) Points to an offshore weld if user-defined.

-502 SUPPORT Indicates the orientation of a pipe support. Content of associated DIRECTION record (containing compound directions for skewed support) is appended to AText.

-512 TACK WELD Plots a distinguishing message that points to a user-positioned tack weld.

-533 FI Identifies field Items on an erection type isometric whenever a new style operations box is requested (Option Switch 53 Position 2 set to 2).

-534 RL Identifies a random length on an erection type isometric whenever a new style operations box is requested (Option Switch 53 Position 2 set to 2).

-535 SU Identifies a pipe support on an erection type isometric whenever a new style operations box is requested (Option Switch 53 Position 2 set to 2).

-536 VL Identifies a valve on an erection type isometric whenever a new style operations box is requested (Option Switch 53 Position 2 set to 2).

-539 Used as a delimiter between the material list cross-reference identifier and the suffix that is added as a unique component identifier in the new style of Identifier (3.1, 3.2, 3.3 as opposed to 3).

-541 _N Used as delimiter/identifier in general note names.

-542 _S Used as delimiter/identifier in general note names.

-543 (Normally blank) Indicates the position of any special note names that are included in an incoming pipeline data file. Used in SmartPlant Spoolgen Probing module.

-544 (Normally blank) Indicates the position of any additional materials that are included in an incoming pipeline data file. Used in SmartPlant Spoolgen probing module.

-545 / Used as a separator between part numbers when outputting dual numbers for associated additional material identification on the plotted isometric.

-546 I (Default) Used as the first character of the drawing output file extension (used in conjunction with Option Switch 71 Pos. 7).

-547 _ (Default) Underline character.
Appendix: AText Reference Data

-548  HOR ?  Distinguishes horizontal skew angles from vertical skew angles on isometric drawings.

-549  ? VER  Distinguishes vertical skew angles from horizontal skew angles on isometric drawings.

-550  (Normally Blank)  Outputs a nominal size message on reducing tees, such as TEE RED.

-551  (Normally Blank)  Outputs a nominal size message on equal tees, such as TEE EQU.

-552  (Normally Blank)  Outputs a nominal size message on concentric reducers, such as CONC RED.

-553  (Normally Blank)  Outputs a nominal size message on eccentric reducers, such as ECC RED.

-557  CONT JACKET  Denotes continuation of core pipe used on a jacket pipeline.

-558  CONT CORE  Denotes continuation of jacket pipe used on a core pipeline.

-885  -FFISYS  Outputs FF isometric continuation message delimiter.

Specification Change Indication

The following ATexts are used for the indication of specification changes on the isometric drawing.

-289  MATL  Indicates a piping material specification change. The content of the PIPING-SPEC type record in the pipeline input data file is appended to the AText to form a composite message.

-290  INSUL  Indicates an insulation specification change. The content of the INSULATION-SPEC type record in the pipeline input data file is appended to the AText to form a composite message.

-291  TRACE  Indicates a tracing specification change. The content of the TRACING-SPEC type record in the pipeline input data file is appended to the AText to form a composite message.

-292  PAINT  Indicates a PAINTING specification change. The content of the PAINTING-SPEC type record in the pipeline input data file is appended to the AText to form a composite message.

-293  (Normally blank)  Reserved for user-defined AText. The contents of a MISC-SPEC1 type record in the pipeline input data file is appended to the AText to form a composite message.

-294  (Normally blank)  Reserved for user-defined AText. The contents of a MISC-SPEC2 type record in the pipeline input data file is
Appendix: AText Reference Data

-295 (Normally blank) Reserved for user-defined AText. The contents of a MISC-SPEC3 type record in the pipeline input data file is appended to the AText to form a composite message.

-296 (Normally blank) Reserved for user-defined AText. The contents of a MISC-SPEC4 type record in the pipeline input data file is appended to the AText to form a composite message.

-297 (Normally blank) Reserved for user-defined AText. The contents of a MISC-SPEC5 type record in the pipeline input data file is appended to the AText to form a composite message.

Title Block/Drawing Frame

-250 DATE The date is taken from the DATE type record in the pipeline input data file and automatically appended in the required format (UK, EUR or USA) to the AText.

NOTE If the date format is set to UK (see Option Switch 6 for details), this AText also uses ATexts -258, -259, -260, -261, -262, -263, -264, -265, -266, -267, -268 and -269 to form the month part of the date output text.

-251 PROJECT NO. This is used in the title block if the project number has been set in a PROJECT-IDENTIFIER type record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.

-252 BATCH REF This is used in the title block area if a batch reference has been set in a BATCH type record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.

-253 PIPING SPEC Used in the title block if a piping specification has been set in a PIPING-SPEC type record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.

-254 ISS Used in the title block if an issue (also known as Revision) identifier has been set in a REVISION type record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.
### Appendix: AText Reference Data

<table>
<thead>
<tr>
<th>AText</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRG</td>
<td>Used in conjunction with AText -256 to generate a drawing identifier of the form - DRG n OF n - in cases where a pipeline is split into multiple isometrics.</td>
</tr>
<tr>
<td>OF</td>
<td>Used in conjunction with AText -255.</td>
</tr>
<tr>
<td>SPL</td>
<td>Used on spool isometric drawings for the identification of individual spool pieces. A software-generated spool number is appended to the AText to form a composite message. This AText is not used if either a spool prefix (SPOOL-PREFIX type record) or spool identifiers (SPOOL-IDENTIFIER type records) are included in the pipeline input data file.</td>
</tr>
<tr>
<td>JAN</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>FEB</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>MAR</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>APR</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>MAY</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>JUN</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>JUL</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>AUG</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>SEP</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>OCT</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>NOV</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>DEC</td>
<td>Used in conjunction with AText -250.</td>
</tr>
<tr>
<td>THERMAL INSULATION SPEC</td>
<td>Used in the title block if an insulation specification identifier has been set in an INSULATION-SPEC record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.</td>
</tr>
<tr>
<td>TRACING SPEC</td>
<td>Used in the title block if a tracing specification identifier has been set in a TRACING-SPEC type record in the pipeline...</td>
</tr>
</tbody>
</table>
Appendix: AText Reference Data

-272  PAINTING SPEC

Used in the title block if a painting specification identifier has been set in a PAINTING-SPEC type record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.

-436  JACKET SPEC

Used in the title block if a jacket specification identifier has been set in a JACKET-SPEC type record in the pipeline input data file. The content of this record is appended to the AText to form a composite message.

Plotted Material and Cut Pipe List Heading Texts

-274  (Normally blank)

If set, is used as a separator between the pipeline reference and the spool identifier in the spool isometric drawing identifier.

-300  FABRICATION MATERIALS

Is the category heading under which components required for SHOP Fabrication are listed.

-301  PT

Is the part number heading used in conjunction with AText -302 to form a composite message.

-302  NO

Used in conjunction with AText -301 to form a composite message.

-303  COMPONENT DESCRIPTION

Is the heading in the material listing under which components are described according to their catalog component description.

-304  N.S.

Is the heading under which the nominal size of each item is listed. Is used in conjunction with AText -330 or AText -331 to form a composite message.

-305  ITEM CODE

Is the heading under which component identification codes are listed.

-306  QTY

Is the heading under which the required quantities are listed.

-307  PIPE

Is the group sub-heading under which pipe is listed.

-308  FITTINGS

Is the group sub-heading under which pipe fittings are listed, such as elbows tees, and so.

-309  FLANGES

Is the group sub-heading under which all flanges are listed.
<table>
<thead>
<tr>
<th>AText</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-310</td>
<td><strong>ERECTION MATERIALS</strong>&lt;br&gt;Is the category heading under which components required for SITE Erection--or Construction--are listed.</td>
</tr>
<tr>
<td>-311</td>
<td><strong>GASKETS</strong>&lt;br&gt;Is the group sub-heading under which all gaskets are listed</td>
</tr>
<tr>
<td>-312</td>
<td><strong>BOLTS</strong>&lt;br&gt;Is the group sub-heading under which all bolts are listed</td>
</tr>
<tr>
<td>-313</td>
<td><strong>VALVES / IN-LINE ITEMS</strong>&lt;br&gt;Is the group sub-heading under which all valves and in-line Items are listed.</td>
</tr>
<tr>
<td>-314</td>
<td><strong>INSTRUMENTS</strong>&lt;br&gt;Is the group sub-heading under which all instruments are listed.</td>
</tr>
<tr>
<td>-315</td>
<td><strong>SUPPORTS</strong>&lt;br&gt;Is the group sub-heading under which all supports are listed.</td>
</tr>
<tr>
<td>-316</td>
<td><strong>PIPE SPOOLS</strong>&lt;br&gt;Is the sub-heading under which all spool numbers are listed.</td>
</tr>
<tr>
<td>-319</td>
<td><strong>CUT PIPE LENGTH</strong>&lt;br&gt;Is the heading under which all the cut pipe lengths are listed.</td>
</tr>
<tr>
<td>-320</td>
<td><strong>PIECE</strong>&lt;br&gt;Is the sub-heading to AText -319 under which the cut pipe piece numbers are listed. This AText is used in conjunction with AText -321 to form a composite heading.</td>
</tr>
<tr>
<td>-321</td>
<td><strong>NO</strong>&lt;br&gt;Used in conjunction with AText -320 to form a composite heading.</td>
</tr>
<tr>
<td>-322</td>
<td><strong>CUT</strong>&lt;br&gt;Is the sub-heading to AText -319 under which the actual cut pipe lengths are listed. This AText is used in conjunction with AText -323 to form a composite heading.</td>
</tr>
<tr>
<td>-323</td>
<td><strong>LENGTH</strong>&lt;br&gt;Used in conjunction with AText -322 to form a composite heading.</td>
</tr>
<tr>
<td>-324</td>
<td><strong>REMARKS</strong>&lt;br&gt;Is the sub-heading to AText -319 under which one of the ATexts -326, -327, -328, or -500, if applicable, is listed.</td>
</tr>
<tr>
<td>-325</td>
<td><strong>(Normally blank)</strong>&lt;br&gt;Used for spool number separator on the material list.</td>
</tr>
<tr>
<td>-326</td>
<td><strong>PLD BEND</strong>&lt;br&gt;Used for a pulled bend remark, which is listed under AText -324 if a cut pipe length contains a pulled bend.</td>
</tr>
</tbody>
</table>
Appendix: AText Reference Data

-327 LOOSE FLG  
Is a remark which will be listed under AText -324 if a cut pipe length has a loose flange requirement.

-328 FF WELD  
Is the field fit weld remark which is listed under AText -324 if a cut pipe length contains a field fit weld.

-329 M  
Used to denote lengths of pipe are in metres. Also used to indicate unit type metres in centreline length summary.

-330 INS  
Used to denote nominal sizes are in inches. It is used in conjunction with AText -304 and AText -317.

-331 MM  
Denotes the nominal sizes are in millimetres. Also used to indicate unit type Millimetres in centreline length summary. It is used in conjunction with AText -304 and AText -317.

-334 S  
Is used only on fixed length piping. The contents of this AText are appended to the item code to form a composite code when one or more ends of the fixed length spool has a special flange.

-335 WITH SPECIAL RATING FLANGE(S) (SEE ISO)  
Is used only on fixed length piping. The contents of the AText are appended to the item description to form a composite message. Is used whenever AText -334 is used.

-339 MISCELLANEOUS COMPONENTS  
Is the group sub-heading under which all non-categorized components are listed.

-340 INDUCTION BEND ID -  
Used to identify pipe required in the fabrication of induction bends. The induction bend tag is appended to the AText to form a complete text string.

-341 EQUIPMENT TRIM MATERIALS  
Is the sub-heading under which all equipment trim materials are listed.

-342 NOZZLE REF -  
Is the sub-heading under which all materials associated with an individual nozzle are listed. The content of the related NOZZLE-REFERENCE is appended to the AText to form a complete text string. Used on equipment trim drawings only.

-343 CONTINUED  
Used with AText -342 to identify situations where the listing of components for a nozzle is being continued from a previous drawing. Used on equipment trim drawings only.
<table>
<thead>
<tr>
<th>AText Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-344</td>
<td><strong>END CONNECTORS</strong></td>
</tr>
<tr>
<td>-345</td>
<td><strong>AND</strong></td>
</tr>
<tr>
<td>-347</td>
<td>(Normally blank)</td>
</tr>
<tr>
<td>-348</td>
<td>(Normally blank)</td>
</tr>
<tr>
<td>-351</td>
<td><strong>FABRICATED (PULLED) BEND</strong></td>
</tr>
<tr>
<td>-352</td>
<td><strong>WEIGHT</strong></td>
</tr>
<tr>
<td>-353</td>
<td><strong>KGS</strong></td>
</tr>
<tr>
<td>-354</td>
<td><strong>LBS</strong></td>
</tr>
<tr>
<td>-355</td>
<td><strong>TOTAL WEIGHT-THIS DRG</strong></td>
</tr>
<tr>
<td>-356</td>
<td><strong>U</strong></td>
</tr>
<tr>
<td>-357</td>
<td><strong>B</strong></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>-358</td>
<td>W</td>
</tr>
<tr>
<td>-359</td>
<td>(Normally blank)</td>
</tr>
<tr>
<td>-362</td>
<td>ENDSONE</td>
</tr>
<tr>
<td>-363</td>
<td>ENDTWO</td>
</tr>
<tr>
<td>-364</td>
<td>ITEM$CODE</td>
</tr>
<tr>
<td>-365</td>
<td>(Normally blank)</td>
</tr>
<tr>
<td>-366</td>
<td>SQ.CUT</td>
</tr>
<tr>
<td>-367</td>
<td>BEVEL</td>
</tr>
<tr>
<td>-368</td>
<td>SCREWED</td>
</tr>
<tr>
<td>-369</td>
<td>SHAPED</td>
</tr>
<tr>
<td>-370</td>
<td>MITRED</td>
</tr>
<tr>
<td>-371</td>
<td>OFFSHORE MATERIALS</td>
</tr>
<tr>
<td>-372</td>
<td>REMARKS</td>
</tr>
<tr>
<td>-373</td>
<td>REM</td>
</tr>
<tr>
<td>-374</td>
<td>ANGLE</td>
</tr>
</tbody>
</table>

- **W**: Special ATEXT only to identify special type fabrication welds. Is used both on the material list and on the isometric area as a prefix to the part number.
- **ENDSONE**: Column heading on cut pipe list. (Also appears in the isometric drawing area section when it is necessary to identify a specific end of a cut piece).
- **ENDTWO**: Column heading on cut pipe list.
- **ITEM$CODE**: Last column heading on cut pipe list when item code heading is required. (See Also AText -365).
- **SQ.CUT**: Used for square cut in End Condition columns on cut pipe list.
- **BEVEL**: Used for bevel in End Condition columns on cut pipe list.
- **SCREWED**: Used for screwed in End Condition columns on cut pipe list.
- **SHAPED**: Used for shaped in End Condition columns on cut pipe list.
- **MITRED**: Used for mitered in End Condition columns on cut pipe list.
- **OFFSHORE MATERIALS**: Is the category heading under which components required for OFFSHORE erection are listed.
- **REMARKS**: Remarks region heading at bottom of material list where remarks text is collectively listed.
- **REM**: Remarks column heading in material list. Remark reference numbers are listed in this column.
- **ANGLE**: Used on special type pulled bends where angle information is appended to the item Description field.
<table>
<thead>
<tr>
<th>Code</th>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-375</td>
<td>WELDS</td>
<td>Is the group sub-heading under which all welds are listed.</td>
</tr>
<tr>
<td>-376</td>
<td>FAB</td>
<td>Used to identify Fabrication material when category is used as a data item.</td>
</tr>
<tr>
<td>-377</td>
<td>EREC</td>
<td>Used to identify Erection material when category is used as a data item.</td>
</tr>
<tr>
<td>-378</td>
<td>OFF</td>
<td>Used to identify Offshore material when category is used as a data item.</td>
</tr>
<tr>
<td>-379</td>
<td>TOTAL FABRICATION WEIGHT</td>
<td>Identification text for total fabrication weight in Weight column.</td>
</tr>
<tr>
<td>-380</td>
<td>TOTAL ERECTION WEIGHT</td>
<td>Identification text for total erection weight in Weight column.</td>
</tr>
<tr>
<td>-381</td>
<td>TOTAL OFFSHORE WEIGHT</td>
<td>Identification text for total offshore weight in Weight column.</td>
</tr>
<tr>
<td>-382</td>
<td>TOTAL WEIGHT UNLISTED ITEMS</td>
<td>Identification text for the total weight of unlisted items in Weight column.</td>
</tr>
<tr>
<td>-383</td>
<td>*</td>
<td>Missing weight indicator. The * is a special marker indicating zero weight.</td>
</tr>
<tr>
<td>-384</td>
<td>TANGENT+</td>
<td>Used in the REMARKS column to indicate extra material for minimum length.</td>
</tr>
<tr>
<td>-385</td>
<td>CUT/WELD</td>
<td>Used in the cut piece remarks section against cut pieces with extra material.</td>
</tr>
</tbody>
</table>
ON the cut pipe list/report.

-431  SOCKET  
Used to indicate a female socket weld/compression/glued/push fit end preparation on the cut pipe list/report.

-472  No.?  
Used to output a location point ID number on the drawing frame. Is only output when multiple location points are included on a single isometric.

-473  OF  
Used as part of a location point position on the drawing frame.

-474  ABOVE  
Used as part of a location point position on the drawing frame.

-500  SHOP TEST  
Used on the cut list to identify cut pieces that need to have an additional shop test allowance. (That is welds with the SKEY WSST or WFST).

-503  SPOOL ID  
Used as either a header or column identifier on the following printed output whenever spool identifiers are listed.

i) Printed material list (Style 1 or 2).
ii) Printed material control file.
iii) Printed weld summary.

-514  REINFPAD  
Used as the item code for a reinforcement pad whenever automatic item code generation is requested.

-515  REINFORCEMENT PAD FOR @  
Used as the first part of a description for a reinforcement pad whenever automatic description generation is requested. The second part of the pad description is the description of the main pipeline tube to which the pad is welded.

-537  (Normally blank)  
If set, is used as an alternative units indication on any length output on any style of material list. (Overrules any length units setting in Option Switch 24).

-538  (Normally blank)  
If set, is used to offer an alternative form of bolt diameter/length output on any style of material list.

-540  (Normally blank)  
If set, is used as an optional column heading for bolt diameter where the bolt units are different to the normal pipeline units.

-554  (Normally blank)  
If set, outputs text to supplement scalar quantities output to the material list on the drawing and
material control file.

-555  SPOOL -  If set, identifies materials belonging to spools on the material list.

Line Summary Area

The ATexts that are used in the line summary area along the bottom of the isometric drawing can either have their ATexts changed or made blank. If the AText is changed, then its associated symbol is drawn. If it is set to blank, then the symbol is not drawn.

**NOTE** In these ATexts, the inclusion of a $ character creates a forced line feed causing the text to be plotted over two lines.

-400  TRACEDPIPE
-401  LAGGEDPIPE
-402  PIPE$SUPPORT
-403  COMPN$JOINT
-404  SCREWED$JOINT
-405  SOCKET$WELD
-406  FIELD$WELD
-407  SHOP$WELD
-408  &
-409  

These two ATexts have no default text but can be used for any user-specified general information on the drawing frame. A typical example is PULLED BEND RADIUS IS 3X NOMINAL PIPE BORE.

-410  [1] DENOTES PIPE SPOOL NO$
-411  1 DENOTES PARTS LIST NO

This is a general note to signify how spool numbers and material list part numbers are shown on the isometric.

**NOTE** If only the bottom line is required, the records in the pipeline input data file should be as shown below:

-410  $ 1 DENOTES PARTS LIST NO
-411  SITE$CONNECTION
The following ATexts appear in the line summary area along the bottom of both the plotted and printed Material Lists.

-317 PIPE NS  Is used in conjunction with AText -318 to which the total centreline length per bore is automatically computed and listed. Also uses AText -330 or AText -331 to indicate units.

-318 CL LENGTH  Is used in conjunction with AText -317. Also uses AText -329 or AText -331 or AText -360 or AText -361 depending on units being used.

-360 FT  Used to indicate unit type feet in pipe centre-line length region.

-361 FT-INS  Used to indicate unit type feet-inches in pipe centre-line length region.

-386 Blank is the default. used to control output of insulation length.

-387 Blank is the default. used to control output of heat trace length.

Printed Material List

The following ATexts are used on the printed material list, in addition to those ATexts listed for the plotted material and cut pipe lists.

-332 PAGE  This has a page number automatically appended.

-333 PIPELINE REF  This has the pipeline reference automatically appended.

-336 SYSTEM REF  This is used as an alternative to AText -333 when producing material list or system isometrics. The contents of a SYSTEM-ISOMETRIC-REFERENCE record in the pipeline input data file is automatically appended to the AText.

Weld Box Summary

Standard Weld Summary Box

Weld Box header details (line 1):

<table>
<thead>
<tr>
<th>-412 WELD</th>
<th>SHOP</th>
<th>WELD</th>
<th>WELDE</th>
<th>VISUAL</th>
<th>ND</th>
<th>HARD</th>
<th>S.R</th>
<th>FAB.Q</th>
</tr>
</thead>
</table>

Continuation of Weld Box header details. (line 2):

<table>
<thead>
<tr>
<th>-413 NO</th>
<th>/FLD</th>
<th>PROC</th>
<th>ID</th>
<th>ACCEP</th>
<th>NO</th>
<th>NO</th>
<th>ACCEP</th>
</tr>
</thead>
</table>
The first column of this Weld Summary box is used for the software-generated weld number and optional prefix. The second column is for Weld category and contains the Shop / Field / Offshore indicators. This must be taken into account when making any changes to either of these ATexts.

<table>
<thead>
<tr>
<th>AText</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Weld category identification - Shop.</td>
</tr>
<tr>
<td>F</td>
<td>Weld category identification - Field.</td>
</tr>
<tr>
<td>O</td>
<td>Weld category identification - Offshore.</td>
</tr>
</tbody>
</table>

One of the above characters is plotted in the Weld Category column (column 2), depending upon the type of weld.

**User-Defined Weld Summary Box**

<table>
<thead>
<tr>
<th>AText</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BW</td>
<td>Used for weld type identifier butt weld.</td>
</tr>
<tr>
<td>SW</td>
<td>Used for weld type identifier socket weld.</td>
</tr>
<tr>
<td>MW</td>
<td>Used for weld type identifier miter weld.</td>
</tr>
<tr>
<td>LUG</td>
<td>Used for weld type identifier LUGG.</td>
</tr>
<tr>
<td>SOF</td>
<td>Used for weld type identifier slip-on flange.</td>
</tr>
<tr>
<td>SOB</td>
<td>Used for weld type identifier set-on branch.</td>
</tr>
<tr>
<td>LET</td>
<td>Used for weld type identifier LET, such as olet, latrolet, half coupling..</td>
</tr>
<tr>
<td>SLW</td>
<td>Used to indicate the weld type for seal welds in welding lists and reports.</td>
</tr>
<tr>
<td>SEAM</td>
<td>Weld type identifier for a seam weld.</td>
</tr>
<tr>
<td>RPD</td>
<td>Can be user-defined and used to identify field fit welds only when the weld category attribute is output.</td>
</tr>
<tr>
<td>LF</td>
<td>Used for weld type identifier for a basic reinforcing pad weld, when one extra weld number is requested.</td>
</tr>
<tr>
<td>L4</td>
<td>Used for weld type identifier for a reinforcing pad to main pipeline weld, when two extra weld numbers are requested. (Used together with AText -509).</td>
</tr>
<tr>
<td>PAD</td>
<td>If set, it is used as the delimiter between the two material list Identifiers in the Location column of the operations box.</td>
</tr>
<tr>
<td>PAD</td>
<td>Used as a part identifier in the Location column of the operations box in cases where a reinforcement pad has not been included on the material</td>
</tr>
</tbody>
</table>
Appendix: AText Reference Data

-513  **TW**  Weld type identifier for a tack weld.

-516  **TRN**  Weld type identifier for a trunnion weld (The weld that connects the trunnion to the main pipeline).

-517  **5**  Used for weld action identification for a manual weld on the operations list.

-518  **1**  Used for weld action identification for an automatic weld on the operations list.

-519  **EB**  Used for pulled bend identification on the operations list.

-520  **RL**  Used for random length identification on the operations list.

-521  **FW.**  Used for weld type identifier for a fillet weld. (The basic weld used for connecting pipe supports to the pipeline).

-522  **(Normally blank)**  If set, it is used as an alternative to **AText -422** to identify the branch connection weld(s) for a reinforced tee or cross.

-523  **(Normally blank)**  If set, it is used as an alternative to **AText -422** to identify the branch connection weld(s) for an angled (not 90°) reinforced tee or cross.

-524  **(Normally blank)**  If set, it is used as an alternative to **AText -422** to identify the branch connection weld(s) for an angled (not 90°) set-on tee or cross.

-525  **(Normally blank)**  If set, it is used for the weld type identifier for any olet type component with an SKEY of HCSC or HCSW.

-526  **(Normally blank)**  If set, it is used for the weld type identifier for a reinforcement pad to main pipeline weld on an angled branch when two extra weld numbers are requested. (Used together with **AText -527**).

-527  **(Normally blank)**  If set, it is used for the weld type identifier for a reinforcement pad to branch weld on an angled branch - when two extra weld numbers are requested. (Used together with **AText -526**).

-528  **(Normally blank)**  If set, it is used for the weld type identifier for a trunnion to elbow / bend connection.

-529  **(Normally blank)**  If set, it is used for the weld type identifier for a 90° non-reinforced trunnion to main pipeline weld.

-530  **(Normally blank)**  If set, it is used for the weld type identifier for an angled non-reinforced trunnion to main pipeline weld.

-531  **(Normally blank)**  If set, it is used for the weld type identifier for a 90° reinforced trunnion to main pipeline weld.
Appendix: AText Reference Data

-532 (Normally blank) If set, it is used for the weld type identifier for an angled reinforced trunnion to main pipeline weld.

Flat Spools and Flange Rotation

The following six ATexts are used in DIRECTION records in the pipeline input data file when indicating compound directions for certain components in skewed Pipelines. Also used when ISOGEN is generating ORIENTATION and CONNECTION DIRECTION messages on flat spools.

-481 E Denotes East.
-482 N Denotes North.
-483 W Denotes West.
-484 S Denotes South.
-485 U Denotes Up.
-486 D Denotes Down.

-487 *** REFERENCE FLAT *** Used to identify which eccentric reducer flat direction is used as a reference for a given flange rotation.

-488 *** REFERENCE SPINDLE *** Used to identify which spindle is used as a reference for a given flange rotation.

-489 *** REFERENCE SUPPORT *** Used to identify which support is used as a reference for a given flange rotation.

-490 *** REFERENCE BRANCH *** Used to identify which branch is used as a reference for a given flange rotation.

-491 *** REFERENCE WINDOW *** Used to identify which window is used as a reference for a given flange rotation.

-492 FLAT DIRECTION Used to point to 2D and 3D skew enclosure triangles at eccentric reducers to indicate a flat direction on flat spools.

-493 SPINDLE DIRECTION Used to point to 2D and 3D skew enclosure triangles located at spindles on flat spools.

-494 SUPPORT DIRECTION Used to point to 2D and 3D skew enclosure triangles located at supports on flat spools.

-495 BRANCH DIRECTION Used to point to 2D and 3D skew enclosure triangles located at undeveloped set-on branches or single
### COMPIPE Material Control Links

- **-299** `/` Single character delimiter used between the three data items that are required to be in each ITEM-CODE record when using the COMPIPE link facility.

- **-453** `MM-` Used to separate nominal size and pipeline reference when ISOGEN generates a drawing number for use in the COMPIPE.MTO file.

### SPOOLGEN (FFISYS) Screen Display

The following -800 series ATexts are used in SPOOLGEN probing and the FFISYS.

- **-800** `BEND` Identification of BEND when probing.

- **-801** `ELBOW` Identification of ELBOW when probing.

- **-802** `OLET` Identification of OLET when probing.

- **-803** `TEE` Identification of TEE when probing.

- **-804** `CROSS` Identification of CROSS when probing.

- **-805** `REDUCER` Identification of REDUCER when probing.

- **-806** `TEE REDUCER` Identification of TEE REDUCER when probing.

- **-807** `REDUCING FLANGE` Identification of REDUCING FLANGE when probing.

- **-808** `TEE BEND/ELBOW` Identification of TEE BEND/ELBOW when probing.

- **-809** `ANGLE VALVE` Identification of ANGLE VALVE when probing.

- **-810** `3 WAY VALVE` Identification of 3 WAY VALVE when probing.
<table>
<thead>
<tr>
<th>Code</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-811</td>
<td>4 WAY VALVE</td>
<td>Identification of 4 WAY VALVE when probing.</td>
</tr>
<tr>
<td>-812</td>
<td>INSTRUMENT</td>
<td>Identification of INSTRUMENT when probing.</td>
</tr>
<tr>
<td>-813</td>
<td>MISC COMPONENT</td>
<td>Identification of MISC COMPONENT when probing.</td>
</tr>
<tr>
<td>-814</td>
<td>PIPE (TUBE)</td>
<td>Identification of PIPE (TUBE) when probing.</td>
</tr>
<tr>
<td>-815</td>
<td>FIXED PIPE</td>
<td>Identification of FIXED PIPE when probing.</td>
</tr>
<tr>
<td>-816</td>
<td>PIPE BLOCK</td>
<td>Identification of PIPE BLOCK when probing.</td>
</tr>
<tr>
<td>-817</td>
<td>FLANGE</td>
<td>Identification of FLANGE when probing.</td>
</tr>
<tr>
<td>-818</td>
<td>LJSE FLANGE</td>
<td>Identification of LJSE FLANGE when probing.</td>
</tr>
<tr>
<td>-819</td>
<td>BLIND FLANGE</td>
<td>Identification of BLIND FLANGE when probing.</td>
</tr>
<tr>
<td>-820</td>
<td>CONNECTOR</td>
<td>Identification of CONNECTOR when probing.</td>
</tr>
<tr>
<td>-821</td>
<td>BACKING NUT</td>
<td>Identification of BACKING NUT when probing.</td>
</tr>
<tr>
<td>-822</td>
<td>CLAMP</td>
<td>Identification of CLAMP when probing.</td>
</tr>
<tr>
<td>-823</td>
<td>MISC HYGENIC COMPONENT</td>
<td>Identification of MISC HYGENIC COMPONENT when probing.</td>
</tr>
<tr>
<td>-824</td>
<td>CAP</td>
<td>Identification of CAP when probing.</td>
</tr>
<tr>
<td>-825</td>
<td>COUPLING</td>
<td>Identification of COUPLING when probing.</td>
</tr>
<tr>
<td>-826</td>
<td>UNION</td>
<td>Identification of UNION when probing.</td>
</tr>
<tr>
<td>-827</td>
<td>VALVE</td>
<td>Identification of VALVE when probing.</td>
</tr>
<tr>
<td>-828</td>
<td>TRAP</td>
<td>Identification of TRAP when probing.</td>
</tr>
<tr>
<td>-829</td>
<td>VENT</td>
<td>Identification of VENT when probing.</td>
</tr>
<tr>
<td>-830</td>
<td>FILTER</td>
<td>Identification of FILTER when probing.</td>
</tr>
<tr>
<td>-831</td>
<td>SUPPORT</td>
<td>Identification of SUPPORT when probing.</td>
</tr>
<tr>
<td>-832</td>
<td>INSTRUMENT TEE</td>
<td>Identification of INSTRUMENT TEE when probing.</td>
</tr>
<tr>
<td>-833</td>
<td>WELD</td>
<td>Identification of WELD when Probing.</td>
</tr>
<tr>
<td>-834</td>
<td>NONE</td>
<td>Indication that NO component was located successfully when probing.</td>
</tr>
<tr>
<td>-835</td>
<td>(Not Used)</td>
<td>Unused AText</td>
</tr>
</tbody>
</table>
(Not Used) Unused AText.

-837 (Not Used) Unused AText.

-838 (Not Used) Unused AText.

-839 (Not Used) Unused AText.

-840 Changed to Bend ‘Probing Action’ message - Elbow changed to bend.

-841 Flange set to Loose ‘Probing Action’ message - Flange set to loose.

-842 Detail Sketch ? ‘Probing Action’ message - Detail Sketch added.

-843 Support changed to Fabrication ‘Probing Action’ message - Support changed to Fabrication.

-844 Support changed to Erection ‘Probing Action’ message - Support changed to Erection.

-845 Support changed to Offshore ‘Probing Action’ message - Support changed to Offshore.


-847 Support(s) added ‘Probing Action’ message - Support Welds added.


-849 Shop Test ‘Probing Action’ message - Shop Test Weld added.

-850 REDUCING-CONCENTRIC Flange type REDUCING-CONCENTRIC selected when probing.

-851 REDUCING ECCENTRIC Flange type REDUCING-ECCENTRIC selected when probing.

-852 STUB/BACKING PAIR Flange type STUB/BACKING PAIR selected when probing.

-853 SCREWED Flange type SCREWED selected when probing.

-854 SLIP-ON J TYPE Flange type SLIP-ON J TYPE selected when probing.

-855 SLIP-ON Flange type SLIP-ON selected when probing.

-856 SOCKET-WELD Flange type SOCKET-WELD selected when probing.

-857 WELD-NECK Flange type WELD-NECK selected when probing.

-858 SLIP-ON ORIFICE Flange type SLIP-ON ORIFICE selected when
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Message Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>-859</td>
<td>WELD-NECK ORIFICE</td>
<td>Flange type WELD-NECK ORIFICE selected when probing.</td>
</tr>
<tr>
<td>-860</td>
<td>LAP-JOINT RING</td>
<td>Flange type LAP-JOINT RING selected when probing.</td>
</tr>
<tr>
<td>-861</td>
<td>LAP-JOINT STUB END</td>
<td>Flange type LAP-JOINT STUB END selected when probing.</td>
</tr>
<tr>
<td>-862</td>
<td>UNKNOWN</td>
<td>Flange type UNKNOWN selected when probing.</td>
</tr>
<tr>
<td>-863</td>
<td>Material added</td>
<td>‘Probing Action’ message - Indication of additional materials added to pipeline.</td>
</tr>
<tr>
<td>-865</td>
<td>Specific Information Note - ?</td>
<td>‘Probing Action’ message - Specific information note added.</td>
</tr>
<tr>
<td>-866</td>
<td>Weld deleted</td>
<td>‘Probing Action’ message - Weld deleted.</td>
</tr>
<tr>
<td>-867</td>
<td>Support Weld(s) deleted</td>
<td>‘Probing Action’ message - Support welds deleted.</td>
</tr>
<tr>
<td>-868</td>
<td>Spool Name deleted</td>
<td>‘Probing Action’ message - Spool same deleted.</td>
</tr>
<tr>
<td>-869</td>
<td>Flow Arrow deleted</td>
<td>‘Probing Action’ message - Flow arrow deleted.</td>
</tr>
<tr>
<td>-870</td>
<td>Message deleted</td>
<td>‘Probing Action’ message - Message deleted.</td>
</tr>
<tr>
<td>-871</td>
<td>Detail Sketch deleted</td>
<td>‘Probing Action’ message - Detail Sketch deleted.</td>
</tr>
<tr>
<td>-872</td>
<td>Information Note deleted</td>
<td>‘Probing Action’ message - Information Note deleted.</td>
</tr>
<tr>
<td>-873</td>
<td>Additional Material deleted</td>
<td>‘Probing Action’ message - Additional material deleted.</td>
</tr>
<tr>
<td>-875</td>
<td>Location point added</td>
<td>‘Probing Action’ message - Location point added.</td>
</tr>
<tr>
<td>-876</td>
<td>Location point deleted</td>
<td>‘Probing Action’ message - Location point deleted.</td>
</tr>
<tr>
<td>-877</td>
<td>FLOOR/WALL PENETRATION</td>
<td>‘Probing Action’ message - Identification of FLOOR/WALL PENETRATION when probing.</td>
</tr>
<tr>
<td>-878</td>
<td>FLOW ARROW</td>
<td>‘Probing Action’ message - Identification of FLOW ARROW when probing.</td>
</tr>
<tr>
<td>-879</td>
<td>INSULATION SYMBOL</td>
<td>‘Probing Action’ message - Identification of</td>
</tr>
</tbody>
</table>
### Appendix: AText Reference Data

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Message Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>-880</td>
<td>MESSAGE</td>
<td>‘Probing Action’ message - Identification of MESSAGE when probing.</td>
</tr>
<tr>
<td>-881</td>
<td>Drawing Identifier deleted</td>
<td>‘Probing Action’ message - Identification of Drawing Identifier deleted.</td>
</tr>
<tr>
<td>-883</td>
<td>Pipeline Start</td>
<td>In Probing - Indication of default pipeline start point.</td>
</tr>
<tr>
<td>-884</td>
<td>Default Bypass Closure</td>
<td>In Probing - Indication of default bypass closure point.</td>
</tr>
<tr>
<td>-886</td>
<td>Bypass Closure</td>
<td>‘Probing Action’ message - Redefined bypass closure point.</td>
</tr>
<tr>
<td>-887</td>
<td>Pipe Support added</td>
<td>‘Probing Action’ message - Pipe support added.</td>
</tr>
<tr>
<td>-888</td>
<td>Pipe Support deleted</td>
<td>‘Probing Action’ message - Pipe support deleted.</td>
</tr>
<tr>
<td>-889</td>
<td>Properties Changed</td>
<td>‘Probing Action’ message - Category change for gaskets and bolts.</td>
</tr>
<tr>
<td>-890</td>
<td>Coupling Added</td>
<td>‘Probing Action’ message - Label showing where a coupling has been added.</td>
</tr>
<tr>
<td>-891</td>
<td>Coupling Deleted</td>
<td>‘Probing Action’ message - Label showing where an existing coupling has been removed.</td>
</tr>
<tr>
<td>-892</td>
<td>Pipe Support Changed</td>
<td>‘Probing Action’ message - Label showing where an existing pipe support has been changed.</td>
</tr>
</tbody>
</table>

### Reference Plane System

The following ATExts are used to output the relative directions associated with reference planes.

- `^` is substituted with the reference plane name.
- `?` is substituted with the distance from the reference plane.

- **-398 VOL ?**
  
  Default is blank. Controls the output of sub-volume names at co-ordinate positions on the isometric.

- **-443 ^ + ?**
  
  Used for positive relative position in E/W plane.

- **-444 ^ - ?**
  
  Used for negative relative position in E/W plane.
<table>
<thead>
<tr>
<th>Code</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-445</td>
<td>^ + ?</td>
<td>Used for positive relative position in N/S plane.</td>
</tr>
<tr>
<td>-446</td>
<td>^ - ?</td>
<td>Used for negative relative position in N/S plane.</td>
</tr>
<tr>
<td>-447</td>
<td>^ + ?</td>
<td>Used for positive relative position in U/D plane.</td>
</tr>
<tr>
<td>-448</td>
<td>^ - ?</td>
<td>Used for negative relative position in U/D plane.</td>
</tr>
<tr>
<td>-449</td>
<td>^ + ?</td>
<td>Set to <strong>blank</strong>. Only outputs the relative position.</td>
</tr>
</tbody>
</table>
Index

COMPIPE Material Control Links • 849
Complete Batch Schedule (Schedule Wizard) • 223
Component Atts (S3D Labels) • 686
Component Note (S3D Labels) • 685
Component Note Conditional (S3D Labels) • 685
Components Overview • 85
Conditional Drawing Update • 82
Configuration Tab (Properties Dialog Box) • 63
Configuration Tab (Surface Style Rule Properties Dialog Box) • 58
Configure SmartPlant PDF Converter for Windows • 43
Configure the software to use an ASCII symbol file • 186
Content (Drawing) • 423
Content (S3D Drawing) • 661
Control drawing content • 123
Controls (Drawing) • 433
Controls (S3D Drawing) • 654
Convert Excel Spreadsheet Reports to Native Text Box Format Custom Command • 379
Copy an item • 35
Copy an object • 341
Copy and Paste View Command • 341
Copy Command • 35
Couplings (SKEYs) • 793
Create a backup to use for restoration • 83
Create a custom symbol for isometric drawings • 187
Create a key point note • 125
Create a piping component file (PCF) • 68
Create a search folder • 190
Create a Template • 201
Create an imported folder • 195
Create an isometric drawing • 99
Create custom commands • 229
Create Drawing(s) Command • 36
Crop a Drawings by Rule 2D Drawing View and the 3D Model Volume • 382
Crosses (SKEYs) • 794
Current Sheet Tab • 256
Custom Commands • 226, 378
Custom Commands Dialog Box • 231
Custom MTO (S3D Drawing Frame) • 671
Custom Symbols for Isometric Drawings • 186
Custom Tab (Properties Dialog Box) • 58
Customize isometric style options • 118
Customize report settings • 139
Cut List Options • 603
Cut List Page • 158

D
Data Files (Supplementary) • 621
Data Files Collection (Supplementary Data Files) • 621
Define a dynamic font for isometric drawing extraction • 164
Define drawing frame attributes • 144
Define drawing margins and report layout • 137
Define Layout Style Dialog Box • 278
Definitions (Drawing) • 444
Delete a custom command • 230
Delete an item • 37
Delete Command • 36
Delete Views • 391
Delivered Custom Commands • 232
Delivered Drawing Types • 23
det Sketches (S3D Supplementary) • 678
det Sketches (Supplementary) • 621
det Sketches in Drawings • 182
detail View (View Menu) • 30
Dimension Paper Space Objects for 3D Drawings • 250
Dimensioned Label Command • 301, 362
Dimensioning in 3D Drawings • 248
Dimensions • 239
Dimensions (Drawing) • 447
Dimensions (S3D Drawing) • 660
Disassociate Graphics from Graphic View • 347
Display a pipeline list • 174
Document Properties Dialog Box • 412
Document Tab • 255
Documentation Comments • 17
Documentation Set • 13
Dotted Symbology (S3D Drawing Format) • 658
Draw a Centerline with Scaled Sketching • 332
Draw a Grate Opening with Scaled Sketching • 331
Draw a Textured Fill with Scaled Sketching • 334
Draw an Opening in a Plate with Scaled Sketching • 336
Draw or Edit Objects at the Same Scale Factor • 329
Draw Rebar with Scaled Sketching • 335
Drawing Areas Page • 147
Index

Drawing Definitions Collection • 445
Drawing Frame (S3D Labels) • 689
Drawing Frame Options • 548
Drawing Frame Options (S3D) • 668
Drawing General Options • 422
Drawing Information File (Supplementary) • 628
Drawing Options (S3D) • 653
Drawing Setup Tool • 132
Drawing Sheet Properties Dialog Box • 376
Drawing View Properties Dialog Box
  (Drawing View Shortcut Menu) • 349
Drawing View Properties Dialog Box (Place View Command) - Composed Drawings • 258
Drawing View Properties Dialog Box (Place View Command) - Steel Order Drawings • 263
Drawings and Reports • 21
Drawings by Query Filters • 91
Drawings Compose Toolbar • 257
Drawings View Explorer • 236
DwgInfoFile Collection (Supplementary DwgInfoFile) • 628
Dynamic Fonts (Drawing) • 521
Dynamic Fonts Collection (Drawing Dynamic Fonts) • 521
End Connections (Drawing) • 522
End Connections Collection (Drawing End Connections) • 522
End Prep Connections • 798
Examples • 823
Extraction Data Dialog Box • 102

F
Find documents to publish • 414
Find Documents to Publish • 413
Find Documents to Publish Dialog Box • 414
Fixed Layout (Cut List) • 606
Fixed Layout (Material List) • 566
Fixed Layout (Weld List) • 595
Fixed Length Pipes (SKEYs) • 798
Flanges (SKEYs) • 799
Flat Spools and Flange Rotation • 848
Flow Arrows • 166
Fonts (Supplementary) • 629
Fonts in Isometric Drawings • 163
Format (Drawing) • 484
Format (S3D Drawing) • 655
Format Tab (Drawing View Properties Dialog Box) • 259, 264, 349
Format Tab (Key Plan Properties Dialog Box) • 356

G
Gasket Data (S3D Neutral File) • 683
General Tab (Properties Dialog Box) • 47
Group existing labels • 305
Group Selected Labels • 303
Grouping of AText Listings • 824

H
Heat Treatment (Supplementary) • 629
Hide an Object • 340
Hide/Show Object Command • 339
Highlight Annotations Command • 343
Highlight Dialog Box • 343

I
Icons for Components and Drawings • 26
Import data from the style XML file • 121
Imported Folders • 194
Info Tab (Drawing View Properties Dialog Box) • 258, 264, 349
Info Tab (Key Plan Properties Dialog Box) • 355
Inline Filters (SKEYs) • 800
| Insert a note at a precise place on an isometric drawing | 80 |
| Instrument SKEYs (Supplementary) | 630 |
| Instruments (SKEYs) | 801 |
| Insulation Spec (S3D Labels) | 688 |
| Interface Overview | 25 |
| Intergraph Alternative Text Options (S3D) | 692 |
| ISOGEN® Symbol Key Mapping | 750 |
| ISOGEN® SKEY Dimensions | 703 |
| Isometric Drawing Area | 824 |
| Isometric Drawing Styles | 108 |
| Isometric Drawing Types | 110 |
| Isometric Style Common Tasks | 115 |
| Isometric Style Options Browser | 131 |
| Issue request documents | 407 |
| Issue Request Tab (Publish Dialog Box) | 412 |
| Issue Tab (Properties Dialog Box) | 60 |

J Section

- Jacketed Pipeline Drawings | 114 |

K Section

- Key Plan Properties Dialog Box | 355 |
- Key Plan Tab (Key Plan Properties Dialog Box) | 356 |
- Key Point Notes (S3D Drawing) | 666 |
- Key Point Notes Collection (S3D Drawing) | 667 |

L Section

- Labels Options (S3D) | 684 |
- Layers | 184 |
- Layers (Drawing) | 520 |
- Layers (SmartSketch Drawing Editor Tools Menu) | 377 |
- Layers Collection (Drawing Layers) | 520 |
- Line Summary Area | 844 |
- LJSE Type Flanges (SKEYs) | 804 |
- Local Sketches (Supplementary Detail Sketches) | 627 |

M Section

- Manage batch jobs | 205 |
- Manage Projects | 415 |
- Management Console (View Menu) | 29 |
- Manual Dimensioning | 247 |
- Manual Place View Ribbon | 352 |
- Map isometric data to drawing layers | 185 |
- Material List (S3D Labels) | 687 |
- Material List Options | 555 |
- Material List Options (S3D) | 672 |
- Material List Page | 150 |
- Material Lists and Material List Files | 169 |
- Menus and Toolbars | 26 |
- Misc Spec (S3D Labels) | 688 |
- Miscellaneous Items (SKEYs) | 805 |
- Miscellaneous Pipe Components (SKEYs) | 805 |
- Modify an Existing Border File | 378 |
- Modify View Ribbon | 381 |
- Move a Drawing View | 274 |
- Move a view to a different drawing | 342 |
- Move a View with Scaled Sketching Objects | 330 |
- Move multiple views to a different drawing | 342 |
- Move Sheet(s) | 238 |
- Move View Command | 341 |
- Move View Dialog Box | 343 |

N Section

- Neutral File (Supplementary) | 630 |
- Neutral File Collection (Supplementary) | 634 |
- Neutral File Options (S3D) | 680 |
- Neutral File Output (Supplementary) | 632 |
- New Command | 37 |
- Nipple Symbol Mapping | 692 |
- Notes Tab (Properties Dialog Box) | 59 |

O Section

- Olets (SKEYs) | 807 |
- One Section (Material List User Defined) | 578 |
- Open a document | 40 |
- Open Command | 39 |
- Open the Drawing Setup Tool | 135 |
- Operators (SKEYs) | 809 |
- Option Override (Piping Isometric Drawing Shortcut Menu) | 179 |
- Option Override Dialog Box | 181 |
- Optional Schedule Properties Dialog Box | 202 |
- Other End Connections (SKEYs) | 810 |
- Override Dimension Styles | 245 |
- Override isometric drawing style options | 180 |

Piping Isometric Drawings User's Guide
Painting Spec (S3D Labels) • 687
Part Data (S3D Neutral File) • 681
Paste an item • 41
Paste Command • 40
Paste Special Dialog Box • 41
Permissions Overview • 28
Pipeline Attributes (Supplementary) • 635
Pipeline List (S3D Drawing Frame) • 669
Pipeline List Box (S3D Labels) • 690
Pipeline Lists • 173
Piping Isometric Drawings by Query • 88
Piping Isometric Drawings by Query Common Tasks • 90
Place a Custom Drawing Property Label on a Template • 360
Place a Cutting Plane/Section View • 316
Place a Detail Envelope • 311
Place a Detail View • 324
Place a Dimensioned Label • 302, 363
Place a Drawing Property Label on a Template • 359
Place a Drawing View for Volume Drawings • 348
Place a Key Plan • 356
Place a Label Command • 296
Place a Label Ribbon • 296
Place a Manual Flow Arrow on an Orthographic Drawing • 300, 368
Place a Manual Label • 297, 367
Place a Manual View • 271
Place a Manual View (By Parts) • 271
Place a Manual View (By Reference Plane and Block) • 272
Place a Manual Weld Label • 298, 369
Place a Section View • 320
Place an Elevation Label • 366
Place an Embedded Report in a Volume Drawing • 353
Place an Unassigned View • 383
Place barcode data on the isometric drawing • 165
Place Cutting Plane Ribbon • 313
Place Cutting Plane/Section View Command • 312
Place Detail Envelope Command • 308
Place Detail Envelope Ribbon • 309
Place Detail View Command • 323
Place Detail View Ribbon • 324
Place Drawing Area Command • 371
Place Drawing Property Label Command (Drawing Labels Toolbar) • 357
Place Drawing Property Label Ribbon • 358
Place Drawing View Command (Template Toolbar) • 348
Place Key Plan Command (Template Toolbar) • 355
Place Region Command • 275
Place Report Command (Template Toolbar) • 352
Place Report View Command • 293
Place Section View Ribbon • 314
Place Snapshot View Command • 278
Place Snapshot View Ribbon • 278
Place View command • 257
Plotted Material and Cut Pipe List Heading Texts • 837
Populate the title block • 119
Preface • 12
Preview Layout Command • 374
Print a document • 42
Print a document as a PDF file • 42
Print Action • 200
Print Command • 42
Print welds • 175
Printed Material List • 845
Printed Material List (Supplementary) • 651
Properties Command • 45
Properties Dialog Box • 46
Properties Dialog Box (Batch Management Command) • 208
Publish • 399
Publish a large 3D model to SmartPlant Foundation • 406
Publish Common Tasks • 398
Publish Dialog Box • 408
Publish documents • 403
Publish Tab (Publish Dialog Box) • 408
Publish Workflows • 404
Published Documents - Load, Consolidated, and MergeDelta Tasks (S3D) • 401
Published Files (S3D Supplementary) • 679
Publishing Documents • 395
Publishing Title Blocks • 397
Record Identification Numbers • 592
Reducers (SKEYs) • 811
Reference Plane System • 854
Reference Planes (Supplementary) • 635
Refresh (Shortcut Menu) • 77
Refresh (View Menu) • 33
Refresh Action • 199
Refresh document status • 78
Region Properties Dialog Box • 277
Remarks Box (Material List User Defined) • 583
Remove Associated Inputs Command • 293
Remove Cropping on a Drawings by Rule View • 383
Rename an item • 66
Rename Command • 66
Repair Documents Custom Command • 232
Report Files (Supplementary) • 640
Report Properties Dialog Box (Place Report View Command) • 294
Report Template (S3D Drawing Frame Pipeline List) • 671
Reports Compatible with Drawings • 295
Restore • 83
Restore a document from a backup model • 83
Retain Edits made inside a Drawing View • 338
Revise • 392
Revise a document • 393
Revise Dialog Box • 394
Revising • 392
Revision Tab (Properties Dialog Box) • 61
Revisions (Drawing) • 527
Run a custom command • 230
Run Query (Shortcut Menu) • 98
Run Update or Full Update • 390

S
S3D Options • 652
Save a package • 74
Save As Command • 66
Save As Dialog Box • 72
Save As MicroStation or AutoCAD Format • 252
Save as SmartPlant Foundation (*.xml) • 70
Save Package Command • 74
Save Package Dialog Box • 75
Save to a file • 67
Scaled Sketching Command • 330
Scaled Sketching Ribbon • 330
Schedule [Task] Dialog Box • 201
Schedule Daily Batch Job (Schedule Wizard) • 219
Schedule Monthly Batch Job (Schedule Wizard) • 221
Schedule One-Time-Only Batch Job (Schedule Wizard) • 222
Schedule Weekly Batch Job (Schedule Wizard) • 220
Schedule Wizard • 214
Search Folder Filters • 191
Search Folders • 189
Section View Orientation Rules in Drawings by Rule • 384
Section View Orientation Rules in Orthographic Drawings • 317
Select a font for isometric drawing output • 163
Select Active Project Dialog Box • 415
Select Aspects Dialog Box • 54
Select Border Family Dialog Box • 373
Select Drawing Style Dialog Box • 95
Select Filter • 95
Select Filter Dialog Box • 95
Select Key Plan Style Dialog Box • 355
Select Options Dialog Box • 181
Select Printer (File Menu) • 43
Select Printer Dialog Box • 43
Select Report Template Dialog Box • 354
Select Template Dialog Box • 295
Set Batch Job Frequency (Schedule Wizard) • 218
Set drawing control options • 125
Set drawing dimension options • 123
Set drawing frame options • 121
Set flow arrow options • 167
Set Print Options • 200
Set properties for publishing documents • 400
Set styles for the MTO neutral file • 173
Set surface styles and aspects for 3D model data documents • 45
Set up a cut list • 172
Set up a Drawings by Query Manager component • 97
Set up a material list • 171
Set up a Piping Isometric Drawing by Query component • 93
Setting Properties • 44
Setup (Drawings by Query Manager Component Shortcut Menu) • 97
Setup (Imported Folder) • 195
Setup (Piping Isometric Drawing by Query Component Shortcut Menu) • 93
Setup (Search Folder) • 191
Setup Dialog Box (Drawings by Query Manager Component) • 98
Setup Dialog Box (Imported Folder) • 196
Setup Dialog Box (Piping Isometric Drawing by Query Component) • 94
Setup Dialog Box (Search Folder) • 191
Sheet Properties Dialog Box • 255
Shortcut Menus • 34, 374
Show an Object • 340
Signature Area Tab (Properties Dialog Box) • 50
Site Weld File (Supplementary) • 641
Site Weld File Collection (Supplementary Site Weld File) • 642
Sketch Mapping (S3D Supplementary Detail Sketches) • 678
Specification Change Indication • 834
Specify a label for the material list • 172
Specify a label for the weld list • 175
Specify columns in the detail view • 30
Specify drawing format • 125
Specify the backing sheet • 135
Spool Attributes (Supplementary) • 643
Spool Attributes Enclosures (Supplementary Spool Attributes) • 644
Spool Information (Supplementary) • 644
Spool Information Collection (Supplementary Spool Information) • 645
Spool Table (Material List User Defined) • 584
SPOOLGEN (FFISYS) Screen Display • 849
Style Tab (Properties Dialog Box) • 52
Submit or Schedule a Batch Job (Schedule Wizard) • 216
Submit or Schedule Printing (Schedule Wizard) • 225
Summary File (Cut List) • 611
Summary File (Material List) • 587
Summary File (Weld List) • 600
Summary File Collection (Cut List Summary File) • 613
Summary File Collection (Material List Summary File) • 590
Summary File Collection (Weld List Summary File) • 603
Supplement (S3D SymbolMAP) • 691
Supplementary Options • 614
Supplementary Options (S3D) • 677
Support Atts (S3D Labels) • 687
Support for Handling Large Publishes • 400
Surface Style Rule Properties Dialog Box • 56
Surface Style Rule Properties Tab (Surface Style Rule Properties Dialog Box) • 57
Surface Styles and Aspects Tab (Properties Dialog Box) • 53
Switch Border • 375
Symbol Mapping Options (S3D) • 690
Symbol Table (Drawing Frame) • 553

T
Table Attributes (Drawing Frame) • 551
Table Attributes (Supplementary) • 646
Table Attributes Collection (Supplementary Table Attributes) • 647
Tees (SKEYs) • 814
Template Toolbar • 347
Three Section (Material List User Defined) • 581
Title Area Tab (Properties Dialog Box) • 48
Title Block/Drawing Frame • 835
Title Texts (Supplementary) • 648
Tools Menu • 197
Traceability (Supplementary) • 649
Traceability Collection (Supplementary Traceability) • 651
Tracing Spec (S3D Labels) • 688
Transfer Ownership Dialog Box • 64
Transfers (Material List) • 591
Traps (SKEYs) • 816
Troubleshooting Linked Servers • 419
Two Section (Material List User Defined) • 579

U
Units of Measure (S3D Drawing Frame) • 669
Update a Manual View • 273
Update a report • 79
Update a single drawing • 80
Update Action • 199
Update all drawings in a folder or a component • 79
Update an Existing Batch Job (Schedule Wizard) • 217
Update and Full Update Commands • 389
Update Now • 78
Update the style • 145
Update View Command • 374
Updating Documents • 76
Use Dimension Rules • 241
Use Dimension Templates • 242
Use piping isometric change management • 177
Use View Styles with Dimension Rules • 240
User Attributes (S3D Neutral File) • 681
User Defined (Cut List) • 607
User Defined (Material List) • 573
User Defined (Weld List) • 597
User Defined Collection (Cut List User Defined) • 610
User Defined Collection (Material List User Defined) • 586
User Defined Collection (Weld List User Defined) • 600
Using Alternative Text • 821
Using Scaled Sketching • 328

V
Valves (SKEYs) • 816
Variable Layout (Material List) • 569
Variable Layout (Weld List) • 595
Variable Layout Collection (Material List Variable Layout) • 573
Variable Layout Collection (Weld List Variable Layout) • 596
Vents (SKEYs) • 819
View Extraction Data • 99
View Log Command • 84
View Menu • 29
View piping isometric extraction data • 100
View style fragment data • 101
View Tab (Drawing View Properties Dialog Box - Drawings View Explorer) • 265
View Tab (Drawing View Properties Dialog Box) • 259, 350
View the results • 145

W
WBS Tab (Properties Dialog Box) • 62
Weld Box Summary • 846
Weld Data (S3D Neutral File) • 682
Weld List (S3D Labels) • 689
Weld List Options • 594
Weld List Page • 155
Weld Lists and Weld Files • 174
Welds (Drawing) • 529
Welds (S3D Drawing) • 661
Welds (SKEYs) • 819
Welds Enclosures (Drawing Welds) • 545
What's New in Drawings and Reports • 18
Working with Drawings and Reports and SmartSketch Drawing Editor • 233